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About this manual

Welcome!
This is the Operation Manual for Steinberg’s Nuendo. 
Here you will find detailed information about all the fea-
tures and functions in the program. 

About the program versions
The documentation covers two different operating sys-
tems or “platforms”; Windows and Mac OS X. 

Some features and settings are specific to one of the plat-
forms, Windows or Mac OS X. This is clearly stated in the 
applicable cases. In other words:

If nothing else is said, all descriptions and procedures 
in the documentation are valid for both Windows and Mac 
OS X.
The screenshots are taken from the Windows version of Nuendo.

About the Nuendo Expansion Kit
The Nuendo Expansion Kit adds a number of music com-
position functions from Steinberg’s Cubase (the “Cubase 
Music Tools”) to the standard Nuendo application. The 
Nuendo Expansion Kit (NEK) is a separate product and 
can be purchased through your Steinberg dealer.

Whenever procedures in this manual use functions avail-
able only when the NEK is installed, this is indicated in the 
text by “Nuendo Expansion Kit only”.

Key command conventions
Many of the default key commands in Nuendo use modi-
fier keys, some of which are different depending on the 
operating system. For example, the default key command 
for Undo is [Ctrl]-[Z] under Windows and [Command]-[Z] 
under Mac OS X.

When key commands with modifier keys are described in 
this manual, they are shown with the Windows modifier 
key first, in the following way:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means “press [Ctrl] 
under Windows or [Command] under Mac OS X, then 
press [Z]”. 

Similarly, [Alt]/[Option]-[X] means “press [Alt] under Win-
dows or [Option] under Mac OS X, then press [X]”.

Please note that this manual often refers to right-click-
ing, e.g. to open context menus, etc. If you are using a Mac 
with a single-button mouse, hold down [Ctrl] and click.
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VST Connections: Setting up input and output busses

About this chapter
Nuendo uses a system of input and output busses to trans-
fer audio between the program and the audio hardware.

• Input busses let you route audio from the inputs on your audio 
hardware into the program. This means that when you record 
audio, you will always do this through one or several input 
busses.

• Output busses let you route audio from the program to the 
outputs on your audio hardware. When you play back audio, 
you will always do this through one or several output busses.

As you can see, the input and output busses are vital when 
you work with Nuendo. This is why you find this chapter in 
the beginning of the Operation Manual – once you under-
stand the bus system and set up the busses properly, it will 
be easy to go on with recording, playing back, mixing and 
doing surround work.

Setting up busses

Strategies
You can create any number of busses in Nuendo, in virtu-
ally any channel configuration – mono, stereo or a number 
of surround formats.

The bus configuration is saved with the projects – 
therefore it’s a good idea to add and set up the busses 
you need and save these in a template project (see “Save 
as Template” on page 488).
When you start working on new projects, you start from this template. 
That way you get your standard bus configuration without having to make 
new bus settings for each new project. If you need to work with different 
bus configurations in different projects, you can either create several dif-
ferent templates or store your configurations as presets (see “Other bus 
operations” on page 14). The templates can of course also contain other 
settings that you regularly use – sample rate, record format, a basic track 
layout, etc.

So, which type of busses do you need? This depends on 
your audio hardware, your general audio setup (e.g. sur-
round speaker setup) and what kind of projects you work 
with. 

Here’s an example:

Let’s say you are using audio hardware with eight analog 
inputs and outputs and digital stereo connections (10 in-
puts and outputs all in all). Furthermore, you work with a 
surround setup in 5.1 format. Here’s a list of busses you 
may wish to add:

Input busses

• Most likely you need at least one stereo input bus assigned to 
an analog input pair. This would let you record stereo material. 
If you want to be able to record in stereo from other analog in-
put pairs as well, you could add stereo input busses for these 
too.

• Although you can record mono tracks from one side of a ste-
reo input, it may be a good idea to add a dedicated mono in-
put bus. This could be assigned to an analog input to which 
you have connected a dedicated microphone pre-amp for ex-
ample. Again, you can have several different mono busses.

• You probably want a dedicated stereo input bus assigned to 
the digital stereo input, for digital transfers.

• If you want to transfer surround material directly to a surround 
track, e.g. from surround-configured location recording equip-
ment, you need an input bus in that surround format  – in this 
example, this would be a 5.1 input bus.

Output busses

• You will need one or several stereo output busses for routing 
stereo mixes to master recorders or other destinations.

• For digital transfers, you need a stereo bus assigned to a dig-
ital stereo output as well.

• You need a surround bus in the format of your speaker config-
uration (in this example, 5.1) assigned to the correct outputs 
(which in turn are connected to the correct speakers).

• You may want additional surround busses if you tend to work 
in different surround formats.
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Preparations
Before you set up busses, you should name the inputs 
and outputs on your audio hardware. For example, if you 
are using a 5.1 surround speaker setup, you should name 
the outputs according to which speaker they are con-
nected to (Left, Right, Center and so on). 

The reason for this is compatibility – it makes it easier to 
transfer projects between different computers and setups. 
For example, if you move your project to another studio, 
the audio hardware may be of a different model. But if 
both you and the other studio owner have given your in-
puts and outputs names according to the surround setup 
(rather than names based on the audio hardware model), 
Nuendo will automatically find the correct inputs and out-
puts for your busses and you will be able to play and 
record without having to change the settings.

Use the Device Setup dialog to assign names to the in-
puts and outputs of your audio hardware:

1. Open the Device Setup dialog from the Devices menu.

2. Make sure that the correct driver for your audio hard-
ware is selected on the VST Audio System page, so that 
the audio card is listed in the Devices list.

3. Select your audio card in the list.
The available input and output ports on your audio hardware are listed on 
the right.

4. To rename a port, click its name in the “Show as” col-
umn and enter a new name.

• If needed, you can also disable ports by deactivating 
them in the “Visible” column.
Disabled ports won’t show up in the VST Connections window when you 
are making bus settings. If you attempt to disable a port that is used by a 
bus, you will be asked whether this is really what you want – note that 
this will remove the port from the bus!

5. Click OK to close the Device Setup dialog.

If you open a project created on another computer and 
the port names don’t match (or the port configuration isn’t 
the same – e.g. the project is created on a system with 
multi-channel i/o and you open it on a stereo in/out sys-
tem), the Pending Connections dialog will appear.
This allows you to manually re-route ports used in the project to ports 
available in your system.

The VST Connections window
You add and set up busses in the VST Connections win-
dow, opened from the Devices menu.

This window contains the following tabs:

• The Inputs and Outputs tabs are for viewing input busses or 
output busses, respectively. 

• The Group/FX tab allows you to create Group and FX chan-
nels/tracks and to make output assignments for these. See 
“Setting up Groups and FX channels” on page 17. 

• The External FX tab allows you to create effect send/return 
busses for connecting external effects which can then be se-
lected via the effect pop-up menus from inside the program. 
See “External instruments/effects” on page 17 and “Using ex-
ternal effects” on page 182 for further information.

• The External Instruments tab allows you to create input/output 
busses for connecting external instruments. See “External in-
struments/effects” on page 17 and the chapter “VST Instru-
ments and Instrument tracks” on page 189 for further 
information.

• The Studio tab is where you enable and configure the Control 
Room. See the chapter “Control Room” on page 151.

For the time being, we shall focus on how to set up input 
and output busses.
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Depending on which tab you have selected, Inputs or Out-
puts, the window lists the current input or output busses, 
with the following columns:

Adding a bus

1. Click the Inputs or Outputs tab depending on which 
you want to add.

2. Click the Add Bus button.
A dialog appears.

3. Select the desired (channel) configuration.
The pop-up menu contains Mono and Stereo options as well as several 
surround formats. To select another surround format, use the “More…” 
submenu.

• Alternatively you can right-click in the VST Connections 
window and add a bus in the desired format directly from 
the context menu that appears.
The new bus appears with the ports visible.

4. Click in the Device Port column to select an input/out-
put port for a channel in the bus.
The pop-up menu that appears lists the ports with the names you have as-
signed in the Device Setup dialog. Repeat this for all channels in the bus.

Adding a child bus

A surround bus is essentially a set of mono channels – 6 
channels in the case of 5.1 format. If you have a mono 
track in the project, you can route it to a separate speaker 
channel in the bus (or route it to the whole surround bus 
and use the surround panner to position it in the surround 
image). But what if you have a stereo track that you simply 
want to route to a stereo channel pair within the bus (Left 
and Right or Left Surround and Right Surround for exam-
ple)? For this you need to create a child bus.

1. Select the surround bus in the list and right-click on it.
A pop-up menu appears.

2. Select a channel configuration from the “Add Child 
Bus” submenu.
As you can see, you can create stereo child busses (routed to various 
speaker channel pairs in the surround bus) or other surround bus formats 
(with fewer channels than the “parent bus”).

The child bus you created will be available for direct rout-
ing in the mixer. It’s a part of the parent surround bus, 
which means there will be no separate channel strip for it.

Although child busses are probably most useful in output 
busses, you can also create child busses within a sur-
round input bus – for example if you want to record a ste-
reo channel pair (e.g. front left-right) in the surround bus 
to a separate stereo track.

Column Description

Bus Name Lists the busses. You can select busses and rename 
them by clicking on them in this column.

Speakers Indicates the speaker configuration (mono, stereo, sur-
round formats) of each bus.

Audio Device This shows the currently selected ASIO driver.

Device Port When you have “opened” a bus (by clicking its + button in 
the Bus Name column) this column shows which physical 
input/output on your audio hardware is used by the bus.

Click You can route the click to a specific output bus, regard-
less of the actual Control Room output, or indeed when 
the Control Room is disabled. 
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Setting the Main Mix bus (the default output bus)

The Main Mix is the output bus that each new channel in 
the mixer will be assigned to when it is created.

Any one of the output busses in the VST Connections 
window can be the default output bus. By right-clicking on 
the name of an output bus, you can set this bus as the 
Main Mix bus.

Setting the default output bus in the VST Connections window.

When creating new audio, group or FX channels in the 
mixer, they will automatically be routed to the default bus.

Other bus operations

• To change the port assignment for a bus, you proceed 
as when you added it – make sure the channels are visible 
(by clicking the “+” button next to the bus, or by clicking 
the “+ All” button at the top of the window) and click in the 
Device Port column to select ports.

• To remove a bus you don’t need, select it in the list, 
right-click and select “Remove Bus” from the pop-up 
menu, or press [Backspace].

• You can store and recall bus presets with the pop-up 
menu at the top of the window.
To store the current configuration as a preset, click the Store “+” button 
and enter a name for the preset. You can then select the stored configu-
ration directly from the Presets pop-up menu at any time. To remove a 
stored preset, select it and click the “-” button.

Using the busses
This section describes briefly how to use the input and out-
put busses you have created. For details refer to the chap-
ters “Recording” on page 64 and “The mixer” on page 122.

Routing
When you play back an audio track (or any other audio 
channel in the mixer – VST Instrument channels, ReWire 
channels, etc.), you route it to an output bus. In the same 
way, when you record on an audio track you select from 
which input bus the audio should be sent.

• You can select input and output busses in the Inspec-
tor, using the Input and Output Routing pop-up menus.

For audio-related channel types other than audio track 
channels (i.e. VST Instrument channels, ReWire channels, 
Group channels and FX channels), only the Output Rout-
ing pop-up menu is available. Select one of its subtracks 
in the Track list to open it.

• You can also select busses in the Routing panel at the 
top of each channel strip in the mixer.
Again, for VST Instrument channels, ReWire channels, Group channels 
and FX channels you will only be able to select output busses.

! The default bus is indicated by an orange colored 
speaker icon next to its name in the VST Connec-
tions window.
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• If you press [Alt]/[Option] and select an input or output 
bus in the Mixer Routing View, it will be chosen for all se-
lected channels.
This makes it easy to quickly set several channels to use the same input 
or output. Similarly, if you press [Shift] and select a bus, the following se-
lected channels will be set to use incrementing busses – the second se-
lected channel will use the second bus, the third will use the third bus 
and so on.

If the Routing panel isn’t shown, click the Show Rout-
ing button in the extended common panel or open the 
Mixer context menu and select “Show Routing View” from 
the Window submenu.

The “Show Routing” button in the extended common panel of the Mixer.

When selecting an input bus for a track you can only se-
lect busses that correspond to the track’s channel config-
uration. Here are the details for input busses:

• Mono tracks can be routed to mono input busses or individual 
channels within a stereo or surround input bus.

• Mono tracks can be routed to External Inputs that are config-
ured in the Studio tab of the VST Connections window. These 
can be mono or individual channels within a stereo or surround 
input bus. They can also be routed to the Talkback input.

• Mono tracks can also be routed to mono output busses, mono 
group output busses or mono fx channel output busses, pro-
vided that these will not lead to feedback.

• Stereo tracks can be routed to mono input busses, stereo in-
put busses or stereo child busses within a surround bus.

• Stereo tracks can be routed to External Inputs that are config-
ured in the Studio tab of the VST Connections window. These 
can be mono input busses or stereo input busses. They can 
also be routed to the Talkback input.

• Stereo tracks can also be routed to mono or stereo output 
busses, mono or stereo group output busses and mono or 
stereo fx channel output busses, provided that these will not 
lead to feedback.

• Surround tracks can be routed to surround input busses.
• Surround tracks can be routed to External Inputs that are con-

figured in the Studio tab of the VST Connections window, pro-
vided that these have the same input configuration. 

• Surround tracks can also be routed to output busses, provided 
that these have the same input configuration or will not lead to 
feedback.

For output busses any assignment is possible.

To disconnect input or output busses, select “No Bus” 
from the corresponding pop-up menu.

Viewing the busses in the mixer
In the mixer, busses are represented by input and output 
channels (shown in separate panes to the left and right in 
the window). You can show or hide these independently 
by clicking the Hide Input Channels and Hide Output 
Channels buttons in the common panel:

! Assignments that will lead to feedback are not avail-
able in the pop-up menu. This is also indicated by a 
one-way symbol.

Hide Input Channels

Hide Output Channels
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Input channels

The input channels are shown to the left in the mixer. As 
you can see, each input channel resembles a regular mixer 
channel strip. Here you can do the following:

• Check and adjust the recording level using the Input 
Gain knobs and/or the level fader.
See “Setting input levels” on page 69.

• Change the phase of the input signal.
This is done by clicking the Input Phase button next to the Input Gain 
control.

• Add effects or EQ to the input bus.
See “Recording with effects” on page 76 for an example of how to add 
effects to your recording at the input bus stage.

Output channels

The output channels are shown to the right in the mixer. 
Here you can do the following:

• Adjust the output level for the busses with the faders.

• Add effects or EQ.
These will affect the whole bus. Examples of effects you may want to add 
here include compressors, limiters and dithering. See the chapter “Audio 
effects” on page 168.

• Using Sends, send varying amounts of one output bus 
to any other output bus that is to the right of the selected 
output bus in the mixer.

! The settings you make in the input channel strip will 
be a permanent part of the recorded audio file!
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Setting up Groups and FX channels
The Group/FX tab in the VST Connections window shows 
all Group channels and FX channels in your project. You 
can create new Group or FX channels by clicking the cor-
responding Add button. This is the same as creating 
Group channel tracks or FX channel tracks in the Project 
window (see “Using group channels” on page 142 and 
the chapter “Audio effects” on page 168).

However, the VST Connections window also allows you to 
create child busses for Groups and FX Channels. This is 
useful e.g. if you have Groups or FX Channels in surround 
format and want to route stereo channels to specific chan-
nel pairs in these.

To create a child bus for a Group channel or FX channel in 
surround format, proceed as follows:

1. Open the VST Connection window and select the 
Groups/FX tab.

2. Select the Group or FX channel in the list and right-
click it.

3. Select a channel configuration from the “Add Child 
Bus” submenu.

The child bus you created will be available for direct rout-
ing in the mixer. It’s a part of the parent Group or FX chan-
nel, which means there will be no separate channel strip 
for it.

About monitoring
By default, monitoring is done via the Control Room (see 
the chapter “Control Room” on page 151). When the 
Control Room is disabled on the Studio tab of the VST 
Connections window, the Main Mix bus (see “Setting the 
Main Mix bus (the default output bus)” on page 14) will be 
used for monitoring.

Setting the monitoring level

When you are using the Control Room for monitoring, this 
is set in the Control Room Mixer, see the chapter “Control 
Room” on page 151. When you are monitoring via the 
Main Mix bus, you can adjust the monitoring level in the 
regular Project Mixer.

When auditioning or scrubbing in the Sample Editor, you 
can also set the monitoring level using the small fader on 
the Sample editor toolbar.

External instruments/effects
Nuendo supports the integration of external effect devices 
and external instruments, e.g. hardware synthesizers, into 
the sequencer signal flow.

You can use the External Instruments tab and the External 
FX tab in the VST Connections window to define the 
necessary send and return ports and access the instru-
ments/effects through the VST Instruments window.

Requirements
• To use external effects, you need audio hardware with 
multiple inputs and outputs. To use external instruments, a 
MIDI interface must be connected to your computer.
An external effect will require at least one input and one output (or input/
output pairs for stereo effects) – in addition to the input/output ports you 
use for recording and monitoring.

• As always, audio hardware with low-latency drivers is a 
good thing to have.
Nuendo will compensate for the input/output latency and ensure that the 
audio processed through external effects isn’t shifted in time.

! External Instruments and effects are indicated by an 
“x” icon in the list next to their names in the respec-
tive pop-up menus.
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Connecting the external effect/instrument
To set up an external effect or instrument, proceed as fol-
lows:

1. Connect an unused output pair on your audio hard-
ware to the input pair on your external hardware device.
In this example, we assume that the hardware device has stereo inputs 
and outputs.

2. Connect an unused input pair on your audio hardware 
to the output pair on your hardware device.

Once the external device is connected to the audio hard-
ware of your computer, you have to set up the input/out-
put busses in Nuendo

Setting up external effects
1. Open the VST Connections window from the Devices 
menu.

2. Open the External FX tab and click “Add External FX”.

3. In the dialog that appears, enter a name for the exter-
nal effect and specify the Send and Return configurations. 
If you want to set up a MIDI device corresponding to the 
external effect, click the “Associate MIDI Device” button.
Depending on the type of effect, you can specify mono, stereo or surround 
configurations. When clicking “Associate MIDI Device”, you can use the 
MIDI Device Manager functions to create a new MIDI device for the effect. 
Note that delay compensation will only be applied for the effect when you 
use MIDI devices. For information about the MIDI Device Manager and 
user device panels see the separate PDF document “MIDI Devices”.

4. Click OK. This adds a new External FX bus.

5. Click in the Device Port column for the Send Bus 
“Left” and “Right” ports and select the outputs on your au-
dio hardware that you connected in step 1 above.

6. Click in the Device Port column for the Return Bus 
“Left” and “Right” ports and select the inputs on your au-
dio hardware that you connected in step 2 above.

7. If you like, make additional settings for the bus.
These are found in the columns to the right. Note however that you can 
adjust these while actually using the external effect – which may be eas-
ier as you can hear the result. You have the following options:

! Please note that it is possible to select input/output 
ports for external effects/instruments that are already 
used (i.e. that have been selected as inputs/outputs 
in the VST Connections window). If you select a 
used port for an external effect/instrument, the exist-
ing port assignment will be broken. Note that you will 
not get a warning message!

Setting Description

Delay If your hardware effect device has an inherent delay (la-
tency), you should enter this value here, as it allows Nu-
endo to compensate for that delay during playback. You 
can also let the delay value be determined by the pro-
gram by right-clicking in the Delay column for the effect 
and selecting “Check User Delay”. Note that you don’t 
have to take the latency of the audio hardware into ac-
count – this is handled automatically by the program.

Send Gain Allows you to adjust the level of the signal being sent to 
the external effect.

Return Gain Allows you to adjust the level of the signal coming in from 
the external effect. 
Note however that excessive output levels from an external 
effect device may cause clipping in the audio hardware. 
The Return gain setting cannot be used to compensate for 
this – you have to lower the output level on the effect de-
vice instead.

MIDI Device When you click in this column, a pop-up menu opens 
where you can either disconnect the effect from the as-
sociated MIDI device, select a MIDI device, create a new 
device or open the MIDI Device Manager in Nuendo to 
edit the MIDI device. 
When Studio Manager 2 is installed, you may also select 
an OPT editor to access your external effect.

Used Whenever you insert an external effect into an audio 
track, this column shows a check mark (“x”) to indicate 
that the effect is being used.
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8. When you are done, close the VST Connections win-
dow.

Note that external device ports are exclusive, see 
“Connecting the external effect/instrument” on page 18.

How to use the external effect

If you now click an insert effect slot for any channel and 
look at the effect pop-up menu, you will find the new exter-
nal FX bus listed on the “External Plug-ins” submenu.

When you select it, the following happens:

• The external FX bus is loaded into the effect slot just like a 
regular effect plug-in.

• The audio signal from the channel will be sent to the outputs 
on the audio hardware, through your external effect device and 
back to the program via the inputs on the audio hardware.

• A parameter window appears, showing the Delay, Send Gain 
and Return Gain settings for the external FX bus. You can ad-
just these as necessary while playing back. The parameter 
window also provides the “Measure Effect’s Loop Delay for 
Delay Compensation” button. This is the same function as the 
“Check User Delay” option in the VST Connections window. It 
provides Nuendo with a Delay value to be used for delay com-
pensation. When you have defined a MIDI device for the ef-
fect, the corresponding Device window will be opened. When 
Studio Manager 2 is installed, and you have set up a corre-
sponding OPT editor, this OPT editor will be displayed.

The default parameter window for an external effect

Like any effect, you can use the external FX bus as an in-
sert effect or as a send effect (an insert effect on an FX 
channel track). You can deactivate or bypass the external 
effect with the usual controls.

Setting up external instruments
1. Open the VST Connections window from the Devices 
menu.

2. Open the External Instrument tab and click “Add Ex-
ternal Instrument”.

3. In the dialog that appears, enter a name for the exter-
nal instrument and specify the number of required mono 
and/or stereo returns. If you want to set up a MIDI device 
corresponding to the external instrument, click the Associ-
ate MIDI Device button.
Depending on the type of instrument, a specific number of mono and/or 
stereo return channels is required. When clicking “Associate MIDI De-
vice”, you can use the MIDI Device Manager functions to create a new 
MIDI device. For information about the MIDI Device Manager and user 
device panels see the separate PDF document “MIDI Devices”.

4. Click OK. This adds a new external instrument bus.

5. Click in the Device Port column for the Return Bus 
“Left” and “Right” ports and select the inputs on your audio 
hardware to which you connected the external instrument.

6. If you like, make additional settings for the bus.
These are found in the columns to the right. Note however that you can 
adjust these while actually using the external instrument – which may be 
easier as you can hear the result. You have the following options:

Setting Description

Delay If your hardware device has an inherent delay (latency), 
you should enter this value here. This allows Nuendo to 
compensate for that delay during playback. Note that you 
don’t have to take the latency of the audio hardware into 
account – this is handled automatically by the program.

Return Gain Allows you to adjust the level of the signal coming in from 
the external instrument. 
Note however that excessive output levels from an exter-
nal device may cause clipping in the audio hardware. The 
Return gain setting cannot be used to compensate for 
this – you have to lower the output level on the device in-
stead.
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7. When you are done, close the VST Connections win-
dow.

Note that external device ports are exclusive, see 
“Connecting the external effect/instrument” on page 18.

How to use the external instrument

Once you have set up the external instrument in the VST 
Connections window, you can use it as a VST Instrument. 
Open the VST Instruments window and click on an empty 
instrument slot. In the instrument pop-up menu, your ex-
ternal instrument is listed on the External Instruments sub-
menu:

When you select the external instrument in the VST Instru-
ments window, the following happens:

• A parameter window for the external device is opened auto-
matically. This may either be the Device window, allowing you 
to create a generic device panel, an OPT editor window or a 
default editor. For information about the Device window, the 
MIDI Device Manager and User device panels, see the sepa-
rate PDF document “MIDI Devices”.

• To send MIDI notes to the external instrument, open the out-
put pop-up menu in the Inspector for the corresponding MIDI 
track and select the MIDI device to which the external instru-
ment is connected. This ensures use of delay compensation. 
The instrument will now play any MIDI notes it receives from 
this track and return them to Nuendo through the return chan-
nel(s) you have set up. 

The external instrument will behave like any other VST In-
strument in Nuendo.

About the Favorites buttons
In the VST Connections window, both the External FX tab 
and the External Instruments tab feature a Favorites button.

The Favorites button on the External FX tab

Favorites are device configurations that you can recall at 
any time, like a library of external devices that are not con-
stantly connected to your computer. They also allow you 
to save different configurations for the same device, e.g. a 
multi-effect board or an effect that provides both a mono 
and a stereo mode.

To save a device configuration as a favorite, proceed as 
follows:

• When you have added a new device in the VST Con-
nections window, select it in the Bus Name column and 
click the Favorites button.
A context menu is displayed showing an option to add the selected ef-
fect or instrument to the Favorites.

• You can recall the stored configuration at any time by 
clicking the Favorites button and selecting the device 
name from the context menu.

MIDI Device When you click in this column, a pop-up menu opens 
where you can either disconnect the instrument from the 
associated MIDI device, select a MIDI device, create a 
new device or open the MIDI Device Manager in Nuendo 
to edit the MIDI device. 
When Studio Manager 2 is installed, you may also select 
an OPT editor to access your external instrument.

Used Whenever you insert the external instrument into a VST 
Instrument slot, this column shows a chicanery (“x”) to in-
dicate that the instrument is being used.

Setting Description
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About the “plug-in could not be found” 
message
When you open a project that uses an external effect/in-
strument, you may get a “plug-in could not be found” mes-
sage. This will happen when you remove an external 
device from the VST Connections window although it is 
used in a saved project, or when transferring a project to 
another computer on which the external device is not de-
fined. You may also see this message when opening a 
project last saved with version 3.0 of Nuendo.

In the VST Connections window, the broken connection 
to the external device is indicated by an icon in the Bus 
Name column.

To reestablish the broken connection to the external de-
vice, simply right-click the entry for the device in the Bus 
Name column and select “Connect External Effect”. The 
icon is removed, and you can use the external device 
within your project as before.

Freezing external effects/instruments
Just as when working with regular VST instruments and 
effects, you can also choose to freeze external effects and 
instruments. The general procedure is described in detail 
in the chapters “Audio effects” on page 168 and “VST In-
struments and Instrument tracks” on page 189.

When freezing external instruments or effects, you can ad-
just the corresponding tail value in the Freeze Channel 
Options dialog:

• Use the arrow buttons next to the Tail Size value field to 
set the desired Tail length, i.e. the range after the part 
boundary that should also be included for the freeze. You 
can also click directly in the value field and enter the de-
sired value manually (the maximum value being 60 s).

• When the Tail Size is set to 0s (default), the freezing will 
only take into account the data within the Part boundaries.

! Note that busses set up for external effects or exter-
nal instruments are saved “globally”, i.e. for your par-
ticular computer setup.

! Note that you have to perform Freeze in realtime. Oth-
erwise external effects will not be taken into account.
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Background
The Project window is the main window in Nuendo. This 
provides you with an overview of the project, allowing you 
to navigate and perform large scale editing. Each project 
has one Project window.

About tracks
The Project window is divided vertically into tracks, with a 
timeline running horizontally from left to right. The follow-
ing track types are available:

About parts and events
Events are the basic building blocks in Nuendo. Different 
event types are handled differently in the Project window:

• Video events and automation events (curve points) are always 
viewed and rearranged directly in the Project window.

• MIDI events are always gathered in MIDI parts, containers for 
one or more MIDI events. MIDI parts are rearranged and ma-
nipulated in the Project window. To edit the individual MIDI 
events in a part, you have to open the part in a MIDI editor (see 
“About editing MIDI” on page 364). 

• Audio events can be displayed and edited directly in the Project 
window, but you can also work with audio parts containing sev-
eral events. This is useful if you have a number of events which 
you want to treat as one unit in the project. Audio parts also 
contain information about the time position in the project.

An audio event and an audio part.

Track type Description

Audio For recording and playing back audio events and audio 
parts. Each audio track has a corresponding audio chan-
nel in the mixer.
An audio track can have any number of automation “sub-
tracks” for automating mixer channel parameters, insert 
effect settings etc.

Folder Folder tracks function as containers for other tracks, 
making it easier to organize and manage the track struc-
ture. They also allow you to edit several tracks at the 
same time. See “Folder tracks” on page 105.

FX Channel FX channel tracks are used for adding send effects. Each 
FX channel can contain up to eight effect processors – 
by routing effect sends from an audio channel to an FX 
channel, you send audio from the audio channel to the ef-
fect(s) on the FX channel. Each FX channel has a corre-
sponding channel strip in the mixer – in essence an effect 
return channel. See the chapter “Audio effects” on page 
168.
An FX channel can also have any number of automation 
subtracks for automating mixer channel parameters, ef-
fect settings etc. All FX channel tracks are automatically 
placed in a special FX channel folder in the Track list, for 
easy management.

Group Channel By routing several audio channels to a Group channel, 
you can submix them, apply the same effects to them, 
etc. (see “Using group channels” on page 142).
A Group channel track contains no events as such, but 
displays settings and automation curves for the corre-
sponding Group channel. Each Group channel track has 
a corresponding channel strip in the mixer. In the Project 
window, Group channels are organized as subtracks in a 
special Group Tracks folder. 

Instrument This allows you to create a track for a dedicated instru-
ment, making e.g. VST instrument handling easier and 
more intuitive. Instrument tracks have a corresponding 
channel strip in the mixer. Each instrument track can have 
any number of automation subtracks in the Project win-
dow. However, Volume and Pan are automated from 
within the mixer. It is possible to edit Instrument tracks di-
rectly in the Project window, using the Edit In-Place func-
tion (see “Edit In-Place” on page 381). For more 
information on instrument tracks, see “VST Instruments 
and Instrument tracks” on page 189.

MIDI For recording and playing back MIDI parts. Each MIDI 
track has a corresponding MIDI channel strip in the mixer. 
It’s possible to edit MIDI tracks directly in the Project win-
dow, using the Edit In-Place function (see “Edit In-Place” 
on page 381).
A MIDI track can have any number of automation “sub-
tracks” for automating mixer channel parameters, insert 
and send effect settings etc. 

Marker The Marker track displays markers which can be moved 
and renamed directly in the Project window (see “Using 
the Marker track” on page 111). A project can have only 
one marker track.

Arranger The Arranger track is used for arranging your project, by 
marking out sections in the project and determining in 
which order they should be played back. See “The Arran-
ger track” on page 98.

Ruler Ruler tracks contain additional rulers, displaying the time-
line from left to right. You can use any number of ruler 
tracks, each with a different display format if you wish. 
See “The ruler” on page 31 for more information about 
the ruler and the display formats.

Transpose The Transpose track allows you to set global key 
changes. A project can only have one transpose track. 
See “The Transpose functions” on page 114.

Video For playing back video events. A project can only have 
one video track.

Track type Description
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Audio handling

When you work with audio files, it is crucial to understand 
how audio is handled in Nuendo:

When you edit or process audio in the project window, 
you always work with an audio clip that is automatically 
created on import or when you record audio. This audio 
clip refers to the audio file on the hard disk that remains 
untouched. This means, that audio editing and processing 
is “non-destructive”, in the sense that you can always 
undo changes or revert to the original versions.

The audio clip does not necessarily refer to just one orig-
inal audio file! If you apply e.g. some processing to a sec-
tion of an audio clip, this will actually create a new audio 
file that contains only the section in question. The pro-
cessing will then be applied to the new audio file only, 
leaving the original audio file unchanged. Finally, the audio 
clip is automatically adjusted, so that it refers both to the 
original file and to the new, processed file. During play-
back, the program will switch between the original file and 
the processed file at the correct positions. You will hear 
this as a single recording, with processing applied to one 
section only. This feature makes it possible to undo pro-
cessing at a later stage, and to apply different processing 
to different audio clips that refer to the same original file.

The audio event is the object that you place on a time po-
sition in Nuendo. If you make copies of an audio event and 
move them to different positions in the project, they will 
still all refer to the same audio clip. Furthermore, each au-
dio event has an Offset value and a Length value. These 
determine at which positions in the clip the event will start 
and end, i.e. which section of the audio clip will be played 
back by the audio event. For example, if you resize the au-
dio event, you will just change its start and/or end position 
in the audio clip – the clip itself will not be affected.

An audio region is a section within a clip with a length 
value, a start time, and a snap point. Audio regions are 
shown in the pool and are best created and edited in the 
Sample Editor. 

If you want to use one audio file in different contexts, or 
if you want to create several loops from one audio file, you 
should convert the corresponding regions of the audio clip 
to events and bounce them into separate audio files. This is 
necessary since different events that refer to the same clip 
access the same clip information. 
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Window Overview

The Track list
The Track list displays all the tracks used in a project. It 
contains name fields and settings for the tracks. Different 
track types have different controls in the Track list. To see 
all the controls you may have to resize the track in the Track 
list (see “Resizing tracks in the Track list” on page 35).

• The Track list area for an audio track:

The Project overview

The event display, showing audio parts and 
events, MIDI parts, automation, markers, etc.

The Inspector

The rulerThe info line The toolbar

 The Track list with 
various track types

Mute & Solo
Record Enable 
Monitor buttonsTrack name

Lane Dis-
play Type

Show/hide 
automation

Indicates whether effect sends, EQ or insert 
effects are activated for the track. Click to bypass.

Musical/Linear 
time base

Lock track 
button

Automation Read/Write buttons

Edit chan-
nel settings

Track activity 
indicator

Freeze Audio 
Track
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• The Track list area for an automation subtrack (opened 
by clicking the Show/Hide Automation button on a track):

• The Track list area for a MIDI track:

The Inspector
The area to the left of the Track list is called the Inspector. 
This shows additional controls and parameters for the track 
you have selected in the Track list. If several tracks are se-
lected (see “Handling tracks” on page 38), the Inspector 
shows the setting for the first (topmost) selected track.

To hide or show the Inspector, click the Inspector icon in 
the toolbar.

The Inspector icon.

• For most track classes, the Inspector is divided into a 
number of sections, each containing different controls for 
the track. You can hide or show sections by clicking on 
their respective names.
Clicking the name for a hidden section brings it into view and hides the 
other sections. [Ctrl]/[Command]-clicking the section name allows you 
to hide or show a section without affecting the other sections. Finally, 
[Alt]/[Option]-clicking a section name shows or hides all sections in the 
Inspector.

• You can also use key commands to show different In-
spector sections.
These are set up in the Key Commands dialog, see “Setting up key com-
mands” on page 518.

Hiding a section does not affect its functionality.
In other words, if you have set up a track parameter or activated an effect 
for example, your settings will still be active even if you hide the respec-
tive Inspector section.

Which sections are available in the Inspector depends on 
the selected track.

Please note that not all Inspector tabs are shown by 
default. You can show/hide Inspector sections by right-
clicking on an Inspector tab and activating/deactivating 
the desired option(s).
Make sure you right-click on an inspector tab and not on the empty area 
below the Inspector, as this will open the Quick context menu instead.

The Inspector Setup context menu.

Automation Read/Write buttons

Automation parameter 
(click to select parameter)

Append automation track

Mute Lock track 
button

Record Enable & 
Monitor buttonsTrack name

MIDI OutputBank Patch MIDI channel

Drum map (Nuendo Expansion Kit only), 
Lock track and Lane display type

Read/Write 
buttons

Edit channel settings

Mute & Solo

Effect sends and insert effects 
indicators and bypass

Edit In-Place

Track activity 
indicator
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Sections

The Inspector contains the controls that can be found on 
the Track list, plus some additional buttons and parame-
ters. In the table below, these additional settings and the 
available sections are listed. Which sections are available 
for which track type is described in the following sections.

Parameter Description

Auto Fades 
Settings button

Opens a dialog in which you can make separate Auto 
Fade settings for the track. See “Making Auto Fade set-
tings for a separate track” on page 97.

Edit Channel 
settings

Opens the Channel Settings window for the track, allow-
ing you to view and adjust effect and EQ settings, etc. 
See “Using Channel Settings” on page 137.

Volume Use this to adjust the level for the track. Changing this 
setting will move the track’s fader in the mixer window, 
and vice versa. See “Setting volume in the mixer” on page 
132 to learn more about setting levels.

Pan Use this to adjust the panning of the track. As with the 
Volume setting, this corresponds to the Pan setting in the 
mixer.

Delay This adjusts the playback timing of the audio track. Posi-
tive values delay the playback while negative values 
cause the track to play earlier. The values are set in milli-
seconds.

Input Routing This lets you specify which Input bus or MIDI input the 
track should use (see “Setting up busses” on page 11 for 
information about Input busses).

Output Routing Here you decide to which output the track should be 
routed. For audio tracks you select an output bus (see 
“Setting up busses” on page 11) or Group channel, for 
MIDI tracks you select a MIDI output.

Inserts section Allows you to add insert effects to the track, see the 
chapter “Audio effects” on page 168. The Edit button at 
the top of the section opens the control panels for the 
added insert effects.

Equalizers 
section

Lets you adjust the EQs for the track. You can have up to 
four bands of EQ for each track, see “Making EQ set-
tings” on page 138. The Edit button at the top of the sec-
tion opens the Channel Settings window for the track. 

Equalizer Curve 
section

Lets you adjust the EQs for the track graphically, by click-
ing and dragging points in a curve display.

Sends section Allows you to route an audio track to one or several FX 
channels (up to eight), see the chapter “Audio effects” on 
page 168. For MIDI tracks, this is where you assign MIDI 
send effects. The Edit button at the top of the section 
opens the control panel for the first effect in each FX 
channel.

Studio Sends The Studio Sends are used to route cue mixes to Control 
Room Studios. For a detailed description of Studios and 
Studio Sends, see the chapter “Control Room” on page 
151.

Surround Pan When the Surround Panner is used for a track, this is also 
available in the Inspector. For further information, see 
“Using the Surround Panner” on page 208.

Channel section Shows a duplicate of the corresponding mixer channel 
strip. The channel overview strip to the left lets you acti-
vate and deactivate insert effects, EQs and sends.

Notepad section This is a standard text notepad, allowing you to jot down 
notes about the track. 
If you have entered any notes about a track, the icon next 
to the “Notepad” heading will light up to indicate this. 
Moving the pointer over the icon will display the Notepad 
text in a tool tip.

Network 
section

This contains controls related to the Network functions of 
the program. For further information, see the separate 
PDF document “Networking”.

User Panel Here you can display device panels, e.g. for external MIDI 
devices, audio track panels or VST insert effect panels. 
For information on how to create or import MIDI device 
setups, see the separate PDF document “MIDI Devices”.

Quick Controls Here you can configure quick controls, e.g. to use remote 
devices. See the chapter “Track Quick Controls” on 
page 338.

Parameter Description
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Audio tracks

For audio tracks, all settings and sections listed above are 
available.

• User Panels for audio tracks can display panels for 
channel controls (such as input phase or the linked panner 
option) or for VST effects currently inserted in the channel.

• User Panels for audio tracks  are accessed by clicking 
the Open Device Panels button (found in the topmost In-
spector section, next to the Read/Write buttons). 
This opens up a menu listing all the device panels available for the audio 
track. If panels have not been created yet, you will see “Setup” panels in 
the menu. Double-cicking on one of these will open the Device window 
for that audio track. Here you will be able to create user panels for any 
parameter of the audio track, including VST effects that have been in-
serted. For more information on how to create device and user panels, 
see the separate PDF document “MIDI Devices”.

The device panel browser.

Once panels have been created, they are available from 
the User Panel section of the Inspector. Click on the arrow 
button at the top right of the User Panel section to view 
the available panels.

The User Panel menu in the Inspector

MIDI tracks

When a MIDI track is selected, the Inspector contains a 
number of additional sections and parameters, affecting the 
MIDI events in real time (e.g. on playback). Which sections 
are available for MIDI tracks is described in the chapter 
“MIDI realtime parameters and effects” on page 342.

Marker tracks

When the marker track is selected, the Inspector shows 
the marker list. See “The Marker window” on page 110.

Video tracks

When a video track is selected, the Inspector contains a 
lock button for locking the track (see “Locking events” on 
page 50), a Mute button for interrupting video playback 
and two settings for how the video thumbnails are shown: 
Show Frame Numbers and Snap Thumbnails (see 
“Playing back a video file” on page 472). 

Video tracks make use of the Notepad and Network In-
spector tabs.

! The Inspector can only display inspector sized user 
panels. Panels of larger sizes will not be available in 
the Inspector.
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Folder tracks

When a folder track is selected, the Inspector shows the 
folder and its underlying tracks, much like a folder struc-
ture in the Windows Explorer or Mac OS X Finder.

You can click one of the tracks shown under the folder 
in the Inspector to have the Inspector show the settings 
for that track.
This way, you don’t have to “open” a folder track to make settings for 
tracks within it.

Here, an audio track within the folder is selected.

FX channel tracks

When an FX channel track is selected, the following con-
trols and sections are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Equalizer Curve section.
• Sends section.
• Studio Sends section.
• Surround Pan section.
• Channel section.
• Notepad section.

FX channel folder tracks

FX channel tracks are automatically placed in a special 
folder, for easier management. When this folder track is 
selected, the Inspector shows the folder and the FX chan-
nels it contains. You can click one of the FX channels 

shown in the folder to have the Inspector show the set-
tings for that FX channel – this way you don’t have to 
“open” a folder track to access the settings for the FX 
channels in it.

Group channel tracks

When a Group channel track is selected, the following 
controls and sections are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Equalizer Curve section.
• Sends section.
• Studio Sends section.
• Surround Pan section.
• Channel section.
• Notepad section.

Group channel folder tracks

Just like FX channel tracks, all Group channel tracks are 
placed in a separate folder – when this is selected, the In-
spector shows the folder and the Group channels it con-
tains. You can click one of the Group channels shown in 
the folder to have the Inspector show the settings for that 
Group channel – this way, you don’t have to “open” a folder 
track to access the settings for the Group channels in it.

Ruler tracks

For ruler tracks, the Inspector isn’t used.

Transpose track

When the transpose track is selected, the following con-
trols and sections are available:

• Mute button.
• Keep Transpose in Octave range.
• Toggle Timebase button.
• Lock button.
• Notepad section.
• Network section.

The Transpose track controls are described in detail in the 
chapter “The Transpose functions” on page 114.
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The toolbar
The toolbar contains tools and shortcuts for opening other 
windows and various project settings and functions:

In addition to these, the toolbar can contain a number 
of other tools and shortcuts, not visible by default. How to 
set up the toolbar and specify which tools should be dis-
played or hidden is described in the section “The Setup 
dialogs” on page 506.

The info line

The info line shows information about the currently se-
lected event or part in the Project window. You can edit al-
most all values on the info line using regular value editing. 
Length and position values are displayed in the format cur-
rently selected for the ruler (see “The ruler” on page 31).

• To hide or show the info line, click the Show Event Info-
line button on the toolbar.

The following elements can be selected for display and 
editing on the info line:

• Audio events.
• Audio parts.
• MIDI parts.
• Video events.
• Markers.
• Automation curve points.
• Transpose events.
• Arranger events.

When several elements are selected

• If you have several elements selected, the info line will 
show information about the first item in the selection. The 
values will be shown in yellow to indicate that several ele-
ments are selected.

• If you edit a value on the info line, the value change is 
applied to all selected elements, relatively to the current 
values. 
If you have two audio events selected and the first is one bar long and 
the other two bars long, the info line shows the length of the first event 
(one bar). If you now edit this value to 3 bars in the info line, the other 
event will be resized by the same amount – and will thus be 4 bars long.

• If you press [Ctrl]/[Command] and edit on the info line, 
the values will be absolute instead. In our example above, 
both events would be resized to 3 bars. Note that [Ctrl]/
[Command] is the default modifier key for this – you can 
change this in the Preferences (Editing–Tool Modifiers 
page, under the Info Line category).

Active project 
indicator

Show/hide 
Inspector

Show/hide 
info line

Show/hide 
Overview

Open Mixer

Open Pool

Automation mode

Constrain delay compensation (see the chapter “VST 
Instruments and Instrument tracks” on page 189).

Project window tools

Transport controls 
(Previous/Next Marker, Cycle, Stop, Play, and Record)

Snap 
on/off

Snap mode

Grid pop-
up menu

Quantize 
value

Color pop-
up menu

Autoscroll 
on/off

Snap to Zero 
Crossings

Project 
Root key
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Editing Transpose and Velocity for MIDI parts

When one or several MIDI parts are selected, the info line 
contains Transpose and Velocity fields.

• Adjusting the Transpose field transposes the selected 
parts in semitone steps.
Note that this transposition doesn’t change the actual notes in the part – 
it’s just a “play parameter”, affecting the notes on playback. The transpo-
sition you specify for a part on the info line is added to the transposition 
set for the whole track. For more information on transposing, see the 
chapter “The Transpose functions” on page 114.

• Adjusting the Velocity field shifts the velocity for the se-
lected parts – the value you specify is added to the veloci-
ties of the notes in the parts.
Again, this velocity shift only affects the notes on playback, and again, 
the value you specify is added to the Vel.Shift. value set for the whole 
MIDI track in the Inspector.

Getting on-the-fly info with the Arrow tool

If the option “Select Tool: Show Extra Info” is activated in 
the Preferences (Editing–Tools page), a tool tip will be 
shown for the Arrow tool, displaying information depend-
ing on where you point it. For example, in the Project win-
dow event display, the tool will show the current pointer 
position and the name of the track and event you’re point-
ing at.

The ruler

The ruler at the top of the event display shows the time-
line. Initially, the Project window ruler uses the display for-
mat specified in the Project Setup dialog (see “The 
Project Setup dialog” on page 33), as do all other rulers 
and position displays in the project. However, you can se-
lect an independent display format for the ruler by clicking 
the arrow button to the right of it and selecting an option 
from the pop-up menu that appears (you can also bring up 
this pop-up menu by right-clicking anywhere in the ruler).

• The selection you make here affects the ruler, the info 
line and tool tip position values (which appear when you 
drag an event in the Project window).
You can also select independent formats for other rulers and position 
displays. 

! Audio events can also be transposed – see “Real-
time pitch-shifting of audio events” on page 288.

Option Positions and lengths displayed as

Bars+Beats Bars, beats, sixteenth notes and ticks. By default there 
are 120 ticks per sixteenth note but you can adjust this 
with the “MIDI Display Resolution” setting in the Prefer-
ences (MIDI page).

Seconds Hours, minutes, seconds and milliseconds.

Timecode This format displays hours, minutes, seconds and frames. 
The number of frames per second (fps) is set in the 
Project Setup dialog (see “The Project Setup dialog” on 
page 33). You can choose between 24, 25, 29.97 and 
30 fps or 29.97 and 30 dfps (“drop frame”).

Feet+Frames 
16mm

Feet and frames, with 40 frames per foot.

Feet+Frames 
35mm

Feet, frames and 1/4 frames, with 16 frames per foot.

Samples Samples.

User Hours, minutes, seconds and frames, with a user defin-
able number of frames per second. You set the desired 
number of fps in the Preferences (Transport page).

Time Linear When this is selected, the ruler will be linear relative to 
time. This means that if there are tempo changes on the 
Tempo track, the distance between the bars will vary in 
Bars+Beats mode.

Bars+Beats 
Linear

When this is selected, the ruler will be linear relative to 
the meter position – bars and beats. This means that if 
there are tempo changes on the Tempo track, there still 
will be the same distance between bars in Bars+Beats 
mode. If the ruler is set to a time-based mode, the dis-
tance between seconds will vary depending on the 
tempo changes.
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• To set the display format globally (for all windows), use 
the primary display format pop-up on the Transport panel, 
or hold down [Ctrl]/[Command] and select a display for-
mat in any ruler.

• If you use the “Timecode” or “User” options and the op-
tion “Show Timecode Subframes” is activated in the Pref-
erences (Transport page), the frames will also display 
subframes.
There are 80 subframes per frame.

• For the “Feet+Frames” settings, there is an option in the 
Preferences (Transport page) called “Feet’n’Frames 
Count from Project Start”.
When this is activated, time displays and rulers in Feet+Frames format 
will always start with 0’00 at the beginning of the project – regardless of 
any Start offset settings in the Project Setup dialog.

Using multiple rulers – ruler tracks

As described above, the Nuendo Project window contains 
a main ruler at the top of the event display, displaying the 
timeline from left to right.

If needed, you can have several rulers in the Project win-
dow, by adding ruler tracks to the project. Each ruler track 
contains an additional ruler.

• To add a ruler track, select “Add Track” from the Project 
menu and from the submenu that appears, select “Ruler”.
A ruler track showing an additional ruler is added to the Track list.

A ruler track set to the display format “Seconds”.

You can add any number of ruler tracks to a project, and 
position them as needed by dragging them up or down in 
the list. Each of the rulers can show a separate display for-
mat:

• To select a display format for a ruler track, click on its 
name in the track list and select an option from the pop-up 
menu.
The different display formats are described above.

Note that ruler tracks are completely independent from the 
main event display ruler, as well as rulers and position dis-
plays in other windows. This means that:

• Ruler tracks can all have independent display formats.
• Ruler tracks are not affected by the display format setting in 

the Project Setup dialog (see “The Project Setup dialog” on 
page 33).

• Ruler tracks are not affected if you set the display format glo-
bally with the primary time display in the Transport panel.

Ruler tracks are affected by the option “Show Time-
code Subframes” in the Preferences (see above).
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Operations

Creating a new project
You create a new project in the following way:

1. Select “New Project” from the File menu.
A dialog appears, listing a number of project templates, including any 
custom templates you may have created (see “Save as Template” on 
page 488). 

2. Select a template and click OK.
A file dialog appears, allowing you to specify a location for the project 
folder. This will contain all files related to the project. 

3. Select an existing folder or type the name of a new 
one. Click OK.
A Project window appears. The new project will be based on the selected 
template, and include tracks, events and settings from the template.

The Project Setup dialog

General settings for the project are made in the Project 
Setup dialog. This is opened by selecting “Project 
Setup…” from the Project menu.

The following settings are available in the Project Setup 
dialog:

Setting Description

Start The start time of the project. Allows you to have the 
project start at another time than zero. Also used for set-
ting the sync start position when synchronizing Nuendo 
to external devices (see “Setting up Nuendo for external 
sync to timecode” on page 451). The format of this value 
is always in timecode. When you change this setting you 
will be asked whether you want to keep the project con-
tent at its timecode positions. “Yes” means that all events 
will stay at their original timecode positions – i.e. they will 
be moved in relation to the start of the project. “No” 
means that all events keep their position relative to the 
project start. See also the note on Feet+Frames in the 
section “The ruler” on page 31.

Length The length of the project. Nuendo is capable of having 
longer lengths than 24 hours since the timecode includes 
a “day” field. This can be handy when creating projects 
that use “time of day” timecode and cross over the 24 
hour mark. The maximum project length is 10 days.

Frame Rate Used when synchronizing Nuendo with external equip-
ment. If Nuendo is slave, this value is automatically set to 
the frame rate of the incoming sync signal. If Nuendo is 
the master, this determines the frame rate of the sent 
sync signal. See “Setting the Frame Rate” on page 448.

Display Format This is the global display format used for all rulers and 
position displays in the program, except ruler tracks (see 
“Ruler tracks” on page 29). However, you can make inde-
pendent display format selections for the individual rulers 
and displays if you like.
For descriptions of the different display format options, 
see “The ruler” on page 31.

Display Offset Offsets the time positions displayed in the ruler etc., al-
lowing you to compensate for the Start position setting. 
Typically, if you synchronize Nuendo to an external 
source starting at a frame other than zero, you set the 
Start position to this value. However, if you still want the 
display in Nuendo to start at zero, set the Display Offset 
to the same value too.

Bar Offset This works just like “Display Offset” described above, in 
that it offsets the time positions in the ruler by a number 
of bars, allowing you to compensate for the Start position 
setting. The difference is that Bar Offset is only used 
when the “Bars+Beats” display format is selected (see 
“The ruler” on page 31).

Sample Rate The sample rate at which Nuendo records and plays au-
dio.

Pull-up/Pull-
down

When working with film transfers, this option is used to 
synchronize sound and images correctly. This is described 
in detail in the section “Working with film transfers” on 
page 476.

Record Format/ 
File Type

When you record audio in Nuendo, the files that are cre-
ated will be of this resolution and file type. See “Selecting 
a recording file format” on page 67.
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Zoom and view options
Zooming in the Project window is done according to the 
standard zoom techniques, with the following special 
notes:

• When you are using the Zoom tool (magnifying glass), 
the result depends on the option “Zoom Tool Standard 
Mode: Horizontal Zooming Only” in the Preferences (Edit-
ing–Tools page).
If this is activated and you drag a selection rectangle with the Zoom tool, 
the window will only be zoomed horizontally (track height will not change). 
If the option is off, the window will be zoomed both horizontally and verti-
cally.

• When using the vertical zoom sliders, the tracks are 
scaled relatively. 
In other words, if you have made any individual track height adjustments 
(see below), the relative height differences are maintained.

You find the following options are available on the Zoom 
submenu on the Edit menu:

• If the option “Zoom while Locating in Time Scale” is ac-
tivated in the Preferences (Transport page), you can also 
zoom by clicking in the main ruler and dragging up or 
down with the mouse button pressed.
Drag up to zoom out; drag down to zoom in.

• You can zoom the contents of parts and events verti-
cally, using the waveform zoom slider in the top right cor-
ner of the event display.
This is useful when viewing quiet audio passages.

• If you activate the option Quick Zoom in the Prefer-
ences (Editing page), the contents of parts and events will 
not be continuously redrawn when you zoom manually.
Instead, the contents are redrawn once you have stopped changing the 
zoom – activate this if screen redraws are slow on your system.

Stereo Pan Law Decides whether panning should use power compensa-
tion or not (see “About the “Stereo Pan Law” Preference 
(audio channels only)” on page 136).

! While most Project Setup settings can be changed at 
any time, you should select a sample rate once and for 
all when starting with a new project! All audio files 
must be of this sample rate to play back correctly.

Option Description

Zoom In Zooms in one step, centering on the project cursor.

Zoom Out Zooms out one step, centering on the project cursor.

Zoom Full Zooms out so that the whole project is visible. “The whole 
project” means the timeline from the project start to the 
length set in the Project Setup dialog (see above).

Zoom to 
Selection

Zooms in horizontally and vertically so that the current se-
lection fills the screen.

Zoom to 
Selection 
(Horiz)

Zooms in horizontally so that the current selection fills the 
screen.

Zoom to Event This option is available only in the Sample Editor (see 
“Zooming” on page 265).

Zoom In 
Vertical

Zooms in one step vertically.

Zoom Out 
Vertical

Zooms out one step vertically.

Setting Description

Zoom In 
Tracks

Zooms in on the selected track(s) one step vertically.

Zoom Out 
Tracks

Zooms out the selected track(s) one step vertically.

Zoom Selected 
Tracks 

This zooms in vertically on the selected track(s) and min-
imizes the height of all other tracks.

Undo/Redo 
Zoom

These options allow you to undo/redo the last zoom op-
eration.

! To get an approximate reading on the level of the au-
dio events by viewing the waveforms, make sure this 
slider is all the way down. Otherwise, zoomed wave-
forms may be mistaken for clipped audio.

Option Description
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Resizing tracks in the Track list

• You can change the height of an individual track by 
clicking on its lower border in the Track list and dragging 
up or down.
To change the height of all tracks simultaneously, hold down [Ctrl]/
[Command] and resize one of the tracks in this way. If “Snap Track 
Heights” is activated on the Track scale pop-up (see below), the track 
height will change in fixed increments when you resize it.

• You can also change the width of the Track list area, by 
dragging the border between the Track list and the event 
display.

• By default, the controls shown for tracks in the Track list 
will adapt to the track size. This means that when resizing 
a track’s height or width the controls will be placed where 
they best “fit in”.
If you prefer to have the controls in fixed positions, you can deactivate the 
option “Wrap Controls” in the Track Controls settings dialog (see “Cus-
tomizing track controls” on page 507).

• You can decide for each track type what controls 
should be shown in the Track list – see “Customizing 
track controls” on page 507.

• You can use the Track scale pop-up (opened by clicking 
the arrow button above the vertical zoom control) to set the 
number of tracks to view in the current Project window.
The track height will be adjusted to show only the number of tracks speci-
fied on the pop-up menu. By selecting “Zoom N Tracks” from the pop-up 
you can manually set the number of tracks to fit in the current Project win-
dow.

• Tracks can also be divided vertically in lanes – see 
“Editing in Lane Display mode” on page 51.

The Enlarge Selected Track option

When this option is activated on the Edit menu (or in the 
Preferences, Editing–Project & Mixer page), the selected 
track is enlarged automatically. This is useful if you are 
stepping through the tracks in the track list, to check or 
edit the settings. The tracks will revert to the size they had 
before when they are deselected. You can adjust the size 
directly in the Track list if the default enlargement factor 
does not suit you. 

While this is the program behavior you will want in most 
cases, it may be a disadvantage when changing the track 
height you started out with for one or more tracks (i.e. their 
“original” height, before "Enlarge Selected Track" was ac-
tivated). As soon as you try to resize a track, it is selected 
and automatically enlarged. Instead of turning off “Enlarge 
Selected Track”, resizing the desired track(s) and the acti-
vating “Enlarge Selected Track” again, you can resize a 
track in the Track list without selecting it.

1. Move the mouse pointer over the lower border of the 
(unselected) track you want to resize.
The mouse pointer turns into a divider symbol.

2. Hold down [Alt]/[Option] and drag the lower border of 
the track until it reaches the desired height.
Now, when you select this track, (and “Enlarge Selected Track” is acti-
vated), it will be enlarged. It will revert to the changed size, when you se-
lect a different track.

! This behavior is different when “Enlarge Selected 
Track” is activated on the Edit menu (see below).
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Zoom presets and Cycle markers

The pop-up menu to the left of the horizontal zoom control 
allows you to select, create and organize zoom presets. 
These are useful if you want to toggle between different 
zoom settings (e.g. one where the whole project is dis-
played in the project window and another with a high 
zoom factor for detailed editing). With this pop-up menu, 
you can also zoom in on the area between cycle markers 
in the project.

The upper part of the menu lists the zoom presets:

• To store the current zoom setting as a preset, select 
Add from the pop-up menu.
A dialog appears, allowing you to type in a name for the preset.

• To select and apply a preset, select it from the pop-up 
menu.

• The “Zoom Full” preset is always available. Selecting 
this option zooms out so that the whole project is visible. 
“The whole project” means the timeline from the project 
start to the length set in the Project Setup dialog (see 
“The Project Setup dialog” on page 33).

• If you want to delete a preset, select “Organize…” from 
the pop-up menu.
In the dialog that appears, select the preset in the list and click the De-
lete button. The preset is removed from the list.

• If you want to rename a preset, select “Organize…” 
from the pop-up menu.
In the dialog that appears, select the desired preset in the list and click 
the Rename button. A second dialog opens, allowing you to type in a 
new name for the preset. Click OK to close the dialogs.

The middle part of the pop-up lists any cycle markers you 
have added in the project:

• If you select a cycle marker from this menu, the event 
display is zoomed in to encompass the marker area (see 
“Zooming to cycle markers” on page 112).

• You cannot edit the cycle markers in this pop-up menu. 
For information on editing markers, see “The Marker win-
dow” on page 110.

The Zoom history

Nuendo maintains a history of recent zoom stages, allow-
ing you to undo and redo zoom operations. This way you 
can zoom in several steps and then easily go back to the 
zoom stage at which you started.

There are two ways to invoke Undo Zoom and Redo 
Zoom:

• Use the items on the Zoom submenu on the Edit menu.
You can also assign key commands for these.

• Double-click with the Zoom tool (magnifying glass) to 
Undo Zoom.
Press [Alt]/[Option] and double-click to Redo Zoom.

Click here… …to open the context menu.

! Zoom presets are global for all projects, i.e. they are 
available in all projects you open or create.

! Only the cycle markers you create in the current 
project are available on the menu.
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Adjusting how parts and events are shown

The Preferences on the File menu (the Nuendo menu, un-
der Mac OS X) contains several settings for customizing 
the display in the Project window.

The Event Display page contains common settings for all 
track types:

The Event Display–Video page contains settings for video 
events:

The Event Display–Audio page contains settings for audio 
events:

The Event Display–MIDI page contains settings for MIDI 
parts:

Option Description

Colorize Event 
Background

Determines whether the backgrounds or “contents” (wave-
forms, etc.) of parts and events will be colorized. See 
“Handling tracks” on page 38.

Show Event 
Names

Determines whether the names of parts and events should 
be shown in the Project window.

Transparent 
Events

When this is activated, events and parts will be transparent, 
showing the waveforms and MIDI events only.

Show Data on 
Small Track 
Heights

If this is activated, the contents of events and parts will be 
shown, even if the height of a track is very small.

Option Description

Show Video 
Thumbnails

When this is activated, thumbnail frames of the video 
contents are shown on the Video track.

Video Cache 
Size

This determines how much memory is available for video 
thumbnails. If you have long video clips and/or work with 
a large zoom factor (so that a lot of frames are shown in 
the thumbnails), you may have to raise this value.

Option Description

Interpolate 
Audio Images

If the option is deactivated, single sample values are 
drawn as “steps”. If the option is activated they are inter-
polated to form “curves”.

Wave Image 
Style

Determines whether audio waveforms should be dis-
played as solid images, frames or “inverted” images 
(solid+frame). This selection affects all waveform images 
in the Project window, Sample Editor and Audio Part Ed-
itor.
Note that the “Framed” and “Solid and Framed” styles 
are more demanding for the computer. If the system feels 
slower in these modes, please switch back to “Solid” 
wave image style.

Show Event 
Volume Curves 
Always

If this is activated the “volume curves” created with the 
volume and fade handles are always shown – if not, the 
curves are only shown for selected events.

Fade Handles 
always on top

When this option is activated, the fade handles stay at 
the top of the event, and vertical help lines indicate the 
exact end or start points of fades.

Thick Fade 
Lines

If this option is activated, the fade lines and volume 
curves are thicker, increasing their visibility.

Show 
Waveforms

Determines whether audio waveforms should be shown 
at all.

Background 
Color 
Modulation

When this is activated, the backgrounds of audio wave-
forms are displayed in a different way, reflecting the wave-
form dynamics. This is especially useful to get an overview 
when working with small track heights.

Option Description

Default Edit 
Action

Determines which editor should be opened when you 
double-click a MIDI part or select it and press [Ctrl]/
[Command]-[E]: the Key or List editor. 

Part Data 
Mode

Determines if and how events in MIDI parts should be 
shown in the Project window: as score notes, as drum 
notes (Nuendo Expansion Kit only) or as lines. If “No 
Data” is selected, events will not be shown at all. Nuendo 
Expansion Kit only: Note that this setting is overridden for 
tracks with drum maps if the option “Edit as Drums when 
Drum Map is assigned” (see below) is activated.

Show 
Controllers

Governs whether non-note events (controllers, etc.) 
should be shown in MIDI parts in the Project window.

Edit as Drums 
when Drum Map 
is assigned 
(Nuendo Expan-
sion Kit only)

If this is activated, parts on MIDI tracks with drum maps 
assigned will be shown with drum note symbols in the 
Project window. Also, the parts will automatically open in 
the Drum editor when double-clicked (overriding the De-
fault Edit Action setting above).

Note Name 
Style

Determines how MIDI note names (pitches) should be 
displayed in editors, etc.

Option Description
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Zooming and navigating in the overview line
By clicking the Show Overview button on the toolbar, an 
extra pane appears under the toolbar; the project overview 
line. 

Show Overview button

In the overview line, events and parts on all tracks are dis-
played as boxes. You can use the overview line to zoom in 
or out, and for navigating to other sections of the project. 
This is done by moving and resizing the track view rectan-
gle in the overview line:

• The track view rectangle indicates the section of the 
project currently displayed in the event display.

• You zoom in or out horizontally by resizing the rectangle.
Resize it by dragging the edges of the rectangle.

• You can drag the track view rectangle to view other 
sections of the project.
This can also be done by clicking anywhere in the upper part of the over-
view – the track view rectangle will be moved to where you clicked. The 
number of tracks shown will not change.

Handling tracks
To add a track to the project, select “Add Track” from the 
Project menu and select a track type from the submenu 
that appears. The new track is added below the currently 
selected track in the Track list.

• The items on the “Add Track” submenu are also avail-
able on the Quick menu.
This is accessed by right-clicking in the Track list.

• If you select Audio, MIDI, Group Channel or Instrument 
from the Add Track submenu, a dialog opens, allowing 
you to insert several tracks in one go.
Just enter the desired number of tracks in the value field.

• For audio and group channel tracks, the channel config-
uration – mono, stereo or a surround configuration – can 
be set in the Configuration pop-up.

• The Browse Sounds option in the Add Track dialog is 
described in the chapter “Track Presets” on page 327.

• In the Preferences (Editing–Project & Mixer page, you 
can find the option “Auto Track Color Mode”.
This offers you several options for automatically assigning colors to 
tracks that are added to the project.

Once you have created tracks, you can manipulate and re-
arrange them in various ways:

• To rename a track, double-click in the name field and 
type in a new name.
If you hold down any modifier key when pressing [Return] to close the 
name field, all events on the track will get the name you entered.

The track view rectangle
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• To select a track, click on it in the Track list.
A selected track is indicated by a light gray color in the Track list.

It is possible to select several tracks, by pressing [Ctrl]/[Command] and 
clicking them. To select a continuous range of tracks, use [Shift]-clicking.

• To move a track, click and drag it up or down in the list.

• To duplicate a track, complete with all contents and 
channel settings, right-click in the Track list and select 
“Duplicate tracks” from the context menu, or select “Dupli-
cate tracks” from the Project menu.
The duplicated track will appear below the original track.

• You can select a default color for a track by activating 
“Show Track Colors” above the Track list and selecting a 
color from the Color pop-up menu on the toolbar. This 
color will be used for all events on the track and will also 
be shown in the Mixer. You can override the default track 
color for individual events and parts by using the Color 
tool or the Color Selector pop-up menu.
The option “Colorize Event Background” in the Preferences dialog (Event 
Display page) determines whether the backgrounds or waveforms of 
events will be colorized.

• To remove a track, right-click on it in the Track list and 
select “Remove Selected Tracks” from the context menu.
You can also remove multiple selected tracks, by selecting “Remove Se-
lected Tracks” either from the Project menu or from the context menu. 
Furthermore, you can remove all tracks not containing any events by se-
lecting “Remove Empty Tracks” from the Project menu.

• To change the track height of an individual track, click 
on its lower border in the Track list and drag up or down, 
see “Resizing tracks in the Track list” on page 35.

Note that you can also automatically enlarge the se-
lected track, see “The Enlarge Selected Track option” on 
page 35.

Disabling tracks

Tracks can be disabled by selecting “Disable Track” from 
the Track list context menu. Disabling a track is similar to 
muting it (see “Muting events” on page 50), since a dis-
abled track will not be played back. However, disabling a 
track not only “zeroes” the output volume from the track, 
but actually shuts down all disk activity for it. See “About 
track disable/enable” on page 62 for more information.

Track folding

On the Project menu you will find the Track Folding sub-
menu, allowing you to quickly show, hide or invert what is 
displayed in the Project window event display. This en-
ables you for example to divide the project into several 
parts (by creating several folder tracks for the different 
project elements) and showing/hiding their contents by 
selecting a menu function (or using a key command). You 
can also fold in automation subtracks this way. The follow-
ing options are available:

• Toggle Selected Track
When you select this menu option, the fold state of the selected track is 
reversed, i.e. if the track was folded in (its elements (subtracks) were hid-
den), it is now unfolded (all subtracks displayed) and vice versa.

• Fold Tracks
Select this menu option to fold in all open folder tracks in the Project win-
dow. Please note that the exact behavior of this function depends on the 
“Deep Track Folding” setting in the Preferences, see below.

• Unfold Tracks
Select this menu option to unfold all folder tracks in the Project window. 
Please note that the exact behavior of this function depends on the 
“Deep Track Folding” setting in the Preferences, see below.

• Flip Fold States
Select this menu option to flip the fold states of the tracks in the Project 
window. This means that all tracks that were folded in will be unfolded 
and all unfolded tracks will be folded in, respectively.

You can assign key commands for these menu options 
in the Key Commands dialog (Project category).

In the Preferences (Editing–Project & Mixer page), you can 
find the following option affecting the track folding behavior:

• Deep Track Folding
When this is activated, any folding settings you make in the Track Fold-
ing submenu of the Project menu also affect the sub-elements of the 
tracks, i.e. if you fold in a folder track which contains 10 audio tracks 5 of 
which have several automation subtracks open, all these audio tracks 
within the folder track will be folded in as well.

This track is selected.
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Dividing the Track list

It is possible to divide the Track list into two parts. Both 
sections will have independent zoom and scroll controls (if 
needed), but resizing the window vertically will affect the 
lower section only (if possible). This is useful if you’re 
working with a video track along with multi-track audio for 
example. This way, you can place the video track in the 
upper Track list, letting you scroll the audio tracks sepa-
rately in the lower Track list, referencing them against the 
video track.

• To divide the Track list, click the “Divide Track List” but-
ton in the top right corner of the Track list.

The “Divide Track List” button.

• To revert to a single Track list, click the button again.

When the Track list is divided into two parts, the following 
applies:

• If you add tracks from the Add Track submenu of the 
Project menu, Video tracks, Marker tracks and Arranger 
tracks will automatically be placed in the upper part of the 
Track list.
If the Track list already contains tracks of the type Video, Marker or Ar-
ranger, these will automatically be moved to the upper part when you di-
vide the Track list. All other types of tracks will be placed in the lower part.

• If you add tracks from the context menu invoked by 
right-clicking in the Track list, tracks will be added to the 
part of the Track list in which you click.

• You can move any type of track from the lower Track list 
to the upper and vice versa by right-clicking it in the Track 
list and selecting “Toggle Track List” from the context menu.

• You can resize the upper part by clicking and dragging 
the divider between the Track lists.

Switching between musical and linear time base

Tracks can be either musical (tempo) or linear (time) based.

• On a track using linear time base, the events will be po-
sitioned on specific time positions – changing the play-
back tempo will not affect the time position of events.

• On a track using musical time base, the positions of 
events are represented as meter values (bars, beats, 1/16th 
notes and ticks, with 120 ticks per 1/16th note). If you 
change the playback tempo, the events will play back at an 
earlier or later time.

• In the Preferences (Editing page), you can find the op-
tion “Default Track Time Type”.
This allows you to specify the default track time type for new tracks (Au-
dio, Group/FX, MIDI and Marker tracks). When you change this setting, 
all new tracks will use the selected time type. You can choose between 
“Musical”, “Time Linear” and “Follow Transport Main Display”. Selecting 
“Musical” will cause all added tracks to be set to musical time type. 
When you select “Time Linear”, all new tracks will use linear time base. 
The third option uses the primary time format setting on the Transport 
panel. When this is set to “Bars+Beats”, tracks with musical time base 
will be added. When this is set to any of the other options (Seconds, 
Timecode, Samples, etc.), all new tracks will use linear time base.

Whether to use musical or linear time base depends on 
the type of project and recording situation. You can always 
change this setting individually for each track, by clicking 
the musical/linear time base button in the Inspector or 
Track list. Musical time base is indicated by a note symbol, 
while linear time base is indicated by a clock symbol.

For more information about tempo changes, see “Back-
ground” on page 415.

! Internally, events on musical time based tracks use the 
same high precision for positioning (64 bit floating 
point values) as linear time based events. However, 
switching between linear and musical time base re-
sults in a very small loss of precision (introduced by 
the mathematical operations used for scaling values in 
the two different formats). Therefore you should avoid 
switching repeatedly between the two modes.

Linear time base selected

Musical time base selected
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Adding events to a track
There are a number of ways to add events to a track:

• By recording (see “Basic recording methods” on page 
65).
This is possible for audio and MIDI tracks.

• By selecting “Audio File…” or “Video File…” from the 
Import submenu on the File menu.
This opens a file dialog, allowing you to locate the file you wish to import. 
When you import a file this way, a clip is created for the file and an event 
that plays the whole clip is inserted on the selected track, at the position 
of the project cursor.
You can also import MIDI files by using the Import submenu, but this 
works in a slightly different way (see “Exporting and importing standard 
MIDI files” on page 498).

• By grabbing audio CD tracks and converting them to au-
dio files (see “Importing audio CD tracks” on page 491).

• By importing only the audio portion of a video file and 
converting it to an audio file (see “Extracting audio from a 
video file” on page 472).

• By using Copy and Paste on the Edit menu.
This allows you to copy all kinds of events between projects. You can 
also copy events within the project, from the Audio Part Editor or Sample 
Editor.

• By drawing.
Some types of events (markers and automation events) can be drawn di-
rectly into the Project window. For audio and MIDI tracks, you can draw 
parts (see “Creating parts” on page 42).

• By dragging files and dropping them on the track at the 
desired position.
You can create events by dragging and dropping from the following lo-
cations:

• The desktop.
• The MediaBay.
• The Pool.
• A library (a Pool file that is not attached to a project).
• The “Find media” dialog.
• The Project window of another open project.
• The Audio Part Editor of any open project.
• The Sample Editor of any open project – press [Ctrl]/[Com-

mand] and drag to create an event of the current selection, or 
click in the left column of the region list and drag to create an 
event from a region.

While you drag the clip in the Project window, its position will be indi-
cated by a marker line and a numerical position box. See also “By using 
drag and drop” on page 302.

Audio file import options

When you are importing audio files there are a number of 
options concerning how the files should be treated by Nu-
endo: 

• You can choose to copy the file into the audio folder of the 
project and have the project make reference to the copied file 
rather than the original file. This helps you keep your project 
“self-contained”.

• You can choose to split stereo and multi-channel files into a 
number of mono files.

• Furthermore, you may want all files in the project to have the 
same sample rate and sample size (resolution).

The Preferences (Editing–Audio page) contains a setting 
that lets you decide which options, if any, to use. Select 
the desired option on the “On Import Audio Files” pop-up:

• Open Options Dialog.
An Options dialog appears when you import, allowing you to select 
whether you want to copy the files to the Audio folder and/or convert them 
to the project settings. Note:
– When importing a single file of a format other than the project settings, 
you can specify which properties (sample rate and/or resolution) should be 
changed.
– When importing multiple files at the same time, you can select to convert 
the imported files automatically if necessary, i.e. if the sample rate is differ-
ent than the project’s or the resolution is lower than the project setting.
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• Use Settings.
No Options dialog will appear when you import. Instead, you can choose 
to make any of the options below the pop-up the standard action(s). Ac-
tivate any number of the following options to have them performed auto-
matically each time you import audio files:

Creating parts

Parts are containers for MIDI or audio events. If you record 
MIDI, a MIDI part is automatically created, containing the 
recorded events. You can also create empty audio or MIDI 
parts and later add events to them. There are two ways to 
do this:

• Draw a part on a MIDI or audio track with the Pencil tool.
You can also draw parts by pressing [Alt]/[Option] and using the Arrow 
tool.

• Double-click with the Arrow tool on a MIDI or audio 
track, between the left and right locator.

To add events to a MIDI part, you use the tools and func-
tions in a MIDI editor (see “The Key Editor – Overview” on 
page 366). Adding events to audio parts is done in the 
Audio Part Editor (see “Window overview” on page 291) 
by pasting or by using drag and drop.

• You can also gather existing audio events into a part, by 
using the “Events to Part” function on the Audio menu.
This creates an audio part containing all selected audio events on the 
same track. To remove the part and make the events appear as indepen-
dent objects on the track again, select the part and use the “Dissolve 
Part” function on the Audio menu.

Auditioning audio parts and events
Audio parts and events can be auditioned in the Project 
window with the Speaker tool:

1. Select the Play tool.
Note that the Play tool and the Scrub tool share the same tool button. If 
the tool icon on the toolbar doesn’t show a speaker symbol, first click on 
the icon to select it, then click again and select “Play” from the pop-up 
menu that appears.

2. Click where you want playback to start, and keep the 
mouse button pressed.
Only the track on which you click is played back, starting at the click po-
sition. 

3. Release the mouse button to stop playback.

Scrubbing
The Scrub tool allows you to locate positions in the audio 
by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.
Note that the Play tool and the Scrub tool share the same tool button. If 
the tool icon on the toolbar doesn’t show a “scrub symbol”, first click on 
the icon to select it, then click again and select “Scrub” from the pop-up 
menu that appears.

2. Click at the desired position and keep the mouse but-
ton pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played back. 
The speed and pitch of the playback depend on how fast you move the 
pointer.

Option Description

Copy Files to 
Working 
Directory

If files are not already in the project’s audio folder they are 
copied there before being imported.

Convert and 
Copy to Project 
If Needed

If files are not already in the project’s audio folder they are 
copied there before being imported. Furthermore, if the 
files have a different sample rate or a lower resolution 
than the project settings, they are automatically con-
verted.

Split multi 
channel files

If you import a multi-channel audio file (including two-
channel stereo files), it will be split into a number of mono 
files – one for each channel – which are placed on sepa-
rate, automatically created mono tracks.

! When auditioning, audio will be routed directly to the 
Control Room, if the Control Room is activated. 
When the Control Room is deactivated, the audio 
will be routed to the default output bus, bypassing 
the audio channel’s settings, effects and EQs.
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You can adjust the responsiveness of the Scrub function 
in the Preferences (Transport–Scrub page).

It is also possible to “scrub” the whole project with the 
Jog wheel on the Transport panel. 
See “Project scrubbing – the Jog Wheel” on page 62.

• Note that scrubbing can be quite a burden on your sys-
tem. To avoid playback problems, you will find the “CPU 
Saving Scrub Mode” option in the Preferences (Trans-
port–Scrub page).
When you activate this option, scrubbing will be less demanding on the 
processor. This can be very useful when scrubbing in a large project, 
where the “normal” scrub behavior leads to processing overloads. When 
“CPU Saving Scrub Mode” is activated, the effects are disabled for 
scrubbing and the resampling quality is lower.

Editing parts and events
This section describes techniques for editing in the Project 
window. If not explicitly stated, all descriptions apply to both 
events and parts, even though we use the term “event” for 
convenience.

When you are using the tools for editing, you can in 
many cases get additional functions by pressing modifier 
keys (e.g. pressing [Alt]/[Option] and dragging with the 
Arrow tool creates a copy of the dragged event). 
On the following pages, the default modifier keys are described – you 
can customize these in the Preferences (Editing–Tool Modifiers page), 
see “Setting up tool modifier keys” on page 524.

Selecting events

Selecting events is done using any of the following 
methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

• Select all events on a track by right-clicking in its Track 
list and selecting “Select All Events” from the pop-up 
menu that appears.

• You can also use the arrow keys on the computer key-
board to select the closest event to the left, right, above or 
below.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several events.

• If the option “Auto Select Events under Cursor” is acti-
vated in the Preferences (Editing page), all events on the 
selected track(s) that are “touched” by the project cursor 
are automatically selected.
This can be helpful when rearranging your project, since it allows you to 
select whole sections (on all tracks) by selecting all tracks and moving 
the project cursor.

• It is also possible to select ranges, regardless of the 
event and track boundaries.
This is done using the Range Selection tool (see “Range editing” on page 
52).

Option Description

All Selects all events in the Project window.

None Deselects all events.

Invert Inverts the selection – all selected events are dese-
lected and all events that were not selected are se-
lected instead.

In Loop Selects all events that are partly or wholly between 
the left and right locator.

From Start 
to Cursor

Selects all events that begin to the left of the project 
cursor.

From Cursor 
to End

Selects all events that end to the right of the project 
cursor.

Equal Pitch These are available in the MIDI Editors (see “Selec-
ting notes” on page 372).

Select Controllers
in Note Range

This is available in the MIDI Editors (see “Selecting 
controllers within the note range” on page 372).

All on Selected 
Tracks

Selects all events on the selected track.

Select Event This is available in the Sample Editor (see “Window 
overview” on page 260).

Left/Right Selection 
Side to Cursor

These two functions are only used for range selection 
editing (see “Creating a selection range” on page 52).

! Note that these functions work differently when the 
Range Selection tool is selected (see “Creating a 
selection range” on page 52).

Option Description
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• Note that in the Preferences (Editing page), you can 
find the option “Use Up/Down Navigation Commands for 
selecting Tracks only”.
By default, tracks are selected with the up/down arrow keys on the com-
puter keyboard. However, these are also used for selecting events (see 
above) which can lead to confusing results in some cases. Since track se-
lection is a most vital operation in both editing and mixing, you have the op-
tion to use the navigation controls for track selection only. The following 
applies:

• When this option is deactivated and no event/part is selected 
in the Project window, the up/down arrow keys on the com-
puter keyboard are used to step through the tracks in the 
Track list – just as you would expect this to work.

• When this option is deactivated and an event/part is selected in 
the Project window, the up/down arrow keys still step through 
the tracks in the Track list – but on the currently selected track, 
the first event/part will automatically be selected as well. If this 
is not the desired behavior, you have to activate “Use Up/Down 
Navigation Commands for selecting Tracks only”.

• When this option is activated, the up/down arrow keys are 
only used to change the track selection – the current event/
part selection in the Project window will not be altered.

• Also in the Preferences (Editing–Tools page), you can 
find the Cross Hair Cursor options section.
This allows you to display a cross hair cursor when working in the Project 
window and editors, facilitating navigation and editing, especially when 
arranging in large projects. You can set up the colors for the line and the 
mask of the cross hair cursor, and define its width. The cross hair cursor 
works as follows:

• When the Selection tool (or one of its subtools) is selected, 
the cross hair cursor appears when you start moving/copying 
a part/event, or when using the event trim handles.

• When the Pencil tool, the Scissors tool or any other tool that 
makes use of this function is selected, the cross hair cursor ap-
pears as soon as you move the mouse over the event display.

• The cross hair cursor is only available for tools where such a 
function is of any use. The Mute tool for example does not use 
a cross hair cursor, as you have to click directly on an event to 
mute it.

Moving events

To move events in the Project window, use the following 
methods:

• Click and drag to a new position.
All selected events will be moved, maintaining their relative positions. You 
can only drag events to tracks of the same type. If Snap is activated, this 
determines to which positions you can move the events (see “Snap” on 
page 55).
Note also that you can restrict movement to be either horizontal or vertical 
only, by holding down [Ctrl]/[Command] while dragging.

• Select the event and edit the Start position in the info line.

• Use the “Move to” functions on the Edit menu.
The following functions are available:

! You will note that there is a slightly delayed response 
when you move an event by dragging. This helps you 
avoid accidentally moving events when you click on 
them in the Project window. You can adjust this de-
lay with the Drag Delay setting in the Preferences 
(Editing page).

Function Description

Move to Cursor Moves the selected event to the project cursor position. If 
there are several selected events on the same track, the 
first event will start at the cursor, and the following will be 
lined up end-to-start after the first one.

Move to Origin Moves the selected events to their original positions, i.e. 
the positions at which they were originally recorded.

Move to Front,
Move to Back

This function doesn’t actually change the position of the 
events, but moves the selected events to the front or 
back, respectively. This is useful if you have overlapping 
events, and want to see one that is partially obscured.
For audio events, this is an extra important feature, since 
only the visible sections of events will be played back. 
Moving an obscured audio event to front (or moving the 
obscuring event to back) will allow you to hear the whole 
event on playback (see also “Overlapping events” on 
page 292).
Note that it is also possible to use the “To Front” function 
on the event context menu for this (although this works in 
a different way, see “Create Events mode (Preferences)” 
on page 74).



45

The Project window

• Use the Nudge buttons in the toolbar.
These move the selected events to the left or right. The amount of move-
ment depends on the selected display format (see “The Project Setup di-
alog” on page 33) and the value set on the Grid pop-up menu.

Here, clicking this button will move the event 2 frames to the right.

The Nudge buttons are not visible in the toolbar by de-
fault. 
You can decide which items should be visible by right-clicking in the 
toolbar and checking them in the pop-up menu that appears. See “The 
Setup dialogs” on page 506 for more information.

Aligning events

Nuendo provides shortcuts to quickly align audio events 
and parts in the project window. You can align to selected 
parts, events or ranges or to the cursor. 

To align audio events or parts to selected parts or events, 
proceed as follows:

1. Select an event or part of any type on any track.
This will be taken as a reference for aligning.

2. With the arrow tool selected, point on the audio event 
or part you want to move, press one of the modifiers listed 
in the table below and click.
The mouse pointer will change its shape and the audio event or part will 
be aligned to the selected part or event.

To align audio events or parts to selection ranges, pro-
ceed as follows:

1. Make a selection range on any track.
This will be taken as a reference for aligning.

2. With the range selection tool selected, point on an au-
dio event or part, press one of the modifiers listed in the 
table below and click.
The mouse pointer will change its shape and the audio event or part will 
be aligned to the selected range.

In both cases, the following modifiers are available:

! When the Range Selection tool is used, the Nudge 
buttons move the selection range (see “Moving and 
duplicating” on page 54).

! When the snap point is set, it will be used as a refer-
ence when you align events.

! Note that the functions depend on where you point 
with the mouse.

Modifier Pointer Description

[Ctrl]/[Command] This aligns the start of the audio event/part 
to the start of the selected event, part or 
range. This function is available when you 
move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command]
+[Alt]/[Option]

This copies the audio event/part and aligns 
its start to the start of the selected event, 
part or range. This function is available when 
you move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command] This aligns the end of the audio event/part to 
the start of the selected event, part or range. 
This function is available when you move the 
mouse on the end of the non-selected event.

[Ctrl]/[Command]
+[Alt]/[Option]

This copies the audio event/part and aligns 
its end to the start of the selected event, part 
or range. This function is available when you 
move the mouse on the end of the non-se-
lected event.

[Ctrl]/[Command]
+[Shift]

This aligns the start of the audio event/part 
to the end of the selected event, part or 
range. This function is available when you 
move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command]
+[Shift]
+[Alt]/[Option]

This copies the audio event/part and aligns 
its start to the end of the selected event, part 
or range. This function is available when you 
move the mouse on the beginning of the 
non-selected event.

[Ctrl]/[Command]
+[Shift]

This aligns the end of the audio event/part to 
the end of the selected event, part or range. 
This function is available when you move the 
mouse on the end of the non-selected event.

[Ctrl]/[Command]
+[Shift]
+[Alt]/[Option]

This copies the audio event/part and aligns its 
end to the end of the selected event, part or 
range. This function is available when you 
move the mouse on the end of the non-se-
lected event.
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You can also align audio events or parts to the project 
cursor. This is done in the following way: 

1. Set the cursor to the position where you want to move 
the audio part or event.
This will be taken as a reference for aligning.

2. Make sure that nothing is selected in your project.

3. With the arrow tool selected, point on the audio event 
or part you want to move, press one of the modifiers listed 
in the table below and click.
The mouse pointer will change its shape and the audio event or part will 
be aligned to the cursor.

For aligning audio events or parts to the cursor, the follow-
ing modifiers are available:

You can change the modifiers in the Preferences dia-
log (Editing–Tool Modifiers page).

Duplicating events

Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new 
position.
If Snap is activated, this determines to which positions you can copy the 
events (see “Snap” on page 55). 

• Audio and MIDI parts can also be duplicated by press-
ing [Alt]/[Option] + [Shift] and dragging.
This creates a shared copy of the part. If you edit the contents of a 
shared copy, all other shared copies of the same part are automatically 
edited in the same way.

Shared copies are indicated by an icon in the right corner of the part.

Note:

• When you duplicate audio events, the copies are al-
ways shared. This means that shared copies of audio 
events always refer to the same audio clip (see “Audio 
processing” on page 239).

• You can convert a shared copy to a real copy by select-
ing “Convert to Real Copy” from the Edit menu. This cre-
ates a new version of the clip (that can be edited 
independently) and adds this to the Pool. Note that no new 
files are created by this operation – for that you need to use 
the “Bounce Selection” function from the Audio menu (see 
“Exporting regions as audio files” on page 308).

• Selecting “Duplicate” from the Edit menu creates a 
copy of the selected event and places it directly after the 
original.
If several events are selected, all of these are copied “as one unit”, main-
taining the relative distance between the events.

• Selecting “Repeat…” from the Edit menu opens a dia-
log, allowing you to create a number of copies (regular or 
shared) of the selected event(s).
This works just like the Duplicate function, but you can specify the num-
ber of copies.

Modifier Icon Description

[Ctrl]/[Command] This aligns the start of the audio event/part to 
the cursor. This function is available when you 
move the mouse on the beginning of the non-
selected event.

[Ctrl]/[Command]
+[Alt]/[Option]

This copies the audio event/part and aligns its 
start to the cursor. This function is available 
when you move the mouse on the beginning of 
the non-selected event.

[Ctrl]/[Command] This aligns the end of the audio event/part to 
the cursor. This function is available when you 
move the mouse on the end of the non-se-
lected event.

[Ctrl]/[Command]
+[Alt]/[Option]

This copies the audio event/part and aligns its 
end to the cursor. This function is available 
when you move the mouse on the end of the 
non-selected event.

! If you hold down [Ctrl]/[Command] as well, move-
ment direction is restricted to either horizontal or ver-
tical. That means if you drag an event vertically it can 
not be moved horizontally at the same time.
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• You can also perform the Repeat function by dragging: 
Select the event(s) to repeat, press [Alt]/[Option], click the 
handle in the lower right corner of the last selected event 
and drag to the right.
The longer to the right you drag, the more copies are created (as shown 
by the tooltip).

• Selecting “Fill Loop” from the Edit menu creates a num-
ber of copies starting at the left locator and ending at the 
right locator.
The last copy is automatically shortened to end at the right locator posi-
tion.

Using Cut, Copy and Paste

You can cut or copy selected events, and paste them in 
again, using the functions on the Edit menu.

• When you paste an event it is inserted on the selected 
track, positioned so that its snap point is aligned with the 
cursor position.
If the selected track is of the wrong type, the event will be inserted on its 
original track. See “Snap” on page 55 for information about the snap point.

• If you use the “Paste at Origin” function, the event is 
pasted at its original position (the position from which you 
cut or copied it).

Using Cut Head and Cut Tail

You can cut everything to the left or right of the cursor or a 
selected range:

• If you use “Cut Head”, everything to the left of the cur-
sor/selection range will be deleted. No data will be kept in 
the clipboard. 

• If you use “Cut Tail”, everything to the right of the cur-
sor/selection range will be deleted. No data will be kept in 
the clipboard. 

Renaming events

By default, audio events show the name of their clip, but 
you can enter a separate descriptive name for separate 
events if you like. This is done by selecting the event and 
typing in a new name in the “Description” field in the info 
line, or by using the Rename Object command from the 
Edit menu.

• You can also give all events on a track the same name 
as the track by changing the track name, holding down a 
modifier key and pressing [Return].
See “Handling tracks” on page 38.

• The Rename Objects command is useful when renaming 
multiple events at the same time. Select one or more 
events. Then choose “Rename…” from the Edit menu. You 
have several options for renaming events automatically us-
ing sequential numbers, timestamps and more (see “Rena-
ming clips or regions in the Pool” on page 300).

Splitting events

You can split events in the Project window in the following 
ways:

• Click with the Scissors tool on the event you want to 
split.
If Snap is activated, this determines the exact split position (see “Snap” 
on page 55). You can also split events by pressing [Alt]/[Option] and 
clicking with the Arrow tool.

• Select “Split at Cursor” from the Edit menu.
This splits the selected events at the position of the project cursor. If no 
events are selected, all events (on all tracks) that are intersected by the 
project cursor will be split.

• Select “Split Loop” from the Edit menu.
This splits events on all tracks at the left and right locator positions.

If you split a MIDI part so that the split position inter-
sects one or several MIDI notes, the result depends on the 
option “Split MIDI Events” in the Preferences (Editing–
MIDI page). 
If the option is activated, the intersected notes will be split (creating new 
notes at the beginning of the second part). If it is deactivated, the notes 
will remain in the first part, but “stick out” after the end of the part.
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Gluing events together

You can glue events together using the Glue Tube tool. 
There are three possibilities: 

• Clicking on an event with the Glue Tube tool glues it to-
gether with the next event on the track. The events do not 
have to touch one another.
The result is a part containing the two events, with one exception: If you 
first split an event and then glue the two sections together again (without 
moving or editing them first), they become a single event again.

• You can select several events on the same track and 
click on one of them with the Glue Tube tool.
A single part is created.

• When you hold down [Alt]/[Option] while clicking on an 
event with the Glue Tube tool, this event will be glued to-
gether with all following events on this track.
You can change the default key command for this in the Preferences 
(Editing–Tool Modifiers page).

Resizing events

Resizing events means to move their start or end positions 
individually. In Nuendo, there are three types of resizing:

To select one of the resizing modes, select the Arrow tool 
and then click again on the Arrow tool icon on the toolbar. 
This opens a pop-up menu from which you can select one 
of the resizing mode options.

The icon on the toolbar will change, indicating the selected resizing mode.

The actual resizing is done by clicking and dragging the 
lower left or right corner of the event. If Snap is activated, 
the Snap value determines the resulting length (see 
“Snap” on page 55).

Normal sizing.

Sizing moves contents.

• If several events are selected, all will be resized in the 
same way.

• You can also resize events with the Scrub tool.
This works just the same as when resizing with the Arrow tool, but the 
audio under the pointer is played back (scrubbed) while you drag.

Resizing type Description

Normal Sizing The contents of the event stay fixed, and the start or end 
point of the event is moved to “reveal” more or less of the 
contents.

Sizing Moves 
Contents

The contents follow the moved start or end of the event 
(see the figure below).

Sizing Applies 
Time Stretch

The contents will be time stretched to fit the new event 
length (see the separate description on “Resizing events 
using time stretch” on page 49).
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• It is also possible to resize events by using the Trim but-
tons (located in the Nudge palette) on the toolbar.
This will move the start or end position of the selected Event(s) by the 
amount set on the Grid pop-up menu. The sizing type currently selected 
applies to this method too, with the exception of “Sizing Applies Time 
Stretch” which is not possible with this method. You can also use key 
commands for this (by default, press [Ctrl]/[Command] and use the left 
and right arrow key).

Note that the Nudge palette is not visible in the toolbar 
by default. See “The Setup dialogs” on page 506 for in-
structions on how to show and hide items in the toolbar.

Resizing events using time stretch

If you want to resize a part and make its contents “fit” the 
new size, you should use this option. Proceed as follows:

1. Click the Arrow icon on the toolbar and select the “Siz-
ing Applies Time Stretch” option from the pop-up menu.

2. Point close to the end point of the part you want to 
stretch.

3. Click and drag left or right.
When you move the mouse, a tooltip shows the current mouse position 
and length of the part. Note that the snap value applies, as with any part 
operation.

4. Release the mouse button.
The part is “stretched” or “compressed” to fit the new length.

• For MIDI parts, this means that the note events are 
stretched (moved and resized).
Controller data will be moved.

• For audio parts, this means that the events are moved, 
and that the referenced audio files are time stretched to fit 
the new length.
A dialog box shows the progress of the time stretch operation.

You can adjust which algorithm should be used for the 
time stretch algorithm in the Preferences (Editing–Audio 
page).
For more information about time stretch, see “Time Stretch” on page 248.

Sliding the contents of an event or part

You can move the contents of an event or part without 
changing its position in the Project window. By default, this 
is done by pressing [Alt]/[Option]+[Shift], clicking in the 
event or part and dragging to the left or right.

Grouping Events

Sometimes it is useful to treat several events as one unit. 
This can be done by grouping them: Select the events (on 
the same or different Tracks) and select “Group” from the 
Edit menu.

Grouped events are indicated by a group icon in the right corner.

If you edit one of the grouped events in the Project window, 
all other events in the same group are affected too (if appli-
cable). 

! When sliding the contents of an audio event, you 
cannot slide past the start or end of the actual audio 
clip. If the event plays the whole clip, you cannot 
slide the audio at all.
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Group editing operations include:

• Selecting events.
• Moving and duplicating events.
• Resizing events.
• Adjusting fade-in and fade-out (audio events only, see “Cre-

ating fades” on page 87).
• Splitting events (splitting one event will automatically split any 

other grouped events that are intersected by the split position).
• Locking events.
• Muting events (see below).
• Deleting events.

Locking events

If you want to make sure you don’t edit or move an event 
by accident, you can lock it. Locking can affect one (or any 
combination) of the following properties:

• To specify which of these properties should be affected 
by the Lock function, use the “Lock Event Attributes” pop-
up menu in the Preferences (Editing page).

• To lock events, select them and select “Lock…” from 
the Edit menu.
The events will be locked according to the options specified in the Pref-
erences.

• You can adjust the lock options for a locked event by 
selecting it and selecting “Lock…” from the Edit menu 
again.
This opens a dialog in which you can activate or deactivate the desired 
lock options.

• To unlock an event (turn off all lock options), select it 
and select “Unlock” from the Edit menu.

• It is also possible to lock a whole track, by clicking the 
padlock symbol in the Track list or in the Inspector.
This disables all editing of all events on the track.

Muting events

To mute individual events in the Project window, proceed 
as follows:

• To mute or unmute a single event, click on it with the 
Mute tool.

• To mute or unmute several events, select them – either 
by using the standard selection techniques, or by using 
one of the options on the Select submenu on the Edit 
menu – and click on one of the selected events with the 
Mute tool.
All selected events will be muted.

• You can also click in an empty area with the Mute tool 
and drag a selection rectangle around several events you 
want to mute or unmute, and then click on one of them 
with the Mute tool.

• You can mute events by selecting them and selecting 
“Mute” from the Edit menu.
Similarly, you can unmute the selected events by selecting “Unmute” 
from the Edit menu.

• You can also change the mute status of selected events 
on the info line.

Muted events can be edited as usual (with the exception 
of adjusting fades), but are not played back.

Muted events are “grayed out”.

Lock Options Description

Position If this is locked, the event cannot be moved.

Size If this is locked, the event cannot be resized.

Other If this is locked, all other editing of the event is disabled. 
This includes adjusting the fades and event volume, pro-
cessing, etc.

The padlock symbol indicates that 
one or more of the lock options 
are activated for the event.
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• You can also mute whole tracks by clicking the Mute 
(“M”) button in the Track list, the Inspector or the mixer.
Clicking the Solo (“S”) button for a track mutes all other tracks. Note that 
there are two modes for the track solo function: 
If the option “Enable Solo on Selected Track” is activated in the Prefer-
ences (Editing–Project & Mixer page) and you have soloed a track, se-
lecting another track in the track list will automatically solo that track 
instead – the solo state “moves” with the track selection.
If the option isn’t activated, the track you solo stays soloed, regardless of 
the selection.

Removing events

To remove an event from the Project window, use any of 
the following methods:

• Click on the event with the Eraser tool.
Note that if you press [Alt]/[Option] while you click, all following events 
on the same track will be deleted, but not the event you clicked and all 
events before it.

• Select the event(s) and press [Backspace], or select 
“Delete” from the Edit menu.

Creating new files from events

An audio event plays a section of an audio clip, which in 
turn refers to one or more audio files on the hard disk. 
However, in some situations you may want to create a new 
file that consists only of the section played by the event. 
This is done with the function “Bounce Selection” on the 
Audio menu:

1. Select one or several audio events.

2. Set up fade in, fade out and event volume (on the info 
line or using the volume handle) as desired.
These settings will be applied to the new file. For details on fades and 
event volume, see “Creating fades” on page 87.

3. Select “Bounce Selection” from the Audio menu.
You are asked whether you want to replace the selected event or not.

• If you click “Replace”, a new file is created, containing 
only the audio in the original event. A clip for the new file is 
added to the Pool, and the original event is replaced by a 
new event playing the new clip.

• If you click “No”, a new file is created and a clip for the 
new file is added to the Pool.
The original event is not replaced.

You can also apply the Bounce Selection function to an 
audio part. In that case, the audio from all events in the 
part will be combined into a single audio file. If you choose 
“Replace” when asked, the part will be replaced with a 
single audio event playing a clip of the new file.

Editing in Lane Display mode
When you are recording in Stacked cycle recording 
mode, each take ends up on a separate lane on the track, 
see “Recording audio in Stacked mode” on page 75 and 
“Cycle Record mode: Stacked/Stacked 2 (No Mute)” on 
page 80. However, you can also select this lane mode 
manually for individual tracks, and use it when editing in 
the Project window. This makes it easier to view and han-
dle overlapping events and parts.

Audio tracks

1. In the Track list or in the Inspector for the selected 
track, click the Lane Display Type button and select “Lanes 
Fixed” from the pop-up menu.
The audio track is divided vertically into two lanes. By default, all audio 
events end up in the first (top) lane.

2. Now you can move events or parts between lanes, ei-
ther by dragging or by using the “Move to Next Lane/Pre-
vious Lane” commands on the Edit menu or Quick menu.
Note that if there are overlapping audio events, the audio on the lowest 
lane has playback priority – moving events between lanes affects what 
will be heard!

If the vertical zoom factor is sufficiently high, the sections that will be 
heard on playback are indicated in green.
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• Note that there will always be an extra, empty lane at the 
bottom of the track – moving an event there always will 
add another lane.
Depending on the number of lanes used, you may want to adjust the ver-
tical zoom for the track – simply drag the track edges in the track list.

3. After rearranging the overlapping events so that you 
hear what you want, you can select all events and select 
“Delete Overlaps” from the Advanced submenu on the 
Audio menu.
This puts all events in the top lane and resizes events so that overlapping 
sections are removed.

4. To turn off Lanes mode, select “Lanes Off” from the 
Lane Display Type pop-up menu.
If you do this without using the “Delete Overlaps” function, all overlapping 
sections will be kept. However, the sections that were green will now be 
the sections visible (“on top”) and thus the sections that will be heard.

MIDI tracks

1. In the Track list or in the Inspector for the selected 
track, click the Lane Display Type button and select “Lanes 
Auto” or “Lanes Fixed”.

2. Click the Lane Display Type button and select “Lanes 
Auto” or “Lanes Fixed”.

• In Lanes Auto mode, extra lanes will automatically be 
added where necessary – if two MIDI parts overlap, they 
will automatically be put on separate lanes.

• In Lanes Fixed mode, you have to move MIDI parts be-
tween lanes manually (by dragging them or by using the 
“Move to Next Lane/Previous Lane” commands on the 
Edit menu or Quick menu).
In this mode, there will always be an extra, empty lane at the bottom of 
the track – if you move a part there, another lane will be added and so on.

3. You can edit the overlapping parts as usual – by cut-
ting, deleting or muting sections in the Project window or 
by opening them in a MIDI editor.
In an editor, parts on different lanes will be treated just like parts on dif-
ferent tracks – you can use the part list pop-up menu to select an active 
part for editing, etc. 
Note that there is no playback priority between lanes on a MIDI track – all 
unmuted parts will be heard during playback.

4. To merge all overlapping parts into one, make sure the 
MIDI track is selected, position the left and right locator 
around the parts and select “Merge MIDI in Loop” from 
the MIDI menu.
In the dialog that appears, activate the Erase Destination option and click 
OK. This merges all unmuted MIDI between the locators to a single part.

5. To turn off Lanes mode, select “Lanes Off” from the 
Lane Display Type pop-up menu.

Range editing
Editing in the Project window isn’t necessarily restricted 
to handling whole events and parts. You can also work 
with selection ranges, which are independent from the 
event/part and track boundaries.

Creating a selection range

To make a selection range, drag with the Range Selection 
tool.

When the Range Selection tool is selected, the Select 
submenu on the Edit menu has the following items for 
making selection ranges:

Option Description

All Makes a selection that covers all tracks, from the start of 
the project to the end (as defined by the Length setting in 
the Project Setup dialog).

None Removes the current selection range.

Invert Only used for event selection (see “Selecting events” on 
page 43).

In Loop Makes a selection between the left and right locator, on 
all tracks.

From Start
to Cursor

Makes a selection on all tracks, from the start of the 
project to the project cursor.

From Cursor 
to End

Makes a selection on all tracks, from the project cursor to 
the end of the project.
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• Double-clicking on an event with the Range Selection 
tool creates a selection range encompassing the event.
If you hold down [Shift] you can double-click several events in a row, and 
the selection range will expand to encompass them all. Double-clicking a 
second time on an event opens it for editing in the Sample Editor.

Adjusting the size of the selection range

You can adjust the size of a selection range in the follow-
ing ways:

• By dragging its edges.
The pointer takes the shape of a double arrow when you move it over an 
edge of the selection range.

• By holding down [Shift] and clicking.
The closest selection range edge will be moved to the position at which 
you clicked.

• By adjusting the selection range start or end position on 
the info line.

• By using the Trim buttons on the toolbar.
The left Trim buttons will move the start of the selection range and the 
right buttons will move the end. The edges will be moved by the amount 
specified on the Grid pop-up.

Clicking this Trim button…

…will move the start of the selection range to the right by 1beat.

• By using the Nudge buttons on the toolbar.
These will move the whole selection range to the left or the right. The 
amount of movement depends on the selected display format (see “The 
Project Setup dialog” on page 33) and the value specified on the Grid 
pop-up menu.

The Trim buttons and the Nudge buttons are located 
in the Nudge palette, which is not visible in the toolbar by 
default. 
See “The Setup dialogs” on page 506 for instructions on how to show 
and hide items in the toolbar.

All on Selected 
Tracks

Only used for event selection (see “Selecting events” on 
page 43).

Select Event This is available in the Sample Editor (see “Using the Se-
lect menu” on page 267).

Left Selection 
Side to Cursor

Moves the left side of the current selection range to the 
project cursor position.

Right Selection 
Side to Cursor

Moves the right side of the current selection range to the 
project cursor position.

Range to Next 
Event

Moves the selection range to the next event head or tail 
on the selected track(s) and turns it to a zero selection

Range to Previ-
ous Event

Moves the selection range to the previous event head or 
tail on the selected track(s) and turns it to a zero selection.

Enlarge Range 
to Next Event

Moves the right side of the current selection range to the 
next event head or tail on the selected track(s).

Enlarge Range 
to Previous 
Event

Moves the left side of the current selection range to the 
previous event head or tail on the selected track(s).

Option Description

! Note that the contents of the selection are not 
moved – using the Nudge buttons is the same as ad-
justing the start and end of the selection range at the 
same time, by the same amount.
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Making selection ranges for several non-contiguous 
tracks

You can create selection ranges that cover several tracks 
by pressing [Alt]/[Option]+[Shift]. However, it is also pos-
sible to exclude tracks from a selection range:

1. Create a selection range from the first to the last de-
sired track.

2. Press [Alt]/[Option] and click in the selection range on 
the tracks you want to exclude from the selection.

3. In the same manner, you can add a track to the selec-
tion range by [Alt]/[Option]-clicking in the selection range 
area on the track.

Moving and duplicating

• To move a selection range, click and drag it to a new 
position.
This will move the contents of the selection range to the new position. If 
the range intersected events or parts, these will be split before moving, 
so that only the sections within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option] 
and drag.
You can also use the Duplicate, Repeat and Fill Loop functions, just as 
when duplicating events (see “Aligning events” on page 45).

Using Cut, Copy and Paste

When working with selection ranges, you can either use 
Cut, Copy and Paste on the Edit menu, or use the func-
tions “Cut Time” and “Paste Time” on the Range submenu 
on the Edit menu. These work differently to their related 
functions on the Edit menu:

Deleting selection ranges

Again, you can either use “regular” Delete or “Delete Time”:

• If you use the Delete function on the Edit menu (or press 
[Backspace]), the data within the selection range is re-
placed by empty track space.
Events to the right of the range keep their position.

• If you use “Delete Time” on the Edit menu’s Range sub-
menu, the selection range is removed and events to the 
right are moved to the left to close up the gap.

Function Description

Cut Cuts out the data in the selection range and moves it to 
the clipboard. The selection range is replaced by empty 
track space in the Project window, meaning that events 
to the right of the range keep their positions.

Copy Copies the data in the selection range to the clipboard.

Paste Pastes the clipboard data at the start position and track 
of the current selection. Existing events are not moved to 
make room for the pasted data.

Paste at Origin Pastes the clipboard data back at its original position. Ex-
isting events are not moved to make room for the pasted 
data.

Cut Time Cuts out the selection range and moves it to the clip-
board. Events to the right of the removed range are 
moved to the left to fill out the gap.

Paste Time Pastes the clipboard data at the start position and track 
of the current selection. Existing events are moved to 
make room for the pasted data.

Paste Time at 
Origin

Pastes the clipboard data back at its original position. Ex-
isting events are moved to make room for the pasted data.
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Other functions

On the Range submenu on the Edit menu, you will find 
three more range editing functions:

Region operations
Regions are sections within a clip, with various uses. 
While regions are perhaps best created and edited in the 
Sample Editor (see “Working with regions” on page 269), 
the following region functions are available in the –Ad-
vanced submenu of the Audio menu:

Options

Snap
The Snap function helps you to find exact positions when 
editing in the Project window. It does this by restricting 
horizontal movement and positioning to certain positions. 
Operations affected by Snap include moving, copying, 
drawing, sizing, splitting, range selection, etc.

• You turn Snap on or off by clicking the Snap icon in the 
toolbar.

Snap activated.

When you are moving audio events with Snap acti-
vated, it isn’t necessarily the beginning of the event that is 
used as Snap position reference. Instead, each audio 
event has a snap point, which you can set to a relevant po-
sition in the audio (such as a downbeat, etc.).
The snap point is preferably set in the Sample Editor since it allows for a 
higher degree of precision (see “Adjusting the snap point” on page 266). 
You can however also set the snap point directly in the Project window, 
in the following way: 

1. Select an event.

2. Place the project cursor at the desired position within 
the selected audio event.

3. Pull down the Audio menu and select “Snap Point To 
Cursor”.
The snap point is set at the cursor position.

The snap point for an event is displayed as a blue line in the Project 
window.

Function Description

Split Splits any events or parts that are intersected by the selec-
tion range, at the positions of the selection range edges.

Crop All events or parts that are partially within the selection 
range are cropped, that is, sections outside the selection 
range are removed. Events that are fully inside or outside 
the selection range are not affected.

Insert Silence Inserts empty track space from the start of the selection 
range. The length of the silence equals the length of the 
selection range. Events to the right of the selection range 
start are moved to the right to “make room”. Events that 
are intersected by the selection range start are split, and 
the right section is moved to the right.

Function Description

Event or Range 
as Region

This function is available when one or several audio 
events or selection ranges are selected. It creates a re-
gion in the corresponding clip, with the start and end po-
sition of the region determined by the start and end 
position of the event or selection range within the clip.

Events from 
Regions

This function is available if you have selected an audio 
event whose clip contains regions within the boundaries 
of the event. The function will remove the original event 
and replace it with event(s) positioned and sized accord-
ing to the Region(s).
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Exactly how Snap works depends on which mode is se-
lected on the Snap mode pop-up menu.

The following sections describe the different Snap modes:

Grid

In this mode, the Snap positions are set with the Grid 
pop-up menu to the right. The options depend on the dis-
play format selected for the ruler. For example, if the ruler 
is set to show bars and beats, the grid can be set to bars, 
beats or the quantize value set with the next pop-up menu 
to the right. If a time or frame-based ruler format is se-
lected, the grid pop-up menu will contain time or frame-
based grid options, etc.

When Seconds is selected as ruler format, the grid pop-up menu con-
tains time-based grid options.

Grid Relative

When you move events and parts in this mode they will not 
be “magnetic” to the grid. Rather, the grid determines the 
step size for moving the events. This means that a moved 
event will keep its original position relative to the grid.

For example, if an event starts at the position 3.04.01 (one 
beat before bar 4), Snap is set to Grid Relative and the 
Grid pop-up is set to “Bar”, you can move the event in 
steps of one bar – to the positions 4.04.01, 5.04.01 and 
so on. The event will keep its relative position to the grid, 
i.e. stay one beat before the bar lines.

• This only applies when dragging existing events or parts 
– when you create new events or parts this mode works 
like the Grid mode.

Events

In this mode, the start and end positions of other events and 
parts become “magnetic”. This means that if you drag an 
event to a position near the start or end of another event, it 
is automatically aligned with the start or end of the other 
event. For audio events, the position of the snap point is 
also magnetic (see “Adjusting the snap point” on page 
266).

• Note that this includes marker events on the marker track.
This allows you to snap events to marker positions, and vice versa.

Shuffle

Shuffle mode is useful when you want to change the order 
of adjacent events. If you have two adjacent events and 
drag the first one to the right, past the second event, the 
two events will change places.

The same principle works when changing the order of 
more than two events:

Magnetic Cursor

When this mode is selected, the project cursor becomes 
“magnetic”. Dragging an event near the cursor causes the 
event to be aligned with the cursor position.

1 2 3 4 5

52431

Dragging event 2 past event 4…

…changes the order of events 2, 3 and 4.
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Grid + Cursor

This is a combination of the “Grid” and “Magnetic Cursor” 
modes.

Events + Cursor

This is a combination of the “Events” and “Magnetic Cur-
sor” modes.

Events + Grid + Cursor

This is a combination of the “Events”, “Grid” and “Mag-
netic Cursor” modes.

Snap to Zero Crossing
When this option is activated in the Preferences (Editing–
Audio page), splitting and sizing of audio events is done at 
zero crossings (positions in the audio where the amplitude 
is zero). This helps you avoid pops and clicks which might 
otherwise be caused by sudden amplitude changes.

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will 
scroll during playback, keeping the project cursor visible 
in the window.

• If the option “Stationary Cursors” is activated in the 
Preferences (Transport page), the project cursor will be 
positioned in the middle of the screen (if possible).

! This setting affects all windows in all open projects – 
with the exception of the Sample Editor (which has 
its own “Use Snap” button for this).
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Background
This chapter describes the various methods available for 
controlling Playback and Transport functions in Nuendo.

The Transport panel
Below you can find a brief description of each item on the 
Transport panel.

The pictures below show the Transport panel with all con-
trols visible and in their default position. The Transport 
panel is divided into sections, from left to right.

Note that the Output Activity and Clipping indicator as 
well as the Output Level Control refer to the Control 
Room channel if the Control Room is activated. If the Con-
trol Room is disabled, these controls refer to the Main Mix 
Output bus as defined on the Outputs tab in the VST 
Connections window. For information on the Control 
Room, see the chapter “Control Room” on page 151.

• The main Transport functions (Cycle/Stop/Play/Record) 
can also be shown on the toolbar.

In addition, various play options are available on the Trans-
port menu.

Activates Auto Quantize

Record mode pop-up menu

Cycle Record mode 
pop-up menu

CPU load and Disk Cache meters

Right locator: punch out 
point and end of Cycle

Activates 
punch out

Activates 
punch in

Left locator: record start point, punch 
in point and beginning of Cycle

Postroll setting 
and on/off switch

Shuttle 
speed

Jog Wheel 
(project scrubbing)

Nudge +/- 1 Frame

Preroll setting and on/off switch

Primary Time Display 
and format pop-upPosition 

slider

Record

Play

Fast forwardRewind

Stop
Go to next 
marker or 
project end

Nudge position 
right/left

Go to previous 
marker or 
project start

Secondary Time Display 
and format pop-up

Exchange time formats

Cycle on/off

Active Arranger 
chain

Activate Arranger 
Mode

First/Last repeat of current Arranger item

Previous/Next Arranger items

Arranger Selector

Current Arranger 
item

Tempo track 
on/off 

Synchronization 
on/off

The tempo and time 
signature display

Metronome click on/off Show Markers (opens 
Marker window)

Jump to Marker

Precount on/off

MIDI In Activity 
(left meter)/
MIDI Out activity

Output Level Control (for the Control Room channel, if the Control 
Room is enabled, or for the Main Mix output bus, see below).

Audio output ac-
tivity and Clipping 
indicator (top)

Audio input activity and Clipping indicator (Default Input channel)
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Hiding and showing the Transport Panel

The Transport panel is shown by default when you launch 
a new project. To hide or show it, select “Transport Panel” 
on the Transport menu (or use a key command – by de-
fault [F2]).

About Preroll and Postroll

These items are described in the chapter “Recording”, 
see “About Preroll and Postroll” on page 83.

Changing the Transport panel setup

You can customize the appearance of the Transport panel 
by right-clicking anywhere on the panel and selecting/de-
selecting the desired options on the pop-up menu that ap-
pears.

This is described in detail in the section “Customizing via 
the setup context menus” on page 506.

The numeric keypad
In the default Key Command settings, various Transport 
panel operations are assigned to the numeric keypad on 
the computer keyboard. The keypads are slightly different 
on PC and Macintosh computers:

Operations

Setting the project cursor position
There are several ways to move the project cursor posi-
tion:

• By using Fast Forward and Rewind.

• By using the Jog/Shuttle/Nudge control on the Trans-
port panel (see “The Shuttle Speed control” on page 62).

• By dragging the project cursor in the lower part of the 
ruler. 

• By clicking in the ruler.
Double-clicking in the ruler moves the cursor and starts/stops playback. 

• If the option “Locate when Clicked in Empty Space” is 
activated in the Preferences (Transport page) you can 
click anywhere in an empty section of the Project window 
to move the cursor position.

• By changing the value in any of the position displays.

• By using the position slider above the transport buttons 
in the Transport panel.
The range of the slider relates to the Length setting in the Project Setup 
dialog. Hence, moving the slider all the way to the right will take you to 
the end of the project. 

• By using markers (see “About markers” on page 110).

• By using playback options (see “Playback functions” on 
page 63).

• By using the Arranger function (see “The Arranger 
track” on page 98).

• By using functions on the Transport menu.

The following functions are available:

Numeric Key Function

[Enter] Play

[+] Fast Forward

[-] Rewind

[*] Record

[÷] (Win)/[/] (Mac) Cycle On/Off

[,] Return to Zero

[0] Stop

[1] Go to Left Locator

[2] Go to Right Locator

[3-9] Go to marker 3 to 9

Function Description

Locate Selection/ 
Locate Selection 
End

Moves the project cursor to the beginning or end of the 
current selection. For this to be available, you must 
have selected one or more events or parts, or made a 
selection range.

Locate Next/
Previous Marker

This moves the project cursor to the closest marker to 
the right or left (see “About markers” on page 110).

Locate Next/
Previous Event

This moves the project cursor forwards or backwards 
respectively, to the closest beginning or end of any 
event on the selected track(s).
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If Snap is activated when dragging the project cursor, 
the Snap value is taken into account. This is helpful for 
finding exact positions quickly.

There are also numerous key commands available for 
moving the project cursor (in the Transport category in the 
Key Commands dialog). 
For example, you can assign key commands to the “Step Bar” and “Step 
Back Bar” functions, allowing you to move the project cursor in steps of 
one bar, backwards and forwards.

About the Transport panel display formats

Primary time display (left) and secondary time display (right).

The time unit shown in the ruler can be independent from 
the time unit shown in the main time display on the Trans-
port panel. This means that you can display timecode in 
the transport position display and bars and beats in the 
ruler, for example. In addition, there is a secondary time 
display to the right of the primary time display which is 
also independent, giving you three different time units 
shown at the same time (in the Project window, you can 
also create additional ruler tracks – see “Using multiple 
rulers – ruler tracks” on page 32). 

The following rules apply:

• If you change the time format of the primary time display 
on the Transport panel, the time format of the ruler will be 
changed as well.
This is the same as changing the display format in the Project Setup. 
Therefore, to have different display formats in the ruler and the main time 
display you should change the format in the ruler.

• The primary time display format is set on the pop-up 
menu to the right in the main position display.

• This setting also determines the time format displayed 
for the left and right locators on the Transport panel.

• The secondary time display is completely independent, 
and the display format is set on the pop-up menu to the 
right in the secondary time display.

• You can swap time formats between the primary and 
secondary time displays by clicking the double arrow sym-
bol between them.

The left and right locators
The left and right locators are a pair of position markers 
used for specifying punch-in and punch-out positions dur-
ing recording, and as boundaries for cycle playback and 
recording. 

When cycle mode is activated on the Transport panel, 
the area between the left and right locator will be repeated 
(cycled) on playback. 
However, if the right locator is positioned before the left, this will work as 
a “jump” or “skip mode” – when the project cursor reaches the right lo-
cator it will immediately jump to the left locator position and continue 
playback from there.

There are several ways to set locator positions:

• To set the left locator, press [Ctrl]/[Command] and click 
at the desired position in the ruler.
Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right lo-
cator. You can also drag the locator “handles” directly in the ruler.

The locators are indicated by the “flags” in the ruler. The area between 
the locators is highlighted in the ruler and in the Project window (see 
“Appearance” on page 511). Note that if the right locator is before the 
left locator, the color of the ruler between the locators will change (from 
blue to red).

• Click and drag in the upper half of the ruler to “draw” a 
locator range.
If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on 
the numeric keypad sets the left or right locator to the 
project cursor position.
Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/
[Command]) to set the project cursor position to the left or right locator 
position. Note that these are default key commands – you can change 
these if you like.

• By creating cycle markers you can store any number of 
left and right locator positions, which can be recalled by 
simply double-clicking on the corresponding marker (see 
“About cycle markers” on page 111).
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• The “Locators to Selection” item on the Transport menu 
(default key command [P]) sets the locators to encompass 
the current selection.
This is available if you have selected one or several events or made a se-
lection range.

• You can also adjust the locators numerically on the 
Transport panel.
Clicking the L/R buttons in the locator section on the Transport panel will 
move the project cursor to the respective locator. If you press [Alt]/[Op-
tion] and click the L or R button, the corresponding locator will be set to 
the current project cursor position.

The Shuttle Speed control

The shuttle speed control (the outer wheel on the Trans-
port panel) allows you to play the project at any playback 
speed, forwards or backwards. This provides a quick way 
to locate or “cue” to any position in the project.

• Turn the shuttle speed wheel to the right to start play-
back.
The further to the right you move the wheel, the faster the playback 
speed. 

• If you turn the wheel to the left instead, the project will 
play backwards.
Similarly, the playback speed depends on how far to the left you turn the 
wheel.

Project scrubbing – the Jog Wheel

The middle wheel on the Transport panel serves as a jog 
wheel. By clicking and dragging it to the right or left you 
will move the playback position manually forwards or 
backwards – much like scrubbing on a tape deck. This 
helps you pinpoint exact locations in the project.

• Note that the jog wheel is an “endless dial” – you can 
turn it as many times as needed to move to the desired 
location.
The faster you turn the wheel, the faster the playback speed.

• If you click the jog wheel during playback, playback will 
automatically stop.

The nudge position buttons
The + and – buttons in the middle of the Shuttle/Jog sec-
tion allow you to nudge the project cursor position to the 
right or left, respectively. Each time you click a nudge but-
ton, the project cursor is moved by one frame.

Options and Settings

The “Return to Start Position on Stop” 
preference
This setting is found on the Transport page in the Prefer-
ences (found on the File menu under Windows, or on the 
Nuendo menu under Mac OS X).

• If “Return to Start Position on Stop” is activated when 
you stop playback, the project cursor will automatically re-
turn to the position where recording or playback last 
started.

• If “Return to Start Position on Stop” is deactivated, the 
project cursor will remain at the position where you stop 
playback.
Pressing Stop again will return the project cursor to the position where 
recording or playback last started.

About track disable/enable
For audio tracks, the track context menu contains an item 
named “Disable Track”. This shuts down all disk activity 
for the track, as opposed to using Mute, which merely 
turns down the output volume for a track. For example, if 
you often record “alternative takes” you can easily build up 
a large number of takes on different tracks. Even though 
these tracks are muted, they are actually still “playing 
back” from the hard disk during playback. This puts an un-
necessary load on your disk system, so using “Disable 
Track” is recommended for such situations.

• Select “Disable Track” for tracks that you want to keep in 
the project for later use (but don’t want to play back now).
Select “Enable Track” from the track context menu to re-enable disabled 
tracks.
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Playback functions
Apart from the standard transport controls on the Trans-
port panel, you can also find a number of functions that 
can be used to control playback on the Transport menu. 
The items have the following functionality:

In the Preferences dialog (Editing–Audio page) you 
will find the option “Treat Muted Audio Events like De-
leted”. When you activate this option, any events over-
lapped by a muted event will become audible.

About Chase
Chase is a function that makes sure your MIDI instruments 
sound as they should when you locate to a new position 
and start playback. This is accomplished by the program 
transmitting a number of MIDI messages to your instru-
ments each time you move to a new position in the 
project, making sure all MIDI devices are set up correctly 
with regard to program change, controller messages 
(such as MIDI Volume), etc.

For example, let’s say you have a MIDI track with a pro-
gram change event inserted at the beginning. This event 
makes a synth switch to a piano sound.

At the beginning of the first chorus you have another pro-
gram change event which makes the same synth switch to 
a string sound.

You now play back the song. It begins with the piano 
sound and then switches to the string sound. In the middle 
of the chorus you stop and rewind to some point between 
the beginning and the second program change. The synth 
will now still play the string sound although in this section 
it really should be a piano!

The Chase function takes care of that. If program change 
events are set to be chased, Nuendo will track the music 
back to the beginning, find the first program change and 
transmit it to your synth, setting it to the correct sound.

The same thing can apply to other event types as well. The 
Chase Events settings in the Preferences (MIDI page) de-
termine which event types will be chased when you locate 
to a new position and start playback.

Event types for which the checkbox is activated here 
will be chased.

• In the Chase Events section of the Preferences (MIDI 
page), you will find the option “Chase not limited to Part 
Boundaries”.
When you activate this option, MIDI controllers are also chased outside 
the part boundaries, i.e. the Chase will be performed on the part touched 
by the cursor as well as on all the parts to the left of it. Please note that 
this option should be deactivated for very large projects, as it consider-
ably slows down operations such as positioning and soloing. When you 
deactivate this option, the MIDI controllers are only chased within the 
parts under the position cursor.

Option Description

Postroll from 
Selection Start/End

Starts playback from the beginning or end of the 
currently selected range and stops after the time 
set in the Postroll field on the Transport panel.

Preroll to Selection 
Start/End

Starts playback from a position before the start or 
end of the currently selected range and stops at 
the selection start or end, respectively. The play-
back start position is set in the Preroll field on the 
Transport panel.

Play from Selection 
Start/End

Activates playback from the beginning or end of 
the current selection.

Play until Selection 
Start/End

Activates playback two seconds before the start or 
end of the current selection and stops at the selec-
tion start or end, respectively.

Play until Next Marker This activates playback from the project cursor and 
stops at the next marker.

Play Selection Range This activates playback from the start of the current 
selection and stops at the selection end.

Loop Selection This activates playback from the start of the current 
selection and keeps starting over again when 
reaching the selection end.

! The functions listed above (except “Play until Next 
Marker”) are only available if you have selected one 
or more events or made a selection range.
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Background
This chapter describes the various recording methods 
that you can use in Nuendo. As it is possible to record 
both audio and MIDI tracks, both recording methods are 
covered in this chapter.

Before you start
This chapter assumes that you are reasonably familiar with 
certain basic recording concepts, and that the following 
initial preparations have been made:

• You have properly set up, connected and calibrated 
your audio hardware. 

• You have opened a project and set the project setup 
parameters to your specifications.
Project setup parameters determine the record format, sample rate, 
project length etc. that affect the audio recordings you make during the 
course of the project. See “The Project Setup dialog” on page 33.

• If you plan to record MIDI, your MIDI equipment should 
be set up and connected correctly.

Basic recording methods
This section describes the general methods used for re-
cording. However, there are additional preparations and 
procedures that are specific to audio and MIDI recording 
respectively. Make sure to read these sections before you 
start recording (see “Audio recording specifics” on page 
67 and “MIDI recording specifics” on page 77).

Record-enabling a track
Nuendo can record on a single track or on several tracks 
(audio and/or MIDI) simultaneously. To make a track ready 
for recording, click the Record Enable button for the track in 
the Track list, in the Inspector or in the mixer. When acti-
vated, the button(s) turn red, indicating record ready mode.

Record Enable in the Inspector, Track list and mixer.

If the option “Enable Record on Selected Track” is ac-
tivated in the Preferences (Editing–Project & Mixer page), 
tracks are automatically record-enabled when you select 
them in the Track list.

The exact number of audio tracks you can record si-
multaneously depends on your computer CPU and hard 
disk performance.
In the Preferences (VST page), you can find the option “Warn on Pro-
cessing Overloads”. When this is activated, a warning message will be 
displayed as soon as the CPU clip indicator (on the Transport panel) 
lights up during recording.

Manually activating recording
You activate recording by clicking the Record button on 
the Transport panel or toolbar or by using the correspond-
ing key command (by default [*] on the numeric keypad).

Recording can be activated in Stop mode (from the current 
cursor position or from the left locator) or during playback:

• If you activate recording in Stop mode, and the option 
“Start Record at Left Locator” is activated on the Trans-
port menu, recording will start from the left locator.
The preroll setting or the metronome count-in will be applied (see “About 
Preroll and Postroll” on page 83).

• If you activate recording in Stop mode, and “Start Record 
at Left Locator” is deactivated, recording will start from the 
current project cursor position.
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• If you activate recording during playback, Nuendo will 
immediately enter Record mode and start recording from 
the current project cursor position.
This is known as “manual punch in”.

Activating recording in Sync mode

If you are synchronizing the Nuendo transport to external 
equipment (Sync is activated on the Transport panel) and 
you activate recording, the program will go into “record 
ready” mode (the record button on the Transport panel 
will light up). Recording then starts when a valid timecode 
signal is received (or when you click the Play button). See 
the chapter “Synchronization” on page 445 for more infor-
mation.

Automatically activating recording
Nuendo can automatically switch from playback to record-
ing at a given position. This is known as “automatic punch 
in”. A typical use for this would be if you need to replace a 
section of a recording, and want to listen to what is al-
ready recorded, up to the recording start position.

1. Set the left locator to the position where you want re-
cording to start.

2. Activate the Punch In button on the Transport panel.

Punch In activated.

3. Activate playback from some position before the left 
locator.
When the project cursor reaches the left locator, recording is automati-
cally activated.

Stopping recording
Again, this can be done automatically or manually:

• If you click the Stop button on the Transport panel (or 
use the corresponding key command, by default [0] on the 
numeric keypad), recording is deactivated and Nuendo 
goes into Stop mode.

• If you click the Record button (or use the key command 
for recording, by default [*]), recording is deactivated but 
playback continues.
This is known as “manual punch out”.

• If the Punch Out button is activated on the Transport 
panel, recording will be deactivated when the project cur-
sor reaches the right locator.
This is known as “automatic punch out”. By combining this with auto-
matic punch in, you can set up a specific section to record – again very 
useful if you want to replace a certain part of a recording. See also “Stop 
after Automatic Punch Out” on page 83.

Punch In and Out activated.

Cycle recording
Nuendo can record and play back in a cycle – a loop. You 
specify where the cycle starts and ends by setting the left 
and right locators. When the cycle is active, the selected 
section is seamlessly repeated until you hit Stop or deac-
tivate cycle mode.

• To activate cycle mode, click the cycle button on the 
Transport panel.
If you now start playback, the section between the left and right locator is 
repeated indefinitely until you stop.

Cycle activated

• To record in cycle mode, you can start recording from 
the left locator, from before the locators or from within the 
cycle, in Stop mode or during playback.
As soon as the project cursor reaches the right locator, it will jump back 
to the left locator and continue recording a new lap.

• The results of cycle recording depend on the selected 
cycle record mode and are different for audio (see “Re-
cording audio in cycle mode” on page 73) and MIDI (see 
“Recording MIDI in cycle mode” on page 80).
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Audio pre-record
This feature allows you to capture up to 1 minute of any in-
coming audio you play in Stop mode or during playback, 
“after the fact”. This is possible because Nuendo can cap-
ture audio input in buffer memory, even when not recording. 

Proceed as follows:

1. Open the Preferences (Record-Audio page).

2. Specify a time (up to 60 seconds) in the “Audio Pre-
Record Seconds” field.
This activates the buffering of audio input, making Pre-Record possible.

3. Make sure an audio track is record-enabled and re-
ceives audio from the signal source.

4. When you have played some audio material you want 
to capture (either in Stop mode or during playback), click 
the Record button.

5. After a few seconds stop the recording.
An audio event is created, starting at where the cursor position was 
when you activated recording. This means that if you were in stop mode, 
and the cursor was at the beginning of the project, you may have to move 
the event to the right in the next step. If you were playing along to a 
project you should leave the event where it is.

6. Select the Arrow tool and place the cursor on the bot-
tom left edge of the event so that a double arrow appears, 
then click and drag to the left. 
Now the event is extended and the audio you played before activating 
record is inserted – this means that if you played along during playback, 
the captured notes will end up exactly where you played them in relation 
to the project.

The recording was activated at the start of bar 9. This is indicated by a 
blue line in the audio event.

Audio recording specifics

Selecting a recording file format
The format for recorded files is set in the Project Setup dia-
log on the Project menu. There are three settings: sample 
rate, record format (bit depth) and record file type. While 
the sample rate is set once and for all when you start work-
ing on a new project, the bit depth and file type can be 
changed at any time.

Record file type

The Record File Type setting determines which type of 
files will be created when you record:

• If you select Broadcast Wave File or AIFF format, you 
can specify Author, Description and Reference text strings 
that will be embedded in the recorded file.
This is done on the Record–Audio–Broadcast Wave page in the Prefer-
ences.

Record format (bit depth)

The available options are 16 bit, 24 bit and 32 bit float. 
Use the following guidelines:

• Normally, select the record format according to the bit 
depth delivered by your audio hardware.
For example, if your audio hardware has 20 bit A/D converters (inputs), 
you may want to record at 24 bit resolution to capture the full bit depth. 
On the other hand, if your hardware has 16 bit inputs, it’s pointless to 
record with a higher bit depth – this will only make the audio files larger, 
with no difference in audio quality. The exception is if you record with ef-
fects – see “Recording with effects” on page 76.

File type Description

Wave File Wave files have the extension “.wav” and are a common 
file format on the PC platform.

Wave 64 File Wave64 is a proprietary format developed by Sonic 
Foundry Inc. Audio-wise it is identical to the Wave format, 
but the internal file structure makes much larger file sizes 
possible. This is useful e.g. for long live recordings in sur-
round format, where the audio files can become huge.

Broadcast 
Wave File

In terms of audio content, the same as regular Wave files, 
but with embedded text strings for supplying additional 
information about the file (see below).

AIFF File Audio Interchange File Format, a standard defined by Ap-
ple Computer Inc. AIFF files have the extension “.aif” and 
are used on most computer platforms. Like Broadcast 
Wave files, AIFF files can contain embedded text strings 
(see below).
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• The higher the bit depth, the larger the files and the 
more strain is put on the disk system.
If this is an issue, you may want to lower the record format setting.

Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono, stereo or sur-
round tracks, with almost any combination of channels 
(CRS, 5.1, 7.1, 10.2, etc). This allows you to record or im-
port a file containing multiple channels and treat it as one 
entity, with no need to split it up into several mono files 
etc. The signal path for an audio track maintains its chan-
nel configuration all the way from the input bus, via EQ, 
level and other mixer settings to the output bus.

You specify the channel configuration for a track when you 
create it:

1. Select “Add Audio Track” from the Track list context 
menu or the Project menu (or double-click in an empty 
area of the Track list when an audio track is selected – 
when a MIDI track is selected, double-clicking in the Track 
list creates a new MIDI track).
A dialog appears with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
The most common formats are listed directly on the pop-up menu, with 
the remaining surround formats listed on the “More…” submenu. For a 
list of the available surround formats, see “Output bus configuration” on 
page 205.

• The Browse item in this dialog allows you to browse 
your disk(s) for created Track Presets, which can be used 
as a basis (or template) for tracks.
This is described in detail in the chapter “Track Presets” on page 327.

3. Click OK.
A track appears, set to the specified channel configuration. In the mixer, 
a corresponding channel strip appears. You cannot change the channel 
configuration for a track.

Selecting an input bus for a track

Here we assume that you have added and set up the re-
quired input busses (see “Setting up busses” on page 11). 
Before you record, you need to specify from which input 
bus the track should record. You can do this in the Inspec-
tor or in the mixer:

• In the Inspector, you select an input bus on the Input 
Routing pop-up menu in the top section.
As described in the section “The Inspector” on page 26, the Inspector by 
shows the settings for the selected track. You show or hide the Inspector 
clicking the “Show/Hide Inspector” button on the Project window toolbar.

! For further information on the options in the Project 
Setup dialog, see “The Project Setup dialog” on 
page 33.

Click here to select an input bus for the track.

Click here to show/hide the Inspector.
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• In the mixer, you select an input bus on the Input Routing 
pop-up menu at the top of the track’s channel strip.
If this pop-up menu isn’t shown, you need to open the Mixer Routing View 
by clicking the “Show Routing” button in the extended Mixer common 
panel or by selecting “Show Routing View” from the Window submenu on 
the Mixer context menu. See “Configuring the mixer” on page 126 for more 
information about the mixer.

Recording from busses

You can also select an output bus, a group bus or an FX 
channel bus as an Input for your recording. 

Let’s assume you want to create a downmix of separate 
tracks, e.g. bass drum, hihats, snare etc. 

Proceed as follows:

1. Set up your separate tracks as desired and add a 
group track.

2. For each of the drum tracks, open the Output Routing 
pop-up menu and select the Group track as output. 

3. Create a new audio track, open the Output Routing 
pop-up menu for it and select the Group track as input for 
this audio track.

4. Record enable this audio track and start recording.

Now, the output of the group track will be recorded on the 
new track and you will get a mix of your separate tracks.

Note that you can also select an FX channel as recording 
source. In this case, only the output of the FX channel will 
be recorded. 

For more information about the routing possibilites, see 
“Routing” on page 14.

Selecting a folder for the recorded audio files 

Each Nuendo project has a project folder containing 
(among other things) an “Audio” folder. By default, this is 
where recorded audio files are stored. However, you can 
select record folders independently for each audio track if 
needed:

1. To select the same record folder for several audio 
tracks, select them by pressing [Shift] or [Ctrl]/[Command] 
and clicking on them in the Track list.

2. Right-click in the Track list for one of the tracks to 
bring up the track context menu.

3. Select “Set Record Folder”.

4. Use the file dialog that appears to navigate to the de-
sired folder (or create a new folder with the Create button).
Tip: if you want to have separate folders for different types of material 
(speech, ambient sounds, music, etc.), you can create subfolders within 
the Project’s “Audio” folder and assign different tracks to different sub-
folders. This way, all audio files will still reside within the project folder, 
which will make managing the Project easier.

• It’s possible to have different tracks record to totally dif-
ferent locations, even on different disks. However, if you 
need to move or archive the project, there is a risk of miss-
ing some files. The solution is to use the “Prepare Archive” 
function in the Pool to gather all external files into the 
project folder first, see “Prepare Archive” on page 309.

Setting input levels
When recording digital sound, it’s important to set the in-
put levels correctly – loud enough to ensure low noise and 
high audio quality, but not so loud that clipping (digital dis-
tortion) occurs.

Clipping typically occurs in the audio hardware when a 
too loud analog signal is converted to digital in the hard-
ware’s A/D converters. 

• It is also possible to get clipping when the signal from 
the input bus is written to a file on your hard disk.
This is because in Nuendo, you can make settings for the input bus, add-
ing EQ, effects, etc. to the signal as it is being recorded. This may raise 
the level of the signal, causing clipping in the recorded audio file.

Click here to select an input 
bus for the track.

Click here to show or hide the 
input and output settings.
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To check the level of the “unprocessed” signal coming into 
the audio hardware, you need to switch the level meters to 
“Meter Input”. In this mode, the input channel level meters 
will show the level of the signal at the input of the bus, be-
fore any adjustments such as input gain, EQ, effects, level 
or pan:

1. Right-click in the Mixer window.
The Mixer context menu appears.

2. Select the Global Meter Settings submenu and make 
sure “Meter Input” is activated.

3. Play back the audio and check the level meter for the 
input channel.
The signal should be as loud as possible without exceeding 0 dB (the 
Clipping indicator for the input bus should not light up).

The Clipping indicator.

4. If necessary, adjust the input level in one of the follow-
ing ways:

• Adjust the output level of the sound source or external 
mixer.

• Use the audio hardware’s own application program to 
set the input levels (if possible).
See the documentation for the audio hardware.

• If your audio hardware supports the ASIO Control Panel 
function, it may be possible to make input level settings.
To open the ASIO control panel, open the Device Setup dialog via the De-
vices menu and, in the list to the left (below "VST Audio System”), select 
your audio card. When this is selected, you can open the Control Panel by 
clicking on the Control Panel button in the settings section to the right.

The next step is to check the level of the audio being writ-
ten to a file on your hard disk. This is only necessary if you 
have made any adjustments to the input channel (level 
settings, EQ, insert effects, etc.). Note also:

• If you record in 32 bit float format, the bit depth will not 
be reduced – which means there’s no risk of clipping at 
this stage.
Also, this preserves the signal quality perfectly. Therefore, you should 
consider using 32 bit float format when you are recording with effects 
(see “Recording with effects” on page 76).

• If you record in 16 or 24 bit format, the available head-
room is lower, which means clipping can occur if the sig-
nal is too loud. To avoid this, set the signal level in the 
following way:

1. Bring up the mixer context menu and select “Meter 
Post-Fader” from the Global Meter Settings submenu.

2. Set up the input channel, by adding EQ and/or effects 
as desired.
With some effects you may want to adjust the level of the signal going 
into the effect – use the Input Gain knob for this. Note that you need to 
press [Shift] or [Alt]/[Option] to adjust the Input Gain.

3. Play back the audio and check the level meter of the 
input channel.
The signal should be reasonably loud but should not reach 0 dB (the 
Clipping indicator for the input bus should not light up).

4. If necessary, use the input channel fader to adjust the 
signal level.
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Monitoring
In this context, “monitoring” means listening to the input 
signal during recording. There are three fundamentally dif-
ferent ways to do this: via Nuendo, externally (by listening 
to the signal before it reaches Nuendo), or by using ASIO 
Direct Monitoring (which is a combination of both other 
methods – see below).

Monitoring via Nuendo

If you monitor via Nuendo, the input signal is mixed in with 
the audio playback. The advantage of this is that you can 
adjust the monitoring level and panning in the mixer, and 
add effects and EQ to the monitor signal just as during 
playback (using the track’s channel strip – not the input 
bus!). 

The disadvantage of monitoring via Nuendo is that the mon-
itored signal will be delayed according to the latency value 
(which depends on your audio hardware and drivers). 
Therefore, monitoring via Nuendo requires an audio hard-
ware configuration with a low latency value. You can check 
the latency of your hardware in the Device Setup dialog 
(VST Audio System page).

If you are using plug-in effects with large inherent de-
lays, the automatic delay compensation function in Nuendo 
will increase the latency.
If this is a problem, you can use the Constrain Delay Compensation func-
tion while recording, see “VST Instruments and Instrument tracks” on 
page 189.

When monitoring via Nuendo, you can select one of four 
Auto Monitoring modes in the Preferences (VST page):

• Manual.
This option allows you to turn input monitoring on or off by clicking the 
Monitor button in the Inspector, the Track list or in the mixer.
• While Record Enabled.
With this option, you will hear the audio source connected to the channel 
input whenever the track is record enabled.
• While Record Running.
This option switches to input monitoring only during recording.

• Tapemachine Style.
This option emulates standard tapemachine behavior: input monitoring in 
Stop mode and during recording, but not during playback.

• In the Preferences (VST–Metering page) you can find the 
option “Map Input Bus Metering to Audio Track (in Direct 
Monitoring)”.
When Direct Monitoring is activated in the Device Setup dialog, this op-
tion allows you to map the input bus metering to monitor-enabled audio 
tracks. This gives you the opportunity to watch the input levels of your 
audio tracks when working in the Project window. 

When Direct Monitoring is activated in the Device Setup 
dialog, this function works as follows:

• When “Map Input Bus Metering to Audio Track (in Direct 
Monitoring)” is activated, audio tracks show the metering sig-
nal from the input bus they are routed to as soon as the track 
is record-enabled.
Note that the tracks are mirroring the input bus signal, i.e. you 
will see the same signal in both places. When using mapped 
metering, any functions (e.g. trimming) you apply to the audio 
track are not reflected in its meters.

• When “Map Input Bus Metering to Audio Track (in Direct 
Monitoring)” is not activated, metering works as usual.

External monitoring

External monitoring (listening to the input signal before it 
goes into Nuendo) requires some sort of external mixer for 
mixing the audio playback with the input signal. This can 
be a stand-alone physical mixer or a mixer application for 
your audio hardware, if this has a mode in which the input 
audio is sent back out again (usually called “Thru”, “Direct 
Thru” or similar).

When using external monitoring, you cannot control the 
level of the monitor signal from within Nuendo or add VST 
effects or EQ to the monitor signal. The latency value of 
the audio hardware configuration does not affect the mon-
itor signal in this mode.

If you want to use external monitoring, you need to make 
sure that monitoring via Nuendo isn’t activated as well.
Select the “Manual” monitoring mode in the Preferences (VST page) and 
don’t activate the Monitor buttons.
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ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may sup-
port ASIO Direct Monitoring. In this mode, the actual mon-
itoring is done in the audio hardware by sending the input 
signal back out again. However, monitoring is controlled 
from Nuendo. This means that the audio hardware’s direct 
monitoring feature can be turned on or off automatically by 
Nuendo, just as when using internal monitoring.

If you are using RME Audio Hammerfall DSP audio 
hardware, make sure that the pan law is set to -3dB in the 
card’s preferences.

• To activate ASIO Direct Monitoring, open the Device 
Setup dialog on the Devices menu and activate the Direct 
Monitoring checkbox on the page for your audio hardware.
If the checkbox is grayed out, your audio hardware (or its driver) doesn’t 
support ASIO Direct Monitoring. Consult the audio hardware manufac-
turer for details.

• When ASIO Direct Monitoring is activated, you can se-
lect a monitoring mode in the Preferences (VST page), as 
when monitoring via Nuendo (see “Monitoring via Nuendo” 
on page 71).

• Depending on the audio hardware, it may also be possi-
ble to adjust monitoring level and panning from the mixer.
Consult the documentation of the audio hardware if in doubt.

• VST effects and EQ cannot be applied to the monitor 
signal in this mode, since the monitor signal doesn’t pass 
through Nuendo.

• Depending on the audio hardware, there may be special 
restrictions as to which audio outputs can be used for di-
rect monitoring.
For details on the routing of the audio hardware, see its documentation.

• The latency value of the audio hardware configuration 
does not affect the monitor signal when using ASIO Direct 
Monitoring.

Recording
Recording is done using any of the general recording 
methods (see “Basic recording methods” on page 65). 
When you finish recording, an audio file is created in the 
Audio folder within the project folder. In the Pool, an audio 
clip is created for the audio file, and an audio event that 
plays the whole clip appears on the recording track. Fi-
nally, a waveform image is calculated for the audio event. If 
the recording was very long, this may take a while.

If the option “Create Audio Images During Record” is 
activated in the Preferences (Record-Audio page), the 
waveform image will be calculated and displayed during 
the actual recording process.
This real-time calculation uses some processing power – if your proces-
sor is slow or you are working on a CPU-intensive project, you should 
consider turning this option off.

Undoing recording

If you decide that you don’t like what you just recorded, 
you can delete it by selecting Undo from the Edit menu. 
The following will happen:

• The event(s) you just created will be removed from the Project 
window.

• The audio clip(s) in the Pool will be moved to the Trash folder.
• The recorded audio file(s) will not be removed from the hard 

disk.

However, since their corresponding clips are moved to 
the Trash folder, you can delete the files by opening the 
Pool and selecting “Empty Trash” from the Media menu, 
see “Deleting from the hard disk” on page 302.
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Recording overlapping events
The basic rule for audio tracks is that each track can play 
back a single audio event at a time. This means that if two 
or more events are overlapping, only one of them will be 
heard at any given time.

What happens when you record overlapping events 
(record in an area where there are already events on the 
track) depends on the Linear Record Mode setting on the 
Transport panel:

• In “Normal” or “Merge” mode, recording where some-
thing has already been recorded creates a new audio 
event that overlaps the previous one(s).
When you record audio, there is no difference between “Normal” and 
“Merge” mode – the difference only applies to MIDI recording (see 
“About overlap and the Record Mode setting” on page 79).

• In “Replace” mode, existing events (or portions of 
events) that are overlapped by the new recording will be 
removed.
This means that if you record a section in the middle of a longer existing 
recording, that original event will be cut into two events with a gap for the 
new event.

Which event will be heard?

If two or more events are overlapping, you will only hear 
the events (or portions of events) that are actually visible. 
Overlapped (hidden) events or sections are not played 
back.

• The functions “Move to Front” and “Move to Back” on 
the Edit menu (see “Moving events” on page 44) are use-
ful for managing overlapping events, as is the “To Front” 
function (see below).

Recording audio in cycle mode
If you are recording audio in cycle mode, the result depends 
on two factors:

• The “Cycle Record Mode” setting on the Transport panel.

• The “Audio Cycle Record Mode” setting in the Prefer-
ences (Record-Audio page).

Cycle Record Modes on the Transport panel

There are five different modes on the Transport panel, but 
the first two modes only apply to MIDI recording. For au-
dio cycle recording, the following applies:

• If “Keep Last” is selected, the last complete “take” (the 
last completely recorded lap) is kept as an audio event.
In reality, all laps you recorded are saved in one audio file divided into re-
gions – one region for each take. You can easily select a previous take 
for playback – this is done as when recording in “Create Regions” mode 
(see “Create Regions mode (Preferences)” on page 74).

• If “Stacked” is selected, each take will appear as an 
event on a separate “lane” on the track.
This is useful when you want to view and edit the different takes and 
eventually combine them to one recording. In this mode, the Audio Cycle 
Record Mode preference doesn’t matter. Stacked 2 (No Mute) is the 
same as Stacked, except that all the takes will be audible. See “Recor-
ding audio in Stacked mode” on page 75. 

• If any of the other cycle recording modes is selected, 
the result depends entirely on the “Audio Cycle Record 
Mode” setting in the Preferences (Record-Audio page).
These options are described below.
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Create Events mode (Preferences)

When “Audio Cycle Record Mode” is set to “Create 
Events” in the Preferences (Record-Audio page), the fol-
lowing will happen when you record audio in cycle mode:

• One continuous audio file is created during the entire 
recording process. 

• For each recorded lap of the cycle, one audio event is 
created.
The events will have the name of the audio file plus the text “Take *”, 
where “*” indicates the number of the take.

• The last take (the last recorded lap) will be on top (and 
will thus be the one you hear when you activate playback).

To select another take for playback, proceed a follows:

1. Right-click the event and select “To Front” from the 
pop-up menu that appears.
A submenu appears, listing all the other (obscured) events.

2. Select the desired take.
The corresponding event is brought to front.

This method allows you to quickly combine the best parts 
of each take, in the following way:

1. Use the Scissors tool to split the events in several sec-
tions, one for each part of the take.
For example, if you recorded four lines of vocals (in each take), you can 
split the events so that each line gets a separate event.

The events after splitting. Note that since the original take events overlap 
each other, clicking with the Scissors tool will split all takes at the same 
position.

2. For each section of the take, use the “To Front” func-
tion to bring the best take to the front.
This way, you can quickly combine the best sections of each take, using 
the first vocal line from one take, the second line from another take and 
so on.

You can also compile a “perfect” take in the Audio Part 
Editor, see “Assembling a “perfect take”” on page 294.

Create Regions mode (Preferences)

When Audio Cycle Record Mode is set to “Create Re-
gions” in the Preferences (Record-Audio page), the fol-
lowing will happen when you record audio in cycle mode:

• One continuous audio file is created during the entire 
recording process. 

• The audio event in the Project window shows the name 
of the audio file plus the text “Take *” (with “*” being the 
number of the last completed cycle lap).

• If you play back the recorded event, you will only hear 
what was recorded during the last lap of the cycle record-
ing. 
The previous “takes” recorded in the cycle are still available, however. 

• The audio clip is divided into regions (called takes), one 
for each lap of the cycle that was recorded.
If you locate the audio file you just recorded in the Pool, and click on the 
plus sign beside it, you can see the regions that have been created, one 
for each lap of the cycle that was completed during recording.



75

Recording

“Take” regions in the Pool window.

To play back the different “takes”, proceed as follows:

1. In the Project window, right-click the event that was 
created during cycle recording.
The Quick menu appears.

2. Select the “Set To Region” menu item.
A submenu appears with the takes you recorded during cycle record.

3. Now you can select any of the takes from the submenu 
and it will replace the previous take event in the Project 
window.

Use this method to listen through the various takes. Select 
the best single take, or compile a “perfect” take by cutting 
out the best bits from each take and putting them together 
(see “Assembling a “perfect take”” on page 294).

Create Events + Regions mode (Preferences)

In this mode, both events and regions are created. If you 
work with the takes as events in this mode, you can edit 
the events freely (e.g. splitting them), see “Create Events 
mode (Preferences)” on page 74. However, in case you 
want to go back to the original takes, they are still available 
as regions (on the “Set To Region” submenu, in the Pool 
or in the Sample Editor).

Recording audio in Stacked mode

When you record audio in cycle mode and the “Stacked” 
Cycle Record Mode is selected on the Transport panel, 
the following happens: 

• Each complete recorded cycle lap is turned into a separate 
audio event.

• The track is divided into “lanes”, one for each cycle lap.
• The events are stacked above each other, each on a different 

lane.

This makes it easy to create a “perfect take” by combining 
the best parts from the different cycle laps:

1. Zoom in so you can work comfortably with the stacked 
events.

If you play back the recorded section, only the lowest 
(last) take will be heard. 

2. To audition another take, either mute the lower take(s) 
with the Mute tool or move the takes between the lanes.
This can be done by dragging or by using the functions Move to Next 
Lane/Previous Lane on the Quick menu or the Edit menu.

3. Edit the takes so that only the parts you want to keep 
can be heard.
You can cut events with the Scissors tool, resize them, mute them or de-
lete them.

The sections that will be heard are indicated in green.

4. When you are satisfied with the result, select all events 
on all lanes and select “Delete Overlaps” from the Ad-
vanced submenu on the Audio menu.
This puts all events back on a single lane and resizes events so that over-
lapped sections are removed.
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5. To turn off the lane display mode for the track, click the 
Lane Display Type button in the track list and select “Lanes 
Off”.
If the button is hidden, you can bring it to view in the Track Controls Set-
tings dialog – see “Customizing track controls” on page 507.

The Lane Display Type button.

Recording with effects
Normally you record the audio signals “dry” and add ef-
fects non-destructively during playback as described in 
the chapter “Audio effects” on page 168. However, Nu-
endo also allows you to add effects (and/or EQ) directly 
while recording. This is done by adding insert effects and/
or making EQ settings for the input channel in the mixer. 
Note:

This will make the effects become part of the audio file 
itself – you cannot change the effect settings after record-
ing.

About the record format

When you record with effects, you should consider setting 
the record format (bit depth) to 32 Bit Float. This is done 
in the Project Setup dialog on the Project menu. Note that 
this isn’t required in any way – you can also record with ef-
fects in 24 or 16 Bit format. However, there are two ad-
vantages to 32 Bit Float format:

• With 32 Bit Float recording, you don’t risk clipping (dig-
ital distortion) in the recorded files.
This can of course be avoided with 24 or 16 Bit recording as well, but re-
quires more care with the levels.

• Nuendo processes audio internally in 32 Bit Float for-
mat – recording in the same format means the audio qual-
ity will be kept absolutely pristine.
The reason is that the effect processing in the input channel (as well as 
any level or EQ settings you make there) is done in 32 Bit Float format. If 
you record at 16 or 24 Bit, the audio will be converted to this lower reso-
lution when it’s written to file – with possible signal degradation as a result.

Note also that it doesn’t matter at which actual resolution 
your audio hardware works. Even if the signal from the au-
dio hardware is in 16 Bit resolution, the signal will be 32 
Bit Float after the effects are added in the input channel.

An example

This example shows how to apply the “SoftClipper” effect 
while recording. Note that this is only an example. The prin-
ciple is the same for all effects (or combinations of effects).

1. Set up an audio track for recording and select the de-
sired input bus.
For best results, you should also activate monitoring as this allows you to 
hear and try out your settings before actually recording. See “Monitoring 
via Nuendo” on page 71 for a description of monitoring via Nuendo.

2. Open the Mixer and make sure the full extended view 
is shown.
To show the extended mixer view, either click the arrow icon (“Show Ex-
tended Mixer”) in the Common Panel, select “Show Extended View” from 
the Window submenu on the Mixer context menu or use a key command 
(this can be set in the Key Commands dialog, see “Setting up key com-
mands” on page 518).

3. Locate the input channel (bus) from which you record.
If the input channels are hidden, click on the Show/Hide Input Channels 
button to the left.

4. Check the input level (of the signal coming into the au-
dio hardware) as described in the section “Setting input 
levels” on page 69 and adjust the level of the source audio 
if necessary.
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5. Pull down the View Options pop-up menu for the input 
channel and select “Inserts”.

The View Options pop-up menu is opened by clicking the arrow button 
between the fader panel and the extended panel.

Now the extended panel for the input channel shows the 
insert slots.

6. Click on an insert slot and select an effect from the 
pop-up menu that appears.
As you see, the included effects are sorted into submenus – you will find 
the SoftClipper effect on the “Distortion” submenu.

The effect is loaded and activated and its control panel is 
automatically opened.

7. Adjust the effect parameters to your liking.
For detailed information on the Effect parameters, see the separate man-
ual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.

8. When the effect is set up as desired, you can check 
the level of the input channel by setting the Meters to 
post-fader (see “Setting input levels” on page 69). 
Use the input channel fader to adjust the level if needed.

9. Activate recording.

10. When you’re finished, you can play back the recorded 
audio track. 
As you can hear, the effect you applied is now a part of the actual audio file.

11. If you don’t want to record more with the same plug-in, 
you should deactivate it by clicking in the insert slot and 
selecting “No Effect”.

MIDI recording specifics

Activating MIDI Thru
Normally, when working with MIDI, you will have MIDI Thru 
activated in Nuendo, and Local Off selected in your MIDI 
Instrument(s). In this mode, everything you play during re-
cording will be “echoed” back out again on the MIDI out-
put and channel selected for the recording track.

1. Make sure the option “MIDI Thru Active” is activated in 
the Preferences (MIDI page).

2. Record enable the track(s) on which you want to 
record.
Now, incoming MIDI is “echoed” back out again for all record-enabled 
MIDI tracks. 

If you just want to use the Thru function for a MIDI 
track without recording, activate the monitor button for the 
track instead.
This is useful e.g. if you want to try out different sounds or play a VST 
instrument in real time without recording your playing.

Setting MIDI channel, input and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the 
same time, each on a different MIDI channel. This is the 
key to playing back several sounds (bass, piano etc.) from 
the same instrument. Some devices (such as General 
MIDI compatible sound modules) always receive on all 16 
MIDI channels. If you have such an instrument, there’s no 
specific setting you need to make in the instrument. On 
other instruments, you will have to use the front panel con-
trols to set up a number of “Parts”, “Timbres” or similar so 
that they receive on one MIDI channel each. See the man-
ual that came with your instrument for more information.

Record Enable button Monitor button
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Naming MIDI ports in Nuendo

MIDI inputs and outputs are often displayed with unneces-
sarily long and complicated names. However, you can re-
name your MIDI ports to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.

2. Select the MIDI Port Setup item in the Device list.
The available MIDI inputs and outputs are listed. Under Windows, which 
device to choose depends on your system.

3. To change the name of a MIDI port, click in the “Show 
As” column and type in a new name.
After closing the dialog, the new name will appear on the MIDI Input and 
Output Routing pop-up menus.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector (the area 
to the left of the Track list in the Project window):

1. If the Inspector is hidden, click the Show Inspector 
button on the toolbar.

2. Select the track(s) by clicking in the Track list.
To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The 
Inspector shows the settings for the first selected track (for details, see 
“The Inspector” on page 26).

3. Click the track name in the Inspector to make sure the 
topmost section is shown.

4. Pull down the Input Routing pop-up menu and select 
an input.
The available MIDI inputs are shown. The items on the menu depend on 
the type of MIDI interface you are using, etc. 

• If you select the “All MIDI Inputs” option, the track will receive 
MIDI data from all available MIDI inputs.

• If you hold down [Alt]/[Option] and select a MIDI input, this is 
selected for all selected MIDI tracks.

Setting the MIDI channel and output

The MIDI channel and output settings determine where 
the recorded MIDI is routed during playback, but are also 
relevant for MIDI Thru in Nuendo. Channel and output can 
be selected in the Track list or in the Inspector. The proce-
dure below describes how to make the settings in the In-
spector, but it can be done in largely the same manner in 
the Track list as well.

1. To select the track(s) and show the settings in the 
Inspector, proceed as when selecting a MIDI input (see 
above).

2. Pull down the Output routing pop-up menu and select 
an output.
The available MIDI outputs are shown. The items on the menu depend on 
what type of MIDI interface you are using etc.

• If you hold down [Alt]/[Option] and select a MIDI output, this is 
selected for all selected MIDI tracks.
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3. Use the channel pop-up menu to select a MIDI chan-
nel for the track.

• If you set the track to MIDI channel “Any”, each MIDI 
event on the track will be sent out on the channel stored in 
the event itself.
In other words, the MIDI material will be played back on the channel(s) 
used by the MIDI input device (the MIDI instrument you play during re-
cording).

Selecting a sound
You can select sounds from within Nuendo by instructing 
the program to send Program Change and Bank Select 
messages to your MIDI device. This is done using the 
“Patch Selector” and “Bank Selector” fields in the Inspec-
tor or Track list.

Program Change messages give access to 128 different 
program locations. If your MIDI instruments have more 
than 128 programs, Bank Select messages (set in the 
“Bank Selector” field) allow you to select different banks, 
each containing 128 programs.

Bank Select messages are recognized differently by 
different MIDI instruments. The structure and numbering 
of banks and programs may also vary. Consult the docu-
mentation of your MIDI instruments for details.

Note that it is also possible to select sounds by name. 
For descriptions of how to set this up, see the separate 
“MIDI Devices” PDF document.

Recording
Recording MIDI is done according to the basic recording 
methods (see “Basic recording methods” on page 65). 
When you finish recording, a part containing MIDI events 
is created in the Project window.

About overlap and the Record Mode setting

MIDI tracks are different from audio tracks when it comes 
to overlapping parts:

All events in overlapping parts are always played back.
If you record several parts at the same locations (or move parts so that 
they overlap), you will hear the events in all parts on playback, even 
though some of the parts are obscured in the Project window.

When recording overlapping parts, the result depends on 
the Linear Record Mode setting on the Transport panel:

• If the record mode is set to “Normal”, overdub recording 
works as with audio tracks, i.e. if you record again where 
something has already been recorded, you get a new part that 
overlaps the previous one(s).

• If the record mode is set to “Merge”, the overdubbed events 
are added to the existing part.

• If the record mode is set to “Replace”, the new recording re-
places any existing events in the area on that track.

About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch 
in/out recording for MIDI tracks is done in exactly the 
same way as for audio tracks. There is one thing to note, 
however: 

• Punching in and out on recordings with Pitch Bend or 
controller data (modulation wheel, sustain pedal, volume 
etc.) may lead to strange effects (apparently hanging 
notes, constant vibrato etc.).
If this happens, you may need to use the Reset item on the MIDI menu 
(see “The Reset function” on page 81).

About the Automatic MIDI Record Quantize function

If Auto Quantize is activated on the Transport panel (the 
“Auto Q” button), the notes you record are automatically 
quantized according to the current Quantize settings. For 
more information about quantizing, see “The Quantizing 
functions” on page 352.
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Recording MIDI in cycle mode
When you record MIDI in cycle mode, the result depends 
on which Cycle Record mode is selected on the Transport 
panel:

Cycle Record mode: Mix (MIDI)

For each completed lap, everything you record is added to 
what was previously recorded in the same part. This is 
useful for building up rhythm patterns, for example. 
Record a hi-hat part on the first lap, the bass drum part on 
the second lap etc. 

Cycle Record mode: Overwrite (MIDI)

As soon as you play a MIDI note (or send any MIDI mes-
sage), all MIDI you have recorded on previous laps is over-
written from that point on in the part. An example:

1. You start recording in an eight bar cycle.

2. The first take wasn’t good enough – you start directly 
with a new take on the next cycle lap and overwrite the 
first take.

3. After recording the second take you let the recording 
roll on and listen, without playing anything. 
You find that the take was good up until bar seven, for example.

4. On the next lap, you wait until bar seven and start play-
ing.
This way you will overwrite the last two bars only.

5. Make sure you stop playing before the next lap begins 
– otherwise you will overwrite the entire take.

Cycle Record mode: Keep Last

Each completed lap replaces the previously recorded lap. 
Note:

• The cycle lap must be completed – if you deactivate re-
cording or press Stop before the cursor reaches the right 
locator, the previous take will be kept.

• If you don’t play or input any MIDI during a lap, nothing 
happens (the previous take will be kept).

Cycle Record mode: Stacked/Stacked 2 (No Mute)

In this mode, the following happens: 

• Each recorded cycle lap is turned into a separate MIDI part.
• The track is divided into “lanes”, one for each cycle lap.
• The parts are stacked above each other, each on a different 

lane.
• All takes but the last one are muted (Stacked). 
• If Stacked 2 is selected, no muting takes place.

This makes it easy to create a “perfect take” by combining 
the best parts from the different cycle laps. You can edit 
the parts in the Project window (by cutting, resizing and 
deleting) or you can use a MIDI editor as in the following 
example:

1. Unmute the muted takes by clicking the parts with the 
Mute tool.

2. Select all takes (parts) and open them in the Key Edi-
tor for example.

3. Use the part list pop-up menu on the toolbar to select 
which part to edit.
See “Handling several parts” on page 365.

4. Remove or edit notes as desired.

5. When you are happy with the result, close the editor.

6. To turn it all into a single MIDI part (containing your 
“perfect take”), select all parts and select “Merge MIDI in 
Loop” from the MIDI menu.

7. In the dialog that appears, activate the Erase Destina-
tion option and click OK.
The remaining events in the parts are merged together into a single part.
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Recording different types of MIDI messages

Notes

When you press and release a key on your synth or other 
MIDI keyboard, a Note On (key down) and a Note Off (key 
up) message are sent out. The MIDI note message also 
contains the information which MIDI channel was used. 
Normally, this information is overridden by the MIDI chan-
nel setting for the track, but if you set the track to MIDI 
channel “Any”, the notes will be played back on their orig-
inal channels.

Continuous messages

Pitch bend, aftertouch and controllers (like modulation 
wheel, sustain pedal, volume etc.) are considered as MIDI 
continuous events (as opposed to the momentary key down 
and key up messages). If you move the Pitch bend wheel on 
your synthesizer while recording, this movement is re-
corded together with the key (Note On and Note Off mes-
sages), just as you’d expect. But the continuous messages 
can also be recorded after the notes have been recorded 
(or even before). They can also be recorded on their own 
tracks, separately from the notes to which they belong. 

Say, for instance, that you record one or several bass 
parts on track 2. If you now set another track, like track 55, 
to the same output and MIDI channel as track 2, you can 
make a separate recording of just pitch bends for the bass 
parts on track 55. This means that you activate recording 
as usual and only move the pitch bend wheel during the 
take. As long as the two tracks are set to the same output 
and MIDI channel, it will appear to the MIDI instrument as 
if the two recordings were made at the same time.

Program Change messages

Normally, when you switch from one program to another 
on your keyboard (or whatever you use to record), a num-
ber corresponding to that program is sent out via MIDI as 
a Program Change message. These can be recorded on 
the fly with the music, recorded afterwards on a separate 
track, or manually entered in the Key or List Editors. 

System Exclusive messages

System Exclusive (SysEx) is a special type of MIDI mes-
sage used to send data that only makes sense to a unit of 
a certain make and type. SysEx can be used to transmit a 
list of the numbers that make up the settings of one or 
more sounds in a synth. For more about viewing and edit-
ing SysEx messages, see the chapter “Working with Sys-
tem Exclusive messages” on page 410.

The Reset function
The Reset function on the MIDI menu sends out note-off 
messages and resets controllers on all MIDI channels. 
This is sometimes necessary if you experience hanging 
notes, constant vibrato, etc.

• Nuendo can also automatically perform a MIDI reset on 
stop.
You can turn this function on or off in the Preferences (MIDI page).

• Also in the Preferences (MIDI page), you can find the 
option “Insert Reset Events after Record”.
This is a very handy function for MIDI recording. At the end of each re-
corded part, a Reset event will be inserted, resetting controller data such 
as Sustain, Aftertouch, Pitchbend, Modulation, Breath Control, etc. This 
is useful if a MIDI part is recorded and e.g. the Sustain pedal is still held 
after stopping recording. Usually, this would cause all following parts to 
be played with Sustain, as the Pedal Off command was not recorded. 
This can be prevented by activating “Insert Reset Events after Record”.

Retrospective Record
This feature allows you to capture any MIDI notes you play 
in Stop mode or during playback and turn them into a MIDI 
part “after the fact”. This is possible due to the fact that 
Nuendo can capture MIDI input in buffer memory, even 
when not recording.

Proceed as follows:

1. Enable the Retrospective Record option in the Prefer-
ences (Record-MIDI page).
This activates the buffering of MIDI input, making Retrospective Record 
possible.

2. Make sure a MIDI track is record-enabled.

3. When you have played some MIDI material you want 
to capture (either in Stop mode or during playback), select 
Retrospective Record from the Transport menu (or use 
the key command, by default [Shift]-[Pad*]).

! You can decide exactly which event types should be 
recorded by using the MIDI filters – see “Filtering 
MIDI” on page 82.
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The content of the MIDI buffer (i.e. what you just played) is 
turned into a MIDI part on the record enabled track. The 
part will appear where the project cursor was when you 
started playing – this means that if you played along dur-
ing playback, the captured notes will end up exactly where 
you played them in relation to the project.

• The Retrospective Record Buffer Size setting in the 
Preferences (Record-MIDI page) determines how much 
data can be captured.

MIDI Preferences
There are several other options and settings in the Prefer-
ences that affect MIDI recording and playback:

MIDI page

• Length Adjustment
Adjusts the length of notes so that there is always a short time between 
the end of one note and the start of another (of the same pitch and on the 
same MIDI channel). The time is set in ticks. By default there are 120 
ticks per 1/16 note, but you can adjust this with the MIDI Display Reso-
lution setting on the same page.

Record-MIDI page

• Snap MIDI Parts to Bars
When this is activated, recorded MIDI parts will automatically be length-
ened to start and end at whole bar positions. If you are working in a 
Bars+Beats-based context, this can make editing (moving, duplicating, 
repeating, etc.) easier.

• Solo Record in MIDI Editors
If this is activated and you open a part for editing in a MIDI editor, its track 
is automatically record-enabled. Furthermore, Record Enable is deacti-
vated for all other MIDI tracks until you close the editor again.
This makes it easier to record MIDI data when you’re editing a part – you 
will always be sure the recorded data ends up in the edited part and not 
on any other track.

• MIDI Record Catch Range in ms
When you record starting at the left locator, this setting helps you make 
sure the very start of the recording is included. A very annoying scenario is 
when you have recorded a perfect MIDI take, only to find out that the very 
first note wasn’t included – because you started playing a little bit too early! 
If you raise the Record Catch Range, Nuendo will catch the events played 
just before the recording start point, eliminating this problem. 

For a description of the other options, click the Help but-
ton in the Preferences.

Filtering MIDI

The MIDI–MIDI Filter page in the Preferences allows you 
to prevent certain MIDI messages from being recorded 
and/or “thruput” (echoed by the MIDI Thru function).

The dialog is divided into four sections:

Section Description

Record Activating any of these options prevents that type of MIDI 
message from being recorded. It will, however, be thru-
put, and if already recorded, it will play back normally.

Thru Activating any of these options prevents that type of MIDI 
message from being thruput. It will, however, be re-
corded and played back normally.

Channels If you activate a channel button, no MIDI messages on 
that MIDI channel will be recorded or thruput. Already re-
corded messages will, however, be played back normally.

Controller Allows you to prevent certain MIDI controller types from 
being recorded or thruput.
To filter out a controller type, select it from the list at the 
top of the Controller section and click “Add”. It will ap-
pear on the list below.
To remove a controller type from the list (allow it to be re-
corded and thruput), select it in the lower list and click 
“Remove”.
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Options and Settings

Recording-related Transport Preferences
A couple of settings in the Preferences (Transport page) 
are relevant for recording. Set these according to your 
preferred method of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is auto-
matically deactivated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after 
automatic punch out (when the project cursor reaches the 
right locator and punch out is activated on the Transport 
panel). If the postroll value on the Transport panel is set to 
a value other than zero, playback will continue for the set 
time before stopping (see below).

About Preroll and Postroll

The preroll and postroll value fields (below the left/right 
locator fields) on the Transport panel have the following 
functionality:

• By setting a preroll value, you instruct Nuendo to “roll 
back” a short section whenever playback is activated.
This applies whenever you start playback, but is perhaps most relevant 
when recording from the left locator (punch in activated on the Transport 
panel) as described below.

• By setting a postroll value, you instruct Nuendo to play 
back a short section after automatic punch out before 
stopping.
This is only relevant when punch out is activated on the Transport panel 
and “Stop after Automatic Punch Out” is activated in the Preferences 
(Transport page).

• To turn preroll or postroll on or off, click the correspond-
ing button on the Transport panel (next to the pre/postroll 
value) or use the “Use Preroll” and “Use Postroll” options 
on the Transport menu.

An example:

1. Set the locators to where you want to start and end re-
cording.

2. Activate Punch in and Punch out on the Transport 
panel.

3. Activate the option “Stop after Automatic Punch Out” 
in the Preferences (Transport page).

4. Set suitable preroll and postroll times by clicking in the 
corresponding fields on the Transport panel and typing in 
time values.

5. Activate preroll and postroll by clicking the buttons 
next to the preroll and postroll times so that they light up.

6. Activate recording.
The project cursor “rolls back” by the time specified in the preroll field 
and playback starts. When the cursor reaches the left locator, recording 
is automatically activated. When the cursor reaches the right locator, re-
cording is deactivated, but playback continues for the time set in the 
postroll field before stopping.

Using the metronome
The metronome can output a click that can be used as a 
timing reference. The two parameters that govern the tim-
ing of the metronome are tempo and time signature, and 
these are edited in the Tempo Track window (see “Editing 
the tempo curve” on page 417).

You can use the metronome for a click during recording 
and/or playback or for a precount (count-in) that will be 
heard when you start recording from Stop mode. Click 
and precount are activated separately:

• To activate the metronome, click the Click button on the 
Transport panel.
You can also activate the “Metronome On” option on the Transport menu 
or use the corresponding key command (by default [C]).

• To activate the precount, click the Precount button on 
the Transport panel.
You can also activate the “Precount On” option on the Transport menu 
or set up a key command for this.

Preroll value field and on/
off switch.

Postroll value field and 
on/off switch.

Click on/off Precount on/off
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Metronome settings

You make settings for the metronome in the Metronome 
Setup dialog, opened from the Transport menu.

The metronome can use either an audio click played back 
via the audio hardware, send MIDI data to a connected 
device which will play back the click or do both. 

The following metronome settings can be made in the dia-
log:

Metronome 
Options

Description

Metronome in 
Record / Play

Allows you to specify whether the metronome should be 
heard during playback, recording or both (when Click is 
activated on the Transport panel).

Use 
Count Base

If this option is activated, a field appears to the right 
where you specify the “rhythm” of the metronome. Nor-
mally, the metronome plays one click per beat, but setting 
this to e.g. “1/8” gives you eighth notes – two clicks per 
beat. It’s also possible to create unusual metronome 
rhythms such as triplets etc.

Precount 
Options

Description

Precount Bars Sets the number of bars the metronome will count in be-
fore it starts recording if precount is activated on the 
Transport panel.

Use Time Signa-
ture at Record 
Start Time

When this is activated, the precount will automatically 
use the time signature and tempo set at the position 
where you start recording.

Use Time 
Signature at 
Project Time

When this is activated, the precount will be in the time 
signature set in the Tempo track. Furthermore, any tempo 
changes in the Tempo track during the precount will be 
applied.

Use Signature… This lets you set a time signature for the precount. In this 
mode, tempo changes in the Tempo track won’t affect 
the precount.

MIDI Click Description

Activate MIDI 
Click

Selects whether or not the metronome will sound via 
MIDI.

MIDI Port/
Channel

This is where you select a MIDI output and channel for 
the metronome click.

Hi Note/
Velocity

Sets the MIDI note number and velocity value for the 
“high note” (the first beat in a bar). 

Lo Note/
Velocity

Sets the MIDI note number and velocity for the “low 
notes” (the other beats). 

Audio Click Description

Activate Audio 
Click

Selects whether or not the metronome will sound via the 
audio hardware.

Beeps When this is selected, the audio clicks will be beeps gen-
erated by the program. Adjust the pitch and level of the 
beeps for the “Hi” (first) beat and “Lo” (other) beats using 
the sliders below.

Sounds When this is selected, you can click in the “Sound” fields 
below to load any audio files for use as the “Hi” and “Lo” 
metronome sounds. The sliders set the level of the click.

Precount 
Options

Description
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Recovery of audio recordings after 
system failure
Normally, when a computer crashes, all changes made to 
your current project since you last saved it will be lost. Usu-
ally, there is no quick and easy way to recover your work.

With Nuendo, when your system crashes while you are re-
cording (because of a power cut or other mishap), you will 
find that your recording is still available, from the moment 
when you started recording to the time when your com-
puter crashed.

When you experience a computer crash during a record-
ing, simply relaunch the system and check the project 
record folder (by default this is the Audio subfolder inside 
the project folder). It should contain the audio file you 
were recording at the time of the crash.

! Please note: This feature does not constitute an 
“overall” guarantee by Steinberg. While the program 
itself was improved in such a way that audio record-
ings can be recovered after a system failure, it is al-
ways possible that a computer crash, power cut, etc. 
might have damaged another component of the 
computer, making it impossible to save or recover 
any of the data.

! Warning: Please do not try to actively bring about 
this kind of situation to test this feature. Although the 
internal program processes have been improved to 
cope with such situations, Steinberg cannot guaran-
tee that other parts of the computer are not damaged 
as a consequence.
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Creating fades
There are two main types of fade-ins and fade-outs in au-
dio events in Nuendo: fades created by using the fade 
handles (see below) and fades created by processing 
(see “Fades created by processing” on page 89).

Fades created by using the fade handles
Selected audio events have blue handles in the upper left 
and right corners. These can be dragged to create a fade-
in or fade-out respectively.

Creating a fade-in. The fade is automatically reflected in the shape of 
the event’s waveform, giving you a visual feedback of the result when 
you drag the fade handle. 

Fades created with the handles are not applied to the au-
dio clip as such but calculated in real time during play-
back. This means that several events referring to the same 
audio clip can have different fade curves. It also means 
that having a huge number of fades may demand a lot of 
processor power.

• If you select multiple events and drag the fade handles 
on one of them, the same fade will be applied to all se-
lected events.

• A fade can be edited in the Fade dialog, as described 
on the following pages. 
You open the dialog by double-clicking in the area above the fade curve, 
or by selecting the event and selecting “Open Fade Editor(s)” from the 
Audio menu (note that this will open two dialogs if the event has both 
fade-in and fade-out curves).
If you adjust the shape of the fade curve in the Fade dialog, this shape 
will be maintained when you later adjust the length of a fade.

• You can make the fade longer or shorter at any time, by 
dragging the handle.
You can actually do this even without selecting the event first, i.e. without 
visible handles. Just move the mouse pointer along the fade curve until 
the cursor turns into a bidirectional arrow, then click and drag.

• If the option “Show Event Volume Curves Always” is ac-
tivated in the Preferences dialog (Event Display–Audio 
page), the fade curves will be shown in all events, regard-
less of whether they are selected or not.
If the option is deactivated, the fade curves are shown in selected events 
only.

• If the option “Fade Handles always on Top” is activated 
in the Preferences dialog (Event Display-Audio page), the 
fade handles stay at the top of the event, and vertical help 
lines indicate the exact end or start points of fades.
This is useful in situations where you want the event volume to be very 
low, as this option allows you to still see the fade handles.

• If the option “Thick Fade Lines” is activated in the Pref-
erences dialog (Event Display-Audio page), the fade lines 
and volume curve are thicker, increasing their visibility.

Fade handles on top of the event and thicker fade and volume lines al-
low you to edit and view fades even in situations where event volume is 
very low.

• When the option “Use Mouse Wheel for Event volume 
and Fades” is activated in the Preferences dialog (Edit-
ing–Audio page), you can use the mouse wheel to move 
the volume curve up or down. When you hold down [Shift] 
while moving the mouse wheel, this will change the fade 
curves. This is useful in situations where the fade handles 
are not visible (e.g. because of a very high zoom factor).
When you position the mouse pointer somewhere in the left half of the 
event, the fade in end point is moved. When the mouse pointer is in the 
right half of the event, the fade out start point will move.

You can set up key commands for changing the event 
volume curve and any fade curves, if you don’t want to use 
the mouse for this.
You will find these commands in the Key Commands dialog, in the Audio 
category. See “Key commands” on page 517.

As an alternative to dragging the fade handles, you 
can use the items “Fade In to Cursor” and “Fade Out to 
Cursor” on the Audio menu to create fades.
Position the project cursor on an audio event where you want a fade in to 
end or a fade out to begin, and select the appropriate option from the 
Audio menu. A fade will then be created, ranging from the event’s start or 
end to the position of the cursor.
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Creating and adjusting fades with the Range Selection 
tool

“Handle-type” fades can also be created and adjusted 
with the Range Selection tool, in the following way:

1. Select a section of the audio event with the Range Se-
lection tool.

The result depends on your selection, in the following way:

• If you select a range from the beginning of the event, a fade-in 
will be created within the range. 

• If you select a range that reaches the end of an event, a fade-
out will be created in the range. 

• If you select a range encompassing a middle section of the 
event, but not reaching neither the start nor the end, both a 
fade-in and a fade-out will be created outside of the selected 
range. In other words, the fade-in will cover the area from the 
beginning of the event to the beginning of the selected range, 
and the fade-out will cover the area from the end of the se-
lected range to the end of the event.

2. Pull down the Audio menu and select “Adjust Fades to 
Range”.
The fade areas are adjusted according to the selection range.

Applying Default Fades

You can also create fades by using the commands “Apply 
Standard Fade In” and “Apply Standard Fade Out” from 
the Audio menu.

1. Select one or more audio events in the project window.

2. From the Audio menu, choose either “Apply Standard 
Fade In” or “Apply Standard Fade Out”.
A fade will be created that is the same length and shape as the Default 
fade (see “As Default button” on page 90 for more information on how to 
define Default fades).

About the volume handle

A selected audio event also has a blue handle in the top 
middle. This is the volume handle, and it provides a quick 
way of changing the volume of an event, directly in the 
Project window. It is linked directly with the volume setting 
on the info line, that is, dragging the volume handle also 
changes the value on the info line.

Removing fades

To remove the fades for an event, select the event and se-
lect “Remove Fades” from the Audio menu.

You can also use the Range Selection tool to remove 
fades and crossfades within the selected range:

1. Drag the Range Selection tool in the Project window, 
so that the selection encloses all of the fades and cross-
fades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

! You can select multiple audio events on separate 
tracks with the Range Selection tool, and apply the 
fade to all of them simultaneously.

Drag the Volume handle 
up or down to change 
the volume of the event.

The volume change is displayed 
numerically in the info line.

The event waveform reflects the volume change.
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Fades created by processing
If you have selected an audio event or a section of an au-
dio event (using the Range Selection tool), you can apply 
a fade-in or fade-out to the selection by using the “Fade 
In” or “Fade Out” functions on the Process submenu on 
the Audio menu. These functions open the corresponding 
Fade dialog, allowing you to specify a fade curve.

Fades created this way are applied to the audio clip rather 
than to the event. Please note the following:

• If you later create new events that refer to the same clip, these 
will have the same fades.

• You can remove or modify the fades at any time using the Of-
fline Process History (see “The Offline Process History dialog” 
on page 251).

If other events refer to the same audio clip, you will be 
asked whether you want the processing to be applied to 
these events or not.

• Continue will apply the processing to all events that refer to 
the audio clip.

• New Version will create a separate, new version of the audio 
clip for the selected event.

• You can also activate “Do not show this message again”. Re-
gardless of whether you then choose “Continue” or “New Ver-
sion”, any further processing will conform to the option you 
select.

The Fade dialogs
The Fade dialogs appear when you edit an existing fade or 
use the “Fade In”/”Fade Out” functions on the Process 
submenu on the Audio menu. The picture below shows 
the Fade In dialog; the Fade Out dialog has identical set-
tings and features.

• If you open the Fade dialog(s) with several events se-
lected, you can adjust the fade curves for all these events 
at the same time.
This is useful if you want to apply the same type of fade-in to more than 
one event, etc.

Curve Kind

These determine whether the fade curve should consist of 
spline curve segments (left button), damped spline seg-
ments (middle button) or linear segments (right button).

Fade display

Shows the shape of the fade curve. The resulting wave-
form shape is shown in dark gray, with the current wave-
form shape in light gray.

You can click on the curve to add points, and click and 
drag existing points to change the shape. To remove a 
point from the curve, drag it outside the display.

Curve shape buttons

These buttons give you quick access to some common 
curve shapes.

! Note that the length of the fade area is determined 
by your selection. In other words, you specify the 
length of the fade before you enter the Fade dialog. 

! Also note that you can select multiple events and ap-
ply the same processing to all of them simultaneously.

! You can change this setting at any time in the Prefer-
ences dialog (Editing–Audio page), under “On Pro-
cessing Shared Clips”.
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Restore button

The Restore button (to the right above the fade display) is 
only available when editing fades made by dragging the 
fade handles. Click this to cancel any changes you have 
made since opening the dialog.

Fade Length Value

The Fade Length Value can be used to enter fade lengths 
numerically. The format of values displayed here are deter-
mined by the Primary Time Display in the Transport Panel.

When you activate the “Apply Length” option, the value 
entered in the Fade Length value field will be used when 
clicking “Apply” or “OK”. This setting is deactivated by de-
fault.

Presets

If you have set up a fade-in or fade-out curve that you may 
want to apply to other events or clips, you can store it as a 
preset by clicking the Store button.

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double-click on the name 
and type a new one. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

As Default button

The “As Default…” button is only available when editing 
fades made by dragging the fade handles. Click this to 
store the current settings as default fade. This shape will 
be used whenever you create new fades by dragging 
event handles. Both the shape and length will be used 
when you create fades using the “Apply Standard Fade…” 
commands from the Audio menu.

Preview, Apply and Process

The buttons in the bottom row are different depending on 
whether you are editing a fade made with the fade handles 
or applying a fade using processing:

The Edit Fade dialogs have the following buttons:

The Process Fade dialogs have the following buttons:

! When you set the current Fade as the Default fade, 
the length value is included as part of the default set-
tings.

! Stored fade-in presets will only appear in the Fade In 
dialog, and fade-out presets will only appear in the 
Fade Out dialog.

Button Function

OK Applies the set fade curve to the event, and closes the 
dialog.

Cancel Closes the dialog.

Apply Applies the set fade curve to the event, without closing 
the dialog.

Button Function

Preview Plays back the fade area. Playback will repeat until you 
click the button again (the button is labeled “Stop” during 
playback).

Process Applies the set fade curve to the clip, and closes the 
dialog.

Cancel Closes the dialog without applying any fade.

The Edit Fade dialog.

The Process Fade dialog.
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Creating crossfades
Overlapping audio material on the same track can be 
crossfaded, for smooth transitions or special effects. You 
create a crossfade by selecting two consecutive audio 
events and selecting the Crossfade command on the Au-
dio menu (or by using the corresponding key command, 
by default [X]). The result depends on whether the two 
events overlap or not:

• If the events overlap, a crossfade is created in the over-
lapping area.
The crossfade will be of the default shape – initially a linear, symmetric 
crossfade, but you can change this as described below.

• If the events don’t overlap but are directly consecutive 
(lined up end-to-start, with no gap) it’s still possible to 
crossfade them – provided that their respective audio 
clips overlap! In this case, the two events are resized so 
that they overlap, and a crossfade of the default length 
and shape is applied.
The default crossfade length and shape are set in the Crossfade dialog 
(see “As Default button” on page 90).

An example:

The events in themselves do not overlap, but their clips do. Therefore, 
the events can be resized so that they overlap, which is required for a 
crossfade to be created.

When you select the Crossfade function, the two events are resized so 
that they overlap, and a default crossfade is created in the overlapping 
section.

• If the events don’t overlap, and cannot be resized 
enough to overlap, a crossfade cannot be created.

• You can specify the length of the crossfade using the 
Range Selection tool: make a selection range covering the 
desired crossfade area and use the Crossfade command.
The crossfade is applied in the selected range (provided that the events 
or their clips overlap, as above). You can also make a selection range af-
ter creating the crossfade and use the function Adjust fades to Range on 
the Audio menu.

• Once you have created a crossfade, you can edit it by 
selecting one or both crossfaded events, and selecting 
“Crossfade” from the Audio menu again (or by double-
clicking in the crossfade zone). 
This opens the Crossfade dialog, see below.

Removing crossfades
To remove a crossfade, select the events and select “Re-
move Fades” from the Audio menu, or use the Range Se-
lection tool:

1. Drag the Range Selection tool in the Project window, 
so that the selection encloses all of the fades and cross-
fades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

• You can also remove a crossfade by clicking and drag-
ging it outside the track.

Overlapping section.

Audio clips.

Audio events.
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The Crossfade dialog

This section describes the default Crossfade dialog.
However, if you activate the option Simple Crossfade Editor in the Pref-
erences dialog (Editing-Audio page), a simplified dialog will be used in-
stead (similar to the regular fade dialogs).

The Crossfade display
The upper part of the Crossfade dialog shows the shape 
of the whole crossfade curve and the resulting waveform. 
You can perform a number of click and drag operations in 
this display.

• Click and drag these points to change the length of the 
fade-out curve (upper) or the fade-in curve (lower), re-
spectively:

If “Symmetric Fades” is activated, these change the length of both the 
fade out and the fade in curve instead. The length change will be ap-
plied equally to both sides, without moving the “Offset Point” (see 
“Changing the Offset Point” on page 96).

• Click and drag these points to move the fade-out curve 
(upper) or the fade-in curve (lower), respectively:

If “Symmetric Fades” is activated, these change the length of both the 
fade out curve and the fade in curve instead – by moving only the end or 
the start of the curves as well as the “Offset Point”.
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• Click and drag these points to move the Offset Point 
(the dotted line) for the fade-out curve (upper) or the fade-
in curve (lower), respectively:

Moving the Offset Point will also move the fade curve. If “Symmetric 
Fades” is activated, the Offset Point for both curves will be moved.

• You can also click and drag to move audio clips (along 
with the fade curve) in the display. The pointer takes on the 
shape of a hand to indicate that it’s possible to move a clip.

• You can right-click (Win) or [Ctrl]-click (Mac) in the 
ruler and use the pop-up menu to select a time format 
(see “The ruler” on page 31).

• You can scroll and zoom the display with the horizontal 
and vertical scroll bars and zoom controls.

Options and settings
The lower part of the Crossfade dialog contains a number 
of common settings and controls, as well as separate (but 
identical) settings for the fade-in (top) and the fade-out 
curve (bottom) of the crossfade.

Nudge Range

This pop-up menu lets you specify the range that is moved 
when using the nudge buttons, see “Using the Nudge 
controls” on page 95.

Nudge Mode

Here, you can specify whether you want the fade or the 
audio to move when you use the Nudge buttons, see “Us-
ing the Nudge controls” on page 95.

Point Offset

The Offset Point is the “center” of the fade area, i.e. the 
point where the volume of the event is precisely halfway 
between full level and zero level. For further information, 
see “Changing the Offset Point” on page 96.

Symmetric Fades

If this is activated, you cannot edit the fade in and fade out 
curves of the crossfade separately, i.e. the editing controls 
will be “linked”, so that both fade curves are affected by 
the same amount regardless of whether you use the fade-
out or fade-in controls. The actual result however, de-
pends on which control is used.

Length, Overlap and Volume

• Use the Length field to specify the length of the cross-
fade, see “Resizing the crossfade area” on page 95.

• Use the Overlap field to move the fade area without ad-
justing the Offset point, see “Using the Overlap controls” 
on page 96.

• You can use the Volume controls to change the volume 
of the crossfaded events. Either use the Volume sliders or 
click in the Volume fields, change the values numerically 
and press [Return].
This is the same as using the volume handles in the Event display, see 
“About the volume handle” on page 88.

The Nudge buttons

Use the nudge buttons to nudge the fade area or the au-
dio in the desired direction, see “The Nudge buttons” on 
page 93.

The Fade Displays

The fade displays show the shape of the fade-out and 
fade-in curve, respectively. You can click on the curve to 
add points, and click and drag existing points to change 
the shape. To remove a point from the curve, drag it out-
side the display.
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Curve buttons

• The curve kind buttons determine whether the corre-
sponding fade curve should consist of spline curve seg-
ments (left button), damped spline segments (middle 
button) or linear segments (right button).

• The curve shape buttons give you quick access to some 
common curve shapes.

Equal Gain and Power

• If you activate the “Equal Gain” checkbox, the fade 
curves are adjusted so that the summed fade-in and fade-
out amplitudes will be the same all along the crossfade 
region. 
This is often suitable for short crossfades.

• If you activate the “Equal Power” checkbox, the fade 
curves are adjusted, so that the energy (power) of the 
crossfade will be constant all along the crossfade region.

Play buttons

• The “Play Fade Out” and “Play Fade In” buttons allow 
you to audition the fade-out or fade-in part only, without 
the crossfade.

• The “Play Crossfade” button plays back the whole 
crossfade.

You can also use the Transport play controls to play back 
the crossfaded audio events. However, that method will 
play back all unmuted audio events on other tracks as well.

Pre-roll and Post-roll

When auditioning with the Play buttons, you can activate 
pre-roll and/or post-roll. Pre-roll lets you start playback 
before the fade area, and post-roll lets you stop playback 
after the fade area. This can be useful for auditioning the 
fade in a context.

• To specify how long the pre- and post-roll should be, 
click in the time fields and enter the desired time (in sec-
onds and milliseconds).

• To activate pre-/post-roll, click the respective button.
To deactivate, click the button again.

1 second pre-roll activated.

Autoscroll

If this option is activated, the crossfade display will be 
scrolled during playback, so that the play position cursor 
is always visible. This works just like Autoscroll in the 
Project window (see “Autoscroll” on page 57).

Note that this only applies if you use the Transport play 
controls – not if you use the Play controls in the Crossfade 
dialog.

Zoom and Auto Zoom

If you have scrolled or zoomed the crossfade display hori-
zontally (see “The Crossfade display” on page 92), you can 
click the “Zoom to Fade” button (the magnifying glass icon) 
to quickly revert to the standard zoom factor and center the 
display on the currently selected crossfade area.

If Auto Zoom is activated (checked), the crossfade display 
will automatically be zoomed and centered on the current 
crossfade if you resize it (see “Resizing the crossfade 
area” on page 95).

! Equal Power curves have only one editable curve 
point. You cannot use the Curve kind buttons or the 
presets when this mode is selected.
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Presets

If you have set up a crossfade that you may want to apply 
to other events, you can store it as a preset by clicking the 
store button (the disk icon).

• To apply a stored preset, select it from the pop-up 
menu. 

• To rename the selected preset, double-click on the 
name and type in a new one. 

• To remove a stored preset, select it from the pop-up 
menu and click the remove button (the trash icon).

Default buttons

Clicking the “As Default” button stores all of the current 
settings as the default crossfade. These settings will then 
be used whenever you create new crossfades.

Clicking the “Recall Default” button copies the curves and 
settings in the Default crossfade to the Crossfade dialog.

Select Crossfade buttons

These allow you to select the previous/next crossfade 
area on the current track, if it contains more than one 
crossfade.

• If “Project selection follows” is activated, selecting an-
other crossfade will automatically change the event selec-
tion in the Project window.

Resizing the crossfade area
You can adjust the length of the crossfade area either in 
the crossfade display (see “The Crossfade display” on 
page 92), by using the Length controls or by clicking in 
the “Length” fields, changing the value numerically and 
pressing [Return].

• If “Symmetric Fades” is activated, both the fade out and 
the fade in length will be changed by the same amount. 
Otherwise, the upper Length controls change the length 
of the fade-out curve, and the lower controls change the 
length of the fade-in curve.

• If possible, the length change will be applied equally to 
“both sides” of the crossfade (i.e. Nuendo tries to “center” 
the crossfade).

Moving the crossfade area
You can move the crossfade area in the crossfade display 
(see “The Crossfade display” on page 92), with the 
Nudge buttons, with the Overlap controls (either the slider 
or numerically) or by changing the Offset Point.

Using the Nudge controls

• When you use the Nudge controls, you can decide 
whether they should move the fade area or the audio clip, 
by clicking the corresponding radio button under “Nudge 
Mode”. 

• Each time you click a Nudge button, the fade area or the 
audio event will be moved in the corresponding direction 
by the amount specified on the “Nudge Range” pop-up 
menu.
The Nudge buttons in the upper region affect the fade-out curve, and the 
Nudge buttons in the lower region affect the fade-in curve. Note that it is 
only possible to move the audio of the second event – i.e. the event that 
is faded in.

• You can also click in the Nudge value field, enter a nu-
merical value and press [Return] to move a fade area or an 
audio event.

• If “Symmetric Fades” is activated, and the Nudge Mode 
is set to “Move Fade”, both the fade-out area and the 
fade-in area will be moved by the same amount.

• If “Symmetric Fades” is activated, and the Nudge Mode 
is set to “Move Audio”, the Nudge buttons in the lower re-
gion will move the audio event with the fade in.
In this mode, the Nudge buttons in the upper region will move both the 
entire fade area and the audio event with the fade in.

! To be able to resize a crossfade this way, it must be 
possible to resize the corresponding event. For ex-
ample, if the left crossfaded event already plays its 
audio clip to the end, its endpoint cannot be moved 
any further to the right.
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Using the Overlap controls

The Overlap controls let you move the fade area without 
moving the Offset Point – the “center” of the fade area 
(see below). This means that the “center” of the fade will 
be offset in relation to the fade area.

• You can either use the Overlap sliders or you can click 
in the Overlap fields, change the values numerically and 
press [Return].

• If “Symmetric Fades” is activated, both the upper and 
the lower Overlap controls will move both the fade-out 
and the fade-in area.

Changing the Offset Point

You can also move a fade area by changing its Offset 
Point. The Offset Point is the “center” of the fade area, i.e. 
the point where the volume of the event is precisely half-
way between full level and zero level.

• Click in the value field, enter the desired value, in accor-
dance with the selected display format (see “The Cross-
fade display” on page 92) and press [Return].
This will move the Offset Point along with the fade area by the specified 
amount. Note however that this only applies to the fade-in area!

• The Offset Point is indicated by a dotted vertical line in 
the crossfade display.

Auto Fades and Crossfades
Nuendo features an Auto Fade function that can be set 
both globally, i.e. for the entire project, and separately for 
each audio track. The idea behind the Auto Fade function 
is to create smoother transitions between events by ap-
plying short (1 - 500 ms) fade-ins and fade-outs.

Making global Auto Fade settings
1. To make Auto Fades settings globally for the project, 
select “Auto Fades Settings...” from the Project menu.
This opens the Auto Fades dialog for the project.

2. Use the checkboxes in the upper right corner to acti-
vate or deactivate Auto Fade In, Auto Fade Out and Auto 
Crossfades, respectively.

3. Use the Length value field to specify the length of the 
Auto Fade or Crossfade (1-500 ms).

! As mentioned earlier, fades are calculated in real 
time during playback. This means that the larger the 
number of audio tracks with Auto Fades activated in 
a project, the higher the demands on the processor.

! Note that auto fades are not indicated by the fade 
lines!
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4. To adjust the shapes of Auto Fade In and Auto Fade 
Out, select the “Fades” tab and make settings as in the 
regular Fade dialogs.

5. To adjust the shape of the Auto Crossfade, select the 
“Crossfades” tab and make settings as in the regular 
Crossfade dialog.

6. If you want to use the settings you have made in future 
projects, click the “As Default” button.
The next time you create a new project, it will use these settings by default.

7. Click OK to close the dialog.

Making Auto Fade settings for a separate 
track
By default, all audio tracks will use the settings you have 
made in the project’s Auto Fades dialog. However, since 
Auto Fades use computing power, a better approach may 
be to turn Auto Fades off globally and activate them for in-
dividual tracks, as needed:

1. Right-click the track in the Track list and select “Auto 
Fades Settings...” from the context menu (or select the 
track and click the “Auto Fades Settings” button in the In-
spector).
The Auto Fades dialog for the track opens. This is identical to the project’s 
Auto Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.
Now, any settings you make will be applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to project settings

If you want a track to use the global Auto Fade settings, 
open the Auto Fades dialog for the track and activate the 
“Use Project Settings” checkbox. 

Event Envelopes
An envelope is a volume curve for an audio event. It is sim-
ilar to the real-time fades, but allows you to create volume 
changes within the event, not only at the start or end. To 
create an envelope for an audio event, proceed as follows:

1. Zoom in on the event so that you can view its waveform 
properly.

2. Select the Pencil tool.
When you move the Pencil tool over an audio event, a small volume curve 
symbol is shown next to the tool.

3. To add an envelope point, click in the event with the 
Pencil tool.
A blue envelope curve and a curve point appear.

4. Drag the curve point to adjust the envelope shape.
The waveform image reflects the volume curve.

• You can add as many curve points as you like.

• To remove a curve point from the envelope, click on it 
and drag it outside the event.

• The envelope curve is a part of the audio event - it will 
follow when you move or copy the event.
After copying an event with an envelope, you can make independent ad-
justments to the envelopes in the original event and the copy.

It is also possible to apply an envelope to the audio 
clip using the Envelope function on the Process submenu 
on the Audio menu.
See “Envelope” on page 242.

• To remove an event envelope curve from a selected 
event, open the Audio menu and select the Remove 
Volume Curve option.
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Introduction
The Arranger track allows you to work with sections of 
your project in a non-linear fashion, to simplify arranging to 
the maximum extent. Instead of moving, copying and past-
ing events in the Project window event display to create a 
linear project, you can define how different sections are to 
be played back, like a playlist.

For this, you can define arranger events, order them in a list, 
and add repeats as desired. This offers a different and more 
pattern-oriented way of working, which complements the 
usual linear editing methods in the Project window. 

You can create several Arranger chains, making it possi-
ble to store different versions of a song within the project 
without sacrificing the original version. When you have 
created an Arranger chain that you like, you have the op-
tion of “flattening” the list, which creates a normal linear 
project based on the Arranger chain. You can chose to 
keep the Arranger track or to remove it. 

You can also use the Arranger track for live performances 
on the stage, in clubs or at parties.

Setting up the Arranger track
Let’s say you have prepared a number of audio files that 
form the base of a typical pop song, with introduction, 
verse, chorus and bridge. Now you want to arrange these 
files.

The first step is to create an Arranger track. On the Ar-
ranger track, you define specific sections of the project by 
creating arranger events. These can be of any length, may 
overlap and are not bound to the start or end of existing 
events and parts. Proceed as follows:

1. Open the project for which you want to create arranger 
events.

2. Open the Project menu and select “Arranger” from the 
Add Track submenu (or right-click in the Track list and se-
lect Add Arranger track).
An Arranger track is added. There can be only one Arranger track in a 
project, but you can set up more than one Arranger chain for this track, 
see “Managing Arranger chains” on page 102.

3. On the Project window toolbar, make sure that Snap 
is activated, and that the Grid resolution is set to a mode 
that allows your arranger events to snap to appropriate 
positions in the project.

Snap to events is activated, i. e. when drawing in the Project window, 
new events will snap to existing events.

4. On the Arranger track, use the Pencil tool to draw an 
event of the desired length.
An Arranger event is added, called “A” by default. Any following events 
will be named in alphabetical order. 

• You can rename an Arranger event by selecting it and 
changing its name in the Project window info line or by 
holding down [Alt]/[Option], double-clicking on the name 
in the Arranger chain (see below) and entering a new 
name.
You may want to name your arranger events according to the structure of 
your project, e.g. Verse, Chorus etc.

5. Create as many events as you need for your project.

In this example, arranger events have been created that correspond to a 
classic pop song structure. Note how there is no real time line in the 
project: the music sequence is determined by the arranger events.

Events can be moved, resized and deleted using the stan-
dard techniques. Please note:

• If you want to change the length of a event, select the 
Arrow tool and click and drag the bottom corners of the 
event in the desired direction.

• If you copy an Arranger event (by [Alt]/[Option]-drag-
ging or by using copy/paste), a new event will be created 
with the same name as the original.
However, this new event will be totally independent from the original event.

• Double-clicking on an arranger event adds it to the cur-
rent Arranger chain.



100

The Arranger track

Working with arranger events
You now have a number of arranger events that form the 
basic building blocks for your arrangement. The next step 
is to arrange these events using the functions of the Ar-
ranger Editor.

Creating an Arranger chain
You can set up an Arranger chain in the Arranger Editor or 
in the Inspector for the Arranger track. The Arranger Editor 
is opened by clicking the “e” button in the Inspector or in 
the Arranger track. 

To the right in the Arranger Editor, the available arranger 
events are listed, in the order they appear on the time line. 
To the left you find the actual Arranger chain, which shows 
in which order the events will be played back, from top to 
bottom, and how many times they should be repeated.

Initially the Arranger chain will be empty – you set up the 
Arranger chain by adding events from the right list to the 
Arranger chain. There are several ways to add events to 
the Arranger chain.

• Double-clicking on the name of an event in the window 
section on the right (or in the project window).
When an event is selected in the Arranger chain on the left will add the 
event above the selected event. When no events are selected in the Ar-
ranger chain on the left will add the event to the end of the list.

• By selecting one or more events in the right list, right-
clicking and selecting “Append Selected In Arranger 
Chain”.
This will add the selected events at the end of the list.

• By dragging and dropping arranger events from the 
right list to the left list.
A blue insertion line shows you where the dragged event will end up in the 
list.

Here, the Verse event is dragged into the Arranger chain and placed af-
ter the first chorus.

• By dragging arranger events from the Project window 
and dropping them in the Arranger chain.

If you followed our example, you should now have arranger 
events arranged in a very basic pop song pattern. How-
ever, we have used audio files that are only a few bars 
long – to turn our pattern into a “song” (or at least into a 
basic sketch of the song structure), these files must be 
looped. This is where the Repeats function comes in.

If you want an event to repeat several times, proceed as 
follows:

• Click in the Repeats field for an event, type in the de-
sired number of repeats and press [Enter].
When playing back the Arranger chain, the Counter column indicates 
which repeat of this event is currently playing.

Click in the Inspector…

…or the Track list…

…to open the Arranger Editor.
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• Click in the Mode field for an event and select the de-
sired repeat mode.

When you now play back the Arranger chain, you will hear 
the complete arrangement. Proceed as follows:

1. Make sure that Arranger mode is activated.
When Arranger mode is activated, the project will be played back using 
the Arranger settings.

The Arranger mode button must be activated.

2. Position the Arranger Editor window so that you can 
see the Arranger track in the Project window, and click in 
the arrow column for the event at the top of the list so that 
the arrow becomes blue.
You should see the project cursor jump to the beginning of the first event 
specified in the Arranger chain.

3. Activate playback, either from the Arranger Editor or 
on the Transport panel.
The events are played back in the specified order.

Editing the Arranger chain
In the Arranger chain to the left, you can do the following:

• Select events by clicking or [Shift]-clicking.
The selected events do not have to be a continuous selection.

• Drag events to move them in the list.

• Drag events while holding [Alt]/[Option] to create cop-
ies of the selected items.
The insert location for both move and copy operations is indicated by a 
blue or red line in the list. A blue line indicates that the move or copy is 
possible; a red line indicates that if the current position were to be used, 
a move or copy is not allowed.

• Use the Repeats column to specify how many times 
each event should be repeated.

• Click the arrow to the left of an event in the Arranger 
chain to move the playback position to the start of that 
event.

• To remove an event from the list, right-click on it and se-
lect “Remove Touched” from the pop-up menu that ap-
pears. To remove several events, select them, right-click 
and select “Remove Selected”.

Navigating
To navigate between arranger events, you use the Ar-
ranger transport buttons:

These controls are available in the Arranger Editor, the 
Project window toolbar, and the Transport panel.

In the Arranger Editor, the event that is currently played 
back is indicated by an arrow in the leftmost column, and 
the indicators in the Counter column. You can switch be-
tween Arranger chains during playback using the pop-up 
menu in the Editor, Inspector or Track list.

Option Button Description

Normal In this mode, your Arranger chain will be played 
back normally, just as you set it up.

Repeat for-
ever

In this mode, the current Arranger event will be re-
peated in a loop until you either click on another 
event in the Arranger Editor or press play once 
again.

Pause after 
Repeats

In this mode, the playback of the Arranger chain 
will be stopped after having played back all re-
peats of the current Arranger event.

First repeat of current chain step
Previous chain step

Next chain step Last repeat of current chain step
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Managing Arranger chains
You can create several Arranger chains. This way, you can 
create alternative versions for playback. In the Arranger 
Editor, the toolbar buttons on the right are used for this:

The Arranger chains you create will be listed on the Name 
pop-up menu, found in the Arranger Editor to the left of 
the buttons, at the top of the Arranger track Inspector, and 
in the Track list. Please note that to be able to select an-
other Arranger chain from the pop-up menu, Arranger 
mode must be activated.

• In the Inspector, these functions are accessed from the 
Arranger pop-up menu (opened by clicking on the Ar-
ranger name field).

Flattening the Arranger chain
When you have found an Arranger chain that suits your pur-
poses, you can “flatten” it, i.e. convert the list into a linear 
project. Proceed as follows:

1. Click the Flatten button (or select Flatten Chain from 
the pop-up menu in the Inspector for the Arranger track).
The events and parts in the project are reordered, repeated, resized, 
moved and/or deleted (if these are not within the boundaries of any used 
Arranger event), so that they correspond exactly to the Arranger chain.

The Flatten button

2. Activate Playback.
The project will now play back exactly as in Arranger mode, but you can 
view it and work with it as usual.

Flattening options
Sometimes it might be useful to keep the original Arranger 
events even after flattening the Arranger track. By using flat-
tening options you can define which chain should be flat-
tened (Source section), where it should be stored and how 
it should be named (Destination section) together with 
other options (Options section). 

1. Click the Flattening options button.

2. In the window that appears, select the desired options.

In the Source section you can specify, which Arranger 
chain should be flattened. The available options are:

Button Description

Click this to rename the current Arranger chain.

Creates a new, empty Arranger chain.

Creates a duplicate of the current Arranger chain, containing 
the same events.

Removes the currently selected Arranger chain. Only avail-
able if you have created more than one Arranger chain.

! Flattening the Arranger chain may remove events 
and parts from the project. Only use the Flatten func-
tion when you know you don’t want to edit the Ar-
ranger track/chain any more. If in doubt, save a copy 
of the project before flattening the Arranger chain.

Option Description

Current Chain If you activate this option, only the current chain will be 
flattened.

Checked Chain If you activate this option, you can select the arranger 
chains you want to flatten in the list to the left.

All Chains If you activate this option, all arranger chains of the cur-
rent project will be flattened.
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The Destination section allows you to choose where the 
result of the flattening should be saved. The available op-
tions are:

In the Options section you can make further settings. The 
available options are:

3. You can now flatten the Arranger track by clicking the 
Flatten button.
If you realize that you want to do further arrangements, you can also click 
the “Go Back” button and make your adjustments. Your Flattening set-
tings will be kept.

4. Click the “Go Back” button to go back to the Arranger 
Editor or close the window by clicking its Close button.

Live Mode
If you have set up an Arranger track and play it back, you 
have also the possibility to influence the playback order 
“live”. Note that the Arranger mode has to be activated to 
be able to use the Live mode. 

1. Add an Arranger track by selecting “Arranger” from the 
Add Track submenu of the Project menu.

2. Create the desired Arranger events by drawing with 
the Pencil tool on Arranger track.

3. Set up an Arranger chain in the Inspector for the Ar-
ranger track or in the Arranger Editor, activate the Ar-
ranger mode and play back your project.

Now you can use your Arranger events listed in the lower 
section of the Arranger track Inspector to play back your 
project in Live Mode:

4. Switch into Live mode by clicking on the little arrow in 
the lower list of the Arranger track Inspector to the left of 
the Arranger event you want to trigger.
The Arranger event will be looped endlessly, until you click on another Ar-
ranger event. This might be useful, if you want to loop e.g. a guitar solo with 
a flexible length.

• You can stop Live mode by clicking the Stop button or 
go back to “normal” playback in Arranger mode by clicking 
on any arranger event in the upper list.
In the latter case, playback will be continued from the arranger event 
where you clicked. The “Select grid” pop-up menu will always be taken 
into account. When the grid is set to “1 Bar” and you click the STOP 
button e.g., playback will be stopped after the next bar.

Option Description

Current Project This option is only available, if you have selected “Current 
Chain” as Source. If you activate this option, the result of 
the flattening of the current chain will be saved in the cur-
rent project.

New Project If you activate this option, you can flatten one or several 
chains in a new project. In this case it might be useful to 
use naming options. If you activate “Append Chain 
Name”, the Chain Name(s) will be appended in brackets 
to the project name. If you activate “Use Chain Name”, 
the new project(s) will have the name of the current Ar-
ranger chain(s). If you activate “Add Number”, the new 
project(s) will be named like the old ones and a number 
will be appended in brackets.

Option Description

Keep Arranger 
Track

If you activate this option, the Arranger Track will be kept 
when flattening the Arranger chain. If you activate the op-
tion “Rename Arranger Events” a number will be ap-
pended to the events according to their use. If e.g. you 
use Arranger event “A” two times, the first occurrence 
will be renamed “A 1” and the second “A 2”.

Make Real Event 
Copies

Normally, you will get shared copies when flattening the 
Arranger track. If you activate this option, real copies will 
be created instead.

Don’t Split 
Events

If the option is activated, MIDI notes that start before or 
are longer than the Arranger event will not be included. 
Only MIDI notes that begin and end inside the Arranger 
event boundaries will be taken into account.

Open New 
Projects

If you activate this option, a new project will be created 
for every flattened Arranger chain. If you activate the op-
tion “Cascade New Projects” the opened projects will be 
cascaded.
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The active Arranger event will be played back as long as 
defined before jumping to the next.

Arranging your music to video
The relative time of your Arranger track can be taken as a 
reference instead of the project time. This is useful, if you 
want to use the Arranger track to compose music for 
video and fill e.g. a specific video section with music, by 
repeating the corresponding number of Arranger events. 

If you position your external sync master device to a posi-
tion that does not match the Project Start time, Nuendo 
will jump automatically to the right position in the Arranger 
track and will start playback from there, i.e. the correct rel-
ative position and not the absolute project time will be 
found. The reference for the external timecode can be 
MIDI or any other Timecode that can be interpreted/read 
by Nuendo. 

If the Arranger mode is not activated or no Arranger 
track exists, Nuendo will work as usual. 

Below follows an example, that will help you understand 
this functionality:

1. Set up a project with a MIDI track and three MIDI parts. 
The first should start at position 00:00:00:00 and end at 
position 00:01:00:00, the second should start at position 
00:01:00:00 and end at position 00:02:00:00 and the 
third should start at position 00:02:00:00 and end at po-
sition 00:03:00:00.

2. Activate the Sync button on the transport panel.

3. Add an Arranger track and create Arranger events that 
match the MIDI parts.

4. Set up the Arranger chain “A-A-B-B-C-C”, activate 
the Arranger mode and play back your project.

5. Start external Timecode at position 00:00:10:00 
(within the range of "A").
In your project, the position 00:00:10:00 will be located and you will hear 
"A" playing. Nothing special!

Now, let’s see what happens if your external sync master 
device starts at a position that does not match the Project 
Start time:

6. Start at 00:01:10:00 (within the range of what origi-
nally was "B").
In your project, the position 00:01:10:00 will be located and you will hear 
"A" playing, because it plays twice in the Arranger track.

7. Start external Timecode at position 00:02:10:00 
(within the range of what originally was "C").
In your project, the position 00:02:10:00 will be located and you will hear 
"B" playing, because it plays "later" in the Arranger track.

Option Description

Now Jumps to the next section immediately.

4 bars, 
2 bars

When one of these modes is selected, a grid of 4 or 2 bars (de-
pending on the setting) will be placed on the active Arranger 
event. Whenever the respective grid line is reached, playback 
will jump to the next Arranger event. An example:
Let’s say you have an Arranger event which is 8 bars long and 
the grid is set to 4 bars. When the cursor is anywhere within the 
first 4 bars of the Arranger event when you hit the next Arranger 
event, playback will jump to the next event when the end of the 
fourth bar of the Arranger event is reached. When the cursor is 
anywhere within the last 4 bars of the Arranger event, playback 
will jump to the next event at the end of the event.
When an event is shorter than 4 (or 2) bars when this mode is 
selected, playback will jump to the next section at the event end.

1 bar Jumps to the next section at the next bar line.

1 beat Jumps to the next section at the next beat.

End Plays the current section to the end, then jumps to the next sec-
tion.
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About folder tracks

Just as the name implies, a folder track is a folder that con-
tains other tracks. Moving tracks into a folder is a way to 
structure and organize tracks in the Project window. For 
example, grouping several tracks in a folder track makes it 
possible for you to “hide” tracks (thus giving you more 
working space on the screen). You can solo and mute 
several tracks in a quicker and easier way and perform ed-
iting on several tracks as one entity. Folder tracks can 
contain any type of track including other folder tracks. 

Handling folder tracks

Creating a folder track
Folder tracks are created just like any other track: Select 
“Add Track” from the Project menu and select “Folder” 
from the submenu that appears, or right-click in the Track 
list and select “Add Folder Track” from the context menu.

Moving tracks into a folder
You can move any type of track into a folder by using drag 
and drop:

1. In the Track list, click on a track that you want to move 
into a folder and drag it onto a folder track.
A green arrow pointing to a folder appears when you drag the track onto 
the folder track in the list.

2. Release the mouse button.
The track is now placed in the folder track, and all parts and events on 
the track will be represented by a corresponding folder part (see “Wor-
king with folder parts” on page 107), which is a graphical representation 
of all parts and events in the folder.

Since you can move any type of track into a folder track, it 
is possible to create sub-folders by moving one folder 
track into another. This is called “nesting”. For example, 
you could have a folder containing all the vocals in a 
project, and each vocal part could have a nested folder 
containing all the takes for easier handling etc.

Removing tracks from a folder
To remove a track from a folder, simply drag it out of the 
folder and release it in the Track list.

Hiding/showing tracks in a folder
You can hide or show the tracks located in a folder by 
clicking on the “Expand/Collapse Folder” button (the 
folder icon). Hidden tracks are still played back as usual.

When a folder is “closed” this way, the folder part(s) still 
give you a graphic representation of the parts and events 
within the folder.

• In the Track Folding submenu of the Project menu, there 
are several options for hiding/showing elements inside 
folders. These are described in detail in the section “Track 
folding” on page 39.

A folder track

Tracks in the 
folder
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Muting and soloing folder tracks
One of the main advantages of using folder tracks is that 
they provide you with a way to mute and solo several tracks 
as one unit. Muting and soloing a folder track affects all 
tracks in the folder. You can also solo or mute individual 
tracks in the folder. 

Muting a folder track

You can mute a folder track (and thereby mute all tracks 
within it) the same way you mute other tracks by clicking in 
the Mute (“M”) button in the Track list.

Soloing a folder track

You can solo a folder track (and thereby mute all tracks 
outside the folder, except those already set to Solo) the 
same way you solo other tracks, by selecting it and click-
ing the Solo button.

Soloing or muting tracks within a folder

This can be done by showing the tracks in the folder and 
using the Mute and Solo buttons in the Track list as usual 
for any tracks inside the folder.

Working with folder parts
A folder part is a graphic representation of events and 
parts on the tracks in the folder. Folder parts indicate the 
position and length of the events and parts, as well as on 
which track they are (their vertical position). If part colors 
are used, these are also shown in the folder part.

Folder parts are created automatically when there are 
parts or events on the tracks within the folder. The follow-
ing rules apply:

• If there is a gap between parts/events on the tracks, 
there will be two separate folder parts.

• Parts or events that overlap within the folder may be 
represented by the same folder part or by two different 
folder parts – depending on how much they overlap.
If a part/event overlaps by half its length or less, it will be placed in a new 
folder part.

Handling and editing folder parts
Most of the editing you can do in the Project window ap-
plies to folder parts as well.

Any Project window editing you perform to a folder part 
affects all the events and parts it contains (those elements 
on the track within the folder that are represented by the 
folder part). You can select several folder parts if you like 
– this allows you to handle and edit them together. The 
editing you can perform includes:

• Moving a folder part. This will move its contained events and 
parts (possibly resulting in other folder parts, depending on 
how the parts overlap).

• Using cut, copy and paste.
• Deleting a folder part. This will delete its contained events and 

parts.
• Splitting a folder part with the Scissors tool (see the example 

below).
• Gluing folder parts together with the Glue tube tool. This will 

only work if the adjacent folder parts contain events or parts 
on the same track.

• Resizing a folder part resizes the contained events and parts 
according to the selected resizing method. This is set by click-
ing the Arrow tool icon on the toolbar and selecting “Normal 
Sizing”, “Sizing Moves Contents” or “Sizing Applies Time 
Stretch” from the pop-up menu – see “Resizing events” on 
page 48. Note that if you select “Sizing Applies Time Stretch”, 
any automation data is not taken into account.

• Muting a folder part. This will mute its contained events and 
parts.

The “snare1” event overlaps the 
“snare2” event by more than half 
its length, which means it is in-
cluded in the same folder part.

The “bass drum” event does not 
overlap with any of the other 
events. This means a new folder 
part is created.
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An example

Editing tracks within folder parts
Tracks inside a folder can be edited as one entity by per-
forming the editing directly on the folder part containing 
the tracks as explained above. You can also edit individual 
tracks within the folder by showing the contained tracks, 
selecting parts and opening editors as usual.

Double-clicking a folder part opens the editors for the cor-
responding track classes present in the folder. The follow-
ing applies:

• All MIDI parts located on the tracks within the folder are 
displayed as if they were on the same track, just like when 
opening the Key Editor with several MIDI parts selected.
To be able to easily discern the different tracks in the editor, give each 
track a different color in the Project window and use the “Part Colors” 
option in the editor (see “Coloring notes and events” on page 370).

• If the folder contains tracks with audio events and/or au-
dio parts, the Sample and/or Audio Part Editors are opened 
with each audio event and audio part in a separate window.

Splitting the folder part 
with the Scissors tool…

…will split all contained parts or 
events present at that position.
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About markers
Markers are used to locate certain positions quickly. If you 
often find yourself jumping to a specific position within a 
project, you should insert a marker at this position. There 
are two types of markers:

• Cycle markers allow you to store the start and end positions of 
a range.

• Standard markers store a specific position. 

Markers can be created and edited in several ways: 

• By using the Marker window (see below).
• By using the Marker track (see “Using the Marker track” on 

page 111).
• By using key commands (see “Marker key commands” on 

page 113).
• By using the Project Browser (see “Editing markers in the Pro-

ject Browser” on page 113).

The left and right locators are handled separately – 
see “The left and right locators” on page 61.

The Marker window

In the Marker window, you can perform most editing oper-
ations concerning markers. The markers are listed in the 
Marker window in the order in which they occur in the 
project. Most functions in the Marker window are also 
available in the Inspector when the Marker track is se-
lected.

To open the Marker window, you can:

• Select “Markers” from the Project menu
• Click the “Show” button in the Marker section on the Trans-

port panel
• Use the key command (by default [Ctrl]/[Command]-[M]).

The Marker window columns

The Marker window is divided into six columns which are 
used for performing the following operations:

• The leftmost column is the Locate column. 
Clicking in this column will move the project cursor to the corresponding 
marker position. A blue arrow indicates the marker at the project cursor 
position (or the closest marker before the project cursor).

• The ID column is used to edit marker ID numbers. 
See “About marker ID numbers” on page 111.

• The Position column displays the markers’ time posi-
tions (or start positions for cycle markers).
The marker positions can be edited directly in this column.

• The End and Length columns display the end positions 
and length of cycle markers – see “About cycle markers” 
on page 111.
These values can also be edited directly in the respective column.

• The Description column lets you enter names or de-
scriptions for markers.

Click on a column heading to sort the marker list by that 
column. The Marker columns can also be reordered by 
dragging and dropping the column headers.

Adding and removing markers in the Marker window

• You add position markers (in Stop mode, during play-
back or during recording) by clicking the Add button or by 
pressing [Insert] (Windows only) on the computer key-
board. Markers are always added at the current project 
cursor position. 

• To add a cycle marker, select “Cycle Markers” from the 
Show pop-up menu and click the Add button.
This adds a cycle marker between the left and right locator. You can also 
draw cycle markers on the Marker track (see “Editing markers on the 
Marker track” on page 112).

• To remove a marker, select it and click the Remove but-
ton.

Note that you can assign key commands to various 
marker commands in the Key Commands dialog (see 
“Marker key commands” on page 113).
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Moving marker positions in the Marker window

The Move button in the Marker window can be used to 
“reprogram” marker positions. Proceed as follows:

1. Set the project cursor to the position to which you 
want to move (or re-program) a marker.

2. Select the marker that you want to change in the 
Marker window.
Do not select the marker by clicking in the leftmost column, as this will 
move the project cursor to this marker.

• If a cycle marker is selected, the Move operation affects 
the cycle marker start position.
The length of the range is not affected.

3. Click the Move button.

You can also move markers by editing their position nu-
merically in the Position column.

About marker ID numbers
Each time you add a marker, it is automatically and se-
quentially assigned an ID number, starting from ID 1. ID 
numbers can be changed at any time – this allows you to 
assign specific markers to key commands (see below). 

IDs for cycle markers are shown in brackets and start from 
[1]. These may also be changed.

Assigning markers to key commands

As explained above, marker ID numbers are assigned au-
tomatically and sequentially each time you add a marker. 
The nine first markers (1 to 9) can be recalled by using key 
commands – by default these are [Shift]-[1] to [9] on the 
typewriter part of the keyboard.

If you have more than nine markers, you cannot use 
key commands to navigate to markers numbered 10 or 
higher.

If you want to keep all current markers, but want to specify 
which markers should be accessed via key commands, 
the solution is to reassign the marker ID numbers. Pro-
ceed as follows:

1. First decide which of the current markers with an ID 
between 1 and 9 you want to reassign to a new ID number, 
and thus remove its key command assignment.
Memorize the ID number.

2. Enter this ID number in the ID column of the marker you 
want to access with a key command and press [Enter].
The two marker ID numbers are switched, and the key command now 
locates to the marker selected in this step.

3. Repeat as necessary for other markers.

• You can also simply remove a marker with an ID number 
between 1 to 9 to free up a key – see “Adding and remo-
ving markers in the Marker window” on page 110.

• For more about marker key commands, see “Marker key 
commands” on page 113.

Using the Marker track

The Marker track is used for viewing and editing markers. 
Markers shown on the Marker track are exactly the same 
as shown in the Marker window, and any changes made 
on the Marker track are reflected in the Marker window 
and vice versa. Standard position markers in the Marker 
track are shown as marker events: vertical lines with the 
marker name (if assigned) and number beside it. If you se-
lect the Marker track, all markers are shown in the Inspec-
tor, much like in the Marker window.

About cycle markers
Cycle markers are shown on the Marker track as two 
markers bridged by a horizontal line. Cycle markers are 
ideal for storing sections of a project. By setting cycle 
markers for sections of a song, for example “Intro”, 
“Verse”, “Chorus” etc., this enables you to quickly navi-
gate to the song sections, and also to optionally repeat 
the section (by activating Cycle on the Transport panel). 

In addition, Cycle markers appear on the horizontal Zoom 
pop-up menu in the Project window (see below).

Adding the Marker track
To add the Marker track to the Project, select “Marker” from 
the Add Track submenu of the Project menu (or right-click 
in the Track list and select “Add Marker Track”). You can 
only have one Marker track in a project.

Cycle markers Markers Locators
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Editing markers on the Marker track
The following editing functions can be performed directly 
on the Marker track:

• Adding position markers “on the fly”.
Use the [Insert] key (Win) or the “Add Marker” button in the Track list for 
the Marker track to add position markers at the current cursor position 
during playback. 

• Adding a cycle marker at the left and right locator posi-
tions.
Clicking the “Add Cycle Marker” button in the Track list for the Marker 
track adds a cycle marker spanning the area between the left and right 
locator.

• Selecting markers.
You can use standard selection techniques like dragging to make a se-
lection rectangle, or use [Shift] to select separate markers.

• Drawing position markers.
By using the Pencil tool (or pressing [Alt]/[Option] and using the Arrow 
tool), you can create or “draw” position marker events at any position on 
the track. If snap is activated on the toolbar, this determines at which po-
sitions you can draw markers.

• Drawing cycle markers.
To draw a cycle marker range, press [Ctrl]/[Command] and use the Pen-
cil tool or the Arrow tool. Snap settings are applied if activated. 

Cycle markers can freely overlap. 

• Resizing a cycle marker.
Select a cycle marker by clicking on it. Two handles appear at the bottom 
of the start and end events. If you click and hold one of the handles you 
can drag the event left or right to resize the cycle marker. This can also 
be done numerically on the info line.

• Moving markers.
Click and drag to move the selected markers or edit marker positions on 
the info line. As usual, snap is taken into account if activated.

• Removing markers.
This is done exactly the same way as for other events, i.e. by selecting 
them and pressing [Delete], using the Erase tool etc.

• Naming markers.
A selected marker’s name can be edited on the info line.

Navigating using cycle markers
Cycle markers represent ranges rather than single posi-
tions. Therefore you don’t use them for moving the project 
cursor, but for moving the left and right locators:

• If you double-click on a cycle marker or select it from 
the Cycle pop-up menu in the Track list, the left and right 
locators are moved to encompass the cycle marker.
To move the project cursor position to the start or the end of the cycle 
marker, move it to the corresponding locator (e.g. by using the numeric 
pad keys [1] and [2]).

• You can also use key commands for this – see “Marker 
key commands” on page 113.

Zooming to cycle markers

• By selecting a cycle marker on the Zoom pop-up menu, 
the event display is zoomed in to encompass the selected 
range only (see the section “Zoom presets and Cycle mar-
kers” on page 36).
You can also do this by pressing [Alt]/[Option] and double-clicking on 
the cycle marker in the event display.

Editing cycle markers using tools

Cycle markers can be edited on the Marker track using the 
following tools (Snap applies as usual):

The other tools cannot be used with cycle markers.

Add Marker/Add Cycle Marker buttons

Tool Use

Pencil Press [Ctrl]/[Command] and use the Pencil tool to create 
new cycle markers (as described above).

Eraser Click with the Eraser tool to delete a cycle marker. If you 
hold down [Alt]/[Option] when you click, all consecutive 
markers will also be deleted.

Selection 
Range

This is described in the following section.
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Using markers to make range selections in the 
Project window
Besides enabling you to quickly move the project cursor 
and the locators, markers can be used in conjunction with 
the Range Selection tool to make range selections in the 
Project window. This is useful if you quickly want to make 
a selection that spans all tracks in the project. 

• Double-click with the Range Selection tool between any 
two markers – this creates a selection range between the 
markers, spanning all tracks in the project (just as if you had 
used the Range Selection tool to draw a rectangle).
Any functions or processing you perform now will affect the selection only.

Moving and copying sections

This is a quick way to move or copy complete sections of 
the project (on all tracks):

1. Set markers at the start and end of the section you 
want to move or copy.

2. Select the Range Selection tool and double-click on 
the Marker track between the markers.
Everything in the project within the cycle marker boundaries is selected.

3. Click on the Marker track in the selected range and 
drag the range to a new position.
The selection in the Project window is moved to the same position.

• If you hold down [Alt]/[Option] while you drag the range, 
the selection in the Project window is copied instead.

Marker key commands
You can use key commands for the following marker oper-
ations:

If you need to check or change any key command assign-
ments, the marker commands can be found in the Trans-
port category in the Key Commands dialog.

For the [Shift]+[Pad1] to [Pad9] commands to work, 
Num Lock must be deactivated on the computer key-
board!

Editing markers in the Project 
Browser

If you have a Marker track in the Project window, you can 
create and edit all marker parameters, including marker 
IDs, in the Project Browser. Proceed as follows:

1. Open the Project Browser by selecting it from the 
Project menu.

2. Select “Marker” in the Project Structure window.
A list of the markers is shown in the main Browser window.

3. Now you can edit marker names, positions and ID 
numbers by selecting an item and typing in values as usual 
in the main editor window.
For details about editing in the Project Browser see “Editing the Marker 
track” on page 433.

• You can use the Add pop-up menu in combination with 
the Add button to insert new markers or cycle markers 
when the Marker track is selected in the Project Browser.
This works just like the Add button in the Marker window (see “Adding 
and removing markers in the Marker window” on page 110).

Operation Description Default key

Insert Marker Creates a new marker at the current 
project cursor position.

[Insert] 
(Windows only)

Locate Next 
Marker

Moves the project cursor to the right to 
the next marker position (if any).

[Shift]+[N]

Locate Previous 
Marker

Moves the project cursor to the left to 
the previous marker position (if any).

[Shift]+[B]

To Marker 1-9 Moves the project cursor to the speci-
fied marker (number 1 to 9).

[Shift]+[1] to [9]

Set Marker 1-9 Moves the specified marker (number 1 
to 9) to the current project cursor posi-
tion.

[Ctrl]+[1] to [9]

Recall Cycle 
Marker 1-9

Moves the left and right locators to 
encompass the specified cycle marker 
(1 to 9).

[Shift]+[Pad1] to 
[Pad9]

! To view and edit markers in the Project Browser, the 
Marker track must be added to the Project window.

Operation Description Default key
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Introduction
Nuendo offers transpose functions for audio, MIDI and in-
strument parts and for audio events. These allow you to 
create variations of your music or change the harmonics of 
an entire project or separate sections. 

Transpose can be applied on three levels:

• On the entire project
By changing the project Root Key in the Project window toolbar, the 
whole project will be transposed (see “Transposing an entire project with 
the Root Key” on page 115). 

• On sections of the project
By creating Transpose events on the Transpose track you can set trans-
pose values for separate sections of your project (see “Transposing sep-
arate sections of a project using Transpose events” on page 118).

• On individual parts or events
By selecting individual parts or events and changing their transpose 
value in the info line, you can transpose individual parts or events (see 
“Transposing individual parts or events using the info line” on page 118).

Apart from the transpose features described in this chap-
ter, you can also transpose all MIDI notes on the selected 
track using the MIDI modifiers (see “Transpose” on page 
346), selected notes using the Transpose dialog (see 
“Transpose” on page 357), and MIDI tracks using MIDI ef-
fects (see the separate manual “Nuendo Expansion Kit – 
Cubase Music Tools for Nuendo 4”).

Transposing your music
In the following sections we will describe the different 
possibilities of transposing your music. Note that these 
can also be combined. However, we recommend you to 
set the root key first, before recording or changing trans-
pose values on the transpose track. 

Transposing an entire project with the Root Key
The root key you specify for a project will be the reference 
that audio or MIDI events in your project will follow. You can 
of course exclude separate parts or events from being 
transposed, e.g. drums or percussion (see “The Global 
Transpose setting” on page 119). 

Depending on whether you are using events which al-
ready contain root key information or not, the procedures 
differ slightly:

If the events already contain root key information

Let’s say you want to create a project based on loops. 
Proceed as follows:

1. Open the Mediabay and drag some loops into an emp-
ty project, see “Browsing for media files” on page 316.
For this example, import audio loops with different root keys.

! The transpose functions do not change the actual 
MIDI notes or the audio, but only affect the playback. 

! As a general rule, you should always set the root key 
first when you work with content with a defined root 
key.
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2. Now, open the Root Key pop-up menu in the Project 
window toolbar and set the project root key.
The entire project will be played back with this root key. Note that by de-
fault, the project root key is not specified (“-”).

A loop-based project with different event root keys

The separate loops will be transposed in order to match 
the project root key. If you e.g. have imported a bass loop 
in C and the project root key is set to E, the bass loop will 
be transposed up by 4 semitones.

3. Now (with the root key set), record audio or MIDI.
The recorded events will get the project root key.

4. When you are done and satisfied with the result, you 
can change the project root key and your events will follow.

If the events do not contain root key information

Let’s say you have created a project by recording audio 
and importing some MIDI loops, and you want to match 
the root key of the whole project to the register of a certain 
singer.

Proceed as follows:

1. In your project, open the Project menu and select 
“Transpose” from the Add Track submenu (or right-click in 
the Track list and select “Add Transpose Track”) to add the 
Transpose track. 
You can only have one Transpose track in a project.

2. Set the project to the desired root key by selecting the 
corresponding option from the Root Key pop-up in the 
Project window toolbar.

3. Right-click in the Track list for the Transpose track and 
select “Set root key for unassigned events” from the con-
text menu.
This sets the project root key for all unassigned parts or events. You can 
undo this command by selecting Undo from the Edit menu. The “Set root 
key for unassigned events” option is only available, if a project root key 
has been set.

! If you work with drums or percussion, you should ex-
clude these from being transposed by setting the 
“Global Transpose” setting on the info line to “Inde-
pendent” (see “The Global Transpose setting” on 
page 119).

! If you work with drums or percussion, you should ex-
clude these from being transposed by setting the 
“Global Transpose” setting on the info line to “Inde-
pendent” (see “The Global Transpose setting” on 
page 119).
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Recording with a project root key

Let’s say that you want to record a guitar line for a project 
that is in D# minor, but your guitar player prefers to play A 
minor and G major. In this case, you can change the 
project root key to A, so that you can record your guitar. 
Proceed as follows:

1. Open your project and set the project root key to A.
All parts and events will be transposed in order to match the root key.

2. Listen to your project and verify that no drums and 
percussions have been transposed. 
If drums have been transposed, select them and set their Global Trans-
pose setting to “Independent”.

3. Record your guitar line as desired.

4. When you are done and you are satisfied with the re-
sult, you can change the project root key back to D# mi-
nor and your events will follow.

Changing the Root key of single events or parts

If you want to check if an audio event or part has root key 
information or if you want to change it, proceed as follows:

1. Open the Pool and display the Key column by select-
ing “Root Key” from the “View/Attributes” pop-up menu in 
the Pool. 

An audio event with a root key set to “C”

2. Click in the Root Key column for the desired audio 
event and set the key according to your needs.
You can also check and assign Root Keys in the MediaBay.

If you change the root key of an audio part or event, 
the corresponding audio file will not change. To save the 
Root Key setting in the audio file, you have to use the 
“Bounce Selection” function from the Audio menu. 

To check the root key setting of a MIDI part, proceed as 
follows:

1. Select your MIDI part in the Project window and check 
the Project window info line.

A MIDI part with a root key set to “E”

2. Click on the root key value in the info line to open the 
Root key pop-up menu in the Project window info line and 
select the desired root key.

! For recorded audio events and MIDI parts, the “Global 
Transpose” setting on the info line ist automatically set 
to “Follow”, i.e. the events or parts will get the project 
root key.

! If you change the project root key after setting the 
event root key, the events will keep their own root key 
settings, and will be transposed to match the project 
root key. If you record an audio or a MIDI part and the 
project root key is specified, this root key is automat-
ically set.
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Transposing separate sections of a project 
using Transpose events
Sometimes you may want to transpose only certain sec-
tions of your project, e.g. to create harmonic variations. 
This can be done by creating transpose events. Trans-
pose events allow you to add a relative transpose offset by 
specifying transpose values in semitones. You can e.g. 
brighten up your loops in C major by transposing them by 
5 semitones, so that the subdominant on F major is played 
back, or you can turn your hit more interesting by trans-
posing the last chorus one semitone upwards.

1. In your project, open the Project menu and select 
“Transpose” from the Add Track submenu (or right-click in 
the Track list and select “Add Transpose Track”) to add the 
Transpose track. 
You can only have one Transpose track in a project.

2. Select the Pencil tool from the toolbar and click in the 
Transpose track to create a transpose event. 
A transpose event will be created from the point where you clicked until 
the end of the project.

3. To create another transpose event, click with the pen-
cil tool on the first transpose event.
By default, the transpose value of new transpose events is set to 0.

You can add more transpose events by clicking with the pencil tool. 

4. Click in the transpose value field and enter the trans-
pose value for the transpose event.
You can enter the desired value with the computer keyboard, use the 
mouse wheel or [Alt]/[Option]-click on the transpose value to open a 
value fader. You can specify values between -24 and 24 semitones. 

If you move the mouse over the transpose event, the cursor turns into a 
hand symbol. This indicates that you can use the mouse wheel to 
change the value.

5. Play back your project.
The parts of your project on the same position as the transpose events 
will be transposed according to the specified transpose values.

You can also transpose the whole project by means of 
the transpose track. This is useful e.g. if your singer does 
not reach a certain pitch. In this case you can transpose 
your whole project by e.g. -2 semitones. Always remem-
ber to verify that the “Global Transpose” setting for drums 
and percussion is set to “Independent” on the info line 
(see “The Global Transpose setting” on page 119).

You can erase and move transpose events, but you can 
not mute, cut or glue them. The option “Locators to Selec-
tion” does not apply on transpose events. 

Transposing individual parts or events using 
the info line
You can also transpose individual audio and MIDI parts and 
events via the Info line (or the Inspector). This transposition 
will be added to the global transposition (i.e. the root key or 
the transpose events). Proceed as follows:

1. Select the event that you want to transpose.

2. In the Project window info line, adjust the Transpose 
value as desired.

A global transpose change will not overwrite individual 
part or event transpose, but will be added to the trans-
pose value for the part or event. In this case, it might be 
useful to keep the transposition within the octave range 
(see “Keep Transpose in Octave Range” on page 120).
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Other functions

Indicate Transpositions
When you transpose your music, you may sometimes 
want to visually compare the original sounds and the 
transposed music. For MIDI parts, you can check this by 
opening the Key Editor and clicking the “Indicate Transpo-
sitions” button. This will help you see how your MIDI notes 
will be transposed. If the button is activated, the Key Edi-
tor will show the note pitch you will hear, if it is deacti-
vated, the Key Editor shows the original pitch of the notes 
in your MIDI part. By default, the “Indicate Transpositions” 
button is deactivated.

A MIDI part as originally recorded.

When you activate “Indicate Transpositions” you will see how your MIDI 
part will be transposed. 

The Global Transpose setting
If you are working with drum and percussion loops or with 
special effects (FX) loops, you normally want to exclude 
these events from being transposed. This can be achieved 
by locking them using the Global Transpose setting. Pro-
ceed as follows:

1. Open your project.

2. Select the desired event or part and set the “Global 
Transpose” setting on the info line to “Independent”.
A symbol will be displayed in the upper right corner of the selected part 
or event. This indicates that the part or event will not be transposed nei-
ther by changing the root key nor by specifying transpose events. 

If Global Transpose is set to Independent, the selected part will not be 
transposed.

3. You can now change the project root key.
The “Independent” parts or events will not be affected by the root key 
changes.

If you import ready-made parts or events that are 
tagged drums or FX, Global Transpose will be automatically 
set to Independent.

If you record audio or MIDI, Global Transpose will be set to 
“Independent”, if the transpose track exists and you have 
specified at least one transpose event (even when the 
transpose value is not defined). In this case, your recording 
will sound exactly the way you played it. The transpose 
events will not be taken into account during recording and 
the recorded event will not get the project root key. Have a 
look at the following example:

1. Set up a project with the root key in C.

2. Add a transpose track and enter transpose events 
with the values 0, 5, 7 and 0.

3. Record some chords with your MIDI keyboard. For our 
example, record C, F, G and C.
The transpose events are not taken into account and the result of your 
recording will be C, F, G and C. The root key will be not set.
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You will get exactly what you have recorded, i.e. when 
your record C, F, G and C this will be played back exactly 
as you recorded it. This is because the recorded event is 
“Independent” from Global Transpose.

If no transpose track exists or if no transpose event has 
been added, Global Transpose will be set to Follow.

If Global Transpose is set to Follow, the selected part will follow all glo-
bal transpositions.

The Edit Lock on the Transpose track
If you want to prevent your transpose events from being 
changed by mistake, you can activate the Lock button on 
the transpose track. This way, you will not be able to move 
your transpose events or change their transpose values.

Mute transpose events
Sometimes it might be useful to disable the transpose 
track, e.g. to hear the original sound of individual tracks. If 
you activate the mute button on the transpose track, your 
transpose events will not be taken into account during 
playback.

Keep Transpose in Octave Range
The “Keep Transpose in Octave Range” button on the 
transpose track (the button with an up and down arrow in 
brackets) keeps the transposition in the octave range. This 
option is activated by default. This way, nothing will be 
transposed by more than seven semitones. This ensures 
that your music never sounds unnatural because the pitch 
was raised too high or too low. 

To understand the principle behind this, follow the exam-
ple below:

1. Create a MIDI part, enter a C major chord, open the key 
editor and activate “Indicate Transpositions”.
This way you can observe and understand what happens, when you 
change the tranposition.

2. Add a transpose track and create a transpose event.
By default, the transpose value is set to 0.

3. Make sure that the “Keep Transpose in Octave 
Range” button is activated on the transpose track and 
change the transpose value of the transpose event.
Your chord will be transposed upwards or downwards according to the 
entered values.

If you enter a transpose value of 7, your chord will be transposed by 
seven semitones upwards. In this example, this would be G3/B3/D4.
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4. Set the transpose value to 8 semitones.
As “Keep Transpose in Octave Range” is activated, your chord will now 
be transposed to the nearest interval or pitch. 

Your chord has been transposed to the nearest pitch, this results in 
G#2/C3/D#3.

! If you mainly work with audio loops, we recommend 
to activate “Keep Transpose in Octave Range”. 
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About this chapter
This chapter contains detailed information about the ele-
ments used when mixing audio and MIDI, and the various 
ways you can configure the mixer. 

Some mixer-related features are not described in this 
chapter. These are the following:

• Setting up and using audio effects.
See the chapter “Audio effects” on page 168.

• Setting up and using MIDI effects.
See the chapter “MIDI realtime parameters and effects” on page 342.

• Surround Sound.
See the chapter “Surround sound” on page 202.

• Automation of all mixer parameters.
See the chapter “Automation” on page 213.

• How to mix down several audio tracks (complete with 
automation and effects if you wish) to a single audio file.
See the chapter “Export Audio Mixdown” on page 437.
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Overview

The mixer offers a common environment for controlling 
levels, pan, solo/mute status etc. for both audio and MIDI 
channels. 

Opening the mixer
The mixer can be opened in several ways:

• By selecting Mixer from the Devices menu.

• By clicking the Mixer icon on the toolbar
This always opens the first Mixer window (see below).

• By using a key command (by default [F3]).

• By clicking the Mixer button in the Devices panel.
You open the Devices panel by selecting Show Panel from the Devices 
menu.

About the multiple mixer windows
You may have noticed that there are in fact several separate 
mixer items selectable from the Devices menu. These are 
not separate mixers, but rather separate views of the same 
mixer. 

• Each of the mixer windows can be configured to show 
any combination of channels, channel types, narrow and 
wide channel strips, etc. (how to do this is described later 
in this chapter).
You can for example configure one mixer window to show MIDI channel 
strips, another to show input and output channels or another to show all 
audio-related channels.

The picture shows an extended mixer (see “Normal vs. Extended channel strips” on page 126).
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• You can also save channel configurations as View sets 
(see “Channel view sets” on page 129), which are then 
accessible from all mixer windows.

These features are very convenient when working with 
large projects. Considering the number of different chan-
nel types that can be shown in the mixer, they could even 
be described as necessary!

The use of multiple mixer windows combined with the abil-
ity to recall different mixer configurations enables you to 
focus on the task at hand and keep window scrolling 
down to a minimum.

All options for configuring the mixer described in this 
chapter are identical for all mixer windows. 

What channel types can be shown in the mixer?
The following track-based channel types are shown in the 
mixer:

• Audio
• MIDI
• Effect return channels (referred to as FX channels in the 

Project window)
• Instrument channels (VSTi Return)
• Group channels
• Instrument tracks
• ReWire channels

The order of audio, MIDI, instrument, group and effect re-
turn channel strips (from left to right) in the mixer corre-
sponds to the Project window Track list (from the top 
down). If you reorder tracks of these types in the Track list, 
this will be mirrored in the mixer.

In addition to the above, the following channel types are 
also shown in the mixer:

• Activated ReWire channels (see the chapter “ReWire” on 
page 482).

• VST Instrument channels (see the chapter “VST Instruments 
and Instrument tracks” on page 189).

ReWire channels cannot be reordered and always appear 
to the right of other channels in the main mixer pane (see 
below). VST instrument (VSTi) channels can be reordered 
in the Track list which will in turn be mirrored in the mixer.

Folder, Marker, Video and Automation tracks are not 
shown in the mixer.

Input and output busses in the mixer
Input and output busses are represented by input and out-
put channels in the mixer. They appear in separate “panes” 
separated by movable dividers and with their own horizontal 
scrollbars, see “The input and output channels” on page 
132.

About multichannel audio
Nuendo has full support for surround sound. Each audio 
channel and bus in the mixer can carry up to 12 speaker 
channels. This means that if you have an audio track con-
figured for 5.1 surround sound, for example, it will have a 
single channel strip in the mixer, just like mono or stereo 
tracks, but its level meter will have six meter bars, one for 
each speaker channel.

Another thing to note is that the look of a channel strip dif-
fers slightly depending on how it is routed – mono or stereo 
tracks routed to a surround output bus will have a surround 
panner control instead of a regular pan control, for example. 
For further information on multichannel audio, see the chap-
ter “Surround sound” on page 202.
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Configuring the mixer
As mentioned earlier, the mixer windows can be config-
ured in various ways to suit your needs and to save screen 
space. Here follows a run through of the various view op-
tions (the following descriptions assume that you have an 
active project containing some tracks):

Normal vs. Extended channel strips
You have the option of selecting normal or extended chan-
nel strips and whether to show the input and output set-
tings at the top of the channel strips. Proceed as follows:

1. Open any of the mixer windows.
The leftmost strip is called the common panel and is always shown in the 
mixer. It contains various global settings and options relating to the mixer. 
For further information, see “The common panel” on page 131.

2. Click on the arrow button on the common panel 
(“Show Extended Mixer”) or right-click in the Mixer to 
open the Mixer context menu and select “Show Extended 
View” from the Window submenu.
You can also use a key command for this. See the chapter “Key com-
mands” on page 517.

3. You can show or hide the Routing panel of the chan-
nel strips by clicking on the respective arrow button 
(“Show Routing”) or by selecting “Show Routing View” 
from the Window submenu on the Mixer context menu.
The fader panel is always shown.

The fader panel shows the basic controls – faders, pan 
controls and an associated vertical row of buttons. The ex-
tended panel can be set to show EQ, effect sends, insert 
effects, etc. The input/output settings panel contains input 
and output routing pop-up menus (where applicable), 
along with input phase switches and input gain controls.

Selecting what to display in the extended 
channel strips
You can select what to display in the extended channel 
strip either globally from the common panel or individually 
from each channel strip. 

The available options vary depending on the type of chan-
nel.

• For a description of the options for audio channels, see “Op-
tions for the extended audio channel strip” on page 136. 

• For a description of the options for MIDI channel, see “Selecting 
what to show in the extended MIDI channel strip” on page 144 .

…and via the Mixer context menu.

Opening the Extended Mixer via the Mixer Common panel…

A basic channel strip with no 
extended options.

A fully extended channel strip 
with the input/output routing 
section at the top.
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Selecting globally from the common panel

1. Open any of the mixer windows.
The leftmost strip is called the common panel and is always shown in the 
mixer. It contains various global settings and options relating to the mixer. 
For more information, see “The common panel” on page 131.

2. Make sure that the extended panel of the mixer is visible.

In the extended area of the common panel, you can see a 
vertical row of icons. These act as buttons and determine 
globally what is displayed in the extended panel for all 
channel strips in the mixer.

If you place the pointer on an icon, a tooltip appears.

3. Click on the “Show all Inserts” button (second icon 
from the top).
Now all channel strips in the mixer will show Insert effect slots in the ex-
tended panel.

• As mentioned above, what can be set globally depends 
on the type of channel. 
Channel types that do not support a selected global option will be unaf-
fected.

• If you press [Alt]/[Option] and click one of the global 
view buttons, input and output channels will be affected 
as well.

Selecting for individual channels

Each channel strip in the mixer features a View options 
pop-up menu, which is used for two things:

• To determine what is shown in the extended panel for 
individual channels in the mixer.

• To set the “Can Hide” status for individual channels in 
the mixer.
This is described in the section “Showing/hiding individual channels (the 
“Can Hide” setting)” on page 128.

The View options pop-up is opened by clicking the down 
arrow located just above the fader panel of the channel 
strip.

• To select what to display in the extended panel from the 
View options pop-up menu, you must first open the ex-
tended mixer.
You can then use the pop-up to select which parameters to show in the 
extended panel for each individual channel in the mixer.

Clear all views (blank panels)

Show all Inserts

Show all Equalizers

Show all Equalizers with curve

Show all Sends

Show Sends 1-4

Show Sends 5-8

Show Surround Panners (where applicable)

Show all Meters

Show Channel Overview

Show Studio Sends
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Setting the width of channel strips

The Channel Narrow/Wide button

• Narrow channel strips contain a narrow fader, miniature 
buttons, and the View options pop-up.
If you have selected to show parameters in the extended section, only the 
channel overview or the Meter can be shown in narrow mode. (The pa-
rameters will be shown again when you return to wide mode.)

Wide and narrow channel strips

• When selecting “All targets narrow” or “All targets 
wide” on the common panel, all channel strips selected as 
command targets (see “About the Command Target” on 
page 129) are affected.

Selecting what channel types to show/hide
You can specify what channel types to show or hide in the 
mixer. In the lower part of the common panel you find a 
vertical strip with different indicator buttons. Each indica-
tor represents a channel type to show or hide in the mixer:

• To hide or show a channel type, click the corresponding 
indicator.
If an indicator is dark, the corresponding channel type will be shown in 
the mixer. If it is orange, the corresponding channel type will be hidden.

Showing/hiding individual channels (the “Can 
Hide” setting)
You can also show/hide individual channels of any type in 
the mixer. For this, you can assign channels a “Can Hide” 
status, which allows you to hide these channels collec-
tively. Proceed as follows:

1. Pull down the View options pop-up menu for the chan-
nel you want to hide and activate the “Can Hide” option.
If “Can Hide” is activated for a channel strip, the corresponding icon (/) 
will be visible in the top middle section of the channel strip.

! Each channel strip can be set to either “Wide” or 
“Narrow” mode by using the Channel Narrow/Wide 
button on the left above the fader strip.

Input Channels

Audio Channels

Group Channels

ReWire Channels

MIDI Channels

VST Instrument Channels

Effect Return Channels

Output Channels

“Can Hide” options – see below.

Reveals all channel strips

“Command Target” options – see “About 
the Command Target” on page 129.
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2. Repeat this for all channels you want to hide.

3. Click the top “hide button” (Hide Channels set to 
“Can Hide”) on the common panel.
This hides all channels set to “Can Hide”. To show them again, click the 
Hide button again or click the button at the bottom on the common panel 
(“Reveal All Channels”).

Below the top hide button, there are three additional “Can 
Hide” buttons.

Channel view sets
Channel view sets are saved configurations of the mixer 
windows, allowing you to quickly switch between different 
layouts for the mixer. Proceed as follows:

1. Set up the mixer the way you wish to store it as a view 
set.
The following settings will be stored:

• Settings for individual channel strips (e.g. narrow or wide mode 
and whether the channel strip is (or can be) hidden or not).

• The hide/show status for channel types.
• The mixer’s display status (fader panel, extended panel, input/

output panel).
• Settings for what is shown in the extended view of the mixer.

2. Click the “Store View Set” button (the plus sign) at the 
bottom of the (non-extended) common panel.

3. A dialog appears, allowing you to enter a name for the 
view set.

4. Click OK to store the current mixer view set.

• You can now return to this stored configuration at any 
time, by clicking the “Select Channel View Set” button 
(the down arrow to the left of the “Store View Set” button) 
and selecting it from the pop-up menu.

• To remove a stored channel view set, select it and click 
the “Remove View Set” button (the minus sign).

About the Command Target
Command targets let you specify which channels should 
be affected by the “commands” (basically all the functions 
that can be assigned key commands) when working with 
the Mixer, e.g. what to display in the extended mixer, the 
width setting of the channel strips, etc. You can set com-
mand targets using the Mixer common panel or the con-
text menu.

The following options are available:

• All Channels
Select this if you want your commands to affect all channels.

• Selected Only
Select this if you want your commands to affect the selected channels 
only.

• Exclude Inputs
Select this if you don’t want your commands to affect the input channels.

• Exclude Outputs
Select this if you don’t want your commands to affect the output channels.

Option Description

Set Target Channels 
to ’Can Hide’

This activates “Can Hide” for all Channels you spec-
ified as “Command Targets”. For more information, 
see below.

Remove ’Can Hide’ 
from Target 
Channels

This deactivates “Can Hide” for all Channels you 
specified as “Command Targets”. For more informa-
tion, see below.

Remove ’Can Hide’ 
from All Channels

This deactivates “Can Hide” for all Channels in the 
Mixer.

! Some remote control devices (such as Steinberg’s 
Houston) feature this function, which means that you 
can use the remote device to switch between the 
channel view sets.

The Command Target Controls 
on the common panel

The Command Target 
submenu in the Mixer 
context menu
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The audio-related channel strips

The mixer in normal mode (faders and Routing View visible), showing 
(from left to right): the common panel, a stereo audio channel, a group 
channel, an instrument channel, an effect return channel and a VST In-
strument channel strip.

All audio-related channel types (audio, instrument track, 
input/output channels, group, effect return, VST Instru-
ment and ReWire) basically have the same channel strip 
layout, with the following differences:

• Only audio track channels have an Input Routing pop-up menu.
• Only audio and instrument track channels have a Monitor and 

Record Enable button.
• Input/output channels do not have sends.
• Instrument track and VST Instrument channels have an addi-

tional button for opening the instrument’s control panel.
• Input channels and output channels have clip indicators.

About the Insert/EQ/Send indicators and bypass 
buttons

The three indicator buttons in each audio channel strip 
have the following functionality:

• If an Insert or Send effect or an EQ module is activated 
for a channel, the corresponding button is lit. 
The effect indicators will be blue, the EQ indicator will be green.

• If you click these buttons when lit, the corresponding 
EQ or effects section will be bypassed.
Bypass is indicated by yellow buttons. Clicking the button again deacti-
vates bypass.

The common panel 
(see “The common 
panel” on page 131)

Channel auto-
mation controls

Record Enable and 
Monitor buttons

Channel input/
output routing

Opens the control panel for the VST Instrument

Channel View 
options pop-up

Level meter

Level fader

Edit button (opens the 
Channel Settings window)

Insert/EQ/Send indicators and 
bypass buttons (see below)

Channel name

Input Gain control 

The speaker configuration for 
the channel

Input Phase switch

Listen button (see the chapter 
“Control Room” on page 151)

The Can Hide State 
for the channel

Narrow/Wide button

Pan control

Narrow/Wide button
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The MIDI channel strips

The MIDI channel strips allow you to control volume and 
pan in your MIDI instrument (provided that they are set up to 
receive the corresponding MIDI messages). The settings 
here are also available in the Inspector for MIDI tracks.

The common panel
The common panel appears to the left in the mixer windows 
and contains settings for changing the look and behavior of 
the mixer, as well as global settings for all channels.

Level fader 
(MIDI volume)

Level (velocity) meter
Channel automation 
controls

Pan control

Monitor and Record 
Enable buttons

MIDI output pop-up

MIDI input pop-up

Edit button

Mute and Solo

Insert/Send indicators 
and Bypass buttons

Input Transformer 
button

MIDI channel pop-up

This opens the 
control panel for 
a connected VST 
Instrument

Channel Narrow/
Wide button

Can Hide State 

Global automation 
Read/Write buttons

Store/Remove View set but-
tons (+/-) and Select View 
set pop-up, see “Channel 
view sets” on page 129.

These indicator but-
tons select what chan-
nel types are shown/
hidden in the mixer.

The View options buttons 
determine what to display 
in the extended panels of 
channel strips. Only visible 
in extended mixer mode.

Command Target settings, 
see “About the Command 
Target” on page 129.

Toggles “All Wide” 
(left arrows) or “All 
Narrow” channel 
strips in the mixer.

Opens the VST Con-
nections window, see 
“The VST Connections 
window” on page 12.

Shows/hides the 
Routing panel

Buttons for showing/
hiding the extended 
panel

Resets the settings 
to default (for all or 
selected channels).

Channel settings copy/
paste, see “Copying 
settings between audio 
channels” on page 141.

“Can Hide” settings, see 
“Showing/hiding individual 
channels (the “Can Hide” 
setting)” on page 128.

Global Mute, Solo 
and Listen buttons
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The input and output channels
The busses you have set up in the VST Connections win-
dow are represented by input and output channels in the 
mixer. These are shown in separate “panes” (to the left 
and right of the regular channel strips, respectively), with 
their own dividers and horizontal scrollbars. The i/o chan-
nel strips are very similar to other audio channels and are 
identical for input and output channels (except that input 
channels don’t have Solo buttons or Sends).

• For information on how to set up input and output bus-
ses, see “VST Connections: Setting up input and output 
busses” on page 10.

• How to route audio channels to busses is described on 
“Routing audio channels to busses” on page 143.

• If the Control Room is disabled (see the chapter “Con-
trol Room” on page 151), the Main Mix (the default output) 
bus is used for monitoring. For information about Monitor-
ing, see “About monitoring” on page 17.

Basic mixing procedures

Setting volume in the mixer
In the mixer, each channel strip has a fader for volume 
control. 

• For audio channels, the faders control the volume of the 
channels before they are routed directly or via a group 
channel to an output bus.
Each channel can in turn handle up to 12 speaker channels – see “Sur-
round sound in Nuendo” on page 203.

• An output channel fader determines the master output 
level of all audio channels routed to that output bus.

• MIDI channels handle fader volume changes in the mixer 
by sending out MIDI volume messages to the connected in-
strument(s).
Connected instruments must be set to respond to MIDI messages (such 
as MIDI volume in this case) for this to function properly.

• The fader settings are displayed numerically below the 
faders, in dB for audio channels and in the MIDI volume 0 
to 127 value range for MIDI channels.
You can click in the fader value fields and enter a volume setting by typing.

• To make fine volume adjustments, hold down [Shift] 
when you move the faders.

• If you hold down [Ctrl]/[Command] and click on a fader, 
it will be reset to its default value, i.e. 0.0 dB for audio 
channels, or MIDI volume 100 for MIDI channels.
This reset to default values works for most mixer parameters.

You can use the faders to set up a volume balance be-
tween the audio and MIDI channels and perform a manual 
mix by moving the faders and other controls while playing 
back. By using the Write function (see “Enabling and 
disabling the writing of automation data” on page 214), 
you can automate the levels and most mixer actions.

Input gain

Bus level meter

Read/Write 
Automation

Clip indicator, see 
“Setting input le-
vels” on page 69.

The Speaker configu-
ration for the bus.

Edit button
Inserts and EQ 
indicators and 
Bypass buttons

Pan control (no 
Panner used for 
surround busses)

Input Phase switch

Mute and Listen 
buttons
(the Output bus 
also features a 
Solo button)

Bus volume fader

! It is also possible to create volume envelopes for 
separate events in the Project window or Audio Part 
Editor (see “Event Envelopes” on page 97) or to 
make static volume settings for an event on the info 
line or with the volume handle (see “About the vo-
lume handle” on page 88).
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About the level meters for audio channels

When playing back audio in Nuendo, the level meters in 
the mixer show the level of each audio channel.

• Directly below the level meter is a small level readout – 
this shows the highest registered peak level in the signal.
Click this to reset the peak levels.

• Peak levels can also be shown as static horizontal lines 
in the meter, see “Changing the meter characteristics” on 
page 141.

If the peak level of the audio goes above 0dB, the numer-
ical level indicator will show a positive value (i.e. a value 
above 0dB).

Nuendo uses 32 bit floating point processing internally, so 
there is virtually limitless headroom – signals can go way 
beyond 0dB without clipping. Therefore:

Having higher levels than 0dB for individual audio 
channels is not a problem in itself. The audio quality will 
not be degraded by this. 
However, when many high level signals are mixed in an output bus, this 
may require that you lower the output channel level a lot (see below). 
Therefore it’s good practice to keep the max levels for individual audio 
channels roughly around 0dB.

About the level meters for input and output channels

For the input and output channels, things are different. I/O 
channels have clip indicators.

• When you are recording, clipping can occur when the 
analog signal is converted to digital in the audio hardware. 
It’s also possible to get clipping in the signal being recorded to disk 
(when 16 or 24 bit record format is used and you have adjusted the mixer 
settings for the input channel). For more about checking and setting in-
put levels, see “Setting input levels” on page 69.

• In the output busses, the floating point audio is converted 
to the resolution of the audio hardware. In the integer audio 

domain, the maximum level is 0dB – higher levels will cause 
the clip indicator for each bus to light up.
If the clip indicators light up for a bus, this indicates actual clipping – dig-
ital distortion which should always be avoided.

Adjusting Input Gain

Each audio channel and input/output channel features an 
Input Gain control. This controls the gain for the incoming 
signal, before EQ and effects.

The Input Gain is not meant to be used as a volume con-
trol in the mixer, as it is not suited for continuous level ad-
justments during playback. It can, however, be used to cut 
or boost the gain in various circumstances:

• To change the level of a signal before the effects section.
The level going into certain effects can change the way the signal is af-
fected. A compressor, for example, can be “driven” harder by raising the 
Input Gain.

• To boost the level of poorly recorded signals.

To change the Input Gain, you need to press [Shift] and 
adjust the control (to avoid accidental gain changes). If 
you press [Alt]/[Option], you can adjust the Input Gain 
with a fader. Alternatively, you can also enter the desired 
number in the value field.

Input Phase switch

Each audio channel and input/output channel has an Input 
Phase switch, to the left of the Input Gain control dial. 
When activated, the phase polarity is inverted for the sig-
nal. Use this to correct for balanced lines and mics that 
are wired backwards, or mics that are “out of phase” due 
to their positioning.

! When Direct Monitoring is used and the option “Map 
input bus metering to Audio track (in Direct Monitor-
ing)” is activated in the Preferences (VST–Metering 
page), the level meters in the mixer will show the level 
of the input bus instead. 

! If the clip indicator lights up for an output channel, 
reset the clip indicator by clicking on it, and lower the 
level until the indicator doesn’t light up.
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• Phase polarity is important when mixing together two 
similar signals. 
If the signals are “out of phase” with respect to one another, there will be 
some cancellation in the resulting audio, producing a hollow sound with 
less low frequency content.

About level meters for MIDI channels

The level meters for MIDI channels do not show actual vol-
ume levels. Instead, they indicate the velocity values of the 
notes played back on MIDI tracks.

About MIDI tracks set to the same MIDI channel and 
output

If you have several MIDI tracks set to the same MIDI chan-
nel (and routed to the same MIDI output), making volume 
and pan settings for one of these MIDI tracks/mixer chan-
nels will also affect all other mixer channels set to the 
same MIDI channel/output combination.

Using Solo and Mute

The Mute (top) and Solo buttons.

You can use the Mute and Solo buttons to silence one or 
several channels. The following applies:

• The Mute button silences the selected channel.
Clicking the Mute button again un-mutes the channel. Several channels 
can be muted simultaneously. Muting Group channels can have two dif-
ferent results depending on how the Preferences are set (see “Settings 
for group channels” on page 142). A muted channel is indicated by a lit 
Mute button and also by the lit Global Mute indicator on the common 
panel. 

• Clicking the Solo button for a channel mutes all other 
channels.
A soloed channel is indicated by a lit Solo button, and also by the lit Glo-
bal Solo indicator on the common panel. Click the Solo button again to 
turn off Solo.

• Several channels can be soloed at the same time.
However, if you press [Ctrl]/[Command] and click the Solo button for a 
channel, any other soloed channels will automatically be un-soloed (i.e. 
this Solo mode is exclusive).

• [Alt]/[Option]-clicking a Solo button activates “Solo De-
feat” for that channel.
In this mode the channel will not be muted if you solo another channel. To 
turn off Solo Defeat, [Alt]/[Option]-click the Solo button again. 

• You can un-mute or un-solo all channels by clicking the 
Mute or Solo indicator on the common panel.

Listen Mode 

The Listen button for a channel strip and the global Listen button on the 
Common panel

Clicking the Listen button for a channel routes that chan-
nel to the Control Room without interrupting the normal 
signal flow. The following applies:

• When the channel is set to after-fader (also referred to 
as post-fader), the signal being routed to the Control 
Room channel will come after the fader and pan controls 
of the Listen-enabled channel.

• When the Control Room channel is set to pre-fader, the 
signal will be routed from just before the fader.

A Listen-enabled channel is indicated by a lit Listen but-
ton, and also by the lit Global Listen button on the com-
mon panel. Click the Listen button again to turn off Listen 
mode. You may also turn off Listen mode for every Listen-
enabled track at once by clicking the Listen button on the 
common panel.

For more information about the Listen functionality, see 
the chapter “Control Room” on page 151.

A muted chan-
nel in the mixer.

A lit Global Mute indicator on the 
common panel shows that one or 
more channels are muted.

[Alt]/[Option]-click a Solo button…
…to activate Solo Defeat 
for that channel.

…and to pre-fader (PFL).Control Room channel set 
to after-fader (AFL)…
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Setting pan in the mixer

The pan control.

The pan controls in the mixer are used to position a chan-
nel between the left and right side of the stereo spectrum. 
By default for stereo audio channels, pan controls the bal-
ance between the left and right channels. You can change 
this in the Preferences. By selecting one of the other pan 
modes (see below), you can set pan independently for the 
left and right channel.

• To make fine pan adjustments, hold down [Shift] when 
you move the pan control.

• To select the (default) center pan position, hold down 
[Ctrl]/[Command] and click on the pan control.

• For MIDI channels, the pan control sends out MIDI pan 
messages.
The result depends on how your MIDI instrument is set to respond to pan 
– check your documentation for details.

The Surround Panner is described in the section 
“Using the Surround Panner” on page 208.

Panning Bypass

You can bypass the panning for all track types except 
MIDI tracks. To do this, keep [Shift] and [Alt]/[Option] 
pressed and click on the pan setting for the respective 
channel in the mixer (on the fader panel or in the extended 
mixer view). The Panning Bypass state is reflected in all 
the different pan setting sections, e.g. if you bypass a 
channel in the mixer, this is automatically reflected in the 
Inspector for the respective track.

When panning is bypassed for a channel, the following 
happens:

• Mono channels will be panned center.
• Stereo channels will be panned left and right.
• Surround channels will be panned center.

To deactivate Panning Bypass, simply press 
[Shift]+[Alt]/[Option] and click again.

About the three pan modes 

If you right-click in the pan control field for a (stereo) audio 
channel, you can select one of three pan modes:

• Stereo Balance Panner controls the balance between 
the left and right channels.
This is the default mode.

• If Stereo Dual Panner is selected, there will be two pan 
controls with the upper controlling pan for the left channel, 
and the lower controlling pan for the right channel.
This allows you set pan independently for the left and right channels. 
Note that it is possible to reverse the left and right channels, i.e. the left 
channel can be panned to the right and vice versa. You can also “sum” 
two channels by setting them to the same pan position (i.e. mono) – note 
that this will increase the volume of the signal.

• If Stereo Combined Panner is selected, the left and 
right pan positions are shown as two lines with a blue/gray 
area between them.
If you reverse the left and right channels, the area between the pan controls 
will be red instead of blue/gray.

In this mode, the left and right pan controls are linked, and 
can be moved left and right like a single pan control (keep-
ing their relative distance).

• Stereo Combined mode also allows you set pan inde-
pendently for the left and right channels. This is done by 
holding down [Alt]/[Option] and dragging the correspond-
ing pan control.
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When moving combined pan controls so that the left or 
right pan control reaches its maximum pan value, it natu-
rally cannot go any further. If you continue to move further 
in the same direction, only the other pan control will move, 
thus altering the set relative pan range until both channels 
are panned fully to one side. If you move the pan controls 
in the opposite direction without releasing the mouse, the 
previously set pan range will be restored.

The pan settings made with the Dual Panner are re-
flected in the Combined Panner and vice versa.

You can specify the default pan mode for inserted au-
dio tracks in the Preferences (VST page).

About the “Stereo Pan Law” Preference (audio channels 
only)

In the Project Setup dialog there is a pop-up menu named 
“Stereo Pan Law”, on which you can select one of several 
pan modes. This is related to the fact that without power 
compensation, the power of the sum of the left and right 
side will be higher (louder) if a channel is panned center 
than if it is panned left or right. 

To remedy this, the Stereo Pan Law setting allows you to 
attenuate signals panned center, by -6, -4.5 or -3dB (de-
fault). Selecting the 0dB option effectively turns off con-
stant-power panning. Experiment with the modes to see 
which fits best in a given situation. You can also select 
“Equal Power” on this pop-up menu, which means that the 
power of the signal will remain the same regardless of the 
pan setting.

Audio specific procedures
This section describes the options and basic procedures 
regarding audio channels in the mixer.

Options for the extended audio channel strip
When using the extended channel strip view options, the 
upper panel can be set to show different views for each 
audio channel strip. You can select what to display in the 
extended panel individually for each channel or globally for 
all channels (see “Selecting what to display in the exten-
ded channel strips” on page 126).

The following views are possible:

• The 8 insert effect slots.
The inserts can also be found in the Inspector and the Channel Settings 
window, see “Using Channel Settings” on page 137.

• The 8 effect sends, with pop-ups and send level value 
sliders.
The sends can also be found in the Inspector and the Channel Settings 
window, see “Using Channel Settings” on page 137.

• You also have the option of displaying four sends at a 
time (the Sends 1-4 and 5-8 menu items). 
These modes offer the additional benefit of displaying send levels as dB 
values.

There are no sends for Input channels.

• The EQ section, either with value sliders (“EQs”) or as 
numerical settings with a curve display (“EQs curve”).
These two views have exactly the same controls but different graphic lay-
outs. The EQ section is also available in the Channel Settings window. 
For EQ parameter descriptions, see “Making EQ settings” on page 138.

• The Surround Panner section (where applicable).
If the channel is routed to a surround bus you can view a compact ver-
sion of the Surround Panner in the extended panel – double-click to 
open the full Surround Panner panel. Also in this section, three parame-
ters of the Mixconvert plug-in will be shown (provided that this plug-in is 
inserted and active). They are SRD (surround), CTR (center) and LFE 
levels. You can edit these values by clicking on them and typing in new 
values.

• The “Meter” option shows large level meters in the ex-
tended panel. 
These operate exactly like the regular meters.

• The User Panel option displays Device panels for the 
audio track, including panels for inserted VST effects, see 
“Audio tracks” on page 28. You can access User panels 
by clicking on the tab at the top of the User Panel display 
in the extended mixer.
For information on Device Panels, see the separate PDF document “MIDI 
Devices”.

• Selecting the “Empty” option will display a blank panel 
in the extended strip.

• You can also select the “Overview” option – this shows 
a graphic overview of which insert effect slots, EQ mod-
ules and effects sends are activated for the channel.
You can click the indicators to turn the corresponding slot/EQ module/
send on or off.
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If you have selected a parameter for the extended 
channel strip and then switch to “narrow” mode, only the 
channel overview and the Meter can be shown in the ex-
tended channel strip. When you switch back to “wide” 
mode, the parameter settings are displayed again.

Using Channel Settings 
For each audio channel strip in the mixer and in the Inspec-
tor and Track list for each audio track, there is an Edit but-
ton (“e”).

Clicking this opens the VST Audio Channel Settings win-
dow. By default, this window contains:

• A section with eight insert effect slots (see “Audio effects” on 
page 168).

• Four EQ modules and an associated EQ curve display (see 
“Making EQ settings” on page 138).

• A section with eight effect sends (see “Audio effects” on page 
168).

• A duplicate of the mixer channel strip (without the extended 
panel but with the input and output settings panel).

You can customize the Channel Settings window, by 
showing/hiding the different panels and/or by changing 
their order:

• To specify which panels should be shown/hidden, right-click 
in the Channel settings window, and activate/deactivate the 
respective options on the Customize View submenu on the 
context menu.

• To change the order of the panels, select “Setup” on the Cus-
tomize View pop-up menu and use the “Move up” and “Move 
Down” buttons.

For further information, see the chapter “Customizing” on 
page 503.

Every channel has its own channel settings (although you 
can view each in the same window if you like – see below).

The Channel Settings window is used for the following 
operations:

• Apply equalization, see “Making EQ settings” on page 138.
• Apply send effects, see “Audio effects” on page 168.
• Apply insert effects, see “Audio effects” on page 168.
• Copy channel settings and apply them to another channel, see 

“Copying settings between audio channels” on page 141.

Changing channels in the Channel Settings window

You can view any channel’s settings from a single window. 

If the option “Sync Project and Mixer Selection” is acti-
vated in the Preferences (Editing–Project & Mixer page), 
this can be done “automatically”:

• Open the Channel Settings window for a track and po-
sition it so that you can see both the Project window and 
the Channel Settings window.

Selecting a track in the Project window automatically se-
lects the corresponding channel in the mixer (and vice 
versa). If a Channel Settings window is open, this will im-
mediately switch to show the settings for the selected 
channel. This allows you to have a single Channel Settings 
window open in a convenient position on the screen, and 
use it for all your EQ and channel effect settings.

! All channel settings are applied to both sides of a 
stereo channel.

Click the Edit button to open the 
Channel Settings window.
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You can also select a channel manually (thereby changing 
what is shown in the open Channel Settings window). 
Proceed as follows:

1. Open the Channel Settings window for any channel.

2. Open the Choose Edit Channel pop-up menu by 
clicking the arrow button to the left of the channel number 
at the top of the Fader view.

3. Select a channel from the pop-up to show the settings 
for that channel in the open Channel Settings window.

• Alternatively, you can select a channel in the mixer by 
clicking its channel strip (make sure not to click on a con-
trol as this will change the respective parameter setting in-
stead).
This selects the channel, and the Channel Settings window is updated.

• To open several Channel Settings windows at the same 
time, press [Alt]/[Option] and click the Edit buttons for the 
respective channels.

Making EQ settings
Each audio channel in Nuendo has a built-in parametric 
equalizer with up to four bands. There are several ways to 
view and adjust the EQs:

• By selecting one of the EQ display modes (“EQs” or 
“EQs Curve”) for the extended channel strip in the mixer.
These modes contain the same settings but present them in different 
ways:

• By selecting the “Equalizers” or “Equalizer Curve” tab in 
the Inspector.
The “Equalizers” section is similar to the “EQs” mode in the extended 
mixer, while the “Equalizer Curve” section shows a display in which you 
can “draw” an EQ curve. Setting EQ in the Inspector is only possible for 
track-based audio channels.

Note that by default, only the Equalizers tab is shown. 
To display the Equalizer Curve tab, right-click on an In-
spector tab (not in the empty area below the Inspector) 
and activate the “Equalizer Curve” option.

• By using the Channel Settings window.
This offers both parameter sliders and a clickable curve display (the 
Equalizer + Curve pane) and also lets you store and recall EQ presets.

! Below we describe how to set up EQ in the Channel 
Settings window, but the parameters are the same in 
the mixer and Inspector (apart from the presets and 
reset function, which are not available in the mixer).

In “EQs” mode, the top value 
slider controls the gain, the mid-
dle controls frequency and the 
lower sets the filter type and the 
Q parameter for each EQ band.

In “EQs Curve” mode, EQ set-
tings are shown as a curve. 
Parameters are set by click-
ing on the value and adjusting 
with the fader that appears.
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The Equalizers + Curve pane in the Channel Settings win-
dow consists of four EQ modules with parameter sliders, an 
EQ curve display and some additional functions at the top.

Using the parameter controls

1. Activate an EQ module by clicking its power button.
Although the modules have different default frequency values and differ-
ent Q names, they all have the same frequency range (20Hz to 20kHz). 
The only difference between the modules is that you can specify different 
filter types for each individual module (see below).

2. Set the amount of cut or boost with the gain control – 
the upper slider.
The range is ± 24 dB.

3. Set the desired frequency with the frequency slider.
This is the center frequency of the frequency range (20Hz to 20kHz) to 
be cut or boosted.

4. Click on the lower slider (to the left) to open the filter 
type pop-up menu and select the desired filter type.
The “eq1” and “eq4” bands can act as parametric, shelving or high/low-
pass filters, while “eq2” and “eq3” will always be parametric filters.

5. Set the Q value with the lower slider (to the right).
This determines the width of the affected frequency range. Higher values 
give narrower frequency ranges.

6. If needed, you can activate and make settings for up to 
four modules.

• Note that you can edit the values numerically as well, by 
clicking in a value field and entering the desired gain, fre-
quency or Q value.

Using the curve display

When you activate EQ modules and make settings, you will 
see that your settings are automatically reflected in the 
curve display above. You can also make settings directly in 
the curve (or combine the two methods any way you like):

1. To activate an EQ module, click in the curve display.
This adds a curve point and one of the modules below are activated.

2. Make EQ settings by dragging the curve point in the 
display.
This allows you to adjust gain (drag up or down) and frequency (drag left 
or right).

3. To set the Q parameter, press [Shift] and drag the 
curve point up or down.
You will see the EQ curve become wider or narrower as you drag.

• You can also restrict the editing by pressing [Ctrl]/
[Command] (sets gain only) or [Alt]/[Option] (sets fre-
quency only) while you drag the curve point.

4. To activate another EQ module, click somewhere else 
in the display and proceed as above.

5. To turn off an EQ module, double-click its curve point 
or drag it outside the display.

6. To mirror the eq curve on the x axis, click the button to 
the left of the curve display.

EQ bypass

Whenever one or several EQ modules are activated for a 
channel, the EQ button will light up in green in the mixer 
channel strip, Inspector (Equalizer and Channel sections), 
Track list and Channel Settings window (top right corner 
of the EQ section).

You can also bypass all EQ modules. This is useful, as it 
allows you to compare the sound with and without EQ. 
Proceed as follows:

• In the mixer, the Track list and in the Channel section in 
the Inspector, click the EQs state button so that it turns 
yellow.
To deactivate EQ Bypass, click the button again, so that it turns green 
again.
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• In the Inspector (Equalizers tab) and in the Channel 
Settings window, click the Bypass button (next to the EQ 
button) so that it turns yellow.
Click again to deactivate EQ Bypass mode.

EQ bypass in the mixer, the Channel Settings window and in the Inspector.

EQ reset

On the preset pop-up menu in the Channel Settings win-
dow and in the Inspector, you will find the Reset command. 
Holding down [Alt]/[Option] and clicking this will turn off all 
EQ modules and reset all EQ parameters to their default 
values.

Using EQ presets

Some useful basic presets are included with the program. 
You can use them as they are, or as a starting point for fur-
ther “tweaking”. 

• To call up a preset, pull down the presets pop-up menu 
in the Channel Settings window or in the Inspector and 
select one of the available presets.

• To store the current EQ settings as a preset, select 
“Store Preset” on the presets pop-up menu and enter the 
desired name for the preset in the dialog that appears.

• To rename the selected preset, select “Rename Preset” 
on the pop-up menu and enter a new name.

• To delete the selected preset, select “Remove Preset” 
on the pop-up menu.

You can also apply EQ (and Inserts) settings from 
Track presets, see “Inserts and EQ settings from track 
presets” on page 337.

EQ in the channel overview

If the “Channel” section is selected in the Inspector or the 
“Overview” view mode is selected in the extended mixer, 
you will get an overview of which EQ modules, insert ef-
fects and effect sends are activated for the channel.

By clicking the respective indicator (1 to 4), you can turn 
the corresponding EQ module on or off.

The channel overview in the Inspector.

The option “Use Nuendo 3 EQ settings as default”

In the Preferences (VST page) you will find the option “Use 
Nuendo 3 EQ settings as default”. When you activate this 
option, the EQ settings from the previous program version 
will be used by default. This means that when you create a 
new track, the four EQ modules will be set to the EQ band 
types they had in Nuendo 3:

This EQ module… …will be set to

EQ1 Low Shelf 1

EQ2 Parametric 1

EQ3 Parametric 1

EQ4 High Pass 1
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Copying settings between audio channels
It is possible to copy all channel settings for an audio chan-
nel and paste them to one or several other channels. This 
applies to all audio-based channel types. For example, you 
can copy EQ settings from an audio track and apply these 
to a group or VST Instrument channel, if you want them to 
have the same sound. 

Proceed as follows:

1. In the mixer, select the channel you want to copy set-
tings from.
You can also select channels with the Channel Select pop-up menu – 
see “Changing channels in the Channel Settings window” on page 137.

2. Click the “Copy Selected Channel Settings” button on 
the common panel.

3. Select the channel(s) you want to copy the settings to 
and click the “Paste Settings to Selected Channels” but-
ton (below the “Copy First Selected Channel Settings” 
button).
The settings are applied to the selected channel(s).

• You can copy channel settings between different types 
of channels, but only those channels will be used for 
which corresponding settings are available in the target 
channel:

• For example, as input/output channels don’t have send ef-
fects, copying from them will leave the Sends settings in the 
target channel unaffected.

• Also, in case of Surround Sound, for example, any Insert ef-
fects routed to surround speaker channels will be muted, 
when the settings are pasted to a mono or stereo channel.

Initialize Channel and Reset Mixer
The Initialize Channel button can be found at the bottom in 
the Control Strip section of the Channel Settings window 
(if this section is not shown in the Channel Settings win-
dow, open the context menu and select “Control Strip” on 
the Customize View submenu). Initialize Channel resets 
the selected channel to the default settings. 

Similarly, the mixer common panel holds a Reset Mixer/
Reset Channels button – when you click this, you will be 
asked whether you want to reset all channels or just the 
selected channels.

The default settings are:

• All EQ, Insert and Send effect settings are deactivated and re-
set.

• Solo/Mute is deactivated.
• The fader is set to 0dB.
• Pan is set to center position.

Changing the meter characteristics 
In the Mixer context menu, opened by right-clicking any-
where on the mixer panel, there is a submenu named “Glo-
bal Meter Settings”. Here you can make settings for the 
preferred meter characteristics, with the following options:

• If “Hold Peaks” is activated, the highest registered peak 
levels are “held” and are shown as static horizontal lines in 
the meter.
Note that you can turn this on or off by clicking in any audio level meter in 
the mixer.

Hold is activated. The highest regis-
tered peak is displayed in the meter.
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• If “Hold Forever” is activated, the peak levels will remain 
until meters are reset (by clicking the numerical peak dis-
play below the meter).
If “Hold Forever” is off, you can specify for how long the peak levels will 
be held with the parameter “Meters’ Peak Hold Time” in the Preferences 
(VST–Metering page). The peak hold time can be between 500 and 
30000ms.

• If “Meter Input” is activated, meters will show input lev-
els for all audio channels and input/output channels. 
Note that the input meters are post input gain.

• If “Meter Post-Fader” is activated, meters will show 
post-fader levels.
This is the default setting for channels in the mixer.

• There is also a “Meter Post-Panner” mode.
This is similar to “Meter Post-Fader”, but the meters will reflect pan set-
tings as well.

• If “Fast Release” is activated, the meters respond very 
quickly to level peaks. If “Fast Release” is deactivated, the 
meters respond more like standard meters.
You can set the time it takes for the meters to “fall back” in the Prefer-
ences (VST–Metering page).

Using group channels
You can route the outputs from multiple audio channels to 
a group. This enables you to control the channel levels us-
ing one fader, apply the same effects and equalization to 
all of them etc. To create a group channel, proceed as fol-
lows:

1. Select Add Track from the Project menu and select 
“Group Channel” from the submenu that appears.

2. Select the desired channel configuration and click OK.
A group channel track is added to the Track list and a corresponding 
group channel strip is added to the mixer. By default the first group chan-
nel strip is labeled “Group 1”, but you can rename it just like any channel 
in the mixer.

3. Pull down the Output routing pop-up for a channel you 
want to route to the group channel, and select the group 
channel.
The output of the audio channel is now redirected to the selected group.

4. Do the same for the other channels you wish to route 
to the group.

Settings for group channels

The group channel strips are (almost) identical to audio 
channel strips in the mixer. The descriptions of the mixer 
features earlier in this chapter apply to group channels as 
well. Some things to note:

• You can route the output of a group to an audio channel 
(see “Recording from busses” on page 69), to an output 
bus or to another group with a higher number.
You cannot route a group to itself. Routing is done with the Output Rout-
ing pop-up menu in the Inspector (select the subtrack for the Group in 
the Track list) or in the Routing section at the top of each channel strip.

• There are no Input Routing pop-ups, Monitor buttons or 
Record Enable buttons for group channels.
This is because inputs are never connected directly to a group.

• Solo functionality is automatically linked for channels 
routed to a group and the group channel itself.
This means that if you solo a group channel, all channels routed to the 
group are automatically soloed as well. Similarly, soloing a channel 
routed to a group will automatically solo the group channel.

• Mute functionality depends on the setting “Group Chan-
nels: Mute Sources as well” in the Preferences (VST page). 
By default, when you mute a group channel no audio will pass through 
the group. However, other channels that are routed directly to that group 
channel will remain unmuted. If any of those channels have aux sends 
routed to other group channels, FX channels or output busses, those will 
still be heard. 
If the option “Group Channels: Mute Sources as well” is activated in the 
Preferences (VST page), muting a group channel will cause all other 
channels directly routed to it to be muted as well. Pressing mute again 

! You can select a group channel as an Input for an 
audio track, e.g. to record a downmix of separate 
track outputs routed to a group (see “Recording 
from busses” on page 69).
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will unmute the group channel and all other channels directly routed to it. 
Channels that were muted prior to the group channel being muted will 
not remember their mute status and will be unmuted when the group 
channel is unmuted.

One application of group channels is to use them as “effect 
racks” – see the chapter “Audio effects” on page 168.

About output busses
Nuendo uses a system of input and output busses which 
are set up using the VST Connections dialog. This is de-
scribed in the chapter “VST Connections: Setting up input 
and output busses” on page 10.

Output busses let you route audio from the program to the 
outputs on your audio hardware. 

Routing audio channels to busses

To route the output of an audio channel to one of the ac-
tive busses, proceed as follows:

1. Open the mixer.

2. Make sure the input/output settings panel is visible – 
see “Normal vs. Extended channel strips” on page 126.

3. Pull down the Output Routing pop-up menu at the top 
of the channel strip and select one of the busses.
This pop-up menu contains the output busses configured in the VST 
Connections window, as well as available group channels (provided that 
the busses and groups are compatible with the speaker configuration for 
the channel – see “Routing” on page 14).

You can also make routing settings in the Inspector.

For details on routing surround channels, see “Surround in 
the mixer” on page 205.

Viewing the output busses in the mixer

Output busses are shown as output channels in a sepa-
rate pane to the right in the mixer. You show or hide this 
pane by clicking the Hide Output Channels button in the 
mixer’s common panel to the left:

Each output channel resembles a regular audio channel 
strip. Here you can do the following:

• Adjust master levels for all configured output busses using the 
level faders.

• Adjust input gain and input phase of the output busses.
• Add effects or EQ to the output channels (see the chapter 

“Audio effects” on page 168).
• Create Sends that can be routed to other Output channels as 

long as they are to the right of the selected Output channel in 
the mixer. This can be useful when creating quick headphone 
mixes from the current monitor mix. This is done by creating a 
send from the current monitor Output bus to another Output 
bus that is routed to a headphone amplifier.

! The option “Group Channels: Mute Sources as well” 
does not affect how mute automation is written. 
Writing mute automation on a group channel only af-
fects the group channel and not channels routed to 
it. When writing the automation, you will see the 
other channels being muted when this option is acti-
vated. However, upon playback, only the group 
channel will respond to the automation.
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MIDI specific procedures
This section describes basic procedures for MIDI chan-
nels in the mixer.

Selecting what to show in the extended MIDI 
channel strip
When using the extended channel strip view options (see 
“Normal vs. Extended channel strips” on page 126), the 
upper panel can be set to show different views for each 
MIDI channel strip. You select what to display for each 
channel by using the View options pop-up menu at the top 
of each channel strip. The following views are possible:

• The MIDI insert effects.
MIDI inserts can also be found in the Inspector and the Channel Settings 
window for MIDI channels. How to use MIDI insert effects is described in 
the chapter “MIDI realtime parameters and effects” on page 342.

• The MIDI send effects.
The sends can also be found in the Inspector and the Channel Settings 
window for MIDI channels. How to use MIDI send effects is described in 
the chapter “MIDI realtime parameters and effects” on page 342.

• The “Meter” option shows large level (velocity) meters in 
the extended panel.

• You can also select the “Overview” option – this shows 
a graphic overview of which insert effect slots and effect 
sends are activated for the channel.
You can click the indicators to turn the corresponding slot/send on or off.

• The “User Panel” option allows you to import MIDI de-
vice panels – this is described in the separate PDF docu-
ment “MIDI Devices”.

• Selecting “Empty” will display a blank panel in the ex-
tended strip.

• By selecting from the View options pop-up on the com-
mon panel, you can set the view for all channels in the 
mixer.
Selecting EQ or Surround Panners (which apply to audio channels only) 
will not change the view for MIDI channels. Selecting inserts or send ef-
fects from the common panel will change the view for all channel types.

Using Channel Settings
For each MIDI channel strip in the mixer (and MIDI track in 
the Track list or the Inspector), there is an Edit (“e”) button. 

Clicking this opens the MIDI Channel Settings window. 
By default, this window contains a duplicate of the mixer 
channel strip, a section with four MIDI inserts and a sec-
tion with four MIDI send effects. 

You can customize the Channel Settings window, by 
showing/hiding the different panels and/or by changing 
their order:

• To specify, which panels should be shown/hidden, right-click 
in the Channel settings window, and activate/deactivate the 
respective options on the Customize View submenu on the 
context menu.

• To change the order of the panels, select “Setup” on the Cus-
tomize View pop-up menu and use the “Move up” and “Move 
Down” buttons in the dialog that opens.

Every MIDI channel has its own channel settings.

The MIDI Channel Settings window.
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Utilities

Link/Unlink channels
This function is used to “link” selected channels in the 
mixer so that any change applied to one channel will be 
mirrored by all channels in that group. You can link as 
many channels as you like, and you can also create as 
many groups of linked channels as you like. To link chan-
nels in the mixer, proceed as follows:

1. Press [Ctrl]/[Command] and click on all the channels 
you want to link.
[Shift]-clicking allows you to select a continuous range of channels.

2. Right-click somewhere on the gray mixer panel.
The Mixer context menu appears.

3. Select “Link Channels” from the context menu.

• To unlink channels, select one of the linked channels and 
select “Unlink Channels” from the Mixer context menu.
The channels are unlinked. Note that you do not need to select all the 
channels that are linked, only one of them.

It is not possible to remove individual channels from 
Link status. 
To make individual settings to a linked channel, press [Alt]/[Option] when 
changing the setting.

What will be linked?

The following rules apply for linked channels:

• Only level, mute, solo, select, monitor and record enable 
will be linked between channels.
Effect/EQ/pan/input and output routing settings are not linked.

• Any individual channel settings you have made before 
linking will remain until you alter the same setting for any of 
the linked channels.
For example, if you link three channels, and one of them was muted at the 
time you applied the Link Channel function, this channel will remain muted 
after linking. However, if you mute another channel all linked channels will 
be muted. Thus, the individual setting for one channel is lost as soon as 
you change the same parameter setting for any of the linked channels.

• Fader levels will be “ganged”.
The relative level offset between channels will be kept if you move a 
linked channel fader.

The three channels shown are linked. Pulling down one fader changes 
the levels for all three channels, but keeps the relative level mix.
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• By pressing [Alt]/[Option], you can make individual set-
tings and changes for channels that are linked.

Linked channels have individual automation subtracks. 
These are completely independent, and are not affected 
by the Link function.

The Window submenu
The Mixer context menu, opened by right-clicking anywhere 
on the Mixer window background, provides the Window 
submenu. Its options are handy for quickly switching to an-
other open mixer window, showing/hiding the different 
mixer panes etc. It contains the following options:

• Show Routing View
Allows you to show/hide the topmost section of the mixer which contains 
the input/output routing settings.

• Show Extended View
Allows you to show/hide the middle section of the mixer, where you can 
display different settings for the channels (EQs, Send effects, etc.).

• Next Mixer
This displays the next mixer window (if you have several mixer windows 
open).

Saving mixer settings

It is possible to save complete mixer settings for selected 
or all audio channels in the mixer. These can later be 
loaded into any project. Channel settings are saved as 
mixer settings files. These have the Windows file exten-
sion “.vmx”. 

Right-clicking somewhere in the mixer panel or in the 
Channel Settings window brings up the Mixer context 
menu where the following Save options can be found:

• “Save Selected Channels” will save all channel settings 
for the selected channels.
Input/output routings are not saved.

• “Save All Mixer Settings” saves all channel settings for 
all channels.

When you select any of the above options, a standard file 
dialog opens where you can select a name and storage lo-
cation on your disk for the file.

Loading mixer settings 

Load Selected Channels

To load mixer settings saved for selected channels, pro-
ceed as follows:

1. Select the same number of channels in the new project 
to match the number of channels you saved settings for in 
the previous project.
For example, if you saved settings for six channels, select six channels in 
the mixer.

• Mixer settings will be applied in the same order as they 
were in the mixer.
Thus, if you save settings from channels 4, 6 and 8 and apply these set-
tings to channels 1, 2 and 3, the settings saved for channel 4 would be 
applied to channel 1, the settings saved for channel 6 to channel 2 and 
so on.

2. Right-click the mixer panel to open the context menu, 
and select “Load Selected Channels”.
A standard file dialog appears, where you can locate the saved file.

3. Select the file and click “Open”.
The channel settings are applied to the selected channels.

! Saving/Loading mixer settings does not apply to 
MIDI channels in the mixer – only audio-related 
channels (group, audio, instrument, effect return, 
VSTi and ReWire) are saved with this function!

! If you choose to apply mixer settings to fewer chan-
nels than you saved, the order of the saved channels 
in the mixer applies – i.e. the saved channels that are 
“left over” and not applied will be the channels with 
the highest channel numbers (or furthest to the right 
in the mixer).
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Load All Mixer Settings

Selecting “Load All Mixer Settings” from the context menu 
allows you to open a saved mixer settings file, and have 
the stored settings applied to all channels for which there 
is information included in the file. All channels, master set-
tings, VST Instruments, sends and master effects will be 
affected.

Please note that if the saved mixer settings were for 
24 channels, for example, and the mixer you apply it to 
currently contains 16 channels, only the settings for chan-
nels 1 to 16 will be applied – this function will not auto-
matically add channels.

About the VST Performance window

The VST Performance window is opened from the Devices 
menu. It indicates the current load on the CPU and the hard 
disk transfer rate. It is recommended that you check this 
from time to time, or keep it always open. Even though you 
have been able to activate a number of audio channels in 
the project without getting any warning, you may run into 
performance problems when adding EQ or effects.

• The upper bar graph shows the CPU (processor) load.
If the red Overload indicator lights up, you need to decrease the number 
of EQ modules, active effects and/or audio channels playing back simul-
taneously.

• The lower bar graph shows the hard disk transfer load.
If the red overload indicator lights up, the hard disk is not supplying data 
fast enough to the computer. You may need to reduce the number of tracks 
playing back by using the Disable Track function (see “About track disable/
enable” on page 62). If this doesn’t help, you need a faster hard disk. 
Note that the overload indicator may occasionally blink, e.g. when you lo-
cate during playback. This does not indicate a problem, but happens be-
cause the program needs a moment for all channels to load data for the 
new playback position.

The CPU and Disk load meters can also be shown on 
the Transport panel (as “Performance”) and on the Project 
window toolbar (as “Performance Meter”).
There they are shown as two miniature vertical meters (by default at the 
left side of the panel/toolbar).
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VST Mixer Diagrams 
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Background

Large console Monitoring sections
In traditional analog studios, the audio console maintained 
control over every audio signal in the studio, including the 
control room monitors, headphone systems, external 2-
track tape machines and communications such as the talk-
back system.

The console itself provided a means of creating multiple 
cue mixes for performers in the studio. Using available aux 
sends, the engineer could create multiple cue mixes for 
the various performers, each one having a unique mix tai-
lored for that person or group of performers.

With the advent of the DAW, many of the functions of the 
console started being performed inside the audio soft-
ware, allowing for more flexibility and instant recall of any 
setting. In many studios, the console sat idle except for 
adjusting the playback level of the speakers, switching to 
monitor external devices and routing signals to head-
phones and other cue mix playback systems.

Smaller hardware units have been made to replace the 
monitoring section using a simple volume knob with 
speaker and input switches. Some even include a talkback 
system and headphone amplifiers.

Surround sound

With more and more surround recording and mixing being 
performed in the DAW environment, the needs of the mon-
itoring section have become magnified. Surround speaker 
setups must be able to work with smaller, stereo speakers 
and even mono speaker systems. Switching back and forth 
between them can become quite complicated. Also, the 
ability to perform downmixes of multi-channel audio is now 
needed on a regular basis for many audio professionals. 

Virtual Control Room solution

Nuendo has now added the functionality of the control 
room monitoring section of large format analog consoles to 
the virtual audio environment of VST with the creation of the 
Control Room Mixer and Control Room Overview windows.

The concept
The concept behind creating the Control Room features 
was to divide the studio environment into the performing 
area (studio) and the engineer/producer area (control 
room) common to traditional studios. Previously, an analog 
console or some method of speaker control and monitor 
routing was necessary to provide this functionality to the 
DAW environment. 

Nuendo now provides all the functionality of the analog 
console’s monitoring section, along with many more fea-
tures, in the virtual world where flexibility and instant recall 
are expected.

Control Room features
The following features are available for the Control Room 
Mixer:

• Support for up to four sets of monitors with various speaker 
configurations from mono up to 10.2 cinema speaker systems.

• Dedicated Headphone output.
• Support for up to four discrete cue mix outputs called “Studios”.
• Dedicated Talkback channel with flexible routing and automatic 

record defeat.
• Support for up to six external inputs with configurations up to 

10.2 surround.
• Click track routing and level control to all Control Room out-

puts.
• Flexible Listen Bus options with the Listen Dim setting that 

allows Listen-enabled tracks to be heard in context with the 
whole mix.

• Listen Bus Enabling on both Control Room and Headphone 
outputs.

• User-definable downmix settings using the MixConvert plug-in 
for all speaker configurations.

• Individual speaker soloing for all speaker configurations.
• Multiple inserts on each Control Room channel for metering 

and surround de-coding among other possibilities.
• Monitor Dim function with adjustable level.
• User-defined Calibrated Monitor level for post-production 

mixing in a calibrated environment.

! Please note that when we speak of “the Mixer” in this 
chapter we refer to the Control Room Mixer window. 
The normal Nuendo Mixer is referred to as the 
“Project Mixer”. For information about the Project 
mixer, see the chapter “The mixer” on page 122.
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• Adjustable Input Gain and Input Phase on all external inputs 
and Speaker outputs.

• Full-sized meters on every Control Room channel.
• Support for up to four aux sends (Studio Sends) for creation 

of discrete cue mixes for performers. Each Studio output has 
its own cue mix.

• The ability to disable the Control Room Section when working 
with an external monitoring solution or console.

• Full support for the monitoring section functionality of the ID 
control surface.

Configuring the Control Room
The Control Room features are configured in several loca-
tions within Nuendo. 

• The VST Connections window has a tab labelled “Studio” in 
which the hardware inputs and output are defined for the 
Control Room channels.

• In the Devices menu you will find the Control Room Overview 
that displays a visual overview of the Control Room channels 
and signal flow.

• In the Devices menu you will find the Control Room Mixer 
which allows operation of the Control Room features.

• In the Preferences (VST–Control Room page) you will find 
some settings for altering the Control Room preferences.

VST Connections Studio tab
The Studio tab of the VST Connections window is where 
you configure the inputs and outputs for the Control Room 
Mixer. For more information, see the chapter “VST Connec-
tions: Setting up input and output busses” on page 10.

Control Room channels

There are five types of channels that you can create, each 
defining either an input or output of the Control Room 
Mixer. As more channels are created, the Control Room 
Mixer expands to display controls for each channel.

• Monitors
Each Monitor channel is a set of outputs that are connected to monitor 
speakers in the Control Room. Each Monitor can be configured for a 
mono, stereo or up to a 10.2 surround speaker configuration. Up to four 
Monitors can be created, each with a different speaker configuration.

• Phones
The Phones channel is used by the engineer in the control room for 
checking cue mixes and as another option for listening to the mix or ex-
ternal inputs on a pair of headphones. It is not intended for cue mixes that 
performers use while recording. Only one stereo Headphone channel is 
available.
• Studios
Studio channels are intended for sending cue mixes to performers in the 
studio during recording. They have talkback and click functions and can 
monitor the main mix, external inputs or a dedicated cue mix. Up to four 
Studios can be created allowing four discrete cue mixes for performers.
• External inputs
External inputs are for monitoring external devices such as CD players, 
multi-channel recorders or any other audio source. Up to six external in-
puts can be created with various configurations from mono up to 10.2 
surround.
• Talkback
The Talkback is a mono input used for a communications system be-
tween the control room and performers in the studio. Only one mono 
Talkback channel is available.

Control Room channels cannot share hardware inputs or 
outputs with external FX or external instruments, as de-
fined in the VST Connections window (see “Connecting 
the external effect/instrument” on page 18). As you create 
connections for each channel, only those device ports that 
have not been used for external FX or instruments will be 
available. However, Control Room channels and inputs 
and outputs can share the same device ports. 

A great deal of confusion can result if outputs and Control 
Room Monitor channels share the same device ports. As a 
starting point, set all the outputs to “Not Assigned” while 
the Control Room is set up. By default, one stereo Monitor 
channel is created after installing Nuendo.

! The Control Room Mixer is designed to display infor-
mation and controls only for the channels you have 
defined in the VST Connections dialog. For example, 
if you have not defined any Studio channels, they will 
not appear in the Control Room Mixer. The Control 
Room Overview displays all the possible channels 
but only highlights the ones that have been defined. 
To see all the available controls in the Control Room 
Mixer, start by creating the maximum amount of 
channels in the VST Connections Studio tab.
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Creating a Control Room channel
To create a new channel, click on the Add Channel button 
in the Studio tab of the VST Connections window. A pop-
up menu lists all available channels along with how many 
of each type are available. Select the type of channel you 
wish to create and a dialog will appear allowing you to 
choose the configuration of the channel (stereo, 5.1, etc.). 

The Studio tab of the VST Connections window with several Control 
Room Channels created

After clicking OK, the new channel will appear in the VST 
Connections window. You can now connect it to any 
available device port using the “+” buttons and the con-
text menu in the Device Port column. An audio device 
must be selected and then a device port must be chosen 
for each audio path. You assign device ports to channels 
in the same fashion as assigning any VST connection.

Monitors

Create a Monitor channel for every set of speakers in your 
studio. A typical post-production studio could have one 
set of 5.1 surround speakers, another stereo set of speak-
ers and even a single, mono speaker for checking bal-
ances for mono broadcast. The Control Room Mixer will 
allow you to switch speakers easily. Each set of Monitors 
can have its own custom downmix settings, input gain and 
input phase adjustments.

Phones

Create a Phones channel if you intend to listen to head-
phones in the control room. The Phones channel is not in-
tended for use by performers in the studio. It is designed 
for the engineer to quickly listen to any source in the stu-
dio, including the four cue mixes, as a reference.

Studios

Create a Studio channel for each cue mix you wish to cre-
ate for performers in the studio. For example, if you have 
two available headphone amplifiers for performers to use, 
create two Studio channels, one for each headphone mix. 
There are four available Studio channels. 

External inputs

Create external input channels for every playback device 
you wish to be able to monitor in the Control Room. There 
are six available external inputs with channel configura-
tions from mono up to 10.2 surround. Use external inputs 
to quickly listen to CD players, master recorders, or other 
workstations. 

Talkback

Create a Talkback channel if you have a microphone in the 
control room available for communication with performers in 
the studio. The Talkback channel can be routed to each 
Studio channel with variable levels in order to optimize 
communications between the control room and performers.

Additionally, the Talkback is available as a possible input 
source for audio tracks. You can record from the Talkback 
just like any other input.

! If you are adding the Talkback or Phones channels, 
there are no channel configuration choices since Talk-
back is mono only and Phones are stereo only. Also, 
Studio channels can either be mono or stereo only.

! Control Room channels can share device ports with 
each other. This can be helpful if you use the same 
speakers as a stereo pair and also as the left and 
right channels of a surround speaker configuration. 
Switching between monitors that share device ports 
will be seamless, providing any downmix of multi-
channel audio to stereo if needed. Only one monitor 
set can be active at a time.

! The Phones channel is stereo only.

! Studio channels can either be mono or stereo.

! If you select external inputs as input source of an au-
dio channel, you can record them. In this case, you 
will not need to assign the device ports to the input 
channel (see “Routing” on page 14).

! Inserts are available on the Talkback and all other 
Control Room channels. A compressor/limiter can 
be inserted on the Talkback channel to ensure that 
erratic levels do not bother performers and clear 
communication with everyone is possible.
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Disabling the Control Room

Once you have created all the channels for your studio 
configuration, the Control Room functions are available for 
use. If you need to use Nuendo without the Control Room 
functions, you can simply press the Disable Control Room 
button on the Studio tab of the VST Connections window. 
Any channels you have created will be saved and when 
you enable the Control Room again, that configuration will 
be reloaded.

You can also create presets for the Control Room config-
uration in the same manner as for inputs and outputs, see 
“Other bus operations” on page 14. 

Outputs – Main Mix
For the Control Room to function correctly, the Main Mix in 
the Outputs tab must be assigned to the set of outputs that 
actually contains your final mix signal. If you only have one 
output bus, it will be the Main Mix by default.

If you have more than one output bus defined, you can 
change which one is the Main Mix by right-clicking on the 
name of the output and selecting “Set “Out” as Main Mix”. 
The Main Mix is marked by a small speaker icon to the left 
of its name.

The VST Connections Output tab showing one bus as the Main Mix 
marked by the small speaker icon.

outputs other than the Main Mix are not routed through the 
Control Room Mixer. They can, however, share the device 
ports of Studio and Monitor channels in the Control Room. 

Output click enabling

There may be a situation when you want the click to be 
routed always to a specific output bus, regardless of the 
actual Control Room settings, or indeed when the Control 
Room is disabled. In these cases, enable the click on spe-
cific outputs using the Click column on the Outputs tab in 
the VST Connections window.

The Output tab showing two stereo outputs, the Main Mix and a second 
output that is click enabled.   

! If you disable the Control Room, make sure that 
there are device ports assigned to the default output 
bus “Main Mix” on the outputs tab. Otherwise, you 
will not hear any sound from the Main Mix. 

! The click will only be heard in outputs that are as-
signed to device ports. Be aware that the click can 
also be routed to device ports using the Control 
Room features. 

! Sharing audio device ports between outputs and 
Control Room channels can cause confusing behav-
ior and possible overload of those ports without any 
indication from Nuendo. It is advisable to disconnect 
all outputs from all device ports when first configur-
ing the Control Room. 

! Be aware that some audio interfaces allow very flexi-
ble routing within the hardware itself. Certain routing 
configurations could cause overloads and possible 
damage to speaker equipment. Consult the hard-
ware documentation for further information.
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The Control Room Overview
You can access the Control Room Overview from the De-
vices menu. The Control Room Overview is designed to 
display the current configuration of the Control Room. The 
window shows all possible channels, with active channels 
highlighted once they have been created in the VST Con-
nections window. Channels that are grayed out have not 
been defined in the VST Connections window.

The Control Room Overview allows you to see the signal 
flow through the Control Room Mixer. All the routing func-
tions of the Control Room Mixer are duplicated in the 
Overview.

The Control Room Overview

Open the Control Room Mixer and the Control Room Over-
view windows side by side. As you operate the controls in 
the Mixer you will see the various pale green squares light 
up in the Overview, indicating changes in signal flow. You 
can also click the squares in the Overview and watch the 
controls in the Mixer reflect the changes in signal flow.

The Control Room Mixer
The Control Room Mixer is where you access all the fea-
tures of the Control Room. The Control Room Mixer can 
be resized to accommodate more channels and to display 
more controls. When you open the window for the first 
time, it will show none of the extendable panels.

The Control Room Mixer

Configuring the Control Room Mixer
In order to display more controls in the Control Room 
Mixer, the small arrows at the lower left and right corners 
can be clicked to open or close the extended speaker 
controls on the right (“Right Strip”) and the External Input 
and Talkback controls on the left (“Left Strip”).

The arrow at the upper right corner of the Control Room 
Mixer extends the Mixer vertically to display meters and in-
serts (“Extended view”). A second arrow appears above 
the inserts and meter display. Extending the Mixer using 
this arrow exposes the Input Gain and Input Phase switch, 
channel configuration and name for each channel (“Rout-
ing view”). 
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The different Control Room Mixer panels are handled in 
the same way as the Project Mixer panels, see “Configu-
ring the mixer” on page 126.

Control Room inserts and meters

When the Control Room Mixer displays the Extended 
View, the meters become visible. These meters look and 
function the same way as the ones in the Project Mixer.

Pressing the small meter icon at the center right side of 
the mixer will change the view to display inserts. Alterna-
tively, these can also be displayed by deactivating the 
Show Meters option on the Window submenu of the Con-
trol Room Mixer context menu.

Each Control Room channel has a set of inserts config-
ured as six pre-fader and two post-fader inserts. External 
inputs and Monitor channels only have the six pre-fader in-
serts.

The Control Room Mixer’s Extended View displaying channel inserts

If you do not wish to see full sized meters but still want 
some indication of signal activity, activate the option “Sig-
nal Presence Indicators” in the Preferences (VST–Control 
Room page). They will be displayed next to the input se-
lection buttons and will indicate signal presence for all in-
puts.

The Control Room Mixer with all Signal Presence indicators lit up.

Inserts for external inputs

Each external input has its own set of six inserts. Selecting 
each external input by clicking the button next to its name 
at the left of the Mixer window will display the inserts as-
sociated with that channel in the extended view.

! You can also use the Window submenu on the Con-
trol Room Mixer context menu to show/hide the dif-
ferent panels, just as in the Project Mixer.
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Inserts for the Talkback channel

The Talkback channel has a separate set of eight inserts. 
In order to view and adjust them, the Talkback must be en-
abled via the TALK button located to the lower right of the 
Control Room Mixer. Click once on the Talkback to latch it 
on. The inserts for external inputs will now display the 
Talkback inserts. Once the Talkback is disabled, the view 
will revert back to external input inserts.

Monitor Inserts

Each Monitor channel has a set of six inserts. These in-
serts are all post Control Room fader level and are most 
useful for surround decoding or brickwall limiting to pro-
tect sensitive monitor speakers.

Each set of monitors has its own Input Phase and Input 
Gain settings available in the top section of the extended 
Control Room Mixer. In addition, there are speaker solo 
icons along with various soloing modes and speaker rout-
ing options in the Speaker Solo panel.

The Speaker Solo panel

Use the speaker solos to test your multichannel speaker 
system and ensure that the proper channels are routed to 
each speaker.

Just below the configuration display, all settings for auto-
matic downmixing of multichannel sources are shown. 
There are four down-mix presets. Some will automatically 
configure themselves for the sets of monitors you have 
defined. Each preset is adjustable by accessing the Mix-
Convert plug-in by clicking the small arrow icon above the 
downmix presets section.

The Down-Mix Presets section.

Control Room operations
In traditional analog studios, the control room section of 
the console contained the most used set of controls in the 
whole studio. Often, the studio monitor level had all the 
markings rubbed off from so much use.

The need to constantly be able to switch monitoring 
sources, adjust the volume of monitors and route various 
cue mixes and other sources to headphone systems is the 
norm in most sessions. Meeting the needs of several per-
formers in the studio plus a producer and the engineer be-
comes a constant task that requires flexibility and ease of 
operation. Communication between everyone must be 
flawlessly clear without intruding on the creativity of per-
formers.

With all this in mind, the Nuendo Control Room Mixer is 
designed to fill those needs with a simple yet highly flexi-
ble solution. The virtual mixing environment of VST is the 
ideal solution to the varied needs of a control room matrix. 
With a virtual mixer, a high degree of customization and 
precise settings are possible with the ability to completely 
recall these settings at any time.

! You can easily identify the inserts for the Talkback 
since they have six pre-fader and two post-fader in-
serts while the external inputs only have six pre-fader 
inserts. If the Control Room Mixer is fully expanded, 
the name displayed at the very top of the Mixer will re-
flect which channel is currently in the Extended View.

! Automatic configuration of the downmix settings fol-
lows a logical path. For example, if you have defined 
one set of 5.1 monitors and another set of stereo 
monitors, Nuendo will create a 5.1 to stereo down-
mix preset and another downmix to mono. You can 
modify all the settings for each downmix preset using 
the MixConvert plug-in.

Click here to open the 
MixConvert control panel.
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Control Room Mixer layout
The Control Room Mixer has a variety of controls, some 
that are similar to the Project Mixer and some that are 
unique to Control Room operations. The following dia-
grams show every control, followed by a brief description 
of what each control does.
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1. Input Phase
Each external input and Monitor speaker output has an Input Phase re-
versal switch. When lit, all audio paths within the channel will have their 
phase reversed.

2. Input Gain
Each external input, Monitor speaker output and the Talkback input has 
an Input Gain control. When an external input or Monitor becomes ac-
tive, the Gain settings will be recalled.

3. Channel Inserts
Each channel in the Control Room Mixer has inserts available. While most 
channels have six pre-fader and two post-fader inserts, the external inputs 
and Monitors only have six pre-fader inserts.

4. Channel Configuration
This displays the current configuration of audio paths in the channel, e.g. 
Stereo, 5.1, etc.

5. Channel Labels
This displays the name of the channel as defined in the VST Connec-
tions.

6. Expansion controls
There are several arrow buttons that open and close various panels of 
the Control Room Mixer. By default, all expandable panels are hidden.

7. Use Reference Level
When you click this button, the Control Room Level is set to the refer-
ence level set in the Preferences, e.g. a level for calibrated mixing envi-
ronments such as film dubbing stages. Press [Alt]/[Option] and click on 
this button to set the Preferences reference level setting to the current 
Control Room level.

8. Control Room and Headphone Input Selectors
These buttons allow the selection of various input sources for the Con-
trol Room and Headphone channels. The choices are for External Input, 
Main Mix, or any one of the four Studio channels.

9. Show Meters/Inserts button
This allows you to switch between the display of Meters and Inserts for 
the extended Mixer view.

10. Listen Bus AFL/PFL
This button determines whether the source signals sent to the Listen bus 
are pre-fader (PFL) or post-fader (AFL).

11. Global Listen Defeat
When lit, this indicates that one or more channels in the Project Mixer are 
Listen enabled. Clicking on this button defeats Listen mode for all chan-
nels.

12. Listen DIM
This gain control adjusts the volume of the Main Mix when channels have 
been put in Listen mode. This allows you to keep Listen enabled chan-
nels in context with the Main Mix. If the Listen DIM is set to minus infinity, 
Listen enabled channels will be heard by themselves. Any other setting 
leaves the Main Mix on at a lower level.

13. DIM Enable
This turns the Control Room Level down by a preset amount (the default 
setting is -30dB). This allows a quick reduction in monitor volume with-
out disturbing the current monitor level. Clicking on the DIM button again 
returns the monitor level to the previous setting.

14. Talkback Enable
Click the Talk button to turn on the Talkback system, allowing communi-
cation between the control room and performers in the studio. There are 
two modes of operation: momentary mode used by clicking and holding 
the Talk button, and latch mode where clicking once turns the Talkback 
on until you click it again to turn it off.

15. Talkback DIM Level
When the Talkback is enabled, this control allows you to determine how 
much the output of all the channels in the Control Room Mixer is re-
duced. This prevents unwanted feedback. If the Talkback DIM level is set 
to 0dB, no change will occur in the Control Room channels.

16. Cycle Down-Mix Preset Selection
The Control Room allows four different Speaker down-mix settings for 
auditioning with various speaker configurations. Clicking this button cy-
cles through the four down-mix presets. Various icons appear to show 
which preset is active.

17. Cycle Monitor Selection
Pressing this button changes the Monitor selection to the next available 
set. As Monitors are changed, so are the down-mix presets, Monitor in-
serts, Input Gain and Input Phase controls associated with that Monitor 
set.

18. Listen Bus Enable
This turns on Listen bus functions for either the Control Room or Head-
phone outputs. If this is not enabled, the Listen bus will not be routed to 
that channel.

19. Listen Bus Gain
This level adjustment determines how loud Listen bus signals are when 
routed to the Control Room or Headphone outputs. Clicking on the num-
ber pops up a fader control for adjustment.

20. Studio Input Selectors
For Studio Channels, the input choices are External Input, Aux (from Studio 
Sends) or Main Mix.

21. Activate Channel Buttons
These buttons turn each channel’s output on or off. When lit, the channel 
is on.
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22. Channel Labels
These labels reflect the names created in the VST Connections window.

23. Talkback Level
This pop-up fader controls the amount of Talkback signal fed to the output 
of each Studio.

24. Talkback Enable
In order for Talkback signals to be routed to a Studio, this button must be 
lit. Clicking on it turns it on or off. When Talkback Enable is deactivated, 
the Talkback DIM setting has no effect on this output.

25. Metronome Mix
These level and pan controls determine how the Metronome will be 
heard in each channel. These controls are independent for each channel.

26. Metronome Enable
This determines whether click signals are sent to each channel. When lit, 
click signals will be heard in that output.

27. Channel Level Control
This is the main volume for each Control Room output. These faders do not 
affect recording input levels or the Main Mix level for exporting mixdowns.

28. External input switching
There are six available external inputs. These buttons determine which 
external input is currently being used. The names for each external input 
are displayed here as they were created in the VST Connections.

29. Signal Presence Indicators
In the Preferences dialog, there is the option to display these Signal 
Presence Indicators as a substitute for the full size meters.

The Monitor controls in the Control Room Mixer

30. Individual Speaker Solos
Each speaker icon is a solo button for that channel. [Shift]-clicking a 
speaker will solo all the speakers in that row (front or rear). [Ctrl]/[Com-
mand]-clicking on a speaker that is already soloed will mute that speaker 
and solo all other channels.

31. LFE Solo
The plus icon solos the LFE channel.

32. Solo Rear Channels
This solos all rear channels.

33. Listen to Rear Channels on Front Monitors
This button solos the rear channels and routes them to the front speak-
ers.

34. Listen to Solo Channels on Center Monitor
When this button is enabled, all speakers that are soloed will be heard in 
the center channel if there is one in the configuration. If not (as with stereo) 
the soloed channel will be heard equally in both left and right speakers.

35. Edit Down-Mix
Clicking on this tab opens the MixConvert plug-in used to down-mix mul-
tichannel signals for monitoring.

36. Down-Mix Labels
This area displays the names of the four down-mix presets. You may click 
on a name to change it. A “?” appears when there is no preset defined 
for that down-mix.

37. Monitor Labels
This area displays the names of the four possible Monitors. The names 
are created in the VST Connections when you define a Monitor channel.

38. Monitor Selection
These buttons select the current Monitor set. Each Monitor has its own 
settings including down-mix preset, solo enables, inserts, Input Gain and 
Input Phase. These settings are automatically recalled when a Monitor is 
selected.

39. Down-Mix Preset Selection
These buttons select the down-mix preset for the current Monitor.

40. Speaker Solo Defeat
This button defeats all speaker solos, resetting them for normal playback.

41. Solo Front Channels
This button solos all front speakers.

42. Solo Left and Right Channels
This button solos the left and right channels.
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The Main Mix and the Control Room channel
The channel configuration of the “Main Mix” (the default 
output) determines what the channel configuration of the 
Control Room channel will be. Switching between a project 
that has a stereo Main Mix to a project that has a 5.1 Main 
Mix will cause the Control Room channel in the Control 
Room Mixer to change from a stereo to a 5.1 configuration.

The Main Mix configuration also determines the layout of 
the Speaker Solo panel. If the Main Mix is stereo, there will 
only be a left and right speaker in the solo panel.

Any external input that has more channels than the Main 
Mix will not be heard correctly when routed to the Control 
Room channel. Only the channels available will be heard.

If a 5.1 external input is routed to a stereo Control 
Room channel, only the left and right channels will be heard 
even if a 5.1 Monitor is selected. Only two channels can be 
routed through a stereo Control Room channel. You could 
use an instance of MixConvert on the external input’s in-
serts to down-mix the material to stereo in order to hear it.

Suggested settings
With all the versatility that the Control Room provides 
there are also opportunities for confusion when first set-
ting up the Control Room. The following list contains sug-
gestions that could help to quickly set up the Control 
Room to get started for recording and mixing.

• If you do not have a master recording device and only use the 
Export Mixdown function to create finished mix files, set your 
Main Mix output to “Not Assigned”. This eliminates many con-
fusing errors and unpredictable behavior since outputs and 
Control Room Monitors can share hardware outputs. The 
Main Mix is automatically routed to the Control Room channel 
and will not be affected.

• Create one stereo Monitor to familiarize yourself with the Con-
trol Room level controls, DIM settings, the Listen Bus and 
other monitoring features. Once you have become acquainted 
to some of these functions, create additional Monitors for ev-
ery set of speakers you intend to use.

• Use the inserts on Monitor channels for surround decoding 
and bass management plug-ins among other things.

• Use the inserts on the Control Room channel for metering and 
spectral analysis plug-ins. All solos including the Listen Bus 
will come through the Control Room channel allowing analysis 
of individual sounds.

• A brickwall limiter in the last insert of the Control Room chan-
nel can prevent accidental overloads and damage to speaker 
systems.

• Use the inserts for the Talkback channel to control the dynam-
ics of the talkback microphone. This will help protect perform-
ers’ hearing and ensure that everyone can be heard over the 
talkback microphone.

• Use the Gain settings on the external inputs to level balance 
CD players and other sources to the Main Mix level for A/B 
comparisons.

• Use the Gain settings on each Monitor to level balance all your 
monitor systems. Switching between sets of speakers will re-
sult in the same playback volume.

• Use the calibrated Control Room level for film or DVD mixing. 
Set this level to the proper speaker volume as determined by 
the mixing standard you choose to follow.

Control Room preferences
There are several preferences for the Control Room Mixer. 
These are found in the Preferences (VST–Control Room 
page).

The Control Room Preferences

Most of these preferences deal with what options are visi-
ble in the Control Room Mixer. This allows you to custom-
ize the layout of the Mixer and only have the controls 
visible that you use the most without added clutter.
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The other preferences have the following functionality:

• Reference Level 
This setting determines the Control Room level used when the Refer-
ence Level button is activated.

• Main Dim Volume 
This is the amount of gain reduction applied to the Control Room chan-
nel when the DIM button is activated.

• Show Control Room Volume in Transport Panel
This option makes the small fader at the right hand side of the Transport 
Panel control the Control Room level. When this option is not activated 
(or the Control Room is disabled), that fader controls the level of the 
Main Mix bus.

• Disable Talkback during Recording
When activated, this option will turn off the Talkback channel when the 
transport enters Record. It is advisable to set the Talkback DIM to 0dB 
when using this feature so as not to radically change the mix level when 
punching in and out of Record.

• Use Phones Channel as Preview Channel
When activated, the Headphone output will be used for Preview options 
such as Import preview, scrubbing, offline process preview and certain 
Sample Editor operations. Note that when using the Headphones output 
for preview, the Control Room channel will no longer output preview audio.

• Dim Studio during Talkback
When this option is enabled, the cue mix heard in a Studio will be dimmed 
(by the amount set in the Talkback dim level field (below the TALK button) 
for as long as the Talkback channel is used. When disabled, the cue mix 
level remains the same during Talkback.

Studios and Studio Sends
Studio Sends are displayed in the Nuendo Project Mixer 
and the Inspector. Each Studio Send is intended for the 
creation of a discrete cue mix for performers to listen to 
during recording. Studio Sends are essentially stereo aux 
sends that are routed to Studio outputs in the Control 
Room Mixer. There are up to four Studios and Studio 
Sends available.

Configuring Studio Sends
Studio Sends only become active when a Studio channel 
has been created in the VST Connections window. Other-
wise they remain grayed out. For every Studio defined in 
the VST Connections, every channel in the Project Mixer 
has an additional aux send with level, pan and pre/post-
fader selection. This aux send is used to create a mix for a 
performer to listen to while recording.

• In the Project Mixer, the Studio Sends are accessed by 
choosing the Studio Sends option from the View options 
pop-up menu in each channel or by clicking the star icon 
(“Show Studio Sends”) on the common panel of the ex-
tended Project Mixer.

The Studio Sends view in the Project Mixer
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• In the Inspector, a Studio Sends tab can be found. This 
will display all Studio Sends for the selected track.
Please note that not all Inspector sections are available by default. To 
show/hide a section, right-click on an Inspector section and activate/
deactivate the desired option on the context menu.

The Studio Sends tab in the Inspector

Each Studio can have a unique name in order to help 
identify what it is being used for. For example, the four 
Studios could be named:

• Vocalist Mix
• Guitarist Mix
• Bassist Mix
• Drummer’s Mix

The name of each Studio is displayed in the Control Room 
Mixer. To hear the Studio Sends mix in the Studio output, 
the input selector for each Studio must be set to “Aux”.

A Studio channel in the Control Room Mixer with its input set to Aux.

Setting up a Studio cue mix
The Studio Sends are very flexible. There are several ways 
to create a cue mix for each Studio in a very fast and effi-
cient manner. Simple “more me” mixes and more complex 
discrete mixes are easily accommodated by the Studio 
Sends.

Using fader and pan settings from the Project Mixer

You can create a cue mix from the fader and pan levels al-
ready used in the Project Mixer and then alter them to 
meet the needs of an individual performer. You can do this 
with any single channel or group of channels at any time. 
To copy fader and pan information from the main mix, pro-
ceed as follows:

1. In the Project Mixer, select all the channels that you 
wish to copy settings from.
The following operations affect only selected channels.
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2. In the Control Room Mixer, right-click anywhere in a 
Studio Channel’s mixer strip and a context menu will ap-
pear that has the Studio’s name as a submenu.
This submenu contains all the Studio Send functions for that Studio. If 
you open the context menu outside of a Studio mixer strip, the submenu 
will be for All Studios. 

The Control Room Mixer’s context menu

3. Choose the “Use Current Mix Levels” option to copy 
the fader levels on the selected tracks to the Studio Sends.
This option sets all Studio Send levels for the selected tracks to the 
same level as the main channel fader. It also changes the Studio Send 
status to pre-fader so that changes in the main mix do not affect the Stu-
dio Sends.

4. Choose the “Use Current Pan Settings” option to 
copy pan information from the main mix to the Studio 
Sends on selected tracks.
Studio Sends are either mono or stereo. If the Send is mono, the pan 
setting will still be copied. However, the output of the Studio Send will 
sum the left and right channels together.

5. Choose the “Enable Studio Sends” option to activate 
the Sends on selected channels.
By default, Studio Sends are not enabled even when level and pan infor-
mation is copied to them. You must enable them in order to hear the Stu-
dio cue mix.

By copying the level and pan information from the main 
mix to the Studio Sends, a rough balance can be created 
in a matter of moments. Next, you may alter the level and 
pan settings on any channel’s Studio Sends to change the 
mix to meet the performer’s needs. This may require in-
creasing the volume of the performer herself. This is often 
referred to as a “more me” mix.

Adjusting the overall Studio Send level

Levels in the main mix are often optimized for the loudest 
signal level possible without clipping. However, when you 
are creating a “more me” mix, you may find that there is not 
enough headroom available in the Studio Send to turn up 
channels without clipping becoming a possibility.

Fortunately, the Studio Sends have an option to adjust 
multiple send levels at the same time, allowing you to keep 
the blend intact while lowering the overall volume to make 
room for “more me” signals.

Once you have created a Studio Send mix, proceed as 
follows to adjust their relative levels.

1. Select all the channels you wish to modify.
Only selected channels are affected by the context menu commands.

2. Right-click anywhere in the Studio mixer strip on the 
Control Room Mixer to open the context menu for that 
Studio. 
You may also use the context menu outside of the Studio strip to adjust 
all four Studio Sends on the selected channels at the same time.

3. Choose the “Change Studio Sends Level” option from 
the Studio submenu.
This will bring up a gain window with a checkbox that reads “Relative 
Mode”. Make sure this is activated if you want to adjust already existing 
levels.

4. Either use the up and down buttons or click on the nu-
meric readout to open a pop-up fader and adjust the gain 
as necessary.
The level of all selected Studio Sends will be adjusted by the amount 
shown here. For example, if the amount reads -3dB, then each Studio 
Send level is reduced by 3dB.
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5. Click OK and the level change will be performed.
It is possible to view these changes as they occur if you have the Project 
Mixer open and the extended view set to show the Studio Sends.

Using Studio Sends from outputs

Each output also has Studio Sends. Studio Sends from 
the Main Mix output can be used to route the main mix in-
stantly to the Studio output. 

Any level changes made to the main mix will be reflected 
in the signal sent by the Studio Send. Setting the level 
lower than 0dB can leave headroom for “more me” signals 
in the Studio channel output.

Post-Fader Studio Sends

It is also possible to use the Studio Sends as post-fader 
aux sends. This is another way for the cue mix to follow 
changes made to the Main Mix. The Reset function is very 
helpful in this regard.

To reset the Studio Sends to the post-fader default level 
of -6dB, proceed as follows:

1. Select all the channels you wish to reset.
Studio Send commands only work on selected channels.

2. In the Studio Channel mixer strip right-click to open 
the context menu. In the Studio submenu, select the “Re-
set Studio Sends” command.
If you open the context menu in other areas of the Control Room Mixer 
besides the Studio mixer strips, the context menu commands will affect 
all Studios at the same time.

3. Selecting the “Reset Studio Sends” option changes 
the Send level of all selected channels to -6dB and sets 
the signal source to post-fader.
The -6dB level is designed to allow for headroom for “more me” signals 
in the Studio outputs.

Once all Studio Sends have been set to -6dB, post-fader, 
any changes to the main mix will also change the Studio 
mix. For “more me” channels, simply turn up the level on 
that channel or even set the signal to pre-fader for abso-
lute control.

Studio Send cue mix summary

Using various combinations of the above techniques 
should allow you to create complex discrete cue mixes for 
performers in very little time. Modifications to these mixes 
can occur in the Project Mixer or the Inspector, giving you 
the most accessibility for quick changes.

To familiarize yourself with how the Studio Sends work, 
open the extended Project Mixer and set the view to the 
Studio Sends. Follow the above examples and watch how 
the Studio Sends react to various commands. This should 
help you get a feel for how they function and increase the 
workflow productivity of recording sessions.

Direct Monitoring and latency
The Control Room and Studio Sends functions use the in-
ternal processing power of the host computer system for 
all routing and processing, which means they are subject 
to the computer’s latency.

When recording with several performers at once, a system 
capable of running at very low ASIO buffer settings will be 
necessary to take full advantage of all the Studio Send 
features. 

Studio Sends are not capable of controlling the Direct 
Monitoring features of various audio hardware interfaces. 
This means that unless the internal latency of the system is 
very low (128 samples or less), monitoring of record-en-
abled tracks through the Studio Sends will have some de-
lay that could affect performers during recording.

In the situation where internal latency is too much for 
record monitoring, it is advisable to use the Studio Sends 
for monitoring of tracks that have already been recorded 
and use normal Direct Monitoring for tracks currently be-
ing recorded.

! If you deactivate the “Relative Mode” option, all Stu-
dio Sends will be set to the same absolute level. 
While the dialog window is still open, you may check 
the “Relative Mode” box again and reload the previ-
ous relative levels. Only when you click OK, will the 
level settings be made permanent. Choosing Cancel 
returns all Send levels to their previous settings.
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WK-Audio’s ID Controller
With the implementation of the Control Room Features, 
functionality for the Monitoring Section of the ID control 
surface has been enabled. The ID has controls for most of 
the Control Room features including:

• Control Room Level
• Studios 1-3 Level
• Control Room Level Meter
• DIM
• Talkback (with built in mic preamp)
• Talkback DIM
• Listen Bus AFL/PFL
• Listen Bus DIM
• Monitor Selection
• Speaker Solos
• External Input Switching
• Headphones (with built-in headphone amp)
• Speaker Down-Mix Control
• Input Selection for Control Room and Headphones

! Complete documentation on the ID features is avail-
able from WK-Audio.
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About this chapter
Nuendo comes with a number of effect plug-ins included. 
This chapter contains general details about how to assign, 
use and organize effect plug-ins. The effects and their pa-
rameters are described in the separate manual “Nuendo 
Expansion Kit – Cubase Music Tools for Nuendo 4”.

Overview
There are three ways to use audio effects in Nuendo:

• As insert effects.
An insert effect is inserted into the signal chain of an audio channel, which 
means that the whole channel signal passes through the effect. This makes 
inserts suitable for effects for which you don’t need to mix dry and wet 
sound, e.g. distortion, filters or other effects that change the tonal or dy-
namic characteristics of the sound. You can have up to eight different in-
sert effects per channel (and the same is true for input and output busses 
– for recording with effects and “master effects”, respectively).

• As send effects.
Each audio channel has eight effect sends, each of which can be freely 
routed to an effect (or to a chain of effects). Send effects are practical for 
two reasons: you can control the balance between the dry (direct) and 
wet (processed) sound individually for each channel using the sends, 
and several different audio channels can use the same send effect. In 
Nuendo, send effects are handled by means of FX channel tracks. 

• By using offline processing.
You can apply effects directly to individual audio events – this is de-
scribed in the chapter “Audio processing and functions” on page 238.

About VST 3 
The new VST 3 plug-in standard offers many improve-
ments over the previous VST 2 standard, yet retains full 
backwards compatibility, i.e. you will still be able to use 
your previous VST effects and presets.

Nuendo is able to run plug-ins originally developed for dif-
ferent platforms: you can use a 32-bit plug-in under Win-
dows Vista 64 bit, and you can use plug-ins developed for 
Mac PPC on MacIntel systems.

As the use of 32-bit plug-ins on 64-bit computers affects 
the computer performance, these will be marked by an 
icon in the plug-in menus.

Please note that this functionality is provided to allow 
you to load older projects including their original plug-ins 
on current computers. However, the plug-ins will require 
higher CPU performance when compared to their native 
platform. Therefore, it is recommended to use 64 bit ver-
sions or Intel Mac (Universal Binary) versions of such 
plug-ins or instruments once available.

In the program, effects compatible with previous VST ver-
sions will be easily recognized:

VST Preset management

From a user perspective, the main difference between 
VST 2 and VST 3 is in the effect preset management. The 
“.fxp/.fxb” files used in VST 2 have been replaced by 
VST 3 Presets (extension “.vstpreset”). Using the preset 
management features, you can assign various attributes to 
your effect presets to help you quickly find the right patch. 
You can also preview effect presets before you load them. 
A large number of presets for effects are included with the 
program. If you have any previous VST plug-ins installed 
on your computer, you can still use them, and you can also 
convert their programs to VST 3 presets. See “Effect pre-
sets” on page 183 for details.

Smart plug-in processing

Another feature of the VST3 standard is “smart” plug-in 
processing. Previously, any loaded plug-in was processing 
continuously, regardless of whether a signal was present or 
not. In VST3, processing by a plug-in can be disengaged if 
there is no signal present. This can greatly reduce the CPU 
load, thus allowing for more effects to be used. 

This is achieved by activating the option “Deactivate VST3 
Plug-in when silence is detected” in the Preferences dia-
log (VST – Plug-ins page).

When this is activated, VST 3 plug-ins will not consume 
CPU power on silent passages, i.e. when no audio data 
runs through them.

! This chapter describes audio effects, i.e. effects that 
are used to process audio, group, VST Instrument 
and ReWire channels. 

An effect compatible with 
a previous VST version.

A VST 3 
effect.
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Be aware, however, that this can lead to a situation where 
you added more plug-ins on "transport stop" than the sys-
tem can handle on playback. Therefore, you should always 
find the passage with the largest number of events playing 
simultaneously to make sure that your system offers the re-
quired performance.

Activating this option can increase your system perfor-
mance a lot in certain projects, but it also makes it more 
unpredictable whether the project can play back fine on 
any timecode position of the project. 

About side-chain inputs

Several VST3 effects feature side-chain inputs. This 
means that the operation of the effect can be controlled 
via external signals routed to the side-chain input. The ef-
fect processing is still applied to the main audio signal. 
See “Setting up side-chain” on page 180.

About plug-in delay compensation
A plug-in effect may have some inherent delay or latency. 
This means that it takes a brief time for the plug-in to pro-
cess the audio fed into it – as a result, the output audio 
will be slightly delayed. This especially applies to dynam-
ics processors featuring “look-ahead” functionality. 

However, Nuendo provides full plug-in delay compensa-
tion throughout the entire audio path. All plug-in delays 
are compensated for, maintaining the sync and timing of 
all audio channels.

Normally, you don’t have to make any settings for this. How-
ever, VST3 dynamics plug-ins with look-ahead functionality 
have a “Live” button, allowing you to disengage the look-
ahead to minimize latency, if they are to be used during real-
time recording (see the separate manual “Nuendo Expan-
sion Kit – Cubase Music Tools for Nuendo 4”).

You can also constrain the delay compensation, which is 
useful to avoid latency when recording audio or playing a 
VST Instrument in real time. See “VST Instruments and In-
strument tracks” on page 189.

About tempo sync
Plug-ins can receive timing and tempo information from 
the host application (in this case, Nuendo). Typically, this 
is used to synchronize certain plug-in parameters (such as 
modulation rates or delay times) to the project tempo.

• This information is automatically provided to any VST 
(2.0 or later) plug-in that “requests it”.
You don’t need to make any special settings for this.

• You set up tempo sync by specifying a base note value. 
You can use straight, triplet or dotted note values (1/1 - 1/32).

Please refer to the separate manual “Nuendo Expansion 
Kit – Cubase Music Tools for Nuendo 4” for details about 
the included effects.

Insert effects

Background
As the name implies, insert effects are inserted into the 
audio signal path – this means that the audio channel data 
will be routed through the effect. You can add up to eight 
different insert effects independently for each audio chan-
nel (audio track, group channel track, FX channel track, 
VST Instrument channel or ReWire channel) or bus. The 
signal passes through the effects in series from the top 
downwards, with the signal path shown below:

Input gain

Insert effect 1

Insert effect 2

Insert effect 3

Insert effect 6

EQ

Volume (fader)

Insert effect 7

Insert effect 8

Insert effect 4

Insert effect 5
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As you can see, the last two insert slots (for any channel) 
are post-EQ and post-fader. Post-fader slots are best 
suited for insert effects where you don’t want the level to 
be changed after the effect, such as dithering (see “Dith-
ering” on page 173) and maximizers – both typically used 
as insert effects for output busses.

Applying several effects on several channels may be 
too much for your CPU to handle!
If you want to use the same effect with the same settings on several 
channels, it may be more efficient to set up a group channel and to apply 
your effect only once, as a single insert for this group. You can use the 
VST Performance window to keep an eye on the CPU load.

Routing an audio channel or bus through 
insert effects
Insert effect settings are available in the mixer (in extended 
mode), the Channel Settings window and the Inspector. 
The examples below show the Channel Settings window, 
but the procedures are the same for all three inserts sec-
tions:

1. Bring up the Channel Settings window, the Inserts 
pane in the extended mixer, or open the Inspector’s Inserts 
section.
In the Channel Settings window, the inserts are located to the far left by 
default.

2. Pull down the effect type pop-up for one of the insert 
slots, and select an effect.

The effect is loaded and automatically activated and its con-
trol panel opens. You can open or close the control panel 
for an effect by clicking the “e” button for the insert slot.

• If the effect has a dry/wet Mix parameter you can use 
this to adjust the balance between the dry signal and the 
effect signal.
See “Making settings for the effects” on page 182 for details about edit-
ing effects.

• To remove an effect, pull down the effect type pop-up 
menu and select “No Effect”.
You should do this for all effects that you don’t intend to use, to reduce 
the CPU load.

• You can add up to 8 insert effects per channel this way.

• You can reorder the effects by clicking in the area above 
the name field and dragging the effect onto another slot.

• You can copy an effect into another effect slot (for the 
same channel or between channels) by holding down 
[Ctrl]/[Command] and dragging it onto another effect slot.

Deactivating vs. bypassing
If you want to listen to the track without having it pro-
cessed by a particular effect, but don’t want to remove 
this effect completely from the insert slot, you can either 
deactivate or bypass it:

• To deactivate an effect, click the blue button on the left 
above the insert slot.

• To bypass an effect, click its Bypass button (the middle 
button above the insert slot).
When an effect is bypassed, this button is yellow.

Deactivating means to terminate all processing, whereas 
bypassing means to play back only the unprocessed origi-
nal signal – a bypassed effect is still processing in the 
background. Bypassing allows for crackle-free comparison 
of the original (“dry”) and the processed (“wet”) signal.

This effect is activated, and 
its control panel is open.

This insert effect is bypassed.
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• To bypass all inserts for a track, click the global bypass 
button. 
This button can be found at the top of the Inserts section in the Inspector 
or the Channel Settings window. It lights up in yellow to indicate that the 
inserts of this track are bypassed. In the track list and the channel strip in 
the mixer, the Inserts State button will also light up in yellow.

Insert effects in the channel overview
If the “Channel” section is selected in the Inspector or the 
“Channel Overview” view mode is selected in the extended 
mixer, you will get an overview of which insert effects, EQ 
modules and effect sends are activated for the channel.

You can activate or deactivate individual insert effect slots 
by clicking the corresponding number (in the top part of 
the overview).

The channel overview in the Inspector.

Using mono or stereo effects with a surround 
channel
Whether your effect supports mono, stereo or multi-chan-
nel processing, depends entirely on the effect plug-in.

Normally, when you apply a mono or stereo insert effect to 
a surround (multi-channel) track, the first speaker chan-
nels of the track (often L and/or R) are routed through the 
effect’s available channels, and the other channels of the 
track are left unprocessed.

However, you may want to apply the effect to other speaker 
channels. This is done in the Channel Settings window:

1. Right-click somewhere in the Channel Settings win-
dow (except the EQ display) to open the Channel Settings 
context menu.

2. Select “Customize View” from the menu, and select 
“Insert Routing” from the submenu.
The Insert Routing section appears to the left of the EQ display. It con-
tains a row of small signal diagrams.

3. Double-click on the small signal diagram for the effect 
to open the Routing Editor window.

The Routing Editor window.

The columns in the diagram represent the channels in the 
current configuration, with signals passing from top to 
bottom. The gray field in the middle represents the actual 
effect plug-in.

• The squares above the effect represent inputs to the effect 
plug-in.

• The squares below the effect represent outputs from the ef-
fect plug-in.

The blue color of inserts 1 and 2 and 
the blue Inserts State button in the 
channel strip indicate that this track 
has active inserts.
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• A line that passes through the effect (with no square input/
output indicators) represent a bypass connection – the audio 
on that speaker channel passes the effect without being pro-
cessed.

• A “broken” line indicates a broken connection – the audio on 
that speaker channel will not pass on to the output at all.

Here, the effect will process the L and R channels. The Ls, Rs and C 
channels are not processed, while the Lfe connection is broken.

Operations

You can move connections to the effect inputs and out-
puts sideways to route the audio to/from inputs/outputs 
other than the standard configuration. To do this, click the 
arrow buttons to the right.

• The upper two arrows move the input connections, and 
the lower two arrows move the output connections.
If the “Link” checkbox is activated, the input and output connections will be 
moved at the same time. This is the mode to use when you simply want to 
process other channels than the default, without any cross-connections.

• If you move inputs or outputs independently of each 
other, this means you create a “cross-connection”.

The audio on the Ls-Rs channels is processed in the plug-in and output 
on the L-R channels. Since the L-R channels are bypassed, this means 
the final L-R output will contain both the original L-R signals and the 
processed Ls-Rs signals.

• If a channel is bypassed (a straight line is shown 
through the plug-in) you can click the line to break the 
connection.
Click again to replace the broken connection with a bypass.

• Clicking Reset takes you back to the original standard 
connection.

Changes you make in this window are audible immedi-
ately.

Adding insert effects to busses
All input and output busses have eight insert slots, just like 
regular audio channels. The procedures for adding insert 
effects are the same.

• Adding insert effects to an input bus allows you to 
record with effects.
The effects will become a permanent part of the recorded audio file (see 
the chapter “Recording” on page 64).

• Insert effects added to an output bus will affect all audio 
routed to that bus, like a “master insert effect”.
Typically you would add compressors, limiters, EQ or other plug-ins to 
tailor the dynamics and sound of the final mix. Dithering is a special case, 
as described below.

Please note that the input/output busses only appear 
as tracks in the Track list, when their automation W(rite) 
buttons have been activated once. I.e. you can only use 
the Inspector section to make Inserts settings for the bus-
ses if you have activated Write automation for the respec-
tive bus beforehand.
However, you can always make Inserts settings in the Channel Settings 
window and the extended mixer.

Dithering
Dithering is a method for controlling the noise produced 
by quantization errors in digital recordings. The theory be-
hind this is that during low level passages, only a few bits 
are used to represent the signal, which leads to quantiza-
tion errors and hence distortion. 

For example, when “truncating bits”, as a result of moving 
from 24 to 16 bit resolution, quantization errors are added 
to an otherwise immaculate recording. By adding a spe-
cial kind of noise at an extremely low level, the effect of 
these errors is minimized. The added noise could be per-
ceived as a very low-level hiss under exacting listening 
conditions. However, this is hardly noticeable and much 
preferred to the distortion that otherwise occurs.
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When should I use dithering?

• Consider dithering when you mix down to a lower reso-
lution, either in real-time (playback) or with the Export Au-
dio Mixdown function. 
A typical example is when you mix down a project to a 16-bit stereo au-
dio file for audio CD burning.

What is a “lower resolution” then? Well, Nuendo uses 32-
bit float resolution internally, which means that all integer 
resolutions (16 bit, 24 bit, etc.) are lower. The negative ef-
fects of truncation (no dithering) are most noticeable when 
mixing down to 8 bit, 16 bit and 20 bit format; whether to 
dither when mixing down to 24 bits is a matter of taste.

Applying dithering

1. Open the VST Output Channel Settings window by 
clicking the “e” button for the Output channel in the mixer.
You can also display the Inserts section in the extended mixer pane.

2. Open the Inserts pop-up menu for slot 7 or 8.
The two last Insert effect slots (for all channels) are post-fader, which is 
crucial for a dithering plug-in. The reason is that any master gain change 
applied after dithering would bring the signal back to the internal 32 bit 
float domain, rendering the dithering settings useless.

3. Select the included UV22HR dithering plug-in from 
the pop-up menu.

The included dithering plug-ins and their parameters are 
described in the separate manual “Nuendo Expansion Kit 
– Cubase Music Tools for Nuendo 4”. If you have installed 
another dithering plug-in that you prefer, you can of 
course select this instead.

4. Make sure the dithering plug-in is set to dither to the 
correct resolution.
This would be the resolution of your audio hardware (on playback) or the 
desired resolution for the mixdown file you want to create (as set in the 
Export Audio Mixdown dialog, see the chapter “Export Audio Mixdown” 
on page 437).

5. Use the other parameters in the control panel to set up 
the dithering to your liking.

Using group channels for insert effects
Like all other channels, group channels can have up to 
eight insert effects. This is useful if you have several audio 
tracks that you want to process through the same effect 
(e.g. different vocal tracks that all should be processed by 
the same compressor). 

Another special use for group channels and effects is the 
following:

If you have a mono audio track and want to process this 
through a stereo insert effect (e.g. a stereo chorus or an 
auto panner device), you cannot just insert the effect as 
usual. This is because the audio track is in mono – the 
output of the insert effect will be in mono as well, and the 
stereo information from the effect will be lost.

One solution would be to route a send from the mono 
track to a stereo FX channel track, set the send to pre-
fader mode and lower the fader completely for the mono 
audio track. However, this makes mixing the track cumber-
some, since you cannot use the fader.

Here’s another solution:

1. Create a group channel track in stereo and route it to 
the desired output bus.

2. Add the desired effect to the group channel as an in-
sert effect.

3. Route the mono audio track to the group channel.

Now the signal from the mono audio track is sent directly 
to the group, where it passes through the insert effect, in 
stereo.
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Freezing (rendering) insert effects for a track
Effect plug-ins can sometimes require a lot of processor 
power. If you are using a large number of insert effects for 
a track, you may eventually reach a point where the com-
puter cannot play back the track properly (the CPU over-
load indicator in the VST Performance window lights up, 
you get crackling sounds, etc.).

To remedy this, you can freeze the track, by clicking the 
Freeze button in the Inspector.

• The Freeze Channel Options dialog is opened, allowing 
you to set a “Tail” time in seconds.
This adds time at the end of the rendered file to allow reverb and delay 
tails to fully fade out.

• The program now renders the output of the track, in-
cluding all pre-fader insert effects, to an audio file.
This file is placed in the “Freeze” folder within the Project folder (Win-
dows). On the Mac, the Freeze folder is stored under “User/Documents”.

• The frozen audio track is locked for editing in the Project 
window.
The frozen insert effects cannot be edited or removed and you cannot 
add new insert effects for the track (except post-fader effects).

• On playback, the rendered audio file is played back. 
You can still adjust the level and panning in the Mixer, 
make EQ settings and adjust the effect sends.
In the Mixer, the channel strip for a frozen track is indicated by a “snow 
flake” symbol on the volume fader handle.

After freezing the Inserts for a track, you hear the track 
play back as before but the insert effects don’t have to be 
calculated in real time, easing the load on the computer 
processor. Typically, you would freeze a track when it’s 
finished and you don’t need to edit it anymore.

• You can only freeze audio tracks this way, not group 
channel tracks or FX channel tracks.

• The last two insert effects will not be frozen. This is 
because these are post-fader insert slots.

• You can also freeze VST instruments and their insert 
effects – see “VST Instruments and Instrument tracks” on 
page 189.

Unfreezing

If you need to edit the events on a frozen track or make 
settings for the insert effects, you can unfreeze the track:

1. Click the Freeze button in the Inspector for the track.
You will be asked whether you really want to unfreeze the channel and if 
you wish to keep or delete the freeze files.

2. Click “Unfreeze” or “Keep Freeze files”.
This reactivates the frozen insert effects. Clicking “Keep Freeze Files” 
will unfreeze the channel but not delete the freeze files. After editing you 
can freeze the track again.

Send effects

Background
As their name implies, send effects are outside of an audio 
channel’s signal path, i.e. the audio data to be processed 
must be sent to the effect (as opposed to insert effects, 
which are inserted into the channel’s signal path).

To this end, Nuendo provides FX channel tracks. When 
you have created such a track, it is added to the track list 
and can be selected as a routing target in the Send slots 
of audio channels.

• When selecting an FX channel track in one of the send 
slots of an audio channel, the audio is sent to the FX chan-
nel and through any insert effects set up for it.
Each audio channel has eight sends, which can be routed to different FX 
channels, and thus different FX channel insert effect configurations. You 
control the amount of signal sent to the FX channel by adjusting the ef-
fect send level.

• If you have added several effects to the FX channel, the 
signal passes through the effects in series, from the top 
(the first slot) downward.
This allows for “custom” send effect configurations – e.g. a chorus fol-
lowed by a reverb followed by an EQ and so on.

• The FX channel track has its own channel strip in the 
mixer, the effect return channel.
Here you can adjust the effect return level and balance, add EQ and 
route the effect return to any output bus.

• Each FX channel track can have any number of automa-
tion tracks, for automating various effect parameters. 
See the chapter “Automation” on page 213 for more information.
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Setting up send effects
Adding an FX channel track

1. Pull down the Project menu and select “FX Channel” 
from the “Add Track” submenu.
A dialog appears.

2. Select a channel configuration for the FX channel 
track.
Normally, stereo is a good choice since most effect plug-ins have stereo 
outputs.

3. Select an effect for the FX channel track.
This is not strictly necessary at this point – you can leave the plug-in 
pop-up menu set to “No Effect” and add effects to the FX channel later if 
you like.

4. Click OK.
An FX channel track is added to the track list, and the selected effect, if 
any, is loaded into the first insert effect slot for the FX channel (in that 
case, the lit Inserts tab for the FX channel track in the Inspector indicates 
that an effect has been assigned and automatically activated).

• All FX channel tracks you create will appear in a dedi-
cated “folder” track in the Track list.
This makes it easy to manage and keep track of all your FX channel 
tracks, and also allows you to save screen space by folding in the FX 
Channel folder.

FX channel tracks are automatically named “FX 1”, “FX 2” etc., but you 
can rename them if you wish. Just double-click the name of an FX chan-
nel track in either the Track list or the Inspector and type in a new name.

Adding and setting up effects

As mentioned above, you can add a single insert effect 
when you create the FX channel track. To add and set up 
effects after the FX channel track is created, you can ei-
ther use the Inspector for the track (click the Inserts tab) 
or the VST FX Channel Settings window:

1. Click the Edit (“e”) button for the FX channel track (in 
the Track list, mixer or Inspector).
The FX Channel Settings window appears, similar to a regular Channel 
Settings window.

To the left in the window is the Inserts section with eight effect slots.

2. Make sure the FX channel is routed to the correct out-
put bus.
This is done with the output routing pop-up menu at the top of the fader 
section (also available in the mixer and Inspector).

3. To add an insert effect in an empty slot (or to replace 
the current effect in a slot), click in the slot and select an 
effect from the pop-up menu.
This works just like when selecting insert effects for a regular audio 
channel.

4. When you add an effect, its control panel will automat-
ically appear. When you set up send effects, you would 
normally set the wet/dry Mix control to all “wet”.
This is because you control the balance between the wet and the dry sig-
nal with the effect sends. For more information, see “Making settings for 
the effects” on page 182.

• You can add up to eight effects for an FX channel.
The signal will pass through all the effects in series. It is not possible to 
adjust the effect send and return levels separately for the effects – this is 
done for the FX channel as a whole. If what you want is several separate 
send effects (where you can control the send and return levels indepen-
dently), you should instead add more FX channel tracks – one for each 
effect.



177

Audio effects

• You can reorder the effects by clicking in the area above 
the name field and dragging the effect onto another slot.

• You can copy an effect into another effect slot (for the 
same channel or between channels) by holding down 
[Ctrl]/[Command] and dragging it onto another effect slot.

• To remove an insert effect from a slot, click in the slot 
and select “No Effect” from the pop-up menu.
You should do this for all effects that you don’t intend to use, to reduce 
the CPU load.

• You can bypass individual effects (or all effects) by 
clicking the corresponding Bypass button(s) for the FX 
channel track.
See “Routing an audio channel or bus through insert effects” on page 171.

• You can also adjust level, pan and EQ for the effect re-
turn in the FX Channel Settings window.
This can also be done in the mixer or in the Inspector.

Remember that the more effect units you use, the 
higher the CPU load.

Setting up the sends
The next step is to set up a send for an audio channel and 
route it to the FX channel. This can be done in the mixer (in 
the extended panel), in the Channel Settings window or in 
the Inspector for the audio track. The example below 
shows the Channel Settings window, but the procedure is 
similar for all three sections:

1. Click the “e” button for an audio channel to bring up its 
Channel Settings window.
In the mixer you would select one of the Sends modes for the extended 
mixer panel; in the Inspector you would click the Sends tab.

In the Channel Settings window, the send section is lo-
cated to the left of the channel strip by default. Each of the 
eight sends has the following controls:

• An On/Off button for activating/deactivating the effect
• A send level slider
• A pre/post-fader switch
• An “e” (edit) button

Note that the last three items are not shown until the send 
is activated and an effect has been loaded.

2. Pull down the routing pop-up menu for a send by 
clicking in the empty slot, and select the desired routing 
destination.

• If the first item on this menu (“No Bus”) is selected, the send 
isn’t routed anywhere.

• Items called “FX 1”, “FX 2” etc. correspond to existing FX 
tracks. If you renamed an FX track (see “Adding an FX channel 
track” on page 176) that name will appear on this menu in-
stead of the default.

• The menu also allows for routing a send directly to output bus-
ses, separate output bus channels or Group channels.

3. Select an FX channel track from the pop-up menu.
Now the send is routed to the FX channel.

4. Click the power button for the effect send so that it 
lights up in blue.
This activates the send.

5. Click and drag the send level slider to a moderate 
value.
The send level determines how much of the signal from the audio chan-
nel is routed to the FX channel via the send.

Setting the Send level.
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6. If you want the signal to be sent to the FX channel be-
fore the audio channel’s volume fader in the mixer, click on 
the Pre-Fader button for the send so that it lights up.
Normally you want the effect send to be proportional to the channel vol-
ume (post-fader send). The picture below shows where the sends are 
“tapped” from the signal in pre and post-fader mode.

A send set to pre-fader mode.

You can choose whether a send in pre-fader mode 
should be affected by the channel’s Mute button or not.
This is done with the option “Mute Pre-Send when Mute” in the Prefe-
rences dialog (VST page).

• When one or several sends are activated for a channel, 
the Send Effects buttons light up in blue in the mixer and 
the Track list. Click the button for a channel to bypass 
(disable) all its effect sends.
When the sends are bypassed, the button is yellow. Click the button again 
to enable the sends. Note that this button is also available in the Inspector 
and the Channel settings window.

Click this button to bypass the sends.

• You can also bypass individual sends in the channel 
overview.
See “Insert effects in the channel overview” on page 172.

• You can also bypass the send effects by clicking the 
“Bypass Inserts” button for the FX channel.
This bypasses the actual send effects which may be used by several dif-
ferent channels. Bypassing a send affects that send and that channel 
only. If you bypass the insert effect the original sound will be passed 
through. This may lead to unwanted side effects (higher volume). To de-
activate all effects, use the mute button in the FX channel.

Setting pan for the sends

By default, the sends for an audio channel follow any pan 
settings – stereo or surround – you make for the channel 
itself. This means that if an audio channel is panned to the 
right, the signal from its effect sends will be panned the 
same way, making the stereo imaging as clear and true as 
possible.

However, you may want to have different pan settings for 
the sends. There are several uses for this:

• If you route a send from a mono channel to a stereo FX chan-
nel track, you can position the send signal at center pan in the 
stereo FX channel (or anywhere you like).

• If you route a send from a stereo channel to a mono FX chan-
nel track, the pan control works as a crossfader, determining 
the balance between the stereo sides when the stereo send 
signal is mixed to mono.

• If you route a send from a mono or stereo channel to a FX 
channel track in surround format, you can use the surround 
panner to position the send signal in the surround image.

• If you route a send from a surround channel to an FX channel in 
a format with less channels, you can set the panning with the 
Mixconvert plug-in.

Input gain

Insert effects 1-6

EQ

Volume (fader)

Insert effects 7-8

Pre-fader sends

Post-fader sends
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You set up send panning in the following way:

1. Open the Channel Settings window for the audio 
channel.

2. Right-click somewhere in the Channel settings win-
dow (not the EQ display), to open the context menu and 
open the “Customize View” submenu.

3. From the submenu, select “Send Routing” and “Con-
trol Strip”.
In the Send Routing section of the Channel Settings window, each send is 
shown as a small routing diagram showing a pre/post selector to the right 
and a pan fader (where applicable). In the Control Strip section, you can 
activate the option “Link Send Routing Panners to Channel Panner as De-
fault”. When this is activated, the send panners follow the pan for the chan-
nel. This item is also available in the Preferences dialog (VST page).

The Sends, Send Routing and Control Strip sections in the Channel Set-
tings window.

4. Click and drag the pan control for the desired send(s) 
in the display.
You can reset the pan control to the center position by [Ctrl]/[Command]-
clicking on the pan control.

• If the FX channel is configured in a surround format, the 
pan control will be a miniature surround panner, similar to 
the one found in the mixer.
You can click and drag the “ball” in the miniature panner display to posi-
tion the send in the surround field, or double-click in the display to bring 
up the surround panner. See the chapter “Surround sound” on page 202.

If both the send (the audio channel) and the FX chan-
nel are in mono, the pan control is not available.

About sends for FX channels

The FX channels themselves have sends, too. However, 
these can only be routed to output busses, not to effects.

Setting effect levels
When you have set up the sends as described in the pre-
vious sections, you can do the following:

• You can use the send level slider in the Channel Set-
tings window, the Inspector or the extended mixer panel to 
set the send level.
By adjusting the send level, you control the amount of signal sent from 
the audio channel to the FX channel.

Setting the effect send level.

Link Send Routing 
Panners to Channel 
Panner

The Control Strip section
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• In the mixer, you can use the level fader for the FX chan-
nel to set the effect return level.
By adjusting the return level, you control the amount of the signal sent 
from the FX channel to the output bus.

Setting the effect return level.

FX channels and the Solo Defeat function
When mixing, you might sometimes want to solo specific 
audio channels, and listen only to these while other chan-
nels are muted. However, this will mute all FX channels as 
well. If the soloed audio channels have sends routed to FX 
channels, this means you won’t hear the send effects for 
the channels.

To remedy this, you can use the Solo Defeat function for 
the FX channel:

1. [Alt]/[Option]-click the Solo button for the FX channel.
This activates the Solo Defeat function for the FX channel. In this mode, 
the FX channel will not be muted if you solo another channel in the mixer.

2. You can now solo any of the audio channels without 
having the effect return (the FX channel) muted.

• To turn off the Solo Defeat function for the FX channel, 
[Alt]/[Option]-click the Solo button for the FX channel 
again.

Using the Side-Chain input
Many VST 3.0 effects feature a side-chain input. Side-
chaining allows you e.g. to lower the music volume when 
someone is speaking (“ducking”) or to use compression 
on e.g. a bass sound when the drums are hit, thereby 
“harmonizing” the intensity of the two instruments. An-
other possibility is to use the side chain signal as a source 
for modulation.

The following types of effects feature side-chain inputs:

• Delay plug-ins
The included delay plug-ins with side-chain functionality are MonoDelay, 
PingPongDelay and StereoDelay.

• Dynamics plug-ins
The included dynamics plug-ins with side-chain functionality are Com-
pressor, Expander, Gate and VintageCompressor.

• Modulation plug-ins
The included modulation plug-ins with side-chain functionality are Auto-
Pan, Flanger, Phaser, StudioChorus, Tremolo and Vibrato.

• Filter plug-ins
The included filter plug-in with side-chain functionality is the WahWah 
effect.

Setting up side-chain

Certain combinations of tracks and side-chain inputs 
may lead to feedback loops and added latency. If this is 
the case, the side-chain options will not be available.

Delay plug-ins

The delay repeats can be silenced by side-chain signals 
exceeding a certain threshold.

You can use this feature to create a so-called “ducking 
delay” for your vocals. Let’s say you want to add a delay 
effect that is audible only when no signal is present on the 
vocal track. For this, you need to set up a delay effect 
which is deactivated every time the vocals start again.

! For detailed descriptions of the plug-ins that feature 
side-chaining, see the separate manual “Nuendo Ex-
pansion Kit – Cubase Music Tools for Nuendo 4”.
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Proceed as follows:

1. Select the vocal track. 

2. On the Project menu, select “Duplicate Tracks”.
Now you can use the vocal events on the second track to silence the de-
lay effect.

3. Open the Insert tab for the first Vocal track in the In-
spector and select “PingPongDelay” from the Effects 
pop-up menu.
The control panel for the effect opens.

4. On the control panel for the effect, make the desired 
effect settings and activate the Side Chain button.
Try out the effect settings to find out which settings will work best with your 
project. For detailed descriptions of the parameters, see the separate man-
ual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.

5. In the Track list, select the second vocal track.

6. Pull down the Output Routing pop-up menu and on 
the Side-Chain submenu, select the PingPongDelay ef-
fect you set up for the vocal track.
This way, the signals from the second (duplicate) track are routed to the 
effect (and do not end up in the mix).

Now every time the signals on the vocal track exceed the 
threshold, the delay will be deactivated. Since the thres-
hold for the delay effect is fixed, you may have to adjust 
the volume of track 2, in this example, to ensure that vocal 
parts of low or middle volume will also silence the delay 
effect.

Dynamics plug-ins

Compression, expansion or gating can be triggered by 
side-chain signals exceeding a specified threshold.

You may run into a situation where you want to lower the 
volume of one instrument every time another instrument is 
played. You could e.g. want to lower the volume of the bass 
guitar during the bass drum hits. This can be achieved by 
applying compression to the bass guitar signal every time 
the drum signals are present on the respective track.

Proceed as follows:

1. Select the bass guitar track.

2. Open the Inserts tab in the Inspector, click in an insert 
slot to open the effect selection pop-up menu and, on the 
Dynamics submenu, select “Compressor”.
The effect is loaded into the effect slot and the effect control panel opens. 

3. Make the desired effect settings (you will most likely 
have to adjust them later to get the right compression 
level) and activate the Side-Chain button.

4. Select the bass drum track. 

5. Open the Sends Inspector section, click in a send slot 
and from the Side-Chain submenu, select the Compres-
sor effect you created for the bass guitar track. Adjust the 
Send level.
This way, the bass drum signal triggers the compressor on the bass gui-
tar track.

When you now play back the project, the bass guitar will 
be compressed whenever the signals on the bass drum 
track exceed the threshold.

Modulation plug-ins

Side-chain signals bypass the built-in LFO modulation 
and instead apply modulation according to the envelope 
of the side-chain signal. Since each channel will be ana-
lyzed and modulated separately, this allows for creating 
astonishing spatial stereo or surround modulation effects. 
Feel free to experiment with the functions to see what they 
have to offer!



182

Audio effects

About drag&drop and Side chain connections
When you drag effects from one insert slot to another (on 
the same channel or between different channels), the fol-
lowing applies:

• When you move an effect within a channel (e.g. from slot 4 to 
slot 6), the side chain connections will be kept.

• When you drag and drop an effect between two channels, the 
side chain connections will not be kept.

• When copying an effect into another effect slot (for the same 
or a different channel), the side chain connections will not be 
copied, i.  e. they will be lost.

Using external effects
Although this program comes with a top selection of VST 
effect plug-ins, and although there’s a huge range of addi-
tional plug-ins available on the market, you may still have 
some hardware effect units that you want to use – valve 
compressors, reverb units, vintage tape echo machines, 
etc. By setting up external FX busses you can make your 
outboard equipment part of the Nuendo virtual studio!

An external FX bus is a combination of outputs (sends) 
and inputs (returns) on your audio hardware, along with a 
few additional settings. All external FX busses you have 
created will appear on the effect pop-up menus and can 
be selected like the internal effect plug-ins. The difference 
is that if you select an external effect as an insert effect for 
an audio track, the audio will be sent to the corresponding 
audio output, processed in your hardware effect (provided 
that you have connected it properly) and returned via the 
specified audio input.

Creating and handling of external effects is described 
in detail in the chapter “VST Connections: Setting up in-
put and output busses” on page 10.

Making settings for the effects

Editing effects
All inserts and sends have an Edit (“e”) button. Clicking 
this opens the control panel for the effect, in which you 
can make parameter settings.

The contents, design and layout of the control panel de-
pends on the selected effect. However, all effect control 
panels have an On/Off button, a Bypass button, Read/
Write automation buttons (for automating effect parameter 
changes, see the chapter “Automation” on page 213), a 
preset pop-up menu and a Preset Management pop-up 
menu for saving and loading effect presets. Some plug-ins 
also feature a side-chain button, see “Using the Side-Chain 
input” on page 180.

The Rotary effect control panel.

• Please note that all effects can be edited using a simpli-
fied control panel (horizontal sliders only, no graphics). This 
panel is opened by pressing [Ctrl]/[Command]+[Alt]/[Op-
tion]+[Shift] and clicking on the Edit button for the effect 
send or slot.

Effect control panels may have any combination of knobs, 
sliders, buttons and graphic curves. 

The included effects and their parameters are de-
scribed in detail in the separate manual “Nuendo Expan-
sion Kit – Cubase Music Tools for Nuendo 4”.

If you edit the parameters for an effect, these settings are 
saved automatically with the project.

You can also save the current settings as a preset, see 
below.

• Effects parameters can be automated – see the chapter 
“Automation” on page 213.
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Effect presets
Effect preset management in Nuendo is very versatile. In 
the MediaBay – or with certain limits in the Save Preset di-
alog – you can assign attributes to presets which allow 
you to organize and browse them according to various cri-
teria. Nuendo comes with a huge array of categorized 
track and VST presets that you can use straight out of the 
box. You can also preview effect presets before loading 
them which considerably speeds up the process of find-
ing the right effect preset.

Effect presets can be divided into the following main cate-
gories:

• VST presets for a plug-in.
These are stored parameter settings for a specific effect.

• Inserts presets that contain insert effect combinations.
These can contain the whole insert effects rack, complete with settings 
for each effect, see “Saving insert effect combinations” on page 185.

Selecting effect presets
Most VST effect plug-ins come with a number of useful 
presets for instant selection.

The preset browser

To select an effect preset in the preset browser, proceed 
as follows:

1. Load an effect, either as a channel insert or into an FX 
channel.
The control panel for the effect is displayed.

2. Click in the preset field at the top of the control panel.
This opens the preset browser.

• You can also open the Preset browser from the Inspec-
tor (Inserts tab) or the Channel Settings window.

3. Select the desired preset in the list.

4. Activate playback to audition the selected preset.
Simply step through the presets until you found the right sound. It may be 
helpful to set up cycle playback of a section to make comparisons be-
tween different preset settings easier.

5. Double-click on the desired preset (or click outside 
the Preset browser) to apply the preset.

• To return to the preset that was selected when you 
opened the Preset browser, click the Reset button.

• You can also open the Preset browser by clicking the 
VST Sound button to the right of the preset field an se-
lecting "Load Preset" from the Preset Management pop-
up menu.

• The preset handling for VST 2 plug-ins is slightly differ-
ent, see “About earlier VST effect presets” on page 184.

The Browser sections

The Preset browser contains the following sections:

• The “Search & Viewer” section (displayed by default) 
lists the available presets for the selected effect.

• The Filter section (displayed when you click the Cate-
gories button) shows the available preset attributes for the 
selected effect.
If no attributes have been specified for the effect presets, the columns 
will be empty. If attributes have been assigned to a preset for this effect, 
you can click on the attribute in the respective column (Category, Style 
etc.), to filter out all presets that do not match the selected attribute(s).

• If you also activate the “Show Location” button, the 
Browser & Filter section is displayed, allowing you to 
specify the Presets folder that should be searched for 
preset files.
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Saving effect presets
You can save your edited effect settings as presets for 
further use (e.g. in other projects):

1. Click the VST Sound button to open the Preset 
Management pop-up menu.

2. Select “Save Preset…” from the pop-up menu.
This opens a dialog where you can save the current settings as a preset.

3. In the File name field in the lower part of the Save Pre-
set dialog, enter a name for the new preset.

• If you wish to assign attributes to the preset, click the 
Tag Editor button.
Click in the Value column to select an appropriate “tag” for one or sev-
eral of the available categories in the Attributes column. For further infor-
mation on preset handling and the Tag Editor, see the chapter “The 
MediaBay” on page 314.

4. Click OK to store the preset and exit the dialog.

User-defined presets are saved in the following location:

• Win: Documents and Settings/User name/Application data/
VST3 presets\<company>\ <plug-in name>

• Mac: Users/<user name>/Library/Audio/Presets/<com-
pany>/<plug-in name>

You cannot change the default folder, but you can add fur-
ther subfolders inside the individual effect preset folders.

About earlier VST effect presets
As stated previously, you can use any VST 2.x plug-ins in 
Nuendo. For a description of how to add VST plug-ins see 
“Installing and managing effect plug-ins” on page 186.

When you add a VST 2 plug-in, any previously stored pre-
sets for it will be in the old FX program/bank format (.fxp/
.fxb). You can import such files, but the preset handling will 
be slightly different. You will not be able to use the new fea-
tures like the Tag editor until you have converted the old 
“.fxp/.fxb” presets to VST 3 presets. If you save new pre-
sets for the included VST 2 plug-ins, these will automati-
cally be saved in the new “.vstpreset” format.

Importing and converting FXB/FXP files

To import .fxp/.fxb files, proceed as follows:

1. Load any VST 2 effect you may have installed, and click 
on the VST Sound button to open the Preset Management 
pop-up menu.

2. Select “Import FXB/FXP…” from the pop-up.
This menu item is only available for VST 2 plug-ins.

3. In the file dialog that opens, locate the .fxp file and 
click Open.
If you load a bank (.fxb), it will replace the current set of all effect pro-
grams. If you load a single program, it will replace the currently selected 
effect program only. Note that such files exist only if you created your 
own .fxp/.fxb presets with a previous version of Nuendo (or any other 
VST 2 application).

! All VST 2 presets can be converted to VST 3 presets.
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4. After importing, you can convert the current program 
list to VST presets by selecting “Convert Program List to 
VST Presets” from the Preset Management pop-up.
After converting, the presets will be available in the Preset Browser, and 
you can use the Tag Editor to add attributes and audition the presets. 
The new converted presets will be stored in the VST3 Preset folder.

Saving insert effect combinations
You can save the complete insert effect rack for a channel 
together with all parameter settings as an inserts preset. 
Inserts presets can be applied to audio, instruments, FX 
channel or group tracks.

This works as follows:

1. Select the desired track in the Track list and open the 
Inserts Inspector section.

2. Load a combination of insert effects and adjust the pa-
rameters (or select effect presets) for each effect.

3. At the top of the Inserts tab, click the VST Sound but-
ton to open the Preset Management pop-up menu for the 
inserts and select “Store Preset”.
This can also be done from the Channel Settings window using the VST 
Sound button at the top of the Inserts section.

4. Type in a name for the preset in the dialog that appears.

5. Select the track (audio/group/instrument/fx channel) 
you wish to apply the new preset to, and click its VST 
Sound button.
As you can see, the new preset is available at the top of the pop-up menu.

6. Select the preset you created from the pop-up menu.
The effects are loaded into the Insert slots of the new track, and the con-
trol panels for all effects are opened.

• Note that when loading insert combination presets, any 
plug-ins that were previously loaded for the track will be 
removed, regardless of whether these slots are used in 
the preset.
In other words, saving an inserts preset means saving the states of all in-
sert slots.

• You can use the Preset Management pop-up to save 
your settings as preset, or to rename or remove the cur-
rent preset.

Extracting insert effect settings from track presets

You can extract the effects used in a track preset and load 
them into your inserts “rack”: 

• Select “From Track Preset…” on the Preset Manage-
ment pop-up menu to open a dialog where all track pre-
sets are shown.

• Select an item in the list to load the effects used in the 
track preset.

Track presets are described in their own chapter in the 
Operation Manual.
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Installing and managing effect plug-
ins
Nuendo supports two plug-in formats; the VST 2 format 
(with the file name extensions “.dll” on the PC and “.VST” 
on the Mac) and the VST 3 format (extension “.vst3” on 
both platforms). The formats are handled differently when 
it comes to installation and organizing.

Installing additional VST plug-ins

Installing VST 3 plug-ins under Mac OS X

To install a VST 3.x plug-in under Mac OS X, quit Nuendo 
and drag the plug-in file into one of the following folders:

• /Library/Audio/Plug-Ins/VST3/
This is only possible if you are the system administrator. Plug-ins in-
stalled in this folder will be available to all users, for all programs that 
support them.

• Users/Username/Library/Audio/Plug-Ins/VST3/
“Username” is the name you use to log on to the computer (the easiest 
way to open this folder is to go to your “Home” folder and use the path /
Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder 
are only available to you.

When you launch Nuendo again, the new effects will ap-
pear on the effect pop-up menus. In the VST 3 protocol, the 
effect category, sub-folder structure etc. are built-in and 
cannot be changed. The effect(s) will simply show up in the 
assigned category folder(s) on the Effect pop-up menu.

Installing VST 2.x plug-ins under Mac OS X

To install a VST 2.x plug-in under Mac OS X, quit Nuendo 
and drag the plug-in file to one of the following folders:

• /Library/Audio/Plug-Ins/VST/
This is only possible if you are the system administrator. Plug-ins in-
stalled in this folder will be available to all users, for all programs that 
support them.

• Username/Library/Audio/Plug-Ins/VST/
“Username” is the name you use to log on to the computer (the easiest 
way to open this folder is to go to your “Home” folder and use the path /
Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder 
are only available to you.

When you launch Nuendo again, the new effects will ap-
pear on the effect pop-up menus.

If an effect plug-in comes with its own installation ap-
plication, you should use this.
As a general rule, always read the documentation or readme files before 
installing new plug-ins.

Installing VST 3 plug-ins under Windows

Under Windows, VST 3 plug-ins are installed by dragging 
the files (with the extension “.vst3”) into the vst3 folder in 
the Nuendo application folder. When you launch Nuendo 
again, the new effects will appear on the Effect pop-up 
menus. In the VST 3 protocol, the effect category, sub-
folder structure etc. are built-in and cannot be changed. 
The installed new effect(s) will simply show up in the as-
signed category folder(s) on the effect pop-up menu.

Installing VST 2 plug-ins under Windows

Under Windows, VST 2.x plug-ins are installed by drag-
ging the files (with the extension “.dll”) into the Vstplugins 
folder in the Nuendo application folder, or into the Shared 
VST Plug-in folder – see below. When you launch Nuendo 
again, the new effects will appear on the effect pop-up 
menus.

If an effect plug-in comes with its own installation ap-
plication, you should use this.
As a general rule, always read the documentation before installing new 
plug-ins.

Organizing VST 2 plug-ins

If you have a large number of VST 2 plug-ins, having them 
all on a single pop-up menu in the program may become 
unmanageable. For this reason, the VST 2 plug-ins in-
stalled with Nuendo are placed in appropriate subfolders 
according to the effect type.

• Under Windows, you can organize VST plug-ins by mov-
ing, adding or renaming subfolders within the Vstplugins 
folder. 
When you launch the program and pull down an effects pop-up menu, 
the subfolders will be represented by hierarchical submenus, each listing 
the plug-ins in the corresponding subfolder.

• Under Mac OS X, you cannot change the hierarchic ar-
rangement of the “built-in” VST plug-ins.
However, you can arrange any additional plug-ins you have installed (in the 
/Library/Audio/Plug-Ins/VST/ folders, see above) by placing them in sub-
folders. In the program, the subfolders will be represented by hierarchical 
submenus, each listing the plug-ins in the corresponding subfolder.

! Plug-ins in Mac OS 9.X format cannot be used.



187

Audio effects

About the effects from previous Nuendo versions

The Legacy folder on the program DVD contains effects 
from previous versions of Nuendo.

The main reason for installing these earlier plug-ins is 
backwards compatibility, allowing you to import old Nu-
endo projects and get the correct effect settings.

The Plug-in Information window
On the Devices menu, you will find an item called “Plug-in 
Information”. Selecting this opens a dialog listing all the 
available VST compatible plug-ins in your system (includ-
ing VST Instruments), along with all MIDI plug-ins.

Managing and selecting VST plug-ins

To display all available VST plug-ins, open the “VST 
PlugIns” tab.

• To enable a plug-in (make it available for selection), put 
a check mark in the left column.
Only the enabled plug-ins will appear on the effect menus.

• The Instances column indicates how many instances of 
the plug-in are currently used in Nuendo.
Clicking in this column for a plug-in which is already in use produces a 
pop-up showing exactly where each use occurs.

A plug-in may be in use even if it isn’t enabled in the 
left column. 
You might for example have opened a project containing effects that are 
currently disabled on the menu. The left column only determines whether 
or not the plug-in will be visible on the effect menus.

• All columns can be resized by dragging the divider in 
the column header.

The other columns show the following information about 
each plug-in:

Update button

Clicking this button will make Nuendo re-scan the desig-
nated VST folders for updated information about the plug-
ins.

VST 2.x Plug-in Paths button

This opens a dialog where you can see the current paths 
to where VST 2.x plug-ins are located. You can freely 
Add/Remove folder locations by using the corresponding 
buttons. If you click “Add”, a file dialog is opened, where 
you can select a folder location.

About the “shared” plug-ins folder (Windows and VST 
2.x only)

You can designate a “shared” VST 2.x plugins folder. This 
will allow VST 2.x plug-ins to be used by other programs 
that support this standard.

You designate a shared folder by selecting a folder in the 
list and clicking the “Set As Shared Folder” button in the 
VST 2.x Plug-in Paths dialog.

Column Description

Name The name of the plug-in.

Vendor The manufacturer of the plug-in.

File This shows the complete name of the plug-in (with extension).

Category This indicates the category of each plug-in (such as VST In-
struments, Surround Effects, etc.).

Version Shows the version of the plug-in.

SDK Shows with which version of the VST protocol a plug-in is 
compatible.

Latency This shows the delay (in samples) that will be introduced if the 
effect is used as an Insert. This is automatically compensated 
for by Nuendo.

Side Chain 
Inputs

Shows the number of side-chain inputs for a plug-in.

I/O This column shows the number of inputs and outputs for each 
plug-in.

Path The path and name of the folder in which the plug-in file is 
located.
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Exporting plug-in information files

You can also save plug-in information as an .xml file, e.g. 
for archiving purposes or troubleshooting. The Export func-
tion is available for VST, MIDI and Audio Codec plug-ins. 
Proceed as follows:

1. Right-click on the desired tab in the Plug-in Information 
window (for VST, MIDI or Audio Codec plug-ins), to open 
the context menu and select “Export”.
A file dialog opens.

2. In the dialog, specify a name and location for the Plug-
in Information export file and click OK to export the file.

• The Plug-in Information file contains information on the 
currently installed/available plug-ins, their version, vendor, 
etc.

• The .xml file can then be opened in any editor applica-
tion supporting the xml format.
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Introduction
VST Instruments are software synthesizers (or other sound 
sources) that are contained within Nuendo. They are played 
internally via MIDI. You can add effects or EQ to VST Instru-
ments, just as with audio tracks.

This chapter describes the general procedures for 
setting up and using VST Instruments.

Depending on the VST version the instrument is com-
patible with, an icon may be displayed in front of the in-
strument name, see “About VST 3” on page 169.

Note that VST instruments are only supplied as part of 
the Nuendo Expansion Kit. You can, however, use your 
own VST instruments in Nuendo. The VST instrument in-
cluded in the Nuendo Expansion Kit are described in de-
tail in the separate manual “Nuendo Expansion Kit – 
Cubase Music Tools for Nuendo 4”.

VST Instrument channels vs. instru-
ment tracks
Nuendo allows you to make use of VST Instruments in two 
different ways:

• By activating instruments in the VST Instruments win-
dow.
This creates a VST Instrument channel, which can be played by one (or 
several) MIDI track(s) routed to it.

• By creating instrument tracks.
Instrument tracks are a combination of a VST Instrument, an instrument 
channel and a MIDI track. You play and record MIDI note data directly for 
this track.

Both methods have their advantages, and should be se-
lected according to what best suits your needs. The fol-
lowing sections describe the two approaches.

VST Instrument channels
You can access a VST Instrument from within Nuendo by 
creating a VST Instrument channel and associating this 
channel with a MIDI track. Proceed as follows:

1. On the Devices menu, select “VST Instruments”.
The VST Instruments window opens.

2. Click in one of the empty slots to open the instrument 
pop-up menu and select the desired instrument.

3. You will be asked if you want to create an associated 
MIDI track connected to the VST Instrument. Do so.
The instrument is loaded and activated, and its control panel is opened. 
A MIDI track with the name of the instrument is added to the Track list. 
The output of this track is routed to the instrument.

In the Preferences dialog (VST–Plug-ins page), you can 
specify what should happen when loading a VST instru-
ment in an instrument slot. Open the pop-up menu “Cre-
ate MIDI track when loading VSTi” and select one of the 
available options:

• When you select “Always”, a corresponding MIDI track will al-
ways be created.

• When you select “Do not”, no track will be created and only 
the instrument will be loaded.

• Select “Always ask to” if you want to decide whether a MIDI 
track should be created whenever you load an instrument.

You can also use modifiers to specify what should happen 
when you load a VST instrument (overriding the Prefer-
ence setting):

• When you hold down [Ctrl]/[Command] while selecting a VST 
Instrument for an instrument slot, a corresponding MIDI track 
with the name of the instrument is automatically created.

• When you hold down [Alt]/[Option] while selecting a VST In-
strument for an instrument slot, no MIDI track will be created 
for the instrument.
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• If you don’t want the plug-in control panels to open every 
time you load a plug-in, open the Preferences dialog 
(VST–Plug-ins page) and deactivate “Open Effect Editor 
After Loading it”.
You can open a plug-in panel at any time by clicking the “e” button of the 
corresponding plug-in slot.

4. If you now look in the Project window track list, you will 
find that a dedicated folder for the chosen instrument has 
been added, within a “VST Instruments” folder (where all 
your VST Instrument channels will be listed).
The separate folder for the added VST Instrument contains two or more 
automation tracks: one for automating the plug-in parameters and one for 
each mixer channel used by the VST Instrument. For example, if you add a 
VST Instrument with four separate outputs (four separate mixer channels), 
the folder will contain five automation tracks. To keep the screen less clut-
tered, you may want to close the folder for the VST Instrument until you 
need to view or edit any of the automation tracks. For more about automa-
tion, see the chapter “Automation” on page 213.

• When you select the MIDI track routed to the VST in-
strument, you will see that the Inspector contains a sepa-
rate section for the instrument.
This section contains the audio channel settings for the VST Instrument 
(inserts, EQs, Sends and fader settings). The tab has two buttons for 
opening the Channel Settings window (for the VST Instrument channel) 
and the Edit Instrument button which opens the control panel for the VST 
Instrument.

5. Depending on the selected VST Instrument, you may 
also need to select a MIDI channel for the track.
For example, a multitimbral VST Instrument can play back different 
sounds on different MIDI channels – check the documentation for the 
VST Instrument for MIDI implementation details.

6. Make sure the option “MIDI Thru Active” is activated in 
the Preferences dialog (MIDI page).

7. Activate the Monitor button for the MIDI track (in the 
Track list, Inspector or mixer). 
When this is activated (or when the track is record enabled), incoming 
MIDI is passed on to the selected MIDI output (in this case the VST In-
strument), see the chapter “Recording” on page 64.

8. Open the mixer.
You will find one or more channel strips for the audio outputs of the VST 
Instrument. VST Instrument channel strips have the same features and 
functionality as group channel strips, with the addition of an Edit button at 
the bottom of the strip for opening the VST Instrument control panel. You 
will also find output routing pop-up menus at the top of the channel strips, 
for routing the VST Instrument channels e.g. to output channels or 
groups. Routing is described in detail in the chapter “VST Connections: 
Setting up input and output busses” on page 10.

9. Play the VST Instrument from your MIDI keyboard.
You can use the mixer settings to adjust the sound, add EQ or effects, etc., 
just as with regular audio channels. Of course, you can also record or man-
ually create MIDI parts that play back sounds from the VST Instrument.

• VST Instrument channels give you full access to multi-
timbral instruments.
You can have several MIDI tracks routed to the VST Instrument, each 
playing a different part.

• Similarly, you can route channels to any available output 
provided by the VST Instrument.

The VST Instruments window
When a VST Instrument is loaded, six controls are dis-
played for this slot in the VST Instruments window.

• The button on the far left is used for the Freeze function, 
see “Instrument Freeze” on page 195.

Opens the Channel 
Settings window

Opens the control panel 
for the VST Instrument

! You can have up to 64 VST Instruments activated at 
the same time, either different instruments or several 
instances of the same instrument. However, software 
instruments can consume a lot of CPU power – keep 
an eye on the VST Performance window to avoid run-
ning out of processor power. See also “Instrument 
Freeze” on page 195.

Instrument 
on/off

Instrument 
Freeze

Activate outputs

Bypass 
instrument

Open instrument panel

Event received
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• The second button is used to activate or deactivate the 
VST Instrument.
When an instrument is selected from the instrument pop-up menu, it is 
activated automatically, i.e. the on/off control lights up in blue.
For some instruments you may also bypass the instrument by clicking the 
Bypass button to the right of the on/off button.

• Click the Edit (“e”) button to open the control panel for 
the VST Instrument. 

• Below the Edit button is a small LED that will light up 
when MIDI data is received by the instrument.

• The rightmost button allows you to activate the desired 
output for the instrument.
This is useful when you are using VST Instruments that have a large num-
ber of audio busses, which may be confusing. Click entries in the pop-up 
list to activate/deactivate output busses for this effect. 

Instrument tracks
An instrument track is a combination of a VST Instrument, a 
MIDI track, and a VST Instrument channel, in other words: 
it is a track coupled with a sound – it allows you to think in 
terms of sounds rather than in terms of track and instru-
ment settings.

Adding Instrument tracks
To open and use an Instrument track, proceed as follows:

1. Open the Project menu and select Instrument from the 
Add Track submenu.
You can also right-click in the track list and select “Add Instrument 
Track” on the context menu.

2. The Add Instrument Track dialog is opened.
You can select an instrument for the track from the pop-up (but you can 
also leave this until later if you wish). Specify the number of instrument 
tracks you wish to create in the “count” field. If you click the “Browse 
Presets” button, the dialog expands to show the preset browser, where 
you can browse for sounds.

3. Click OK to add the Instrument track.
When you selected an Instrument in the Add Track dialog, the new track 
will get the name of the instrument. When no instrument was selected, 
the track will be named “Instrument track”.

An instrument track in the Track list.

Properties
• Each Instrument track has a corresponding channel 
strip in the mixer.

• In the Inspector, you can select a VST Instrument from 
the Instrument pop-up menu.
When you select an instrument from this pop-up, its control panel will 
open automatically.

• You can also exchange the “sound” of an instrument 
track (i.e. the VST Instrument and its settings) by extract-
ing these data from another instrument track or a VST pre-
set, see “Extracting sound from an instrument track or VST 
preset” on page 335.

• On the Input Routing pop-up menu, you can select a 
MIDI input.
Instrument tracks have only one MIDI input.

• To open the control panel for the VST Instrument, click 
the “Edit Instrument” button in the Inspector.

• As with MIDI tracks, you can perform the usual MIDI ed-
iting procedures on the instrument track, like duplicate, 
split repeat or lock the track, use the In-Place Editor, drag 
and drop the MIDI parts of an instrument track etc. For 
more information, see the chapter “MIDI realtime parame-
ters and effects” on page 342.

• As with MIDI track inspector and track controls, you can 
adjust track delay, choose MIDI input, work with VST Instru-
ment panels, etc. For more information, see the chapter 
“MIDI realtime parameters and effects” on page 342.

• Instrument tracks have all options that VST Instrument 
channels have, i.e. Inserts, Sends, EQ, etc.

VST Instruments used in Instrument tracks do not ap-
pear in the VST Instruments window.
For an overview over all used VST Instruments, open the Plug-in Informa-
tion window via the Devices menu. For further information, see the sepa-
rate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.
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Restrictions
• Instrument tracks have no MIDI Sends.

• MIDI volume and pan cannot be controlled (there is no 
“MIDI fader” tab in the Inspector); instead, the VST Instru-
ment volume and pan are used (via the “Channel” tab in the 
Inspector). This applies also to the respective automation 
parameters.

Due to there being only one volume and pan control for 
the instrument track, the Mute button will mute the com-
plete track including the VST Instrument. (As opposed to a 
MIDI track with an assigned VST Instrument, for which mut-
ing the MIDI track still allows you to monitor and record the 
VST Instrument.)

• Instrument tracks always have one stereo output chan-
nel only. This means that VST Instruments that do not pro-
vide a stereo output as their first output channel cannot be 
used with instrument tracks, and must be loaded via the 
VST Instruments window.

• Due to the limitation to one output channel, instrument 
tracks play only the first voice of a multi-timbral VST In-
strument. If you want to use all voices, you have to load the 
instrument via the VST Instruments window and set up a 
MIDI channel to play it.

Import and export options

Importing MIDI loops

You can import “MIDI loops” (file extension “*.midiloop”) in 
Nuendo. These files contain MIDI Part information (MIDI 
notes, controllers, etc.) as well as all the settings that are 
saved in Instrument track presets (see “About track pre-
sets and VST presets” on page 197). This way, you can 
easily reuse instrument patterns you really like in other 
projects or applications for example.

Proceed as follows:

1. Open the MediaBay window via the Media menu.

2. In the Filter section, activate the “Show MIDI Loops” 
button.
This is not necessary, but will help you locate your MIDI loops more quickly.

3. In the Viewer section, select the desired MIDI loop and 
drag it in an empty section in the Project window.
An Instrument track is created and the Instrument part is inserted at the 
position where you dragged the file. The Inspector will reflect all settings 
saved in the MIDI loop, e.g. the VST instrument that was used, applied 
Insert effects, Track parameters, etc.

You can also drag MIDI loops onto existing Instrument 
or MIDI tracks. However, this will only import the part infor-
mation.
This means this part will only contain the MIDI data (notes, controllers) 
saved in the MIDI loop, but no inspector settings or instrument parameters.

Exporting MIDI loops

Exporting MIDI loops is a great way of saving a MIDI part 
together with its instrument and e.g. effect settings. This 
allows you to easily reproduce patterns you once created 
without having to search for the correct sound, style or ef-
fect.

Proceed as follows:

1. Select the desired Instrument part.

2. On the File menu–Export submenu, select “MIDI 
Loop…”.
A file dialog opens.

3. Enter the desired name for the MIDI loop in the Name 
field in the lower section of the dialog.

• If you want to save attributes for the MIDI loop, click the 
Tag Editor button.
This lets you specify e.g. a category and a sub category for your MIDI 
loop.

4. Click OK to close the dialog and save the MIDI loop.

MIDI Loop files are saved in the following folder:

• Windows: /Documents and Settings/<Username>/Applica-
tion Data/Steinberg/MIDI Loops.

• Mac: /Users/<Username>/Library/Application Support/
Steinberg/MIDI Loops/

This default folder cannot be changed, you can however 
create subfolders within this folder to organize your MIDI 
loops. Simply click the “Create New Folder” button in the 
Save MIDI Loop dialog.
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Exporting instrument tracks as MIDI file

You can also export instrument tracks as standard MIDI 
files, see “Exporting MIDI files” on page 498.

Please note: 

• As there is no MIDI patch information in an instrument 
track, this information is missing in the resulting MIDI file.

• If you activate “Export Inspector Volume/Pan”, volume 
and pan information of the VST Instrument will be con-
verted and written into the MIDI file as controller data.

Comparison
Since instrument tracks are a combination of MIDI and 
VST features, the instrument track properties and their 
handling show aspects of both. 

On the left, the MIDI Inspector for a MIDI channel with its output routed 
to a VST Instrument – on the right, the instrument track Inspector for an 
instrument track using the same VST Instrument.

Automation considerations
• Automation of the VST Instrument channel settings or 
the settings for an instrument track is done in the same 
way as automating regular channels.

• Automation of the specific parameters for a VST Instru-
ment is done in the same way as automating VST effect 
parameters.

When you set up a VST Instrument in the VST Instruments 
window, you also need to create a MIDI channel in which 
to enter the notes that you want the instrument to play. Al-
though the VST Instrument channel and the MIDI track are 
connected via the VST Instrument, there is no direct con-
nection between, for example, the volume automation of 
the VST Instrument channel and the events on the MIDI 
track. If you move the MIDI part, the automated volume 
curve of the VST return channel will not move with it. 
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In the instrument track, however, you have one track that 
includes the MIDI data, the VST Instrument and the chan-
nel you wish to automate. Therefore, the information on 
the automation track will move with the MIDI part.

For more information on track automation, see the chapter 
“Automation” on page 213.

What do I need? Instrument channel 
or Instrument track?
• If you need a particular sound without knowing which 
VST Instrument to use, create an instrument track and use 
the preview features to find the sound you want.

• Do likewise if the Instrument track restrictions described 
above do not matter.

• If you are planning to create an instrument track preset, 
complete with inserts and EQ settings, you have to use an 
instrument track.

• If you need to use multitimbral parts and/or multiple out-
puts, set up a VST Instrument channel. 

Instrument Freeze
Like all plug-ins, VST Instruments may require a lot of pro-
cessor power. If you are using a moderately powerful com-
puter or if you are using a large number of VST Instruments, 
you may come to a point where your computer cannot han-
dle all VST Instruments playing back in real time (the CPU 
overload indicator in the VST Performance window lights 
up, you get crackling sounds, etc.).

Enter the Instrument Freeze function! This is how it works:

• When you freeze a VST Instrument, the program renders 
an audio file of the instrument output (taking into account 
all unmuted MIDI parts routed to that VST Instrument). This 
file is placed in the “Freeze” folder within the Project folder.

• All MIDI tracks routed to the VST Instrument, or the in-
strument track associated with the VST Instrument, are 
muted and locked (the controls for these tracks will ap-
pear “grayed-out” in the track list and Inspector).

• When you start playback, the rendered audio file is 
played back from an “invisible” audio track, routed to the 
VST Instrument’s mixer channel. Thus, any effects, EQ or 
mixing automation will still be applied.

• You can also freeze the mixer channel of the VST Instru-
ment. This freezes any pre-fader insert effects for the chan-
nels, just as when freezing audio tracks (see “Freezing 
(rendering) insert effects for a track” on page 175).

The result of the Freeze is that you get exactly the same 
sound as before, but the computer processor doesn’t have 
to calculate the sound of the VST Instrument in real time.

Performing the freeze
The instrument freeze function is available in the VST In-
struments window, and in the track list and the Inspector 
for instrument tracks.

1. Set up the project so that the VST Instrument plays 
back the way you want it to.
This includes editing the MIDI tracks routed to the VST Instrument, or ed-
iting the instrument track, and making parameter settings for the VST In-
strument itself. If you have automated parameter changes for the VST 
Instrument, make sure the Read (R) button is activated.

2. Open the VST Instruments window from the Devices 
menu, or, if you are using an instrument track, select the 
track and open the top Inspector tab.
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3. Click the Freeze button for the VST Instrument (the 
button to the left of the VST Instrument slot), or the Freeze 
button in the Inspector for the instrument track.

The Freeze Instrument Options dialog appears with the 
following options for the Freeze operation:

• Select “Freeze Instrument Only” if you don’t want to 
freeze any insert effects for the VST Instrument channels.
If you are using insert effects on the VST Instrument channel(s) and want 
to be able to edit, replace or remove these after freezing the VST Instru-
ment, you should select this option.

• Select “Freeze Instrument and Channels” if you want to 
freeze all pre-fader insert effects for the VST Instrument 
channels.
If your VST Instrument channels are set up with the desired insert effects 
and you don’t need to edit these, select this option.

• You can set a Tail Size time to let sounds complete their 
normal release cycle.
Otherwise, the sound might be cut off at the very end of the freeze file.

• When you activate “Unload Instrument when Frozen”, 
the frozen VST Instrument will be removed.
This is useful if you are freezing an instrument that uses a lot of RAM, e.g. 
for pre-loading samples. By unloading the instrument, the RAM becomes 
available for other plug-ins, etc.

4. Click OK.
A progress dialog is shown while the program renders the VST Instru-
ment audio to a file on your hard disk.

The Freeze button lights up. If you check the Project win-
dow at this point, you will find that the relevant MIDI/in-
strument tracks have grayed out controls in the Track list 
and Inspector. Furthermore, the MIDI parts are locked and 
cannot be moved.

5. Play back the project.
You will hear exactly the same sound as before freezing the VST Instru-
ment – but the CPU load will be considerably less! 

• If you selected “Freeze Instrument and Channels”, any 
insert effects used by the VST Instrument are also frozen 
(except for the post-fader inserts). However, you can al-
ways adjust level, pan, sends and EQ for frozen VST In-
struments.

Unfreezing
If you need to make adjustments (either to the MIDI tracks, 
to the VST Instrument parameters or to the VST Instru-
ment channels if these were frozen) you need to unfreeze 
the VST Instrument:

1. Click the Freeze button for the VST Instrument again 
(either in the VST Instruments window or in the Inspector).
You will be asked to confirm this operation.

2. Click “Unfreeze”.
The tracks and VST Instrument are restored and the rendered “freeze 
file” is deleted.

VST instruments and processor load
If you are working with VST 3 instruments, another way to 
relieve processor load is the option “Deactivate Plug-in 
when silence is detected” in the Preferences dialog 
(VST–Plug-ins page). This is described in detail in the 
section “Smart plug-in processing” on page 169. 

The Freeze button in the 
VST Instruments window…

…and in the Inspector.
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Using presets for VSTi configuration

About track presets and VST presets
Track presets and VST presets allow you to quickly set up 
tracks or instruments with all the settings required for the 
sound you want. Nuendo provides various types of pre-
sets for various purposes. Two of these are of relevance 
for VST Instruments:

• Track presets for instrument tracks store the parameter 
settings of a VST Instrument together with all track/chan-
nel settings (applied audio and MIDI insert effects, etc.).
Instrument track presets can only be applied to instrument tracks, not to 
instrument channels activated in the VST Instruments window.

• VST presets store all panel settings for a plug-in (VST In-
struments and VST effects), but no track/channel settings.
Note that you can create instrument tracks from VST 3 presets, i.e. se-
lecting a VST 3 preset will create an instrument track with all settings 
stored in the VST preset plus an “empty” track.

As described in the chapter “Audio effects” on page 168, 
there are two types of VST presets that can be used: the 
VST 2 standard “.fxb/.fxp” files and the VST 3 preset stan-
dard with the extension “.vstpreset”. Some of the included 
VST Instruments use the VST 2 preset standard, and oth-
ers use the VST 3 standard. 

All VST 2 instruments can import “.fxb/.fxp” files and also 
convert them to the VST 3 standard. Once converted, you 
can use all VST 3 features. See “About earlier VST Instru-
ment presets” on page 200.

For further information on Track presets and VST pre-
sets, see the chapter “Track Presets” on page 327.

Browsing for sounds
One important and often time-consuming aspect of music 
creation is the search for the right sounds. You might spend 
a huge amount of time trying out the presets for a particular 
instrument only to find out later that the preset for another 
instrument contains the sound you were looking for. 

This is why Nuendo features extensive browsing possibili-
ties, allowing you to preview all available presets without 
having to load them first! 

In addition, you can filter your search by specifying cate-
gory, style etc.

For example, if you are looking for a bass sound, simply 
select the Bass category and you can browse and preview 
all bass sounds for all instruments. If you know you want a 
synth bass sound, select Synth Bass as sub-category and 
all synth bass sounds will be shown etc.

You can also browse and preview track presets for instru-
ment tracks, i.e. instrument sounds plus all track settings 
and all channel insert effect settings for this track.

These features combined speed up the process of finding 
the right sound immensely. 

• When creating your own presets, it is always a good 
idea to set up attributes for them, as it allows you to fully 
use the browsing features for your files, too.
This is described in detail in the chapter “The MediaBay” on page 314.

There are two ways of browsing for sounds:

• Using the Presets browser.
This will apply preset settings to an existing track.

• Using the Browse Sounds dialog.
Use this dialog if you haven’t set up a track yet.

Using the Presets browser

1. Create an instrument track and select it in the track list.
You do not have to assign an instrument to the track, but make sure to 
specify a MIDI input.

2. Make sure that the track settings are shown in the In-
spector.

3. Click in the Track Preset field in the Inspector (the text 
field currently reads “No Track Preset”).

Click here…

…to open the Presets browser.
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4. The Presets browser is opened. It contains three sec-
tions (Browser, Search & Viewer and Filter). By default, only 
the Search & Viewer section is shown. Note that it may take 
a moment before all available sounds appear in the Viewer.

• The Viewer section to the right displays all track presets 
for instrument tracks and all VST 3 presets.
Track presets for audio tracks, MIDI tracks or “multi” track setups are not 
displayed. The preset icon to the left of the file name indicates the type of 
preset.

5. Select a preset in the list.

6. Play a few notes on your MIDI keyboard to hear the 
preset sound. You can switch between presets and hear 
the sound when you play. You can also play back/loop a 
MIDI part on a track. Each time you select a preset, all as-
sociated track and/or instrument settings are automati-
cally loaded.

7. Use the Filter section to search for specific attributes if 
you wish.
You can click on the attributes in the respective column (Category, Style 
etc.), to filter out all presets that do not match the selected attribute(s).

8. When you have found the right sound, click OK to 
close the dialog.

Using the “Browse Sounds” dialog

1. Open the Project menu–Add Track submenu and se-
lect “Browse Sounds”.
The Browse Sounds dialog is opened. It contains the same sections as the 
Apply Track Presets dialog (Browser, Viewer and Filter) and its Browser 
section also has the root “Presets” item selected – leave it like this.

• The Viewer section of the Browse Sounds dialog dis-
plays all preset sounds for all track types and all VST In-
struments.

To preview the presets, you have to select a MIDI file or 
play MIDI notes on your MIDI keyboard because at this 
stage there is no track connected. This is done as follows:

2. Select a preset in the Viewer section.
A row of buttons appears in the dialog below the Viewer section.

3. Click the “Choose MIDI File” button.
This opens a file dialog where you can navigate to the location of a MIDI 
file (extension “.mid”).

4. Click “MIDI Input” and then the “Play” button.
The sound is played. For each new preset you select you have to click 
the “Play” button to preview the preset.

5. Use the Filter section to search for specific attributes if 
you wish.
You can click on the attributes in the respective column (Category, Style 
etc.), to filter out all presets that do not match the selected attribute(s).

6. When you have found a preset, click OK to close the 
dialog.
An instrument track is created. It will show all track and/or instrument 
settings that were saved in the preset.

Selecting VST Instrument presets
The previous sections focussed on selecting presets for 
the creation of new instrument tracks, or for changing the 
setup of an existing track. However, you can also use pre-
sets to change the settings of a VST Instrument.

To select a VST Instrument preset, proceed as follows:

1. Load a VST Instrument (either in the VST Instruments 
window or via an instrument track).

2. If you use the VST Instruments window, select a MIDI 
track routed to the instrument. If you use an instrument 
track, select this. 

3. If necessary, click on the track name at the top of the 
Inspector to open the basic track settings.

! Note that the following refers to the selection of VST 3 
presets (.vstpreset). If you want to apply .fxp/.fxb pre-
sets to your VST 2 instruments in this way, see “About 
earlier VST Instrument presets” on page 200.
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4. Click in the Programs field in the Inspector.
The Preset browser is opened.

5. Step through the presets during playback to find the 
sound you are looking for.

6. Double-click the desired preset to load it and close 
the preset browser.

• You can also open the preset browser by clicking in the 
preset name field in the the control panel of a VST Instru-
ment or by clicking the VST Sound button in the control 
panel and selecting “Load Preset…” from the pop-up

• Selecting another preset in the preset browser will load 
it directly, replacing the previous preset.

• When the preset browser is open, you can still use 
Project window key commands, allowing you to start/stop 
playback or locate to different positions in the project.

• Clicking the Reset button below the Viewer will reload 
the last loaded preset.

Saving VST Instrument presets
You can save your settings as presets for further use (e.g. 
in other projects):

1. In the VST Instrument panel, click the VST Sound but-
ton to the right of the preset name and select “Save Pre-
set” from the pop-up menu.
This opens a dialog where you can save the current settings as a preset.

Presets are saved into a default folder named VST3 Pre-
sets. Within this folder, there is a folder called “Steinberg 
Media Technologies” where the included presets are ar-
ranged in sub-folders named after each instrument.

You cannot change the default folder, but you can add fur-
ther subfolders inside the instrument’s preset folder.

• Under Windows, the default preset folder is in the fol-
lowing location:
Boot drive/Documents and Settings/User name/Application data/VST3 
Presets.

• Under Mac OS, the default preset folder is in the follow-
ing location:
Users/Username/Library/Audio/Presets/<company>/<plug-in name>

2. Enter a name for the new preset in the File name field 
in the lower part of the dialog.

• If you wish to assign attributes to the preset, click the 
Tag Editor button.
Click in the Value column to select an appropriate “tag” for one or sev-
eral of the available categories in the Attributes column. Tagging is de-
scribed in detail in the chapter “The MediaBay” on page 314.

3. Click OK to store the preset and exit the dialog.

Extracting sound from Track Presets

You can extract a sound from a Track preset (disregarding 
any track/channel settings) and save it as a VST preset. 
Proceed as follows:

1. Click the VST Sound button (“Extract sound from 
Track Preset”) below the Output Routing pop-up menu in 
the Inspector. 
This opens a dialog where all Track Presets are shown.

2. Select an instrument track preset or VST preset and 
click OK.
The VST Instrument and the settings (but no inserts, EQs or modifiers) of 
the existing track are overwritten using the data of the track preset. The 
previous VST Instrument for this instrument track is removed and the 
new VST Instrument with its settings is set up for the instrument track.

Track Presets are described in detail in the chapter “Track 
Presets” on page 327.
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About earlier VST Instrument presets
You can use any VST 2.x Instrument plug-ins in Nuendo. 
Installing VST Instrument plug-ins works the same way as 
for audio effects – see “Installing additional VST plug-ins” 
on page 186.

When you install a VST 2 instrument, any previously 
stored presets for it will be of the old FX program/bank 
(.fxp/.fxb) standard. You can import such files, but the pre-
set handling will be slightly different. You will not be able 
to use the new features like the Preview function or the 
Tag editor until you have converted the old “.fxp/.fxb” pre-
sets to VST 3 presets. If you save new presets for a VST 2 
plug-in these will automatically be saved in the new “.vst-
preset” format in the default location.

Importing and converting FXB/FXP files

To import .fxp/.fxb files, proceed as follows:

1. Load any VST 2 instrument you may have installed, and 
click on the VST Sound button to open the Preset Ma-
nagement pop-up menu.

2. Select “Import FXB/FXP” from the pop-up menu.
This menu item is only available for VST 2 instrument plug-ins.

3. In the file dialog that opens, locate the .fxp file and 
click “Open”.
If you load a bank (.fxb), it will replace the current set of all effect pro-
grams. If you load a single program, it will replace the currently selected 
effect program only. Note that such files exist only if you created your 
own .fxp/fxb presets with a previous version of Nuendo (or any other 
VST 2 application).

• After importing, you can convert the current program list 
to VST presets by selecting “Convert Program List to VST 
Presets” from the Preset Management pop-up.
When the presets are converted, they will be available in the preset 
browser, and you can use the Tag Editor to add attributes and audition 
the presets. The presets will be stored in the VST3 Preset folder.

About latency
Depending on your audio hardware and its ASIO driver, 
the latency (the time it takes for the instrument to produce 
a sound when you press a key on your MIDI controller) 
may simply be too high to allow comfortable real-time VST 
Instrument playback from a keyboard. 

If this is the case, a workaround is to play and record your 
parts with another MIDI sound source selected, and then 
switch to the VST Instrument for playback.

You can check the latency for your audio hardware in 
the Device Setup dialog (VST Audio System page).
The input and output latency values are shown below the ASIO Driver 
pop-up menu. For live VST Instrument playing, these values should ide-
ally be a few milliseconds (although the limit for “comfortable” live playing 
is a matter of personal taste).

Constrain Delay Compensation
Nuendo features full delay compensation throughout the 
entire audio path. This means that any delay inherent in the 
VST plug-ins you use will automatically be compensated 
for during playback, so that all channels are kept in perfect 
sync (see “About plug-in delay compensation” on page 
170).

However, when you play a VST Instrument in real time or 
record live audio (with monitoring through Nuendo acti-
vated), this delay compensation may sometimes result in 
added latency. To avoid this, you can click the Constrain 
Delay Compensation button on the Project window tool-
bar. This function tries to minimize the latency effects of 
the delay compensation, while maintaining the sound of 
the mix as far as possible.

• In the Preferences dialog (VST page) you will find a set-
ting called Delay Compensation Threshold. Only plug-ins 
with a delay higher than this setting will be affected by the 
Constrain Delay Compensation function.



201

VST Instruments and Instrument tracks

• VST plug-ins (with higher delay than the threshold 
value) which are activated for VST Instrument channels, 
audio track channels that are record enabled, group chan-
nels and output channels will be turned off when you acti-
vate Constrain Delay Compensation.

• VST plug-ins activated for FX channels are not turned 
off but their delay is disregarded by the program (delay 
compensation is turned off).

After recording or using a VST Instrument with Constrain 
Delay Compensation, you should turn off the function to 
restore full delay compensation.

External instruments
An external instrument bus is an input (return) to your au-
dio hardware, along with a MIDI connection via Nuendo 
and few additional settings. External instrument busses 
are created in the VST Connections window. All external 
instrument busses you have created will appear on the 
VST Instrument pop-up menus and can be selected in the 
same way as any VST Instrument plug-in. If you select an 
external instrument, you play it via MIDI as usual (you have 
to create a MIDI device to play it) and the sound (synth au-
dio output) will come in to the VST environment where you 
can apply processing etc. For more information on exter-
nal instruments, see “Setting up external instruments” on 
page 19. 
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Background

What is Surround sound?
Surround is a common name for various techniques for 
positioning audio in reference to the listener. Whereas 
regular stereo is limited to left/right positioning, within a 
relatively narrow field, surround sound opens possibilities 
of positioning an audio source anywhere around the lis-
tener.

Surround sound comes in many flavors, from the ill-fated 
Quadraphonic format for vinyl discs launched in the 70s, 
to today’s more successful incarnations.

The differences between the formats are in two areas:

• The number and configuration of speakers.
This varies from two speakers up to 12.

• The intended final coding format.
This depends on the media the audio will be “stored” on: film, broadcast 
video or DVD, for example.

Surround sound is a large topic, there are entire books 
and regular publications devoted to the subject. This 
chapter will not provide an in-depth introduction to sur-
round sound as such. Instead it will concentrate on the 
specific implementation in Nuendo.

Surround sound in Nuendo
Nuendo has integrated surround sound features with sup-
port for several formats. This support goes all the way 
through the audio path – all audio channels and busses 
can handle multiple speaker channel configurations (up to 
12 channels). A channel in the mixer can either carry com-
plete surround mixes, or an individual speaker channel 
which is part of a surround setup.

• Audio channels can be routed freely to surround channels.
• The Surround Panner function in the mixer allows you to 

graphically position channels in the surround field.
• The Mixconvert plug-in allows conversion of one surround 

channel into another with a different speaker configuration. 
Nuendo places Mixconvert automatically where needed.

• Nuendo is ready for surround specific plug-ins, that is plug-ins 
with multi-channel support specifically designed for surround 
sound mixing tasks (the included “Mix8to2” plug-in is an ex-
ample of this). There are also surround aware plug-ins, which 
are not designed specifically for Surround but which due to 
their multi-channel support work well in a Surround configura-
tion. An example is the Surrounddither plug-in.

• You configure Nuendo for surround by defining input and out-
put busses in the desired surround format, and specifying 
which audio inputs and outputs should be used for the differ-
ent channels in the busses. This is done in the VST Connec-
tions window.

Requirements for using Surround
The following additional equipment is required for taking 
advantage of the surround sound implementation in Nu-
endo:

• An audio card with more than two outputs.
The card must have as many outputs as the surround format you plan to 
select.

• A matching amplifier/speaker configuration.

Encoding
The result of a surround mix in Nuendo is either the multi-
channel audio sent from the surround output bus to your 
surround speaker setup, or (if you use the Export audio 
feature) audio file(s) on your hard disk. Exported surround 
mixes can either be split (one mono file per speaker chan-
nel) or interleaved (a single file containing all the surround 
channels).

Getting from this step to the final product (surround sound 
on DVD disc, DTS, etc.) requires special software and 
possibly hardware. This equipment will encode the signal 
into the desired format, possibly compress the audio and 
store it on the final media.

Exactly what type of software and/or hardware you need 
depends on what kind of format you are mixing for and is 
not dependent on Nuendo in any way.

• Steinberg provides Dolby Digital and DTS encoders for 
purchase, tailored for use with Nuendo.
For details, please go to www.steinberg.net.
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About surround plug-ins
Included with the program are some specific surround-
plug-ins. These are:

• MatrixEncoder and MatrixDecoder.
These are used for working with LRCS Surround encoded material. In 
LRCS Surround, four audio channels are converted to two channels, for 
distribution via regular video and broadcast formats. These plug-ins per-
form such conversions (in both ways) and are compatible with the LRCS 
Surround format.

• Mixconvert
Mixconvert gives you an easy way to take surround mixes and convert 
them to other formats with less channels. For example, Mixconvert can 
be used to downmix a 5.1 surround mix to a normal stereo mix. This plug-
in is unique in that Nuendo will automatically insert it in place of the chan-
nel panner or aux send panner in certain situations. Please refer to the 
manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4” for 
complete information about Mixconvert.

• Mix6to2
The Mix6to2 effect allows you to control the levels of up to six surround 
channels, and to mix these down to a stereo output. 

• Mix8to2
The Mix6to2 effect allows you to control the levels of up to eight sur-
round channels, and to mix these down to a stereo output.

• Mixer Delay
The Mixer Delay effect is useful for time aligning surround speakers if 
your room configuration does not allow for proper ITU-R speaker place-
ment. It is also handy for re-routing surround channels to their proper 
speaker channels in your setup (refer to the separate manual “Nuendo 
Expansion Kit – Cubase Music Tools for Nuendo 4” for more information 
about Mixer Delay.

• SurroundDither
This is a dithering plug-in capable of handling six channels at the same 
time – use this for applying dithering to a surround output bus.

• SurroundPanner
This is described in the section “Using the Surround Panner” on page 
208.

Surround plug-ins (apart from the SurroundPanner) 
are described in the separate manual “Nuendo Expansion 
Kit – Cubase Music Tools for Nuendo 4”.

The VST Connections window
In this window you can add input and output busses. 
There is a complete selection of common surround con-
figurations available, as well as standard mono or stereo 
busses.

The Bus Name column contains the currently configured 
busses as they will appear in the input and output routing 
pop-ups in the mixer.

VST Connections showing the Outputs page. The “5.1 Out” bus is un-
folded, displaying the individual speaker channels, with their physical 
output ports displayed in the Device Port column to the right.

The outputs selected for the 
channels in the busses.Click here to add a bus.

The currently configured busses.
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Surround in the mixer
Surround sound is supported throughout every stage of 
the signal path in the Nuendo mixer, from input to output 
bus. Each bus or audio channel can carry up to 12 sur-
round speaker channels.

In the output channel section of the mixer you can control 
the master levels for configured busses. The level meter 
for a bus (or channel in the mixer) that carries multiple sur-
round channels will show multiple level bars, one for each 
speaker channel in the surround configuration.

Operations

Setting up the surround configuration

Output bus configuration

Before you can start working with surround sound, you 
have to configure a surround output bus, through which all 
the speaker channels of the chosen surround format are 
routed. How to add and set up busses is described in de-
tail in the section “Setting up busses” on page 11. Here is 
a brief run through:

1. Open the VST Connections window from the Devices 
menu.

2. Click the “Outputs” tab.

3. Click the “Add Bus” button and select one of the pre-
set formats from the Configuration pop-up (see below).
The new bus appears with the ports visible.

4. By clicking in the Device Port column you can now 
route the speaker channels to the desired outputs of your 
audio hardware.

5. If you like, rename the output bus by clicking its name 
and typing in a new one.
This name will appear in the mixer and on routing pop-ups.

The following surround configurations are included:

Here, the SurroundPanner is used for positioning 
the sound “dynamically” in the surround field.

Using the Output Routing pop-up, 
audio channels can be routed di-
rectly to surround channels.

Format Description

LRCS
LRCS refers to Left Right Center Surround, where the 
surround speaker is center-rear positioned. This is the 
original surround format that first appeared as Dolby Ste-
reo in cinema and later as the home cinema format Dolby 
ProLogic.

5.0
This is the same as 5.1 (see below) but without the LFE 
channel. The LFE channel is optional in 5.1 and if you 
don’t plan to use it, you might find this option more con-
venient.

5.1
This format is one of the most popular in cinema and 
DVD. In its various cinema and DVD encoding implemen-
tations (established by different manufacturers) it is re-
ferred to as Dolby Digital, AC-3, DTS and MPEG 2 
Multichannel. 5.1 has one center speaker (mainly used 
for speech), main left and right speakers, and two sur-
round speakers (mostly for sound effects). Additionally a 
subchannel (LFE – Low Frequency Effects) with lower 
bandwidth is used for special low frequency effects.

L C R

S

L C R

SRSL

L C R

SRSL

+
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LRC
Same as LRCS, but without the surround speaker chan-
nel.

LRS
Left-Right-Surround, with the surround speaker posi-
tioned at center-rear.

LRC+Lfe
Same as LRC but with an Lfe sub-channel added.

LRS+Lfe
Same as LRS but with an Lfe sub-channel added.

Quadro
The original Quadraphonic format for music, with one 
speaker in each corner. This format was intended for vinyl 
record players.

LRCS+Lfe
Same as LRCS but with an Lfe sub-channel added.

Quadro+Lfe
Same as Quadro but with an Lfe sub-channel added.

6.0 Cine
A Left-Right-Center front speaker arrangement with 3 
(Left-Right-Center) surround channels.

Format Description

L C R
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S
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+
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S

+
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S

+
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+
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6.0 Music
This uses 2 (Left/Right) front channels with Left and 
Right surround channels and Left and Right Side chan-
nels.

6.1 Cine
Same as 6.0 Cine but with an Lfe sub-channel added.

6.1 Music
Same as 6.1 Cine but with an Lfe sub-channel added.

7.0 Cine
A Left, Mid-left, Center, Mid-right, Right front speaker ar-
rangement with Left and Right surround channels.

7.0 Music
Same as 6.0 Music but with a Center front channel 
added.

7.1 Cine
Same as 7.0 Cine but with an Lfe sub-channel added.

7.1 Music
Same as 7.0 Music but with an Lfe sub-channel added.

8.0 Cine
Same as 7.0 Cine but with the addition of a Center Sur-
round channel.

Format Description
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Child busses

Essentially a child bus is a bus within a (bigger) bus. Typi-
cally you may want stereo child busses within your sur-
round bus – this allows you to route stereo tracks directly 
to a stereo speaker pair within the surround bus. You may 
also want to add child busses in other surround formats 
(with fewer channels than the “parent bus”).

Once you have created a surround bus, you can add one or 
several child busses to it by right-clicking the bus and se-
lecting “Add Child Bus”. This is described in detail in the 
section “Adding a child bus” on page 13.

Input bus configuration

To work with surround sound in Nuendo, it is often not 
necessary to configure a surround format input bus. You 
can record audio files via standard inputs, and easily route 
the resulting audio channels to surround outputs at any 
stage. You can also directly import multi-channel files of 
specific surround format onto audio tracks of the same 
format.

You should add a surround input bus in the following cir-
cumstances:

• You have existing audio material in a specific surround 
format, and you wish to transfer this material into Nuendo 
as a single, multi-channel file.

• You wish to record a surround setup “live”.

In both cases, you can add and configure an input bus of 
the format you wish to use in the VST Connections dialog 
so that each input on your audio hardware is routed to the 
corresponding speaker channel.

To add an input bus, use the same general method as de-
scribed for output busses (see “Output bus configuration” 
on page 205), but select the “Inputs” tab instead.

Routing channels directly to surround channels
If you want to place an audio source in one separate 
speaker channel only, you can route it directly to that 
speaker channel. This is useful for pre-mixed material or 
multi-channel recordings that don’t require panning.

1. Open the mixer and locate the channel you wish to 
route.

2. From the output routing pop-up menu, select the cor-
responding surround speaker channel.

• If a stereo audio channel is routed directly to a speaker 
channel, the left/right channels will be mixed to mono.
The pan control for the audio channel governs the balance between the 
left and right channel in the resulting mono mix. Center pan will produce 
a mix of equal proportion.

Routing channels using child busses

Child busses provide a way to route stereo (or multi-chan-
nel) audio channels to specific speaker channels in a sur-
round configuration. 

The most obvious application of a child bus is when you 
wish to add a stereo channel to two specific left/right sur-
round speaker channels.

8.0 Music
Same as 7.0 Music but with the addition of a Center Sur-
round channel.

8.1 Cine
Same as 8.0 Cine but with an Lfe sub-channel added.

8.1 Music
Same as 8.0 Music but with an Lfe sub-channel added

10.2
This is an experimental format with ten surrounding 
speakers and two Lfe channels (a combination of two 
5.1, one at the top and one at the bottom of the room).

Format Description
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If you have added a child bus within a surround bus (see 
above), it appears as a submenu item within the surround 
bus on the output routing pop-up menu. Select this to 
route a stereo audio channel directly to that stereo 
speaker pair in the surround bus.

Using the Surround Panner
Nuendo has a special feature for graphically positioning a 
sound source in a surround field. This is actually a special 
plug-in which distributes the audio from the channel in 
various proportions to the surround channels.

1. Open the mixer and locate the channel you wish to 
position.
This could be a mono or stereo channel.

2. From the output routing pop-up menu, select the 
“whole surround bus” option (not a specific speaker 
channel).
A miniature graph of the surround plug-in interface appears above the 
fader in the channel strip.

When the “whole surround bus” is selected, the channel strip shows a 
miniature surround control. 

3. You can click and drag directly in the miniature image 
to move the sound in the surround field.
The horizontal red strip to the right controls the subbass (LFE) level (if 
available in the selected surround format).

• You can also view a slightly larger version of this control 
by selecting “Panner” on the View options pop-up menu 
for the extended mixer panel.
This mode offers click and drag-panning as well as numerical values for 
left/right balance, front/rear balance and LFE amount – enter the desired 
number or use the mouse wheel to adjust them.

• The SurroundPan can also be displayed in the Inspector 
for all audio channel track types. To display the Surround 
Pan tab in the Inspector, make sure the corresponding op-
tion is enabled in the Inspector context menu.

• For total control over surround panning, double-click on 
the miniature image to open the full Surround Panner 
interface in a separate window.
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The SurroundPan controls

The SurroundPan plug-in interface in Standard, Position and Angle 
mode, respectively.

The SurroundPan plug-in allows you to position your au-
dio in the surround field. It consists of an image of the 
speaker arrangement, as defined by the output bus se-
lected on the output routing pop-up menu, with the sound 
source indicated as a gray ball. 

Mode – Standard/Position/Angle

The Standard Mode/Position Mode/Angle Mode switch 
allows you to work in three modes:

• In both Standard and Position mode, the speakers in the front 
are aligned, as they would normally be in a cinema-type situa-
tion. This means that the front speakers are at a varying dis-
tance from the center. Standard mode (default) is the best 
mode for moving sources between speakers without level at-
tenuation.

• Angle Mode is the traditional surround sound mixing definition. 
Note that here the speakers are defined as being at equal dis-
tance from the center. This is not really a true representation of 
for example a cinema, but has still proven to work well in many 
situations.

Speakers

The speakers in the panel represent the chosen surround 
configuration. 

• The speakers in the front are aligned, as they would nor-
mally be in a cinema-type situation. 
This means that the front speakers are at a varying distance from the 
center, allowing you to move sources between speakers without level 
attenuation.

• You can turn speakers on and off by clicking them with 
[Alt]/[Option] pressed. When a speaker is turned off, no 
audio will be routed to that surround channel.

Positioning and levels

A sound source is positioned either by clicking or by drag-
ging the gray “ball” around in the panel (or by using key 
commands, see below). By dragging during playback you 
can record automation, see “Enabling and disabling the 
writing of automation data” on page 214.

• In Standard Mode, the signal levels from the individual 
speakers are indicated by colored lines from the speakers 
to the center of the display.

• In Position Mode, the concentric circles will help you 
determine the level of the signal at a certain position.
The yellow circle represents -3dB below nominal level, the red circle is at 
-6dB and the blue is located at -12dB. These are affected by attenua-
tion, see below.

! The text below assumes that the Mono/Stereo pop-
up is set to “Mono Mix”. For more information on the 
other modes, see below.
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• In Angle Mode, a red arc helps you determine the per-
ceived “range” of a source. The sound will be at its loud-
est in the middle of the arc and will have dropped in level 
towards the ends.

Exactly how levels are handled may require some explana-
tion:

• When you move a source around, a number will indicate 
the loudness in each speaker.
This is a value in dB (decibel) and is relative to the nominal level of the 
source. In other words, 0.0 (dB) represents full level.

• If you position the source far enough away from a 
speaker, its level will drop to zero (indicated by an infinity 
symbol).

• The signal levels from the individual speakers are indi-
cated by colored lines from the speakers to the center of 
the display.

• You can use modifier keys to restrict movement in vari-
ous ways:

In Standard and Position Mode:

In Angle Mode:

There is also a special set of key commands for working in 
the SurroundPan window.

The LFE dial (all modes)

If the selected surround setup includes an LFE (Low Fre-
quency Effects) channel, a separate LFE level dial will be 
available in the SurroundPan window. Use this to set the 
signal amount sent to the LFE channel. You can also set 
this using the small red strip to the right of the Surround 
Panner in the mixer channel strip, or by typing in a number 
in the LFE value field in the larger Surround Panner that 
can be shown in the extended channel strip.

The Surround Panner in the channel strip (bottom) and in the extended 
panel of the mixer channel strip (“Panner” selected on the View options 
pop-up menu).

Mono/Stereo pop-up (All Modes)

If you have a mono channel the Mono/Stereo pop-up is by 
default set to Mono Mix. The panner will then behave as 
described above.

If you have a stereo channel, you have the option of using 
one of the three Mirror modes. Two gray balls will then ap-
pear, one for each channel (L/R). This will allow you to 
move the two channels symmetrically, by dragging one of 
them. The three modes allow you to select which axis 
should be used for mirroring.

• The default mode for stereo channels is the Y-Mirror mode.
• If you run a stereo signal through the panner in Mono Mix 

mode, the two channels will be mixed together before entering 
the plug-in.

• If you run a mono signal through the plug-in in one of the ste-
reo modes, the signal will be split before entering the plug-in.

Key Movement restriction

[Shift] Horizontally only

[Ctrl]/[Command] Vertically only

[Alt]/[Option] Diagonally (up left, down right)

[Ctrl]/[Command]+ 
[Alt]/[Option]

Diagonally (up right, down left)

Key Movement restriction

[Shift] From center to perimeter only

[Ctrl]/[Command] Along the perimeter only (at current distance from 
center)

! For a complete list of the available key commands, 
click on the “SurroundPanner” logo and then click 
again!

…or drag this control to set LFE level.

Click here and type in a LFE level value…
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Additional parameters (Standard mode)

• Center Level.
This determines how center source signals should be reproduced by the 
front speakers. With a value of 100%, the center speaker will provide the 
center source. With a value of 0%, the center source will be provided by 
the ghost image created by the left and right speakers. Other values will 
produce a mix between these two methods.

• Divergence Controls.
The three divergence controls determine the attenuation curves used 
when positioning sound sources, for X-axis front, X-axis back and Y-axis 
(front/rear), respectively. If all three Divergence values are 0% (default), 
positioning a sound source on a speaker will set all other speakers to 
zero level (-×) (except for the center speaker which depends on the cen-
ter level). With higher values, the other speakers will receive a percent-
age of the sound source.

Additional parameters (Position and Angle mode)

• Attenuate.
Attenuate can be used to amplify or weaken the source. Exactly what effect 
this has on the level in each speaker can be determined by the level read-
outs, the concentric circle (Position mode) and the arc (Angle mode).

• Normalize.
Normalize is a function for controlling the overall loudness from all speak-
ers. When this is set to 1.0 (full normalization), the level from all speakers 
together is always exactly 0dB. The individual levels will then be boosted 
or attenuated accordingly.

Automation

All parameters in the SurroundPan plug-in can be auto-
mated, just as with any other plug-in. See “Enabling and 
disabling the writing of automation data” on page 214.

Mixconvert
Mixconvert is a special plug-in that converts one multi-
channel audio source into another multi-channel destina-
tion. It is most frequently used to “downmix” a multi-chan-
nel surround mix into another format with less channels (a 
5.1 surround mix into a stereo mix for example).

This plug-in can be used as an insert effect in the mixer 
like other plug-ins but it also has special functions. Nu-
endo will automatically insert Mixconvert in place of the 
surround panner in cases where the channel (audio track, 
group channel etc…) is being routed to a destination that 
has fewer audio paths. Mixconvert will also be inserted in 
place of any aux send panner when the destination has a 
different audio path than the source. The surround pan-
ner’s displays and controls will be replaced by Mixcon-
vert’s.

Please refer to the separate manual “Nuendo Expansion 
Kit – Cubase Music Tools for Nuendo 4” for detailed infor-
mation on the operation of Mixconvert.

There is one exception to this behavior. When a stereo 
channel is routed to a mono destination through the chan-
nel routing or an aux send routing, a normal panner will ap-
pear. However, this panner will control the balance of the 
left and right channels as they are blended into the mono 
destination. The center position blends both channels to-
gether equally. With the pan set all the way to the left, only 
the left channel will be heard. With the pan set all the way 
to the right, only the right channel will be heard.

Exporting a Surround mix
When you have set up a surround mix you can choose to 
export it with the Export Audio Mixdown function. This 
function exports a single selected output bus – this means 
that all channels that you want to be part of the mix must 
be routed to the surround output bus.

You have the following export options when doing sur-
round work:

• Export to “split” format, resulting in one mono audio file 
for each surround channel.

• Export to interleaved format, resulting in a single multi-
channel audio file (e.g. a 5.1 file, containing all six sur-
round channels).

! Please note that this is not a dynamic feature, like 
compression or limiting. It is instead just a tool for 
scaling the nominal output levels from the surround 
channels.
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• Under Windows you can also export a 5.1 surround mix 
to a file in Windows Media Audio Pro format.
This is an encoding format tailored for 5.1 surround – see “Windows 
Media Audio Pro files (Windows only)” on page 442.

• You can also export a surround mix to a Dolby Digital 
AC3 file or a DTS file, if you have the Steinberg Dolby Dig-
ital Encoder or the Steinberg DTS Encoder (both optional, 
separate plug-ins) installed in your system.
Please go to www.steinberg.net for details.

For more about exporting to files, see the chapter “Export 
Audio Mixdown” on page 437.

Using effects in surround configurations
Nuendo introduces a special surround format for VST 
plug-ins, that is plug-ins that can process more than two 
channels. Mix8to2 is an example of such a plug-in.

Applying a Surround-aware plug-in

This is not different from applying a regular plug-in. The 
only difference is that the plug-in panel may have controls 
for more than two channels.

Using a stereo plug-in in a surround configuration

Normally, when you apply a stereo insert effect to a sur-
round configuration, the first two speaker channels (often 
L and R) are routed through the plug-in and other chan-
nels are left unprocessed. 

However, you may want to use the plug-in on other speaker 
channels. This is described in the chapter “Audio effects” 
on page 168.
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Introduction
In essence, automation means finding and recording, for 
each and every moment of your project, the right values for 
a particular mixer parameter. When you create your final 
mix, you won’t have to worry about having to adjust this 
particular parameter control yourself – Nuendo will do it 
for you.

Automation is a key feature when mixing audio data in 
complex, multi-track projects. Whether you want to mix a 
music project or if you are performing a feature-film re-re-
cording – without comprehensive automation features 
your task would be impossible. Nuendo provides very 
powerful and yet intuitive automation of virtually every 
mixer and effect parameter.

The following sections provide detailed descriptions of the 
Nuendo automation features:

• The section following below describes how to activate 
automation Write mode and how the automation data is 
displayed.

• What can and what cannot be automated is briefly ex-
plained in “What can be automated?” on page 216.

• “The Automation panel” on page 217 provides a first 
look at the Automation panel and its features.

• Make sure you read and understand “Virgin territory vs. 
the initial value” on page 217!

• The various automation punch-out modes are explained 
in detail in the section “Automation modes” on page 219.

• The Nuendo automation features become truly powerful 
thanks to the automation performance utilities, as ex-
plained in the section “Automation performance utilities” 
on page 222.

• “The Settings section” on page 229 describes the glo-
bal options and settings available on the Automation 
panel.

• “Hints and further options” on page 230 gives you gen-
eral information on how the automation features interact 
with other Nuendo features.

• The section “Automation track operations” on page 231 
describes how to open and manipulate automation tracks.

• Finally, the section “Working with automation curves” 
on page 235 explains how to edit automation curves.

Enabling and disabling the writing 
of automation data
Tracks and mixer channels in Nuendo can be “automation 
enabled” by activating their automation Write (W) buttons.

All track types except arranger, folder, marker, transpose, 
video and ruler tracks feature Write (W) and Read (R) but-
tons in the mixer, in the Track list and in the Channel Set-
tings window. Furthermore, the control panels for all plug-
in effects and VST Instruments also feature Write and 
Read buttons.

The Write and Read buttons for a channel in the mixer and for an auto-
mation track in the Track list.

• If you activate Write for a channel, virtually all mixer pa-
rameters you adjust during playback for that specific 
channel will be recorded as automation events.

• If Read is activated for a channel, all your recorded 
mixer actions for that channel will be performed during 
playback, just like you performed them in Write mode.

• The W and R buttons for a track in the Track list are mir-
rors of the W and R buttons in the corresponding channel 
strip in the mixer.

Note that the Read button is automatically enabled 
when you enable the Write button. This allows Nuendo to 
read existing automation data at any time.
You can separately deactivate Write, if you want to only read existing 
data. There is no status Write on/Read off.

There are also global Read and Write indicator buttons 
(“All Automation to Read/Write Status”) in the common 
panel of the mixer and at the top of the Track list:

The “All Automation to Read/Write Status” buttons in the mixer, and in 
the Track list.
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These buttons light up as soon as there is a single en-
abled Read or Write button on any channel/track within 
your project.

• When “All Automation to Read/Write Status” is dis-
abled and you click on one of these buttons, all Read/
Write buttons on all tracks/channels are enabled.
When “All Automation to Read/Write Status” is enabled, this means that 
at least one of the Read/Write buttons on one of the channels of your 
project is enabled.

• When “All Automation to Read/Write Status” is enabled 
and you click on one of these buttons, any enabled Read/
Write buttons on the tracks/channels of your project are 
disabled.

You will also find global Read/Write buttons on the 
Automation panel. See the section “The Read/Write but-
tons in the Mode section” on page 221.

MIDI Controller Input to Automation Tracks
If you set up a remote device to control parameters and 
settings in Nuendo, you can record automation with that 
remote device – just activate Write as usual. However, if 
you are recording a MIDI track and want to record auto-
mation at the same time, the controller data sent by the re-
mote device will be recorded “twice” – as automation and 
as MIDI controller data on the MIDI track.

To avoid this, activate the “MIDI Controller Input to Auto-
mation Tracks” option in the Preferences (MIDI page). 
When this is activated, the controllers will be recorded as 
automation only, not as MIDI controller data on the re-
corded MIDI track.

Creating automation data
Within a Nuendo project, the changes in a parameter 
value over time are reflected as curves on so-called auto-
mation tracks. The curves are drawn in real-time while you 
write the automation data. Most of the tracks in your 
project have automation tracks, one for each automated 
parameter.

Note that automation tracks are hidden by default. You 
can display all automated parameters and the corre-
sponding automation tracks at the same time.
See the section “Automation track operations” on page 231 for details on 
how to show, hide or remove automation tracks. “Working with automation 
curves” on page 235 explains what you can do with automation curves.

There are two approaches you can use to create automa-
tion curves:

• “Offline”, by manually drawing the curves on automation 
tracks in the Project window.
See “Editing automation events” on page 235.

• “Online”, by enabling the Write/Read buttons and ad-
justing parameters in the mixer or channel settings win-
dow while rolling through the project in real-time. The 
value settings are recorded and displayed as a curve on 
the automation track.
In the following sections, this online writing of automation data is also re-
ferred to as an “automation pass”. See “Enabling and disabling the writ-
ing of automation data” on page 214.

The methods are not different in terms of how the automa-
tion data is applied. They only differ in the way the automa-
tion events are created – manually drawing them or 
recording them during automation passes. Any applied 
automation data will be reflected in both the mixer (a fader 
will move for example) and in a corresponding automation 
track curve. 

There are no hard and fast rules regarding which method 
you should use. For example, you can create your automa-
tion data online without ever even opening an automation 
track. Or you can stick to drawing automation curves off-
line. Every method has its advantages, but of course it is 
up to you to decide what to use and when.
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• Editing curves on automation tracks offers a graphical 
overview in relation to the track contents and the time po-
sition.
This makes it easy to quickly change parameter values at specific points, 
without having to activate playback. For example, this method gives you a 
good overview if you have a voice-over or a dialog on one track and a 
music bed on another track, the level of which needs to be lowered by a 
specific amount every time the dialog occurs.

• By using write automation in the mixer you don’t have to 
manually select parameters from the Add Parameter list.
You can work much like you would using a “real” physical mixer. Every 
action you perform is automatically recorded on automation tracks which 
you can later open for viewing and editing of the parameters you changed.

The automation tracks themselves indicate the writing of 
automation data:

• While writing automation data, the color of the automa-
tion track in the track list changes to red.

• The delta indicator in the automation track shows the 
relative amount by which the new parameter setting devi-
ates from any previously automated value.
This is an additional visual aid when writing new automation data.

What can be automated?
You can automate virtually every parameter in the Nuendo 
mixer. 

• To find out which parameters can be automated for a 
particular track, click in the Parameter display of the auto-
mation track to open a pop-up menu. Select “More…” to 
open the Add Parameter dialog.
This dialog lists all automatable parameters for a particular track type. It is 
described in detail in the section “Assigning a parameter to an automa-
tion track” on page 232.

The following actions CANNOT be automated, even 
though they are features of the Nuendo mixer:

• Changing the input phase
• Changing the input gain
• Changing of routing settings
• Inserting a plug-in
• Moving of plug-ins to different insert slots
• Copying insert settings
• Changing the stereo panner mode
• Changing Control Room settings

The delta indicator
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The Automation panel

The Automation panel is a floating window, similar to the 
Mixer and Transport panel. You can leave it open while 
you work – the Project window will always have the focus.

To open the Automation panel, open the Project menu and 
select the Automation Panel option or click the Automa-
tion Panel button on the Nuendo toolbar.

The Automation panel gives you access to all automation 
options in Nuendo. By default, all seven sections are dis-
played.

You can change the panel configuration using the Setup 
dialog – see “The Setup dialogs” on page 506. The fol-
lowing sections will explain all options and functions.

Virgin territory vs. the initial value

Before we go into detail about the various modes and op-
tions available through the Automation panel, we need to 
explain how Nuendo handles those sections of your project 
in which you have not yet performed an automation pass. 

For parameter automation, Nuendo works either with an 
initial value (see below) or with “virgin territory” (see “Vir-
gin territory” on page 218). 

It is very important that you understand the difference be-
tween these two concepts and their individual advantages 
and disadvantages before continuing.

The initial value
An initial value is always used when “Use Virgin Territory” is 
disabled on the Automation panel.

Use Virgin Territory is disabled.

Click here… …to open the Automation panel.

! When we speak of “touching a control” in the follow-
ing sections, we mean both clicking a parameter 
control on the Nuendo program interface and physi-
cally touching a fader or other control on a remote 
control device.
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When no automation data exists for a particular parame-
ter, and you perform an automation pass for this parame-
ter, its value at the moment when you start the automation 
pass is saved as the initial value. When you punch-out of 
the automation pass, it is this initial value to which the pa-
rameter will return.

This has one very important consequence: As soon as the 
initial value is set, the corresponding parameter is fully au-
tomated, on this track, at any given timecode position of 
the project – even if your automation pass lasted only 2 
seconds.

The straight line after the last automation event indicates the initial value.

This is reflected in the curve on the automation track – it is 
visible right through to the end of the project that the initial 
value is kept. As long as the track is in Read mode, the pa-
rameter control will follow this curve – it will either take 
values set during an automation pass, or it will return to its 
initial value.

You may touch the parameter control and force it to a dif-
ferent value manually. But as you let go of the control, it 
will return to the value defined by the automation curve – 
even when in Stop mode.

Virgin territory
Think of virgin territory as the “state” of the automation 
track before performing the first automation pass. When 
you enable the “Use Virgin Territory” option, no automa-
tion curve is displayed on the automation track, and you 
have full manual control of the parameter.

Use Virgin Territory is enabled.

The idea here is that you find automation only where you 
actually perform an automation pass – there is no initial 
value to which the parameter can return.

Outside a section with automated values, you always have 
full manual control of the parameter.

Gaps

After an automation pass you will find virgin territory only 
to the right of the last automation event. “Empty” sections 
between two automation curves are referred to as “gaps” 
in the following sections. 

Only the dynamic change in the parameter is automated.

You can create gaps inside a section with automated val-
ues. This is useful if you want to have full manual control:

1. Make sure that “Use Virgin Territory” is enabled.

2. Select the Range Selection tool.

3. On an automation track with existing automation data, 
select a range and press [Delete] or [Backspace].
A gap is created.

A new break-point at the position where the selected 
range started marks the end point of the automation curve 
to the left. A second new break-point can now be found at 
the position where the selected range ended, marking the 
start of the automation curve to the right of the gap.
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• When you select one or more break-points of an auto-
mation curve with the Arrow tool and press [Delete] or 
[Backspace], no gap is created.
Instead, the selected break-points are deleted. The curve between the 
deleted points is replaced by a new line connecting the two points to the 
left and right of the deleted points.

The “Terminator” setting

You can “force” any automation track into using virgin ter-
ritory, by defining any automation break-point on the auto-
mation curve as the “terminator” point of this part of the 
curve. This will automatically delete the line between this 
break-point and the next one, creating a gap – a section 
on the automation track where you find no automation 
data. The next break-point to the right of the terminator 
point will automatically become the “start” point of the 
next automated section.

Note that this is independent of the setting for “Use 
Virgin Territory” – you can create gaps at any time.

• To define a break-point as the last point in an automa-
tion curve, select it by clicking on it with the mouse 
pointer, and in the Event info line above the Project win-
dow, set “Terminator” to Yes.

• When you set the “Terminator” option for the last (right-
most) automation break-point of an automation curve to 
“Yes”, any automation data to the right of this point (as de-
fined by an initial value) is deleted.

Automation modes
Nuendo provides three different punch-out modes for au-
tomation, available on the Automation Mode pop-up menu 
on the main toolbar and in the Mode section on the Auto-
mation panel.

Selecting the automation mode in the Automation panel and the Nu-
endo toolbar

The three modes available are Touch, Auto-Latch and 
Cross-Over. In all three modes, automation data will be 
written as soon as a parameter control is touched in play 
mode. They differ in the way the writing of automation data 
is ended, i.e. in their “punch-out” behavior. Which mode 
to use depends on what is required in your particular 
working situation.

Note that you can change the automation mode at any 
time, i.e. in play or stop mode or during an automation 
pass. You can also assign key commands to the automa-
tion modes so you can quickly change between them.
See “Automation key commands” on page 230.

General punch-out conditions
The current automation pass will always punch-out as 
soon as one of the following conditions is met, indepen-
dent of which automation mode is selected:

• If you Disable Write
• If you Stop playback
• If you activate Fast Forward/Rewind
• If the project cursor reaches the right locator in Cycle mode.
• If you click in the timeline to move the project cursor.

Select a break-point…

…and set “Terminator” to Yes.

A gap is created.
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Touch
Typically, you would use Touch mode in situations where 
you want to make a change lasting only a few seconds to 
an already set up parameter.

As the name implies, Touch will write automation data only 
for as long as you actually touch a parameter control – 
punch-out occurs as soon as you release the control.

After punch-out, the control will return to the previously 
set value. The Return Time setting (see “Return Time” on 
page 229) determines how long it takes for the parameter 
to reach the previously set value.

Automation mode: Touch

Auto-Latch
In Auto-Latch mode, there is no specific punch-out condi-
tion other than those valid in all modes – see “General 
punch-out conditions” on page 219.

Auto-Latch is probably the automation mode you will use 
the most, in all situations where you want to keep a value 
over a longer period of time – for example when making 
EQ settings for a particular scene.

Once your pass has started, the writing of automation 
data continues for as long as playback lasts or Write is 
enabled – if you wanted an adjustment that lasted for just 
a few moments, you would use Touch mode. The last 
value setting will be kept until you stop writing.

Automation mode: Auto-Latch

The automation mode for ON/OFF switches is always 
Auto-Latch (even if another mode is selected globally or 
for the track).

Cross-Over
Think of the Cross-Over mode as a kind of “manual return 
time” option (see also “Return Time” on page 229). The 
Cross-Over mode can be used in situations where you are 
not happy with an already existing automation curve or 
with the automatically applied return settings. Cross-Over 
mode gives allows you to perform a “manual return” to en-
sure smooth transitions between new and existing auto-
mation settings.

For Cross-Over, the punch-out condition is crossing over 
an already existing automation curve after touching the 
parameter for a second time.

Look at the figure below: Like in Auto-Latch mode, once 
the automation pass begins with the first touching of the 
parameter control, automation data is written for as long 
as playback lasts.

When you have found the correct value setting, you can 
release the fader – the automation pass continues, with 
the value setting remaining the same.
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Now, re-touch the fader and move it towards the original 
value. As soon as you cross the original curve, punch-out 
occurs automatically.

Automation mode: Cross-Over

Trim
This is described in the section “Trim” on page 224.

Automation mode: global or different for each 
track?
The automation mode you set on the Automation panel (or 
in the Project window toolbar) is used globally, i.e. for all 
tracks of your project.

However, you may also select a different automation mode 
for individual tracks:

• Open the topmost Inspector section for a track for 
which you require a different automation mode, and from 
the Track Automation Mode pop-up menu, select the de-
sired automation mode.

• When selecting the Global option from the pop-up 
menu, the track will again use the automation mode se-
lected from the toolbar or the Automation panel.
Note that you can use the option “All track modes to Global” in the Key 
Commands dialog–Automation category to set up a key command that 
will reset all tracks to using the global automation mode.

The Read/Write buttons in the Mode section
At the bottom of the Mode section, you find two Read and 
two Write buttons. These are used to globally enable or 
disable the Read and Write buttons on all tracks.

The All Automation to Read/Write buttons in the Mode section.

• Click “All Automation to Write” to enable all Write but-
tons (and, at the same time, all Read buttons) on all 
tracks/channels of your project.
Clicking “All Automation Write off” will disable all Write buttons. The 
Read buttons will remain enabled.

• Click “All Automation to Read” to enable all Read but-
tons on all tracks/channels of your project.
Clicking “All Automation Read off” will disable all Read buttons.

The various other Read and Write buttons on the Nuendo 
interface are described in detail in the section “Enabling 
and disabling the writing of automation data” on page 214.

Selecting an automation 
mode for an individual track.

! When selecting Trim as the automation mode for a 
track (see “Trim” on page 224), the punch-out be-
havior will always be as in Auto-Latch.
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Automation performance utilities
The automation modes described above become far more 
effective when used in combination with the Nuendo auto-
mation performance utilities. These are a number of op-
tions and functions tailored to specific situations, allowing 
you to write automation data quickly and efficiently. You 
will find these utilities in the various sections on the Auto-
mation panel. 

The Fill options

The Fill options define conditions for what is to happen in 
a specific section of your project when you punch-out of a 
running automation pass. They can be used in real-time 
while rolling through your project, in situations that are not 
too complex. Look at these two examples:

Fill To End

Imagine you are automating volume for the background 
tracks of a two-minute scene. Rather than to hold on to 
the fader for two minutes, you can proceed as follows: 

1. Open the Automation panel and select Touch as your 
automation mode.

2. Click the “To End” button once to activate it as Fill op-
tion.
The “To End” button is highlighted. 

3. Start rolling and touch the parameter control to punch-
in the automation pass.

4. Move the fader until you have found the setting you 
want, and release the fader.
This will punch-out the writing of automation data. As you let go of the 
fader, the automation curve will take the found value setting, from where 
you punched out through to the end of the project.

Fill To End

Fill To Punch

Let’s say you are rolling, in real-time, over a scene cut and 
volume must be softer in the next scene – you don’t yet 
know how much softer, but the change in volume from the 
first to the second scene must be abrupt.

1. Select Touch as automation mode and “Fill To Punch” 
as Fill option.

2. Start rolling somewhere during the first scene and 
touch the fader on the moment of scene change.
The automation pass is punched in.

3. Move the fader until you have found the volume setting 
you need in the second scene, and release the fader to 
punch-out.
The volume curve is set from the point of punch-out back to where you 
punched in. The values written while moving the fader to find the right 
value are deleted, and volume jumps, at exactly the right moment, from 
the value set in the first scene to the value found for the second scene.

You will find this works the same for the other Fill options:

• When “To Start” is selected, punching out of automa-
tion will fill the automation track from where you punched 
out to the start of the project.
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• To use the Loop option, you must first set up a loop 
range with the left and right locators. When you then se-
lect Loop, punching out of automation will set the found 
value within the range defined by the left and right locator.
Note that, even when the project cursor is outside the defined loop, the 
found automation value will be applied only between the locators.

Fill Loop

• The Gaps option is used only in combination with Virgin 
Territory. This is explained in detail in the section “Virgin 
territory vs. the initial value” on page 217. When Gaps is 
selected, punching out of automation will fill any gaps be-
tween previously written automation with the last value 
found during the last automation pass.

Fill combinations

You can also combine the various Fill options. 

• Select “To Punch” and “To End” if you want the found 
value to be used from where you punched in through to 
the end of your project. 

Combining Fill To Punch and Fill To End

• Combining “To Start” and “To End” will fill the automation 
track from the beginning through to the end of the project.

Combining Fill To Start and Fill To End

• You can also combine the Fill options with the Preview 
options (see “The Preview options” on page 225), and 
when working offline with the Pencil tool.
Offline editing is explained in more detail in the section “Editing automa-
tion events” on page 235). This is a very fast and efficient way to move 
through your project.

Feel free to experiment!

! The Fill options write one particular value across a 
defined section of your automation track – any previ-
ously created data within this section is overwritten. 
Therefore, use the Fill options with caution, to avoid 
accidental loss of data.

! Note that when Trim is active, the Fill–Gaps option 
will have no effect. This is because Trim will only 
modify already existing data.
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One shot vs. continuous fill

The Fill options can be used in two different ways:

• When you click one of the Fill options once, it is high-
lighted, and will be enabled during the next automation 
pass.
Afterwards, the option is disabled again, i.e. the operation can be per-
formed only once.

• If you click a Fill option a second time, a lock symbol is 
displayed on the highlighted button, indicating that you 
are permanently in “Fill to X” mode and that the operation 
can be repeated as many times as you wish.
Clicking the option for a third time will disable this Fill option.

Trim
Trim is available from the Automation panel only. Trim is a 
way of manipulating an already written automation curve, 
other, rather than an automation mode. 

Trim works for channel volume and aux send level 
adjustments.

When enabling Trim, a channel volume fader is positioned 
in the exact middle position, and will not move with any ex-
isting volume automation curve.

You can use Trim either in Stop mode or in Play mode.

Trim in Stop mode

In Stop mode, selecting one of the Fill options and moving 
the fader in Trim mode will move the entire existing volume 
automation curve up or down, so you can still adjust the 
overall volume of a channel without destroying any auto-
mation data that you might have created earlier.

• In Stop mode, Trim is used in combination with some of 
the Fill options (see “The Fill options” on page 222), to 
determine within which range the automation curve is ad-
justed.
The Fill options available are To Start, To End, Loop and any combination 
of these.

Trim in Play mode

In Play mode, moving the fader in Trim mode will move the 
existing break-points by a relative amount as the project 
cursor passes over them.

• In Play mode, as the project cursor moves along the 
timeline, your Trim moves will adjust the existing break-
points on the automation curve. 

Note that the exact result of your trim moves in Play 
mode will only be visible after punch-out.

Trim in Play mode, in combination with Fill to Punch. Note that you 
would arrive at a similar curve when enabling Trim, setting the left and 
right locators, selecting Fill Loop and moving the fader downwards in 
Stop mode.

Note that Trim is not merely a matter of rewriting the 
automation curve using the fader movements you perform. 
Instead, the settings from the existing curve and the set-
tings calculated from your fader movements are used to 
re-calculate the automation curve as soon as you punch-
out.
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The Preview options

Preview provides an easy way to find new settings without 
recording the steps needed to locate them:

• Preview allows you to deal with abrupt changes in your 
audio material, e.g. in music when changing from verse to 
chorus, or in film when moving into the next scene.

• With Preview, you can do a test run of your automation 
pass. 

• Preview is the mode to use in complex situations where 
many things happen in a very short period of time, and 
where it is not possible to set all required parameters in 
real-time.

• Preview allows you to set up automation for several pa-
rameters simultaneously.

Imagine two film scenes where the actors move from a ho-
tel entrance hall into the open air: while some of your pa-
rameter settings might still be OK for the second scene, 
others will have to change abruptly as soon as the second 
scene starts.

So for the second scene, you must find new settings, but 
without deleting any existing automation data.

The Preview workflow

The Preview workflow has three different phases: touch-
collecting the required parameters, finding the required val-
ues, and the actual automation pass. Proceed as follows:

1. On the Automation panel, click the Preview button in 
the Preview section.
The Preview button is highlighted.

2. Touch a parameter control.
Below the Preview button three other buttons are displayed. You now 
have full manual control of the touch-collected parameter, suspending 
(but not deleting!) any previously recorded automation data. You may 
now touch-collect another parameter, if you want to write data for several 
parameters during the same automation pass.

• Note that each automation track has its own Preview 
button. 

Clicking this button will enable Preview mode for this particular automa-
tion track. This is touch-collecting via automation tracks.

3. Play back the scene (you may want to loop it) and find 
the parameter setting(s) you want.

Touch the required parameter, start rolling, find the desired value and 
select Punch to start the new automation pass.

• Use the Suspend option in the Preview section on the 
Automation panel to compare any previously automated 
value with the value found during preview.
Suspend will play back your audio material using the parameter values 
set before activating Preview – in our example above, to hear the settings 
for the indoor scene, you need to click Suspend, and at the moment of 
scene change, you need to click Suspend again to return you to Preview 
mode and the values found for the open-air scene.

Suspend allows you to listen to the existing automation settings.
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Remember: you can use the delta indicator in the au-
tomation track as an additional visual aid for comparing 
the previously found and the currently set parameter val-
ues.

4. When you are happy with the values found, start roll-
ing and click Punch to punch-in the automation pass. 
The new value setting is recorded, from the point where you punched in 
to your punch-out position (as defined by the automation mode setting).

The result of the Preview automation pass.

Punch vs. Punch on Play

When using the Punch option as described above, start-
ing playback and punching in are two separate actions. If 
you want to punch-in when starting playback, activate 
Punch on Play. 

• Punch would be the option to use if you need to listen to 
the section before your desired punch-in point and if this 
section has automation data already that you don’t want to 
overwrite – you would roll through this section and then 
punch-in the automation pass.

• You can also use Punch in Stop mode. To create auto-
mation data in this way, Punch must be combined with 
one of the Fill modes (see “The Fill options” on page 222).

• Use Punch on Play when you cannot punch-in on the fly 
– i.e. in situations where you need to find the punch-in po-
sition in stop mode. Once you have found the exact posi-
tion, enable Punch on Play and start playback from there.

Auto Punch

As described in the section “General punch-out condi-
tions” on page 219, when setting up a loop with the left 
and right locators, an automation pass will always punch-
out when reaching the right locator. 

When in Preview mode, you can also use the left and right 
locators to automatically punch-in and out at defined posi-
tions, using the Auto Punch command.

• Use Auto Punch when you want the automation pass to 
begin and end at defined positions.

You can also use Auto Punch without enabling Preview 
mode, to set up a “safe zone” for previously written auto-
mation data: 

• Place the right locator at the beginning of an area you 
wish to protect and enable cycle mode. 
This will ensure that a running automation pass will always punch-out be-
fore reaching this section of your project.

Touch Assist

When you use Preview mode, you may get into a situation 
where you change some parameters, but not others, al-
though they belong to the same group of parameters (e.g. 
EQ settings). To prevent you from forgetting some para-
meters while touch-collecting parameters for Preview (see 
also “The Preview workflow” on page 225), you can en-
able the Touch Assist option. You will find this option at 
the bottom of the Preview section on the Automation 
Panel.

The Touch Collect Assistant is enabled.

When the Touch Collect Assistant is enabled, the para-
meters of the following features will be treated as groups:

• Channel EQ module (21 parameters total)
• Aux send on/off and send level
• Stereo panner
• Surround panner (Left-Right, Front-Rear, LFE)
• Insert plug-ins (only available for plug-ins with 32 or less 

parameters)

• When this option is enabled, it will ensure that touching 
one parameter in a group will “touch” all other parameters 
in that group as well.
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• If, however, you want to automate one and only one par-
ticular parameter, the Touch Collect Assistant should be 
disabled to prevent you from inadvertently overwriting any 
previously created automation data.

Changing plug-in presets in Preview mode

When changing a preset of a VST plug-in while in Preview 
mode, the change in the parameter settings caused by the 
preset change is recorded automatically as automation. 
Note that the plug-in must have 32 or less parameters for 
this to work.

The Punch Log section

This section of the Automation panel displays a list of re-
cent punch-in operations performed in Preview mode.

By loading one of these log entries for the current track, 
you recall the corresponding touch-collected parameters 
and their values at the moment of punch-in.

• To recall the settings of a particular entry in the punch 
log, select it in the list and click Load.
The Preview button on the Automation panel and the “Preview mode” 
button on the corresponding automation track light up to indicate that 
this parameter is now in Preview mode. 

• You can rename any log entry by double-clicking it and 
entering a new name.

• To delete an entry, select it and click Delete.

• To specify how many log entries are displayed, click the 
Max. Log Entries button in the Settings section.
If this value is set to 10 entries, the eleventh punch event will overwrite 
the entry created for the first event, the twelfth will replace the second 
entry, etc. The maximum possible number of punch log entries is 100.

• You can prevent a particular entry from being overwrit-
ten by clicking in the right column for this entry, so that a 
check mark is displayed.

• Punch log entries are saved with the current project.
Punch log data is always project-specific. There is no way to export log 
entries to another project.

Loading behavior

When loading a log entry, you add the corresponding pa-
rameter(s) to any other parameters that you have touch-
collected during the current Preview session. 

However, if you manually touch-collect a parameter, e.g. 
volume, and then add volume again by loading a punch 
log entry, the settings for volume from the punch log will 
be used, replacing any values set manually.

The Suspend options

The parameters or parameter groups selected here are 
excluded from the reading or writing of automation data – 
giving you full manual control of these parameters. 

Note that the Others options refer to all parameters 
not covered by any of the options Volume, Pan, Mute, EQ, 
Sends or Inserts.

! Enabling the Touch Collect Assistant may lead to the 
creation of a large amount of automation data, caus-
ing a higher CPU load. If performance is an issue in 
your workflow, you should consider not using the 
Touch Collect Assistant.
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Suspending Write

Imagine the following situation: To help you concentrate 
while working on a particular track, you mute several other 
tracks. However, because automation Write is active on 
these tracks, this mute state is also automated during the 
next automation pass – a classic situation in mixing.

To avoid inadvertently excluding whole tracks from your 
mix in this way, you can exclude Mute from all automation 
writing. Simply click Mute below the Suspend Write but-
ton in the Suspend section on the Automation panel.

• Click the Suspend Write button to enable all Suspend 
Write options, thus suspending the writing of automation 
data for all parameters/parameter groups.
When any of the options below the Suspend Write button are enabled, 
clicking Suspend Write will disable these buttons.

• When an automation pass is in progress for a particular 
parameter and you write-suspend this parameter, it will 
punch-out of the automation pass.

Suspending Read

Imagine you have already automated several tracks. While 
working on the current track, you want one of the other 
tracks to be louder, to better identify a particular position 
in your audio material. By suspending Read for the volume 
parameter, you regain full manual control and can set the 
volume to the required level.

• Click the Suspend Read button to enable all Suspend 
Read options, thus suspending the reading of automation 
data for all parameters/parameter groups.
When any of the options below the Suspend Read button are enabled, 
clicking Suspend Read will disable these buttons.

The Show options

The Show options in the Automation panel

The Show options in the Automation panel always affect 
all tracks. Clicking on these buttons opens the automation 
tracks for the corresponding parameters, e.g. volume or 
pan. This makes it easy to look at, e.g., your EQ settings 
on several tracks.

• When you click either Volume, Pan, EQ, Sends or In-
serts, this will open the corresponding automation track(s) 
for all tracks.
The automation tracks will be opened even if no automation data was re-
corded on these tracks.

• For parameter groups (i.e. Pan, EQ, Sends and Inserts) 
you can step through the individual parameter sets by re-
peatedly clicking the respective button.

• When the Used Only button is enabled, clicking one of 
the parameter options will show you only the automation 
tracks for which automation data has already been written.
“Empty” automation tracks will not be displayed.

• When you click Show Used, only those automation 
tracks that contain automation data will be displayed.
These will be all automation tracks, for any parameter, on all automated 
tracks.

• Hide All will hide all open automation tracks.
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The Settings section

The options in the Settings section of the Automation panel

In the Settings section of the Automation panel you will 
find a number of global options and commands.

The Functions pop-up menu

At the top of the Settings section you will find the Func-
tions pop-up menu. Here you will find a number of global 
commands affecting automation.

You can always undo these actions!

Delete All Automation in Project

This global command will remove all automation data from 
your project. Use this option with great caution, otherwise 
you may loose your work.

Delete Automation of Selected Tracks

When you select this command, all automation data for 
the selected track(s) will be removed. Make sure you have 
selected the right track(s) before using this option.

Delete Automation in Range

This command will delete, on all tracks, all automation 
data between the left and right locator. Be sure that this is 
what you want to do before proceeding!

Fill Gaps on Selected Tracks

When working with virgin territory (see “Virgin territory vs. 
the initial value” on page 217), selecting this option will, 
on the selected track(s), fill the gaps between those sec-
tions of the project that show automation curves with a 
continuous value.

The value used is the value of the last break-point (the end 
point) of a section. This value is written across the gap up 
to one millisecond before the first break-point of the next 
automated section. A new break-point is inserted here; 
the value will be ramped to the next automated section.

Fill Gaps with current Value (Selected Tracks)

When working with virgin territory (see “Virgin territory vs. 
the initial value” on page 217), selecting this option will, 
on the selected track(s), fill the gaps between those sec-
tions of the project that show automation curves with the 
value set by the current position of the corresponding 
control.

Global options

Return Time

The Return Time setting determines how fast the auto-
mated parameter returns to any previously automated 
value when you release the mouse button. 

The default setting is 33ms. Make sure that the return time 
is set to a value larger than 0, to prevent sudden jumps in 
your parameter settings (which may lead to crackles). 

Reduction Level

The automation reduction function automatically reduces 
the number of automation events. During an automation 
pass (or when drawing automation with the Pencil tool), 
these are added as a continuous stream of densely packed 
break-points. This is necessary because the program can-
not “guess” what you will be doing next.

However, when punching out, the reduction function will 
remove all break-points that are not needed. The automa-
tion curve will contain only the break-points necessary to 
reproduce your actions.
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For example, all break-points that lie between two other 
points, but do not deviate from the curve, will be automat-
ically removed by reduction.

If you try to add a break-point that doesn’t deviate from the existing 
curve between two existing points…

…it will be removed when the mouse is released. If you move the se-
lected break-point by any amount so that the resulting curve isn’t a 
straight line, a new event will be added.

• If you are unhappy with the default setting (a reduction 
of roughly 75%), you can change it, but normally the de-
fault setting works well.

Max. Log Entries

This setting refers to the Punch Log and is described in 
“The Punch Log section” on page 227.

Show Data on Tracks

When this option is enabled, audio waveforms or MIDI 
events will be displayed not only on the audio or MIDI 
tracks, but also on the corresponding automation tracks.

Note that this depends on two options in the Prefe-
rences dialog: The events will be displayed only when the 
option “Show waveforms” (Event Display–Audio) is en-
abled and when “Part Data Mode” (Event Display–MIDI) is 
set to an option other than “No data”.

Use Virgin Territory
This option is described in detail in the section “Virgin ter-
ritory vs. the initial value” on page 217.

Hints and further options

Automation key commands
In the Key Commands dialog (opened from the File menu 
in Nuendo), in the Commands section on the left, you will 
find an Automation category which lists all automation 
commands to which you can assign key commands.

How to assign key commands is described in detail in the 
chapter “Key commands” on page 517.

About automation undo
Every automation write operation you perform creates its 
own event in the undo history, so you can undo or redo 
any of your automation moves at any time.

About linking and automation
Nuendo allows you to link, in the mixer window, various 
parameters between different channels (see “Link/Unlink 
channels” on page 145).

Also, in the channel settings window, you can link a send’s 
panorama settings to the panorama settings displayed in 
the channel strip (by enabling the option “Link Send Rout-
ing Panners to Channel Panner as Default” in the Prefer-
ences–VST page).

• When automating the settings of a channel that is linked 
to another channel in the mixer, the parameters of the 
linked channel will NOT be automated.

• For linked panners of sends and channels, automating 
one panner will automate the linked panner as well.

! The higher the number of automation events, the 
higher the CPU load. If performance is an issue in 
your workflow, you should consider moving the re-
duction level slider further to the right, to remove 
more events.
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Automation track operations

About automation tracks
Audio tracks, group channel tracks and FX channel tracks 
all have automation tracks. These allow you to view and 
edit the automation of all mixer settings for the track, in-
cluding settings for the track’s insert effects. There is one 
automation track for each parameter, and automation 
tracks can be shown or hidden in any combination.

Similarly, MIDI tracks have automation tracks for mixer set-
tings, track parameters and (if used) for send and insert ef-
fect settings.

VST Instruments have special automation tracks that ap-
pear in the Project window when you load a VST Instrument 
via the VST Instruments window. There is one automation 
track for the plug-in parameters, and one track for each 
mixer channel used by the instrument. These tracks all have 
automation tracks, giving you access to all parameters and 
mixer settings.

Instrument tracks, as a combination of a MIDI track and a 
VST Instrument, have automation tracks that provide auto-
mation parameters for the VST Instrument itself, for the 
VST Instrument channel and the respective MIDI automa-
tion parameters.

Finally, for ReWire channels and input/output channels, 
automation tracks are automatically added as soon as you 
activate automation (with the Write button) in the corres-
ponding mixer channel strip or in the Channel Settings 
window. These tracks have automation tracks for all pa-
rameters as well.

Opening automation tracks 
Every track/channel has a number of automation tracks, 
each showing one automation parameter.

For audio, Instrument, group channel, MIDI and FX chan-
nel tracks, there are two ways you can open an automa-
tion track for the channel:

• By right-clicking the track in the Track list and selecting 
“Show Automation” from the context menu.

• By clicking along the left edge of the track in the Track 
list. (Also, when you position the mouse pointer over the 
lower left corner of the track, a corresponding arrow icon 
(“Show/Hide Automation”) appears.)
An automation track opens in the Track list. Depending on your Prefer-
ence settings (see above), the event display shows a straight black hori-
zontal line as well as a grayed out mirror image of the audio events’ 
waveform (or MIDI events for MIDI tracks). By default, the volume para-
meter is assigned to the first automation track.

For VST Instruments (not for Instrument tracks, see below), 
automation tracks appear automatically when you add them 
in the VST Instruments window.

For ReWire channels and input/output busses, automa-
tion tracks are automatically created when the Write auto-
mation button (see “Enabling and disabling the writing of 
automation data” on page 214) is activated in either:

• The corresponding channel strip in the mixer.
• The corresponding Channel Settings window.
• The mixer common panel (“All Automation to Write Status”).
• The area above the Track list (“All Automation to Write Status”).

Opening additional automation tracks

• If you position the mouse pointer over the lower left cor-
ner of an automation track, a “+” sign (“Append Automa-
tion Track”) will appear. If you click this, another 
automation track opens, by default showing the next pa-
rameter in the Add Parameter list (see below).

Click here to open an 
automation track
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Assigning a parameter to an automation track
Default parameters are already assigned to automation 
tracks when you open them, according to their order in the 
Add Parameter list (see below).

To select which parameter an open automation track 
should display, proceed as follows:

1. If none exists, open an automation track using one of 
the methods described above.

2. Click in the parameter display for the automation track.
A pop-up list is shown, containing some of the automation parameters 
plus the item “More...” at the bottom of the list. The contents of the list 
depend on the track type (audio, MIDI, VST instrument, etc.).

• If the parameter you wish to automate is on the pop-up 
menu, you can select it directly.
The parameter will then replace the current parameter in the automation 
track. 

• If you wish to add a parameter not available on the pop-
up menu or want to view all parameters that can be auto-
mated, go on to the next step.

3. Select “More...”.
The Add Parameter dialog appears. This dialog shows a list with all pa-
rameters that can be automated for the selected channel (sorted into dif-
ferent categories), including the parameters for any assigned insert 
effects. To view the parameters in each category, click the “+” sign for 
the category folder.

The Add Parameter dialog for an audio track.

4. Select a parameter from the list and click OK.
The parameter will then replace the current parameter in the automation 
track.
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Note that the “replacing” of the parameter displayed in 
the automation track is completely non-destructive. 
For example, if the automation track contained any automation data for 
the parameter you just replaced, this data will still be there, although it 
will not be visible after you replaced the parameter. If you click in the pa-
rameter display you can switch back to the replaced parameter. On the 
pop-up menu, all automated parameters are indicated by an asterisk (*) 
after the parameter name.

The Volume parameter is automated.

You can click the “Append Automation Track” button (the 
“+” sign) for the automation track several times to open 
additional automation tracks. Repeat the above procedure 
to assign a parameter to each automation track.

Removing automation tracks 
To remove automation tracks from the Track list, proceed 
as follows:

• To remove a single automation track, click the parame-
ter name and select “Remove Parameter” from the pop-up 
menu.
Note that this will also delete any automation events on the automation 
track, and the automation track will be closed.

• To remove all currently unused automation tracks from a 
track in the Track list, select “Remove Unused Parame-
ters” from any of its automation track parameter name 
pop-ups.
All automation tracks that do not contain automation events will be 
closed for the selected track.

• On the Automation panel, you will find the Delete op-
tions in the Functions pop-up menu (see “The Functions 
pop-up menu” on page 229).
Using these commands will also lead to the removal of automation tracks.

Showing/hiding automation tracks
• To hide a single automation track, position the pointer 
over the top left border of the automation track in the Track 
list and click the “Hide Automation Track” button (the minus 
sign).

• To hide all automation tracks for a track, right-click the 
track for which you wish to hide the automation tracks, 
and select “Hide Automation” from the context menu.

• To hide all automation tracks for all tracks in the Track 
list, right-click any track and select “Hide All Automation” 
from the context menu.
This option is also available in the Track Folding submenu of the Project 
menu.

• On the Automation panel, you can hide or show auto-
mation tracks using the options in the Show section.
See “The Show options” on page 228.

Showing only used automation tracks

If a lot of automation tracks are used, it may be impractical 
to have them all open in the Track list. If you want to view 
only the automation tracks that are used (i.e. those that 
actually contain automation events) and hide all empty au-
tomation tracks, do one of the following:

• Right-click any track in the Track list and select the op-
tion “Show All Used Automation” from the pop-up menu.
This will close all automation tracks not containing any automation 
events, while leaving used automation tracks open for all tracks. This op-
tion is also available in the Track Folding submenu of the Project menu.

• Right-click a specific track and select the option “Show 
Used Automation (Selected Track)” from the context menu.
This will close all automation tracks for the selected track not containing 
any automation events, while leaving used automation tracks open.
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Muting automation tracks

You can mute individual automation tracks by clicking their 
Mute buttons in the Track list. Clicking the Read (R) but-
ton (see “Enabling and disabling the writing of automation 
data” on page 214) for an automation track will activate or 
deactivate Read mode for all automated parameters of the 
track. Using the Mute button allows you to turn off auto-
mation for a single parameter.

The “Automation follows Events” setting
If you activate “Automation follows Events” on the Edit 
menu (or in the Preferences–Editing page), automation 
events will automatically follow when you move an event or 
part on the track. 

This makes it easy to set up automation related to a spe-
cific event or part, rather than to a specific position in the 
project. For example, you can automate the panning of a 
sound effect event (having the sound pan from left to right, 
etc.) – if you need to move the event, the automation will 
automatically follow! The rules are:

• All automation events for the track between the start 
and end of the event or part will be moved.
If there are automation events in the new position (to which you move the 
part or event), these will be overwritten.

• If you copy an event or part (using Copy/Paste, or [Alt]/
[Option]-dragging, or using the Duplicate or Repeat func-
tions), the automation events will be duplicated as well.

Recording plug-in automation
Every parameter for every assigned effect or VST Instru-
ment can be automated in much the same manner as de-
scribed above.

The following example assumes that you have assigned an 
insert effect to an FX channel track (see the chapter “Au-
dio effects” on page 168), and describes how to record 
automation for the effect:

1. Select the FX channel track in the Track list and open 
its Inserts section in the Inspector.
If the Inspector is hidden, click the “Show Inspector” button in the 
Project window toolbar.

Please note that not all Inspector tabs are shown by 
default. You can show/hide Inspector sections by right-
clicking on an Inspector tab and activating/deactivating 
the desired option(s).
Make sure to click on an Inspector tab and not on the empty area below 
the Inspector, as this will open the Quick context menu instead.

2. Open the control panel for the effect by clicking the Edit 
button (“e”) above the insert effect slot in the Inspector.

3. Click the Write button in the control panel to enable 
Write mode.
The Read button is enabled as well. All effects and VST Instruments have 
Write/Read buttons on their control panels. These work exactly like the 
corresponding buttons in the mixer or in the Track list.

4. Start playback and adjust some effect parameters in 
the control panel.
When you are finished, stop playback and return to the position where 
you started playback.

5. Disable Write.
The Read button remains enabled.

6. Start playback and watch the control panel.
All actions you performed during the previous playback will be repro-
duced exactly.

Assigning an automated parameter to an automation 
track

To select which parameter is currently shown in the auto-
mation track for a channel, proceed as follows:

1. Click on the parameter name for the channel’s automa-
tion track.
The parameter name pop-up list is shown containing the automation pa-
rameters for the plug-in. The parameter(s) you previously automated are 
indicated by an asterisk after the parameter name in the list.

Automated parameters for the PingPongDelay effect.

2. Select the parameter you wish to view from the para-
meter display pop-up.
The automation curve for the parameter you selected is displayed on the 
automation track.
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• To view VST Instrument parameters, you use the same 
method.
As described earlier, each VST Instrument has two or more automation 
tracks – one for the plug-in settings and one for each VST Instrument 
mixer channel.

Dragging and dropping of insert plug-ins

You can drag an insert plug-in from one insert slot to an-
other, either on the same channel or on a different chan-
nel.

• When dragging a plug-in to a different insert slot on the 
same channel, any existing automation data will move with 
the plug-in.

• When dragging a plug-in to a different insert slot on a 
different channel, any existing automation data will not be 
transferred to the new channel.

Working with automation curves

About automation curves 
There are two kinds of automation curves, “ramp” and 
“jump”:

• Jump curves are created for any parameter that only has 
on/off values, like a Mute button, for example.

• Ramp curves are created for any parameter that gener-
ates continuous multiple values, such as fader or dial 
movements etc. 

Examples of jump and ramp automation curves shown in the event dis-
play.

About the static value line
When you are not using virgin territory (see “Virgin terri-
tory vs. the initial value” on page 217) and you open an 
automation track for a parameter for the first time, it 
doesn’t contain any automation events (unless you have 

previously adjusted that parameter with write automation 
activated), and this is reflected in the event display as a 
straight horizontal black line, the “static value” line. This 
line represents the current parameter setting.

• If you have manually added any automation events or 
used write automation for the corresponding parameter, 
and then disable the reading of automation data, the auto-
mation curve will be grayed-out in the automation track 
event display and the static value will be used instead.
As soon as Read mode is enabled, the automation curve will become 
available.

Editing automation events

Drawing automation events

By using write automation in the mixer, you generate auto-
mation events by moving parameter dials and faders in the 
mixer. You can also add them manually by drawing automa-
tion curves on an automation track. Proceed as follows:

1. Show the automation track by clicking on the left edge 
of the track in the Track list.
The static value line is shown in the event display for the automation 
track.

2. Select the Pencil tool.
You can also use the various modes of the Line tool for drawing curves, 
see below.

3. Click on the static value line. An automation event is 
added, read automation mode is automatically activated, 
and the static value line changes to a blue automation 
curve.
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4. If you click and hold, you can draw a curve by adding a 
multitude of single automation events.
Note that the track color in the track list changes to red to indicate that 
automation data is being written.

5. When you release the mouse button, the number of 
automation events is reduced to a few events, but the ba-
sic shape of the curve still remains the same.
This “thinning out” of events is governed by the Reduction Level setting 
in the Settings section of the Automation panel, see “Reduction Level” 
on page 229.

6. If you now activate playback, the volume will change 
with the automation curve.
In the mixer, the corresponding fader moves accordingly.

7. Simply redo the operation if you are not happy with the 
result.
If you draw over existing events, a new curve is created.

• If the automation track is in Read mode already, you can 
also add automation events by clicking with the Arrow 
tool.
If you are trying to add a break-point between two existing points and the 
new point doesn’t deviate from the existing curve, it will be removed by 
reduction as soon as you release the mouse button (see “Reduction 
Level” on page 229).

Drawing curves with Fill enabled

You can use the Fill options on the Automation panel in 
combination with the Pencil tool. This provides you with an 
extremely powerful tool for offline work:

1. As in the example above, open an automation track for 
the desired parameter and select the Pencil tool.
Remember: the Write button does not have to enabled.

2. On the Automation panel, select “To End”.

3. Click and draw to create an automation curve.

4. Release the mouse button.
At the moment of release, a final automation event is created. The auto-
mation curve is written from this last break-point through to the end of 
the project.

You will find this works the same for all the other Fill op-
tions. For more information on what you can do with Fill 
and the other automation performance utilities, see “Auto-
mation performance utilities” on page 222. 

Using the various modes of the Line tool to draw 
automation curves

The Line tool can be very useful for drawing automation 
events. The various modes are accessed by selecting the 
Line tool on the toolbar, clicking on it a second time and 
selecting from the pop-up menu that appears.

• Clicking and dragging with the Line tool in Line mode 
shows a line in the automation track and creates automa-
tion events aligned with this line.
This is a quick way to create linear fades, etc.

• The Line tool in Parabola mode works in the same way, 
but aligns the automation events with a parabolic curve in-
stead, resulting in more “natural” curves and fades.
Note that the result depends on the direction from which you draw the 
parabolic curve.

• The Sine, Triangle and Square Line tool modes create 
automation events aligned with continuous curves.
If snap is activated and set to Grid, the period of the curve (the length of 
one curve “cycle”) is determined by the grid setting. If you press [Shift] 
and drag, you can set the period length manually, in multiples of the grid 
value.
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Selecting automation events

• To select a single automation break-point, click on it 
with the Arrow tool.
The break-point turns red, and you can drag it in any horizontal or vertical 
direction between two points.

• To select multiple break-points, you can either [Shift]-
click or drag a selection rectangle with the Arrow tool.
All break-points inside the selection rectangle will be selected.

Drawing a selection rectangle around break-points to select them.

• To select all automation events on an automation track, 
right-click the automation track in the Track list and 
choose “Select All Events” from the context menu.

Removing automation events

There are several ways to remove break-points:

• By selecting points and pressing [Backspace] or [De-
lete] or selecting Delete from the Edit menu, or by clicking 
on a break-point with the Eraser tool.
This will remove the break-points. The curve is redrawn to connect the 
break-points immediately to the left and right of the removed points.

• By selecting a range (with the Range Selection tool), 
and pressing [Backspace] or [Delete] or selecting Delete 
from the Edit menu.
When “Use Virgin Territory” is enabled, this will create a gap. When “Use 
Virgin Territory” is disabled, this will remove the break-points within the 
range, but the curve will be redrawn to connect new break-points at the 
start and end of the selected range. See also “Gaps” on page 218.

• By clicking in the parameter display on an automation 
track and selecting “Remove Parameter” from the pop-up.
This will remove all automation events from the automation track, and the 
automation track will be closed.

Editing automation events

Automation events can be edited much like other events. 
You can use cut, copy and paste, you can group and 
nudge events etc. There are, however, four items on the 
Edit menu that are not applicable to automation events. 
These are:

• Split at Cursor
• Split Loop
• Move to Front
• Move to Back

Editing automation events in the Project 
Browser
You can also edit automation events in the Project 
Browser. Proceed as follows:

1. Open the Project Browser by selecting it from the 
Project menu.
The Browser window opens. The window is divided into two sections, 
the Structure list to the left and the event display to the right.

2. Click on the “+” sign for a track in the structure list.
Automated tracks have two subitems: Track Data and Automation. The 
Automation item corresponds to the automation track in the Project win-
dow, and contains the track’s automation events.

3. Click on the “+” sign for the Automation item.
All automated parameters for the track are shown in the structure list. 

4. Clicking on a parameter in the structure list brings up 
the automation events in the event display.

The following parameters are available for all automation 
tracks:

Parameter Description

Position The position of the automation event.

Value The value of the automation event. 
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Background
Audio processing in Nuendo can be called “non-destruc-
tive”, in the sense that you can always undo changes or 
revert to the original versions. This is possible because 
processing affects audio clips rather than the actual audio 
files, and because audio clips can refer to more than one 
audio file. This is how it works:

1. If you process an event or a selection range, a new au-
dio file is created in the Edits folder, within your project 
folder. 
This new file contains the processed audio, while the original file is unaf-
fected. 

2. The processed section of the audio clip (the section 
corresponding to the event or selection range) then refers 
to the new, processed audio file.
The other sections of the clip will still refer to the original file.

• Since all edits are available as separate files, it is possi-
ble to undo any processing, at any point and in any order!
This is done in the Offline Process History dialog, see “The Offline Pro-
cess History dialog” on page 251.

• Furthermore, the original, unprocessed audio file can 
still be used by other clips in the project, by other projects 
or by other applications.

Audio processing
Basically, you apply processing by making a selection and 
selecting a function from the Process submenu on the Au-
dio menu. Processing is applied according to the follow-
ing rules:

• Selecting events in the Project window or the Audio 
Part Editor will apply processing to the selected events 
only.
Processing will only affect the clip sections that are referenced by the 
events.

• Selecting an audio clip in the Pool will apply processing 
to the whole clip.

• Making a selection range will apply processing to the 
selected range only.
Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy 
(i.e. the event refers to a clip that is used by other events in 
the project), you are asked whether you want to create a 
new version of the clip or not.

Select “New Version” if you want the processing to affect the selected 
event only. Select “Continue” if you want the processing to affect all 
shared copies. 

If you activate “Do not show this message again”, any 
further processing you do will conform to the selected 
method (“Continue” or ”New Version”). 
You can change this setting at any time by using the “On Processing 
Shared Clips” pop-up in the Preferences (Editing–Audio page).

After processing the event the clip will refer both to the original file and 
a new file, containing the processed section only.

This event plays a section of this clip…

…which refers to this audio file.
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Common settings and features
If there are any settings for the selected Audio processing 
function, these will appear when you select the function 
from the Process submenu. While most settings are spe-
cific for the function, some features and settings work in 
the same way for several functions:

The “More…” button

If the dialog has a lot of settings, some options may be 
hidden when the dialog appears. To reveal these, click the 
“More…” button.

To hide the settings, click the button again (now labeled 
“Less…”).

The Preview, Process and Cancel buttons

These buttons have the following functionality:

Pre/Post-CrossFade

Some processing functions allow you to gradually mix the 
effect in or out. This is done with the Pre/Post-CrossFade 
parameters. If you activate Pre-CrossFade and specify a 
value of e.g. 1000 ms, the processing will be applied grad-
ually from the start of selection, reaching full effect 1000 ms 
after the start. Similarly, if you activate Post-CrossFade, the 
processing will gradually be removed, starting at the speci-
fied interval before the end of the selection.

Acoustic Stamp

The Acoustic Stamp function is a convolution tool, which 
allows you to apply room characteristics (reverb) to the 
audio. This is done by processing the audio signal accord-
ing to an impulse response – generally a stereo or mono 
recording of a very short signal (the impulse) in a room or 
other location. As a result, the processed audio will sound 
as if it were played in the same location.

The dialog contains the following settings:

Impulse and Envelope display

This display shows the loaded impulse response (in white) 
and the Envelope (in red). You can zoom in vertically on 
the impulse response using the slider to the right of the 
display (this can be useful since impulse responses typi-
cally are very weak). Zooming does not affect the pro-
cessing in any way.

Button Description

Preview Allows you to listen to the result of the processing with 
the current settings. Playback will continue repeatedly 
until you click the button again (the button is labeled 
“Stop” during Preview playback). You can make adjust-
ments during Preview playback, but the changes are not 
applied until the start of the next “lap”. Some changes 
may automatically restart the Preview playback from the 
beginning.

Process Performs the processing and closes the dialog.

Cancel Closes the dialog without processing.

! The sum of the Pre- and Post-CrossFade times can-
not be larger than the length of the selection.

! This function requires a lot of processing power, es-
pecially when using the Preview function. If you are 
working with long impulse response files or stereo 
files, you may find that Preview playback stutters or 
stops. In that case, it’s better to process the material, 
listen to the result and modify it in the Offline Pro-
cess History (see “The Offline Process History dia-
log” on page 251) if necessary.
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Load Impulse button

Clicking the “Load Impulse” button allows you to load an 
impulse response file from disk. These are ordinary wave 
or aiff audio files, with a maximum duration of 12 seconds. 
The name of the currently loaded impulse response file is 
shown above the display.

• A number of demonstration impulse response files are 
included in the Nuendo program folder. 
For proper use of the Acoustic Stamp function, we recommend that you 
acquire files from a professional impulse response library.

Play Impulse button

Plays back the currently loaded impulse response.

Channel selector

If the currently loaded impulse response is a stereo file, 
this pop-up menu allows you to select whether the left 
channel, right channel or both (stereo) should be used for 
the convolution process.

Envelope controls

The five sliders below the display are used for setting up 
the “reverb envelope”, that is, a gain curve modifying how 
the impulse response is applied over time, and thereby the 
reverb character. These settings are reflected in the red 
Envelope display above. The sliders have the following 
functionality:

Filter controls

The three sliders to the right allow you to tailor the tonal 
character of the processed sound. In essence, this is a 
graphic equalizer with three broad bands: the LPF slider 
governs the low frequency content, the BPF governs the 
midrange and the HPF governs the high frequency content.

• Setting a slider to 100% means that the corresponding 
filter is “fully open”.
When all three sliders are set to 100%, the processed audio is not fil-
tered at all.

Reset button

Sets all parameters in the upper section of the dialog to 
their default values.

Wet/Dry Mix

These two sliders allow you to specify the balance be-
tween wet (processed) and dry (original) signal in the re-
sulting clip.

Normally the two sliders are “reverse-ganged”, so that 
raising the Wet mix slider lowers the Dry mix slider by the 
same amount. However, if you press [Alt]/[Option] and 
drag a slider, you can move it independently. This allows 
you to set e.g. 80% dry and 80% wet signal. Be careful to 
avoid distortion.

Tail

This parameter allows you to “add space” after the original 
audio section, to avoid that the reverb tail is cut off. When 
the checkbox is activated, you can specify a tail length us-
ing the slider. The tail time is included when playing back 
with the Preview function, allowing you to find the appro-
priate tail length. A good value would be the Reverb 
Length value, displayed in ms to the right of the Reverb 
Length parameter.

Pre and Post-CrossFade

See “Pre/Post-CrossFade” on page 240.

Parameter Description

First Reflections A level control for the first section of the reverb (the 
length of which is set with the next parameter, see be-
low). Usually, this governs the volume of the first reflec-
tion(s) of the reverb.

First Ref. Length This determines the length of the First Reflections sec-
tion (the level of which is controlled by the previous pa-
rameter). Usually you would want to set this so that it 
includes the first reflection in the impulse response (nor-
mally about 5% of the total length).

Reverb Att. A level control for the end section of the reverb (the sec-
tion after the First Reflections, see above).

Reverb Length Governs the reverb time, in milliseconds.

Gain Allows you to adjust the gain of the impulse response. 
This may be necessary for optimal results, since different 
impulse response files may be recorded at different lev-
els.
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Envelope

The Envelope function allows you to apply a volume enve-
lope to the selected audio. The dialog contains the follow-
ing settings:

Curve Kind buttons

These determine whether the envelope curve should con-
sist of spline curve segments (left button), damped spline 
segments (middle button) or linear segments (right button).

Fade display

Shows the shape of the envelope curve. The resulting 
waveform shape is shown in dark gray, with the current 
waveform shape in light gray. You can click on the curve 
to add points, and click and drag existing points to change 
the shape. To remove a point from the curve, drag it out-
side the display.

Presets

If you have set up an envelope curve that you may want to 
apply to other events or clips, you can store it as a preset 
by clicking the Store button. 

• To apply a stored preset, select it from the pop-up 
menu. 

• To rename the selected preset, double-click on the 
name and enter a new one in the dialog that appears. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

Fade In and Fade Out
For a description of these functions, see the chapter 
“Fades, crossfades and envelopes” on page 86.

Gain

Allows you to change the gain (level) of the selected audio. 
The dialog contains the following settings:

Gain

This is where you set the desired gain, between -50 and 
+20dB. The setting is also indicated below the Gain dis-
play as a percentage.

Clipping detection text

If you use the Preview function before applying the pro-
cessing, the text below the slider indicates whether the 
current settings result in clipping (audio levels above 
0dB). If that is the case, lower the Gain value and use the 
Preview function again.

• If you want to increase the level of the audio as much as 
possible without causing clipping, you should use the Nor-
malize function instead (see “Normalize” on page 244).

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 240.
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Merge Clipboard

This functions mixes the audio from the clipboard into the 
audio selected for processing, starting at the beginning of 
the selection.

The dialog contains the following settings:

Sources mix

Allows you to specify a mix ratio between the original (the 
audio selected for processing) and the copy (the audio on 
the clipboard).

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 240.

Noise Gate

Scans the audio for sections weaker than a specified 
threshold level and replaces them with silence. The dialog 
contains the following settings:

Threshold

The level below which you want audio to be silenced. 
Levels below this value will close the gate.

Attack Time

The time it takes for the gate to open fully after the audio 
level has exceeded the threshold level.

Min. Opening Time

This is the shortest time the gate will remain open. If you 
find that the gate opens and closes too often when pro-
cessing material that varies rapidly in level, you should try 
raising this value.

Release Time

The time it takes for the gate to close fully after the audio 
level has dropped below the threshold level.

Linked Channels

This is available for stereo audio only. When it is activated, 
the Noise Gate is opened for both channels as soon as 
one or both channels exceed the Threshold level. When 
Linked Channels is deactivated, the Noise Gate works in-
dependently for the left and right channel.

Dry/Wet mix

Allows you to specify a mix ratio between “dry” and pro-
cessed sound.

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 240.

! For this function to be available, you need to have cut 
or copied a range of audio in the Sample Editor first.
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Normalize

The Normalize function allows you to specify the desired 
maximum level of the audio. It then analyzes the selected 
audio and finds the current maximum level. Finally it sub-
tracts the current maximum level from the specified level 
and raises the gain of the audio by the resulting amount (if 
the specified maximum level is lower than the current max-
imum, the gain will be lowered instead). A common use for 
Normalizing is to raise the level of audio that was recorded 
at too low an input level. The dialog contains the following 
settings:

Maximum

The desired maximum level for the audio, between -50 and 
0dB. The setting is also indicated below the Gain display as 
a percentage.

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 240.

Phase Reverse
Reverses the phase of the selected audio, turning the 
waveform “upside down”. The dialog contains the follow-
ing settings:

Phase Reverse on

When processing stereo audio, this pop-up menu allows 
you to specify which channel(s) should be phase-reversed.

Pre- and Post-CrossFade

See “Pre/Post-CrossFade” on page 240.

Pitch Shift

This function allows you to change the pitch of the audio 
with or without affecting its length. You can also create 
“harmonies” by specifying several pitches or apply pitch 
shift based on a user specified envelope curve.

When the “Transpose” tab is selected, the dialog contains 
the following parameters:

Keyboard display

This offers a way to specify the transpose interval in semi-
tones and gives a graphic overview of the transposition 
setting.

• The “root note” is indicated in red.
This has nothing to do with the actual key or pitch of the original audio, it 
just provides a way to display transpose intervals. If you like, you can 
change the root note by using the settings in the Pitch Shift Base sec-
tion, or by pressing [Alt]/[Option] and clicking in the keyboard display.

• To specify a transpose interval, click on one of the keys.
The key is indicated in blue, and the program plays test tones in the base 
pitch and transpose pitch to give you an audible confirmation.

• If “Multi Shift” is activated (see below), you can click on 
several keys to create “chords”.
Clicking on a blue (activated) key removes it.

Pitch Shift settings

The “Semitones” and “Fine tune” settings allow you to 
specify the amount of pitch shift. You can transpose the 
audio ±16 semitones, and fine tune it by ±200 cents 
(hundredths of semitones).
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Volume/Amplitude

Allows you to lower the volume of the pitch-shifted sound.

Multi Shift

When this is activated, you can add more than one trans-
pose value, creating multi-part harmonies. This is done by 
adding intervals in the keyboard display (see above). Note 
that you cannot use the Preview function in Multi Shift 
mode.

• If the intervals you add make up a standard chord, this 
chord is displayed to the right.
Note however, that to include the base pitch (the original, untransposed 
sound) in the processed result, you need to click the base key in the key-
board display as well, so that it is displayed in blue.

Listen Key/Chord button

Clicking this button plays a test tone pitched according to 
the activated interval key on the keyboard display. If “Multi 
Shift” is activated, this button is called “Listen Chord” and 
plays all activated intervals as a chord.

Pitch Shift Base

This allows you to set the root note (the red key in the key-
board display). It has nothing to do with the actual pitch, 
but is an aid for setting up intervals and chords.

Pitch Shift Mode

This is where you can make settings for the MPEX 3 algo-
rithm.

You can choose between 7 quality settings: 

Formant Mode 

If you are processing vocal material, you should activate 
this option in order to preserve the vocal characteristics of 
the pitch-shifted audio and to avoid a a “chipmunk voice” 
effect.

Time Correction

When this is activated, the pitch shift process will not af-
fect the length of the audio. When this is deactivated, rais-
ing the pitch will shorten the audio section and vice versa, 
much like changing the playback speed on a tape re-
corder.

Using envelope based Pitch Shift

When the “Envelope” tab is selected, you can specify an 
envelope curve on which the pitch shift should be based. 
This allows you to create pitch bend effects, pitch-shift 
different sections of the audio by different amounts, etc.

Option Description

Preview This mode should only be used for preview.

Mix Fast This mode is a very fast mode for preview. This works 
best with composite music signals mono or stereo mate-
rial.

Solo Fast Use this mode for single instruments (monophonic mate-
rial) and voice.

Solo Musical Same as above but higher quality.

Poly Fast Use this for processing monophonic and polyphonic ma-
terial. This is the fastest setting that gives still very good 
results. You can use this for drum loops, mixes, chords.

Poly Musical Use this for processing monophonic and polyphonic ma-
terial. This is the recommended MPEX default quality set-
ting. You can use this for drum loops, mixes, chords.

Poly Complex This high quality setting is quite processor intense and 
should be used only when processing difficult material or 
for stretch factors above 1,3.

Option Description



Audio processing and functions — 246

Envelope display

Shows the shape of the envelope curve over the wave-
form image of the audio selected for processing. Envelope 
curve points above the center line indicate positive pitch 
shift, while curve points below the center line indicate 
negative pitch shift. Initially, the envelope curve will be a 
horizontal, centered line, indicating zero pitch shift.

• You can click on the curve to add points, and click and 
drag existing points to change the shape. To remove a 
point from the curve, drag it outside the display.

Curve Kind

These buttons determine whether the envelope curve 
should consist of spline curve segments (left button), 
damped spline segments (middle button) or linear seg-
ments (right button).

Spline curve segment envelope.

The same envelope with damped spline segments selected.

The same envelope with linear segments selected.

Range

This parameter determines the vertical pitch range of the 
envelope. If set to “4”, moving a curve point to the top of 
the display corresponds to pitch shifting by + 4 semi-
tones. The maximum range is +/- 16 semitones. 

Transpose and Fine Tune

These parameters allow you to adjust the value of a curve 
point numerically:

1. Click on a curve point to select it.
The selected point is shown in red.

2. Adjust the Transpose and Fine Tune parameters to 
change the pitch of the curve point in semitones and 
cents, respectively.

Pitch Shift Mode

These are the same parameters as on the Transpose tab, 
see “Pitch Shift Mode” on page 245.

Example

Let’s say that you wish to create a pitch bend effect, so 
that the pitch is raised linearly by exactly 2 semitones in a 
specific part of the selected audio.

1. Remove all curve points by clicking the Reset button.

2. Select a linear curve by clicking the Curve Kind button 
to the right.

3. Make sure the Range parameter is set to 2 semitones 
or higher.

4. Create a point where you want the pitch bend to start 
by clicking on the envelope line.
Since this is the starting point for the pitch bend, you want its pitch to be 
zero (the envelope line should still be straight). If necessary, use the Fine 
Tune parameter to set the curve point to 0 cents, because this point gov-
erns the start point, where you want the pitch transition to begin.

5. Create a new curve point at the horizontal position 
where you want the pitch bend to reach the full value.
This curve point determines the rise time of the pitch bend effect, i.e. the 
further away from the starting point the new point is positioned, the 
longer it will take for the pitch bend to reach the full value, and vice versa.

6. With the second point still selected, use the Trans-
pose and Fine Tune parameters to set the pitch to exactly 
2 semitones.
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7. Create a new curve point to set the duration of the 
pitch bend, i.e. the time the pitch should remain trans-
posed by 2 semitones.

8. Finally, create a point where you want the pitch bend 
to end.
You don’t need to create a new point if you are at the end of the audio 
file, since there is always an end point at the right side of the waveform 
display.

9. If necessary, make additional settings in the Pitch Shift 
Mode section, see “Pitch Shift Mode” on page 245.

10. Click Process.
The pitch bend is applied according to the specified settings.

Remove DC Offset
This function will remove any DC offset in the audio selec-
tion. A DC offset is when there is too large a DC (direct 
current) component in the signal, sometimes visible as the 
signal not being visually centered around the “zero level 
axis”. DC offsets do not affect what you actually hear, but 
they affect zero crossing detection and certain process-
ing, and it is recommended that you remove them.

There are no parameters for this function. Note that you can 
check for DC Offset in an audio clip using the Statistics 
function (see “Statistics” on page 256).

Resample

The Resample function can be used for changing the 
length, tempo and pitch of an event.

The original sample rate of the event is listed in the dialog. 
Resample the event to a higher or lower sample rate by ei-
ther specifying a sample rate or by specifying the differ-
ence (as a percentage value) between the original sample 
rate and the desired new one.

• Resampling to a higher sample rate will make the event 
longer and cause the audio to play back at a slower speed 
with a lower pitch.

• Resampling to a lower sample rate will make the event 
shorter and cause the audio to play back at a faster speed 
with a higher pitch.

• You can audition the result of the resampling by enter-
ing the desired value and clicking “Preview”.
The event will then be played back as it will sound after the resampling.

• When you are satisfied with the preview result, click 
“Process” to close the dialog and apply the processing.

Reverse
Reverses the audio selection, as when playing a tape 
backwards. There are no parameters for this function.

Silence
Replaces the selection with silence. There are no parame-
ters for this function.

! It is recommended that this function is applied to 
complete audio clips, since the DC offset (if any) is 
normally present throughout the entire recording.
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Stereo Flip

This function works with stereo audio selections only. It al-
lows you to manipulate the left and right channel in various 
ways. The dialog contains the following parameters:

Mode

 

This pop-up menu determines what the function does:

Time Stretch

This function allows you to change the length and “tempo” 
of the selected audio without affecting the pitch. The dia-
log contains the following parameters:

Define Bars section

In this section you set the length of the selected audio and 
the time signature:

Original Length section

This section contains information and settings regarding 
the audio selected for processing:

Option Description

Flip Left-Right Swaps the left and right channel.

Left to Stereo Copies the left channel sound to the right channel.

Right to Stereo Copies the right channel sound to the left channel.

Merge Merges both channels on each side for mono sound.

Subtract Subtracts the left channel information from the right and 
vice versa. This is typically used as a “Karaoke effect”, for 
removing centered mono material from a stereo signal.

Parameter Description

Bars If you use the tempo setting (see below), you can specify 
the length of the selected audio here, in bars.

Beats If you use the tempo setting, you can specify the length of 
the selected audio here, in beats.

Sign. If you use the tempo setting, you can specify the time sig-
nature here.

Parameter Description

Length in 
Samples

The length of the selected audio, in samples.

Length in 
Seconds

The length of the selected audio, in seconds.

Tempo in BPM If you are processing music, and know the actual tempo 
of the audio, you can enter it here as beats per minute. 
This makes it possible to time-stretch the audio to an-
other tempo, without having to compute the actual time 
stretch amount.
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Resulting Length section

These settings are used if you want to stretch the audio to 
fit within a specific time span or tempo. The values will 
change automatically if you adjust the Time Stretch Ratio 
(see below).

Seconds Range section

These settings allow you to set the desired range for the 
time stretch.

Time Stretch Ratio section

The Time Stretch Ratio determines the amount of time 
stretch as a percentage of the original length. If you use 
the settings in the Resulting Length section to specify the 
amount of time stretch, this value will change automati-
cally. The possible range depends on the “Effect” option:

• If the “Effect” checkbox is deactivated, the range is 75-
125%.
This is the preferred mode if you want to preserve the character of the 
sound.

• If the “Effect” checkbox is activated, you can specify val-
ues between 10 and 1000% (Realtime), or 50 and 200% 
(MPEX 3). 
This mode is mainly useful for special effects, etc.

Algorithm section

Allows you to select a time stretch algorithm: MPEX 3 and 
Realtime mode. 

• MPEX 3 mode
This mode is based on Prosoniq's proprietary MPEX (Minimum Per-
ceived Loss Time Compression/Expansion) algorithm. This algorithm 
(which is also used in Prosoniq’s TimeFactory™ application) uses an arti-
ficial neural network for time series prediction in the scale space domain 
to achieve high end time and pitch scaling. This gives the best possible 
audio quality result. You can choose between 7 quality settings, see 
“Pitch Shift Mode” on page 245.

• Realtime mode
This is the algorithm used for the realtime time stretching features in Nu-
endo. Although this algorithm is optimized for time stretching in realtime, 
you can use it for offline processing as well. The Presets pop-up con-
tains the same presets as found in the Algorithm pop-up in the Sample 
Editor, see “Determining the audio tempo automatically and time-stretch-
ing your audio” on page 272.

Applying plug-ins
You can add plug-in effects in real-time during playback 
(see the chapter “Audio effects” on page 168). However, 
sometimes it’s useful to “permanently” apply effects to 
one or several selected events. This is done in the follow-
ing way:

1. Make a selection in the Project window, the Pool or an 
editor.
Effects are applied according to the same rules as Processing (see 
“Common settings and features” on page 240).

2. Select “Plug-ins” from the Audio menu.

3. Select the desired effect from the submenu that ap-
pears.
The Process Plug-in dialog appears.

About stereo and mono

If you are applying an effect to mono audio material, only 
the left side of the effect’s stereo output will be applied.

Parameter Description

Samples The desired length in samples.

Seconds The desired length in seconds.

BPM The desired tempo (beats per minute). For this to work, 
you have to know the actual tempo of the audio, and 
specify this (along with time signature and length in bars) 
in the Original Length section to the left.

Parameter Description

Range Allows you to specify the desired length as a range be-
tween two time positions.

Use Locators Clicking the diamond-shaped button below the Range 
fields sets the Range values to the left and right Locator 
positions, respectively.
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The process plug-in dialog

The process plug-in dialog for the StudioChorus effect.

The upper section of the process plug-in dialog contains 
the actual effect parameters of the selected plug-in. For 
details on the parameters of the included plug-ins, see the 
separate manual “Nuendo Expansion Kit – Cubase Music 
Tools for Nuendo 4”.

The lower section of the dialog contains settings for the 
actual processing. These are common to all plug-ins.

• If the lower section is hidden, click the “More…” button 
to display it.
Clicking the button again (now labeled “Less…”) will hide the lower sec-
tion.

The following settings and functions are available in the 
common, lower section of the dialog:

Wet mix/Dry mix

These two sliders allow you to specify the balance be-
tween wet (processed) and dry (original) signal in the re-
sulting clip. 

Normally the two sliders are “reverse-ganged”, so that 
raising the Wet mix slider lowers the Dry mix slider by the 
same amount. However, if you press [Alt]/[Option] and 
drag a slider, you can move it independently. This allows 
you to set e.g. 80% dry and 80% wet signal. Be careful to 
avoid distortion.

Tail

This parameter is useful if you are applying an effect that 
adds material after the end of original audio (such as re-
verb and delay effects). When the checkbox is activated, 
you can specify a tail length using the slider. The tail time 
is included when playing back with the Preview function, 
allowing you to find the appropriate tail length.

Pre/Post-CrossFade

These settings allow you to gradually mix the effect in or 
out. If you activate Pre-CrossFade and specify a value of 
e.g. 1000 ms, the effect will be applied gradually from the 
start of selection, reaching full effect 1000 ms after the 
start. Similarly, if you activate Post-CrossFade, the pro-
cessing will gradually be removed starting at the specified 
interval before the end of the selection.

Preview button

Allows you to listen to the result of the processing with the 
current settings. Playback will continue repeatedly until 
you click the button again (the button is labeled “Stop” 
during Preview playback). You can change the effect set-
tings during Preview playback if needed.

Process button

Applies the effect and closes the dialog.

Cancel button

Closes the dialog without applying the effect.

! The sum of the Pre- and Post-CrossFade times can-
not be larger than the length of the selection.
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The Offline Process History dialog

Procedures
If you want to remove some or all processing from a clip, 
this can be done in the Offline Process History dialog. 
Processing that can be modified in the Offline Process 
History dialog includes the functions on the Process 
menu, any applied plug-in effects, and Sample Editor op-
erations such as Cut, Paste, Delete and drawing with the 
Pencil tool.

Due to the clip-file relationship (see “Background” on 
page 239), it is even possible to modify or remove some 
processing “in the middle” of the Process History, while 
keeping later processing! This feature depends on the type 
of processing performed (see “Restrictions” on page 251).

Proceed as follows:

1. Select the clip in the Pool or one of its events in the 
Project window.
You can see which clips have been processed by checking the Status 
column in the Pool – the waveform symbol indicates that processing or 
effects have been applied to the clip (see “About the Status column sym-
bols” on page 299).

2. Select “Offline Process History…” from the Audio 
menu.
The Offline Process History dialog appears.

The left part of the dialog contains a list of all processing 
you have added to the clip, with the most recent opera-
tions at the bottom of the list. The “Start” and “Length” 
columns indicate which section of the clip was affected by 
each operation. The “Status” column indicates if the oper-
ation can be modified or undone.

3. Locate the operation you want to edit and select it by 
clicking on it in the list.

• To modify the settings of the selected processing, click 
the “Modify” button.
This opens the dialog for the processing function or applied effect, allow-
ing you to change the settings. This works just as when you applied the 
processing or effect the first time.

• To replace the selected operation with another pro-
cessing function or effect, select the desired function from 
the pop-up menu and click the “Replace By” button.
If the selected function has settings, a dialog will appear as usual. The 
original operation will then be removed and the new processing will be 
inserted in the Offline Process History.

• To remove the selected operation, click the “Remove” 
button.
The processing is removed from the clip.

• To undo the selected operation and remove the pro-
cessing from the clip click the “Deactivate” button.
The processing is removed from the clip, but the operation remains in the 
list. To redo the operation and apply the processing again, click the but-
ton, now renamed to “Activate”, again.

• To save the list of processing operations as a Batch 
Process, click the “Save As Batch” button.
See “Batch Processing” on page 252.

4. Click “Close” to close the dialog.

Restrictions
• If there are no settings for the processing function, you 
cannot modify it.

• If you have applied processing that changes the length 
of the clip (such as Cut, Insert or Time Stretch), you can 
only remove this if it is the most recent processing in the 
Offline Process History (at the bottom of the list in the di-
alog). If an operation cannot be removed or modified, this 
is indicated by an icon in the “Status” column. Also, the 
corresponding buttons will be grayed out.

• The list must contain at least two processing operations 
in order to be saved as a Batch Process (see “Batch Pro-
cessing” on page 252.
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Batch Processing
Nuendo features a Batch Processing function that lets you 
apply a chain of audio processing to one or several events 
in one go – in either the Project window or the Pool. Batch 
Processing is based on operations in the Offline Process 
History dialog, described above. That is, the list of applied 
processes in this dialog is what can be made to constitute 
a batch process.

Batch Processing is therefore a convenient way to apply 
the same effects with the same settings to several audio 
events in a project.

It can also be used to “store” effect settings for future use. 
You may for example have performed a series of elaborate 
audio processing with a good result, and want to retain 
the particular combination and settings of effects you ap-
plied, so that you may quickly and easily apply them again 
to other events in the future.

To set up a batch process, proceed as follows:

1. Apply the desired processing to an audio event or se-
lection range in the project.
Note that you must apply at least two audio processes to be able to set 
up a batch process.

From here, there are two ways to go:

2. Pull down the Audio menu, and from the Batch Pro-
cesses submenu, select “Create from Process History…”.

3. In the dialog that appears, type in a name for the batch 
process, and click OK.

or…

4. Pull down the Audio menu and select “Offline Process 
History”.
The Offline Process History dialog opens. In this dialog you can modify 
settings or remove operations as desired (see “The Offline Process His-
tory dialog” on page 251).

5. In the Process History Dialog, click “Save As Batch”, 
and then type in a name for the batch process in the dia-
log that appears and click OK.

Regardless of which of the above two methods you use, 
the batch process is now saved and available for use:

6. In the Project window, select all the audio events you 
want to process.
You can also make a selection range that spans multiple tracks and 
batch process the selection for all the audio events.

7. Pull down the Audio menu and open the Batch Pro-
cesses submenu.
At the top of the menu you can now find the name of the batch process 
you created. The menu will list the names of any batch processes you 
create, until you delete them (see below).

8. Select the batch process you want to apply from the 
menu.
All the selected events will now be processed accordingly.

Note that even if you clear the Offline Process History 
dialog of all the operations that make up a batch process, 
this will not affect the saved batch process. It will still con-
tain and perform the operations on which it was based 
when created.



253 — Audio processing and functions

Managing Batch Processes
You can delete and rename created batch processes in 
the Manage Batch Processes dialog.

• Open the Audio menu and select “Manage…” from the 
Batch Processes submenu to open the Manage Batch 
Processes dialog.
The created batch processes are listed in the left column, and the oper-
ations each batch process contains are listed in the right column.

• To remove a batch process, just select it in the list and 
click “Delete”.

• To change the name of a batch process, select it in the 
list and click “Rename” and enter the new name.

Freeze Edits
The Freeze Edits function on the Audio menu allows you 
to make all processing and applied effects permanent for 
a clip:

1. Select the clip in the Pool or one of its events in the 
Project window.

2. Select “Freeze Edits…” from the Audio menu.

• If there is only one edit version of the clip (no other clips 
refer to the same audio file), the following dialog will ap-
pear:

If you select “Replace”, all edits will be applied to the original audio file 
(the one listed in the clip’s Path column in the Pool). If you select “New 
File”, the Freeze Edits operation will create a new file in the Audio folder 
within the project folder (leaving the original audio file unaffected).

• If the selected clip (or the clip played by the selected 
event) has several edit versions (i.e. there are other clips 
referring to the same audio file), the following alert will ap-
pear:

As you can see, you don’t have the option to Replace the original audio 
file in this case. This is because that audio file is used by other clips. Se-
lect “New File” to have a new file created in the Audio folder within the 
project folder.

! After a Freeze Edits, the clip refers to a new, single 
audio file. If you open the Offline Process History di-
alog for the clip, the list will be empty.
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Detect Silence

The Detect Silence function on the Advanced submenu of 
the Audio menu searches for silent sections in an event 
and either splits the event, removing the silent parts from 
the project, or creates regions corresponding to the non-
silent sections. Proceed as follows:

1. Select the event in the Project window or the Audio 
Part Editor.
You can select several events if you like, in which case you will be al-
lowed to make separate settings for each selected event.

2. Select “Detect Silence” from the Advanced submenu 
of the Audio menu.
The Detect Silence dialog appears.

3. Adjust the settings in the Detection section to the left.
They have the following functionality:

4. Click the “Compute” button.
The audio event is analyzed, and the waveform display is redrawn to indi-
cate which sections will be considered “silent”, according to your set-
tings. Above the Compute Button the number of detected regions is 
displayed.

• If you activate the “auto” checkbox next to the Compute 
button, the audio event will be analyzed (and the display 
will be updated) automatically every time you change the 
settings in the Detection section of the dialog.
Please note that you should not activate this option when you are work-
ing with very long files, as this process might take some time.

Setting Description

Open
Threshold

When the audio level exceeds this value, the function will 
“open”, i.e. let the sound through.
Set this low enough to open when a sound starts, but 
high enough to remove unwanted noise during “silent” 
sections.

Close 
Threshold

When the audio level drops below this value, the function 
will “close”. This value cannot be higher than the Open 
Threshold value. 
Set this high enough to remove unwanted noise during 
“silent” sections.

Linked If this checkbox is ticked, Open and Close Threshold will 
have the same value.

min. time 
open

Determines the minimum time that the function will re-
main “open” after the audio level has exceeded the Open 
Threshold value.
If the audio contains repeated short sounds, and you find 
that this results in too many short “open” sections, try 
raising this value.

min. time 
closed

Determines the minimum time that the function will re-
main “closed” after the audio level has dropped below 
the Close Threshold value.
Usually you would want to set this to a low value, to avoid 
removing sounds.

Pre-Roll Allows you to have the function “open” slightly before the 
audio level exceeds the Open Threshold value. In other 
words, the start of each “open” section is moved to the 
left according to the time you set here.
This is useful to avoid removing the attack of sounds.

Post-Roll Allows you to have the function “close” slightly after the 
audio level drops below the Close Threshold value.
This is useful to avoid removing the natural decay of 
sounds.

Setting Description
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• You can use the Preview function to listen to the result.
The event is played back repeatedly in its entire length, but with the 
“closed” sections silenced.

5. Repeat steps 3 and 4 until you are satisfied with the 
result.

6. Select the desired result, by activating either the “Add 
as Regions” or the “Strip Silence” checkbox, or both.
“Add as Regions” will create regions according to the non-silent sec-
tions. “Strip Silence” will split the event at the start and end of each non-
silent section, and remove the silent sections in between.

7. If you activate “Add as Regions”, you can specify a 
name for the Regions in the Region Name field.
In addition to the name, the regions will be numbered, starting with the 
number specified in the Auto Number Start field.

8. Click “Process”.
The event is split and/or regions are added.

The result of the “Strip Silence” option.

• If you selected more than one event in step 1 above, you 
can activate the “process all” checkbox to apply the same 
settings to all selected events. If you don’t activate this, 
the dialog will appear again, allowing you to make sepa-
rate settings for each event.

The Spectrum Analyzer
This function analyzes the selected audio, computes the 
average “spectrum” (level distribution over the frequency 
range) and displays this as a two-dimensional graph, with 
frequency on the x-axis and level on the y-axis.

1. Make an audio selection (a clip, an event or a range se-
lection).

2. Select “Spectrum Analyzer” from the Audio menu.
A dialog with settings for the analysis appears.

The default values give good results in most situations, but 
you can adjust the settings if you like:

Setting Description

Size in Samples The function divides the audio into “analysis blocks”, the 
size of which is set here. The larger this value, the higher 
the frequency resolution of the resulting spectrum.

Size of Overlap The overlap between each analysis block.

Window used Allows you to select which window type should be used 
for the FFT (Fast Fourier Transform, the mathematical 
method used for computing the spectrum). 

Normalized 
Values

When this is activated, the resulting level values are 
scaled, so that the highest level is displayed as “1” 
(0dB).

From Stereo When analyzing stereo material, there is a pop-up menu 
with the following options:
Mono mix – the stereo signal is mixed to mono before an-
alyzing.
Mono left/right – the left or right channel signal is used 
for analysis.
Stereo – both channels are analyzed (two separate spec-
trums will be displayed).
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3. Click the “Process” button.
The spectrum is computed and displayed as a graph.

4. You can adjust the display with the settings in the dis-
play window:

5. If you move the mouse pointer over the graph, a 
crosshair cursor follows the graph curve and the display in 
the upper right corner shows the frequency/note and level 
at the current position.
To compare the level between two frequencies, move the pointer to one 
of the frequencies, right-click once and move the pointer to the second 
frequency. The delta value (the difference in level between the current 
position and the right-click position) is displayed in the upper right corner 
(labeled “D”).

• If you analyze stereo audio and selected the “Stereo” op-
tion in the first dialog, the graphs for the left and right chan-
nel are superimposed in the display, with the left channel 
graph in white and the right channel graph in yellow.
The display in the upper right corner shows the values for the left channel 
– to see the right channel values, hold down [Shift]. An “L” or “R” is dis-
played to indicate which channel values are shown.

6. You can leave the window open or close it by clicking 
the “Close” button.
If you leave it open and the “Active” checkbox is ticked, the result of the 
next Spectrum Analysis will be displayed in the same window.

Statistics

The Statistics function on the Audio menu analyzes the 
selected audio (events, clips or range selections) and dis-
plays a window with the following information:

Setting Description

dB When this is activated, the vertical axis shows dB values. 
When it is deactivated, values between 0 and 1 are 
shown.

Freq. log When this is activated, frequencies (on the horizontal 
axis) are displayed on a logarithmic scale. When it is de-
activated, the frequency axis is linear.

Precision Indicates the frequency resolution of the graph. This 
value cannot be changed here, but is governed by the 
Size in Samples setting in the previous dialog.

Frequency/
Note

Allows you to select whether you want the frequencies to 
be displayed in Hertz or with note names.

Min. Sets the lowest frequency shown in the graph.

Max. Sets the highest frequency shown in the graph. By ad-
justing the Min and Max values, you can take a closer look 
at a smaller frequency range.

Active When this is activated, the next Spectrum Analysis will 
appear in the same window. When deactivated, new 
Spectrum Analysis results will appear in separate win-
dows.

Item Description

Min. Sample 
Value

The lowest sample value in the selection, as a value be-
tween -1 and 1 and in dB.

Max. Sample 
Value

The highest sample value in the selection, as a value be-
tween -1 and 1 and in dB.

Peak Amplitude The largest sample value (in absolute numbers) in the se-
lection, in dB.

DC Offset The amount of DC Offset (see “Remove DC Offset” on 
page 247) in the selection, as a percentage and in dB.

Estimated 
Resolution

Even though an audio file is in 16 or 24 bits, it may have 
been converted from a lower resolution. The Estimated 
Resolution value makes an educated guess about the ac-
tual audio resolution, by computing the smallest level dif-
ference between two samples.
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Estimated Pitch The estimated pitch of the audio selection.

Sample Rate The sample rate of the audio selection.

Min. RMS 
Power

The lowest loudness (RMS) measured in the selection.

Max. RMS 
Power

The highest loudness (RMS) measured in the selection.

Average The average loudness over the whole selection.

Item Description
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Background
The Sample Editor allows you to view and manipulate au-
dio at the audio clip level, by cutting and pasting, removing 
or drawing audio data, processing or applying effects (see 
“Audio processing and functions” on page 238). This ed-
iting can be called “non-destructive”, in the sense that you 
can undo changes or revert to the original versions at any 
time, using the Offline Process History (see “The Offline 
Process History dialog” on page 251), and because the 
actual audio file (if created or imported from outside the 
project) will remain untouched.

The Sample Editor also contains most of the Audio Warp 
related functions, i.e. the realtime time-stretching and 
pitch-shifting functions in Nuendo. These are useful to e.g. 
tempo-match any audio loop to the project tempo (see 
“Audio Warp realtime processing / Tempo matching audio 
to the project tempo” on page 272).

Another special feature of the Sample Editor is hitpoint 
detection. Hitpoints allow you to create “slices”, that are 
useful, if you want to e.g. change the tempo without af-
fecting the pitch (see “Working with hitpoints and slices” 
on page 278).

Opening the Sample Editor
You open the Sample Editor by double-clicking an audio 
event in the Project window or the Audio Part Editor, or by 
double-clicking an audio clip in the Pool. You can have 
more than one Sample Editor open at the same time.

• Note that double-clicking an audio part in the Project 
window will open the Audio Part Editor, even if the part 
only contains a single audio event.
This is described in a separate chapter, see “The Audio Part Editor” on 
page 290.
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Window overview

The Elements menu

If you right-click in the Sample Editor to bring up the 
Quick menu, you will find a submenu called “Elements”. 
By activating or deactivating options on this submenu, you 
specify what is shown in the editor window. Some of 
these options are also available as icons on the toolbar.

The toolbar
The toolbar contains the tools…

… and information about the edited audio clip:

The Sample Editor tools Audition, Loop & 
Volume controls

Show 
regions

Autoscroll

Show Inspector Use SnapShow Au-
dio event

Global Transport statusAudio format and length

Realtime status

Selected display format 
(for info line and ruler)

Current selection range

Number of edits 
made to the clip

Zoom factor
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Initially, length and position values are displayed in the for-
mat specified in the Project Setup dialog. If you click in the 
middle field, a pop-up menu opens, where you can select 
another display format. This selection affects the Sample 
Editor ruler as well.

• You can customize the toolbar by right-clicking it and 
using the pop-up menu to hide or show items.

• Selecting Setup from the pop-up menu allows you to 
reorder sections on the toolbar, store presets, etc. See 
“The Setup dialogs” on page 506.

The Sample Editor Inspector
To the left of the Sample Editor, you will find the Sample 
Editor Inspector. It contains all the tools and functions for 
working in the Sample Editor. 

You open a tab by clicking on it. If you want to open an-
other tab without closing the first, [Ctrl]/[Command]-click 
on it. To open all tabs in the Inspector [Alt]/[Option]-click 
on any tab.

You can show/hide Inspector sections by right-click-
ing on an Inspector tab and activating/deactivating the de-
sired option(s).
Make sure you right-click on an inspector tab and not on the empty area 
below the Inspector, as this will open the Quick context menu instead.
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The Definition tab

The topmost tab of the Sample Editor Inspector is used to 
define the musical context of your audio. Here, you can de-
fine the grid, i.e. measure the audio tempo and the groove. 
Open this tab, if you want to use your audio in a musical 
context, so that you can later activate the Straighten Up 
mode, create a groove quantize map or slices.

The upper section of the Definition tab will help you to ad-
just the audio grid. You can select a grid resolution from 
the pop-up menu and adjust the grid manually by activat-
ing the Manual Adjust tool, or automatically by clicking the 
Auto Adjust button. When you click on the Auto Adjust 
button, the Manual Adjust tool will be activated, so that 
you can afterwards verify and change the grid manually, if 
necessary. The Preview mode should be activated (default 
setting) to use the grid for playback. Preview is linked to 
the Straighten Up mode and Quantize menu on the Play-
back tab. If you only want to create slices or quantize 
grooves, you can deactivate the Preview mode.

The lower section displays the length of your audio file in 
bars and beats (PPQ) together with the estimated tempo 
and the time signature. You should always verify if the 
length in bars corresponds to the audio file you imported. 
If necessary, listen to your audio and enter the correct bar 
length.

The Playback tab

In this tab, the audio grid and the tempo of the audio can 
be adjusted to the project grid by activating the Straighten 
Up mode.

From the algorithm pop-up, you can select an algorithm 
for the realtime time-stretching.

If you activate Straighten Up mode, the audio file will snap 
to the project grid. The Quantize pop-up lets you select a 
resolution for the audio, allowing you to specify how exact 
the quantization will be. When you select the “Bars” option, 
the audio will be synced to tempo without quantizing. The 
Swing fader lets you offset every second position in the grid 
creating a swing or shuffle feel.

In Free Warp mode you can manually change the rhythm 
of the audio. When this button is activated, you can drag 
beats to time positions in the grid. This is described in the 
section “Free Warp” on page 285.

When the Transpose track has been added to the project, 
or when the event root key is defined and the project root 
key is set, you can follow global transpose by activating the 
Follow Global mode (see “Realtime pitch-shifting of audio 
events” on page 288). Note that the Transpose function on 
the Playback tab is not available if you opened the Sample 
Editor by double-clicking on an event in the Pool.

If you click the Flatten button, the realtime warp processing 
will be applied to the clip, making the settings permanent 
(see “Flattening the realtime processing” on page 288).

! If you work with audio with triplet feeling, set the ba-
sic grid resolution to 1/8 or 1/16 and the signature 
to 12/8. Note that you should afterwards also set the 
time signature for the project to 12/8 (in the Trans-
port panel).

! Warp tabs will only be displayed in the waveform, if 
this tab is open.



263

The Sample Editor

The Hitpoints tab

In this tab, the transients, i.e. hitpoints of the audio can be 
marked. 

Adjust the sensitivity slider to determine how many hit-
points should be shown, and edit them with the Edit Hit-
points tool, if necessary. If you want to clear all hitpoints, 
e.g. to re-detect hitpoints, click the Remove All button.

Click the Slice & Close button, if you want to slice your 
audio to quantize the rhythm of the different slices sepa-
rately (see “Creating slices” on page 283).

Click the Make Groove button, if you want to create an au-
dio groove for quantizing other material to the groove of 
your audio (see “Creating groove quantize maps” on page 
283).

Click the Create Markers button, if you want to create mark-
ers for the hitpoints (see “Create Markers” on page 284).

Use the Create Regions button, if you want to create re-
gions, e.g. for further use in a sampler (see “Create Regi-
ons” on page 284).

Use the Create Events button, if you wish to create sepa-
rate events according to the hitpoints for a file (see “Create 
Events” on page 284).

Before you can use the Make Groove and the Slice & Close 
buttons, the tempo and the time signature of the audio must 
be defined (the Definition tab will light up in blue to indicate 
this). 

The Range tab

In this tab you will find some utility functions for working 
with ranges and selections (see “Making selections” on 
page 267).

The Process tab

This tab regroups the most important audio editing com-
mands from the Audio and the Edit menus. For further in-
formation on the Select Process and Select Plug-in pop-
up menus, see the chapter “Audio processing and func-
tions” on page 238.

The thumbnail display

The thumbnail display provides an overview of the whole 
clip. The section currently shown in the main waveform 
display of the Sample Editor is indicated by a blue rectan-
gle in the thumbnail, while the current selection range is 
shown in blue.

• You can move the blue rectangle in the thumbnail to 
view other sections of the clip.
Click in the lower half of the rectangle and drag to the left or right to 
move it.

• You can resize the blue rectangle (by dragging its left or 
right edge) to zoom in or out, horizontally.

• You can define a new viewing area by clicking in the up-
per half of the overview and dragging a rectangle with the 
mouse.

! Hitpoints will only be displayed in the waveform, if 
this tab is open.
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The ruler
The Sample Editor ruler is located between the thumbnail 
and the waveform display. It shows the timeline in the dis-
play format specified in the Project Setup dialog (see “The 
Project Setup dialog” on page 33). If you like, you can se-
lect an independent display format for the ruler by clicking 
on the arrow button to the right of it and selecting an op-
tion from the pop-up menu that appears (this affects the 
values in the info line too). For a list of the display format 
options, see “The ruler” on page 31.

The waveform display and the level scale

The waveform display shows the waveform image of the 
edited audio clip – in the style selected in the Preferences 
(Event Display–Audio page), see “Adjusting how parts 
and events are shown” on page 37. To the left of the 
waveform display, a level scale can be shown, indicating 
the amplitude of the audio.

• When the level scale is shown, you can select whether 
the level should be shown as a percentage or in dB.
This is done by right-clicking the level scale and selecting an option from 
the pop-up menu that appears. This also allows you to hide the level scale.

• To display the level scale after hiding it, right-click to 
bring up the Quick menu and activate “Level Scale” on the 
Elements submenu.

• This submenu also allows you to select whether you 
want the zero axis and/or the half level axis indicated in the 
waveform display.

Half 
level 
axis

Zero axis
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General Operations

Zooming
Zooming in the Sample Editor is done according to the 
standard zoom procedures, with the following special 
notes:

• The vertical zoom slider changes the vertical scale rela-
tive to the height of the editor window, in a way similar to 
the waveform zooming in the Project window (see “Zoom 
and view options” on page 34).
The vertical zoom will also be affected if the option “Zoom Tool Standard 
Mode” (Preferences on the Editing–Tools page) is deactivated and you 
drag a rectangle with the Zoom tool.

• The following options relevant to the Sample Editor are 
available on the Zoom submenu (on the Edit menu and the 
Quick context menu):

• You can also zoom by resizing the rectangle in the 
thumbnail display.
See “The thumbnail display” on page 263.

• The current zoom setting is shown in the info line, as a 
“samples per screen pixel” value.

• Note that you can zoom in horizontally to a scale with 
less than one sample per pixel! 
This is required for drawing with the Pencil tool (see “Drawing in the 
Sample Editor” on page 271).

• If you have zoomed in to one sample per pixel or less, 
the appearance of the samples depend on the option 
“Interpolate Audio Images” in the Preferences (Event Dis-
play–Audio page).
If the option is deactivated, single sample values are drawn as “steps”. If 
the option is activated, they are interpolated to “curves” form.

Auditioning
While you can use the regular play commands to play 
back audio when the Sample Editor is open, it is often 
useful to listen to the edited material only.

When auditioning, audio will be routed to the Control 
Room (if the Control Room is activated) or to the Main Mix 
(the default output bus). For information about routing, see 
the chapter “VST Connections: Setting up input and out-
put busses” on page 10.

You can adjust the auditioning level with the miniature 
level fader on the toolbar.

By using key commands

If you activate the “Playback Toggle triggers Local Pre-
view” option in the Preferences (Transport page), you can 
use the [Space] bar to audition. This is the same as click-
ing the Audition icon on the toolbar.

By using the Audition icon

Clicking the Audition icon on the toolbar plays back the 
edited audio, according to the following rules:

• If you have made a selection, this selection will be played 
back.

• If there is no selection, but the option “Show Event” is acti-
vated (see “Show audio event” on page 271), the section of 
the clip corresponding to the event will be played back.

• If there is no selection, and “Show Event” is deactivated, play-
back will start at the cursor position (if the cursor is outside 
the display, the whole clip will be played back).

• If the Loop icon is activated, playback will continue repeatedly 
until you deactivate the Audition icon. Otherwise, the section 
will be played back once.

Note that there is a separate Play button for audition-
ing regions. See “Auditioning regions” on page 270.

Option Description

Zoom In Zooms in one step, centering on the position cursor.

Zoom Out Zooms out one step, centering on the position cursor.

Zoom Full Zooms out so that the whole clip is visible in the editor.

Zoom to 
Selection

Zooms in so that the current selection fills the screen.

Zoom to 
Selection (Horiz.) 
(Edit menu only)

Zooms in horizontally so that the current selection fills 
the screen.

Zoom to Event 
(Edit menu only)

Zooms in so that the editor shows the section of the clip 
corresponding to the edited audio event. This is not 
available if you opened the Sample Editor from the Pool 
(in which case the whole clip is opened for editing, not 
an event).

Zoom In/Out 
Vertical (Edit 
menu only)

This is the same as using the vertical zoom slider (see 
above).
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By using the Speaker tool

If you click somewhere in the waveform display with the 
Speaker (“Play”) tool and keep the mouse button pressed, 
the clip will be played back from the position at which you 
clicked. Playback will continue until you release the mouse 
button.

Scrubbing

The Scrub tool allows you to locate positions in the audio 
by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse 
button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played 
back. The speed and pitch of the playback depends on how fast you 
move the pointer.

• You can adjust the response of the Scrub tool with the 
Scrub Response (Speed) setting in the Preferences 
(Transport–Scrub page).
There you will also find a separate Scrub Volume setting.

Adjusting the snap point
The snap point is a marker within an audio event (or clip, 
see below). This is used as a reference position when you 
are moving events with snap activated, so that the snap 
point is “magnetic” to whatever snap positions you have 
selected. 

By default, the snap point is set at the beginning of the au-
dio event, but often it is useful to move the snap point to a 
“relevant” position in the event, such as a downbeat, etc.

1. Activate the “Audio Event” option so that the event is 
displayed in the editor.

2. Scroll so that the event is visible, and locate the “S” 
flag in the event.
If you haven’t adjusted this previously, it will be located at the beginning 
of the event.

3. Click on the “S” flag and drag it to the desired position.
When you drag the snap point, a tool tip shows its current position (in 
the format selected on the Sample Editor ruler).

• If the Scrub tool is selected when you move the snap 
point, you will hear the audio while dragging (just like 
when scrubbing).
This makes it easier to find the correct position.
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You can also adjust the snap point by setting the project 
cursor:

1. Place the cursor at the desired position (intersecting 
the event).
You may want to do this by scrubbing, to spot the right position exactly.

2. Right-click to open the Quick menu and select “Snap 
Point To Cursor” from the Audio submenu.
The snap point will be set to the position of the cursor. This method can 
also be used in the Project window and the Audio Part Editor.

• It is also possible to define a snap point for a clip (for 
which there is no event yet).
To open a clip in the Sample Editor, double-click it in the Pool (or drag it 
from the Pool to the Sample Editor). After having set the snap point using 
the procedure described above, you can insert the clip into the project 
from the Pool or the Sample Editor, taking the snap point position into 
account.

Making selections
To select an audio section in the Sample Editor, you click 
and drag with the Range Selection tool.

• If Snap to Zero Crossing is activated on the toolbar, the 
start and end of the selection will always be at zero cross-
ings (see “Snap to Zero Crossing” on page 271).

• You can resize the selection by dragging its left and 
right edge or by [Shift]-clicking.

• The current selection is indicated in the corresponding 
fields in the Range tab of the Sample Editor Inspector.
You can fine-tune the selection by changing these values numerically. 
Note that the values are relative to the start of the clip, rather than to the 
project timeline.

Using the Select menu

In the Select menu in the Range tab and in the Select sub-
menu of the Edit menu you can find the following options:! When you set the Grid Start in the Definition tab, the 

snap point will be moved to the Grid Start (see “Ma-
nually adjusting grid and tempo of your audio” on 
page 275).

A selected range

Function Description

Select All Selects the whole clip.

Select None Selects no audio (the selection length is set to “0”).

Select in Loop Selects all audio between the left and right locator.

Select Event Selects the audio that is included in the edited event only. 
This is not available if you opened the Sample Editor from 
the Pool (in which case the whole clip is opened for edit-
ing, not an event).

Locators to Se-
lection (Range 
tab only)

Sets the locators to encompass the current selection. 
This is available if you have selected one or several 
events or made a selection range.

Locate Selec-
tion (Range tab 
only)

Moves the project cursor to the beginning or end of the 
current selection. For this to be available, you must have 
selected one or more events or parts, or made a selection 
range.

Loop Selection 
(Range tab only)

This activates playback from the start of the current se-
lection and keeps starting over again when reaching the 
selection end.

From Start to 
Cursor (Edit 
menu only)

Selects all audio between the clip start and the project 
cursor.

From Cursor to 
End (Edit menu 
only)

Selects all audio between the project cursor and the end 
of the clip. For this to work, the project cursor must be 
within the clip boundaries.

Left Selection 
Side to Cursor 
(Edit menu only)

Moves the left side of the current selection range to the 
project cursor position. For this to work, the cursor must 
be within the clip boundaries.

Right Selection 
Side to Cursor 
(Edit menu only)

Moves the right side of the current selection range to the 
project cursor position (or the end of the clip, if the cursor 
is to the right of the clip).
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Editing selection ranges
Selections in the Sample Editor can be processed in sev-
eral ways. Please note:

• If you attempt to edit an event that is a shared copy (i.e. 
the event refers to a clip that is used by other events in the 
project), you are asked whether you want to create a new 
version of the clip or not (if you haven’t made a “perma-
nent” choice already – see below).
Select “New Version” if you want the editing to affect the selected event 
only. Select “Continue” if you want the editing to affect all shared copies. 
Note: If you activate the option “Do not show this message again” in the 
dialog, any further editing you do will conform to the selected method 
(“Continue” or “New Version”). You can change this setting at any time 
with the “On Processing Shared Clips” pop-up menu in the Preferences 
(Editing–Audio page).

• Any changes to the clip will appear in the Offline Process 
History, making it possible to undo them at a later point (see 
“The Offline Process History dialog” on page 251).

Cut, Copy and Paste

The Cut, Copy and Paste commands (on the Edit menu in 
the Process tab of the Sample Editor Inspector or in the 
main Edit menu) work according to the following rules:

• Selecting Copy copies the selection to the clipboard.

• Selecting Cut removes the selection from the clip and 
moves it to the clipboard.
The section to the right of the selection is moved to the left to fill out the 
gap.

• Selecting Paste copies the data on the clipboard into 
the clip.
If there is a selection in the editor, this will be replaced by the pasted 
data. If there is no selection, the pasted data will be inserted starting at 
the selection line. The section to the right of the line will be moved to 
make room for the pasted material.

The pasted data will be inserted at the selection line.

Delete

Selecting Delete (on the Edit menu in the Process tab of 
the Sample Editor Inspector or in the main Edit menu or 
pressing [Backspace]) removes the selection from the 
clip. The section to the right of the selection is moved to 
the left to fill out the gap.

Insert Silence

Selecting “Insert Silence” (on the Edit menu in the Pro-
cess tab of the Sample Editor Inspector or in the Range 
submenu of the main Edit menu) will insert a silent section 
with the same length as the current selection, at the selec-
tion start. 

• The selection will not be replaced, but moved to the 
right to make room. 
If you want to replace the selection, use the “Silence” function instead 
(see “Silence” on page 247).
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Processing

Processing (on the Select Process menu in the Process 
tab of the Sample Editor Inspector or in the Process sub-
menu on the Audio menu) can be applied to selections in 
the Sample Editor, as can the effects (on the Select Plug-
in menu in the Process tab of the Sample Editor Inspector 
or in the Plug-ins submenu on the Audio menu). See the 
chapter “Audio processing and functions” on page 238. 

Creating a new event from the selection

You can create a new event that plays only the selected 
range, using the following method:

1. Make a selection range.

2. Press [Ctrl]/[Command] and drag the selection range 
to the desired audio track in the Project window.

Creating a new clip or audio file from the selection

You can extract a selection from an event and either cre-
ate a new clip or a new audio file, in the following way:

1. Make a selection range.

2. Right-click to open the Quick menu and select 
“Bounce Selection” from the Audio submenu.

A new clip is created and added to the Pool, and another 
Sample Editor window will open with the new clip. The 
new clip will refer to the same audio file as the original clip, 
but will only contain the audio corresponding to the selec-
tion range.

Working with regions
Regions are sections within a clip. One of the main uses for 
regions is Cycle recording, in which the different “takes” 
are stored as regions (see “Recording audio in cycle mode” 
on page 73). You can also use this feature for marking im-
portant sections in the audio clip. Regions can be dragged 
into the Project window from the Editor or the Pool to cre-
ate new audio events. You can also export a region to disk 
as a new audio file, from the Pool.

Regions are best created, edited and managed in the 
Sample Editor.

Creating a region

1. Select the range you want to convert into a region.

2. Click the “Show Regions” button on the toolbar, or ac-
tivate the “Regions” option on the Elements submenu on 
the Quick menu.
The regions list is displayed to the right in the Sample Editor window.

3. Click the Add region button above the Regions list (or 
select “Event or Range as Region” from the Advanced 
submenu of the Audio menu).
A region is created, corresponding to the selected range.

4. To name the region, click on it in the list and enter a 
new name.
Regions can be renamed at any time, using this procedure.

• When a region is selected in the Regions list, it is in-
stantly displayed and selected in the Sample Editor.

Creating regions from Hitpoints

If your audio event contains calculated hitpoints, you can 
choose to automatically create regions from hitpoints. This 
can be useful to isolate recorded sounds. For further infor-
mation on hitpoints, see “Working with hitpoints and sli-
ces” on page 278.
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Editing regions

The region selected in the list is displayed in gray in the 
waveform display and thumbnail.

There are two ways to edit the start and end position of a 
region:

• Click and drag its start and end handles in the waveform 
display (with any tool).
When you move the pointer over the handles, it will automatically change 
to an arrow pointer to indicate that you can drag the handles.

• Edit the Start and End positions numerically in the Re-
gions list.
The positions are shown in the display format selected for the ruler and 
info line, but are relative to the start of the audio clip, rather than the 
project timeline.

Auditioning regions

You can listen to a region by selecting it in the list and 
clicking the Play Region button (above the list). The region 
will play back once or repeatedly, depending on whether 
the Loop icon on the toolbar is activated or not.

Making selections from regions

If you select a region in the list and click the Select Region 
button above, the corresponding section of the audio clip 
is selected (as if you had selected it with the Range Se-
lection tool). This is useful if you want to apply processing 
to the region only.

• Note that you can also double-click a region in the Pool 
to have its audio clip open in the Sample Editor with the 
area of the region automatically selected.

Creating new events from regions

You can create new audio events from regions, using the 
following method:

1. Click in the Region’s leftmost column in the list and 
keep the mouse button pressed.

2. Move the pointer to the desired audio track and posi-
tion in the Project window.

3. Release the mouse button.
A new event is created.

• You can also use the function “Events from Regions” 
from the Advanced submenu of the Audio menu for this 
(see “Region operations” on page 55).

Removing regions

To remove a region from a clip, select it in the list and click 
the Remove Region button above the list.

Exporting regions as audio files

If you create a region in the Sample Editor, the region can 
be exported to disk as a new audio file. This is done from 
the Pool, see “Exporting regions as audio files” on page 
308.
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Drawing in the Sample Editor
It is possible to edit the audio clip at sample level by draw-
ing with the Pencil tool. This can be useful if you need to 
manually edit out a spike or click, etc.

1. Zoom in to a zoom value lower than 1.
This means that there is more than one screen pixel per sample.

2. Select the Pencil tool.

3. Click and draw at the desired position in the waveform 
display.
When you release the mouse button, the edited section is automatically 
selected.

Options and settings

Show audio event

When the Show Audio Event button is activated on the 
toolbar (or the option “Audio Event” is activated on the Ele-
ments submenu on the Quick menu), the section corre-
sponding to the edited event is highlighted in the waveform 
display and Thumbnail. The sections of the audio clip not 
belonging to the event are shown with a dark gray back-
ground.

• In this mode, you can adjust the start and end of the 
event in the clip by dragging the event handles in the 
waveform display.
When you move the pointer over the event handles (no matter what tool 
may be selected), it takes on the shape of an arrow, to indicate that you 
can click and drag.

Snap to Zero Crossing

Snap to Zero Crossing activated.

When this option is activated, all audio edits are done at 
zero crossings (positions in the audio where the amplitude 
is zero). This helps you avoid pops and clicks which might 
otherwise be caused by sudden amplitude changes.

• This setting affects the Sample Editor only. In the 
Project window and other editors, the Snap to Zero 
Crossing setting on the Project menu toolbar or in the 
Preferences (Editing–Audio page) is used.

If hitpoints have been calculated, these will also be 
taken into account when snapping to zero crossings.

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will 
scroll during playback, keeping the project cursor visible 
in the editor.

! Any changes created by drawing will appear in the 
Offline Process History, making it possible to undo 
them at a later stage (see “The Offline Process His-
tory dialog” on page 251).

! This is only available if you opened the Sample Editor 
by double-clicking an audio event in the Project win-
dow or the Audio Part Editor and not, if you opened 
the audio event from within the Pool.
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Audio Warp realtime processing / 
Tempo matching audio to the 
project tempo
Audio warp is the generic name for the realtime time-
stretching and pitch-shifting functions in Nuendo. The main 
audio warp features are tempo-matching any audio loop to 
the project tempo (see “Determining the tempo of an audio 
loop and slicing your audio” on page 277) and matching up 
an audio clip with fluctuating tempo to a fixed tempo. 

If you want to tempo match an audio loop to the project 
tempo, you will normally work with loops with straight 
beats. In this case you will only need to activate the 
Straighten Up mode. 

Proceed as follows: 

1. Import your loop into the project and double-click it to 
open it in the Sample Editor.

2. Open the Playback tab in the Sample Editor Inspector 
and activate the Straighten Up mode.
Your loop will automatically adapt to the project tempo. 

If you want to use an audio file instead, or if the beat of 
your loop is not straight, further adjustments could be 
necessary. These are described in the following sections.

Determining the audio tempo automatically 
and time-stretching your audio
If you want to use an audio file with an unknown tempo in 
your project context, the easiest way to determine the 
tempo is to define a loop. You can then determine the 
tempo of the loop automatically (or manually) and finally 
match the tempo of this loop to the project tempo in Nu-
endo. 

1. Import a suitable audio file, for example a drum loop 
and double-click on it to open it in the Sample Editor.

2. Make sure that the first downbeat of the audio clip is 
aligned with the first beat of the first bar in the Sample Ed-
itor.

If your audio file is a two or four bar loop, you can import it 
into your project and proceed with step three, if you have 
a longer audio file, possibly with an upbeat, you have the 
following possibilities to define a loop:

• Resize your event by adjusting the Event Start and the 
Event End and make sure that the Preview mode is acti-
vated.

Or
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• Make a selection range in a longer clip and click the Au-
dition Loop button.
Adjust the selection range until the loop is smooth. 

A 4 bar loop has been selected.

3. Open the Definition tab and make sure the Bars value 
corresponds to the length of the audio file, or the selection 
range, respectively.
If necessary, listen to your audio to determine the correct bar length.

4. Cick the Auto Adjust button to automatically adjust the 
grid to the audio file.

When you click Auto Adjust, the following happens:

• If you created a loop by defining a selection range in a longer 
audio file, the snap point (S symbol) will be moved to the loop 
start.

• In the waveform, vertical lines will be displayed. The thick lines 
should match the bar positions and the thin lines the beat po-
sitions. You can adjust these lines by means of the Manual 
Adjust tool, see below.

• In the Definition tab the Manual Adjust tool will be activated 
(see “Manually adjusting grid and tempo of your audio” on 
page 275).

• In the Playback tab the Straighten Up button will be switched 
on (see “About the Straighten Up mode” on page 275).

5. Open the Playback tab to select an algorithm that 
should be applied on realtime playback. 
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In this pop-up you can find various options that govern the 
audio quality of the realtime time-stretching. There are pre-
sets for common types of audio material and an Advanced 
option where you can manually set warp parameters:

If you select the Advanced menu item, a dialog opens 
where you can manually adjust the three parameters that 
govern the sound quality of the time-stretching:

6. If you are satisfied with the result, i.e. the vertical lines 
match bars and beats positions, close the Sample Editor 
and activate playback.
If your audio file contained an upbeat and you resized the audio event to 
a smooth loop with the event handles, you might want to move the audio 
event to the beginning of the project:

The loop will now automatically adjust to the project 
tempo, and follow any further tempo changes you make! In 
the Project window, the audio event will have a note sym-
bol and two arrows in the upper right corner. The note 
symbol indicates Straighten Up mode and the arrow indi-
cates that the file is stretched.

Option Description

Drums This mode is best for percussive sounds, because it will not 
change the timing of your audio. Using this option for pitched 
audio will lead to noticeable artefacts. In this case, you can try 
the Mix mode.

Plucked This should be used for audio with transients and a relatively sta-
ble spectral sound character (e.g. plucked instruments).

Pads Use this mode for pitched audio with slower rhythmics and a 
stable spectral sound character. This will minimize sound arte-
facts, but the rhythmic accuracy will not be preserved.

Vocals This mode was optimized for slower signals with transients and 
a prominent tonal character (e.g. vocals).

Mix This mode will preserve the rhythm and minimize the artefacts 
for pitched material which does not meet the above criteria (i.e. 
with a less homogenous sound character). 
This will be selected by default for audio that is not categorized.

Advanced This allows for a manual tweaking of the time-stretching param-
eters. By default, the settings that are shown when you open the 
dialog are those of the last used preset (except if the Solo mode 
was selected, see below). The Advanced settings are described 
in more detail below this table.

Solo This mode will preserve the formants of the audio. It should only 
be used for monophonic material (solo woodwind/brass instru-
ments or solo vocals, monophonic synths or string instruments 
that do not play harmonies).

Parameter Description

Grainsize The realtime time-stretching algorithm splits the audio into 
small pieces called “grains”. This parameter determines the 
size of the grains. For material with many transients you 
should use low Grainsize values for best results. 

Overlap Overlap is the percentage of the whole grain that will over-
lap with other grains. Use higher values for material with a 
stable sound character.

Variance Variance is also a percentage of the whole length of the 
grains and sets a variation in positioning so that the overlap-
ping area will sound smooth. A Variance setting of 0 will 
produce a sound akin to time-stretching used in early sam-
plers, whereas higher settings will produce more (rhythmic) 
“smearing” effects but less audio artefacts.
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About the Straighten Up mode

The Straighten Up mode is one of the key audio warp fea-
tures. It allows you to lock audio clips to the project tempo 
by using realtime time-stretching. This is very useful if you 
want to use loops in your project and do not want to worry 
too much about timing.

Straighten Up mode is automatically activated if the Pre-
view button on the Definition tab is activated and the 
tempo of the audio file or loop has been specified either 
automatically by clicking the Auto Adjust button or manu-
ally by using the Manual Adjust tool. 

When this mode is activated, audio events will adapt to 
any tempo changes in Nuendo, just like MIDI events. How-
ever, using Straigthen Up function should not be confused 
with quantizing: the timing, i.e. the rythmic feeling will be 
maintained.

The Straighten Up mode in the Playback tab is automatically activated, 
when the audio tempo (time positions) is specified and the internal au-
dio quantization (musical positions) has been defined.

It is also possible to activate/deactivate Straighten Up 
mode from within the Pool by clicking the respective 
checkbox in the Straighten Up column. 

When you have correctly set a tempo or length for an au-
dio clip, this information is saved with the project. This al-
lows you to import files into the project with Straighten Up 
mode already activated. The tempo (if set) is also saved 
when exporting files.

Manually adjusting grid and tempo of your 
audio
If you want to manually adjust the grid and the tempo of 
your audio file, because you have a very special loop and 
the automatic functions did not lead to satisfying results, 
proceed as follows:

1. Open the Definition tab in the Sample Editor Inspector 
and activate the Manual Adjust tool.

The Sample Editor ruler does not reflect the audio event 
position in the Project window, but the length of the audio 
file in bars and beats. With the Manual Adjust tool you can 
manipulate this time grid for the audio file. If you select the 
Manual Adjust tool and move the mouse in the Sample 
Editor the pointer turns to a flag. Depending on the posi-
tion, the tool can have the following functions:

! Nuendo supports ACID® loops. These loops are 
standard audio files but with embedded tempo/
length information. When ACID® files are imported 
into Nuendo, Straighten Up mode is automatically 
activated and the loops will adapt to the tempo set in 
the project.

Function Description

Set Grid Start 
(green)

This tool is shown at the clip start. When it is displayed, 
you can drag it with the mouse to the first downbeat in or-
der to set the grid start at this position.

Stretch Bars 
(red)

This tool is shown at beat positions. When it is displayed, 
you can drag it with the mouse to beat positions in order 
to set the start of the next bar. All grid positions will be 
stretched.

Stretch 
Previous - Move 
Next (pink)

This tool is shown at bar positions when you hold down 
[Alt]/[Option]. When it is displayed, you can drag it with 
the mouse to bar positions in order to set the start of the 
next bar. The tempo of the last bar will be changed, i.e. the 
beat/grid positions of the last bar will be stretched, while 
all following grid positions will be moved.

Adjust Beat 
Position - Single 
(blue)

This tool is shown at beat positions when you hold down 
[Ctrl]/[Command]. When it is displayed, you can drag it 
with the mouse to adjust single beat positions, the previ-
ous and next beat will be locked. Edited or locked beats 
will be displayed in red.
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2. Audition the file to determine where the first downbeat 
occurs.

3. Move the mouse pointer to the beginning of the audio 
file until the pointer changes to a green flag (Set Grid 
Start).

4. Click and drag the green flag to the right until it 
matches the first downbeat in the sample and release the 
mouse button.
Now the ruler grid is offset so that it starts on the first downbeat in the 
sample.

5. Make sure that the length in bars shown in the lower 
section of the Definition tab corresponds to your settings.

6. Audition the file to determine where the next downbeat 
occurs, i.e. the first beat of the second bar in the sample.

7. Place the mouse pointer at the start of the second bar 
in the waveform display.

8. Click and drag the red flag (Stretch Bars) to the left or 
right until the second bar in the ruler is aligned with the 
position of the second downbeat of the sample, and re-
lease the mouse button.
The start of the next bar is set, and all grid positions will be stretched.

9. Check the other beats and hold down [Alt]/[Option] to 
use the pink flag (Stretch Previous - Move Next) if neces-
sary.
This flag is shown at bar positions. When you drag it with the mouse, the 
start of the next bar is set, and the tempo of the last bar will be changed.

!  You can change the modifiers for this in the “Define 
Auto Grid” category in the Preferences dialog (Edit-
ing-Tool Modifier page).
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10. Now have a look at the single beats in between the 
bars, and, if necessary, hold down [Ctrl]/[Command] to use 
the blue flag (Adjust Beat Position - Single) to adjust them.
Drag the flag until the single beat position is aligned with the waveform, 
and release the mouse button. 

11. Activate playback.
If you find that the beat sounds too straight, you can either adjust the 
Quantize value on the Playback tab or move the Swing slider to add 
swing.

The loop will automatically adjust to the project tempo, 
and follow any further tempo changes you make! In the 
Project window, the audio event will have a note symbol 
and two arrows in the upper right corner. The note symbol 
indicates Straighten Up mode and the arrow indicates that 
the file is stretched.

Determining the tempo of an audio loop and 
slicing your audio
1. Import a suitable audio file, for example a drum loop.

2. Double-click the loop to open it in the Sample Editor.
If your want to work with longer audio file, possibly with an upbeat, define 
a loop or resize the event as described in the section “Determining the 
audio tempo automatically and time-stretching your audio” on page 272.

3. Open the Definition tab and make sure the length in 
bars corresponds to the actual audio file.
If necessary, listen to your audio and enter the correct bar length.

4. On the Hitpoints tab, open the “Use” pop-up and se-
lect the desired option.
This affects which hitpoints should be shown when moving the Sensitiv-
ity slider (see “Setting the sensitivity” on page 280).

5. Adjust the Sensitivity slider.
The hitpoints are shown. 

6. If necessary, select the Edit Hitpoints tool to edit hit-
points manually.
You can add, delete and listen to hitpoints by pressing [Alt]/[Option] and 
clicking in the waveform. For detailed informations about hitpoints and 
their editing, see below.

7. Now, click the Slice & Close button in the Hitpoints 
tab to create audio slices from your hitpoints.
The loop will be sliced and adjusted to the project tempo. The Sample 
Editor will be closed.

In the following sections you will find more detailed infor-
mation on editing and using hitpoints.
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Working with hitpoints and slices
Hitpoint detection is a special feature of the Sample Edi-
tor. It detects attack transients in an audio file and then 
adds a type of marker, a “hitpoint”, at each transient. 
These hitpoints allow you to create “slices”, where each 
slice ideally represents each individual sound or “beat” in 
a loop (drum or other rhythmic loops work best with this 
feature). When you have successfully sliced the audio file, 
you can do a number of useful things with it:

• Change the tempo without affecting the pitch.
• Extract the timing (a groove map) from a drum loop. This can 

then be applied to quantize other events.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the 

basic feel.
• Extract sounds from loops.

The term “loop” is used throughout this chapter. Loop 
in this context usually means an audio file with a musical 
time base, i.e. the length of the loop represents a certain 
number of bars and/or beats at a certain tempo. Playing 
the loop back at the right tempo in a cycle set to the cor-
rect length will produce a continuous loop without gaps.

Using hitpoints
The basic functionality of using hitpoints to slice up a loop 
is to make a loop fit the tempo of a song, or alternatively to 
create a situation that allows the song tempo to be 
changed while retaining the timing of a rhythmic audio 
loop, just like when using MIDI files. 

Which audio files can be used?

Here are some guidelines as to what type of audio files are 
suited for slicing using hitpoints:

• Each individual sound in the loop should have some no-
ticeable attack. 
Slow attacks, legato playing etc. may not produce the desired result.

• Poorly recorded audio might be difficult to slice cor-
rectly.
In these cases, try to normalize the files or to remove DC Offset.

• There may be problems with sounds drowned in smear-
ing effects, like short delays.

Calculating hitpoints and slicing a loop

Before proceeding, find a suitable loop using the criteria 
above. Proceed as follows:

1. Open the event or clip for editing in the Sample Editor.
You can do this by double-clicking an event on an audio track in the 
Project window or a clip in the Pool. In this example, we assume you 
work with an event on a track.

2. Open the Hitpoints tab in the Sample Editor Inspector 
and select an option from the Use pop-up. 
These settings don’t affect the actual detection but rather which hit-
points will be shown afterwards. If you e.g. know that your loop is based 
on 1/16th notes, select “1/16”. If you’re uncertain, set this to “All” – you 
can change this setting afterwards if needed (see “Setting the sensiti-
vity” on page 280). 

The Use pop-up menu

3. Adjust the sensitivity slider.
Now, as you can see, hitpoints have been set at the beginning of each 
sound in the loop.

! When a selection range is defined, hitpoints will only 
be detected within this range. 
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4. If you now move the hitpoint sensitivity slider to the 
left, this gradually hides the hitpoints. Moving the slider to 
the right increases the sensitivity to reveal additional hit-
points detected during the calculate process.
The basic aim is to add, remove or edit the hitpoints in various other ways 
so that one individual sound is played between each hitpoint. For details, 
see “Editing hitpoints” on page 279.

5. Verify the tempo and bars in the Definition tab. 

In the next step, the loop will adapt to the project tempo 
set in Nuendo. 

6. In the Hitpoints tab, click on the Slice & Close button 
to create audio slices from hitpoints. (You can also use the 
option “Create Audio Slices from Hitpoints” from the Au-
dio menu.)
The following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that there is a separate event for 

each hitpoint. 
• The audio event is replaced by an audio part, containing the 

slices (double-click the part to view the slices in the Audio 
Part Editor).

• The loop is automatically adapted to the project tempo.

The slices in the Audio Part Editor. Here, the project tempo was higher 
than the loop’s original tempo – the slice events overlap slightly.

• Sliced clips are represented by a different icon in the 
Pool.

Dragging the sliced clip from the Pool to an audio track will create an 
audio part with the slices adapted to the project tempo, just as above.

7. If you activate cycle playback on the Transport panel, 
the loop should now play back seamlessly at the tempo 
set in the program!

8. To make the loop follow any further tempo changes, 
make sure the track is set to “Musical time base” by using 
the respective button in the Track list or Inspector (the 
button should show a note symbol – see “Switching bet-
ween musical and linear time base” on page 40).

• Note that if the project tempo is lower than the original 
tempo of the loop, there may be audible gaps between 
each slice event in the part.
This can be remedied by using the Close Gaps function on the Ad-
vanced submenu of the Audio menu, see “Close Gaps” on page 284. 
You should also consider activating auto fades for the respective audio 
track – fade-outs set to about 10 ms will help eliminate any clicks be-
tween the slices when you play back the part. See “Auto Fades and 
Crossfades” on page 96.

• If the project tempo is higher than the loop’s original 
tempo, you may want to activate auto crossfades for the 
track.
You can use the Close Gaps functions in this case as well, see “Close 
Gaps” on page 284.

Editing hitpoints
In this section, we go back a bit and look at what can be 
done with hitpoints in the Sample Editor. There are two 
ways to invoke the hitpoint calculation:

• Use the sensitivity slider on the Hitpoints tab of the 
Sample Editor Inspector.

• Select Calculate Hitpoints from the Hitpoints submenu 
on the Audio menu.

For some loops, this may be all that is needed to set the 
hitpoints so that each slice to be created will contain a 
single “hit” or sound. However, there will almost certainly 
be cases when the automatic calculation may add a hit-
point where there shouldn’t be one, and fail to add a hit-
point where one is needed, even if the sensitivity slider is 
set to maximum. If there are too many or too few hitpoints 
in a loop, it will most probably not play back properly.

When this occurs, you have to edit the hitpoints manually 
in the Sample Editor.
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Auditioning slices

A slice is a section of the waveform, from one hitpoint to 
the next. 

The first thing you should do before editing hitpoints is to 
listen to each slice in the Sample Editor to determine what 
they contain. The aim is to avoid “double hits”, like a snare 
hit being followed by a hi-hat hit within the same slice. You 
also want to determine whether any hitpoints have been 
added that should be removed: 

1. Open a loop in the Sample Editor.
If you have already created slices, you can open them in the Sample Ed-
itor by double-clicking any event in the Audio Part Editor. If it is a new 
loop, follow the instructions below.

2. Open the Hitpoints tab and select the Edit Hitpoints 
tool.
When you point in the waveform display, the pointer changes to a 
speaker icon.

Click on this button to edit hitpoints

3. Now you can simply point and click in any slice area 
and the corresponding slice will be played back from the 
beginning to the end.
Listen for “double hits” and slices that contain parts of a single sound. 

If you find hitpoints that need to be removed or instances 
where a hitpoint needs to be added, the first thing to try is 
to change the sensitivity setting – see the following sec-
tion.

Setting the sensitivity

The loop is first analyzed to determine where hitpoints 
should appear (where the individual “beats” in the loop are), 
then you manually set the sensitivity with the sensitivity 
slider to determine how many hitpoints there should be.

• Try raising the sensitivity to add “missing” hitpoints and 
lowering it to remove unwanted hitpoints.
This may or may not work, depending on the situation, but as a general 
rule you should try this first.

• Audition the slices again to determine if changing the 
sensitivity has improved matters.
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The “Use” pop-up menu in Hitpoints tab of the Sample 
Editor Inspector affects which hitpoints are shown and is 
a useful tool for removing unwanted hitpoints. The options 
on the pop-up menu are:

If your main reason for slicing the loop is to change the 
tempo, you generally need as many slices as you can get, 
but never more than one per individual “hit” in the loop.

If you want to create a groove (see “Creating groove 
quantize maps” on page 283), you should try to get ap-
proximately one slice per eighth note, sixteenth note or 
whatever the loop requires.

Disabling slices

You might run into situations where there are too many 
slices – a single sound may have been split into two 
slices, for example. You could of course reduce the sensi-
tivity to get rid of the hitpoints you don’t want, but then 
other hitpoints could disappear too, which may be unde-
sirable. What you need to do in a situation like this is to 
disable an individual slice:

1. Open the Hitpoints tab in the Sample Editor Inspector 
and select the Edit Hitpoints tool.

2. Press [Alt]/[Option] and move the pointer to the han-
dle (the triangle).
The pointer turns into a cross. 

3. Click on the handle of the hitpoint you wish to disable.
The hitpoint handle is diminished and its line disappears to indicate that 
it is disabled.

4. Now, the hitpoint won’t be taken into account when 
you create slices.

5. To reactivate a disabled hitpoint, [Alt]/[Option]-click 
on the hitpoint handle in Edit Hitpoints tool.

Locking slices

If you lock a hitpoint by clicking on its handle with the Edit 
Hitpoints tool, it will stay even if you drag the sensitivity 
slider all the way to zero. This can be used in situations 
where one or several slices contain double hits, but raising 
the sensitivity adds a lot of unwanted slices.

1. Find the place where you hear double hits when audi-
tioning.

2. Remember the current slider setting.

3. Raise the sensitivity slider to a higher value so that a 
hitpoint appears, separating the two sounds.
Most likely this will add a lot of other unwanted hitpoints as well.

4. Audition to make sure you got what you wanted.

5. Point at the handle with the Edit Hitpoints tool.
The speaker icon changes to a normal arrow pointer.

Option Description

All All hitpoints are shown (taking the sensitivity slider into 
account).

1/4, 1/8, 
1/16, 1/32

Only hitpoints that are close to the selected note value 
positions within the loop will be shown (e.g. close to ex-
act sixteenth note positions, if the 1/16 option is se-
lected). Again, the sensitivity slider is taken into account.

Metric Bias This is like the “All” mode, but all hitpoints that are close 
to even meter divisions (1/4 notes, 1/8 notes, 1/16 
notes, etc.) get a “sensitivity boost” – they are visible at 
lower sensitivity slider settings. This is useful if you are 
working with dense or cluttered material with a lot of hit-
points, but you know that the material is based on a strict 
meter. By selecting Metric Bias it will be easier to find the 
hitpoints close to the meter position (although most other 
hitpoints are also available, at higher sensitivity settings).
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6. Click on the handle to lock the new slice.
Locked hitpoints are displayed in a darker color.

7. Drag the sensitivity slider to the original setting.
The locked hitpoint will remain shown.

• You can unlock a locked hitpoint by clicking it again 
with the Edit Hitpoints tool.

Setting hitpoints manually

If you cannot get the desired result by adjusting sensitivity, 
disabling or locking, you can add, move and delete hit-
points manually.

Manually adding hitpoints can be done in situations where 
a hitpoint is missing at a specific point, but doesn’t appear 
even if the sensitivity is set to full.

1. Zoom in on the waveform at the point where you wish 
to add a hitpoint.

2. Select the Edit Hitpoints tool to audition the area and 
make sure that the start of the sound is in view.

3. Activate Snap to Zero Crossing on the Sample Editor 
toolbar.
By finding zero crossings in the waveform (positions where the amplitude 
is close to zero), manually added slices won’t introduce any clicks or 
pops. All hitpoints found by the Calculate function are automatically 
placed at zero crossings.

4. With the Edit Hitpoints tool selected press [Alt]/[Op-
tion] so that the mouse pointer changes to a pencil tool 
and click just before the start of the sound.
A new hitpoint appears. Manually added hitpoints are locked by default.

• If you click and keep the mouse button pressed, you can 
adjust the position of the new hitpoint by dragging.
Releasing the mouse button adds the hitpoint.

5. Audition the new slice with the Audition tool to make 
sure you got what you wanted.

If you manually added a hitpoint, and it was either placed 
too far away from the start of the sound or too far into the 
sound, you can manually move the hitpoint. It is also pos-
sible to move calculated hitpoints this way.

1. Make sure Snap to Zero Crossing is activated on the 
Sample Editor toolbar.

2. Select the Edit Hitpoints tool.

3. Click on the hitpoint handle and drag it to the new po-
sition.

To delete a hitpoint, select the Edit Hitpoints tool and drag 
the hitpoint out of the Sample Editor window. Hitpoints 
that you have created manually can also be deleted by 
clicking their handle.

Match-Quantizing audio

Optionally, hitpoints can have individual Q-points. These 
are mainly used for audio quantizing. Their function is to 
define the point to which the quantizing will apply. Some-
times a slice might have a slow attack, and a peak further 
into the slice which you wish to use as the Q-point. When 
you apply quantize, the Q-point will define where the warp 
tab will be added. This also defines the point which will be 
stretched to a grid position when quantizing.

! “Use Snap” may alter the timing. In some cases it 
might be better to deactivate it, especially if you just 
want to generate a groove quantize. However, if you 
create slices afterwards, auto fades will then be nec-
essary.

! Sounds with a slow attack have their rhythmic center 
at some point before the peak. 
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• To activate Q-points, open the Preferences (Editing–
Audio page) and activate the option “Hitpoints have Q-
Points”.
Next time you use the Calculate Hitpoints function, the hitpoints will have 
Q-points.

• To offset the position of a Q-point in relation to the hit-
point, simply click on the “Q” icon and drag it to the right 
to the desired position.

Creating slices

When you have specified the correct loop length and time 
signature and worked on the hitpoints in the Sample Edi-
tor so that one sound per slice is heard, it is time to actu-
ally slice the file (if that is what you want to do – there are 
other uses for hitpoints as well, as described on the fol-
lowing pages). This is done either by clicking on the Slice 
& Close button in the Hitpoints tab of the Sample Editor 
Inspector or by selecting “Create Audio Slices from Hit-
points” from the Hitpoints submenu on the Audio menu.

The following happens:

• If you edited an event on an audio track, the Sample Ed-
itor closes.

• The audio event is “sliced” so that there is a separate 
event for each hitpoint.
In other words, the sections between the hitpoints become separate 
events, all referring to the same original file.

• On the audio track, the former audio event is replaced 
by an audio part that contains the slices. 
If you edited a clip from the Pool, you need to drag it to an audio track to 
get a part with the slices. 

See also the section “Calculating hitpoints and slicing a 
loop” on page 278.

• The loop is automatically adapted to the tempo set in 
Nuendo.
This takes the loop length you specified into account: e.g., if the loop 
was one bar long, the part is resized to fit exactly one bar in the Nuendo 
tempo, and the slices are moved accordingly, keeping their relative posi-
tions within the part.

You can change the tempo and have the loop automati-
cally follow (provided that the track is set to musical time 
base, see “Switching between musical and linear time 
base” on page 40). Furthermore, you can double-click the 
part to edit the slices in the Audio Part Editor to: 

• Remove or mute slices.
• Change the loop by reordering, replacing or quantizing slices.
• Apply processing or effects to individual slices.
• Create new files from individual slices using the “Bounce Se-

lection” function on the Audio menu.
• Realtime transpose and stretch slices.
• Edit slice envelopes.

Creating groove quantize maps
You can generate groove quantize maps based on the hit-
points you have created in the Sample Editor. Groove 
quantizing is not meant for correcting errors, but for creat-
ing rhythmic feels. This is done by comparing your re-
corded music with a “groove” (a timing grid generated 
from the file) and moving the appropriate notes so that 
their timing matches the one of the groove. In other words, 
you can extract the timing from an audio loop and use it for 
quantizing MIDI parts (or other audio loops, after slicing 
them).

Proceed as follows:

1. Check the audio tempo and define the audio grid as 
described above.

2. Create and edit hitpoints as described above.
You don’t have to create slices – just set up the hitpoints.

• You should try to get approximately one slice per eighth 
note, sixteenth note or whatever the loop requires when 
setting hitpoints for extracting a groove.
It can be helpful to use one of the note value-based options on the “Use” 
pop-up menu when you’re setting up the hitpoints (see “Setting the sen-
sitivity” on page 280).

3. When you have finished setting the hitpoints, click on 
the Make Groove button in the Hitpoints tab of the Sam-
ple Editor Inspector or select “Create Groove Quantize 
from Hitpoints” from the Hitpoints submenu on the Audio 
menu.
The groove is extracted.

! Only when the audio tempo has been defined and 
the audio grid matches the project tempo, your slices 
will be straight (quantized). 

! When you create slices, all events containing the ed-
ited clip will also be replaced.
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4. If you now pull down the Quantize Type pop-up menu 
in the Project window you will find an additional item at the 
bottom of the list, with the same name as the file from 
which you extracted the groove.
This groove can now be selected as a base for quantizing, just like any 
other quantize value. See “The Quantizing functions” on page 352.

5. If you want to save this Groove, open the Quantize 
Setup dialog and store it as a preset.

You can also create grooves from a MIDI part by se-
lecting the part and dragging it on the grid display in the 
middle of the Quantize Setup dialog or by selecting “Part 
to Groove” from the Advanced Quantize submenu on the 
MIDI menu.

Other hitpoint functions
On the Hitpoints tab of the Sample Editor Inspector and 
on the various submenus of the Audio menu, you will also 
find the following functions:

Create Markers

If an audio event contains calculated hitpoints, you can 
click on the Create Markers button in the Hitpoints tab to 
add markers – one for each hitpoint (see “Using the Mar-
ker track” on page 111). This can be useful to snap to hit-
points, e.g. for locating hitpoints and for using the 
Timewarp tool (see “The Time Warp tool” on page 422).

Create Regions

If your audio event contains calculated hitpoints, you can 
click the Create Regions button in the Hitpoints tab to au-
tomatically create regions from hitpoints. This can be use-
ful to isolate recorded sounds, in order to upload them, 
e.g. to HALion either as velocity or keyzones.

When you make a selection, regions will only be calcu-
lated from the hitpoints that are contained in the selection.

Create Events

When you simply wish to create separate events according 
to the hitpoints for a file, you can click on the Create Events 
button in the Hitpoints tab. This means that you do not have 
to make the same considerations as when slicing for tempo 
changes. You can use any method you like to set hitpoints.

• The slices created will appear in the Project window as 
separate events.

Close Gaps

This Advanced submenu function on the Audio menu is 
useful, if you have sliced a loop for tempo changes. Low-
ering the tempo below the loop’s original tempo will cre-
ate gaps between the slices. The lower the tempo is in 
relation to the original tempo, the wider the gaps will be. 
Close Gaps can be used to remedy this.

1. Set the desired tempo.

2. Select the part in the Project window.

3. Select “Close Gaps” from the Audio menu – Ad-
vanced submenu.
Now time-stretch is applied on each slice to close the gaps. Depending 
on the length of the part and the algorithm set in the Preferences, this 
can take a little while.

4. The waveform is redrawn and the gaps are closed!

• Note that this feature creates new clips in the Pool, one 
for each slice.

• Close Gaps can also be used when the project tempo 
is higher than the original loop tempo.
This will use the time-stretch function to compress the slices to fit.

• If you decide to change the tempo again after using the 
Close Gaps function, you should undo the Close Gaps 
operation or start over again, using the original un-
stretched file.

• You can also use this function on individual events (in 
the Audio Part Editor or Project window).
The events don’t have to be slices – you can use Close Gaps simply to 
stretch an audio event to the start position of the next event.
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Free Warp

Warp tabs are a kind of marker or anchor that can be 
attached to musically relevant time positions in an audio 
event, e.g. the first beat of every bar. Warp tabs can be 
dragged to the corresponding time positions in the 
project, and the audio will be stretched accordingly. 

A typical application of warp tabs is to use them to synchro-
nize audio to video, i.e. manipulate audio that is not musical.

You can also use warp tabs for further tweaking after hav-
ing applied Straighten Up (see “About the Straighten Up 
mode” on page 275).

Using the Free warp tool 
Warp tabs are created using the Free Warp tool on the 
Playback tab of the Sample Editor, but can also be cre-
ated from hitpoints (see “Creating warp tabs from hit-
points” on page 287). In this example, we will show how a 
file with a slightly varying tempo can be locked to a steady 
tempo by using warp tabs.

1. Open the audio file you wish to process in the Sample 
Editor.

2. Activate the “Use snap” button in the Sample Editor 
toolbar.
When you activate this button, warp tabs will snap to zero crossings and 
hitpoints (if shown).

3. Determine the original tempo (if this is non-varying) or 
the length of the file (see “Determining the audio tempo au-
tomatically and time-stretching your audio” on page 272).

4. Click the Auto Adjust button so that the audio event is 
stretched to the project tempo.
The Straighten Up mode is automatically activated.

5. Select the Free Warp tool by clicking on it.
For aligning the tempo, you should use Bars and Beats as the ruler reso-
lution. When you place the mouse pointer in the waveform display, it 
changes to a clock with arrows on either side, and a vertical line in the 
middle which represents the pointer. When you move the pointer in the 
waveform window, it shows the position in bars, beats and ticks as well 
as in seconds.

6. Line up the audio file so that the first beat of the first 
bar (in the audio event) starts on the first beat of a bar in 
the project.

• If the audio file doesn’t start on a downbeat, you can 
use the Event Start handle in the Sample Editor and adjust 
the position in the Project window so that the first down-
beat in the sample is aligned with the first beat of a bar in 
the grid.
Now the musical first downbeat should be aligned with the first beat of a 
bar in the project. The next step is to see where the first warp tab needs 
to be added. It may be useful to hear the metronome click to determine 
when the tempo of the audio clip drifts from the project tempo. To hear 
the metronome, activate the Click button on the Transport panel and play 
back using the transport controls.

7. Play back the audio file, either by auditioning in the 
Sample Editor or from the Transport panel, and determine 
where the first beat of a bar in the audio event does not 
match the corresponding ruler position in the project.
If you find it difficult to pinpoint an exact position in the audio event, you 
can switch to the Scrub tool and/or zoom in the view. Switch back to the 
Free Warp tool when you have found the position.

! When you change the Straighten Up mode, select 
another Quantize value or move the Swing slider, all 
your warp edits will be lost.
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8. In our example, the first beat of the third bar in the au-
dio event is slightly offset from the corresponding grid po-
sition and thus needs to be moved back a bit.

9. Place the pointer at the position of the first beat of the 
third bar in the audio event and click and hold.
When you click, a warp tab is added. If the position where you clicked 
was off, you can adjust it by dragging the tab in the ruler.

10. With the mouse button still pressed, drag the warp tab 
so that the position lines up with the first beat of the bar in 
the ruler.

11. Release the mouse button.
Now the first beat in the audio event is perfectly aligned with the corre-
sponding position in the project! 

• You can also first add warp tabs at the relevant musical 
positions and change their positions later, see “Editing 
warp tabs” on page 287.

Next to the warp tab handle in the ruler, a number is 
shown. This number indicates the warp factor, i.e. the 
amount of stretch. Warp factor numbers higher than 1.0 
indicate that the audio region preceding the warp tab is 
expanded and will play back slower. Warp factor numbers 
lower than 1.0 indicate that the audio region preceding 
the warp tab is compressed and will play back faster. 

Note that this ratio is limited to a range between 0.1 and 
10. This factor is updated when you change the project 
tempo with Straighten Up mode enabled or apply the 
timestretch tool in the project.

12. Continue to use the same method to align the first 
beat in each bar to the corresponding ruler position.
You only have to add warp tabs where the downbeat in the audio file 
drifts from the ruler position and/or if you want to lock a warp tab so that 
it is not moved when editing other points. 

When you are done, the previously varying tempo of the 
audio event will be metronome-steady and will adapt to 
any tempo in Nuendo.

The third downbeat in the audio event.
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This example illustrates the general methods of using 
warp tabs and the Free Warp tool. But you can of course 
use warp tabs for other operations than aligning down-
beats to grid positions. With the Free Warp tool, you can 
literally stretch any region within a sample to any position!

Editing warp tabs

Moving the destination position of existing warp tabs

To move a destination position of a warp tab (and thus 
stretch the audio), select the Free Warp tool and position 
the pointer on the Warp line in the waveform so that the 
line in the middle of the pointer becomes blue. Then click 
and drag to move the position of the warp tab. 

Moving the source position of existing warp tabs

If you simply wish to change the position of a warp tab re-
garding the audio, click and drag the warp tab header in 
the ruler. However, this will change the warping.

Deleting warp tabs

To delete a warp tab, press [Shift] so that the pointer be-
comes an eraser and click on the warp tab.

Unstretching audio files

By selecting “Unstretch Audio” from the Realtime Process-
ing submenu of the Audio menu, all realtime time-stretching 
(by sizing or by warp tabs) can be removed.

Note that realtime transpose (in the infoline) and 
Straighten Up mode will not be removed by this.

Whether the “Unstretch Audio” menu item is available de-
pends on whether the time-stretching was applied on the 
event or clip level: 

• If you sized an audio event in the Project window using 
“Sizing Applies Time Stretch” (see “Resizing events using 
time stretch” on page 49), you can undo the time-stretch-
ing by selecting the event in the Project window and then 
applying “Unstretch Audio”.
This will remove all time-stretching and warp tabs.

• When you have entered a tempo and/or length using 
the Definition tab, this information is saved for the source 
clip and all events that use it.

Creating warp tabs from hitpoints

You can also create warp tabs from hitpoints selecting 
“Create Warp Tabs from Hitpoints” on the Realtime Pro-
cessing submenu of the Audio menu.

For descriptions of how hitpoints are created and edited 
please see “Using hitpoints” on page 278.
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Realtime pitch-shifting of audio 
events
Audio events can be pitch-shifted in realtime just like MIDI 
events. The process is very simple:

1. Open the audio event in the Sample Editor and open 
the Playback tab.

2. Set a value in the corresponding field in the Transpose 
section.
The value range is up/down two octaves in semitone steps. 

3. Press [Enter].
The audio event is now transposed to the set value using pitch-shift.

4. If a root key is specified or if the Transpose track has 
been added, you can click the Follow Global mode to ac-
tivate/deactivate Global Transpose.
Event transpose will be added to the Global transpose value.

For more information on the transpose functions and the 
Transpose track, see the chapter “The Transpose func-
tions” on page 114. 

• You can also select the audio event in the Project win-
dow and change the Transpose value on the infoline. In 
this case, you can also fine-tune selected audio events in 
cent steps (100ths of a semitone) by entering a value in 
the Finetune field to the right.

Flattening the realtime processing
You can “flatten” any realtime processing at any time. This 
can be done to serve two purposes; to conserve CPU 
power and to optimize the sound quality of the processing. 

• Select the audio event(s) you wish to process and se-
lect “Flatten Timestretch and Transpose” from the Real-
time Processing submenu of the Audio menu.
You should also use this function before applying any offline processing. 
When the flatten processing is applied, a copy of the original file is auto-
matically created in the Pool so that the original audio clip remains intact.

Selecting an algorithm for the flattening

When you flatten the realtime processing, you can use the 
MPEX 3 algorithm to process the audio, which may pro-
duce better sound quality than the realtime processing. 
This is also the only way to achieve polyphonic formant 
conserving pitch-shifting, apart from offline processing. 
Proceed as follows:

1. Select the audio event(s) you wish to process.

2. Click the Flatten button on the Playback tab of the 
Sample Editor Inspector, or select “Flatten Timestretch 
and Transpose” from the Realtime Processing submenu of 
the Audio menu.
A dialog appears where you can select an algorithm for the processing. 
You can either select the MPEX 3 algorithm, which will produce the high-
est sound quality, or the Realtime algorithm which is much quicker but 
will not improve the audio quality of the processing (although it will 
lessen the CPU load).

! Audio and MIDI events cannot be transposed simul-
taneously.
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The MPEX3 algorithm allows you to select one of seven 
different quality settings:

Note that you can only select the MPEX 3 algorithm if 
the time-stretching factor is between 0.5 and 2 through-
out the whole event. For audio that has been stretched 
with a factor outside this range, only the Realtime algo-
rithm can be used.

• If the audio has been transposed, the dialog also con-
tains the option “Formant Correction”. Activate this if you 
want to e.g. avoid a “chipmunk voice” effect.

3. Select an algorithm and click OK.
When the processing is finished, any loop that was previously stretched 
in realtime or had been pitch-shifted will play back exactly the same, but 
Straighten Up mode will be deactivated and the realtime pitch-shifting 
will be set to 0.

The audio clip is now like any standard audio clip before 
applying realtime processing, i.e. it will not follow tempo 
changes. The flattening processing function is best used 
when you have determined the tempo or key of a project, 
but you can of course always adapt the audio to a new key 
or tempo. In this case, it is better to revert back to the orig-
inal audio clip rather than to process the already pro-
cessed file again.

Option Description

Preview This mode should only be used for preview.

Mix Fast This mode is a very fast mode for preview. This works best 
with composite music signals (mono or stereo material).

Solo Fast Use this mode or single instruments (monophonic mate-
rial) and voice.

Solo Musical Same as above but higher quality.

Poly Fast Use this for processing monophonic and polyphonic ma-
terial. This is the fastest setting that gives still very good 
results. You can use this for drum loops, mixes, chords.

Poly Musical Use this for processing monophonic and polyphonic ma-
terial. This is the recommended MPEX default quality set-
ting. You can use this for drum loops, mixes, chords.

Poly Complex This high quality setting is quite processor intense and 
should be used only when processing difficult material or 
for stretch factors above 1,3.
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Background
The Audio Part Editor allows you to view and edit the events 
inside audio parts. Essentially, this is the same type of edit-
ing that you do in the Project window, which means that 
this chapter contains a lot of references to the chapter “The 
Project window” on page 22.

Audio parts are created in the Project window in one of 
the following ways:

• By selecting one or several audio events on the same 
track, and selecting “Events to Part” from the Audio menu.

• By gluing together two or more audio events on the 
same track with the Glue Tube tool.

• By drawing an empty part with the Pencil tool.

• By double-clicking between the left and right locator on 
an audio track.
With the last two methods, an empty part is created. You can then add 
events to the part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor
You open the Audio Part Editor by selecting one or more 
audio part(s) in the Project window and double-clicking 
on any one of them (or using the Edit-Open key command, 
by default [Ctrl]/[Command]-[E]). The Audio Part Editor 
can display several parts at once, and you can also have 
more than one Audio Part Editor open at the same time.

Double-clicking on an audio event in the Project win-
dow will open the Sample Editor (see “Opening the Sam-
ple Editor” on page 259).

Window overview

The toolbar
The tools, settings and icons on the toolbar have the same 
functionality as in the Project window, with the following 
differences:

• A Solo button (see “Auditioning” on page 293).
• Separate tools for auditioning (Speaker) and scrubbing (see 

“Scrubbing” on page 293).
• No Line, Glue Tube or Color tools.
• Play and Loop icons and an Audition Volume control (see “Au-

ditioning” on page 293).
• Independent Track Loop settings (see “The independent track 

loop function” on page 293).
• Part List controls for handling several parts: activating parts 

for editing, restricting editing to active parts only and showing 
part borders (see “Handling several parts” on page 294).

You can customize the toolbar by hiding or reordering 
its items.
See “The Setup dialogs” on page 506.

The ruler and info line
These have the same functionality and appearance as 
their counterparts in the Project window.

• Note that you can select a separate display format for 
the Audio Part Editor ruler by clicking on the arrow button 
on the right and selecting an option from the pop-up menu 
that appears.
For a list of the available formats, see “The ruler” on page 31.
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About lanes
If you make the editor window larger, this will reveal addi-
tional space below the edited events. This is because an 
audio part is divided vertically in lanes. 

Lanes can make it easier to work with several audio events 
in a part:

In the top figure it is unnecessarily hard to discern, select 
and edit the separate events. In the bottom figure, some of 
the events have been moved to a lower lane, making se-
lection and editing much easier.

• To move an event to another lane without accidentally 
moving it horizontally, press [Ctrl]/[Command] and drag it 
up or down.
This is the default modifier key for this – you can adjust this in the Prefer-
ences if you like.

Overlapping events

Only one event per track can be played back at the same 
time! This means that if you have overlapping events (on 
the same lane or different lanes) these will cut each other 
off, according to the following rules:

• For events on the same lane, the ones that are on top 
(visible) will be played.
To move overlapping events to the front or back, use the Move to Front 
and Move to Back functions on the Edit menu.

• For events on different lanes, the event on the lowest 
lane gets playback priority.

The overlapping sections of the upper event will not be played since the 
event on the lower lane has playback priority!

Imagine the following situation: You have two overlapping 
audio events, with the top event audible during playback. 
What happens when you mute the audible event?

• By default, you will not hear the overlapped event when 
muting an event that has playback priority over another 
event.
This default behavior ensures that you don’t suddenly hear audio events 
that previously were not part of your mix.

• In the Preferences dialog (Editing–Audio page) you will 
find the option “Treat Muted Audio Events like Deleted”. 
When you activate this option, any events overlapped by a 
muted event will become audible.

Lanes
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Operations

• Note that if a part is a shared copy (i.e. you have previ-
ously copied the part by [Alt]/[Option]+[Shift]-dragging), 
any editing you perform will affect all shared copies of this 
part.
To indicate that it is a shared copy, its name is displayed in italics and a 
symbol is displayed in the lower right corner of the part in the Project 
window (see “Aligning events” on page 45).

Auditioning
There are three ways to listen to the events in the Audio 
Part Editor:

By using the Speaker tool

If you click somewhere in the editor’s event display with the 
Speaker tool and keep the mouse button pressed, the part 
will be played back from the position where you clicked. 
Playback will continue until you release the mouse button.

By using the Audition icon

The Audition and Audition Loop icons.

Clicking the Audition icon on the toolbar plays back the 
edited audio, according to the following rules:

• If you have selected events in the part, only the section bet-
ween the first and last selected event will be played back.

• If you have made a range selection, only this section will be 
played back.

• If there is no selection, the whole part will be played back. If 
the project cursor is within the part, playback starts from the 
current cursor position. If the cursor is outside the part, play-
back starts from the beginning of the part.

• If the Audition Loop icon is activated, playback will continue 
until you deactivate the Audition icon. Otherwise, the section 
will be played back once.

• When auditioning with the Speaker tool or Audition 
icon, audio will be routed directly to the Control Room or 
to the Main Mix (the default output bus), if the Control 
Room is disabled. 

By using regular playback

You can of course use the regular playback controls while 
in the Audio Part Editor. Furthermore, if you activate the 
Solo Editor button on the toolbar, only the events in the 
edited part will be played back.

The independent track loop function

The independent track loop is a sort of “mini-cycle”, af-
fecting only the edited part. When the loop is activated, 
the events in the parts that are within the loop will be re-
peated continuously and completely independent – other 
events (on other tracks) are played back as usual. The only 
“interaction” between the loop and the “regular playback” 
is that every time the cycle starts over again, so does the 
loop.

To set up the independent track loop, proceed as follows:

1. Turn on the loop by clicking the Independent Track 
Loop button on the toolbar.
If it isn’t visible, right-click the toolbar and add the Independent Track 
Loop Settings section – see “The Setup dialogs” on page 506.

When the loop is activated, the cycle isn’t shown in the 
editor’s ruler. Now you need to specify the length of the 
loop:

2. [Ctrl]/[Command]-click in the ruler to set the start and 
[Alt]/[Option]-click to set the end of the loop.
You can also edit the loop start and end positions numerically in the 
fields next to the Loop button.

The loop is indicated in purple in the ruler.

The events will be looped as long as the Loop button 
is activated and the Audio Part Editor window is open.

Scrubbing
In the Audio Part Editor, the Scrub tool has a separate icon 
on the toolbar. Apart from that, scrubbing works exactly as 
in the Project window (see “Scrubbing” on page 42).

! Zooming, selecting and editing in the Audio Part Ed-
itor are done just as in the Project window (see “Op-
erations” on page 33).
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Handling several parts
When you open the Audio Part Editor with several parts se-
lected – all on the same track or on different tracks – they 
might not all “fit” in the editor window, which can make it 
hard to get an overview of the different parts when editing.

Therefore, the toolbar features a few functions to make 
working with multiple parts easier and more comprehen-
sive:

• The Part List menu lists all parts that were selected 
when you opened the editor, and lets you select which 
part should be active for editing.
When you select a part from the list, it is automatically made active and 
centered in the display.

Note that it is also possible to activate a part by click-
ing on it with the Arrow tool.

• The button “Edit Active Part Only” lets you restrict edit-
ing operations to the active part only.
If you for example select “All” from the Select submenu on the Edit menu 
with this option activated, all events in the active part will be selected but 
not the events in other parts.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on an active part so that it fills the 
screen by selecting “Zoom to Event” from the Zoom sub-
menu on the Edit menu.

• The button “Show Part Borders” can be used if you 
want to see clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, 
making the borders easily discernible. There are also two “markers” in 
the ruler with the name of the active part, marking its beginning and end. 
These can be moved freely to change the part borders.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts, making them ac-
tive, with key commands.
In the Key Commands dialog – Edit category, there are two functions: 
“Activate Next Part” and “Activate Previous Part”. If you assign key com-
mands to these, you can use them to cycle between parts. Please refer 
to “Setting up key commands” on page 518 for instructions on how to 
set up key commands.

Common methods

Assembling a “perfect take”
When you record audio in Cycle mode, either an event or 
a region (or both) is created for each recorded lap (see 
“Recording audio in cycle mode” on page 73). These 
events and regions are named “Take X”, where “X” is the 
number of the take. You can create a perfect take by put-
ting together sections of the different takes in the Audio 
Part Editor.

The procedure below will not work if you recorded 
with “Keep Last” mode selected on the Transport panel.
In that case, only the last take will be kept on the track (although the pre-
vious takes will be available as regions in the Pool).

First, you have to create an audio part from the takes. This 
procedure is slightly different depending on whether you 
choose to create events or regions.

Creating an audio part from events

1. In the Project window, use the Object Selection tool to 
draw a rectangle around the recorded events.
This is necessary, since clicking on the event may just select the event on 
top (the last take). If in doubt, check the info line – the info text should be 
yellow.

2. Pull down the Audio menu and select “Events to Part”.
The events are converted to an audio part.

• Note that the events cycle record mode also makes it 
easy to combine different takes in the Project window – 
see “Create Events mode (Preferences)” on page 74.
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Creating an audio part from regions

1. In the Project window, select the event you recorded in 
Cycle mode.
After recording, this will play the last take.

2. Pull down the Audio menu and select “Events to Part”.
You are asked whether you want to “Create part using regions”.

3. Click “Regions”.
The regions are converted to an audio part.

Assembling a take

1. Double-click the part to open the Audio Part Editor.
Now, the different takes will be placed on different lanes, with the last 
take at the bottom.

2. Use the tools to cut out pieces of the takes and as-
semble the final result.
This can include splitting with the Scissors tool, resizing events with the 
Arrow tool or deleting with the Eraser tool. 

• Remember that the events on the lowest lane have play-
back priority. 
Use the Audition icon to audition the result.

3. Close the Audio Part Editor.
You have now assembled a “perfect take”!

Options and Settings
The following options and settings are available in the 
Audio Part Editor:

• Snap
You can specify an independent Snap mode (and snap value for the Grid 
mode) in the editor. The functionality is exactly the same as in the Project 
window.

• Autoscroll
When Autoscroll is activated on the toolbar, the window will scroll during 
playback, keeping the project cursor visible in the editor. This setting can 
be activated or deactivated individually for each window.

• Snap to Zero Crossing
When this option is activated, all audio edits are done at zero crossings 
(positions in the audio where the amplitude is zero). This helps you avoid 
pops and clicks which might otherwise be caused by sudden amplitude 
changes. 
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Background

What is the Pool?
Every time you record on an audio track, a file is created 
on your hard disk. A reference to this file – a clip – is also 
added to the Pool. Two general rules apply to the Pool:

• All audio and video clips that belong to a project are 
listed in the Pool.

• There is a separate Pool for every project.

The way the Pool displays folders and their contents is 
similar to the way the Mac OS X Finder and the Windows 
Explorer display folders and lists of files.

What can you do in the Pool?
In the Pool you can, among other things, perform the fol-
lowing operations:

Operations that affect files on disk

• Import clips (audio files can automatically be copied and/or 
converted).

• Convert file formats.
• Rename clips (this will also rename the referred files on disk),  

and regions.
• Delete clips (if you select the “Move to Trash” option and 

empty the Trash folder – see “Deleting clips” on page 302).
• Prepare File Archives for backup.
• Minimize files.

Operations that only affect clips

• Copy clips.
• Audition clips.
• Organize clips.
• Apply audio processing to clips.
• Save or import complete Pool files.

Opening the Pool
You open the Pool in any of the following ways:

• By clicking the Pool icon in the Project window.

• By selecting “Pool” on the Project menu or “Open Pool Win-
dow” on the Media menu.

• By using a key command (by default [Ctrl]/[Command]+[P] – 
note that using this key command a second time will close the 
Pool again).

The content of the Pool is divided into three main folders: 

• The Audio folder
This contains all audio clips and regions currently in the project.

• The Video folder
This contains all video clips currently in the project.

• The Trash folder 
Unused clips can be moved to the Trash folder for later permanent re-
moval from the hard disk.

These folders cannot be renamed or deleted from the Pool, 
but any number of subfolders can be added (see “Organi-
zing clips and folders” on page 308).

Window overview

Audio folder

Trash folder Video folder

Audio clip name

 Region name

Waveform image

Column Headings

Toolbar
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Toolbar overview

The info line
Click the “Show Info” button on the toolbar to show or 
hide the info line at the bottom of the Pool window. It 
shows the following information:

How clips and regions are displayed in the 
Pool
• Audio clips are represented by a waveform icon followed by 

the clip name.

• Audio regions are represented by a region icon followed by 
the region name.

• Video clips are represented by a camera icon followed by the 
clip name.

The Pool window columns
Various information about the clips and regions can be 
viewed in the Pool window columns. The columns contain 
the following information:

Open/Close all 
FoldersView / Attributes

Pop-up

Hide/show 
info line

Import Button

Project Folder Path

Pool Record Folder Path
Play and Loop buttons, 
audition volume control

Search Button

Number of audio 
files in the Pool

Number of files in the Pool that are not 
in the project folder (e.g. video files)

Total size of all audio 
files in the Pool

Number of audio 
files in use

Column Description

Media This column contains the Audio, Video and Trash folders. 
If the folders are opened, the clip or region names are 
shown and can be edited. This column is always shown.

Used This column displays the number of times a clip is used in 
the project. If a column row is empty, the corresponding 
clip is not used.

Status This column displays various icons that relate to the cur-
rent Pool and clip status. See “About the Status column 
symbols” on page 299 for a description of the icons.

Straighten up The checkbox in this column allows you to activate or de-
activate Straighten up. If the Tempo column (see below) 
displays “???”, you have to enter the correct tempo be-
fore you can activate Straighten up.

Tempo This shows the tempo of audio files for which a tempo 
has been set. If no tempo has been specified, the column 
displays “???”. 

Sign. This is the time signature, e.g. “4/4”.

Key This ist the root key, if one was specified for the file.

Info This column shows the following information for audio 
clips: The sample rate, bit resolution, number of channels 
and the length in seconds. For regions, it displays start 
and end times in frames, and for video clips the frame 
rate, number of frames, and length in seconds.

Type This column shows the file format of the clip.

Date This column shows the date when the clip was created.

Origin Time This column shows the original start position where a clip 
was recorded in the project. As this value can be used as 
a basis for the option “Insert into Project” in the Media or 
context menu (and other functions), you can change it if 
the Origin Time value is independent (i.e. not for regions). 
This can either be done by editing the value in the col-
umn, or by selecting the corresponding clip in the Pool, 
moving the project cursor to the new desired position 
and selecting “Update Origin” from the Audio menu.

Image This column displays waveform images of audio clips or 
regions. 

Path This column shows the path to the location of a clip on 
the hard disk.

Reel Name If you have imported an OMF file (see “Exporting and im-
porting OMF files” on page 494), they may include this 
attribute, in which case it is shown in this column. The 
Reel Name describes the 'physical' reel or tape from 
which the media was originally captured.
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About the Status column symbols

The Status column can display various symbols that relate 
to the clips status. The following symbols can be shown:

User Attributes

You can define your own attributes for elements in the pool. 
This is handy when you have a large number of audio files in 
the Pool. You can use the attributes to sort items in the pool 
or merely keep track of some aspect of your project.

Simply select the “Define User Attributes” option from the 
View/Attributes pop-up and create as many new attributes 
as you need. These attributes will then get their own col-
umns in the Pool. Each attribute can be defined as check-
box, text field or number. You can then specify the user 
attributes for each file, thus categorizing them further. All 
user attributes you created are automatically available as 
search criteria in the Pool and can be added as separate el-
ements to the search pane (or replace the search criteria 
above the Location parameter, see above). This allows for a 
very detailed search, helping you to master even the largest 
sound database.

Setting up a talent name attribute to keep track of ADR takes.

Sorting the Pool contents

You can sort the clips in the Pool by name, date etc. This 
is done by clicking on the corresponding column heading. 
Clicking again on the same heading switches between as-
cending and descending sort order.

Symbol Description

This indicates the current Pool Record folder (see 
“Changing the Pool Record folder” on page 308).

This symbol is shown if a clip has been processed.

The question mark indicates that a clip is referenced to 
the project but is missing from the Pool (see “About mis-
sing files” on page 305).

This indicates that the clip file is external, i.e. located out-
side the current Audio folder for the project.

This indicates that the clip has been recorded in the cur-
rently open version of the project. This is useful for finding 
recently recorded clips quickly.

The arrow indicates the sort 
column and sort order.
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Customizing the view

• You can specify which of the columns should be shown 
or hidden by selecting the View/Attributes pop-up on the 
toolbar and selecting/deselecting items.

• You can rearrange the order of the columns by clicking 
on a column heading and dragging the column to the left 
or right.
The mouse pointer changes to a hand when you place it on the column 
heading.

• The width of a column can also be adjusted by placing 
the pointer between two column headers and dragging 
left or right.
The pointer changes to a divider when you place it between two column 
headers.

Operations
Most of the Pool-related main menu functions are also 

available on the Pool context menu (opened by right-click-
ing in the Pool window).

Renaming clips or regions in the Pool
To rename a clip or a region in the Pool, select it and click 
on the existing name, type in a new name and press [Re-
turn].

In case of a clip, this will also rename the referred files 
on disk!

Renaming multiple clips or regions

You can also rename multiple clips or regions in the Pool 
using the “Rename…” command from the Edit menu.

1. Select one or more audio clips, video clips or regions 
in the Pool. 
You can only select one type of object at a time.

2. From the Edit menu, select “Rename…”.
A dialog with several options for renaming objects automatically will 
open.

3. Set the parameters for renaming objects and press 
[Return].

! Renaming a clip in the Pool is much preferred to re-
naming it outside Nuendo (for example on the com-
puter desktop). This way, Nuendo already “knows” 
about the change, and won’t lose track of the clip the 
next time you open the project. See “About missing 
files” on page 305 for details about lost files.
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Setting parameters of the Rename Object dialog

The Rename Object dialog provides a great deal of flexi-
bility and options when renaming multiple objects in Nu-
endo. In addition to simple prefix, suffix, and incremental 
numeric additions to names, you can remove certain char-
acters, include timestamp information and more.

The Rename Objects dialog

Each of the eight fields found in the left section of the Re-
name Objects dialog can be used to add an element to 
the name generated for each object. 

The first line will create text or numbers at the left of the 
new name. The eighth and last line will create text or num-
bers at the very right of the new name.

Each of the eight lines can add one of the following ele-
ments including a prefix and suffix for each item (You can 
use a prefix to create a space separating items in the gen-
erated name.):

An example of the result is displayed in the bottom of the 
window for reference. All of these parameters can be 
saved as a preset as well.

Copying clips in the Pool
To make a duplicate clip, proceed as follows:

1. Select the clip you wish to copy.

2. Select “New Version” on the Media menu.
A new version of the clip appears in the same Pool folder, with the same 
name but with a “version number” after it, to indicate that the new clip is 
a duplicate. The first copy made of a clip will logically get the version 
number “2” and so on. Regions within a clip are copied too, but keep 
their name. 

Inserting clips into a project

By using menus

1. Select the clip(s) you want to insert into the project.

2. Pull down the Media menu and select an “Insert into 
Project” option.
“At Cursor” will insert the clip(s) at the current project cursor position. 
“At Origin” will insert the clip(s) at their Origin Time position(s).

• Note that the clip will be positioned so that its snap 
point is aligned with the selected insert position.
You can also open the Sample Editor for a clip by double-clicking it, and 
perform the insert operation from there. This way you can set the snap 
point before inserting a clip.

3. The clip is inserted on the selected track or on a new 
audio track.
If several tracks are selected, the clip will be inserted on the first selected 
track.

Option Description

Free Text Any text you would like to include in the name.

Original Name The original name given to the object. There are options 
to remove all numbers or non-alphanumerics or just the 
ones on the left or right sides.

Number An increasing or decreasing number starting with a mini-
mum amount of digits and a starting number (i.e. 001, 
002 etc.).

Project Time The current location of the clip in the project window us-
ing any of the seven ruler formats (Bars+Beats, Time-
code etc.).

Date The date that the file was created in several formats.

File Extension The file type.

Audio Bitsize The bit depth of the audio file.

Samplerate The samplerate of the audio file.

Audio Tempo The audio tempo for that clip if it has been assigned.

User Attribute Any one of the custom attributes created in the Setup User 
Attributes dialog (see “User Attributes” on page 299).

! Copying a clip does not create a new file on disk, but 
just a new edit version of the clip (referring to the 
same original file).

Option Description
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By using drag and drop

You can use drag and drop to insert clips into the Project 
window. You can also use drag and drop from the Sample 
Editor for a clip by making a selection range and pressing 
[Ctrl]/[Command] while dragging. Note:

• Snap is taken into account if activated.

• While you drag the clip in the Project window, its posi-
tion will be indicated by a marker line and a numerical po-
sition box.
Note that these indicate the position of the snap point in the clip. For ex-
ample, if you drop the clip at the position 10.00, this will be where the 
snap point ends up. See “Adjusting the snap point” on page 266 for in-
formation on how to set the snap point.

• If you position the clip in an empty area in the event dis-
play (i.e. below existing tracks), a new track is created for 
the inserted event.

Deleting clips

Removing clips from the Pool

To remove a clip from the Pool without deleting it from the 
hard disk, proceed as follows:

1. Select the clip(s) and select “Delete” from the Edit 
menu (or press [Backspace] or [Delete]).

If you try to delete a clip that is used by one or more 
events, the program will ask you if you want to remove 
these events from the project.

If you cancel, neither the clip nor the associated events are deleted.

2. Click Remove.
A new prompt asks whether you want to move the clip to the Trash or re-
move it from the Pool.

3. Select “Remove from Pool”.
The clip is no longer associated with the project, but still exists on the hard 
disk and can be used in other projects etc. This operation can be undone.

Deleting from the hard disk

To delete a file permanently from the hard disk, it must first 
be moved to the Trash folder:

1. Follow the instructions for deleting clips above and 
click the Trash button.
Alternatively, you can drag and drop clips into the Trash folder.

2. Select “Empty Trash” on the Media menu. Select one 
of the two options in the alert: 

• Click “Erase” to delete the file on the hard disk perma-
nently.
This operation cannot be undone!

• Click “Remove from Pool” to remove the clip from the 
Pool but to keep the file.

To retrieve a clip or region from the Trash Folder, drag 
and drop it back into an Audio or Video folder.

Removing unused clips from the Pool

This function finds all clips in the Pool that are not used in 
the project. You can then decide whether to move them to 
the Pool Trash folder (where they can be permanently de-
leted) or to remove them from the Pool:

1. Select “Remove Unused Media” on the Media or con-
text menu.
A message appears asking you whether you want to move the file to the 
trash or to remove it from the Pool.

2. Make your selection.

Removing regions

To remove a region from the Pool, select it and select “De-
lete” from the Edit menu (or press [Backspace] or [Delete]). 

Note that for regions, there is no alert if the region is 
used in the project!

Snap point

! Before you permanently delete audio files from the 
hard disk, make sure that they are not used by an-
other project!



303

The Pool

Locating events and clips

Locating events via clips in the Pool

If you want to find out which events in the project refer to a 
particular clip in the Pool, proceed as follows:

1. Select one or more clips in the Pool.

2. Select “Select in Project” on the Media menu.
All events that refer to the selected clip are now selected in the Project 
window.

Locating clips via events in the Project window

If you want to find the clip for an event in the Project win-
dow, proceed as follows:

1. Select one or more events in the Project window.

2. Pull down the Audio menu and select “Find Selected 
in Pool”.
The corresponding clip(s) will be located and highlighted in the Pool. If 
the Pool window isn’t already open, it will be opened.

Searching for audio files
The Pool can help you locate audio files in your Pool, on 
your hard disk or other media. This works much like the 
regular file search, but with a couple of extra features:

1. Click the Search button in the toolbar.
A search pane appears at the bottom of the window, displaying the 
search functions.

The search pane in the Pool.

By default, the search parameters available in the search 
pane are “Name” and “Location”. For using other filter cri-
teria, see “Extended search functionality” on page 304.

2. Specify the name of the file(s) to search for in the 
Name field.
You can use partial names or wildcards (*). Note that only audio files of 
the supported formats will be found.

3. Use the Location pop-up menu to specify where to 
search.
The pop-up menu will list all your local drives and removable media. 

• If you want to limit the search to certain folders, choose 
“Select Search Path” and select the desired folder in the 
dialog that appears.
The search will include the selected folder and all subfolders. Note also 
that folders you have recently selected using the “Select Search Path” 
function will appear on the pop-up menu, allowing you to quickly select 
any of them.

4. Click the Search button.
The search is started and the Search button is labeled Stop – click this 
to cancel the search if needed.

When the search is finished, the found files are listed to 
the right.

• To audition a file, select it in the list and use the play-
back controls to the left (Play, Stop, Pause and Loop).
If Auto Play is activated, selected files will automatically be played back.

• To import a file into the Pool, double-click on it in the list 
or select it and click the Import button.

5. To close the search pane, click the Search button in 
the toolbar again.

The Find Media window

Alternatively to the search pane in the Pool, you can open 
a stand-alone Find Media window by selecting the 
“Search Media…” option from the Media or context menu 
(also available from the Project window). This offers the 
same functionality as the search pane. 

• To insert a found clip or region directly into the project 
from the Find Media window, select it in the list in the dia-
log and select one of the “Insert into Project” options from 
the Media menu.
The options are described in the section “Inserting clips into a project” 
on page 301.
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Extended search functionality 

Apart from the search criterion Name, additional search fil-
ters and user attributes are available. To use them, proceed 
as follows:

1. Set up a couple of user attributes using the “View/
Attributes” pop-up menu.

2. Click the Search button on the toolbar.
The Search pane is displayed in the lower part of the Pool window.

3. Move the mouse pointer over the “Name” text to the 
right of the name field, until an arrow is displayed, and 
click it.

4. The Extended Search pop-up menu opens.
This contains six options determining which search criteria will be dis-
played above the Location field (Name, Size, Bitsize, Channels, Sample 
Rate or Date). It also contains all the user attributes you specified and the 
Add Filter and Presets submenus.

The search criteria have the following parameters:

• Name: partial names or wildcards (*)
• Size: Less than, more than, equal, between (two values), in 

seconds, minutes, hours and bytes
• Bitsize (resolution): 8, 16, 32, 64
• Channels: mono, stereo and from 3 to 16
• Sample Rate: various values, choose “Other” for free setting
• Date: various search ranges

5. Select one of the topmost 6 options in the pop-up 
menu to change the search option above the Location 
pop-up menu.
This way, you can choose e.g. to display the Size or Sample Rate para-
meter instead of the Name field.

6. If you want to display more search options, select the 
desired element from the Add filter submenu.
This allows you e.g. to add the Size or the Sample Rate parameters to 
the already displayed Name and Location parameters.

This allows for a very detailed search, helping you to mas-
ter even the largest sound database.

• You can store presets of your search filter settings. For 
this, click Store Presets in the Presets submenu and enter 
a name for the preset.

Existing presets will be found at the bottom of the list. To remove a pre-
set, click on the preset to activate it, then select Remove Preset.

• It is also possible to further refine the search options by 
including your user attributes in the search criteria. 
When user attributes have been defined, these will appear on the pop-
up menu (see above).

Move the mouse pointer over the “Name” text to 
the right of the name field and click…

… to show the Extended Search pop-up menu.



305

The Pool

About missing files
When you open a project, the Resolve Missing Files dialog 
(see below) may open, warning you that one or more files 
are “missing”. If you click Close, the project will open any-
way, without the missing files. In the Pool, you can check 
which files are considered missing. This is indicated by a 
question mark in the Status column.

A file is considered missing under one of the following 
conditions:

• The file has been moved or renamed outside the pro-
gram since the last time you worked with the project, and 
you ignored the Resolve Missing Files dialog when you 
opened the project for the current session.

• You have moved or renamed the file outside the pro-
gram during the current session.

• You have moved or renamed the folder in which the 
missing files are located.

Locate missing files

1. Select “Find Missing Files” from the Media or context 
menu.
The Resolve Missing Files dialog opens. 

2. Decide if you want the program to try to find the file for 
you (Search), if you want to do it yourself (Locate) or if you 
want to specify in which directory the program should 
search for the file (Folder).

• If you select Locate, a file dialog opens, allowing you to 
locate the file manually.
Select the file and click “Open”.

• If you select Folder, a dialog opens to let you specify the 
directory in which the missing file can be found.
This might be the preferred method if you have renamed or moved the 
folder containing the missing file, but the file still has the same name. 
Once you select the correct folder, the program finds the file and you can 
close the dialog.

• If you select Search, a dialog opens to let you specify 
which folder or disk should be scanned by the program. 
Click the Search Folder button, select a directory or a disk and click the 
Start button. If found, select the file from the list and click “Accept”. 
Afterwards Nuendo tries to map all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e.g. if you have acciden-
tally deleted it from the hard disk), it will normally be indi-
cated with a question mark in the Status column in the 
Pool. However, if the missing file is an edit file (a file cre-
ated when you process audio, stored in the Edits folder 
within the project folder), it may be possible for the pro-
gram to reconstruct it by recreating the editing to the orig-
inal audio file:

1. Open the Pool and locate the clip(s) for which files are 
missing.

2. Check the Status column – if it says “Reconstruct-
ible”, the file can be reconstructed by Nuendo.

3. Select the reconstructible clips and select “Recon-
struct” from the Media menu.
The editing is performed and the edit files are recreated.

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or re-
constructed, you may want to remove these. For this, select 
“Remove Missing Files” from the Media or context menu. 
This will remove all missing files from the Pool as well as 
their corresponding events from the Project window.
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Auditioning clips in the Pool
There are three methods you can use to audition clips in 
the Pool:

• By using key commands.
If you activate the “Playback Toggle triggers Local Preview” option in the 
Preferences (Transport page), you can use the [Space] bar to audition. 
This is the same as clicking the Audition icon on the toolbar.

• By selecting a clip and activating the Play button.
The whole clip will play back, unless you stop playback by clicking the 
Play button again.

The Play button.

• By clicking somewhere in the waveform image for a clip.
The clip will play from the position in the waveform you click until the end 
of the clip, unless you stop playback by clicking the Play button, or by 
clicking anywhere else in the pool window.

Click in the waveform image to audition a clip.

• The audio will be routed directly to the Control Room, if 
the Control Room is activated. When the Control Room is 
deactivated, the audio will be routed to the Main Mix (the 
default output) bus, bypassing the audio channel’s set-
tings, effects and EQs. 
You can adjust the auditioning level with the miniature level fader on the 
toolbar. This does not affect the regular playback level.

If you have activated the Loop button before you audition, 
the following will happen:

The Loop button.

• If you click the Play button to audition a clip, it will repeat 
indefinitely until you stop playback by clicking the Play or 
Loop button again.

• If you click in the waveform image to audition, the sec-
tion from the point you clicked to the end of the clip will re-
peat indefinitely until you stop playback.

Opening clips in the Sample Editor
The Sample Editor allows you to perform detailed editing 
on the clip (see “The Sample Editor” on page 258). You 
can open clips in the Sample Editor directly from the Pool 
in the following ways:

• If you double-click on a clip waveform icon or a clip 
name in the Media column, the clip will open in the Sam-
ple Editor.

• If you double-click on a region in the Pool, its clip will 
open in the Sample Editor with the region selected.

One practical use for this is to set a snap point for a clip 
(see “Adjusting the snap point” on page 266). When you 
later insert the clip from the Pool into the project, you can 
have it properly aligned according to the set snap point.

Import Medium…
The Import Medium dialog lets you import files directly into 
the Pool. It is opened from the Media or context menu or 
with the Import button in the Pool window.

Clicking the Import button opens the Import dialog:
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This is a standard file dialog, where you can navigate to 
other folders, audition files etc. The following audio file for-
mats can be imported:

• Wave (Normal or Broadcast, see “Broadcast Wave files” on 
page 441)

• AIFF and AIFC (Compressed AIFF)
• REX or REX 2 (see “Importing ReCycle files” on page 493)
• Dolby Digital AC3 file (ac3 – if you have the Steinberg Dolby 

Digital Encoder installed in your system)
• DTS file (dts – if you have the Steinberg DTS Encoder in-

stalled in your system)
• SD2 (Sound Designer II) 
• MPEG Layer 2 and Layer 3 (mp2 and mp3 files – see “Impor-

ting compressed audio files” on page 493)
• Ogg Vorbis (ogg files – see “Importing compressed audio 

files” on page 493)
• Windows Media Audio (Windows – see “Importing com-

pressed audio files” on page 493)
• Wave64 (w64 files)

They may have the following characteristics:

• Stereo or mono
• Any sample rate (although files with another sample rate than 

the one used in the project will play back at the wrong speed 
and pitch – see below).

• 8, 16, 24 bit or 32 bit float resolution

The following videos formats can also be imported:

• AVI (Audio Video Interleave)
• MOV and QT (QuickTime)
• WMV (Windows only)
• DV (Mac OS X only)
• MPEG 1 and 2 video files.

It is also possible to use the commands on the Import 
submenu on the File menu to import audio or video files 
into the Pool.

When you select a file in the Import Medium dialog and 
click Open, the Import Options dialog opens:

It contains the following options:

• Copy File to Working Directory.
Activate this if you want a copy of the file to be made in the Audio folder 
of the project, and have the clip refer to this copy. If the option is off, the 
clip will refer to the original file in the original location (and will thus be 
marked as “external” in the Pool – see “About the Status column sym-
bols” on page 299).

• Convert to Project section:
Here you can choose to convert the sample rate (if the sample rate is dif-
ferent than the one set for the project) or the sample size, i.e. resolution 
(if the sample size is lower than the record format used in the project).
The options are only available if necessary. Note that if you are importing 
several audio files at once, the Import Options dialog will instead contain 
a “Convert if needed” checkbox. When this is activated, the imported 
files will be converted only if the sample rate is different or the sample 
size is lower than the project’s.

• Split Channels
If this is activated, stereo and multi-channel files will be split into a corre-
sponding number of mono files – one for each channel – and these will 
be imported into the Pool. Note that if you use this option, the imported 
files will always be copied to the Audio folder of the project, as described 
above.

• Do not Ask again.
If this is activated, files will always be imported according to the settings 
you have made, without this dialog appearing. This can be reset in the 
Preferences (Editing–Audio page). 

You can always convert files later by using the Convert 
Files (see “Convert Files” on page 310) or Conform Files 
(see “Conform Files” on page 310) options.

! For video files to be played back correctly, the right 
codecs have to be installed.
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Importing audio CD tracks
You can import tracks (or sections of tracks) from an au-
dio CD directly into the Pool by using the “Import Audio 
CD” function on the Media menu. This opens a dialog in 
which you can specify which tracks should be copied from 
the CD, converted to audio files and added to the Pool.

For details about the Import Audio CD dialog, see “Im-
porting audio CD tracks” on page 491.

Exporting regions as audio files
If you have created regions within an audio clip (see “Wor-
king with regions” on page 269), these can be exported as 
separate audio files. To create a new audio file from a re-
gion, proceed as follows:

1. In the Pool, select the region you wish to export.

2. On the Audio menu, select “Bounce Selection”.
A browser dialog opens.

3. Select the folder in which you want the new file to be 
created.
A new audio file is created in the specified folder. The file will have the 
name of the region and will automatically be added to the Pool.

If you have two clips that refer to the same audio file 
(different “versions” of clips, e.g. created with the “Convert 
to Real Copy” function), you can use the Bounce Selection 
function to create a new, separate file for the copied clip.
Select the clip, select Bounce Selection and enter a location and name 
for the new file.

Changing the Pool Record folder

The Pool Record folder.

In the Pool Record folder, all audio clips that you record in 
the project will end up. The Pool Record folder is indi-
cated by the text “Record” in the Status column and by a 
red dot on the folder itself, as shown in the picture above. 
By default, this is the main Audio folder. You can, how-
ever, at any time create a new Audio subfolder and desig-
nate this as your Pool Record folder. Proceed as follows:

1. Select the Audio folder or any audio clip.
You cannot designate the Video folder (or a subfolder in it) as the Pool 
Record folder.

2. Select “Create Folder” on the Media or context menu.
A new empty audio subfolder appears in the Pool.

3. Select the new folder.

4. Select “Set Pool Record Folder” on the Media or con-
text menu, or click in the Status column of the new folder.
The new folder now becomes the Pool Record folder, and any audio re-
corded in the project will be saved in this folder.

Organizing clips and folders
If you accumulate a large number of clips in the Pool, it 
may sometimes be difficult to quickly find specific items. In 
such cases, organizing clips in new subfolders with suit-
able names that reflect the content can be a solution. For 
example, you could put all sound effects in one folder, all 
lead vocals in another etc. Proceed as follows:

1. Select the type of folder, audio or video, for which you 
want to create a subfolder.
You cannot put audio clips in a video folder and vice versa.

2. Select “Create Folder” on the Media on context menu.
A new empty subfolder named “New Folder” appears in the Pool.

3. Click on the name and enter an appropriate name for 
the folder.

4. Drag and drop the clips you wish to move to the new 
folder.

5. Repeat steps 1-4 as necessary.

Applying processing to clips in the Pool
You can apply audio processing to clips from within the 
Pool in the same way as to events in the Project window. 
Simply select the clip(s) and choose a processing method 
from the Audio menu. To find out more about audio pro-
cessing, see the chapter “Audio processing and functions” 
on page 238.
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Undoing processing
If you have applied processing to a clip, in the Project win-
dow, the Sample Editor, or in the Pool, this is indicated by 
the red and gray waveform symbol in the Status column. 
This processing can always be undone using the Offline 
Process History, see “The Offline Process History dialog” 
on page 251.

Freeze Edits
You can use the Freeze Edits function to create a new file 
with processing applied or to replace the original with a 
processed version, see “Freeze Edits” on page 253.

Minimize File
The option “Minimize File” on the Media or context menu 
allows you to change the size of audio files according to 
the audio clips referenced in a project. The files produced 
using this option will only contain the audio file portions 
actually used in the project. This can significantly reduce 
the size of the project, if large portions of the audio files 
are unused. Therefore, the option is useful for archiving 
purposes after you have completed a project.

This operation will permanently alter the selected au-
dio files in the Pool. This cannot be undone!
If this is not what you want, you can use the option “Save Project to New 
Folder” on the File menu instead, see “Save Project to New Folder” on 
page 489. This function also has the option of minimizing files, but cop-
ies all files into a new folder, leaving the original project untouched.

Proceed as follows:

1. Select the file(s) you wish to minimize in the Pool.

2. Select “Minimize File” on the Media menu.
An alert appears, informing you that the entire Edit History will be cleared. 
Click Minimize to proceed or Cancel to stop the process. 

3. After the minimizing is finished, another alert appears, 
because the file references in the stored project have be-
come invalid. 
Click Save Now to save the updated project or click Later to proceed 
with the unsaved project. 

Only the audio portions actually used in the project remain 
in the corresponding audio file(s) in the Pool Record folder.

Prepare Archive
The option “Prepare Archive” on the Media menu is useful 
if you want to archive a project. It verifies that every clip 
referenced in the project is located in the same folder, and 
takes actions if that is not the case: 

• Any files that are located outside the current project 
folder will be copied into it.
Please note that audio files that reside within the project folder will not be 
copied to the audio folder. You will therefore have to copy them there 
manually before backing up the audio folder or save them separately dur-
ing backup, see below.

• If any processing has been applied, you will be asked 
whether you want to Freeze Edits.
If you do this, you don’t have to archive the Edits folder. Everything belong-
ing to the project will be contained in the project file and the Audio folder.

Once you have performed a Prepare Archive, you can copy 
the project file, the Audio folder and any other audio mate-
rial you saved in the project folder to backup disks, etc.

It is not necessary to archive the Images folder, since 
these Images can be recreated by Nuendo. You may also 
find a file with the extension “.csh” in the project folder. 
This contains image information for edited clips and other 
data that can be recreated, so it can safely be deleted.

Importing and exporting Pool files
You can import or export a Pool as a separate file (file ex-
tension “.npl”), by using the “Import Pool” and “Export 
Pool” options on the Media or context menu. 

When you import a Pool file, the file references in it are 
“added” to the current Pool.

Since the audio and video files are only referenced but 
not saved in the Pool file, the Pool import is only useful if 
you have access to all referenced files (which preferably 
should have the same file paths as when the Pool was 
saved).

You can also save and open libraries. These are stand-
alone Pool files that are not associated with a project.
See “Working with libraries” on page 490.

! Video clips are always referenced and not stored in 
the project folder.
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Convert Files

Selecting the option “Convert Files” on the Media or con-
text menu opens the Convert Options dialog which oper-
ates on selected files. Use the pop-up menus to specify 
which audio file attributes you want to keep and which you 
want to convert. The available settings are:

• Sample Rate
Keep as is, or convert to a sample rate between 8.000 and 96.000 kHz.

• Sample Width
Keep the sample width (resolution) as is, or convert to 16 bit, 24 bit or 
32 Bit float.

• Channels
Keep as is, or convert the file to Mono or Stereo Interleaved.

• File Format
Keep as is, or convert to Wave, AIFF, Wave 64 or Broadcast Wave format.

Options

When you convert a file, you can use the Options pop-up 
to set one of the following options regarding what to do 
with the new file:

Conform Files
By using this command, you will change all selected files 
that have different file attributes than what is specified for 
the project, to conform to this standard.

Proceed as follows:

1. Select the clips in the Pool.

2. Select “Conform Files” on the Media menu.
A dialog opens allowing you to choose between keeping or replacing the 
original unconverted files in the Pool. The following applies:

• Clip/event references in the pool are always redirected to the 
conformed files.

• If any “keep” option is selected, original files remain in the 
Project’s Audio folder and new files are created.

• If you select the “Replace” option, files in the Pool and in the 
Project’s Audio folder are replaced.

Extract Audio from Video
This Media menu item allows you to extract the audio from 
a video file on disk. It automatically generates a new audio 
clip that will appear in the Pool Record folder. The result-
ing clip will have the following properties:

• It will get the same file format and sample rate/width as 
in the current project.

• It will get the same name as the video file.

This function is not available for mpeg video files.

Option Description

New Files Creates a copy of the file in the audio folder and converts 
this new file according to the chosen attributes. The new 
file is added to the Pool, but all clip references will still 
point to the original, unconverted file.

Replace Files Converts the original file without changing clip refer-
ences. The references are however saved with the next 
save action.

New + Replace 
in Pool

Creates a new copy with the chosen attributes, replaces 
the original file with the new one in the Pool and redirects 
the current clip references from the original file to the 
new file. This is the option to select if you want your audio 
clips to refer to the converted file, but still want to keep 
the original file on disk (e.g. if the file is used in other 
projects).
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Introduction

One of the biggest challenges in typical project studio en-
vironments is how to manage the ever-growing number of 
plug-ins, instruments, presets, etc. Nuendo provides a 
truly universal, fully integrated solution to this problem: 
VST Sound.

What constitutes VST Sound?
The Nuendo VST Sound is what links the MediaBay and 
instrument tracks as well as track and VST3 presets. 

• The MediaBay is a universal Media Management Sys-
tem providing different views that allows you to find and 
tag media files, quickly import media files into projects and 
more (see “The MediaBay” on page 314).

• Instrument tracks are a sound-oriented combination of 
MIDI tracks and VST Instruments, another way of applying 
sounds to tracks easily (see “VST Instruments and Instru-
ment tracks” on page 189).

• Track presets are a combination of track settings, ef-
fects and mixer settings that can be applied to new tracks 
of various types. So right from the start, you can set up 
your tracks for a specific sound (see “Track Presets” on 
page 327). 

• With the introduction of the VST3 plug-in standard, Nu-
endo makes use of VST presets as an additional way to 
apply sounds to instrument tracks and effects to audio 
track (see “Inserts and EQ settings from track presets” on 
page 337). Plug-in parameters can be saved as VST pre-
sets, and you can also generate VST presets (i.e. sounds) 
from VST2 Instruments.

You can identify VST Sound features through the VST 
Sound logo.

The VST Sound logo

The VST Sound logo is used in various places in Nuendo, 
for example:

• In the Inspector as a button for applying track presets.
You will only see track presets corresponding to the type of track you are 
working on.
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• In the Inspector for instrument tracks as a button for ex-
tracting sounds.

• In the Inspector or the Channel settings window as but-
tons for extracting Inserts or EQ settings from track presets.

What can VST Sound do for you?
• VST Sound allows you to manage any sound from any 
software or hardware synthesizer under a single, unified 
user interface.

• VST Sound can help you find any sound, not only by in-
strument but also by category, type, style, character or 
other attributes (Track presets organized in the MediaBay).

• VST Sound comes with more than 1000 ready-to-play 
sounds, which are also conveniently organized by instru-
ment category, type, and character. These can even be in-
stantly previewed before loading (Instrument track presets 
managing the VST instruments – again organized in the 
MediaBay).

• VST Sound can manage your VST plug-in presets. 
These can be organized and categorized to form one big 
effects library (VST presets organized in the MediaBay).
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Introduction
Modern media production involves having to deal with a 
multitude of media files, e.g. audio, MIDI, video, etc.

Nuendo features a powerful media file management data-
base that allows you to control all your media files from 
within your sequencer program. This may involve several 
different tasks: 

• You can browse the folders of your file system to view 
folders and files.

• You can define searches to find specific files and filter 
the search results.

• You can organize your files in a folder structure.

• You can use the tagging features to assign your files to 
specific categories, and use these categories as the basis 
for your searches.

Which file formats are supported?
The following media file formats are supported by the Nu-
endo Media Management System:

• Audio: .wav, .w64, .aiff, .aifc, .rex, .rx2, .mp3, .mp2, .ogg, 
.sd2, .wma (Windows only)

• MIDI: .mid and .midiloop

• Track Presets: .trackpreset
These are templates for audio tracks, MIDI tracks and instrument tracks. 
Track Presets are described in detail in the chapter “Track Presets” on 
page 327.

• VST Presets: .vstpreset
VST presets are files containing all parameter settings for a particular 
VST plug-in. VST preset files are described in detail in the section “In-
serts and EQ settings from track presets” on page 337.

• Video: .avi, .mov, .qt, .mpg, .wmv (Windows only)

• Project files (from Cubase, Nuendo, Sequel): .cpr, .npr, 
.steinberg-project

Accessing the Media Management System
Nuendo provides the following options to access the 
Media Management System:

• Pull down the Media menu and select “Open MediaBay”, 
“Open Loop Browser” or “Open Sound Browser” (or use 
the respective key commands).
When one of these windows is open, selecting the menu option or using 
the key command will close it instead.

The preconfigured windows of the Media 
Management System
The Media Management System in Nuendo can be ac-
cessed via the MediaBay, the Loop Browser or the Sound 
Browser.

Which of these to use depends entirely on your working 
environment, and you may find that you want to change 
the default setup to better meet your requirements.

• By default, the MediaBay is configured to show all win-
dow sections and display all file types. The default search 
mode is Details search.
If you want to work on media files of various types, if you have to move 
files to different locations using the Browser section, or if you want to 
perform other general file management tasks, the MediaBay is probably 
the best view configuration.

• The Loop Browser is configured to show audio files, with 
Category search mode selected by default.
Use this if your focus is on audio files of any kind.

• The Sound Browser is focussed on the VST Sound 
node (see “The VST Sound node” on page 318). Its filter 
buttons are set to showing track preset and VST preset 
files. Its default search mode is the Category search.
Use this if you want to work with the available presets.

Whenever you read about the “MediaBay” in this manual, 
please remember the following:

The MediaBay is only one of these three preconfigured 
views of the Nuendo Media Management System. In the 
MediaBay window, all controls of the Media Management 
System are visible by default, so we will refer to the Media-
Bay throughout this manual when describing functions. 
However, what you can do in the MediaBay can also be 
done in the Loop Browser and the Sound Browser.
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Window overview

The info line
The info line is located at the bottom of the window.

The info line shows the number of files displayed in the 
Viewer section and the path to the folder selected in the 
Browser section in which these files were found.

MediaBay sections
You can use the three buttons below the Browser section 
to show/hide the respective sections in the MediaBay 
window. The Viewer section cannot be hidden.

Click this button to hide the Browser section.

• You can change the size of the individual sections by 
dragging the divider line between two sections.

• When saving a Nuendo project, the current status of the 
MediaBay is also saved.
This means that if the MediaBay was open when you saved a project, it 
will be opened again the next time you open this particular project. The 
last MediaBay window configuration will also be restored.

Browsing for media files
To the left in the default MediaBay window you will find 
the Browser section. 

The Browser section of the MediaBay window

Note that the Browser section can only show folders; 
any media files contained in a selected folder are dis-
played in the Viewer section to the right.
This also depends on the “Deep Results” setting, see “Filtering the 
Viewer display” on page 319.

The Scope section, 
see “Previewing files 
in the Scope sec-
tion” on page 322.

The Tag Editor, see 
“The Tag Editor” 
on page 323.

The Viewer 
section, see 
“Finding files 
in the Viewer 
section” on 
page 319.

The Browser 
section, see 
“Browsing for 
media files” 
on page 316.

The Filter section, see “Finding files in the Viewer section” on page 319.
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Scanning operations
When you open the MediaBay, the Loop Browser or the 
Sound Browser for the first time, a scan for the media files 
needs to be performed. Specify which folders or directories 
should be included in the scan by activating the check 
boxes to the left of their name. Depending on the amount of 
media files on your computer, the scan may take a while. 
The scan result is saved in the MediaBay database. 

• To include a folder, activate its check box.

These folders will be scanned for files.

• You can also only scan individual subfolders.
This will be reflected in the icon for the folder the subfolder resides in.

Only the VST3 Presets subfolder of the Factory Content folder will be 
scanned for files. The Track presets folder will not be searched.

When you select a folder in the Browser display, the 
MediaBay will scan this folder and all its subfolders for 
media files, even if they have been scanned before (unless 
“Rescan on select” is deactivated, see below).

• When “Stop scanning folders when closing MediaBay” 
is activated in the Preferences dialog (MediaBay page), 
Nuendo will scan for media files only when the MediaBay 
window is open. When this is deactivated, the folders will 
be scanned in the background, even when the MediaBay 
window is not open.
Even if scanning in the background is activated, Nuendo will not scan 
folders while playing back or recording.

Scanning indicator and status

At the top right in the in the Viewer section, you will find 
the scanning indicator, which shows whether the Media-
Bay is scanning for files or whether the scan is complete.

• When the folders specified in the Browser section are 
being scanned, the scanning indicator appears.

• When the scan is complete, the scanning indicator will 
not be shown.

The scanning status for the individual folders in the 
Browser section is indicated by the color of the icons:

• A red icon means that this folder is currently being scanned.
• A light blue icon means this folder has been scanned.
• Orange folder icons are displayed when a scanning process 

was interrupted. 
• Yellow icons are displayed for folders that have not been 

scanned.

Deep Results

Clicking the “Deep Results” button switches the Viewer 
display between showing only the folders and files con-
tained in the selected folder, and showing the files con-
tained in the selected folder and in any subfolders (without 
showing the subfolders).

The Deep Results button

About “Rescan on Select”

The “Rescan on Select” button

• When this button is activated, selecting a folder in the 
Browser section will always cause this folder to be re-
scanned. This ensures that the MediaBay will always dis-
play the current content of a folder.

• When “Rescan on Select” is deactivated, you can always 
right-click in the Browser section and select “Refresh” from 
the context menu to force a rescan of the currently selected 
folder.

When this indicator ap-
pears, a scan is performed.

! When a folder contains a large number of media files, 
the scanning process may take some time – you may 
want to deactivate “Rescan on Select”, if you know 
that you haven’t made any changes to the content of 
your media folders since they were last scanned.



318

The MediaBay

Folder operations
The Browser section shows the folder structure of your 
computer’s file system in a way very similar to the Win-
dows Explorer or the Mac OS Finder:

• Click on the folder icons in the Browser display to se-
lect the corresponding folder.

• Double-click on the folder icons in the Browser display 
to open the corresponding folder.

• When a folder contains subfolders, this is indicated by a 
plus icon in front of the folder icon. The plus icon changes 
to a minus icon when the folder is open. To open or close 
a folder, you can also click the plus/minus icons.

• You can switch the Browser display between the Full 
view and the Focus view.
Focussing a selected folder means showing only this folder and any sub-
folders it contains. Any folder levels above the focussed folder are not 
displayed. When you switch back to the Full view, the entire file system 
node can be accessed.

The Focus view for the Audio folder.

• You can hide all folders not being scanned for files by 
clicking the “Show Mediabay Managed Items Only” button.
This will keep the list less cluttered.

• Use the buttons “Previous Browse Location”, “Next 
Browse Location” and “Browse Containing Folder” to 
navigate to folders.
Click “Previous Browse Location” or “Next Browse Location” to select 
the previous or next folder in a sequence of previously selected folders. 
Clicking the “Browse Containing Folder” button will select the parent 
folder of the previously selected folder.

• You can create a new folder inside the folder selected in 
the Browser section by clicking the “Create New Folder” 
button (the folder icon).
A dialog is opened in which you can enter a name for the new folder.

The VST Sound node

The VST Sound node in the Browser section.

The Browser section provides a shortcut to user content 
and factory content files, including the preset folders. You 
find this node at the top of the Browser folder hierarchy, at 
the same level as the File System node. 

• The folders below the VST Sound node represent the 
folders in which content files and newly created track pre-
sets, VST presets, etc. are stored by default.
To find out the “true” location of such a file, right-click on it in the Viewer 
section and select “Open in Explorer” (Win)/“Reveal in Finder” (Mac). 
This will open an Explorer/Finder window in which the corresponding file 
is highlighted.

Creating Favorites
If you constantly find yourself returning to specific folders 
during your work, you can save these browse locations as 
presets so that selecting such a preset will take you to the 
folder instantly. Proceed as follows:

1. Select the desired folder in the folder display.

2. Click the Add Browse Location Preset button (the “+” 
icon).
A naming dialog for the new preset is displayed.

3. Accept the default name (the complete folder path) or 
enter a new name for the preset.

The “Create new 
folder” button

The folder navigation 
buttons
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4. Click OK.
The new preset is added to the Select Browse Location Presets pop-up 
menu (which can be opened by clicking on the down arrow icon).

When you now open the Select Browse Location Presets 
pop-up menu and select the new preset, the respective 
preset folder will be selected in the Browser display.

• To remove a preset from the Select Browse Location 
Presets pop-up, select it from the pop-up and click the 
“Remove Browse Location Preset” button (the “-” icon).

Finding files in the Viewer section
The Viewer section consists of two panes: the Filter section 
at the top and below it, the Viewer display. In the Filter sec-
tion, you can set up filters and define searches for specific 
files. The Viewer display lists any files contained in the folder 
selected in the Browser, and tags of these files. How to set 
up the tag display in the Viewer is described in the section 
“Managing the tag lists” on page 323. 

Note that it is only possible to edit tags in the Viewer if 
“Allow Editing in Viewer” is activated in the Preferences 
dialog (MediaBay page). 
When this preference is deactivated, editing is only possible in the Tag 
Editor (see “Editing tags in the Tag Editor” on page 324).

The Viewer section

Depending on your settings, the number of files displayed 
in the Viewer can be huge (the info line at the bottom of 
the window shows the number of files found with the cur-
rent filter settings). Therefore, the MediaBay provides a 
number of ways to display only specific files and to per-
form very refined file searches.

By default, the number of files displayed in the Viewer 
section is limited to 10,000 files. You can change this by 
specifying a new value for “Maximum Number of Results in 
Viewer” in the Preferences dialog (MediaBay page).

Filtering the Viewer display
The MediaBay provides a number of filter buttons that can 
be used to limit the number of files displayed in the Viewer 
section.

• At the top of the Viewer section you will find the filter 
buttons that can be used to show all supported file types 
or any combination of file types.
For example, when you activate the Audio and the MIDI filter buttons, 
only the audio and the MIDI files contained in the folder selected in the 
Browser will be displayed. When none (or all) of these buttons are acti-
vated, files of all supported types will be displayed.

The filter buttons. The display is filtered to show only audio files.

Defining searches for specific files
The filter buttons let you find files according to the folder(s) 
they might be located in, or according to their file type. 
However, you can also perform very detailed searches for 
files that meet certain criteria.

• The Details search mode allows you to perform a search 
for a specific file tag value.
You define which tag to search for, e.g. “Name”, and specify the corre-
sponding value, e.g. “myfilename.wav”.

• In Category search mode, the Filter section will display 
all values found for a specific tag (or “category”). Select-
ing one of these values will result in a list of files all show-
ing this particular tag value.
For example, you could look for sample rates and pick 44.1 kHz to give 
you a list of all files with that particular sample rate. But Category search 
mode becomes really interesting when making extensive use of tagging – 
see “Performing a Category search” on page 320 and “Tagging media 
files” on page 325.
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• Once a search operation has been completed, the very 
first entry in the Viewer list is selected. When you now 
press [Tab] once, this selected entry will receive the focus 
and you can use the Up and Down arrow keys to browse 
the list of files.

Performing a Details search
The following section briefly describes how to perform a 
search for a particular file name in the file system.

Proceed as follows:

1. Select the root folder of your hard disk in the Browser 
section.

2. Select the Details search mode by clicking on the De-
tails tab at the top of the Filter section.

3. By default, the tag pop-up menu to the left is set to 
“Any Attribute”, and the condition pop-up menu in the 
middle is set to “contains”.
Leave these as they are.

4. Enter part of the name of the file that you wish to find 
in the text field to the right.
Note how the search is performed anew every time you enter a new let-
ter. Detail searches are not case sensitive.

A Details search for files whose names contain “e-piano”.

• The Tag pop-up menu shows an alphabetical list of file 
tags you can choose from. At the top of the pop-up menu, 
the MediaBay maintains a smaller list of the last 5 tags se-
lected during previous searches.
Note that you can select more than one tag. This will create an OR con-
dition: the files found will match either one or the other tag. Click OK to 
set the tag(s) to search for. How to configure the tag list is described in 
the section “Managing the tag lists” on page 323.

• To reset all search fields to their default settings, click 
the Reset button in the top right corner of the Filter section.
This will also reset the tag list settings.

The Reset button in the Filter section

• The condition pop-up menu contains the following op-
tions:

• Note that for all conditions except “range”, you can en-
ter more than one string in the text field (separate different 
search strings with a space).
These strings form an AND condition, i.e. the files found will match all 
strings entered in the field.

• To open a new filter line, move the mouse pointer to the 
right end of the text field and click the “+” button that ap-
pears.
This way, you can set up up to five additional filter lines in which you can 
define new search conditions. Note that two or more filter lines form an 
AND condition, i.e. the files searched for must match the conditions de-
fined in all filter lines. Click the “-” button for a filter line to remove it.

Performing a Category search
The MediaBay allows you not only to view and edit some 
of the standard file attributes found in all computer files, 
but it also provides preconfigured tags, or “categories”, 
that you can use to organize your media files. 

The advantages of such categorization become obvious 
when having to find one specific file, e.g. a certain guitar 
sound, among large numbers of media files from various 
contexts, without knowing the name of that file.

Enter the file name here.

Option Description

contains The searched tag value must contain the text or number speci-
fied in the text field to the right.

omits The searched tag value must not contain the text or number 
specified in the text field to the right.

equals The searched tag value must match the text or number speci-
fied in the text field to the right, including any file extension. Note 
however, that detail searches for text are not case sensitive.

>= The searched tag value must be higher than, or equal to, the 
number specified in the field to the right.

<= The searched tag value must be lower than, or equal to, the 
number specified in the field to the right.

is empty You can use this option to find files for which certain tags have 
not been specified yet.

range When “range” is selected, you can specify a lower and an up-
per limit for the searched tag value in the fields to the right.
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When you select the Category search mode, the Filter 
section will show the tag columns, each with its own list of 
tag values. 

The default setup of Category search mode

By clicking on individual tag values in the tag columns, you 
define the search filter: only the files that match the se-
lected tag values will be displayed in the Viewer. Select 
more tag values from other columns to further refine your 
search.

• Selected tag values in the same tag column form an OR 
condition.
This means that files must be tagged according to either one or the other 
value to be displayed in the Viewer section.

For the “Style” tag, the files found will show either the “Blues” OR the 
“Jazz” tag value.

• Tag values in different columns form an AND condition.
This means that files must be tagged according to all these values to be 
displayed in the Viewer section.

The files found will belong to the “E. Guitar” sub category tag AND 
show “Blues” for the Style tag.

Categorization by tagging makes it easy to organize your 
media files. How to assign tag values to your files is de-
scribed in the section “The Tag Editor” on page 323 and 
in the section “Tagging media files” on page 325. 

Note that you can use existing tags or use the user tag 
feature (see “Defining user tags” on page 324) to create 
your own categories.

Category searches are used not only in the MediaBay, but 
throughout Nuendo in various VST Sound-related con-
texts (see the chapter “VST Sound” on page 311).

! By default, the first two tag columns are set to “Cate-
gory” and “Sub Category”. These tags are directly 
linked to each other: for each Category value, there is 
a number of Sub Category values. Changing to a dif-
ferent Category value in the first tag column will give 
you different values in the Sub Category column!

! Each tag column displays only the tag values found 
in the folder selected in the Browser section of the 
MediaBay! This means that selecting a different 
folder in the Browser may lead to the display of dif-
ferent Category search settings.

These tag values were found in the currently selected folder.

The files displayed in the Viewer match the selected tag values.
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Further options for Category searches

• The text field at the top serves as an additional name fil-
ter: you can enter a file name or part of a file name here.
This corresponds to a “Name: contains” Details search, which means 
that the name of the searched file must contain the text you enter here. 
See also “Performing a Details search” on page 320.

In addition to the filter defined by the tag columns, the name of the 
searched file must contain “120bpm”.

• You can change which tag is displayed at the top of 
each tag column by clicking on the tag and selecting a dif-
ferent tag from the Filter tag list pop-up menu.
How to configure the Filter tag list is described in the section “Managing 
the tag lists” on page 323.

• To select a tag value, simply click on it. To deselect it, 
click the value again.
Note that you can select more than one value in each tag column.

• Click the Reset button on the top right of the Filter sec-
tion to clear all settings in the tag columns.
This will also reset the tag list settings.

Previewing files in the Scope section
Below the Viewer you will find the Scope section. It allows 
you to play back files selected in the Viewer section.

The elements visible in this section and their functions 
depend on the type of media file selected in the Viewer.

Previewing audio files

The Scope section for an audio file.

• To preview an audio file, simply click the Start button.

• When Auto Play is activated, selecting a file in the 
Viewer will automatically start playback.

• When “Play in Project context” is activated, the file will 
be played back together with the current project, starting 
at the current project cursor position.

Previewing MIDI files

The Scope section for a MIDI file.

• To preview a MIDI file (.mid), you first have to select an 
output device in the Output pop-up.
The “Auto Play” and “Play in Project context” options work in the same 
way as with audio files.

• Auto Play and “Play in Project context” work as for audio 
files, see above.

Previewing MIDI loops

• To preview a MIDI loop file, click the Start button.

• Auto Play works as for audio files, see above.
MIDI Loops are always played in the project context.

! The Scope section does not play back video files or 
project files. Also, it is not possible to preview audio 
track presets in the MediaBay (see below).

Auto Play Play in Project 
context

Preview levelTransport controls

Output Auto Play Play in Project 
context

Transport controls
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Previewing track and instrument presets

The Scope section for a MIDI track preset.

Track presets for MIDI or Instrument tracks and VST plug-
in presets require MIDI notes for previewing. There are 
two ways these notes can be sent to the track template:

• Click the “MIDI Input” button and play MIDI notes on a 
MIDI keyboard connected to your system.

• Clicking “Choose MIDI File” will open a file dialog where 
you can navigate to a MIDI file. When you now click “Play”, 
the notes received from the MIDI file will be played with 
the settings of the track preset applied.

Track presets for audio tracks cannot be previewed in the 
MediaBay. You can do this in the Apply Track Template 
dialog (for further information, see “Previewing track or 
VST presets before applying” on page 336).

The Tag Editor
When a file is selected in the Viewer section, the Tag Editor 
shows a two-column list of tags and tag values for this file.

Tags for media files (also called “attributes”) are sets of 
metadata providing additional information on the file. The 
different types of media files have different tags: for exam-
ple, for .wav audio files you will find standard tags like 
name, length, size, sample rate, etc., while for .mp3 files, 
additional tags such as “Artist” or “Genre” are available.

The Media Management System provides further tags, 
such as “Category” or “Character”.

You have access not only to the standard tags and the 
preconfigured tags provided by Nuendo, but you can also 
define your own tags and add these to your files. 

The following sections describe how to set up the various 
tag lists, how to edit tags in the Tag Editor, and how to de-
fine user tags.

Managing the tag lists
Lists of tags and tag values are used in various places in 
the MediaBay window. You can configure these lists and 
define certain tag properties in the Manage Tags dialog.

Proceed as follows:

1. Open the Manage Tags dialog by clicking on the Man-
age Tags button in the lower right corner of the MediaBay 
window.

2. Click one of the filter buttons at the top of the Manage 
Tags dialog to select the file type for which you want to 
configure the tag lists.
The Manage Tags dialog shows a list of all tags available for the media 
files supported by the MediaBay, and three columns of checkboxes, one 
for the Filter section, one for the Viewer and one for the Tag Editor.

3. To display a certain tag in the Filter tag lists, the Viewer 
or the Tag Editor, activate the corresponding checkbox for 
this tag:

4. Close the Manage Tags dialog by clicking its close box.
Your settings will be applied.

• The Type column shows whether the value for a tag is a 
number, text or a Yes/No-type switch. The Precision col-
umn shows the number of decimals displayed after a point 
for number tags.

 MIDI In activity

The “Category” tag 
is selected for dis-
play in the Filter tag 
lists, the Viewer and 
in the Tag Editor.
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• Click and drag in the tag display to select several tags 
(click somewhere outside the selected area to deselect).
This way, you can activate/deactivate all selected check boxes in one go.

• To return to the default tag display settings for the Filter, 
Viewer and Tag Editor sections, click the “Reset to Default” 
button (above the tag display) in the Manage Tags dialog.

Displaying tags in the Tag Editor

You can switch the tag display in the Tag Editor:

• Click on “Managed” to show only the tags activated for 
display in the Manage Tags dialog.
Use this view to limit the tag display to only those tags that are of interest 
to you.

• Click on “All” to show all tags for the file selected in the 
Viewer for which values are available.
Use this display if you wish to see all tags, including standard file at-
tributes such as Name, Size or Date Modified.

Displaying tags in the Viewer

Most of the time, tags displayed in the MediaBay are 
sorted alphabetically. Only in the Viewer can you change 
the tag display order:

• Move the mouse pointer to a column heading, click and 
drag that heading to a different position in the display.

Editing tags in the Tag Editor
You can use the Tag Editor to edit tag values of the vari-
ous media files. 

Note that changing a tag value in the Tag Editor may 
permanently change the corresponding file.

When it comes to editing, you will notice that there are dif-
ferent types of tags:

• “Display only” tags cannot be edited. Their values are 
displayed in a slightly lighter color.
In this case, the file format probably doesn’t permit changing this value, 
or changing a particular value makes no sense (e.g. you cannot change 
the file size in the MediaBay, because you have no way of adding or re-
moving media information).

• Most tag values can be edited by double-clicking in the 
Value column of the Tag Editor.
Tag values can be text, numbers or yes/no switches. Simply enter/change 
the text, number or Yes/No setting in the field displayed for a value.

Renaming a file in the Tag Editor

• When clicking in the Value column for “Category”, “Sub 
Category” or “Style”, a pop-up menu opens from which 
you can choose a value.
The tags “Category” and “Sub Category” are directly linked to each 
other. The “Category” pop-up allows you to set a category, the “Sub 
Category” pop-up allows you to set a category and a corresponding sub 
category. If you pick a sub category from a category that is different from 
the category set for the “Category” tag, this tag will be changed as well.

• Clicking in the Value column for the “Character” tag will 
open the Edit Character dialog.
Click a radio button on the left or the right side and then click OK to de-
fine values for the Character tag.

• Clicking in the Value column for the Rating tag allows 
you to rate the file on a scale from 1 – 5.
For example, use this to indicate the file’s sound quality or its suitability 
for a certain purpose.

Defining user tags
You can define your own tags and save these in the Media-
Bay. You can use such user tags for example to define your 
own filter categories, further refining the categorization of 
your media files.

To define a user tag, proceed as follows:

1. Open the Manage Tags dialog by clicking the Manage 
Tags button in the lower right corner of the MediaBay win-
dow.

2. Click on the Add Tag button.
The Add User Tag dialog opens.

3. Enter a name for the new tag and define its type.
Tags can be of type “Text”, “Number” or “Yes/No” switch.

• For tags of type “Number”, you can also specify how 
many decimals should be displayed after a decimal point.
Enter the corresponding value in the Precision field.
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4. Click OK.
The new tag is added to the list of available tags and can be displayed in 
the Tag Editor and the Viewer.

• To remove a user tag, select it in the Tags list and click 
the Remove Tag button.
The tag will be removed from all tag lists in which it was previously dis-
played.

Media management

General handling
• You can use the [Tab] key on your computer keyboard 
to move the focus between the different sections of the 
MediaBay window. Use the arrow keys to navigate to dif-
ferent folders, files or tags.

• When assigning tag values, note that you can select 
several files and assign the same tag value to all files.

File management
You can use the MediaBay for various file management 
tasks, similar to what you can do in the Windows Explorer/
Mac OS Finder.

• When the option “Show file extensions” is activated in 
the Preferences dialog (MediaBay page), file name exten-
sions (e.g. “.wav” or “.cpr”) will be displayed in the Media-
Bay. When this is deactivated, file extensions will not be 
shown.

Browser operations

The following tasks can be performed in the Browser sec-
tion:

• To delete a folder, right-click on the folder icon and se-
lect “Delete from Disk” from the context menu.
A warning message is displayed, asking you to confirm that you really 
want to move this folder to the operating system’s trash folder.

• To rename a folder, select it in the list, click on its name 
and enter a new name.

• You can drag & drop a folder to a different location.
You will be asked if you wish to copy or move the folder to the new 
location.

Viewer operations

• You can move/copy a file from the Viewer section to a 
different location by clicking and dragging it to a different 
folder in the Browser section.
You will be asked if you wish to copy or move the file to the new location.

• To insert a file into the project, right-click the file and se-
lect one of the “Insert into project” options from the con-
text menu.
This will import this file into your current project, either at the start of the 
project or at the current cursor position.

• To delete a file, right-click on it in the Viewer and select 
“Delete” from the context menu.
A warning message is displayed, asking you to confirm that you really 
want to move this file to the operating system’s trash folder.

• When the option “Allow Editing in Viewer” is activated 
in the Preferences dialog–MediaBay page, you can also 
edit tags in the Viewer.
Otherwise this is possible only in the Tag Editor.

Tagging media files
The search functions, especially the Category search 
mode, become a truly powerful media management tool 
when making extensive use of tagging.

Media files are usually organized in complex folder struc-
tures to provide a logical way of guiding the user to the 
desired files, with the folder and/or file names indicating 
the instrument, style, tempo etc.

To find a particular sound or loop in such a folder structure 
can be very time consuming – tagging is the answer! To 
assign a number of meaningful tags, e.g. to a library of 
loop files, proceed as follows:

1. Copy the loop files to your hard disk.
Tagging means editing the files, so you need them on your system.

2. Open the MediaBay and browse to where the new 
loops are located.

3. Navigate to a folder containing loops.
For example, you might have a folder containing Metal style drum loops, 
at 120bpm.

4. In the Viewer, select all files contained in this folder.
Make sure that the Deep Results button is deactivated, so that only files 
contained in this folder are displayed.
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5. Assign tags that reflect the information indicated by 
the folder structure.
In the above example, you would put “Metal” as a value for the Style tag, 
and “Drums” for the Instrument tag. The Tag Editor also allows you to 
display a “Tempo” tag, for which you could specify a value of “120”.

You can now use the Category search mode to find quickly 
all Metal style drum loops at 120bpm, without the need to 
navigate through a large number of folders and subfolders.
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Introduction
Track presets are templates that you can create from au-
dio, MIDI or instrument tracks – or several of these tracks. 
With these track presets, you can then create new tracks 
or apply them to existing tracks of the same type. 

The idea behind track presets is:

• To allow you to quickly access, browse, select, change 
and preview sounds.

• To give you an easy way to reuse channel settings 
across projects.

Track presets are part of the VST Sound concept (see 
“VST Sound” on page 311) and organized in the Sound 
Browser (a view of the MediaBay, see “The MediaBay” on 
page 314). This allows you to categorize track presets 
with tags like “EPiano” or “Jazz” and search for these tags.

Related topics

Nuendo offers a variety of related functions that allow you 
to handle presets of program settings:

• You can save and load channel settings in the mixer (not 
for MIDI), see “Saving mixer settings” on page 146.

• You can save and load inserts rack and EQ presets, see 
“Inserts and EQ settings from track presets” on page 337. 

• You can export and import tracks as track archives , see 
“Exporting and importing tracks” on page 500.

Types of track presets
There are four kinds of track presets:

• Audio

• Instrument (this also includes certain VST3 presets, see 
“VST (Instrument) presets” on page 330)

• MIDI

• Multi (any number of the three preset types above in any 
sequence)

Since the purpose of track presets is to make sound 
handling easier, only parameters are saved that are rele-
vant for the sound of a certain track.

Audio track presets
Track presets for audio tracks include all inserts and ef-
fects that “define” the sound. Since there are big differ-
ences between the typical settings for a trumpet and a 
human voice, for example, audio track presets are a quick 
way to optimize your track.

For example, you can:

• Easily audition your audio track with the factory presets.

• Use the factory presets as a starting point for your own 
editing.

• Save the audio settings that you optimized for an artist 
with which you often work and use the resulting audio 
track preset for future recordings.

Data saved in audio track presets

• Insert FX settings
• EQ settings (including VST effect presets)
• Volume + Pan
• Input Gain + Phase

Note that volume, pan, input gain and input phase will 
be restored only when creating a new track from a track 
preset.

Instrument track presets
Instrument track presets are best choice when handling 
sounds of simple, mono-timbral VST Instruments. Like the 
instrument track, they offer both MIDI and audio features. 

• You can use instrument track presets like the audio 
track presets above for auditioning your tracks, inspiration, 
or saving your preferred sound settings. 

• In addition, you can directly extract sounds from instru-
ment track presets and VST presets for use in instrument 
tracks.

VST presets also behave like instrument track presets, 
see “VST (Instrument) presets” on page 330.
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Data saved in instrument track presets

• Audio Insert FX
• Audio EQ
• Audio Volume + Pan
• Audio Input Gain + Phase
• MIDI Insert FX
• MIDI Track Parameters
• Input Transformer
• VST Instrument

And also:

• Staff settings
• Color settings

Volume, pan, input gain and input phase will be re-
stored only when creating a new track from a track preset.

MIDI track presets
MIDI tracks offer more possibilities than instrument tracks; 
therefore, they should be used for multi-timbral VST In-
struments and external instruments.

Due to the resulting complex settings, more details have 
to be taken into account when working with MIDI track 
presets, to ensure that the saved settings are really usable 
as presets for new tracks.

• To ensure that saved MIDI track presets for external in-
struments will work again with the same instrument later, 
install the instrument as MIDI device, because in this case 
the MIDI interface and the connecting ports are irrelevant. 
(For this to work, the MIDI device has to have exactly the 
same name as in the original setup.) For more information 
about this, see the separate pdf document “MIDI Devices”.

Include MIDI Channel or MIDI Patch

There is an additional Include option when creating MIDI 
track presets: 

• Choose “MIDI Patch” if you want to save the MIDI track 
preset with the currently set patch. This is useful if your ex-
ternal MIDI device offers sounds as certain patches but 
does not require any specific channel settings.

• Choose “MIDI Channel” if you want to save the MIDI 
track preset with the currently set channel. This is useful if 
you have the sounds of an external device always on the 
same channel, e.g. strings on channel 12, trumpets on 
channel 13.

The choice is exclusive – you can either save the 
channel or the patch, but not both.

Example 1: Multi-timbral external instrument

Assume you have a multi-timbral external instrument (for 
example, a MIDI Expander), with all sounds available on all 
channels, but the sounds (patches) might change.

In this case, set it up as an external instrument, open a 
MIDI track and select it as output. In the Programs List, 
select a patch. Then save the MIDI track preset with the 
patch included.

Example 2: Multi-timbral external instrument with pre-
configured setup

In a rarer case we have a multi-timbral external instrument 
(for example, a Sampler) which is completely pre-config-
ured. There is no sound (patch) to configure, but only the 
device and the MIDI channel to know. 

In this case, include the channel in the MIDI track preset 
so that the correct channel will be called up.

Example 3: VSTi as pre-configured setup

If you want to use a MIDI track preset for a pre-configured 
VST Instrument setup, the following conditions have to be 
met:

• The VST Instrument(s) are installed in the VST Instruments 
window.

• The VST Instrument patches have not been changed since the 
track preset was saved (that means for example that no other 
FXP/FXB was installed in the meantime).

To ensure this, use a template project with the VSTi setup 
included and put the sounds (track presets) of this tem-
plate project into specific subfolders, as they only work 
within this setup.
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Data saved in MIDI track presets

• MIDI Modifiers (Transpose etc.)
• MIDI Inserts (FX)
• Output + Channel or Program Change
• Input Transformer
• Volume + Pan

And also:

• Staff settings
• Color settings

Note that volume and pan will be restored only when 
creating a new track from a track preset.

Multi track presets
If you select more than one track when creating a track 
preset, the settings of all selected tracks will be saved as 
one multi track preset. Since you can apply a multi track 
preset only if the target tracks are of the same type, num-
ber and sequence as the tracks in the track preset, multi 
track presets are useful when you have a reoccurring situ-
ation with very similar tracks and settings.

For example, this would be the case for:

• Recording setups that require several microphones, 
e.g. when recording a drum set or a choir, where you 
record always under the same conditions and have to edit 
the resulting tracks in a similar way.

• Layered tracks, where you use several tracks to gener-
ate a certain sound instead of manipulating only one track.

Data saved in multi track presets

For each track type, the respective track preset parame-
ters are saved in the same sequence as the tracks in the 
Project window.

VST presets
As of VST3, VST presets make it easy for you to work with 
VST plug-ins and instruments, substituting the .fxp and 
.fxb files of the VST2 standard.

There are two kinds of VST presets:

• VST presets based on effect plug-ins
• VST presets based on VST Instrument plug-ins

In this manual, the wording “VST presets” stands for 
VST3 Instrument presets, unless stated otherwise.

VST effect plug-in presets
VST effect plug-ins are available in VST3 and VST2 for-
mat, for example as insert effects like Expander or Limiter. 
Therefore, VST effect presets can be part of audio track 
presets, see also “VST Sound” on page 311.

VST (Instrument) presets
VST3 (Instrument) presets (extension .vstpreset) are me-
dia files that can be managed in the Sound Browser and 
to which you can assign tags. VST presets are also listed 
in dialogs like the “Add Track” dialog, see below.

The VST presets behave like instrument track presets in 
the context of the Project window and contain a VST In-
strument and its settings but no modifiers, MIDI inserts, in-
serts or EQ settings:

• You can create instrument tracks from VST presets just 
like from instrument track presets, see “Creating tracks 
from track presets or VST presets” on page 333.
In the Inspector of the new instrument track, the VST Instrument, the se-
lected program and the name of the applied VST preset are displayed.

• You can apply VST presets to instrument tracks just like 
instrument track presets, see “Applying audio, MIDI and 
instrument track presets” on page 334.

• When selecting VST presets in the Browse presets 
section or the Sound Browser, you can preview them like 
instrument track presets, see “Creating tracks from track 
presets or VST presets” on page 333.

• Like with instrument tracks presets, you can extract the 
“sound” of VST presets, see “Extracting sound from an in-
strument track or VST preset” on page 335.



331

Track Presets

The programs of VST2 plug-ins also can be converted to 
VST3 presets. For more information about plug-ins, 
please refer to the separate manual “Nuendo Expansion 
Kit – Cubase Music Tools for Nuendo 4”.

Browsing for presets

Using the Sound Browser
When browsing track presets, the quickest way is to use 
the Sound Browser, as it is set up specifically to display 
track and VST presets. 

To open this browser, select “Open Sound Browser” on 
the Media menu.

The Sound Browser.

In the Sound Browser, you can preview track and VST 
presets as well as select them to drag and drop them into 
the project to create new tracks (see “Creating tracks 
from track presets or VST presets” on page 333) or to ap-
ply them to existing tracks (see “Applying audio, MIDI and 
instrument track presets” on page 334).

The general handling of the Sound Browser is the same 
as for the MediaBay, see “The MediaBay” on page 314.

Dialogs related to VST Sound
When you work with track presets, you will find the same 
user interface in all “Add Track” and “Browse Sounds” dia-
logs and the Presets browser.

Note that some of the dialogs will save their last state. 
They may therefore not look exactly like the dialogs de-
scribed below.

Browse Presets section

When you create a new track, the Add Track dialog opens:

The “Add MIDI Track” dialog.

(For a more detailed description of the Add Track dialog, 
see “Handling tracks” on page 38.)

Click “Browse Presets...” to open the Browse Presets 
section with the Category search and a list of all available 
presets. For details, see “Performing a Category search” 
on page 320.

The Add Track dialog with the Browse Presets section opened.
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Browser section

In addition to the Browse Presets section, you can click 
“Show Location” to open the Browser section. It is similar 
to the one in the MediaBay (see “Browsing for media files” 
on page 316), but only necessary if you want to take an 
explicit look at the contents of Presets subfolders, as you 
can’t move up to other folders.

The Add Track dialog for a MIDI track with all sections open.

When you select a MIDI or instrument track preset (or a 
VST preset), you can see a preview section below the list. 
The preview works like the one in the Scope section in the 
MediaBay (see “Previewing MIDI, instrument and VST 
presets independently of tracks” on page 336).

The Presets browser

When you apply a track or VST preset to an existing track 
or when you extract a sound, the Presets browser opens, 
allowing you e.g. to preview the presets.

The Presets browser for an audio track preset.

The Browse Sounds dialog

Normally, the view of the Browse Presets section is fil-
tered to show only track presets of a certain kind. There-
fore, if you want to see all available presets, e.g. also multi 
track and VST presets, you can open the Browse Sounds 
dialog. 

Browse Sounds dialog showing all available track and VST presets.
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Creating a track preset
A track preset is created from an existing audio, MIDI or 
instrument track – or several of these tracks. Proceed as 
follows:

1. Select one or more tracks in the Project window. 
If several are selected, all of them are stored in one combined multi track 
preset, see “Multi track presets” on page 330.

2. Right-click one of the selected tracks in the track list to 
open the context menu and select “Create Track Preset”.
The Save Track Preset dialog opens. The buttons on top work like the cor-
responding ones in the MediaBay, see “Folder operations” on page 318.

3. Enter a file name in the “File Name” field.
The track preset file name extension .trackpreset is assigned automatically.

In the case of MIDI files, you have the additional option of 
including the MIDI channel or the MIDI patch, see “Include 
MIDI Channel or MIDI Patch” on page 329.

4. If you want to apply tags, click on “Tag Editor”.
The available tags are displayed (on how to edit the list of available tags, 
see “Managing the tag lists” on page 323). To enter a value, click in the 
value field. For many tags, e.g. “Character” and “Style”, pop-up menus 
open in which you can select an entry. In case of a free text entry, enter 
the text in the text field. For more information about the Tag Editor, see 
“Editing tags in the Tag Editor” on page 324.

As the category search is based on the tags, we highly 
recommend that you use them.

5. Click OK to create the track preset.

Track presets are saved in the “Track Presets” folder in 
default subfolders named according to their track type 
(audio, MIDI, instrument and multi). For further information, 
see “Where are the settings stored?” on page 514.

All presets are available under the (virtual) VST Sound 
node, see “The VST Sound node” on page 318.

Creating tracks from track presets 
or VST presets

Creating tracks via drag and drop
1. Open the Sound Browser.
You can also drag and drop from the Windows Explorer or the Mac OS 
Finder, but in this case, no preview for MIDI and instrument track presets 
is possible.

2. Select a track or VST preset from the list of all presets. 
At this point you can preview selected MIDI and instrument track presets 
as well as VST presets, see “Previewing MIDI, instrument and VST pre-
sets independently of tracks” on page 336.

3. Drag and drop the track preset onto the track list in the 
Project window.
One or more (in case of multi track presets) tracks will be created. If you 
drag and drop a VST instrument preset, this will result in an instrument 
track.

Creating tracks in the Browse Sounds dialog
1. Right-click the track list to open the context menu and, 
on the Add Track submenu, select “Browse Sounds…”.
The Browse Sounds dialog opens.

2. Select a track or VST preset from the list of all presets. 
At this point you can preview selected MIDI and instrument track presets 
as well as VST presets, see “Previewing MIDI, instrument and VST pre-
sets independently of tracks” on page 336. If you want to list a certain 
track preset type only, open the respective folder in the Browser section.

3. Click OK to create one or more (in case of multi track 
presets) tracks.

! You cannot change the default folders, but you can 
add further subfolders, e.g. “drums” and “choir”.
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Creating one or more audio, MIDI or instrument 
tracks with the Add Track function
1. To create one or more new tracks from a track preset, 
proceed as if adding a new track by selecting the corre-
sponding option on the context menu (or by using the key 
command). 
A dialog opens, in this example the “Add Audio track” dialog:

• If you want to create more than one track of this type, 
enter the number in the Count field.

2. Click “Browse Presets” to open the Browse Presets 
section of the “Add Track” dialog.
The view is filtered to show only the corresponding track presets, e.g. if 
you choose “Add Audio Track”, only audio track presets will be displayed. 

3. Select a track or VST preset.
At this point, you can preview selected MIDI and instrument track presets 
as well as VST presets, see “Previewing MIDI, instrument and VST pre-
sets independently of tracks” on page 336. 

4. Click OK to create the track(s).
The new track(s) will be named after the original track (not the track pre-
set).

As adding multiple tracks is not available as menu op-
tion, multi track presets can only be used for track creation 
via drag and drop or the “Browse Sounds” dialog.

Applying track presets
Track presets can be applied to tracks of their own type 
only, i.e. audio track presets to audio tracks, etc. 

When you apply a track preset, all saved settings are ap-
plied, see “Types of track presets” on page 328.

• For instrument tracks, VST presets are also available. 
Since VST presets have no modifiers, MIDI inserts, inserts 
or EQs, applying them leads to removal of your current 
settings for these, see “Inserts and EQ settings from track 
presets” on page 337.

Applying audio, MIDI and instrument track 
presets

Applying track or VST presets via drag and drop

1. Open the Sound Browser from the Media menu.
You can also drag and drop from the Windows Explorer or the Mac OS 
Finder, but in this case, no preview for track presets is possible.

2. Select a track or VST preset.
At this point, you can preview selected presets, see “Previewing track or 
VST presets before applying” on page 336.

3. Drag and drop it onto a track of the same type.

Applying track or VST presets in the Inspector or the 
context menu of the track

Proceed as follows:

1. Select a track in the Project window.

2. Click the VST Sound button in the Inspector or right-
click the track to open the context menu and select “Apply 
Track Preset”.

Click here to open the Presets browser.

In both cases, the Presets browser opens. Here, the files 
are sorted by categories.
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3. Select a track or VST preset from the list to the right.

At this point you can preview selected presets, see “Pre-
viewing track or VST presets before applying” on page 336.

4. Click outside the browser to apply the selected preset 
or click the Reset button below the list to return to the un-
changed track.

Once the track preset is applied, you cannot undo the 
changes!

In the Inspector, you can see which preset was applied 
last, in this example “Jazz Bazz”.

Applying a multi track preset
To be able to apply a multi track preset, certain require-
ments have to be met. Proceed as follows:

1. Select several tracks in your project. 
The selected tracks have to be of the same type, number and sequence 
as the tracks in the track preset.

2. Right-click the track to open the context menu and se-
lect “Apply Track Preset”.
The Presets browser opens. Only multi track presets corresponding to 
the selection of tracks in the project will be shown. 

3. Select a multi track preset from the list.

4. Click outside the browser to apply the selected preset 
or click the Reset button below the list to return to the un-
changed track.

Once the track preset is applied, you cannot undo the 
changes!

Reloading track or VST presets
To revert to the default settings of the applied preset, click 
the “Reload Track Preset” button.

Applying another track or VST preset
To apply another track or VST preset, open the Presets 
browser as described above and select another preset.

Removing a track or VST preset from a track
It is not possible to remove an applied preset from a track 
and return to the previous state. If you are unsatisfied with 
the track settings, you can either edit the settings manually 
or apply another preset.

Extracting sound from an instrument track or 
VST preset
For instrument tracks, you can extract the “sound” of an 
instrument track preset or VST preset, that means the VST 
Instrument and its settings.

Proceed as follows:

1. Select the instrument track to which you want to apply 
a sound.

2. Click the VST Sound button below the Output Rout-
ing field in the Inspector. 

The Presets browser opens, showing a list of all available 
presets. 
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3. Select an instrument track preset or VST preset and 
click OK. 
The VST instrument and its settings (but no inserts, EQs and modifiers) 
of the existing track are overwritten with the data of the track preset. The 
previous VST instrument for this instrument track is removed and the new 
VST instrument with its settings is set up for the instrument track. Note 
that the VST instrument of an instrument track does not show up in the 
VST Instrument window but only in the Plug-In Information window, see 
the separate manual “Nuendo Expansion Kit – Cubase Music Tools for 
Nuendo 4”.

Previewing track and VST presets
You can preview all types of track and VST presets except 
for multi track presets.

Previewing track or VST presets before 
applying
When you apply a track preset to an existing track, the 
corresponding dialog opens. Here you can preview the 
track presets before applying them permanently. This 
works for audio, MIDI and instrument track presets as well 
as for VST presets.

You can use this preview for listening to the changes in 
the output in real time. Proceed as follows:

1. Set your target track to cycle and play back the loop.

2. Select a track preset in the list.

3. Hit the Play button on the Transport panel to listen to 
the track with all settings from the track preset applied to it.

4. Click outside the browser to apply the selected preset 
or click the Reset button below the list to return to the un-
changed track.

Previewing MIDI, instrument and VST presets 
independently of tracks
You can also preview MIDI and instrument track presets 
as well as VST presets in the Sound Browser or in dialogs 
with the Browse Presets section open. 

For example, when you open the “Browse Sounds” dialog 
and select a MIDI or instrument track preset or a VST pre-
set, preview buttons appear on the lower right. (In the 
Sound Browser, the preview buttons appear in the Scope 
section.)

Track-independent preview, for example a VST preset in the “Browse 
Sounds” dialog.

Two preview options are available:

Previewing with standard MIDI input

1. Click the MIDI Input button.

2. Play some MIDI notes via your MIDI input device, for 
example a keyboard.
The Activity meter on the far right mirrors the MIDI in activity.

For this to work, “In All Inputs” has to be activated for 
your MIDI input device (this is the default setting), as only 
MIDI data incoming via “All MIDI Inputs” is used for preview.

Previewing using a MIDI file

1. Click the Choose MIDI File button.
A file dialog opens.

2. Select a MIDI file (.mid) to be played back with the 
track or VST preset applied and click OK.

3. Click the MIDI Input button.
The Play button will become available.

4. Click “Play”.
The program applies the track or VST preset to the MIDI file.

• In the Browse Sounds dialog, clicking OK will create a 
new track (see “Creating tracks in the Browse Sounds di-
alog” on page 333).

The MIDI file selection is not saved when closing the 
dialogs or the Sound Browser. Therefore, you have to se-
lect a new file the next time you want to preview a preset 
using a MIDI file.
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Inserts and EQ settings from track 
presets
Instead of handling complete track presets, it is also pos-
sible to apply settings for Inserts or Equalizers from track 
presets.

This can be done via the Inspector or via the Channel set-
tings window.

• In the Inspector, select e.g. an Instrument track and 
click the VST Sound button on the Inserts or Equalizers 
tab to open the presets pop-up menu. There, select the 
option “From Track Preset…”.

• In the Channel Settings window for a MIDI track, instru-
ment track or audio channel track (opened by clicking the 
“e” button in the Inspector), click on the VST Sound but-
ton in the Inserts section and select “From Track Pre-
set…” in the pop-up menu.

The Presets browser opens, showing all available track 
presets that contain Inserts or EQ settings. Select the 
track preset whose Inserts or EQs you want to apply and 
click outside the browser.

• For information on the general handling of Inserts pre-
sets, see the separate manual “Nuendo Expansion Kit – 
Cubase Music Tools for Nuendo 4”.

• For information on the general handling of EQ presets, 
see “Using EQ presets” on page 140.
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Introduction
Nuendo can give you instant access to up to eight para-
meters of each audio track, MIDI track or instrument track. 
This is done with the aid of the so-called quick controls, 
set up on the Quick Controls Inspector tab for these 
tracks.

The Quick Controls tab can be used as a kind of track 
control center, an area in which your most important pa-
rameters are assembled in one place. This saves you from 
having to click your way through the various windows and 
sections pertaining to your track.

Also, Nuendo allows you to assign these quick controls 
very quickly to an external remote control device. This 
gives you manual control of your most important track pa-
rameters.

Setting up the Quick Controls tab
The Quick Controls tab in the track Inspector is available 
for all audio tracks, MIDI tracks and Instrument tracks. It is 
displayed by default.

The Quick Controls tab in the Inspector.

Assigning parameters to quick controls
The opened Quick Controls tab shows eight slots, one for 
each quick control. To start with, these slots are empty. 
Proceed as follows to assign track parameters to the 
quick control slots:

1. In the Quick Controls tab, click on the first quick con-
trol slot.
A context menu is opened. This context menu lists all parameters cur-
rently accessible for this particular track. 

2. Double-click the parameter that you want to assign to 
the first quick control slot.
The parameter name and its value are displayed in the slot. You can 
change the value by dragging the quick control’s slider.

The track’s main volume parameter is assigned to quick control 1.

You can now repeat these steps for each quick control 
slot until all eight slots are associated with track parame-
ters!

Renaming a quick control

By default, the parameter name as listed in the browser 
pop-up menu for available track parameters is displayed in 
the quick control slot.

• To rename a quick control, simply double-click on the 
name in the slot to select it, enter a new name and press 
[Enter].
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Replacing a quick control assignment

• To replace a parameter assignment with a different pa-
rameter, click on the corresponding quick control slot and 
double-click on a different parameter in the browser pop-
up menu list.
The parameter assignment in this slot is changed.

Removing a quick control assignment

To remove a parameter from a slot, you have the following 
possibilities:

• Double-click the parameter name to select it and press 
the [Delete] or [Backspace] key. Confirm this operation by 
pressing [Enter].

• Click in the corresponding slot and select “No parame-
ter” from the browser pop-up menu.

The parameter assignment is removed, and the quick con-
trol slot is empty.

Options and settings
• Quick control assignments are saved with the current 
project.

• Since quick control settings are part of the track setup, 
you can save them as track presets, allowing you to re-use 
your settings across different projects.
Track presets are described in the chapter “Track Presets” on page 327.

• You can automate all parameter settings on the Quick 
Controls tab using the Read/Write Enable buttons (R and 
W) at the top right.
The automation features of Nuendo are described in detail in the chapter 
“Automation” on page 213.

Quick controls and automatable parameters
The quick controls feature has one special extension that 
should be used with caution: you can use quick controls 
not only to access certain parameters of the current track, 
but also to control all automatable parameters.

This makes it possible to use the Quick Controls tab of a 
dedicated track as a kind of “mini mixer”, controlling pa-
rameters on other tracks. Proceed as follows:

1. Create a new, empty audio track and open its Quick 
Controls tab.
This track has no events or parts.

2. Hold down the [Ctrl]/[Command] key and click on the 
slot for quick control 1.
The parameter selection context menu is opened, but it lists not the pa-
rameters of the current track, but all automatable parameters.

3. Click the + sign in the list to open the VST Mixer folder.

The pop-up lists all channels available in the mixer of your 
current project. 

4. Now assign a parameter of one particular channel to 
quick control 1, and another parameter of another channel 
to quick control 2.

Here, quick controls 1-5 have been set up to control the main volume of 
five audio tracks.

The Quick Controls tab has become a “secondary” mixer, 
dedicated to quick-controlling parameters on other tracks.

! Quick controls that are assigned that way cannot 
work when saved as track presets.
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Setting up quick controls on an 
external remote controller
Quick controls become really powerful when used in com-
bination with a remote controller.

Setting up the connection between the slots on the Quick 
Controls Inspector tab and a remote control device is 
easy. Proceed as follows:

1. In Nuendo, open the Device Setup dialog from the De-
vices menu.

2. In the Devices list on the left, select the Quick Con-
trols option.

This will open the Quick Controls section on the right of 
the dialog:

3. With your remote controller device connected to Nu-
endo via MIDI, select the corresponding MIDI port on your 
computer in the MIDI Input pop-up (or select “All MIDI In-
puts”).
If your remote controller has its own MIDI input and supports MIDI feed-
back, you can connect your computer to the device input. Then, select 
the corresponding MIDI port in the MIDI Output pop-up.

4. Click “Apply” to apply your settings.

5. Select “QuickControl1” in the “Control Name” column.

6. Move the control (knob, fader or other) on your remote 
control device that you want to use for the first quick con-
trol.

7. In the Device Setup dialog, click the Learn button.

8. Repeat the last 3 steps for the other quick controls.

You have now associated the slots on the Quick Control 
tab with control elements on your external remote control-
ler. Moving a control element will automatically change the 
value of the parameter assigned to the corresponding 
quick control.

• The remote controller setup for quick controls is saved 
globally, i.e. independent of any projects.
If you have various remote controllers, you can store and load several 
quick control setups using the Export and Import buttons.



25
MIDI realtime parameters and effects



343

MIDI realtime parameters and effects

Introduction
For each MIDI track, you can set up a number of track pa-
rameters, or modifiers, and MIDI effects. These affect how 
the MIDI data is played back, “transforming” MIDI events 
in real time before they are sent to the MIDI outputs.

On the following pages, the available parameters and ef-
fects are described. Keep in mind:

• The actual MIDI events will not be affected – the changes 
happen “on the fly”.

• Since the modifier settings don’t change the actual MIDI data 
on the track, they will not be reflected in the MIDI editors. To 
convert the track settings to “real” MIDI events, use the Freeze 
MIDI Modifiers function or the Merge MIDI in Loop function 
(see “Making your settings permanent” on page 357).

The Inspector – General handling
The MIDI modifiers and effects are set up in the Inspector 
(although some settings are available in the mixer as well). 
Here’s a brief rundown on how to handle the Inspector:

• To show or hide the Inspector, click the Inspector icon 
on the Project window toolbar.

• For a MIDI track, up to nine sections are available. 
Which of these sections are displayed in the Inspector is 
determined in the setup context menu or the Setup dialog 
of the Inspector.
For information about setting up the Inspector, see “The Setup dialogs” 
on page 506.

• You can fold or unfold the sections individually by click-
ing on the section name.
Clicking the name for a hidden section brings it to view and hides the 
other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or 
show a section without affecting other sections. Finally, [Alt]/[Option]-
clicking a tab shows or hides all sections in the Inspector.

The Inspector for a MIDI track.

Folding or hiding (via the Setup dialog) a section does 
not affect the functionality but merely hides the section 
from view. 
This means your settings will still be active even if you fold or hide the In-
spector settings.
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Basic track settings
The topmost Inspector section contains the basic settings 
for the selected MIDI track.

These are settings that either affect the basic functionality 
for the track (mute, solo, enable record, etc.) or send out 
additional MIDI data to the connected devices (program 
change, volume, etc.). The section contains all settings in 
the Track list (see “The Track list” on page 25), with a few 
additional parameters:  

Note that the functionality of the Bank and Patch se-
lector settings (used for selecting sounds in the con-
nected MIDI instrument) depends on the instrument to 
which the MIDI output is routed, and how you have set it 
up in the MIDI Device Manager.
The MIDI Device Manager allows you to specify which MIDI instruments 
and other devices are connected to the various MIDI outputs, thus mak-
ing it possible to select patches by name. See the separate PDF docu-
ment “MIDI Devices” for details about the MIDI Device Manager.

Many of the basic track settings are duplicated in 
“mixer channel strip form” in the MIDI Fader section of the 
Inspector (see below).

Parameter Description

Track name
field

Click once to show/hide the topmost Inspector section. 
Double-click to rename the track.

Edit button This opens the Channel Settings window for the track (a 
window showing a channel strip with volume fader and 
other controls, along with effect settings – see “Using 
Channel Settings” on page 137).

Mute/Solo 
buttons

Mutes or solos the MIDI track.

Read/Write 
buttons

Used for automating the track settings – see “Enabling 
and disabling the writing of automation data” on page 
214.

Open Device 
Panels button

If the MIDI track is routed to a device with a panel, click-
ing this button opens the respective panel. For more in-
formation, see the separate PDF document “MIDI 
Devices”.

Input trans-
former button

Opens the Input Transformer dialog, allowing you to 
transform incoming MIDI events in real time, see “The In-
put Transformer” on page 397.

Record enable 
button

Activate this to make the track ready for recording.

Monitor button When this is activated (and the option “MIDI Thru Active” 
is activated in the Preferences–MIDI page), incoming 
MIDI will be routed to the selected MIDI output.

Toggle Time-
base button

Switches between musical (tempo related) and linear 
(time related) time base for the track. See “Switching 
between musical and linear time base” on page 40.

Lock button Activate this to disable all editing of all events on the 
track.

Lane Display 
Type button

Allows you to divide the tracks in lanes. For more about 
lanes, see “Recording audio in Stacked mode” on page 
75.

Volume Use this to adjust the level for the track. Changing this 
setting will move the track’s fader in the mixer window, 
and vice versa. See “Setting volume in the mixer” on page 
132 for more about setting levels.

Pan Use this to adjust the panning of the track. 

Delay This adjusts the playback timing of the MIDI track. Posi-
tive values delay the playback while negative values 
cause the track to play earlier. The values are set in milli-
seconds.

In/Out/Chn 
pop-ups

This is where you select MIDI input, MIDI output and MIDI 
channel for the track.

Edit Instrument 
button

If the MIDI track is routed to a VST instrument, clicking 
this button opens the control panel for the VST instru-
ment.

Bank and Patch 
Selector pop-up

Allows you to select a sound, see below. (If no bank is 
available, only the Patch selector is shown.)

Apply Track 
Preset button

Allows you to apply a track preset, see “Applying track 
presets” on page 334.

Parameter Description
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Other Inspector sections
Apart from the basic track settings (see above), the MIDI 
Modifiers (see “MIDI Modifiers” on page 346) and the ef-
fect sections (see “MIDI effects” on page 348), the Inspec-
tor for a MIDI track also contains the following sections:

The MIDI Fader section

This contains a single channel strip, allowing you to set 
volume, pan, mute/solo and other parameters for the track, 
and a panel view of the active sends/inserts. This is a “mir-
ror” of the track’s channel strip in the Nuendo mixer – see 
“The MIDI channel strips” on page 131.

The Notepad section

This is a standard notepad, allowing you to enter notes 
and comments about the track. Each track has its own 
notepad in the Inspector.

The Network section

This contains controls related to Nuendo’s Network func-
tions. See the Networking pdf document for information.

VST Instrument section

If the MIDI track is routed to a VST Instrument, a new sub-
panel will appear at the bottom of the Inspector, labeled 
with the name of the VST instrument. Clicking this section 
shows a duplicate of the Inspector settings for the VST In-
strument channel. This makes it easy to adjust the channel 
settings for the VST Instrument while you are editing the 
MIDI track.

• If the VST Instrument has multiple outputs (and thus 
several mixer channels), there will be a setting called 
“Output” at the top of the VST Instrument section.

New sub-panels will also be added in the following cases:

• When a MIDI track is routed to an external instrument or effect 
that has an associated MIDI Device. In this case, the new sub-
panel will get the name of the device.

• When a MIDI track is routed to an effect plug-in that also re-
ceives audio data, i.e. that is used as an insert effect for an au-
dio track (e.g. MIDI Gate), a sub-panel for this audio track 
appears in the MIDI track inspector.

• If a MIDI track is routed to a plug-in assigned to a FX Channel 
track, a corresponding FX sub-panel is added to the Inspector.

For an easy way to combine MIDI and VST instruments, 
check out instrument tracks (see “VST Instruments and In-
strument tracks” on page 189).

User Panel section

This allows you to display MIDI device panels, which are 
control panels for external hardware. This is described in 
the separate PDF document “MIDI Devices”.

Quick Controls section

This allows you to configure quick controls, e.g. to use re-
mote devices. See the chapter “Track Quick Controls” on 
page 338.
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MIDI Modifiers 

The following settings will affect the MIDI events on the 
track in real time during playback. They will also be in ef-
fect if you play “live” with the track selected and record 
enabled (provided that “MIDI Thru Active” is activated on 
the Preferences–MIDI page). This makes it possible to e.g. 
transpose or adjust the velocity of your live playing.

If you want to compare the result of your modifier set-
tings with the “unprocessed” MIDI, you can use the By-
pass button in the MIDI Modifiers section.
When this is activated, the MIDI Modifiers settings will be temporarily 
disabled. A bypassed section is indicated by a yellow Bypass button.

Transpose
This allows you to transpose all notes on the track in semi-
tones. The available range is -127 to +127 semitones, but 
remember that the total range of MIDI note numbers is 0 
to 127. Furthermore, not all instruments can play back 
notes over the whole range. Therefore, extreme transposi-
tions can give rather strange and unwanted results.

• You can also transpose individual MIDI parts using the 
Transpose field in the info line.
The transposition in the info line (for the individual part) is added to the 
transpose value you have set up for the whole track in the Inspector.

This setting is also affected by the global Transpose 
settings. For detailed information, see the chapter “The 
Transpose functions” on page 114.

Velocity Shift
This setting lets you change the dynamics of all notes on 
the track. The value in this field is added to the velocity of 
each note message that is sent out (use negative values to 
lower the velocities). The range is -127 to +127 with 0 
representing no change in velocity.

Note that the effect of changing the velocity depends on 
the sound and instrument.

You can also adjust the velocity of events in individual 
MIDI parts using the Velocity field in the info line.
The velocity shift in the info line (for the individual part) is added to the 
velocity shift you have set up for the whole track in the Inspector.

Velocity Compression
This function multiplies the velocity values with the factor 
you specify. This factor is set using a numerator (left value) 
and a denominator (right value), resulting in a fractional 
number (1/2, 3/4, 3/2 etc.). For example, if you set the 
factor to 3/4, the velocities will be three quarters of their 
original values. This will also affect the difference in veloc-
ity between the notes, thus compressing or expanding the 
velocity scale. Typically, you would combine this setting 
with the Velocity Shift parameter. An example:

Let’s say you have three notes with the velocity values 60, 
90 and 120, and wish to “even out” the velocity differ-
ences somewhat. If you set the Velocity Compression 
value to 1/2, the notes will play back with the velocities 
30, 45 and 60. By adding 60 in the Velocity Shift field, the 
notes will play back with the velocities 90, 105 and 120, 
meaning you have compressed the velocity range. 

In a similar way, you can use Velocity Compression values 
greater than 1/1 together with negative values in the Ve-
locity Shift field, to expand the velocity range.

Length Compression
This value adjusts the lengths of all notes on the track. As 
with Velocity Compression, the value is set with a numer-
ator and denominator. For example, the value 2/1 means 
that all note lengths will be doubled, while 1/4 means all 
note lengths will be a quarter of the actual lengths.

! Remember that the maximum velocity is always 127 
no matter how much you try to expand.
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Random
The Random settings let you introduce random variations 
to various properties of MIDI notes. Anything from very 
subtle variations to dramatic changes can be applied. 
There are two separate “random generators”, set up in the 
following way:

1. Pull down the Random pop-up menu and select which 
note property should be randomized.
The options are position, pitch, velocity and length. 

Keep in mind that depending on the content of the 
track, certain parameter changes might not be immedi-
ately noticeable or have any effect at all (as would be the 
case if applying random length to a percussion track play-
ing “one-shot” samples for example). 
To best audition the random changes, choose a track with clearly defined 
rhythm and note content (as opposed to a string pad).

2. Set the desired range of random deviation by entering 
values in the two number fields.
The two values govern the limits of the randomization, so that the values 
will vary between the left value and the right value (you cannot set the left 
value higher than the right value). The maximum random range for each 
property is listed in the table below: 

You can make independent settings for the two ran-
dom generators.

• To deactivate the Random function, pull down the Ran-
dom pop-up menu(s) and select “OFF”.

Range
The Range function lets you specify a note (pitch) or ve-
locity range and either force all notes to fit within this 
range, or exclude all notes outside this range from play-
back. As with the Random function, there are two sepa-
rate Range settings. Set them up as follows:

1. Pull down the Range pop-up menu and select one of 
the following four modes:

2. Use the two fields to the right to set the minimum and 
maximum values.
These values will be shown as numbers (0-127) for the velocity modes 
and as note numbers (C-2 to G8) for the pitch modes.

Note that you can make independent settings for the 
two Range functions.

• To deactivate the Range function, pull down the Range 
pop-up menu(s) and select “OFF”.

Property Range

Position -500 to +500 ticks

Pitch -120 to +120 semitones

Velocity -120 to +120 

Length -500 to +500 ticks

Mode Description

Vel. Limit This function affects all velocity values outside the speci-
fied range. Velocity values below the Min setting (the 
lower limit of the range) are set to the Min value, and ve-
locity values above the Max setting are set to the Max 
value. Notes with velocity values within the set range are 
not affected. Use this if you want to force all velocity val-
ues to fit within a certain range.

Vel. Filter Velocity Filter works by excluding all notes with velocity 
values outside the specified range. Notes with velocity 
values below the Min setting or above the Max setting will 
not be played back. Use this to “isolate” notes with cer-
tain velocity values.

Note Limit This function allows you to specify a pitch range, and 
forces all notes to fit within this range. Notes outside the 
specified range are transposed up or down in octave 
steps until they fit within the range.
Note: If the range is too “narrow”, so that some notes 
cannot be fit within the range by octave-transposing, 
these notes will get a pitch in the middle of the range. For 
example, if you have a note with a pitch of F3, and the 
range is C4-E4, that note will be transposed to D4.

Note Filter Note Filter works by excluding all notes with pitches out-
side the specified range. Notes lower than the Min set-
ting or higher than the Max setting will not be played 
back. Use this to “isolate” notes with certain pitches.
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MIDI effects
Nuendo comes with a number of MIDI effect plug-ins, ca-
pable of transforming the MIDI output from a track in vari-
ous ways.

Just like the MIDI modifiers, MIDI effects are applied in real 
time to the MIDI data played back from the track (or to 
MIDI you play live “thru” the track).

What are MIDI effects?
Although a MIDI effect can be similar to an audio effect, 
it’s important to remember that you’re not processing the 
sound resulting from MIDI playback, but the MIDI data (the 
“instructions” for how the music should be played back). 

A MIDI effect will change properties of the MIDI events 
(e.g. change the pitch of notes) and/or generate new MIDI 
events (for example, a MIDI delay may add new MIDI 
notes, “echoing” the original notes).

The included MIDI effect plug-ins are described in the 
separate manual “Nuendo Expansion Kit – Cubase Music 
Tools for Nuendo 4”.

Insert and send effects
As with audio effects, there are two ways to route the MIDI 
events on a track to an effect:

If you add an insert effect, the MIDI events will be sent 
to the effect, which will process the data and pass it on to 
the track’s MIDI output (or to another insert effect).
In other words, the MIDI events will be routed “through” the insert effect.

If you use a send effect, the MIDI events will be sent 
both to the track’s MIDI output and to the effect.
That is, you will get both the unprocessed MIDI events and the output of 
the MIDI effect. Note that the effect can send its processed MIDI data to 
any MIDI output – not necessarily to the one used by the track.

There are separate sections in the Inspector for MIDI in-
serts and MIDI sends.

MIDI Inserts section

This allows you to add up to four MIDI insert effects. The 
section contains the following items:

Effects that display their controls in the Inspector can 
be opened in a separate control panel window by press-
ing [Alt]/[Option] and clicking the Edit button.

Item Description

Preset Manage-
ment button

Click this to open the track presets pop-up menu and se-
lect an insert preset or apply an insert from a track preset, 
see “Inserts and EQ settings from track presets” on page 
337.

Bypass button Click this to temporarily disable all insert effects for the 
track (useful for comparing with the unprocessed MIDI, 
etc.).

Inserts section 
tab

This is in blue if an insert effect is activated.

Effect selection 
pop-up menu 
(x 4)

Selecting an effect from this pop-up menu automatically 
activates it and brings up its control panel (which can be 
a separate window or a number of settings below the in-
sert slot in the Inspector).
To remove an insert effect completely, select “No Effect”.

On button (x 4) Allows you to turn the selected effect on or off.

Edit button (x4) Click this to bring up the control panel for the selected 
effect. Depending on the effect, this may appear in a sep-
arate window or below the insert slot in the Inspector. 
Clicking the button again hides the control panel.
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MIDI Sends section

This allows you to add up to four MIDI send effects. Unlike 
audio send effects, you can select and activate send ef-
fects individually for each track. The section contains the 
following items:

Effects that display their controls in the Inspector can 
be opened in a separate control panel window by press-
ing [Alt]/[Option] and clicking the Edit button.

About presets
Several of the MIDI plug-ins come with a number of pre-
sets for instant use. The controls for handling presets con-
sist of a Presets pop-up menu along with Store (+) and 
Remove (-) buttons.

• To load a preset, select it from the Presets pop-up menu.

• To store your current settings as a preset, click the (+) 
button to the right.
A dialog appears, asking you to specify a name for the preset. The stored 
preset will then be available for selection from the pop-up menu for all in-
stances of that MIDI plug-in, in all projects.

• To remove a stored preset, select it and click the (-) but-
ton to the right.

Item Description

Bypass button Click this to temporarily disable all send effects for the 
track (useful for comparing with the unprocessed MIDI, 
etc.).

Sends section 
tab

This is in blue if any send effect is activated.

Effect selection 
pop-up menu
(x 4)

Selecting an effect from this pop-up menu automatically 
activates it and brings up its control panel (which can be 
a separate window or a number of settings below the 
send slot in the Inspector).
To remove a send effect completely, select “No Effect”.

On button 
(x 4)

Allows you to turn the selected effect on or off.

Pre/Post button 
(x4)

If this is activated, the MIDI signals will be sent to the 
send effects before the MIDI modifiers and insert effects.

Edit button 
(x4)

Click this to bring up the control panel for the selected 
effect. Depending on the effect, this may appear in a sep-
arate window or below the sends slot in the Inspector. 
Clicking the button again hides the control panel.

Output pop-up 
menu (x4)

This determines to which MIDI output the effect should 
send the processed MIDI events.

Channel setting 
(x4)

This determines on which MIDI channel the effect should 
send the processed MIDI events.

Remove buttonStore button
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Applying a MIDI insert effect – an example
Here is a step-by-step example of how to add a MIDI in-
sert effect to a MIDI track:

1. Select the MIDI track and open the Inspector.

2. Open the MIDI Inserts tab in the Inspector.

• Alternatively you could use the mixer: bring up the ex-
tended mixer panel and select “Inserts” on the view op-
tions pop-up menu for the track’s channel strip.

3. Click in one of the insert slots to open the MIDI effect 
pop-up menu.

4. Select the desired MIDI effect from the pop-up menu.
The effect is automatically activated (the power button for the insert slot 
lights up) and its control panel appears, either in a separate window or in 
the MIDI Inserts section below the slot (depending on the effect).

Now all MIDI from the track will be routed through the ef-
fect.

5. Use the control panel to make settings for the effect.
All included MIDI effects are described in the separate manual “Nuendo 
Expansion Kit – Cubase Music Tools for Nuendo 4”.

• You can bypass the insert effect by clicking its power 
button (above the insert slot).

• To bypass all insert effects for the MIDI track, use the 
bypass button in the MIDI Inserts section in the Inspector, 
in the mixer channel strip or in the Track list.

• To remove an insert effect, click in its slot and select 
“No Effect”.

Managing plug-ins
Selecting Plug-in Information from the Devices menu 
opens a window in which all loaded plug-ins, audio and 
MIDI, are listed.

• To view the MIDI effect plug-ins, click the MIDI Plug-ins 
tab.

• The leftmost column allows you to deactivate plug-ins.
This is useful if you have plug-ins installed that you don’t want to use in 
Nuendo. Only plug-ins that are activated (ticked checkbox) will appear 
on the MIDI effect pop-up menus.
Note that plug-ins that are currently in use cannot be deactivated.

• The second column shows how many instances of each 
plug-in are currently used in the project.

• The remaining columns show various information about 
each plug-in and cannot be edited.
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Introduction
This chapter describes the various MIDI processing func-
tions available on the MIDI menu. They offer various ways 
to edit MIDI notes and other events, either in the Project 
window or from within a MIDI editor.

MIDI functions vs. MIDI modifiers

In some cases, the result of a MIDI function can also be 
obtained by using MIDI modifiers and effects (see “MIDI 
realtime parameters and effects” on page 342). For exam-
ple, the operations “Transpose” and “Quantize” are avail-
able as MIDI modifiers as well as MIDI functions.

The main difference is that MIDI modifiers and effects don’t 
affect the actual MIDI events on the track in any way, while 
MIDI functions change the events “permanently” (although 
recent changes can be undone). 

Use the following guidelines to decide which path to 
choose for operations that are available both as modifiers 
or effects and as functions:

• If you want to adjust a few parts or events only, use MIDI 
functions. The MIDI modifiers and effects affect the output 
of the whole track (although they can be made permanent 
in a specific area with the Merge MIDI in Loop function).

• If you want to experiment with different settings, use 
MIDI modifiers and effects.

• MIDI modifiers and effects settings are not reflected in 
the MIDI editors, since the actual MIDI events aren’t af-
fected. This can be potentially confusing; if you’ve e.g. 
transposed notes using modifiers, the MIDI editors will still 
show the notes with their original pitch (but they will play 
back at their transposed pitch). Therefore MIDI functions 
are a better solution if you want to see the effects in the 
MIDI editors.

What is affected by the MIDI functions?

Which events are affected when you use a MIDI function 
depends on the function, the active window and the cur-
rent selection:

• Some MIDI function only apply to MIDI events of a cer-
tain type.
For example, quantization affects notes only, while the Delete Controllers 
function obviously applies to MIDI controller events.

• In the Project window, the MIDI functions apply to all 
selected parts, affecting all events (of the relevant types) 
in them.

• In the MIDI editors, the MIDI functions apply to all se-
lected events. If no events are selected, all events in the 
edited part(s) will be affected.

The Quantizing functions

What is quantizing?
Quantizing in its fundamental form is a function that auto-
matically moves recorded notes, positioning them on ex-
act note values:

However, quantizing is not only a method of correcting er-
rors, it can also be used creatively in various ways. For ex-
ample, the “quantize grid” does not have to consist of 
perfectly straight notes, some notes can automatically be 
excluded from quantizing, etc.

When quantizing MIDI, only MIDI notes are affected 
(no other event types).
However, you can choose to move the controllers together with their re-
spective notes by activating the “Move Controller” option in the Quantize 
Setup dialog, see “The Move Controller setting” on page 355.

For example, if you record a series of eighth notes, some of them 
may end up slightly beside the exact eighth note positions.

Quantizing the notes with the quantize grid set to eighth notes 
will move the “misplaced” notes to exact positions.
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Setting up quantize on the toolbar
At its most basic, setting up quantizing consists of select-
ing a note value from the Quantize pop-up menu on the 
toolbar (in the Project window or a MIDI editor).

This allows you to quantize to exact note values (straight, 
triplet or dotted notes) only. 

Setting up quantize in the Quantize Setup 
dialog
If you want more options than those available on the pop-
up menu, select “Quantize Setup…” from the MIDI menu 
(or “Setup…” from the Quantize pop-up menu) to open 
the Quantize Setup dialog.

The grid display in the middle of the dialog shows one bar 
(four beats), with blue lines indicating the quantize grid 
(the positions that notes will be moved to). Value changes 
in the grid, presets and quantize options will be graphically 
reflected here, see below. 

Straight note values

Triplet note values

Dotted note values

! Any settings you make in the dialog are immediately 
reflected in the Quantize pop-up menus. However, if 
you want your settings permanently available on the 
Quantize pop-up menus, you have to use the presets 
functions (see “Presets” on page 354).
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The Quantize Setup dialog contains the following set-
tings:

The Grid and Type pop-ups

These are used to determine the basic note value for the 
quantizing grid. In other words, these have the same func-
tionality as the Quantize pop-up menu on the toolbar.

Swing

The Swing slider is only available when a straight note 
value is selected for the grid and Tuplet is off (see below). 
It lets you offset every second position in the grid, creating 
a swing or shuffle feel. When you adjust the Swing slider, 
the result is shown in the grid display.

A straight eighth note grid compared with a grid with 60% swing.

Tuplet

Allows you to create more rhythmically complex grids by 
dividing the grid into smaller steps.

Magnetic Area

This allows you to specify that only notes within a certain 
distance from the grid lines should be affected by quantiz-
ing. 

• When the slider is set to 0%, the Magnetic Area func-
tion is deactivated, i.e. all notes are affected by quantizing.
If you move the slider gradually to the right, you will note how the mag-
netic areas are shown around the blue lines in the grid display.

Presets

The controls in the lower left corner of the dialog allow you 
to store the current settings as a preset, which will then be 
available on the Quantize menus on the toolbars. The 
usual preset procedures apply:

• To store the settings as a preset, click the Store button. 

• To load a stored preset into the dialog, just select it from 
the pop-up menu. 
This is useful if you want to modify an existing preset.

• To rename the selected preset, double-click on the 
name and type in a new one. 

• To remove a stored preset, select it from the pop-up 
menu and click Remove.

• You can also create presets by extracting existing 
grooves from a MIDI part. 
Just select the desired MIDI part and drag it on the grid display in the 
middle of the Quantize Setup dialog or open the Advanced submenu on 
the MIDI menu and select “Part to Groove” (see “Part to Groove” on 
page 356).

Only notes within the indicated zones will be affected by quantizing.
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Apply and Auto

These functions allow you to apply quantizing directly from 
the dialog, see below.

The Non Quantize setting

This additional setting affects the result of the quantizing. 
It allows you to set a “distance” in ticks (120ths of six-
teenth notes).

Events that already are within the specified distance from 
the quantize grid will not be quantized. This allows you to 
keep slight variations when you quantize, but still correct 
notes that are too far from the grid.

The Random Quantize setting

This additional setting affects the result of the quantizing. It 
allows you to set a “distance” in ticks (120ths of sixteenth 
notes).

Events will be quantized to random positions within the 
specified “distance” from the quantize grid, thus creating 
a more “loose” quantizing. Much like the Non Quantize 
setting, this allows for slight variations, while at the same 
time keeping notes from ending up too far from the grid.

The Iterative Strength setting

Here you specify how much the notes should be moved 
towards the grid when using the Iterative Quantize func-
tion, see below.

The Move Controller setting

When this is activated, controllers related to notes (pitch 
bend, etc.) are automatically moved with the notes when 
these are quantized.

Applying quantize
There are several ways to apply the quantize:

• The standard method is to select “Over Quantize” from 
the MIDI menu (or using a key command, by default [Q]).
This quantizes the selected MIDI parts or notes according to the current 
Quantize pop-up menu setting.

• You can also apply quantizing directly from the Quantize 
Setup dialog, by clicking the “Apply Quantize” button.

• If you activate the “Auto” checkbox in the Quantize 
Setup dialog, any change you make in the dialog is imme-
diately applied to the selected MIDI parts or notes.
A great way of using this feature is to set up a playback loop, and adjust 
the settings in the dialog until you get the desired result. 

The Auto Quantize function
If you activate the Auto Q button on the Transport panel, 
all MIDI recordings you make are automatically quantized 
according to the settings you have made in the Quantize 
Setup dialog.

Iterative Quantize
Another way to apply “loose” quantization is to use the Iter-
ative Quantize function on the MIDI menu. It works like this:

Instead of moving a note to the closest quantize grid posi-
tion, Iterative Quantize moves it only part of the way. You 
specify how much the notes should be moved towards the 
grid with the “Iterative Strength” setting in the Quantize 
Setup dialog.

Iterative Quantize also differs from “regular” quantization 
in that the operation is not based on the notes’ original po-
sitions but on their current, quantized position. This makes 
it possible to repeatedly use Iterative Quantize, gradually 
moving the notes closer to the quantize grid until you’ve 
found the desired timing.

! If you don’t want to apply the quantizing you have set 
up in the dialog, close the window by clicking its 
standard close box. 

! When you apply quantize, the result is based on the 
original position of the notes. Therefore, you can 
freely try out different quantize settings with no risk of 
“destroying” anything. See also “Undo Quantize” on 
page 356.
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Advanced Quantize functions

Quantize Lengths

This function (on the Advanced Quantize submenu on the 
MIDI menu) will quantize the length of the notes, without 
changing their start positions. At its most basic level, this 
function will set the length of the notes to the Length 
Quantize value on the MIDI editor toolbar. However, if you 
have selected the “Quantize Link” option on the Length 
Quantize pop-up menu, the function will resize the note 
according to the quantize grid, taking the Swing, Tuplet 
and Magnetic Area settings into account. An example:

1. Length Quantize set to “Quantize Link”.

2. Some 1/16th notes.

3. Here, the quantize value has been set to straight 1/16th notes with 
Swing at 100%. Since Snap is activated (see “Snap” on page 370), the 
quantize grid is reflected in the note display’s grid.

4. Selecting Quantize Lengths will adjust the note lengths according to 
the grid. If you compare the result to the first figure above, you will find 
that notes that started within the odd sixteenth note “zones” show the 
longer grid length, and notes in the even zones have the shorter length.

Quantize Ends

The Quantize Ends function on the Advanced Quantize 
submenu will only affect the end positions of notes. Apart 
from that, it works just like regular quantizing, taking the 
Quantize pop-up menu setting into account.

Undo Quantize

As mentioned above, the original position of each quan-
tized note is stored. Therefore, you can make the selected 
MIDI notes revert to their original, unquantized state at any 
time by selecting Undo Quantize from the Advanced 
Quantize submenu. This is independent from the regular 
Undo History.

Freeze Quantize

There may be situations when you want to make the quan-
tized positions “permanent”. For example, you may want to 
quantize notes a second time, having the results based on 
the current quantized positions rather than the original po-
sitions. To make this possible, select the notes in question 
and select “Freeze Quantize” from the Advanced Quantize 
submenu. This makes the quantized positions permanent.

Part to Groove

With this function, you can extract the groove from a se-
lected MIDI part and turn it into a Quantize preset. 

You can also extract grooves from audio, using e.g. hit-
points (see “Creating groove quantize maps” on page 283), 
or audio parts, rex parts or drum parts that have been pro-
cessed with the Detect Silence function. Since audio con-
tains no velocity information, velocity will remain unchanged 
after applying a Groove that you extracted from audio.

In both cases, the resulting groove appears on the Quan-
tize menus and you apply it as you would any Quantize 
preset. You can also view and edit the resulting quantize 
settings in the Quantize Setup dialog.

! This function is only available from within the MIDI 
editors.

! After you have performed a Freeze Quantize for a 
note, you cannot undo its quantization.
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Transpose
The Transpose item on the MIDI menu opens a dialog with 
settings for transposing the selected notes:

You can also use the Transpose track for transposing, 
see “The Transpose functions” on page 114.

Semitones

This is where you set the amount of transposition.

Scale Correction

Scale Correction transposes the selected notes by for-
cing them to the closest note of the selected scale type. 
This can be used for creating interesting key and tonal 
changes, either by itself or in conjunction with the other 
settings in the Transpose dialog.

• To activate Scale Correction, click the checkbox.

• Select a root note and scale type for the current scale 
from the upper pop-up menus.

• Select a root note and scale type for the new scale from 
the lower pop-up menus.
Make sure to select the correct root note if you want to keep the result in 
the same key as the original notes, or select an entirely different key if you 
want to experiment.

Keep Notes in Range

When this is activated, transposed notes will remain 
within the Upper and Lower Limit values.

• If a note ends up outside the limits after transposition, it 
will be shifted to another octave, keeping the correct 
transposed pitch if possible.
If this isn’t possible (if you have set a very narrow range between the Up-
per and Lower Limit), the note will be transposed “as far as possible”, i.e. 
to the Upper or Lower Limit note. If you set the Upper and Lower Limits 
to the same value, all notes will be transposed to this pitch!

OK and Cancel

Clicking OK performs the transposition. Clicking Cancel 
closes the dialog without transposing.

Making your settings permanent
The settings described in the chapter “MIDI realtime para-
meters and effects” on page 342 do not change the MIDI 
events themselves, but work like a “filter”, affecting the 
music on playback. Therefore, you may want to make them 
permanent, i.e. convert them to “real” MIDI events, for ex-
ample to transpose a track and then edit the transposed 
notes in a MIDI editor. For this, you can use two com-
mands from the MIDI menu:

• “Freeze MIDI Modifiers” – This applies all filter settings 
permanently to the respective track. 
With this function, the settings are “added” to the events on the track, 
and all modifiers will be set to zero.

• “Merge MIDI in Loop” – This merges all selected tracks 
(or parts) to create a new track.
The settings are applied during the merge and will still be displayed later 
in the respective menus.

These two functions are described in the following sec-
tions.
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Freeze MIDI Modifiers
The “Freeze MIDI Modifiers” function affects the following 
settings for MIDI tracks:

• Several settings on the main tab of the Inspector (program 
and bank selection and the Delay parameter).

• The settings on the MIDI Modifiers tab (i.e. Transpose, Veloc-
ity Shift, Velocity Compression and Length Compression).

• The settings on the MIDI Inserts tab (if, e.g., you are using an ar-
peggiator and want to convert the added notes to real events).

The following settings for MIDI parts are taken into ac-
count as well:

• The Transpose and Velocity settings for parts displayed on the 
info line – the Volume setting is not taken into account. 

To use the “Freeze MIDI Modifiers” function, proceed as 
follows:

1. Select the desired MIDI track.

2. Pull down the MIDI menu and select “Freeze MIDI 
Modifiers”.
The Inspector settings will be converted to MIDI events and inserted at 
the beginning of the part(s). All notes of the part(s) will be modified ac-
cordingly and the Inspector settings will be reset.

Merge MIDI in Loop
The function “Merge MIDI in Loop” combines all MIDI 
events on all unmuted tracks, applies MIDI modifiers and 
effects and generates a new MIDI part, containing all the 
events as you would hear them play back. Proceed as fol-
lows:

1. Make sure only the desired MIDI track(s) are unmuted.
If you only want to include events from a single track in the merge opera-
tion, you may want to solo the track.

2. Set up the left and right locator around the area you 
want to merge.
Only events starting within this area will be included.

3. Select the track on which you want the new part to be 
created.
This can be a new track or an existing track. Data in the cycle area on the 
track can be kept or overwritten (see below).

4. Select “Merge MIDI in Loop” from the MIDI menu.
A dialog appears with the following options:

5. Click OK.
A new part is created between the locators on the destination track, con-
taining the processed MIDI events.

Applying effects to a single part

Normally, the MIDI modifiers and effects affect a whole 
MIDI track. This may not always be what you want – you 
may want to apply some MIDI effects to a single part for 
example (without having to create a separate track for that 
part only). The Merge MIDI in Loop function can help:

1. Set up your MIDI modifiers and MIDI effects the way 
you want them for the part.
This will of course affect the whole track, but focus on the part for now.

2. Set the locators to encompass the part.
Simply select the part and choose Locators to Selection from the Trans-
port menu (or use the corresponding key command, by default [P]).

3. Make sure the track holding the part is selected in the 
Track list.

4. Select Merge MIDI in Loop.

5. In the dialog that appears, activate the desired effect 
options, make sure that Erase Destination is activated and 
click OK.
Now a new part is created on the same track, containing the processed 
events. The original part is deleted.

6. Turn off or reset all MIDI modifiers and effects, so that 
the track plays back as usual.

Option Description

Include Inserts If this is activated, any MIDI insert effects currently acti-
vated for the track(s) will be applied.

Include Sends If this is activated, any MIDI send effects currently acti-
vated for the track(s) will be applied.

Erase 
Destination

If this is activated, all MIDI data between the left and right 
locator on the destination track will be deleted.

Include Chase If this is activated, events placed outside the selected part 
but relating to it will be included in the processing, e.g. a 
Program Change right before the left locator. For more 
about chase events, see “About Chase” on page 63.
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Dissolve Part
The Dissolve Part function on the MIDI menu has two sep-
arate uses:

• When you work with MIDI parts (on MIDI channel “Any”) 
containing events on different MIDI channels.
Dissolve Part separates the events according to MIDI channel.

• When you want to separate MIDI events according to 
pitch.
A typical example would be drum and percussion tracks, where each 
pitch usually corresponds to a separate drum sound.

When dissolving a part into either separate channels 
or separate pitches, you can automatically remove the si-
lent (empty) areas of the resulting parts by activating the 
“Optimized Display” checkbox in the Dissolve Part dialog.

Dissolving parts into separate channels
Setting a track to MIDI channel “Any” will cause each MIDI 
event to play back on its original MIDI channel, rather than 
a channel set for the whole track. There are two main situ-
ations when “Any” channel tracks are useful:

• When you record several MIDI channels at the same 
time.
You may for example have a MIDI keyboard with several keyboard zones, 
where each zone sends MIDI on a separate channel. Recording on an 
“Any” channel track allows you to play back the recording with different 
sounds for each zone (since the different MIDI notes play back on sepa-
rate MIDI channels).

• When you have imported a MIDI file of Type 0.
MIDI files of Type 0 contain only one track, with notes on up to 16 different 
MIDI channels. If you were to set this track to a specific MIDI channel, all 
notes in the MIDI file would be played back with the same sound; setting 
the track to “Any” will cause the imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on 
different MIDI channels and distributes the events into new 
parts on new tracks, one for each MIDI channel found. This 
allows you to work with each musical part individually. Pro-
ceed as follows:

1. Select the part(s) containing MIDI data on different 
channels.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that appears, select the “Separate Chan-
nels” option.

Now, for each MIDI channel used in the selected part(s), a 
new MIDI track is created and set to the corresponding 
MIDI channel. Each event is then copied into the part on 
the track with the corresponding MIDI channel. Finally, the 
original part(s) are muted.

An example:

Dissolving parts into separate pitches
The Dissolve Part function can also scan MIDI parts for 
events of different pitches, and distribute the events into 
new parts on new tracks, one for each pitch. This is useful 
when the different pitches are not used in a regular me-
lodic context, but rather for separating different sounds 
(e.g. MIDI drum tracks or sampler sound FX tracks). By 
dissolving such parts, you can work with each sound indi-
vidually, on a separate track. Proceed as follows:

1. Select the part(s) containing MIDI data.

2. Select “Dissolve Part” from the MIDI menu.

3. In the dialog that appears, select the “Separate 
Pitches” option.
A new MIDI track is created for each used pitch in the selected part(s). 
The events are then copied into the parts on the track for the corres-
ponding pitch. Finally, the original part(s) are muted.

This part contains events on 
MIDI channel 1, 2 and 3.

Selecting “Dissolve Part” creates new parts on new tracks, set 
to channel 1, 2 and 3. Each new part contains only the events 
on the respective MIDI channel.

The original MIDI part is muted.
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Repeat Loop
With this function, the events inside the independent track 
loops will be repeated until the end of the part, i.e. the 
notes that were previously only played repeatedly are now 
actual notes on the MIDI track. Events to the right of the 
independant track loop (within the same part) will be re-
placed by this function. For more information about inde-
pendent track loops, see “The independent track loop” on 
page 369.

Other MIDI functions
The following items can be found in the Functions sub-
menu of the MIDI menu:

Legato
Extends each selected note so that it reaches the next note.

You can specify the desired gap or overlap with the “Legato 
Overlap” setting in the Preferences (Editing–MIDI page).

When using Legato with this setting, each note will be extended to end 
5 ticks before the next note.

When you activate the “Legato Mode: Selected Only” op-
tion, the length of the note will be adjusted so that it 
reaches the next selected note, allowing you e.g. to only ap-
ply Legato to your bass line (when playing on a keyboard).

Fixed Lengths

This function resizes all selected notes to the length set 
with the Length Quantize pop-up menu on the MIDI editor 
toolbar.

Delete Doubles
This function removes double notes, i.e. notes of the same 
pitch on the exact same position. Double notes can occur 
when recording in Cycle mode, after Quantizing, etc.

Delete Controllers
This function removes all MIDI controllers from the se-
lected MIDI parts.

Delete Continuous Controllers
This function removes all “continuous” MIDI controller 
events from the selected MIDI parts. Therefore, “on/off” 
events such as sustain pedal events are not removed.

Delete Notes
Allows you to delete very short or weak notes. This is use-
ful for automatically removing unwanted “ghost notes” af-
ter recording. Selecting “Delete Notes…” opens a dialog 
in which you set up the criteria for the function.

! This function is only available from within the MIDI 
editors.

! This function always affects whole MIDI parts.

! This function always affects whole MIDI parts.

! This function always affects whole MIDI parts.
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The parameters have the following functionality:

Minimum Length

When the Minimum Length checkbox is activated, the 
note length is taken into account, allowing you to remove 
short notes. You can either specify the minimum length 
(for notes to be kept) in the value display or by dragging 
the blue line in the graphical length display below.

• The graphical length display can correspond to 1/4 bar, 
one bar, two bars or four bars.
You change this setting by clicking in the field to the right of the display.

In this case, the whole length display corresponds to two bars, and the 
Minimum Length is set to 1/32nd notes (60 ticks).

Minimum Velocity

When the Minimum Velocity checkbox is activated, the ve-
locity of notes is taken into account, allowing you to re-
move weak notes. You specify the minimum velocity (for 
notes to be kept) in the value display.

Remove when under

This setting is only available when both Minimum Length 
and Minimum Velocity is activated. By clicking the value 
display, you select whether both length and velocity crite-
ria must be met for notes to be deleted, or whether one of 
the criteria will suffice.

OK and Cancel

Clicking OK performs the automatic delete according to 
the rules set up. Clicking Cancel closes the dialog without 
deleting notes.

Restrict Polyphony
Selecting this item opens a dialog in which you can spec-
ify how many “voices” should be used (for the selected 
notes or parts). Restricting the polyphony this way is use-
ful when you have an instrument with limited polyphony 
and want to make sure all notes will be played. The effect 
is achieved by shortening notes as required, so that they 
end before the next note starts.

Pedals to Note Length
This function scans for Sustain pedal on/off events, length-
ens the affected notes to match the Sustain pedal off posi-
tion, and then removes the Sustain Controller on/off events.

Delete Overlaps (mono)
This function allows you to make sure that no notes of the 
same pitch overlap (i.e. that one starts before the other 
ends). Overlapping notes of the same pitch can confuse 
some MIDI instruments (a new Note On is transmitted be-
fore the Note Off is transmitted). This command can then 
be used to automatically solve the problem.

Delete Overlaps (poly)
This function shortens notes when required, so that no 
note begins before another ends. This happens regard-
less of which pitch the notes have.

Velocity
This function opens a dialog that allows you to manipulate 
the velocity of notes in various ways.

The following types of velocity processing are available:

Add/Subtract

This simply adds a fixed number to the existing velocity 
values. You set the value (positive or negative) with the 
Amount parameter.
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Compress/Expand

Compresses or expands the “dynamic range” of MIDI 
notes by scaling the velocity values according to the Ratio 
setting (0 – 300%). The principle behind this is that multi-
plying different velocity values with a factor higher than 1 
(over 100%) will also make the differences between ve-
locity values greater, while using a factor lower than 1 (un-
der 100%) will make the differences smaller. In short:

• To compress (“even out” velocity differences), use ratio 
values below 100%.
After compression, you would probably want to add a velocity amount 
(with the Add/Subtract function) to maintain the average velocity level. 

• To expand (create greater difference in velocity), use ra-
tio values above 100%.
Before you expand, you may want to adjust the velocity with the Add/
Subtract function, so that the average velocity is somewhere in the mid-
dle of the range. If the average velocity is high (near 127) or low (near 0), 
expansion will not work properly, simply because velocity values can only 
be between 0 and 127!

Limit

This function allows you to make sure that no velocity val-
ues fall outside a given range (the Lower and Upper val-
ues). Any velocity values outside this range are raised/
lowered to exactly the Lower/Upper values.

Fixed Velocity
This function sets the velocity of all selected notes to the 
Insert Velocity value on the toolbar in the MIDI editors.

Thin Out Data
Thins out MIDI data. Use this to ease the load on your ex-
ternal MIDI devices if you have recorded very dense con-
troller curves etc. 

You can also manually thin out the controller data by using 
the quantize function in the Key Editor.

Extract MIDI Automation
This option allows you to automatically convert continuous 
controller data of a MIDI part into MIDI track automation 
data. Proceed as follows:

1. Select the desired MIDI part containing the continuous 
controller data.

2. Select “Extract MIDI Automation”. (This command is 
also available on the Key Editor context menu.)
The controller data will automatically be removed from the controller lane 
in the editor.

3. In the Project window, open the automation track(s) 
for the respective MIDI track. You will find that an automa-
tion track has been created for each of the continuous 
controllers in the part.

Please note that this function can only be used for con-
tinuous controllers. Data such as Aftertouch, Pitchbend or 
SysEx cannot be converted to MIDI track automation data.

Remember that to be able to hear the automation data, 
you have to activate the Read button for the respective au-
tomation track(s).

Reverse
This function inverts the order of the selected events (or of 
all events in the selected parts), causing the MIDI music to 
play backwards. Note that the effect is different from re-
versing an audio recording. With MIDI, the individual notes 
will still play as usual in the MIDI instrument – it’s only the 
order of playback that is changed.

Merge Tempo from Tapping
This function allows you to create a complete tempo track 
based on your tapping, see the section “Merge Tempo 
From Tapping” on page 422.

! This is an extremely useful function as it allows you to 
quickly and easily convert the continuous controllers 
of your recorded MIDI parts into MIDI track automa-
tion data, making them available for editing in the 
Project window.
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About editing MIDI
There are several ways to edit MIDI in Nuendo. You can 
use the tools and functions in the Project window for 
large-scale editing, or use the functions on the MIDI menu 
to process MIDI parts in various ways (see “What is affec-
ted by the MIDI functions?” on page 352). For hands-on 
graphical editing of the contents of MIDI parts, you use the 
MIDI editors:

• The Key Editor is the default MIDI editor, presenting 
notes graphically in an intuitive piano roll-style grid.
The Key Editor also allows for detailed editing of non-note events such 
as MIDI controllers. For more information, see “The Key Editor – Over-
view” on page 366.

• The Score Editor (Nuendo Expansion Kit only) shows 
MIDI notes as a musical score and comes with advanced 
tools and functions for notation, layout and printing.

• The Drum Editor (Nuendo Expansion Kit only) is similar 
to the Key Editor, but takes advantage of the fact that with 
drum parts, each key corresponds to a separate drum 
sound. 

• The List Editor shows all events in the selected MIDI 
parts as a list, allowing you to view and edit their proper-
ties numerically.
For more information, see “The List Editor – Overview” on page 383.

• The Edit In-Place function allows you to edit MIDI parts 
directly in the Project window.
This is similar to working in the Key Editor, but makes it easier to edit 
MIDI in context with other track types. See “Edit In-Place” on page 381.

• You can also edit MIDI in the Project Browser.
Like the List Editor, the Project browser shows the events in a list and al-
lows you to perform numerical editing. However, you will probably find the 
List Editor better suited for MIDI editing, since it has various dedicated fea-
tures and functions for this. The Project Browser is described in the chap-
ter “The Project Browser” on page 428.

You can define each of the editors mentioned above 
as your default MIDI editor, see below. 

About this chapter

Please note that features that are identical in these editors 
will be described in the Key Editor section. The sections 
about the Inplace-Editor (see “Edit In-Place” on page 381) 
and the List Editor (see “The List Editor – Overview” on 
page 383) describe the specific features of these editors 
only.

Opening a MIDI editor
There are two ways to open a MIDI editor:

• Select one or several parts (or a MIDI track, with no 
parts selected) and select Open Key Editor, Open Score 
Editor (Nuendo Expansion Kit only), Open Drum Editor 
(Nuendo Expansion Kit only), Open List Editor or Open In-
Place Editor from the MIDI menu (or use the correspond-
ing key command).
The selected parts (or all parts on the track, if no part was selected) will 
open in the chosen editor.

• Double-click a part to open it in the default editor.
Which editor opens depends on the Default Edit Action setting in the 
Preferences (Event Display–MIDI page).

Nuendo Expansion Kit only: If the option “Edit as Drums 
when Drum Map is assigned” is activated and a drum map 
is selected for the edited track, the Drum Editor will open. 
This way you can double-click to open the Key Editor (or 
the Score Editor, List or Edit In-Place Editor, depending 
on your preferences) but drum tracks will automatically 
open in the Drum Editor.

If the part you open for editing is a shared copy, any ed-
iting you perform will affect all shared copies of this part.
Shared copies are created by pressing [Alt]/[Option]+[Shift] and drag-
ging, or by using the Repeat function with the “Shared copies” option 
activated. In the Project window, shared copies are indicated by the part 
name in italics and an icon in the bottom right corner of the part (see 
“Aligning events” on page 45).
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Handling several parts
When you open a MIDI editor with several parts (or a MIDI 
track containing several parts) selected, you might find it 
somewhat hard to get an overview of the different parts 
when editing.

For such cases the editor toolbar features a few functions 
to make working with multiple parts easier and more com-
prehensive:

• The Part List menu lists all parts that were selected when 
you opened the editor (or all parts on the track, if no parts 
were selected), and lets you select which part should be 
active for editing.
When you select a part from the list, it is automatically made active and 
centered in the note display.

Note that it is also possible to activate a part by select-
ing an event within this part with the Arrow tool.

• The button “Edit Active Part Only” lets you restrict edit-
ing operations to the active part only.
For example, if you select “All” from the Select submenu on the Edit menu 
with this option activated, only events in the active part will be selected. 
Similarly, if you select notes by dragging with the Arrow tool (making a se-
lection rectangle), only the notes in the active part will be selected.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on the active part so that it fills the 
screen by selecting “Zoom to Event” from the Zoom sub-
menu on the Edit menu.

• The button “Show Part Borders” can be used if you 
want to see clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, mak-
ing the borders easily discernible. In the Key Editor, there are also two 
“markers” in the ruler with the name of the active part, marking its begin-
ning and end. These can be moved freely to change the size of the part.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts (making them ac-
tive) using key commands.
In the Key Commands dialog – Edit category, you will find two functions for 
this: “Activate Next Part” and “Activate Previous Part”. If you assign key 
commands to these, you can use them to cycle between parts in the edi-
tors. For further information, see “Setting up key commands” on page 518.
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The Key Editor – Overview 

The toolbar
As in other windows, the toolbar contains tools and vari-
ous settings. You can specify which toolbar items should 
be shown and store/recall different toolbar configurations 
– see “The Setup dialogs” on page 506. 

The info line

The info line shows information about selected MIDI 
notes. You can edit all values on the info line using regular 
value editing (see “Editing on the info line” on page 375 
for details). Length and position values are displayed in 
the format currently selected for the ruler (see below).

• To hide or show the info line, click the icon in the toolbar.

RulerInfo lineToolbar

Note displayController display

Show/Hide Info line

Solo Editor button
Key Editor tools

Autoscroll 
on/off

Audition on/off

Part list

Show/Hide Part 
borders

Edit active 
part only

Auto Select 
Controllers

Nudge Tools

Transpose Palette

Snap on/off

Velocity for inserted notes Grid modes

Indicate Transpositions

Quantize settings Step Input

MIDI Input

Step/MIDI input controls

Color pop-up menu

Independent track 
loop on/off

Loop range (see “The indepen-
dent track loop” on page 369).

Chord recogni-
tion display

Mouse pointer display: Current 
pitch and meter position

Open Device 
Button
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The ruler
The ruler shows the time line, by default in the display for-
mat selected on the Transport panel. You can select a 
separate format for a MIDI editor ruler on the Ruler pop-up 
menu, opened by clicking the arrow button to the right of 
it. For a list of the available formats, see “The ruler” on 
page 31.

At the bottom of the pop-up menu, there are two addi-
tional items:

• If “Time Linear” is selected, the ruler, note display and 
controller display will be linear in relation to time.
This means that if the ruler shows bars and beats, the distance between 
the bar lines will vary depending on the tempo.

• If “Bars+Beats Linear” is selected, the ruler, note display 
and controller display will be linear in relation to tempo.
This means that if the ruler shows bars and beats, the distance between 
beats will be constant.

In most cases, you would probably set the display format 
to “Bars+Beats” in “Bars+Beats Linear” mode when edit-
ing MIDI.

The note display

The note display is the main area in the Key Editor. It con-
tains a grid in which MIDI notes are shown as boxes. The 
width of a box corresponds to the note length, and the 
vertical position of a box corresponds to the note number 
(pitch), with higher notes higher up in the grid. The piano 
keyboard to the left serves as a guide for finding the right 
note number. 

For a description on how to display colors in the note dis-
play, see “Coloring notes and events” on page 370.

The chord recognition function

Nuendo features a handy chord recognition function that 
helps you identify chords in the Key Editor note display. To 
find out which chord is formed by simultaneously played 
notes, place the project cursor over the notes. All MIDI 
notes currently “touched” by the project cursor are ana-
lyzed and the chord recognition display in the toolbar 
shows you which chord the notes form.

In the picture above, the project cursor touches the notes C, Eb and G. 
As shown in the chord recognition display, this results in a C minor chord.
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The controller display

The area at the bottom of the Key Editor window is the 
controller display. This consists of one or several control-
ler lanes, each showing one of the following properties or 
event types:

• Velocity values of the notes.
• Pitch Bend events.
• Aftertouch events.
• Poly Pressure events.
• Program Change events.
• Any type of continuous controller event.

To change the size of the controller display, drag the di-
vider between the controller display and the note display. 
This will make the controller display larger and the note 
display smaller, or vice versa.

Velocity values are shown as vertical bars in the controller 
display, with higher bars corresponding to higher velocity 
values:

Each velocity bar corresponds to a note in the note display.

Events in the controller display (that is, anything other than 
velocity values) are shown as “blocks”, the heights of which 
correspond to the “values” of the events. However, events 
that have been recorded (or drawn with a low quantize 
value) may appear more like “filled curves”, simply because 
they are positioned very closely:

If you zoom in on the upper “curve”, you will find that it consists of sep-
arate events.

Unlike notes, events in the controller display have no 
length. The value of an event in the display is “valid” until 
the start of the next event:

For a description of editing in the controller display, see 
“Editing in the controller display” on page 377.

Key Editor operations

Zooming
Zooming in the Key Editor is done according to the stan-
dard zoom procedures, using the zoom sliders, the Zoom 
tool or the Zoom submenu on the Edit menu.

• When you drag a rectangle with the Zoom tool, the result 
depends on the option “Zoom Tool Standard Mode: Hori-
zontal Zooming Only” in the Preferences (Editing–Tools 
page).
If this is activated, the window will only be zoomed horizontally; if not, the 
window will be zoomed both horizontally and vertically.

If you delete the second event… …the first event will be “valid” 
until the start of the third event.
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Using the Trim tool
The Trim tool allows you to change the length of note 
events by cutting off the end or the beginning of notes. It 
is available in the Key Editor and in the List Editor.

Using the Trim tool means moving the note-on or the note-
off event for one or several notes to a position defined with 
the mouse. Proceed as follows:

1. Select the Trim tool in the toolbar.
The mouse pointer changes to a knife symbol.

2. Locate the notes that you wish to edit.

• To edit a single note, click on it with the Trim tool. The 
range between the mouse cursor and the end of the note 
will be removed.
You can use the mouse position display in the toolbar to find the exact 
position for the trim operation.

• To edit several notes, click and drag with the mouse 
across the notes.
A line is displayed. The notes will be trimmed along this line.

Trimming the end of three note events.

• By default, the Trim tool will cut off the end of notes. To 
trim the beginning of the note(s), press [Alt]/[Option] while 
dragging.

• If you press [Ctrl]/[Command] while dragging, you will 
get a vertical trim line, allowing you to set the same start or 
end time for all edited notes.

You can change the Trim tool key commands in the Pref-
erences (Editing–Tool Modifiers page).

Note that when you trim the beginning of a note in the 
List Editor, the note may move to a different position in the 
list (since other events may now begin before the edited 
event).

Note that the trimmed note ends don’t snap to the grid.

Playing back
You can play back your music as usual when working in a 
MIDI editor. There are several features designed to make 
editing easier during playback:

Solo button

If you activate the Solo button, only the edited MIDI parts 
will be heard during regular playback.

Autoscroll

 

As described in the section “Autoscroll” on page 57, the 
Autoscroll function makes the window “follow” the project 
cursor during playback, so that the current play position is 
visible at all times. However, when you are working in a 
MIDI editor, you may want to deactivate Autoscroll – this 
way, the events you are working with will stay visible.

The Autoscroll buttons in each of the MIDI editors are inde-
pendent of the Project window Autoscroll setting, which 
means that Autoscroll can be activated in the Project win-
dow and deactivated in the MIDI editor you are working in.

The independent track loop

The independent track loop is a sort of “mini-cycle”, affect-
ing only the MIDI part being edited. When the loop is acti-
vated, the MIDI events within the loop will be repeated 
continuously and completely independent – other events 
(on other tracks) will be played back as usual. The only “in-
teraction” between the loop and the “regular playback” is 
that every time the cycle starts over again, so does the loop.

To set up the independent track loop, proceed as follows:

1. Activate the loop by clicking on the Loop button on the 
toolbar.
If it isn’t visible, right-click the toolbar and add the Independent Track 
Loop Settings section – see “The Setup dialogs” on page 506.
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When the loop is activated, the cycle isn’t shown in the 
ruler. 

2. Now you need to specify the length of the loop. You 
have the following possibilities:

• [Ctrl]/[Command]-click and [Alt]/[Option]-click in the 
ruler to set the start and end of the loop, respectively.

• Edit the loop start and end positions numerically in the 
fields next to the Loop button.

• Click and drag in the upper part of the ruler to move the 
locators to the desired positions.

The independent track loop is indicated in purple in the 
ruler.

The MIDI events will be looped as long as the Loop 
button is activated and the MIDI editor window is open.

To turn the loop into actual MIDI notes, use the Repeat 
Loop function on the MIDI menu, see “Repeat Loop” on 
page 360.

Auditioning

If the speaker icon on the toolbar is activated, individual 
notes will automatically be played back (auditioned) when 
you move or transpose them, or when you create new notes 
by drawing. This makes it easier to hear what you’re doing.

Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when 
editing in a MIDI editor. It does this by restricting horizon-
tal movement and positioning to certain positions. Opera-
tions affected by snap include moving, duplicating, 
drawing, sizing, etc.

• How Snap works depends on the Snap mode pop-up 
menu next to the Snap button.
See “Snap” on page 55.

• When the “Bars+Beats” display format is selected in 
the ruler, the snap grid is set by the quantize value on the 
toolbar.
This makes it possible to snap not only to straight note values but also to 
swing grids set up in the Quantize Setup dialog (see “The Quantizing 
functions” on page 352).

When any of the other display formats is selected in the 
ruler, positioning is restricted to the displayed grid, i.e. you 
can snap in finer increments by zooming in, and in coarser 
increments by zooming out the display.

Coloring notes and events
By using the Colors pop-up menu on the toolbar, you can 
select a color scheme for the events in the editor. The fol-
lowing options are available:

When any of the options (apart from “Part”) is selected, 
you can select “Setup” from the Colors pop-up menu. 
This opens a dialog in which you can specify which colors 
should be associated with which velocities, pitches or 
channels, respectively.

Option Description

Velocity The notes get different colors depending on their velocity 
values.

Pitch The notes get different colors depending on their pitch.

Channel The notes get different colors depending on their MIDI 
channel value.

Part The notes get the same color as their respective part in 
the Project window. Use this option when you are work-
ing with two or more tracks in an editor, to make it easier 
to see which notes belong to which track.

GridMatch The notes get different colors depending on their time 
position. This mode makes it easy to see e.g. if the notes 
in a chord start at the exact same beat.
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Creating and editing notes
To draw in new notes in the Key Editor, you use the Pencil 
tool or the Line tool.

Drawing notes with the Pencil tool

With the Pencil tool, you insert single notes by clicking at 
the desired time (horizontal) and pitch position (vertical).

• When you move the pointer in the note display, its bar 
position is indicated in the toolbar, and its pitch is indicated 
both in the toolbar and on the piano keyboard to the left.
This makes it easy to find the right note and insert position.

• If Snap is activated, this determines the start position of 
the created note.

• If you click once, the created note will have the length 
set on the Length Quantize pop-up menu on the toolbar.
You can create a longer note by clicking and dragging. The length of the 
created note will be a multiple of the Length Quantize value.

Drawing notes with the Line tool

The Line tool can be used for creating series of contigu-
ous notes. To do so, click and drag to draw a line and then 
release the mouse button.

The Line tool has several different modes.
To select one of the modes, click on the Line tool icon on the toolbar 
when the tool is already selected. This opens a pop-up menu from which 
you can select one of the Line tool modes.

The tool icon will change appearance according to the se-
lected mode.

Setting velocity values

When you draw notes in the Key Editor, the notes will get 
the velocity value set in the insert velocity field on the tool-
bar.

You can use one of four different methods for determining 
the velocity:

• When a key command is assigned for the Select tool–
Edit Velocity action (in the Editing–Tool Modifiers page of 
the Preferences dialog), you can select one or more notes, 
press [Ctrl]/[Command]+[Shift] and click on one of the 
selected notes to change the velocity. 
The cursor changes into a speaker and, next to the note, a field with the 
velocity value appears – the Note Velocity slider. Move the mouse 
pointer up or down to change the value. Value changes will be applied to 
all selected notes, as you can see in the controller lane. 

• Selecting a predefined velocity value from the insert ve-
locity pop-up menu.
The menu contains five different predefined velocity values. The “Setup…” 
item opens a dialog that allows you to specify which five velocity values 
should be available on the pop-up menu. (This dialog can also be opened 
by selecting “Insert Velocities…” from the MIDI menu.)

Mode Description

Line This is the default mode for the Line tool. When this 
mode is selected, you click and drag to create a straight 
line, in any angle. When you release the mouse button a 
series of notes will be created, aligned with the line. If 
Snap is activated, the notes will be spaced and sized ac-
cording to the Quantize value.

Parabola, Sine, 
Triangle, Square

These modes insert events along different curve shapes. 
While they can be used for creating notes, they’re proba-
bly best suited for controller editing (see “Adding and 
editing events in the controller display” on page 379).

Paint Allows you to insert multiple notes by dragging with the 
mouse button pressed. If Snap is activated, the notes will 
be positioned and sized according to the Quantize and 
Length Quantize values. If you press [Ctrl]/[Command] 
while painting, movement will be restricted to horizontal 
only (i.e. the painted notes will have the same pitch).
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• Manually entering the desired velocity value by clicking 
in the insert velocity field and typing in the desired value.

• Using a key command.
You can assign a key command to each of the five available velocity val-
ues in the Key Commands dialog (MIDI category – the items Insert Ve-
locity 1-5). This allows for quick switching between different velocity 
values when entering notes. See “Setting up key commands” on page 
518 for instructions on how to set up key commands.

Selecting notes

Selecting notes is done using any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply, like selecting by clicking on the 
note or using a selection rectangle. Note that when you press [Shift] and 
click on notes or draw a selection rectangle, these notes will be added to 
the overall selection. When you press [Ctrl]/[Command] and click on 
notes or draw a selection rectangle, these notes will be removed from 
the overall selection (standard Windows behavior).

• Use the Select submenu on the Edit menu or Quick 
menu.
The Select menu options are:

• You can also use the left and right arrow keys on the 
computer keyboard to step from one note to another.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several notes.

• To select all notes of a certain pitch, press [Ctrl]/[Com-
mand] and click on the desired key in the keyboard display 
to the left.

You can also press [Shift] and double-click on a note to select all the fol-
lowing notes of the same pitch – or use the Equal Pitch functions on the 
Select submenu.

• If the option “Auto Select Events under Cursor” is acti-
vated in the Preferences (Editing page), all notes “touched” 
by the project cursor are automatically selected.

Toggle selections

If you want to toggle the selected elements within a selec-
tion rectangle, press [Ctrl]/[Command] and enclose the 
same elements within a new selection rectangle. Once 
you release the mouse button, the previous selection is 
deselected and vice versa.

Selecting controllers within the note range

You can select the controllers within the range of the se-
lected notes. The following applies:

• When the Auto Select Controllers button is activated 
on the toolbar, the controllers will always be selected 
when the respective notes are selected.

• When you select “Select Controllers in Note Range” on 
the Select submenu of the Edit menu, the controllers 
within the note range (i.e. between the first/leftmost and 
last/rightmost note) will be selected.
Please note that for this to work, only two notes have to be selected. All 
controllers within this range will be selected.

• A note range lasts until the start of the next note or the 
end of the part. 

• Selected controllers for notes are moved when the cor-
responding notes are moved.

Option Description

All Selects all notes in the edited part.

None Deselects all events.

Invert Inverts the selection – all selected events are deselected 
and all notes that were not selected are selected instead.

In Loop Selects all notes that are partially or completely inside the 
boundaries of the left and right locators (only visible if lo-
cators are set).

From Start to 
Cursor

Selects all notes that begin to the left of the project cur-
sor.

From Cursor to 
End

Selects all notes that end to the right of the project cur-
sor.

Equal Pitch – 
all Octaves

This function requires that a single note is selected. It se-
lects all notes of this part that have the same pitch (in any 
octave) as the currently selected note.

Equal Pitch – 
same Octave

As above, but selects notes of the exact same pitch only 
(same octave).

Select Control-
lers in Note 
Range

Selects the MIDI controller data within range of the se-
lected notes, see below.

All notes of the corresponding pitch are selected.
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Moving and transposing notes

To move notes in the editor, use any of the following me-
thods:

• Click and drag to a new position.
All selected notes will be moved, maintaining their relative positions. If 
Snap is activated, this determines to which positions you can move the 
notes, see “Snap” on page 370.

• Use the up and down arrow keys on the computer key-
board.
This method allows you to transpose the selected notes, without risking 
to move them horizontally. You can also use the Transpose function (see 
“Transpose” on page 357) or the info line (see “The info line” on page 
366) for this. Note that pressing [Shift] and using the up and down arrow 
keys will transpose notes in steps of one octave.
Transport is also affected by the global transpose setting, see “The 
Transpose functions” on page 114.

• Use the Move to Cursor function on the Edit menu.
This moves the selected notes to the project cursor position.

• Select a note and adjust its position or pitch on the info 
line.
See “Editing on the info line” on page 375.

• Use the Move buttons in the Nudge palette on the tool-
bar.
This moves the selected note(s) by the amount set on the Quantize pop-
up menu. 
By default, the Nudge palette isn’t shown on the toolbar – see “The Se-
tup dialogs” on page 506 for more information.

Note that when you move selected notes to a different 
position, any selected controllers for these notes will move 
accordingly.
See also “Moving and copying events” on page 380.

You can also adjust the position of notes by quantizing 
(see “The Quantizing functions” on page 352).

Duplicating and repeating notes

Notes are duplicated much in the same way as events in 
the Project window:

• Hold down [Alt]/[Option] and drag the note(s) to a new 
position.
If Snap is activated, this determines to which positions you can copy 
notes (see “Snap” on page 370).

• Selecting Duplicate from the Edit menu creates a copy 
of the selected note and places it directly after the original.
If several notes are selected, all of these are copied “as one unit”, main-
taining the relative distance between the notes.

• Selecting Repeat from the Edit menu opens a dialog, al-
lowing you to create a number of copies of the selected 
note(s).
This works like the Duplicate function, but you can specify the number of 
copies.

• You can also perform the Repeat function by dragging: 
Select the note(s) to repeat, press [Alt]/[Option], click the 
right edge of the last selected note and drag to the right.
The longer to the right you drag, the more copies are created (as indi-
cated by the tool tip).

Using cut and paste

You can use the Cut, Copy and Paste options on the Edit 
menu to move or copy material within a part or between 
different parts. When you paste copied notes, you can ei-
ther use the regular Paste function or the function “Paste 
Time” from the Range submenu of the Edit menu.

• “Paste” inserts the copied notes at the project cursor position 
without affecting existing notes.

! Note also that you can restrict movement to horizon-
tal or vertical only by holding down [Ctrl]/[Command] 
while dragging.
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• “Paste Time” inserts at the project cursor position, but moves 
(and if necessary, splits) existing notes to make room for the 
pasted notes.

Resizing notes

To resize a note, use one of the following methods:

• Position the arrow tool at the start or end of the note, so 
that the pointer takes on the shape of a small double ar-
row. Click and drag to the left or right to resize the note.
This method allows you to resize the note from either direction.

• Click with the Pencil tool within the note box and drag 
to the left or the right (to make the note shorter or longer, 
respectively).

With both these methods, the resulting length will be a 
multiple of the Length Quantize value on the toolbar.

• Use the Trim Start/End buttons on the Nudge palette on 
the toolbar.
This resizes the selected note(s) by moving their start or end positions, in 
steps according to the Length Quantize value on the toolbar. By default, 
the Nudge palette isn’t shown on the toolbar – see “The Setup dialogs” on 
page 506 for more information.

• Select the note and adjust its length on the info line.
See “Editing on the info line” on page 375 for details on info line editing.

• Use the Trim tool, see “Using the Trim tool” on page 369.

Splitting notes

There are three ways to split notes:

• Clicking on a note with the Scissors tool splits the note 
at the position you pointed (taking the Snap setting into 
account if activated).
If several notes are selected, they are all split at the same position.

• If you select “Split at Cursor”, all notes that are inter-
sected by the project cursor are split at the cursor position.

• If you select “Split Loop”, all notes that are intersected 
by the left or right locator are split at the locator positions.

Gluing notes

Clicking on a note with the Glue Tube tool will “glue it to-
gether” with the next note of the same pitch. The result will 
be one long note spanning from the start of the first note 
to the end of the second note and with the properties (ve-
locity, etc.) of the first note.

Muting notes

Individual notes can be muted in the Key Editor, as op-
posed to muting an entire MIDI part in the Project window. 
This allows you to exclude notes from playback, but keep 
the option to bring them back again at any time. To mute a 
note, use one of the following methods:

• Click on it with the Mute tool.

• Drag a rectangle with the Mute tool, enclosing all notes 
you want to mute.

• Select the note(s) and choose Mute from the Edit menu. 
The default key command for this is [Shift]+[M].

Muted notes are “dimmed” in the note display.

To unmute a note, either click it or enclose it with the Mute 
tool, or select it and choose Unmute from the Edit menu. 
The default key command for this is [Shift]+[U].

Selecting “Paste Time” with this data on the 
clipboard and the project cursor here…

…will give you this.
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Deleting notes

To delete notes, either click on them with the Eraser tool 
or select them and press [Backspace].

Editing on the info line
The info line shows the values and properties of the se-
lected event(s). If a single event is selected, its values are 
displayed on the info line. If several events are selected, 
the info line shows the values of the first of these events in 
yellow.

Several events selected.

You can edit the values on the info line using regular value 
editing. This allows you to move, resize, transpose or 
change velocity of events in a very precise manner. It’s also 
possible to click the Pitch or Velocity field in the info line 
and play a note on your MIDI keyboard – the pitch or veloc-
ity will be adjusted according to the note you played.

If you have several events selected and change a value, 
all selected events will be changed by the set amount.

If you have several events selected, hold down [Ctrl]/
[Command] and change a value, the change will be abso-
lute.
In other words, the value setting will be the same for all selected events.

How the Key Editor handles drum maps 
(Nuendo Expansion Kit only)
When a drum map is assigned to a MIDI track, the Key 
Editor will display the drum sound names as defined by 
the drum map.

This allows you to use the Key Editor for drum editing, e.g. 
when editing drum note lengths (which may be necessary 
for some external instruments) or when editing several 
parts, to identify drum events.

Editing notes via MIDI
You can change the properties of notes via MIDI. For ex-
ample, this can be a fast way to get the right velocity value, 
since you will hear the result even as you edit:

1. Select the note you want to edit.

2. Click on the MIDI connector symbol on the toolbar.

Click this button to enable editing via MIDI.

The drum sound names are displayed…

…in the info line, in the Pitch field…

…in the Mouse Note Value field…

…in the event itself (provided the 
zoom factor is high enough).

…when dragging a note…
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3. Use the note buttons on the toolbar to decide which 
properties should be changed by the MIDI input.
You can enable editing of pitch, note-on and/or note-off velocity.

With this setting, the edited notes will get the pitch and velocity values 
of the notes input via MIDI, but the note-off velocities will be kept as 
they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will get the pitch, velocity and/or note-off 
velocity of the played note.

The next note in the edited part is automatically selected, 
making it easy to quickly edit a series of notes.

• If you want another try, select the note again (e.g. by 
pressing the left arrow key on the computer keyboard) and 
again play a note on your MIDI instrument.

Step input
Step input, or step recording, is when you enter notes one 
at a time (or one chord at a time) without worrying about 
the exact timing. This is useful e.g. when you know the part 
you want to record but are not able to play it exactly as you 
want it.

Proceed as follows:

1. Click the Step Input button on the toolbar to activate 
Step Input mode.

2. Use the note buttons to the right to decide which 
properties should be included when you input the notes.
For example, you may not want to include the velocity and/or note-off ve-
locity of the played notes. It’s also possible to turn off the pitch property, 
in which case all notes will get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start po-
sition (the desired position of the first note or chord).
The step input position is shown as a blue line in the note display, and in 
the lower mouse pointer display in the toolbar.

4. Specify the desired note spacing and length with the 
Quantize and Length Quantize pop-up menus.
The notes you input will be positioned according to the Quantize value 
and have the length set with the Length Quantize value. For instance, if 
you set Quantize to 1/8 notes and Length Quantize to 1/16 note, the 
notes will be sixteenth notes, appearing on each eighth note position.

5. Play the first note or chord on your MIDI instrument.
The note or chord appears in the editor and the step input position ad-
vances one quantize value step.

If Insert mode is activated, all notes to the right of the 
step input position will be moved to “make room” for the 
inserted note or chord.

Insert mode activated.

6. Continue in the same way with the rest of the notes or 
chords.
You can adjust the Quantize or Length Quantize value as you go along, 
to change the timing or note lengths. You can also move the step input 
position manually by clicking anywhere in the note display.

• To insert a “rest”, press the right arrow key on the com-
puter keyboard.
This advances the step input position one step.

7. When you’re done, click the Step Input button again 
to deactivate step input.
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Editing in the controller display

About controller lanes

By default, the controller display has a single lane, show-
ing one event type at a time. However, you can add lanes 
by right-clicking in the display and selecting “Create new 
controller lane” from the Quick menu. This allows you to 
view and edit different controllers at the same time.

The controller display with three lanes set up.

• To remove a lane, right-click in it and select “Remove this 
Lane” from the Quick menu, or click on the minus button.
This hides the lane from view – it doesn’t affect the events in any way.

• If you remove all lanes, the controller display will be 
completely hidden.
To bring it back again, select “Create new controller lane” from the Quick 
menu.

Selecting the event type

Each controller lane shows one event type at a time. To 
select which type should be displayed, use the pop-up 
menu to the left of the lane.

• Selecting “Setup…” opens a dialog in which you can 
specify which continuous controller event types should be 
available on the pop-up menu.

• Each MIDI track has its own controller lane setup (num-
ber of lanes and selected event types). 
When you create new tracks, they get the controller lane setup used last.

Controller lane presets

Once you have added the required number of controller 
lanes and selected the event types you need, you can 
store this combination as a controller lane preset. You 
could for example have a preset with one velocity lane 
only, another with a combination of velocity, pitch bend 
and modulation, and so on. This can make working with 
controllers much quicker.

• To add the current controller lane setup as a preset, pull 
down the pop-up menu to the left of the horizontal scroll-
bar and select “Add”.
Enter a name for the preset in the dialog that appears and click OK.

• To apply a stored preset, select it from the pop-up menu.
This immediately brings up the controller lanes and event types in the 
preset.

• To remove or rename presets, select “Organize” from 
the pop-up.

Controller types in this 
list are already listed on 
the pop-up menu.

Controller types in this 
list are not listed on the 
pop-up menu.

Click this button to add 
the selected controller 
type to the pop-up menu.

Click this button to remove the 
controller type selected in the 
left list from the pop-up menu.
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Editing velocity values

When “Velocity” is selected for viewing, the lane shows 
the velocity of each note as a vertical bar.

Velocity values are edited with the Pencil or the Line tool. 
The different tools and Line tool modes offer several pos-
sibilities, as listed below.

If the option “Controller Lane Editing: Select Tool de-
faults to Pen” is activated in the Preferences (Editing–MIDI 
page), the Arrow tool automatically switches to the Pencil 
tool when you move the pointer into the controller display.
If you want to use the Arrow tool to select events in the controller display, 
press [Ctrl]/[Command].

If the Speaker icon (Acoustic Feedback) is activated 
on the toolbar, the notes will be played back when you ad-
just the velocity, allowing you to audition your changes.

• You can use the Pencil tool to change the velocity of a 
single note: click on its velocity bar and drag the bar up or 
down.
While you drag, the current velocity value is shown in the display to the left.

• You can use the Pencil tool or the Line tool in Paint 
mode to change the velocity values of several notes by 
painting a “freehand curve”.
When editing velocity, these two methods have the same functionality.

• Use the Line tool in Line mode for creating linear veloc-
ity ramps.
Click where you want the ramp to start and drag the cursor to where you 
want the ramp to end. When you release the mouse button, the velocity 
values are aligned with the line between the two points.

• Parabola mode works in the same way, but aligns the 
velocity values to a Parabola curve instead.
Use this for smooth, “natural” velocity fades, etc.

• The remaining three Line tool modes (Sine, Triangle and 
Square) align the velocity values to continuous curve 
shapes (see below).

Note:

• If there is more than one note at the same position (e.g. a 
chord), their velocity bars will overlap in the controller lane. 
If none of the notes are selected, all notes at the same position will be set 
to the same velocity value when you draw. To edit the velocity of only one 
of the notes at the same position, first select the note in the note display. 
Now, editing will only affect the velocity of the selected note.

You can also adjust the velocity of a single note by select-
ing it and changing its velocity value on the info line.
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Adding and editing events in the controller display

When any option other than “Velocity” is selected for a 
controller lane, you can create new events or edit the val-
ues of existing events using the Pencil tool or the Line tool 
in its various modes: 

• Clicking with the Pencil tool or the Line tool in Paint 
mode creates a new event.
Note the “Select Tool defaults to Pen” option – see “Editing velocity va-
lues” on page 378. 

• Press [Alt]/[Option] and use the Pencil tool or the Line 
tool in Paint mode to modify the value of an event (without 
creating a new one).
Note that you can click and drag to change or add multiple events, draw 
controller curves, etc. You can press or release [Alt]/[Option] while draw-
ing, switching dynamically between “edit mode” and “create mode”.

With the Pencil tool and the Line tool in Paint mode, the 
quantize value determines the “density” of created control-
ler curves (if Snap is activated, see “Snap” on page 370).
For very smooth curves, you should use a small quantize value or turn off 
Snap. However, this will create a very large number of MIDI events, which 
can cause MIDI playback to “stutter” in some situations. A medium-low 
density is often sufficient.

• Clicking and dragging with the Line tool in Line mode 
shows a line in the controller lane, and creates events with 
values aligned to this line.
This is the best way to draw linear controller ramps. If you press [Alt]/[Op-
tion], no new events are created – use this mode for modifying existing 
controller curves.

• The Parabola mode works in the same way, but aligns 
the values to a parabola curve instead, giving more “natu-
ral” curves and fades.
Note that the result depends on the direction from which you draw the 
parabola.

• In Parabola mode, you can use modifier keys to deter-
mine the shape of the parabola curve.
If you press [Ctrl]/[Command], the parabola curve will be reversed. If you 
press [Alt]/[Option]+[Ctrl]/[Command] while Snap is activated, you can 
change the position of the whole curve (in both cases the snap value for 
the positioning will be a quarter of the quantize value). If you press [Shift], 
the exponent will be increased or decreased.

If you want to enter or adjust a single event, click once with the Pencil 
tool or the Line tool in Paint mode.

If you want to “paint a curve”, drag the tool (with the mouse button 
pressed):

When you move the pointer in the controller lane, the 
corresponding value is displayed in this field.

Converting a controller curve to a ramp 
using the Line tool.
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In Line and Parabola modes, the length quantize value 
determines the “density” of created controller curves (if 
Snap is activated).
For very smooth curves, you should use a small length quantize value or 
turn off Snap. To avoid over-dense controller curves (which may cause 
MIDI playback to “stutter”), use a medium-low density.

• The Sine, Triangle and Square modes create events 
with values aligned to continuous curves.
In these modes, the quantize value determines the period of the curve 
(the length of one curve “cycle”) and the length quantize value deter-
mines the density of the events (the lower the length quantize note value, 
the smoother the curve).

• In Sine, Triangle and Square mode you can also use 
modifier keys to determine the shape of the curve.
If you press [Ctrl]/[Command] you can change the phase of the beginning 
of the curve, if you press [Alt]/[Option]+[Ctrl]/[Command] while snap is 
activated you can change the position of the whole curve (in both cases 
the snap value for the positioning will be a quarter of the quantize value).

You can also set the curve period freely by holding 
down [Shift] when you insert events in Sine, Triangle or 
Square mode.
Activate Snap, [Shift]-click and drag to set the length of one period. The 
period length will be a multiple of the quantize value.

• In Triangle and Square mode, you can press [Shift] + 
[Ctrl]/[Command] to change the maximum position of the 
triangle curve (to create sawtooth curves) or the pulse of 
the square curve. As in other modes, you can press [Alt]/
[Option] if you want to change the existing events rather 
than creating new ones. Again, the snap value for the po-
sitioning will be a quarter of the quantize value.

Moving and copying events

You can move or duplicate events in a controller lane, 
much like you can with notes:

1. Click with the Arrow tool to select the events you want 
to cut or copy.
If the option “Controller Lane Editing: Select Tool defaults to Pen” is ac-
tivated in the Preferences (Editing–MIDI page), you need to press [Ctrl]/
[Command] to get the Arrow tool.

2. Click and drag the events to move them.
If Snap is activated, this determines to which positions you can move the 
events (see “Snap” on page 370).

• If you hold down [Alt]/[Option] and drag, the events will 
be copied rather than moved. 

Using cut, copy and paste

You can use the standard Cut, Copy and Paste options on 
the Edit menu to move or copy events in the controller dis-
play:

1. Select the events you want to cut or copy.

2. Select Cut or Copy from the Edit menu.

3. If you want to paste the events into another MIDI part, 
open that part in another Key Editor window.

4. Position the project cursor where you want to paste 
the events.

5. Select Paste from the Edit menu.
The events on the clipboard are added, starting at the project cursor po-
sition, maintaining their relative distances. If a pasted event ends up at 
the same position as an existing event of the same type, the old event is 
replaced. 

! If there is an event of the same type at the exact 
same position already, this will be replaced by the 
moved event.

! Remember that a non-note event doesn’t have a 
length – it’s “valid” until the next event (see “The 
controller display” on page 368.

! When the Auto Select Controllers button is activated 
in the Key Editor toolbar, selecting controller events 
will also select the corresponding notes. Moving 
events (either using cut/copy/paste or drag & drop) 
in the note display will also move the corresponding 
controller events and vice versa. See also “Selecting 
controllers within the note range” on page 372.
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Deleting events in the controller display

You delete events by clicking on them with the Eraser tool 
or by selecting them and pressing [Backspace]. Please 
note:

• Deleting a controller event makes the last event before 
this valid up until the next event. It does not “zero” any 
controller changes.

• You can delete notes by deleting their velocity bars in 
the controller display.
Please be aware that if there is more than one note on the same position, 
there may still only be one velocity bar visible – make sure you delete only 
the desired notes!

Adding and editing Poly Pressure events

Poly Pressure events are special, in that they “belong to” a 
specific note number (key). That is, each Poly Pressure 
event has two editable values: the note number and the 
amount of pressure. Therefore, when Poly Pressure is se-
lected on the event type pop-up menu, there are two value 
fields to the left of the controller display, one for the note 
number and one for the amount:

To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Set the note number by clicking on the keyboard dis-
play.
The selected note number is displayed in the upper value field to the left 
of the controller display. Note that this only works for the topmost lane. If 
you have selected “Poly Pressure” for several controller lanes, you have 
to type in the desired note number directly in the lower value field to the 
left of each lane. 

3. Use the Pencil tool to add a new event, just as when 
adding regular controller events.

To view and edit existing Poly Pressure events, proceed 
as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Click on the arrow button next to the note number field 
to the left of the controller lane.
A pop-up menu appears, listing all note numbers for which there already 
are Poly Pressure events.

3. Select a note number from the pop-up menu.
The Poly Pressure events for the selected note number are shown in the 
controller lane.

4. Use the Pencil tool to edit the events as usual.
Press [Alt]/[Option] to edit existing events without adding any new ones.

• Poly Pressure events can also be added and edited in 
the List Editor.

Edit In-Place
The Edit In-Place function makes it possible to edit MIDI 
parts directly in the Project window, for quick and efficient 
editing in context with other tracks. 

To open the In-Place editor for one or more selected 
tracks, you have the following possibilities:

• Select “Open In-Place Editor” on the MIDI menu.

• Use a key command, by default [Ctrl]/[Com-
mand]+[Shift]+[I].

• Toggle the In-Place Editor for all selected tracks by 
clicking on the respective button above the Track list.

• To open a single MIDI track, you can also click the Edit 
In-Place button in the Track list (if necessary, expand the 
Track list to see the button).

This expands the MIDI track to show something like a min-
iature Key Editor, allowing you to edit MIDI notes and con-
trollers.
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• To zoom or scroll the In-Place Editor, point at the left 
part of the piano keyboard display so that the pointer 
changes to a hand. Now you can click and drag to the 
right or left to zoom in or out vertically, and drag up or 
down to scroll the editor.

• Clicking on the little gray triangle in the upper right cor-
ner of the Track list for the edited track brings up a local 
toolbar with some settings specific to the In-Place Editor.

For descriptions of these settings, see “The toolbar” on page 366.

• Just like in the Key Editor, you can edit velocity or con-
tinuous controllers at the bottom of the In-Place Editor.
To change which controller type is shown, click in the controller name field 
directly below the piano keyboard and select a controller type from the 
pop-up menu. To add or remove controller lanes, right-click below the con-
troller name field and select an option from the context menu that appears.

• When you select a MIDI note, the Project window info 
line shows information about that note, just like the info 
line in the Key Editor.
You can perform the same editing here as on the Key Editor info line, see 
“Editing on the info line” on page 375.

• The Snap button and Snap type pop-up menu on the 
Project window toolbar govern snapping in the In-Place 
Editor, but the snap grid is set using the Quantize pop-up 
menu.

• To close the In-Place Editor for one or several selected 
tracks, you can use the key command or click the “Toggle 
the In-Place Editor” button above the Track list. 

• To close the In-Place Editor for one track, you can click 
the Edit In-Place button in the Track list or double-click 
below the controller display in the In-Place Editor.

Working with Parts 

If you work with parts in the In-Place Editor, some editing 
functions are available. You can:

• change the length of the parts by clicking on the lower part 
edges (so that the mouse pointer changes to a double arrow) 
and dragging it to the left or right.

• drag and drop notes from one part to the other.
• change the length of notes by clicking on them and dragging 

the double arrow to the left or right.
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The List Editor – Overview

The toolbar
The toolbar contains several items that are the same as in 
the Key Editor (edit solo, snap, quantize settings, etc.). 
These are described earlier in this chapter. The following 
toolbar items are unique to the List Editor:

• The Insert pop-up menu is used when creating new 
events.
This is where you determine what type of event to add (see “Inserting 
events” on page 384).

• The Mask pop-up menu and Filter view (Show Filter 
View button) allow you to hide events from view, based on 
their type and other properties.
See “Filtering” on page 385.

• The Value View button can be used for hiding and 
showing the Value display (see below).

The List Editor has no info line (numerical editing is avail-
able in the list instead).

If you see an empty or incomplete list of items although 
the items are visible in the Key Editor, check if you have ac-
tivated any filters (see “Filtering” on page 385).

The list
This lists all events in the selected MIDI part(s), in the or-
der (from top to bottom) in which they are played back. 
You can edit the event properties by using regular value 
editing, see “Editing in the list” on page 384.

The event display
This shows the events graphically. The vertical position of 
an event in the display corresponds to its entry in the list 
(i.e. to the playback order), while the horizontal position cor-
responds to its actual position in the project. This is where 
you add new parts or events, drag to move them, etc.

The value display
This display shows the “value” of each event, allowing for 
easy viewing and graphical editing. Typically, the value 
shown is the “Data 2” or “Value 2” property (amounts to 
MIDI controller events, velocity for notes, etc.). You can 
show or hide this display by clicking the “Show List Value 
View” button on the toolbar.

Event displayEvent list 

Value 
display

RulerToolbar Filter view
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List Editor operations

Customizing the view
You can click and drag the divider between the list and 
the event display to make one area wider and the other 
narrower. Furthermore, the list can be customized in the 
following ways:

• You can change the order of the columns by dragging 
the column headings.

• You can resize columns by dragging the dividers be-
tween the column headings.

Setting the display format

Just like in the Project window, you set the display format 
(bars+beats, seconds, etc.) by right-clicking in the ruler 
and selecting an option from the pop-up menu. This set-
ting affects both the ruler and all start, end and length val-
ues shown in the list.

Zooming

You can change the horizontal magnification in the event 
display by using the zoom slider below the display or the 
Zoom tool (the magnification glass).

Inserting events
To add a new event to the edited part, proceed as follows:

1. Use the Insert pop-up menu on the toolbar to select 
the event type.

2. Select the Pencil tool and click in the event display at 
the desired position (relative to the ruler).
If you are creating note events, you can click and drag to set the length of 
the note.

The new event appears in the list and in the display. Its 
properties will be set to default values, but can be ad-
justed in the list.

• Notes will get the insert velocity value set in the insert 
velocity field on the toolbar. See “Setting velocity values” 
on page 371.

Editing in the list
The list allows you to perform detailed numerical editing of 
the events properties. The columns have the following 
functionality:

• You can edit several events at once. If several events 
are selected and you edit a value for one event, the other 
selected events’ values will be changed as well.
Normally, any initial value differences between the events will be main-
tained – i.e. the values will change by the same amount. If you press [Ctrl]/
[Command] when you edit, however, all events will get the same value.

Column Description

L Locate column. An arrow in this column indicates the 
event that starts closest before the project cursor posi-
tion. If you click in this column for an event, the project 
cursor is moved to the start of that event. Double-clicking 
moves the cursor position and starts/stops playback – 
useful for auditioning when editing in the list.

Type The event type. This cannot be changed.

Start The start position of the event, shown in the format se-
lected for the ruler. Changing this is the same as moving 
the event. Note that moving the event past any other 
event in the list will re-sort the list (the list always shows 
the events in the order they are played back).

End This is only used for note events, allowing you to view and 
edit the end position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of 
the note – changing this resizes the note and automati-
cally changes the End value as well.

Data 1 This is the “data 1” or “value 1” property of the event. The 
content of this depends on the event type – for notes, 
this is the pitch, for example. Where applicable, the val-
ues are shown in the most relevant form. For instance, the 
Data 1 value for notes is shown as a note number in the 
format selected in the Preferences (Event Display–MIDI 
page). See also the table in the section “Editing in the va-
lue display” on page 386.

Data 2 This is the “data 2” or “value 2” property of the event. The 
content of this depends on the event type – for notes, 
this is the velocity value, for example. See the table in the 
section “Editing in the value display” on page 386.

Channel The MIDI channel of the event. Note that this setting is 
normally overridden by the channel setting for the track. 
To make a MIDI event play back on “its own” channel, set 
its track to channel “Any” in the Project window.

Comment This column is used for some event types only, providing 
an additional comment about the event.
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For SysEx (system exclusive) events, you can only edit 
the position (Start) in the list.
However, when you click the Comment column, the MIDI SysEx Editor 
opens, in which you can perform detailed editing of system exclusive 
events (see “Working with System Exclusive messages” on page 410).

Editing in the event display
The event display allows you to edit the events graphically 
using the tools on the toolbar. You can edit single events 
as well as several selected events simultaneously.

• To move an event, click and drag it to a new position.
Note that moving the event past any other event in the display will re-sort 
the list (the list always shows the events in the order they are played 
back). As a result, the vertical position of the event in the display will 
change as well.

• To make a copy of an event, press [Alt]/[Option] and 
drag it to a new position.

• To resize a note, select it and drag its end point with the 
Arrow tool as in the Project window.
This only works with notes.

• To mute or unmute an event, click on it with the Mute 
tool.
You can mute or unmute several events in one go by enclosing them in a 
selection rectangle with the Mute tool.

• You can select a color scheme for the events with the 
Colors pop-up menu on the toolbar.
This affects how all MIDI events are shown in the List and Key editors – 
see “Coloring notes and events” on page 370.

• To delete an event, select it and press [Backspace] or 
[Delete], or click on it with the Eraser tool in the event dis-
play.

Filtering

Clicking the “Show Filter View” button on the toolbar 
opens an additional filter bar that allows you to hide spe-
cific event types from view. For example, it may be hard to 
find note events if the part contains a lot of controllers. By 
hiding these, the list becomes more manageable.

• To hide an event type, activate its checkbox on the filter 
view.

• To see one event type only (hide all other event types), 
press [Ctrl]/[Command] and click its checkbox. If you 
[Ctrl]/[Command]-click again, all checkboxes are cleared 
(all events will be visible).

The event types remain hidden even if you close the fil-
ter view.
To make sure you see all events, open the filter view and check that all 
checkboxes are deactivated.

The filter view does not remove, mute or change the 
events in any way.

Masking

The Mask function is similar to the filter view but allows 
you to hide events based on other criteria as well. Pro-
ceed as follows:

1. Select an event (or several events) of the type you want 
to view.

2. Pull down the Mask pop-up menu on the toolbar and 
select one of the options.
The results are as follows:

Option Description

Event Types Only events with the type of the selected event will be 
shown. This does the same as the filter view but is 
quicker if you only want to view a single event type.

Event Types
and Data 1

Only events of the same type and with the same “Data 1” 
value will be shown. For example, if a note event is se-
lected, only notes with the same pitch will be shown. If a 
controller event is selected, only controllers of the same 
type will be shown.

Event Channels Only events with the same MIDI channel value as the se-
lected event will be shown.
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In addition to the above options, the menu also gives you 
access to the presets available in the Logical Editor (see 
“The Logical Editor, Transformer and Input Transformer” 
on page 387). Furthermore, the “Setup…” item on the 
Mask pop-up menu gives you direct access to the Logical 
Editor. In that editor you can create very complex masking 
settings.

When you apply any of the presets from the Logical Editor 
or use the Logical Editor to create masking settings your-
self, only the events that meet the criteria specified will be 
visible.

• To deactivate the Mask function, select “Nothing” from 
the Mask pop-up menu.

The most typical usage of the Mask function is to view a 
certain type of controller only (e.g. Modulation, Breath 
Control, etc.). Since these are all the same event types 
(controller), this would not be possible using the filter 
view. With the “Event Types and Data 1” option on the 
Mask pop-up menu, it is!

Editing in the value display
The value display to the right of the event display is a tool 
for quick viewing and editing of multiple values, e.g. veloci-
ties or controller amounts. The values are shown as hori-
zontal bars, with the bar length corresponding to the value.

A velocity ramp in the value display.

You edit the values by clicking and dragging. Note that the 
pointer automatically takes on the shape of the Pencil tool 
when you move it into the value display – you don’t have to 
select the Pencil tool for this.

Exactly which value is shown for an event depends on the 
event type. The following table shows what is displayed 
and edited in the Data columns and the value display:

• The value display can be hidden from view by clicking 
the “Show List Value View” button on the toolbar, so that it 
is not lit.

Event type Data 1 Data 2 Value display

Note Pitch
(note number)

Velocity Velocity

Controller Controller type Controller 
amount

Controller 
amount

Program 
Change

Program 
number

Not used Program 
number

Aftertouch Aftertouch 
amount

Not used Aftertouch 
amount

Pitch Bend Bend amount Not used Bend amount

SysEx Not used Not used Not used
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Introduction
Most of the time you will perform your MIDI editing graphi-
cally in one of the main graphic editors. But there are times 
when you want more of a “search and replace” function on 
MIDI data, and that’s where the Logical Editor comes in.

The principle for the Logical Editor is this:

• You set up filter conditions to find certain events.
This could be events of a certain type, with certain attributes or values or 
on certain positions, in any combination. You can combine any number of 
filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed.
The options include Transform (changing properties of the found events), 
Delete (removing the events), Insert (adding new events based on the 
found events’ positions) and more.

• You set up a list of actions, which specify exactly what 
should be done.
This is not necessary for all functions. For example, the Delete function 
does not require any additional action specifications – it simply removes 
all found events. The Transform function on the other hand requires that 
you specify which properties should be changed and in which way 
(transpose notes by a certain amount, adjust velocity values, etc.).

By combining filter conditions, functions and the specific 
actions, you can perform very powerful processing.

To master the Logical Editor you need some knowledge 
about how MIDI messages are structured. However, the 
Logical Editor also comes with a rich selection of presets, 
allowing you to access its processing powers without 
delving into its more complicated aspects, see “Selecting 
a preset” on page 389.

About the Transformer MIDI effect

The Transformer effect is a real-time version of the Logical 
Editor, allowing you to apply editing to the events played 
back from a track “on the fly”. The Transformer contains 
virtually the same settings and functions as the Logical 
Editor – where there are differences between the two, this 
is clearly stated on the following pages.

About the Input Transformer

Again, this is very similar to the Logical Editor. Just like the 
Transformer effect, the Input Transformer works in real 
time. However, the Input Transformer filters out and trans-
forms MIDI data as it is recorded. In other words, the set-
tings you make in the Input Transformer will affect the 
actual MIDI events you record.

The Input Transformer is described in the section “The In-
put Transformer” on page 397. However, we recommend 
that you make yourself familiar with the Logical Editor first, 
since they share many features and principles.

About the Project Logical Editor

There is also a “Project Logical Editor” available via the 
Edit menu. This is described in the chapter “The Project 
Logical Editor” on page 399.

Opening the Logical Editor
1. Select the desired parts or events.
What will be affected by the operation depends on the current selection:

• In the Project window, edits using the Logical Editor are ap-
plied to all selected parts, affecting all events (of the relevant 
types) in them.

• In the MIDI editors, edits using the Logical Editor are applied 
to all selected events. If no events are selected, all events in 
the edited part(s) will be affected.

You can change the selection while the Logical Editor 
window is open.

2. Select “Logical Editor…” from the MIDI menu.

For details on how to open the Transformer (and other 
MIDI effects), see “MIDI realtime parameters and effects” 
on page 342.

! Studying the included presets is an excellent way to 
learn the workings of the Logical Editor! Many of them 
can also be used as starting points when you set up 
your own editing operations using the Logical Editor.
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Window overview

Selecting a preset
To understand the Logical Editor, it might be a good idea to 
start by exploring the included presets. These are found on 
the Presets pop-up menu at the bottom of the window, to 
the right.

• To load a preset, select it from the Presets pop-up menu.
The window will show the settings stored in the preset. As the preset is 
not applied to the MIDI events yet, you can load different presets just to 
study them without affecting any events. You can also edit the preset be-
fore applying it.

• To apply the loaded preset (i.e. to perform the opera-
tions defined in the Logical Editor), click Do It.

You can also select Logical Presets directly from the 
MIDI menu.
This allows you to apply a preset to the selected MIDI part directly, with-
out having to open the Logical Editor.

It is also possible to select and apply Logical Presets 
directly in the List Editor (from the Mask menu). You can 
also open the Logical Editor from the List Editor.

For information on how to create and handle your own 
presets, see “Working with presets” on page 397.

Setting up filter conditions

General procedure

The upper list is where you set up the filter conditions, de-
termining which events to find. The list contains one or 
several conditions, each on a separate line.

If you want to start from scratch (as opposed to basing 
your settings on an existing preset), you may want to ini-
tialize the settings by selecting the Init option from the 
Presets pop-up menu.

• To add a new line (condition), click the Add Line button 
to the right.
The new line is added at the bottom of the list. If there are many lines, you 
may need to use the scrollbar to the right to view them.

• To remove a line, click anywhere on it to select it and 
click the Delete Line button to the right.

You set up a filter condition line by clicking in the columns 
and selecting options from the pop-up menus that appear. 
Here is a brief description of the columns:

This is where you select a function 
(Transform, Delete, etc.). The field to the 
right shows an additional explanation of 
the selected function.

This is the filter condition 
list, specifying which 
events to look for.

This is the action 
list, specifying e.g. 
how to change the 
found events.

This is where you load, 
store and handle pre-
sets. See “Working with 
presets” on page 397.

The “Do It” button 
performs the task 
you have set up 
(not available in 
the Transformer).

Column Description

Left bracket This is used for “bracketing” several lines together when 
creating conditions with multiple lines and the boolean 
operators And/Or. See “Combining multiple condition li-
nes” on page 393.

Filter Target Here you select which property to look for when finding 
events. Your choice here affects the available options in 
the other columns as well, see below!

Condition This determines how the Logical Editor should compare 
the property in the Filter Target column to the values in 
the Parameter columns (Equal, Unequal, Bigger, etc. – 
see the separate table below). The available options de-
pend on the Filter Target setting.

Parameter 1 Here you set which value the event properties should be 
compared to (a numeric value, a position or a choice from 
a pop-up menu, depending on the Filter Target). 
For example, if the Filter Target is “Position” and Condition 
is “Equal”, the Logical Editor will look for all events starting 
at the position you specify in the Parameter 1 column.

Parameter 2 This column is only used if you have selected one of the 
“Range” options in the Condition column. Typically, this 
allows you to find all events with values inside (or out-
side) the range between Parameter 1 and Parameter 2.
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• You can also set up filter conditions by dragging MIDI 
events directly into the upper list.
If the list contains no line entries, a MIDI event dragged into this section will 
form conditions including the state and type of the event. If it contains en-
tries, the dragged event(s) will initialize the matching parameters. E.g. if a 
length condition is used, the length will be set according to the event 
length.

Conditions

The options in the Condition column have the following 
meaning (note that the available Condition options de-
pend on the Filter Target setting):

The Conditions for the “Property” filter target are dif-
ferent, see “Searching for properties” on page 392.

Below, the different Filter Targets (and their correspond-
ing Condition and Parameter options) are described in 
more detail.

Searching for events at certain positions
Selecting Position in the Filter Target column lets you find 
events starting at certain positions, either relative to the 
start of the song or within each bar.

• If you select any condition other than the Range or Bar 
Range options, you set up a specific position (in bars, 
beats, sixteenth notes and ticks) in the Parameter 1 column.

Here, the Logical Editor will find all events at 5.1.1. in the project.

• If you select Inside Range or Outside Range in the Con-
dition column, you set the start position of the range in the 
Parameter 1 column and the end position in the Parameter 
2 column.
The Logical Editor will then find all events inside or outside this position 
range.

Bar Range This column is only used if the Filter Target is “Position” 
and one of the “Bar Range” options is selected in the 
Condition column. In these cases, you use the Bar Range 
column to specify “zones” within each bar (allowing you 
to find e.g. all events on or around the first beat of every 
bar). See “Searching for events at certain positions” on 
page 390.

Right bracket This is used for “bracketing” several lines together. See 
“Combining multiple condition lines” on page 393.

bool This allows you to insert the boolean operators And/Or, 
when creating conditions with multiple lines. See “Com-
bining multiple condition lines” on page 393.

Condition Events will be found if their Filter Target property…

Equal …has the exact same value as set up in the Parameter 1 
column.

Unequal …has any value other than the one set up in the Parame-
ter 1 column.

Bigger …has a value higher than the one set up in the Parameter 
1 column.

Bigger or Equal …has a value that is the same as or higher than the one 
set up in the Parameter 1 column.

Less …has a value lower than the one set up in the Parameter 
1 column.

Less or Equal …has a value that is the same as or lower than the one 
set up in the Parameter 1 column.

Inside Range …has a value that is between the values set up in the Pa-
rameter 1 and Parameter 2 columns. Note that Parameter 
1 should be the lower value and Parameter 2 the higher.

Outside Range …has a value that is not between the values set up in the 
Parameter 1 and Parameter 2 columns.

Inside Bar 
Range

…is within the “zone” set up in the Bar Range column 
(Position only), in each bar within the current selection.

Outside Bar 
Range

…is outside the “zone” set up in the Bar Range column 
(Position only), in each bar within the current selection.

Before Cursor …is before the song cursor position (Position only).

Beyond Cursor …is after the song cursor position (Position only).

Column Description

Inside Track 
Loop

…is inside the set track loop (Position only).

Inside Cycle …is inside the set cycle (Position only).

Exactly match-
ing Cycle

…exactly matches the set cycle (Position only).

Note is equal to …is the note specified in the Parameter 1 column, re-
gardless of octave (Pitch only). Lets you find e.g. all C 
notes, in all octaves.

Condition Events will be found if their Filter Target property…
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• If you select one of the Bar Range options in the Condi-
tion column, the Bar Range column will show a graphic 
bar display. You specify the range within the bar by click-
ing and dragging in the bar display (the specified Bar 
Range is indicated in blue).
The Logical Editor will then find all events starting inside or outside this 
Bar Range, in all bars (within the current selection).

Here, the Logical Editor will find events starting around the second beat 
in each bar.

Searching for notes of certain lengths
Only note events have lengths (actually, a note is made up 
of separate note-on and note-off events but in Nuendo it’s 
considered as a single event with a length). Therefore, the 
“Length” Filter Target is only valid if you’re specifically 
searching for notes – there has to be another condition 
line with the Filter Target “Type”, Condition “Equal” and 
Parameter 1 set to “Note”. See “Combining multiple con-
dition lines” on page 393 for more about using multiple fil-
ter conditions.

Searching for Value 1 or Value 2
A MIDI event is composed of several values. The mean-
ings of value 1 and 2 depend on the type of event:

System Exclusive events are not included in the table 
above, since they don’t use value 1 and 2.

Since value 1 and 2 have different meanings for different 
events, searching for e.g. value 2 = 64 would both find 
notes with the velocity 64 and controllers with the amount 
64, etc. If this is not what you want, you can add an addi-
tional filter condition line with the Filter Target “Type”, 
specifying which type of events to find (see below).

The general procedures when searching for value 1 or 2 
are:

• If you select any Condition other than the Range options, 
you set up a specific value in the Parameter 1 column.

Here, the Logical Editor will find all events with a value 2 less than 80.

• If you select Inside Range or Outside Range in the Con-
dition column, the range consists of the values between 
Parameter 1 and Parameter 2.
Note that Parameter 1 should have the lower value.

Searching for note pitch or velocity

If you add another condition line with the Filter Target 
“Type”, Condition “Equal” and Parameter 1 set to “Note”, 
the Logical Editor will “know” you are searching for pitch 
or velocity. This has the following benefits:

• The Filter Targets Value 1 and Value 2 will be displayed as 
“Pitch” and “Velocity” respectively, making it easier to grasp 
the function of the filter condition.

• Pitch values in the Parameter columns will be displayed as 
note names (C3, D#4, etc.). When entering pitch values you 
can either type a note name or a MIDI note number (0–127).

• When Value 1 (pitch) is selected as Filter Target, an additional 
option appears in the Condition column: “Note is equal to”. 
When this is selected, you specify a note name in the Para-
meter 1 column but without any octave number (C, C#, D, D#, 
etc.). The Logical Editor can then find all notes of a certain key, 
in all octaves.

See “Combining multiple condition lines” on page 393 for 
more info on working with multiple filter condition lines.

Event type Value 1 Value 2

Notes The Note Number/Pitch. The velocity of the note.

PolyPressure The key that was 
pressed.

The amount of pressure for 
the key.

Controller The type of Controller, 
displayed as a number.

The amount of Control 
Change.

Program Change The Program Change 
number.

Not used.

Aftertouch The amount of pressure. Not used.

Pitchbend The “fine tune” of the 
bend. Not always used.

The coarse amount of bend.

! This is particularly useful when searching for note 
pitch or velocity values, as described below.
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Searching for controllers

There is similar extended functionality when searching for 
controllers: If you’ve added an additional “Type = Control-
ler” condition line, the Logical Editor will “know” you are 
searching for controllers. The Parameter 1 column will 
then show the names of the MIDI controllers (Modulation, 
Volume, etc.) when Value 1 is selected as Filter Target.

Searching for MIDI channels
Each MIDI event contains a MIDI channel setting (1–16). 
Normally, these settings are not used, since the MIDI event 
plays back on the MIDI channel set for its track. However, 
you can come across MIDI parts with events set to different 
channels, for example in the following scenarios:

• If you have recorded MIDI from an instrument sending on sev-
eral different channels (e.g. a master keyboard with different 
key zones).

• If you have imported a MIDI file of type 0 (with a single track, 
containing MIDI events with different channel settings).

Searching for MIDI channel values is straightforward; you 
select a Condition and enter a MIDI channel (1–16) in the 
Parameter 1 column (and, if you’ve selected one of the 
Range Conditions, a higher channel in the Parameter 2 
column, creating a value range).

Searching for event types
Selecting Type as the Filter Target allows you to find 
events of a certain type only.

• The Condition column contains only three options: Equal, Un-
equal and All Types.

• Clicking the Parameter 1 column displays a pop-up menu, list-
ing the available event types (Note, PolyPressure, Controller, 
etc.).

The Logical Editor will find all events matching or not 
matching the selected type (depending on the Condition).

Searching for properties
On the Filter Target pop-up menu you will find an option 
called Property. This allows you to search for properties 
that are not part of the MIDI standard but rather event-
specific Nuendo settings.

When the Property option is selected, the Condition col-
umn has two options: “Property is set” and “Property is not 
set”. Which property to look for is selected in the Parameter 
1 column. The options are “muted” and “selected”. Two ex-
amples:

Here, the Logical Editor will find all muted events.

Here, the Logical Editor will find all events that are selected but not 
muted.

Searching for event contexts
On the Filter Target pop-up menu you will find an option 
called “Last Event”. This can be used to perform context 
dependent searches (especially useful in the Input Trans-
former).

“Last Event” indicates the state of an event which has al-
ready passed the Input Transformer/Logical Editor. The 
condition has to be combined with Parameter 1 and Pa-
rameter 2. 

A few examples on how the Last Event filter target can be 
used:

Here, the action will only be performed when the sustain 
pedal is down:! As mentioned above, selecting Type = Note or 

Type = Controller adds some additional functionality 
to the Logical Editor. You should make it a habit to 
add a Type condition when applicable.

Fiiter Target Condition Parameter 1 Parameter 2

Last Event Equal MIDI Status 176/Controller

Last Event Equal Value 1 64

Last Event Bigger Value 2 64
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In this example, the action will be performed when the 
note C1 is pressed (the “Note is playing” condition is only 
available in the Input Transformer and in the Transformer 
effect):

In this example, the action will be performed after playing 
the C1 note:

Combining multiple condition lines
As described above, you can add condition lines by click-
ing the Add Line button to the right of the list. The result of 
combining condition lines depends on the boolean And/
Or operators and the brackets.

The bool column

By clicking in the “bool” column to the right in the list, you 
can select a boolean operator: “And” or “Or”. A boolean 
operator separates two condition lines and determines the 
result in the following way:

If two condition lines are separated by a boolean And, 
both conditions must be fulfilled for an event to be found.

The Logical Editor will only find events that are notes and start at the 
beginning of the third bar.

If two condition lines are separated by a boolean Or, 
one of the conditions (or both) must be fulfilled for an 
event to be found.

The Logical Editor will find all events that are notes (regardless of their 
position) and all events starting at the beginning of the third bar (re-
gardless of their type).

Using brackets

The bracket (parenthesis) columns let you enclose two or 
more condition lines, dividing the conditional expression 
into smaller units. This is only relevant when you have 
three or more condition lines and want to use the boolean 
Or operator. This is how it works:

Without brackets, the conditional expressions are 
evaluated according to their order in the list.

In this case we have the expression Type = Note AND Pitch = C3 
(Win)/60 (Mac) OR Channel = 1, without brackets. This means that the 
Logical Editor will find all MIDI notes with the pitch C3, as well as all 
events (regardless of their type) set to MIDI channel 1.

Maybe you wanted to find all notes that either had the 
pitch C3 or the MIDI channel 1 (but no non-note events)? 
Then you need to add some brackets:

Here the expression is Type = Note AND (pitch = C3 (Win)/60 (Mac) 
OR Channel = 1), which will find what you want. The rule behind this is:

Filter Target Condition Parameter 1 Parameter 2

Type is Equal Note 

Last Event Equal Note is playing 36/C1

Filter Target Condition Parameter 1 Parameter 2

Last Event Equal Value 1 36/C1

! When you add a new condition line, the boolean set-
ting defaults to And. Therefore, if all you want to do is 
set up two or more conditions that all must be met 
for an event to be found, you don’t have to think 
about the boolean column – just add the required 
lines and make the usual filter settings.
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Expressions within brackets are evaluated first.
If there are several layers of brackets, these are evaluated “from the in-
side out”, starting with the innermost brackets.

You add brackets by clicking in the bracket columns and 
selecting an option. Up to triple brackets can be selected.

Editing filter conditions as text

The area directly below the filter condition list shows you 
the current filter conditions as text. It also allows you to 
enter and edit the filter conditions in textual form. For tips 
on the syntax, please study the included presets.

There is no additional functionality involved when edit-
ing filter conditions as text; it is simply another way to 
make settings. 
When you enter something in the text field you will see the correspond-
ing settings appear in the filter condition list (provided that you have used 
the correct syntax).

Selecting a function

The pop-up menu in the top left corner of the Logical Edi-
tor is where you select the function – the basic type of ed-
iting to be performed. When you select an option from the 
pop-up menu, the field to the right displays a comment, 
making it easier to see what the function does.

Below, the available options are listed. Note that some op-
tions are available in the Logical Editor only – not in the 
Transformer effect.

Delete

Deletes all events found by the Logical Editor. In the case 
of the Transformer, this function will remove (or “mute”) all 
found events from the “output stream” – the actual events 
on the track are not affected.

Transform

Changes one or several aspects of the found events. You 
set up exactly what should be changed in the action list, 
see “Specifying actions” on page 395.

Insert

This will create new events and insert these into the 
part(s) (Logical Editor) or the output stream (Transformer). 
The new events will be based on the events found by the 
Logical Editor’s filter conditions, but with any changes you 
have set up in the action list applied. 

Another way of expressing this is that the Insert function 
copies the found events, transforms them according to the 
action list and inserts the transformed copies among the 
existing events.

Insert Exclusive

This will transform the found events according to the ac-
tion list. Then, all events that were not found (that didn’t 
meet the filter conditions) are deleted (Logical Editor) or 
removed from the output stream (Transformer).

Copy (not available in the Transformer)

This will copy all found events, transform them according 
to the action list and paste them into a new part on a new 
MIDI track. The original events are not affected.

Extract (not available in the Transformer)

This works like Copy, but will cut the found events instead. 
Or in other words, Extract will transform all found events 
and move them to a new part on a new MIDI track.

Select (not available in the Transformer)

This will simply select all found events, highlighting them 
for further work in the regular MIDI editors.

! In the Logical Editor, processing isn’t performed until 
you click the Do It button. When using the Trans-
former MIDI effect, there is no Do It button – the cur-
rent settings are automatically applied in real time 
during playback or live playing.
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Specifying actions

The lower list in the Logical Editor window is the action 
list. This is where you specify any changes that should be 
made to the found events (relevant for all function types 
except Delete and Select).

The handling of the action list is similar to the filter condi-
tion list, but without the brackets and booleans. You sim-
ply add lines by clicking the Add Line button to the right, 
and fill out the columns as required. To remove a superflu-
ous action line, select it and click the Delete Line button.

Action Target
This is where you select the property that should be 
changed in the events:

Operation
This setting determines what to do with the Action Target. 
The options on this pop-up menu are different depending 
on the selected Action Target. Below, all available opera-
tions are listed:

Add

Adds the value specified in the Parameter 1 column to the 
Action Target.

Subtract

Subtracts the value specified in the Parameter 1 column 
from the Action Target.

Multiply by

Multiplies the Action Target value with the value specified 
in the Parameter 1 column.

Divide by

Divides the Action Target value by the value specified in 
the Parameter 1 column.

Round by

This “rounds” the Action Target value using the value 
specified in the Parameter 1 column. In other words, the 
Action Target value is changed to the closest value that 
can be divided by the Parameter 1 value.

For example, if the Action Target value is 17 and Parame-
ter 1 is 5, the result of rounding will be 15 (the closest 
value that can be divided by 5). Another word for this type 
of operation would be “quantizing”, and it’s actually possi-
ble to use it for this, by setting the Action Target to “Posi-
tion” and specifying a quantize value with Parameter 1 (in 
ticks, with 480 ticks per quarter note).

Set Random Values between

This will set the Action Target value to a random value 
within the range specified with Parameter 1 and 2.

Option Description

Position Adjusting this value will move the events.

Length Lets you resize the events (notes only).

Value 1 This adjusts value 1 in the events. As described in the 
section “Searching for Value 1 or Value 2” on page 391, 
the meaning of value 1 depends on the event type. For 
notes, value 1 is the pitch.

Value 2 This adjusts value 2 in the events. As described in the 
section “Searching for Value 1 or Value 2” on page 391, 
the meaning of value 2 depends on the event type. For 
notes, value 2 is the velocity value.

Channel Allows you to change the MIDI channel setting. See 
“Searching for MIDI channels” on page 392.

Type Allows you to change an event from one type to another, 
e.g. transform aftertouch events to modulation events.

Value 3 This adjusts value 3 in the events, which is used for han-
dling of Noteoff-velocity when searching for properties. 
See “Searching for properties” on page 392.
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Set Relative Random Values between

This will add a random value to the current Action Target 
value. The added random value will be within the range 
specified with Parameter 1 and 2. Note that these can be 
set to negative values.

For example, if you set Parameter 1 to -20 and Parameter 
2 to +20, the original Action Target value will get a ran-
dom variation, never exceeding ±20.

Set to fixed value

This sets the Action Target to the value specified in the 
Parameter 1 column.

Add Length

This is only available when Action Target is set to Position. 
Furthermore, it is only valid if the found events are notes 
(and thus have a length). When Add Length is selected, 
the length of each note event will be added to the Position 
value. This can be used for creating new events (using the 
Insert function) positioned relative to the end positions of 
the original notes.

Transpose to Scale

This is only available when Action Target is set to Value 1, 
and when the filter conditions are specifically set up to 
find notes (a “Type = Note” filter condition line has been 
added). When “Transpose to Scale” is selected, you can 
specify a musical scale using the Parameter 1 and 2 col-
umns. Parameter 1 is the key (C, C#, D, etc.) while Pa-
rameter 2 is the type of scale (major, melodic or harmonic 
minor, etc.).

Each note will be transposed to the closest note in the se-
lected scale.

Use Value 2

This is only available when Action Target is set to Value 1. 
If this option is selected, the Value 2 setting in each event 
will be copied to the Value 1 setting.

For example, this would be useful if you are transforming 
all Modulation controllers to Aftertouch events (since con-
trollers use Value 2 for their amount, while Aftertouch uses 
Value 1 – see “Searching for Value 1 or Value 2” on page 
391).

Use Value 1

This is only available when Action Target is set to Value 2. 
If this option is selected, the Value 1 setting in each event 
will be copied to the Value 2 setting.

Mirror

This is only available when Action Target is set to Value 1 
or Value 2. When this option is selected, the values will be 
“mirrored” or “flipped” around the value set in the Parame-
ter 1 column.

In the case of notes, this will invert the scale, with the key 
set in the Parameter 1 column as “center point”.

Linear Change in Loop Range

This will affect events within the loop range (between the 
left and right locators) only. It will create a linear “ramp” of 
values (replacing the original values) starting at the value 
in the Parameter 1 column and ending at the Parameter 2 
value.

This can be used for creating linear controller sweeps, ve-
locity ramps, etc.

Relative Change in Loop Range

As with the previous option, this will create a ramp of val-
ues, affecting events in the cycle loop range only. How-
ever, here the changes are “relative”, meaning that values 
will be added to the existing values.

In other words, you set up a value ramp starting at Para-
meter 1 and ending at Parameter 2 (note that the Parame-
ter values can be negative). The resulting value ramp is 
then added to the existing values for the events within the 
cycle loop range.

For example, if you apply this to note velocities with Param-
eter 1 set to 0 and Parameter 2 set to -100, you create a 
velocity fade-out, keeping the original velocity relations:
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Applying the defined actions
Once you have set up filter conditions, selected a function 
and set the required actions (or loaded a preset), you ap-
ply the actions defined with the Logical Editor by clicking 
the Do It button.

Logical Editor operations can be undone just like any 
other editing.

Again, when using the Transformer MIDI effect there is 
no Do It button. The processing is applied to the events 
played back from the track (or played live “thru” the track) 
as soon as you set it up.
Since no existing events on the track are affected by the Transformer 
setting, there is no need for undo.

Working with presets
The Presets section in the bottom right section of the win-
dow allows you to load, store and manage Logical Editor 
presets. A preset contains all settings in the window, 
which means you can simply load a preset and click Do It.

To load a preset, select it from the Presets menu.

Storing your own settings as a preset

If you have made Logical Editor settings that you want to 
use again, you can store them as a preset:

1. You can enter some explanatory text in the Comment 
field.
An extra description of the preset can be useful, especially if the settings 
are complex.

2. Click the Store button in the Presets section.
A dialog for specifying a name for the new preset is displayed.

3. Enter a name for the preset and click OK.
The preset is stored.

To remove a preset, load it and click the Remove but-
ton.

Organizing and sharing presets

The Logical Editor presets are stored within the applica-
tion folder in the Presets\Logical Edit subfolder (see also 
“Where are the settings stored?” on page 514). While 
these files cannot be edited “manually”, you can reorga-
nize them (e.g. putting them in subfolders) like any files.

This also makes it easy to share presets with other Nu-
endo users, by transferring the individual preset files.

The list of presets is read each time the Logical Editor 
is opened.

The Input Transformer
This function allows you to selectively filter out and change 
MIDI data coming to a MIDI track before it is recorded. The 
Input Transformer is very similar to the Transformer MIDI ef-
fect, but contains four independent “modules”, for which 
you can set up different filtering and actions if you like. You 
can activate any or all of these four modules.

Here are some of the things the Input Transformer allows 
you to do the following:

• Set up split keyboard combinations for recording left and right 
hands separately.

• Turn a controller like a foot pedal into MIDI notes (for playing 
bass drum the right way).

• Filter out one specific type of MIDI data on one MIDI channel 
only.

• Turn aftertouch into any controller (and vice versa).
• Invert velocity or pitch.

Again: four of these things can be done at the same time.

Opening the Input Transformer

To open the Input Transformer for a MIDI track, select the 
track and click the Input Transformer button in the Inspec-
tor to open the pop-up menu:

• Select Global to make Input Transformer settings that 
affect all MIDI inputs (and thereby all MIDI tracks).

• Select Local to make Input Transformer settings for this 
track only.
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In both cases, the button lights up and the Input Trans-
former opens.

Handling the four modules

The Input Transformer is really four separate transformers, 
or modules.

• You select which module to view and make settings for 
by clicking its button in the Selected Module section.

Module 2 selected for viewing and editing.

• The checkboxes in the Active Module section determine 
which module(s) are active.

Here, modules 1, 2 and 4 are active.

The two modes

The Mode pop-up menu contains two options: Filter and 
Transform.

• In Filter mode, only the filter conditions (the upper list) 
are taken into account. All events matching the conditions 
set up will be filtered out (excluded from the recording).

• In Transform mode, events matching the filter conditions 
will be transformed according to the settings in the action 
list (the lower list).

Setting up filtering and actions

This is done just like in the Logical Editor. Here is a brief 
rundown:

• Click the Add Line buttons to add lines to the filter con-
dition list or action list.
To remove a line, click it to select it and click the Delete Line button to 
the right.

• Clicking the columns in the filter condition list opens 
pop-up menus allowing you to specify the conditions to 
match.

• Clicking the columns in the action list opens pop-up 
menus allowing you to specify what should be done to the 
found events (when Transform mode is selected).

For detailed descriptions of the filter conditions and action 
columns, see “General procedure” on page 389.

• Selecting the Init option from the Presets pop-up menu 
will reset the selected module, removing all filter condition 
and target list lines.

• The Input Transformer has no “Do It” button – the set-
tings are active as soon as you activate an Active Module 
checkbox.
The settings made in the activated modules will affect all MIDI data you 
record on the track.

Closing the Input Transformer window does not turn it 
off – you need to deactivate all Active Module checkboxes 
for this!
A lit Input Transformer button in the Inspector indicates that one or more 
modules are active.
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Introduction
On the Edit menu you will find the function “Project Logi-
cal Editor…” that opens a Project Logical Editor for the 
entire project. It works similar as the Logical Editor on the 
MIDI menu, see “The Logical Editor, Transformer and In-
put Transformer” on page 387. The most important differ-
ence is, that the Logical Editor for MIDI works on event 
level whereas the Project Logical Editor works on project 
level, and is therefore a very powerful tool for “search and 
replace” functions in your project.

The MIDI events in the MIDI parts will not be affected 
by the Project Logical Editor operations. If you want to 
change MIDI notes or controller data, you have to use the 
Logical Editor, see “The Logical Editor, Transformer and 
Input Transformer” on page 387.

The Project Logical Editor allows you to create “macros”, 
e.g. for special track type operations on tracks that are 
named identically. You can use its functions to delete all 
muted MIDI parts or to toggle the open state of all folder 
tracks in your project, etc. 

Included with the Project Logical Editor are a number of 
presets that give you an impression of the great possibili-
ties that this feature offers, see “Selecting a preset” on 
page 401. Many of them can also be used as starting 
points when you set up your own editing operations. 

The principle for the Project Logical Editor is this:

• You set up filter conditions to find certain events.
This could be events of a certain type, with certain attributes or values or 
on certain positions, in any combination. You can combine any number of 
filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed.
The options are Transform (changing properties of the found events), 
Delete (removing the events) and Select (selecting the found events).

• You set up a list of actions, which specify exactly what 
should be done.
This is not necessary for all functions. For example, the Delete function 
does not require any additional action specifications – it simply removes 
all found events. 

By combining filter conditions, functions and the specific 
actions, you can perform very powerful processing.

Opening the Project Logical Editor
1. Open the desired project.
All elements in the project will be affected, you do not have to make any 
selection.

2. Select “Project Logical Editor…” from the Edit menu.

Window overview
! When we speak of “events” in this chapter, we refer 

to all the Project window elements that can be mod-
ified with the Project Logical Editor, e.g. MIDI parts, 
audio events and parts, Transpose parts, Arranger 
parts, automation events, etc.

! The Project Logical Editor allows all kind of settings 
that may not always make sense. Experiment a bit be-
fore applying your edits to important projects. You can 
undo the operations by using the Undo command on 
the Edit menu.

This is where you select a function 
(Transform, Delete, etc.). The field to the 
right shows an additional explanation of 
the selected function.

This is the filter condition 
list, specifying which 
events to look for.

This is the action 
list, specifying e.g. 
how to change the 
found events.

This is where you load, 
store and handle pre-
sets. See “Working with 
presets” on page 409.

The “Do It” button 
performs the task 
you have set up.
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Selecting a preset
To understand the Project Logical Editor, it might be a good 
idea to start by exploring the included presets. These are 
found on the Presets pop-up menu at the bottom of the 
window, to the right.

• To load a preset, select it from the Presets pop-up menu.
The window will show the settings stored in the preset. As the preset is 
not applied to the events yet, you can load different presets just to study 
them without affecting any events. You can also edit the preset before 
applying it.

• To apply the loaded preset (i.e. to perform the opera-
tions defined in the Project Logical Editor), click Do It.

You can also open the Edit menu and select Presets di-
rectly from the “Process Project Logical Editor” submenu.
This allows you to apply a preset directly, without having to open the 
Project Logical Editor.

For information on how to create and handle your own 
presets, see “Working with presets” on page 409.

Setting up filter conditions

General procedure

The upper list is where you set up the filter conditions, de-
termining which elements to find. The list contains one or 
several conditions, each on a separate line.

If you want to start from scratch (as opposed to basing 
your settings on an existing preset), you may want to ini-
tialize the settings by selecting the Init option from the 
Presets pop-up menu.

• To add a new line (condition), click the Add Line button 
to the right.
The new line is added at the bottom of the list. If there are many lines, you 
may need to use the scrollbar to the right to view them.

• To remove a line, select it and click the Delete Line but-
ton to the right.

You set up a filter condition line by clicking in the columns 
and selecting options from the pop-up menus that appear. 
Here is a brief description of the columns:

Below, the different Filter Targets (and their corresponding 
Condition and Parameter options) are described in more 
detail.

Column Description

Left bracket This is used for “bracketing” several lines together when 
creating conditions with multiple lines and the boolean 
operators And/Or. See “Combining multiple condition li-
nes” on page 406.

Filter Target Here you select which property to look for when finding 
elements. Your choice here affects the available options 
in the other columns as well, see below!

Condition This determines how the Project Logical Editor should 
compare the property in the Filter Target column to the 
values in the Parameter columns (see the separate table 
below). The available options depend on the Filter Target 
setting.

Parameter 1 Here you set which value the element properties should 
be compared to (depending on the Filter Target). 
For example, if the Filter Target is “Position” and Condi-
tion is “Equal”, the Project Logical Editor will look for all 
elements starting at the position you specify in the Pa-
rameter 1 column.

Parameter 2 This column is only used if you have selected one of the 
“Range” options in the Condition column. Typically, this 
allows you to find all elements with values inside (or out-
side) the range between Parameter 1 and Parameter 2.

Bar Range This column is only used if the Filter Target is “Position” 
and one of the “Bar Range” options is selected in the 
Condition column. In these cases, you use the Bar Range 
column to specify “zones” within each bar (allowing you 
to find e.g. all elements on or around the first beat of ev-
ery bar). See “Searching for elements at certain positi-
ons” on page 404.

Right bracket This is used for “bracketing” several lines together. See 
“Combining multiple condition lines” on page 406.

bool This allows you to insert the boolean operators And/Or, 
when creating conditions with multiple lines. See “Com-
bining multiple condition lines” on page 406.
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Searching for Media types
1. Select Media Type in the Filter Target pop-up menu.
This allows you to find elements of certain types of media only. 

2. Open the pop-up menu in the Parameter 1 column 
and select the desired option.
When the Filter Target is set to Media type, the pop-up menu lists the 
available media types. The following table lists what will be found:

3. Open the pop-up menu in the Condition column and 
select the desired condition. 
For media types, the following options are available:

If, e.g. you have set up the Project Logical Editor like this…

…the Project Logical Editor will find all Marker events and 
tracks in the project.

Searching for Container types
1. Select Container Type in the Filter Target pop-up menu.
This allows you to find parts, events or tracks. 

2. Open the pop-up menu in the Parameter 1 column 
and select the desired option.
When the Filter Target is set to Container type, the pop-up menu lists the 
available container types. The following table lists what will be found:

3. Open the pop-up menu in the Condition column and 
select the desired condition. 
For container types, the following options are available:

If, e.g. you have set up the Project Logical Editor like this…

…the Project Logical Editor will find all Folder tracks in the 
project.

This Filter Target is very powerful in combination with the 
Media type Filter Target:

Here, the Project Logical Editor will find all MIDI and Instrument parts in 
the project.

Media Type Description

Audio If no container type is specified, this finds audio events, 
audio parts and audio tracks.

MIDI If no container type is specified, this finds MIDI parts and 
MIDI tracks.

Automation If no container type is specified, this finds automation 
events and automation tracks.

Marker If no container type is specified, this finds marker events 
and marker tracks.

Transpose If no container type is specified, this finds transpose 
events and transpose tracks.

Arranger If no container type is specified, this finds Arranger 
events and Arranger tracks.

Condition Description

Equal …finds the Media Type set up in the Parameter 1 column.

All Types …finds all Media Types.

Container Type Description

Folder Track This finds all folder tracks, included FX Channel and 
Group Channel folders.

Track This finds all kinds of tracks.

Part This finds audio, MIDI and Instrument parts. Folder 
parts will not be found.

Event This finds automation points, markers, audio events, 
arranger events and transpose events.

Condition Description

Equal …finds the Container Type set up in the Parameter 1 col-
umn.

All Types …finds all Container Types.
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Combining Media type and Container type
The combination of the Filter Targets Media type and Con-
tainer represents a vesatile tool for logical operations:

Here, the Project Logical Editor will find all Automation tracks (not 
events) in the project whose name contains vol.

Here, the Project Logical Editor will find all MIDI and Instrument parts 
(not tracks) in the project that are muted.

Here, the Project Logical Editor will find all MIDI and Instrument parts 
(not tracks) or all audio events (not parts or tracks) in the project that 
are muted.

Searching for Names
1. Select Name on the Filter Target pop-up menu.

2. Enter the desired name, or a part of a name in the Pa-
rameter 1 column.

3. Open the pop-up menu in the Condition column and 
select the desired condition.
For names, the following options are available:

If, e.g. you have set up the Project Logical Editor like this…

…the Project Logical Editor will find all tracks in the 
project whose name contains “voc”.

To take most advantage of this feature, we recom-
mend you to use a standard nomenclature in your projects 
(Drums, Perc, Voc, etc.). 

Condition Description

Equal …is the exact same string as set up in the Parameter 1 
column.

Contains …contains the set string.
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Searching for elements at certain positions
1. Select Position in the Filter Target pop-up menu.
This allows you to find elements starting at certain positions, either rela-
tive to the start of the project or within each bar.

2. Open the pop-up menu in the Condition column and 
select the desired condition. 
For positions, the following options are available: 

• If you select any condition other than the Range, Bar 
Range, Cursor, Loop or Cycle options, you set up a spe-
cific position (in bars, beats, sixteenth notes and ticks) in 
the Parameter 1 column. Note that the position for Bar 
Range is measured in ticks related to the start of the bar. 

Here, the Logical Editor will find all elements at the position 5.1.1. in the 
project.

• If you select Inside Range or Outside Range in the Con-
dition column, you set the start position of the range in the 
Parameter 1 column and the end position in the Parameter 
2 column.
The Project Logical Editor will then find all elements inside or outside this 
position range.

• If you select one of the Bar Range options in the Condi-
tion column, the Bar Range column will show a graphic bar 
display. You specify the range within the bar by clicking and 
dragging in the bar display (the specified Bar Range is indi-
cated in blue).
The Project Logical Editor will then find all elements starting inside or 
outside this Bar Range, in all bars (within the current selection).

Here, the Project Logical Editor will find elements starting around the 
second beat in each bar.

Condition Description

Equal …has the exact same value as set up in the Parameter 1 
column.

Unequal …has any value other than the one set up in the Parame-
ter 1 column.

Bigger …has a value higher than the one set up in the 
Parameter 1 column.

Bigger or Equal …has a value that is the same as or higher than the one 
set up in the Parameter 1 column.

Less …has a value lower than the one set up in the 
Parameter 1 column.

Less or Equal …has a value that is the same as or lower than the one 
set up in the Parameter 1 column.

Inside Range …has a value that is between the values set up in the Pa-
rameter 1 and Parameter 2 columns. Note that Parameter 
1 should be the lower value and Parameter 2 the higher.

Outside Range …has a value that is not between the values set up in the 
Parameter 1 and Parameter 2 columns.

Inside Bar 
Range

…is within the “zone” set up in the Bar Range column, in 
each bar within the current selection.

Outside Bar 
Range

…is outside the “zone” set up in the Bar Range column, 
in each bar within the current selection.

Before Cursor …is before the song Project position.

Beyond Cursor …is after the song Project position.

Inside Track 
Loop

…is inside the set track loop (see “The independent track 
loop function” on page 293).

Inside Cycle …is inside the set cycle.

Exactly match-
ing Cycle

…exactly matches the set cycle.
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Searching for elements of certain lengths
1. Select Length in the Filter Target pop-up menu.
This allows you to find elements of a certain length only. The Length pa-
rameter is interpreted via the time base setting of the tracks, i.e. in ticks 
(musical) or ms (time), except for audio parts or events: these are always 
measured in samples.

2. Open the pop-up menu in the Condition column and 
select the desired condition. 
For lengths, the following options are available:

If you select any condition other than the Range options, 
you set up a specific position in the Parameter 1 column.

Here, the Project Logical Editor will find all audio parts and events in 
the project with a length smaller than 200 samples.

Searching for properties
1. Select Property on the Filter Target pop-up menu.

2. Open the pop-up menu in the Condition column and 
select the desired condition. 
When the Property option is selected, the Condition column has two op-
tions: “Property is set” and “Property is not set”. 

3. Open the pop-up menu in the Parameter 1 column 
and select the desired option.
This sets which property will be searched. The options are “muted” and 
“selected”. 

Two examples:

Here, the Project Logical Editor will find all muted MIDI and Instrument 
parts.

Here, the Project Logical Editor will find all elements that are selected 
but not muted.

Condition Description

Equal …has the exact same value as set up in the Parameter 1 
column.

Unequal …has any value other than the one set up in the Parame-
ter 1 column.

Bigger …has a value higher than the one set up in the 
Parameter 1 column.

Bigger or Equal …has a value that is the same as or higher than the one 
set up in the Parameter 1 column.

Less …has a value lower than the one set up in the 
Parameter 1 column.

Less or Equal …has a value that is the same as or lower than the one 
set up in the Parameter 1 column.

Inside Range …has a value that is between the values set up in the Pa-
rameter 1 and Parameter 2 columns. Note that Parameter 
1 should be the lower value and Parameter 2 the higher.

Outside Range …has a value that is not between the values set up in the 
Parameter 1 and Parameter 2 columns.
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Combining multiple condition lines
As described above, you can add condition lines by click-
ing the Add Line button to the right of the list. The result of 
combining condition lines depends on the boolean And/
Or operators and the brackets.

The bool column

By clicking in the “bool” column to the right in the list, you 
can select a boolean operator: “And” or “Or”. A boolean 
operator separates two condition lines and determines the 
result in the following way:

If two condition lines are separated by a boolean And, 
both conditions must be fulfilled for an element to be found.

The Project Logical Editor will only find MIDI Tracks.

If two condition lines are separated by a boolean Or, 
one of the conditions (or both) must be fulfilled for an ele-
ment to be found.

The Project Logical Editor will find all parts or events that match exactly 
the cycle.

Using brackets

The bracket (parenthesis) columns let you enclose two or 
more condition lines, dividing the conditional expression 
into smaller units. This is only relevant when you have 
three or more condition lines and want to use the boolean 
Or operator. This is how it works:

Without brackets, the conditional expressions are 
evaluated according to their order in the list.

Here, the Project Logical Editor will find all audio parts and events 
whose name contains perc and all Audio parts and events whose name 
contains drums, as well as other parts and events (e.g. MIDI parts) 
whose name contains drums.

Maybe you wanted to find all Audio parts and events that 
either had the name perc or the name drums (but no other 
parts or events named drums)? Then you need to add 
some brackets:

Here, all audio parts or events will be found whose name contains perc 
or drums. The rule behind this is:

Expressions within brackets are evaluated first.
If there are several layers of brackets, these are evaluated “from the inside 
out”, starting with the innermost brackets.

You add brackets by clicking in the bracket columns and 
selecting an option. Up to triple brackets can be selected.

Editing filter conditions as text
You can also edit filter conditions as text. This works just 
like in the Logical Editor for MIDI, see “Editing filter condi-
tions as text” on page 394.

! When you add a new condition line, the boolean set-
ting defaults to And. Therefore, if all you want to do is 
set up two or more conditions that all must be met 
for an element to be found, you don’t have to think 
about the boolean column – just add the required 
lines and make the usual filter settings.
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Selecting a function

The pop-up menu in the top left corner of the Project Log-
ical Editor is where you select the function – the basic 
type of editing to be performed. When you select an op-
tion from the pop-up menu, the field to the right displays a 
comment, making it easier to see what the function does.

The available options are:

Delete

Deletes all elements found by the Project Logical Editor.

When you delete automation tracks and undo this op-
eration by selecting Undo from the Edit menu, the automa-
tion tracks will be restored, but the tracks will be closed.

Transform

Changes one or several aspects of the found elements. 
You set up exactly what should be changed in the action 
list, see below.

Select 

This will simply select all found elements, highlighting 
them for further work in the Project window.

Specifying actions

The lower list in the Project Logical Editor window is the 
action list. This is where you specify any changes that 
should be made to the found elements, relevant for the 
function type Transform.

You can perform two different kinds of actions: track-based 
actions (such as Track Operation, Name) and event-based 
actions (such as Position, Length, Name). There are also 
actions that only take effect on automation data (Trim).

The handling of the action list is similar to the filter condi-
tion list, but without the brackets and booleans. You sim-
ply add lines by clicking the Add Line button to the right, 
and fill out the columns as required. To remove a superflu-
ous action line, select it and click the Delete Line button.

Action Target
This is where you select the property that should be 
changed. The Operations determine what to do with the 
Action Target. Below, all available operations are listed:

Position

Adjusting this value will move the elements:

Operation Description

Add Adds the value specified in the Parameter 1 column to the 
Position.

Subtract Subtracts the value specified in the Parameter 1 column 
from the Position.

Multiply by Multiplies the Position value with the value specified in the 
Parameter 1 column.

Divide by Divides the Position value by the value specified in the Para-
meter 1 column.

Round by This “rounds” the Position value using the value specified in 
the Parameter 1 column. In other words, the Position value is 
changed to the closest value that can be divided by the Pa-
rameter 1 value.
For example, if the Position value is 17 and Parameter 1 is 5, 
the result of rounding will be 15 (the closest value that can 
be divided by 5). Another word for this type of operation 
would be “quantizing”, and it’s actually possible to use it for 
this, by specifying a quantize value with Parameter 1 (in ticks, 
with 480 ticks per quarter note).
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Length

Lets you resize the elements. This parameter is interpreted 
via the time base setting of the tracks, i.e. in ticks (musical) 
or ms (time):

Track Operation

This lets you change the track status.

Name

This lets you rename the found elements. 

Trim

This Action Target is used for automation only and lets you 
trim the found elements.

Applying the defined actions
Once you have set up filter conditions, selected a function 
and set the required actions (or loaded a preset), you ap-
ply the actions defined with the Project Logical Editor by 
clicking the Do It button.

Project Logical Editor operations can be undone just like 
any other editing.

Set Relative 
Random 
Values 
between

This will add a random value to the current Position value. 
The added random value will be within the range specified 
with Parameter 1 and 2. Note that these can be set to nega-
tive values.
For example, if you set Parameter 1 to -20 and Parameter 2 
to +20, the original Position value will get a random variation, 
never exceeding ±20.

Set to fixed 
value

This sets the Position to the value specified in the Parameter 
1 column.

Operation Description

Add Adds the value specified in the Parameter 1 column to the 
Length.

Subtract Subtracts the value specified in the Parameter 1 column 
from the Length.

Multiply by Multiplies the Length value with the value specified in the 
Parameter 1 column.

Divide by Divides the Length value by the value specified in the Para-
meter 1 column.

Round by This “rounds” the Length value using the value specified in 
the Parameter 1 column. In other words, the Length value is 
changed to the closest value that can be divided by the Pa-
rameter 1 value.

Set to fixed 
value

This sets the Length to the value specified in the Parameter 
1 column.

Set Random 
Values
between

This will add a random value to the current length. The 
added random value will be within the range specified with 
Parameter 1 and 2. 

Operation Description

Operation Description

Folder Opens, closes or toggles folders.

Record Enables, disables or toggles the record enable status.

Monitor Enables, disables or toggles the monitor status.

Solo Enables, disables or toggles the solo status.

Mute Enables, disables or toggles the mute status.

Operation Description

Replace Replaces names by the string specified under Parameter 1.

Append Names will be appended with the string specified under Pa-
rameter 1.

Prepend The name will be prepended with the string specified under 
Parameter 1.

Generate 
Name

The name will be replaced by the string specified under Pa-
rameter 1 followed by the number set with Parameter 2. The 
number will be increased by 1 for every found element. 

Replace 
Search 
String

You can specify a search string under Parameter 1 that 
should be replaced by the string specified under Parameter 2.

Operation Description

Multiply by Multiplies the Trim value with the value specified in the 
Parameter 1 column.

Divide by Divides the Trim value by the value specified in the Para-
meter 1 column.
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Working with presets
The Presets section in the bottom right section of the win-
dow allows you to load, store and manage Project Logical 
Editor presets. A preset contains all settings in the window, 
which means you can simply load a preset and click Do It.

To load a preset, select it from the Presets menu.

Storing your own settings as a preset

If you have made Project Logical Editor settings that you 
want to use again, you can store them as a preset:

1. You can enter some explanatory text in the Comment 
field.
An extra description of the preset can be useful, especially if the settings 
are complex.

2. Click the Store button in the Presets section.
A dialog for specifying a name for the new preset is displayed.

3. Enter a name for the preset and click OK.
The preset is stored.

To remove a preset, load it and click the Remove but-
ton.

Organizing and sharing presets

The Project Logical Editor presets are stored within the ap-
plication folder in the Presets\Logical Edit Project subfolder 
(see also “Where are the settings stored?” on page 514). 
While these files cannot be edited manually, you can reor-
ganize them (e.g. putting them in subfolders) like any files.

This also makes it easy to share presets with other Nu-
endo users, by transferring the individual preset files.

The list of presets is read each time the Project Logi-
cal Editor is opened.

Setting up key commands for your presets

If you have stored Project Logical Editor presets, you can 
set up key commands for them:

1. Pull down the File menu and select “Key Commands…”.
The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to 
the category “Process Logical Project Preset” and click 
the plus-sign to display the items in the folder.

3. In the list, select the item to which you wish to assign a 
key command, click in the “Type in Key” field and enter a 
new key command.

4. Click the Assign button above the field.
The new key command appears in the Keys List.

5. Click OK to exit the dialog.

For more information on Key Commands, see the chapter 
“Key commands” on page 517.
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Introduction
SysEx (System Exclusive) messages are model-specific 
messages for setting various parameters of a MIDI device. 
This makes it possible to address device parameters that 
would not be available via normal MIDI syntax.

Every major MIDI manufacturer has its own SysEx identity 
code. SysEx messages are typically used for transmitting 
patch data, i.e. the numbers that make up the settings of 
one or more sounds in a MIDI instrument.

Nuendo allows you to record and manipulate SysEx data 
in various ways. This chapter points to various features 
that help you manage and create SysEx data.

(To learn about the possibilities of the MIDI Device Man-
ager for controlling your device, please refer to the sepa-
rate PDF document “MIDI Devices”.)

Bulk dumps

Recording a bulk dump in Nuendo
In any programmable device, the settings are stored as 
numbers in computer memory. Change those numbers, 
and you will change the settings.

Normally, MIDI devices allow you to dump (transmit) all or 
some settings in the device's memory in the form of MIDI 
SysEx messages. A dump is therefore (among other 
things) a way of making backup copies of the settings of 
your instrument: sending such a dump back to the MIDI 
device will restore the settings. 

If your instrument allows the dumping of a few or all of its 
settings via MIDI by activating some function on the front 
panel, this dump will probably be recordable in Nuendo.

1. Open the Preferences dialog from the File menu (on 
the Mac, this is located on the Nuendo menu) and select 
the MIDI–MIDI Filter page.
This allows you to govern which MIDI event types should be recorded 
and/or thru-put.

2. Make sure that recording of Sysex data is not filtered, 
by unchecking the Sysex checkbox in the Record section. 
The Sysex checkbox in the Thru section can be left as it is 
(by default activated).

This way, SysEx messages will be recorded but not echoed back out to 
the instrument (which may lead to unpredictable results).

3. Activate recording on a MIDI track and initiate the 
dump from the front panel of the instrument.

4. When done recording, select the new part and open 
the List Editor from the MIDI menu.
This allows you to check that the SysEx dump was recorded – there 
should be one or several SysEx events in the part/event list.

! If your MIDI instrument doesn’t offer a way to initiate a 
dump “by itself”, you have to send a Dump Request 
message from Nuendo to start the dump. In that case, 
use the MIDI SysEx Editor (see “Editing System Exclu-
sive messages” on page 413) to insert the specific 
Dump Request message (see the instrument’s docu-
mentation) at the beginning of a MIDI track. When you 
activate recording, the Dump Request message will 
be played back (sent to the instrument), the dump will 
start and be recorded as above.
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Transmitting a bulk dump back to a device
1. Make sure the MIDI track with the System Exclusive 
data is routed to the device.
You may want to check your device’s documentation to find details about 
which MIDI channel should be used, etc.

2. Solo the track.
This might not be necessary, but it is a good safety measure.

3. Make sure the device is set up to receive SysEx mes-
sages (often, receiving SysEx is turned off by default).

4. If necessary, put the device in “Standby to Receive 
System Exclusive” mode.

5. Play back the data.

Some advice
• Don't transmit more data than you need. If all you want is a sin-

gle program, don't send them all, it will only make it harder to 
find the one you want. Usually, you can specify exactly what 
you want to send.

• If you want the sequencer to dump the pertinent sounds to 
your instrument each time you load a project, put the SysEx 
data in a silent “count-in” before the project itself starts.

• If the dump is very short (for instance, a single sound) you can 
put it in the middle of the project to re-program a device on the 
fly. However, you can achieve the same effect by using Program 
Change. This is definitely preferable, since less MIDI data is 
sent and recorded. Some devices may be set up to dump the 
settings for a sound as soon as you select it on the front panel.

• If you create parts with useful “SysEx dumps”, you can put 
these on a special muted track. When you want to use one of 
them, drag it to an empty unmuted track and play it back from 
there.

• Do not transmit several SysEx dumps to several instruments at 
the same time.

• Make a note of the current device ID setting of the instrument. 
If you change this, the instrument may refuse to load the dump 
later.

Recording System Exclusive 
parameter changes
Often you can use SysEx to remotely change individual 
settings in a device, e.g. open a filter, select a waveform, 
change the decay of the reverb etc. Many devices are also 
capable of transmitting changes made on the front panel 
as SysEx messages. These can be recorded in Nuendo, 
and thus incorporated into a regular MIDI recording.

Here's how it works: let's say you open up a filter while 
playing some notes. In that case, you will record both the 
notes and the SysEx messages generated when you 
opened of the filter. When you play it back, the sound 
changes exactly like it did when you recorded it.

1. Open the Preferences dialog from the File menu, se-
lect the MIDI–MIDI Filter page and make sure that SysEx is 
recorded, i.e. the Sysex checkbox in the Record section is 
deactivated.

2. Make sure the instrument is actually set to transmit 
changes of front panel controls as SysEx messages.

3. Record normally.
When you’re done, you can check that the events were recorded pro-
perly in the List Editor.



413

Working with System Exclusive messages

Editing System Exclusive messages
While SysEx events are shown in the List Editor/Project 
Browser, their entire content is not (only the beginning of 
the message is displayed in the Comment column for the 
event). Also, you cannot edit the event (other than moving 
it) as you can with other event types in the List Editor.

Instead, you have to use the MIDI SysEx Editor for this.

• To open the MIDI SysEx Editor for an event, click in the 
Comments column for the event in the List Editor/Project 
Browser.

The display shows the entire message on one or several 
lines. SysEx messages always begin with F0 and end with 
F7 with a number of arbitrary bytes in between. If the mes-
sage contains more bytes than fit on one line, it continues 
on the next. The Address indication to the left helps you 
find out on which position in the message a certain value 
resides.

You can edit all values except for the first (F0) and last one 
(F7).

Selecting and viewing values
To select a value, either click on it or use the cursor keys. 
The selected byte is displayed in various formats:

• In the main display, values are shown in hexadecimal format.
• To the right of this, values are shown in ASCII format.
• At the bottom of the dialog, the selected value is shown in 

binary and decimal formats.

Editing a value
The selected value can be edited directly in the main dis-
play or in the decimal and binary displays. Just click on it 
and type in the desired value as usual.

Adding and deleting bytes
Using the Insert and Delete buttons or their corresponding 
computer keyboard keys, you can add and delete bytes 
from the message. Inserted data will appear before the se-
lection.

To delete the complete SysEx message, select it in the 
List Editor and press [Delete] or [Backspace].

Importing and exporting data
The Import and Export buttons allow you to get SysEx data 
from disk and to export the edited data to a file. The file 
has to be in “MIDI SysEx” (.SYX) binary format. Only the 
first dump in a .SYX file will be loaded.

This format should not be confused with MIDI files, which 
have the extension .MID.



31
Working with the Tempo track



415

Working with the Tempo track

Background
For each track in Nuendo that can make use of this func-
tion, you can specify whether it should be time-based or 
tempo-based (see “Switching between musical and linear 
time base” on page 40). For tempo-based tracks, the 
tempo can either be fixed through the whole project (this 
is called “Fixed tempo mode”) or follow the Tempo track 
(this is called “Tempo track mode”), which may contain 
tempo changes.

• To switch between Fixed tempo mode and Tempo track 
mode, use the Tempo button on the Transport panel:

When the Tempo button is lit (and the text “Track” is 
shown), the tempo follows the Tempo track; when it is de-
activated (and the text “Fixed” is shown), the Fixed tempo 
is used (see “Setting the Fixed tempo” on page 419). You 
can also switch tempo mode in the Tempo Track Editor 
(see below).

In Tempo track mode, the tempo cannot be changed on 
the Transport panel, i.e. the tempo information here is for 
display purposes only.

The Tempo track also contains time signature events. 
These are always active, regardless of whether Fixed 
tempo mode or Tempo track mode is selected.

A note about tempo-based audio tracks

For tempo-based tracks, the start time position of audio 
events depends on the current tempo setting. However, it 
is important to realize that the actual audio (“within” the 
events) will play back as recorded, regardless of any 
tempo changes you make. Therefore, it’s good practice to 
make the proper tempo and time signature settings before 
you start recording tempo-based audio.

To make an already recorded audio track follow the 
tempo changes, you can use the Sample Editor, see “The 
Sample Editor” on page 258.
How well this works depends on the character of the audio recordings, 
since the Hitpoint detection feature works best with fairly rhythmical ma-
terial.

To adapt the tempo track to time-based material, you 
can use the Time Warp tool, see “The Time Warp tool” on 
page 422.
This allows you to adjust the tempo track so that tempo-based material 
(e.g. positions in music) coincides with time-based material (e.g. positions 
in narration, video, etc.).

The Tempo Track Editor – Overview
To make changes to the actual Tempo track, you need to 
open the Tempo Track Editor by selecting “Tempo Track” 
on the Project menu.



416

Working with the Tempo track

The toolbar
The toolbar contains various tools and settings. The tempo 
and time signature displays to the right allow you to view 
and edit the value of the selected tempo curve point or time 
signature event, much like the info line in other editors.

The ruler
The ruler in the Tempo Track Editor shows the timeline. As 
in other windows, you can select a display format by click-
ing on the arrow button to the right of the ruler and select-
ing an option from the pop-up menu that appears.

The two additional items at the bottom of the menu have 
the following functionality:

• If “Time Linear” is selected, the ruler, time signature area 
and tempo curve display will be linear in relation to the 
timeline.
This means that if the ruler shows bars and beats, the distance between 
the bar lines will vary depending on the tempo.

• If “Bars+Beats Linear” is selected, the ruler, time signa-
ture area and tempo curve display will be linear in relation 
to beats.
If the ruler shows bars and beats, the distance between beats will be 
constant.

The time signature area
The area below the ruler contains time signature events. 

Tools

Tempo track on/off Autoscroll

Snap on/off Snap pop-up

Curve type selector

Curve type for new tempo events

Time signature

The selected tempo

Tempo 
record slider

Open Process 
Tempo dialog)

Open Process 
Bars dialog)
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The tempo curve display

The main display shows the tempo curve (or, if Fixed tempo 
mode is selected, the Fixed tempo – see “Setting the Fixed 
tempo” on page 419). To the left of the display is a tempo 
scale to help you quickly locate the desired tempo.

• Note that the vertical “grid lines” correspond to the dis-
play format selected for the ruler.

Operations

Zooming
Changing the magnification is done using any of the fol-
lowing methods:

• By using the zoom sliders in the lower right corner of the 
window.

• By using the Magnifying Glass tool.
This works according to the standard procedures.

• By using the Zoom submenu on the Edit menu.
The options on the menu work as in other windows.

Editing the tempo curve

Adding tempo curve points

1. Use the “insert curve” pop-up menu in the toolbar to 
select whether you want the tempo to change gradually 
from the previous curve point to the new one (“Ramp”) or 
change instantly to the new value (“Jump”).

2. Select the Pencil tool.

3. Click at the desired time position in the tempo curve 
display, and keep the mouse button pressed.
If Snap is activated on the toolbar, this determines at which time posi-
tions you can insert tempo curve points, see “Snap” on page 421.

When you click, the tempo display in the toolbar shows the tempo value.

4. Drag the curve point to the desired tempo value (indi-
cated in the tempo display), and release the mouse button.
The tempo curve point is inserted. The result depends on whether you 
selected “Ramp” or “Jump” in step 1 above:

• You can also just click and draw a tempo curve with the 
Pencil tool, so that curve points are inserted while you draw.
For this, the “Ramp” Insert Curve mode is useful.

! This section assumes that you are working in Tempo 
track mode, i.e. the Tempo button must be activated 
on the Transport panel.

Insert curve set to “Ramp”:

Insert curve set to “Jump”:
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• Instead of using the Pencil tool, you can press [Alt]/[Op-
tion] and use the Arrow tool. 
This will only insert a single point (i.e. you cannot draw a curve with the 
Arrow tool).

Selecting tempo curve points

Selecting curve points is done using any of the following 
methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

• You can also use the left and right arrow keys on the 
computer keyboard to go from one curve point to the next.
If you press [Shift] and use the arrow keys, the current selection will be 
kept, allowing you to select several points.

Editing tempo curve points

Curve points can be edited in the following ways:

• By clicking and dragging horizontally and/or vertically.
If several points are selected, all of them are moved. If Snap is activated 
on the toolbar, this determines to which time positions you can move 
curve points, see “Snap” on page 421.

• By adjusting the tempo value in the tempo display on 
the toolbar.
For this to work, a single tempo curve point must be selected.

Adjusting the curve type

You can change the curve type of a tempo curve segment 
at any time, using the following method:

1. Select all curve points within the segment you want to 
edit.

2. Pull down the Curve pop-up menu on the toolbar and 
select “Jump” or “Ramp”.
The curve sections between the selected points are adjusted.

! You can also have tempo values automatically in-
serted by the Beat Calculator, see “The Beat Calcu-
lator” on page 421.

Option Description

All Selects all curve points on the Tempo track.

None Deselects all curve points.

In Loop Selects all curve points between the left and right locator.

From Start
to Cursor

Selects all points to the left of the project cursor.

From Cursor
to End

Selects all points to the right of the project cursor.

! Dragging tempo curve points with a time-based dis-
play format (any other format than “Bars+Beats”) may 
lead to confusing results. This is because moving a 
point will change the relationship between tempo and 
time. For example, let’s say you move a tempo point to 
the right and drop it on a certain time position. When 
you release the mouse button, the mapping between 
tempo and time will be adjusted (since you have 
changed the tempo curve). As a result, the moved 
point will appear at another position. For this reason, 
we recommend that you use the Bars+Beats display 
format when editing tempo curves.
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Removing tempo curve points

To remove a curve point, either click on it with the Eraser 
tool or select it and press [Backspace]. The first tempo 
curve point cannot be removed.

Recording tempo changes

The tempo record slider on the toolbar allows you to record 
tempo changes “on the fly”: simply start playback and use 
the slider to raise or lower the tempo at the desired posi-
tions. Useful for creating natural sounding ritardandos, etc.

Setting the Fixed tempo
When the Tempo track button is deactivated, the Tempo 
track curve is grayed out (but still visible). Since the Fixed 
tempo is constant throughout the whole project, there are 
no tempo curve points. Instead, the Fixed tempo is dis-
played as a horizontal black line in the tempo curve display.

There are three ways to set the tempo in Fixed mode:

• Drag the tempo line up or down with the Arrow tool.

• Adjust the value numerically in the tempo display on the 
toolbar.

• On the Transport panel, in Fixed tempo mode, click on 
the Tempo value to select it, enter a new value and press 
[Enter].

Adding and editing time signature events
• To add a time signature event, click in the time signature 
area with the Pencil tool. 
This adds a default 4/4 time signature event at the closest bar position. 
You can also do this by pressing [Alt]/[Option] and clicking with the Ar-
row tool.

• To edit the value of a time signature event, select it and 
adjust the value in the signature display on the toolbar.
Note that there are two controls for the signature display; the left one ad-
justs the numerator and the right one adjusts the denominator.

• You can move a time signature event by clicking and 
dragging it with the Arrow tool.
Again, note that time signature events can only be positioned at the start 
of bars.

• To remove a time signature, either click on it with the 
Eraser tool or select it and press [Backspace].
The first time signature event cannot be removed.

Exporting and importing Tempo tracks
You can export the current tempo track for use in other 
projects by selecting “Tempo Track” from the “Export” 
submenu on the File menu. This allows you to save the 
tempo track information (including time signature events) 
as a special xml file (file extension “.smt”).

To import a saved tempo track, select “Tempo Track” from 
the Import submenu on the File menu. Note that this re-
places all tempo track data in the current project (although 
the operation can be undone if needed).
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Process Tempo
Process Tempo allows you to define a specific length or 
end time for a set range, and the Tempo track will automat-
ically set a tempo that will fit the range in the specified time. 

It works as follows:

1. Open the Tempo Track Editor and specify a region or 
range that you wish to process by setting the left and right 
locators. 

2. Click on the Process Tempo button on the Tempo 
Track toolbar.
The Process Tempo dialog appears.

3. In the Process Range fields, the specified range is 
shown, in Bars and Beats (PPQ) and in a time format, which 
can be selected from the Time Display Format pop-up.
The range defined in step 1 will already be set, but you can edit the range 
by adjusting the values in the Process Range fields if you wish.

Now you can either specify a new range length or a new 
range end time. What to choose depends on whether the 
range should have a specific length or whether it should 
end at a specific time position.

4. Enter the desired End or Length in the corresponding 
fields of the New Range section.
You can select a time format for the new range in the Time Display For-
mat pop-up.

5. Click Process.
Now the tempo track is automatically adjusted, and the range will have 
the specified duration.

The Process Bars dialog

The Process Bars dialog, which can be opened from the 
Tempo Track Editor, uses the global “Insert Silence” and 
“Delete Time” functions from the Edit menu – Range sub-
menu, but uses a musical “bars+beats-based” environ-
ment for calculating the necessary ranges (or parameters). 
It also ensures that the time signatures stay “in sync” after 
these operations. This allows for a much more intuitive ap-
proach when inserting, deleting or replacing “time” while 
working with a project set to the Bars+Beats time type.

The Process Bars dialog is opened by clicking on the re-
spective button on the Tempo Track toolbar (next to the 
Process Tempo button).

The dialog contains the following elements:

Option Description

Bar Range The Bar Range display gives you a graphical overview of 
the position of the bar range within the project as well as 
its length. You can change the setting here by dragging 
the green rectangle; however this is accomplished much 
easier by using the Start and Length value fields (see be-
low).
The small arrow pair in this section mark the length of the 
current project. The area to the right marks the bar range 
that can be added (500 bars max.).

Bar Range – 
Start

This is where you specify the desired start position for the 
bar range. Click on the small arrows to raise/lower the 
value by one step or click directly in the value field and 
enter the desired number manually.

Bar Range – 
Length

This is where you specify the desired length of the bar 
range. Click on the small arrows to raise/lower the value 
by one step or click directly in the value field and enter 
the desired number manually.

Action –
Insert Bars

When you select this action, clicking the Process button 
will insert the specified number of empty bars with the set 
time signature at the desired start position in the project.

… to open the Process Bars dialog.

Click this button…
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Options and settings

Snap
You activate or deactivate Snap by clicking the Snap icon 
on the toolbar. The behavior of the function depends on 
the display format selected for the ruler:

• If “Bars+Beats” is selected, tempo curve points will 
snap to the set resolution on the Snap pop-up.
If this is set to 1/1, curve points will snap to the start of bars.

• If any other display format is selected, tempo curve 
points will snap to the vertical grid lines in the tempo curve 
display.
The spacing of the grid lines depends on the horizontal magnification.

• Time signature events can only be positioned at the start 
of bars, regardless of whether Snap is activated or not.

Autoscroll
When this option is activated, the tempo curve display will 
scroll during playback, keeping the project cursor visible.

The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of 
freely recorded audio or MIDI material. It also allows you to 
set the tempo by tapping.

Calculating the tempo of a recording
1. In the Project window, make a selection that covers an 
exact number of beats of the recording.

2. Select “Beat Calculator…” from the Project menu.
The Beat Calculator window appears.

3. Enter the number of beats that the selection encom-
passes in the Beats field.
The corresponding tempo is calculated and displayed in the BPM field.

• If you need to adjust the selection, you can go back to 
the Project window, leaving the Beat Calculator open.
To re-calculate the tempo after adjusting the selection, click Refresh.

4. If you like, you can insert the calculated tempo into the 
Tempo track by clicking one of the buttons in the lower left 
corner of the Beat Calculator window.
Clicking “At Tempo Track Start” will adjust the first tempo curve point, 
while “At Selection Start” will add a new tempo curve point at the selec-
tion’s start position, using the “Jump” curve type (see “Adding tempo 
curve points” on page 417).

Action – Delete 
Bars

When you select this action, clicking the Process button 
will delete the specified number of bars beginning at the 
set start position.

Action – 
Reinterpret 
Bars

When you select this action, clicking the Process button 
will reinterpret the bar range to fit the specified time sig-
nature. This is very special in the sense that both 
bars+beats positions of the notes and the tempo are be-
ing changed to fit the new time signature, but the play-
back of the notes will stay just the same.
If you want to reinterpret e.g. a bar with the time signature 
3/4 so that it gets the time signature 4/4, quarter notes 
will become half note triplets. If you reinterpret a bar with 
the time signature 4/4 to attain 3/4, you will get quadru-
plets.

Action – 
Replace Bars

When you select this action, clicking the Process button 
will cause the time signature of the specified bar range to 
be replaced by the one you specify in this dialog. 

Action – 
Signature

This lets you specify the desired time signature for the 
action you select in the Action pop-up menu (except for 
the Delete Bars action).

Process Click this button to apply your changes to the desired bar 
range.

Close Clicking this button closes the Process Bars dialog. 
Please note that you have to click the Process button first 
to apply your settings. Clicking this button without click-
ing on “Process” first will close the dialog without apply-
ing your settings.

Option Description

! If Fixed tempo mode is selected when you insert the 
calculated tempo, the Fixed tempo will be adjusted, 
regardless of which button you click.
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Using Tap Tempo
The Tap Tempo function allows you to specify a tempo by 
tapping:

1. Open the Beat Calculator.

2. If you want to tap the tempo to some recorded material, 
activate playback.

3. Click the Tap Tempo button.
The Tap Tempo window appears.

4. Tap the tempo on the computer keyboard’s space bar 
or with the mouse button.
The tempo display will update the calculated tempo between each tap.

5. When you stop tapping, the program calculates the 
average timing of the taps and displays it.

6. Click OK to close the Tap Tempo dialog.
The tapped tempo is now shown in the Beat Calculator’s BPM display. If 
you like, you can insert it into the Tempo track as described above.

Merge Tempo From Tapping
This function allows you to create a complete tempo track 
based on your tapping. Typically, you would use this if you 
have an audio file with no tempo mapping and want to be 
able to add sequenced material afterwards, etc.

1. Create an empty time-based MIDI track and, while 
playing back your audio material, tap the new tempo on 
your MIDI keyboard and record the created notes onto the 
new MIDI track.
Note that you must create note events – pedal events cannot be used for 
this function.

2. Play back the audio and check that the timing of the 
MIDI notes corresponds to that of the audio. 
If necessary, edit the MIDI notes in an editor.

3. Select the part (or the individual notes in an editor) 
that you want to use for the calculation.

4. Select “Merge Tempo From Tapping” from the Func-
tions submenu on the MIDI menu.
A dialog opens.

5. In the dialog, specify what type of note (1/2, 1/4 etc.) 
you tapped during the recording.
If you activate the “Begin at Bar Start” option, the first note will automati-
cally start at the beginning of a bar when calculating the new tempo curve.

6. Click OK.
The project’s tempo is adjusted to the tapped notes.

7. Open the Project menu and select “Tempo Track” to 
check that the new tempo information is reflected in the 
tempo curve.

Another way of creating a tempo map for freely re-
corded audio would be to use the Time Warp tool, see 
below.

The Time Warp tool
The Time Warp tool lets you adjust the Tempo track so 
that “musical time-based” material (positions related to 
the tempo) matches “linear time-based” material (posi-
tions in time). Some typical applications:

• When you have recorded music (audio or MIDI) without tempo 
reference or metronome click, the Time Warp tool can be used 
for creating a tempo map that fits the recording (allowing you to 
rearrange or add sequenced material).

• When you are creating music for a movie and want to match 
certain positions in the video with certain positions in the music.

The Time Warp tool makes use of the fact that tracks can 
be based on time positions (linear time base) or positions 
related to tempo (musical time base), see “Switching bet-
ween musical and linear time base” on page 40 for a de-
scription of these modes.
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Basic procedure
You use the Time Warp tool to drag a musical position (a 
position in bars+beats format) to a certain position in time. 
This can be done in the Project window or in editor win-
dows, as described below. Here is the general procedure:

1. Make sure Tempo track mode is selected.
You cannot use the Time Warp tool in Fixed tempo mode.

2. Select the Time Warp tool.

Bars+Beats format is automatically selected for the ruler in the active 
window, and the ruler is shown in brown.

3. Click in the window at a musical position and drag it 
so that it matches a position in the material you are editing 
– e.g. the start of an event, a certain “hit” within an audio 
event, a frame in a video clip, etc.
When you click with the Time Warp tool, it snaps to the grid in the window.

Dragging the start of bar 3 to the start of the audio event.

While you are dragging, the track(s) you are editing are 
temporarily switched to linear time base. This means that 
the contents of the tracks remain at the same time posi-
tions regardless of the tempo (there is an exception to this 
in the Project window, see below).

4. When you release the mouse button, the musical posi-
tion you clicked on matches the time position you dragged 
it to.
This is because the Time Warp tool changed the last tempo event on the 
Tempo track (and/or added new ones, depending on window and us-
age), thereby scaling the tempo track to fit.

Rules
• When you use the Time Warp tool, the tempo value of 
the last tempo event (before the click position) is adjusted.

• If later tempo events exist, a new tempo event will be 
created at the click position. This way, the later tempo 
event(s) will not be moved.

• If you press [Shift] and use the Time Warp tool, a new 
tempo event is created at the click position.
[Shift] is the default modifier for this – you can adjust this in the Prefer-
ences (Editing–Tool Modifiers page).

• If you use the Time Warp tool in an editor, a tempo 
event will be created at the start of the edited part or 
event. Only the currently edited track will be affected – but 
note that events to the right of the edited events or parts 
(on the edited track) will be affected as well.

• If you have made a selection range (in the Project win-
dow, Audio Part Editor or Sample Editor) and use the 
Time Warp tool within that range, the tempo changes will 
be confined to that range.
This means tempo events will be inserted at the start and end of the se-
lection range, if needed – useful if you need to adjust the tempo within a 
certain area but want all material outside that range to stay in place.

• When you click with the Time Warp tool, it snaps to the 
tempo grid in the window.

• When you drag the tempo grid to a new position, it can 
be magnetic to events in the window.
In the Project window, this requires that Snap is activated and “Events” 
is selected on the Snap pop-up menu – the grid will then snap to the 
start and end of events or parts, and to markers. In the Sample Editor, 
this requires that Snap to Zero Crossings is activated – the grid will then 
snap to hitpoints (if any). In the MIDI editors, this requires that Snap is 
activated – the grid will then snap to the start and end of notes.

• The function will create tempo values up to 300 bpm.
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Viewing and adjusting tempo events
When you select the Time Warp tool, the ruler of the ac-
tive window is shown in brown. Existing tempo events are 
shown in the ruler as “flags” with the tempo values dis-
played.

This helps you see what’s going on, but you can also use 
this for editing the tempo track:

• If you press the create/erase modifier key (by default 
[Shift]) and click on a tempo event in the ruler, it is deleted.

• You can click on a tempo event in the ruler and drag to 
move it.
This automatically edits the tempo value in the event so that elements to 
the right keep their positions.

• If you press [Alt]/[Option] and move (or delete) a tempo 
event in the ruler, the tempo value is not adjusted – this 
means elements to the right will be moved.
This is the default modifier key for this – you can adjust this in the Prefer-
ences (Editing–Tool Modifiers page).

Using the Time Warp tool in the Project 
window
In the Project window, there are two modes for the Time 
Warp tool:

• In the default mode, all tracks are temporarily switched to lin-
ear time base when you use the tool. This means that all tracks 
will keep their absolute time positions when you adjust the 
tempo track.

• In the “musical events follow” mode, no tracks are switched to 
linear time base. This means that all tracks that are not set to 
linear time base will follow the changes you make to the tempo 
track.

You select the Time Warp mode by selecting the tool, 
clicking on the tool icon and selecting from the pop-up 
menu that appears.

Matching a musical score to video

Here’s an example of how to use the Time Warp tool in 
“musical events follow” mode. Let’s say you are creating 
the music for a film. You have a video track, an audio track 
with a commentary and some audio and/or MIDI tracks 
with your music. Now you want to match the position of a 
musical cue to a position in a video film. The musical cue 
is located in bar 33. There are no tempo changes in the 
project (yet).

1. Make sure tempo track mode is selected in the Trans-
port panel.

2. Now you need to locate the position in the video. If you 
don’t need very high precision, you can simply locate it 
looking at the thumbnails on the video track – otherwise 
you can pinpoint the exact position and add a marker to 
the Marker track (that you can snap to later on).
You can also make a note of the exact position and add an extra ruler 
track set to show the time code.

3. Make sure the correct tracks are set to linear time 
base or musical time base, respectively.
In our example, we want the video track and the audio track with a com-
mentary voice-over to be linear time-based (as well as the marker track, if 
you are using one). All other tracks should be set to musical time base. 
You change this by clicking the time base button in the Track list or In-
spector.

4. Set up the Grid Type pop-up menu as desired.
When you click with the Time Warp tool, it snaps to the selected grid. In 
this case, you will find the musical cue at the start of bar 33, so we can 
set the grid to “Bar”.

Musical time base selected.

Linear time base selected.
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• Note that this affects the snapping to the ruler (tempo 
grid) when you click! In addition, the tool can be “mag-
netic” to events in the Project window when you drag – for 
this, you need to activate Snap and select “Events” on the 
Snap pop-up menu. 
In our example, this would be useful if you created a marker at the de-
sired position in the video – when you drag the grid (see below), it will 
snap to the marker.

5. Select the Time Warp tool and select the “musical 
events follow” mode.

6. Click in the event display at the start of bar 33 and 
drag to the desired position in the video.
As mentioned above, this can mean dragging to a position indicated by 
the thumbnails on the video track, to a marker on the Marker track or to a 
time position on an additional ruler track.

When you drag, the ruler is scaled – and the music tracks 
will follow.

7. Release the mouse button.
If you look in the ruler at the beginning of the project, you will see that the 
first (and only) tempo event has been adjusted.

8. Try playing back.
The musical cue should now happen at the correct position in the video.

OK, let’s say you need to match another cue to another 
position later on in the video. If you simply repeat this pro-
cedure, you will find that the first cue gets out of sync – 
since you are still changing the first (and only) tempo 
event on the Tempo track!

You need to create a “lock point” – a tempo event at the 
first cue position:

9. Press [Shift] and click with the Time Warp tool in the 
event display at the cue position.
In our case this is bar 33.

As you can see, a tempo event (with the same value as the 
first one) is added at that position.

10. Now match the second musical cue to the correct 
video position by dragging the musical position to the 
desired time position as before.
The new tempo event is edited – the first tempo event is unaffected and 
the original cue is still matched.

• If you know you are going to match several cues this 
way, you should make it a habit to press [Shift] each time 
you use the Time Warp tool to match positions.
This adds a new tempo event – that way, you don’t have to add tempo 
events afterwards as in step 9 above.

About snapping

If Snap is activated in the Project window and “Events” is 
selected on the Snap pop-up menu, the Time Warp tool 
will be magnetic to events when you drag the tempo grid. 
This makes it easier to snap a tempo position to a marker, 
the start or end of an audio event, etc.
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Using the Time Warp tool in an audio editor
Using the Time Warp tool in the Sample Editor or Audio 
Part Editor is different from using it in the Project window, 
in the following ways:

• When you use the Time Warp tool, a tempo event is automa-
tically inserted at the beginning of the edited event or part – 
this tempo event will be adjusted when you warp the tempo 
grid with the tool. This means that material before the edited 
events won’t be affected.

• Only the default mode for the Time Warp tool is available. So 
when you use the tool, the edited track is temporarily switched 
to linear time base.

Making a tempo map for a “free” recording

The following example shows how to use the Time Warp 
tool in the Sample Editor to create a tempo map matching 
freely recorded music. Let’s say you have recorded a drum-
mer, playing without a metronome – this typically means the 
tempo varies ever so slightly. To be able to add sequenced 
material and easily rearrange the recorded audio, you want 
the tempo in Nuendo to match the recorded drum track:

1. If necessary, move the recorded event to its desired 
start position.
Move it so that the first downbeat (“one”) happens on the start of the de-
sired bar – zoom in if needed.

2. Open the drum recording in the Sample Editor and 
make sure Hitpoint mode isn’t selected.
The Time Warp tool cannot be used in Hitpoint mode. However, if you 
have calculated hitpoints already, these will be visible when the Time 
Warp tool is selected (see below).

3. Set the zoom so that you can see the individual drum 
hits clearly.
To achieve this type of “visual” beat matching, it’s important to have a 
fairly clean recording, such as the drum track in this example.

4. Select the Time Warp tool.

You have already matched the first downbeat with the 
start of a bar. However, if the recording starts before the 
first downbeat (with a fill, some silence, etc.), you want to 
“lock” the first downbeat so that it stays in position:

5. Press [Shift] and click in the event at the position of 
the first downbeat (the start of the bar).
When you press [Shift], the pointer turns into a pencil. Clicking adds a 
tempo event at the first downbeat – when you later adjust the tempo with 
the Time Warp tool, the first downbeat will stay in place. Note: if the 
event started exactly on the first downbeat (no audio before the “one”), 
you wouldn’t need to do this. This is because a tempo event is automati-
cally added at the start of the edited event.

6. Now, locate the start of the next bar in the ruler. 

7. Click at that position in the event display and drag the 
position to the downbeat of the second bar in the record-
ing.
When you click, the pointer will snap to the ruler grid.

You do not have to match the downbeats (“ones”) – in this figure, beat 
“2” in the second bar is matched to the “two” in the recording’s second 
bar (simply because the snare drum hits on the upbeats are easier to 
spot in the waveform image).

When you dragged the grid you changed the tempo value 
in the tempo event at the first downbeat. If the drummer 
held a fairly consistent tempo, the following bars should 
now match pretty well too.

8. Check the following bars and locate the first position 
where the audio drifts from the tempo.

Now, if you simply adjusted that beat in the tempo grid to 
match the beat in the recording, the tempo event at the 
first downbeat would be changed – this would ruin the 
match in the previous bars! We need to lock these by in-
serting a new tempo event.
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9. Locate the last beat that is in sync.
This would be the beat just before the position where the audio and 
tempo drift apart.

10. Press [Shift] and click at that position to insert a tempo 
event there.
This locks this matched position. The material to the left will not be af-
fected when you make adjustments further along.

11. Now match the tempo grid to the next (unmatched) 
beat by clicking and dragging with the Time Warp tool.
The tempo event you inserted in step 10 will be adjusted.

12. Work your way through the recording this way – when 
you find that the recording drifts from the tempo, repeat 
steps 9 to 11 above.

Now the Tempo track follows the recording and you can 
add sequenced material, rearrange the recording etc.

Matching to hitpoints

If you have calculated hitpoints for the audio event you are 
editing, these will be shown when the Time Warp tool is 
selected.

• The number of hitpoints shown depends on the Hitpoint Sen-
sitivity slider setting you’ve made in Hitpoint mode.

• If you activate the Snap to Zero Crossing button on the tool-
bar, the Time Warp tool will snap to hitpoints when you drag 
the tempo grid.

• You can use the Create Markers from Hitpoints function (on 
the Hitpoints submenu of the Audio menu) to create markers 
at the hitpoint positions. This can be useful when using the 
Time Warp tool in the Project window, as the tool will be mag-
netic to markers (if Snap to Events is activated on the toolbar).

Using the Time Warp tool in a MIDI editor
This is very similar to using the tool in an audio editor:

• When you use the Time Warp tool, a tempo event is automat-
ically inserted at the beginning of the edited part – this tempo 
event will be adjusted when you warp the tempo grid with the 
tool. Material before the edited part won’t be affected.

• Only the default mode for the Time Warp tool is available. So 
when you use the tool, the edited MIDI track is temporarily 
switched to linear time base.

• The rulers in the MIDI editors can be set to “Time Linear” or 
“Bars+Beats Linear” mode (see “The ruler” on page 367) – 
the Time Warp tool requires Time Linear mode. If necessary, 
the ruler mode will be switched when you select the Time 
Warp tool.

• If Snap is activated on the toolbar in the MIDI editor, the tool 
will snap to the start and end of MIDI notes when you drag the 
tempo grid.

Typically, you would use the Time Warp tool in a MIDI 
editor to match the Nuendo tempo to freely recorded MIDI 
material (much like the audio example above).



32
The Project Browser



429

The Project Browser

Window Overview

While the Project window and the editors display events 
and other data graphically, the Project Browser window 
provides a list based representation of the project. This al-
lows you to view and edit all events on all tracks by using 
regular value editing in a list.

Opening the Project Browser
You open the Project Browser by selecting “Browser” 
from the Project menu. The Browser window can be open 
while you are working in other windows; any changes 
made in the Project window or an editor are immediately 
reflected in the Project Browser and vice versa.

Navigating in the Browser
You use the Project Browser much like you use the Win-
dows Explorer and Mac OS X Finder for browsing folders 
on your hard disk:

• Click on an item in the Project Structure list to select it 
for viewing.
The contents of the item are shown in the event display.

In this figure, the parts on a MIDI track are displayed.

• Items with hierarchical substructures can be folded out 
by clicking the plus symbols or the “closed folder” sym-
bols in the Project Structure list.
When the substructure of an item is revealed, a minus symbol or an “open 
folder” symbol is shown instead – click this to hide the substructure.

• To reveal or hide all substructures in the Project Struc-
ture list, use the buttons “(+) All” and “(–) All” above the list.

The Project Structure list. This is where 
you navigate through the project.

The event display. This is where you view 
and edit parts, events and Regions.

The Add pop-up menu and Add button for 
creating new parts, events and regions.

The Filter pop-up menu, 
used when editing MIDI.

The Time Format (display 
format) pop-up menu.
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• The actual editing is done in the event display, using 
regular value editing techniques.
There is one exception: You can rename items in the Project Structure 
list by clicking on their names and typing.

Customizing the view
You can drag the divider between the Project Structure 
list and the event display to make one of them wider and 
the other narrower. Furthermore, the event display can be 
customized in the following ways:

• You can change the order of the columns by dragging 
the column headings to the left or right.

• You can resize columns by dragging the dividers be-
tween the column headings.

• To select a display format for all position and length val-
ues, use the Time Format pop-up menu.

• You can sort events in the display by columns, by click-
ing the column heading.
For example, if you want to sort events by their start positions, click that 
column heading. An arrow appears in the column heading, indicating that 
events are sorted by that column. The direction of the arrow indicates 
whether the events are sorted in ascending or descending order. To 
change the direction, click the column heading again.

Importing files via the MediaBay
As the Project Browser is just another view of the project, 
you can import audio, video and MIDI files into the project 
via the MediaBay. For this, select the file in the MediaBay 
and drag and drop it into the Project Browser.

You can only import into existing tracks. This means, 
for example, that a video track has to exist in the Project 
window prior to importing a video file in the Project 
Browser.

For more information about the MediaBay, see 
“The MediaBay” on page 314.

About the Sync Selection option
If the “Sync Selection” checkbox is activated (in the top 
right corner of the Project Browser), selecting an event in 
the Project window automatically selects it in the Project 
Browser, and vice versa. This makes it easy to locate 
events in the two windows.

Editing tracks

Editing audio tracks
Audio tracks can have two “subitems”: Track Data and 
Automation. 

• The Automation item corresponds to the Automation subtrack 
in the Project window, and contains the track’s automation 
events (see “Editing Automation tracks” on page 432).

• The Track Data item corresponds to the actual audio track in 
the Project window. It contains audio events and/or audio 
parts, which in turn can contain audio events.

Note that if you have not performed any automation or 
opened an automation subtrack, the Browser will only 
contain the audio data.

The following parameters are available for the different 
items:

The list columns for audio events:

Parameter Description

Name Allows you to enter a descriptive comment for the event. 
Double-clicking on the waveform image beside it opens 
the Sample Editor for the event.

File The name of the audio file referenced by the event’s au-
dio clip.

Start The start position of the event. If the event belongs to an 
audio part, you cannot move it outside the part.

End The end position of the event. 

Snap The absolute position of the event’s snap point. Note that 
adjusting this value will not change the position of the 
snap point within the event – instead it is another way of 
moving the event!

Length The length of the event. 

Audio track

Track Data subitem of 
the audio track

Audio parts

Automation 
subtracks

Audio events
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The list columns for audio parts:

Creating audio parts

When the “Audio” item of an audio track is selected in the 
Project Structure list, you can create empty audio parts on 
the track by clicking the Add button on the toolbar. This 
will insert a part between the left and right locator.

Editing MIDI tracks
Just like audio tracks, MIDI tracks can have two “sub-
items”: Track Data and Automation.

• The Track Data item corresponds to the actual MIDI track in 
the Project window and can contain MIDI parts (which in turn 
can contain MIDI events).

• The Automation item corresponds to the automation subtrack 
in the Project window, and contains the track’s automation 
events (see “Editing Automation tracks” on page 432).

Note that if you have not performed any automation or 
opened an automation subtrack, the Browser will only 
contain the MIDI data.

When editing the Track Data, the following parameters are 
available:

The list columns for MIDI events:

Offset This determines “where in the audio clip” the event starts. 
Adjusting this value is the same as sliding the contents of 
the event in the Project window (see “Sliding the con-
tents of an event or part” on page 49). 
You can only specify positive Offset values, since the 
event cannot start before the start of the clip. Likewise, it 
cannot end after the end of the clip. If the event already 
plays the whole clip, the Offset cannot be adjusted at all.

Volume The volume of the event, as set with the Volume handle or 
on the info line in the Project Window.

Fade In
Fade Out

The length of the fade-in and fade-out areas respectively. 
If you use these settings to add a fade (where there pre-
viously was none), a linear fade will be created. If you ad-
just the length of an existing fade, the previous fade 
shape will be maintained.

Mute Click in this column to mute or unmute the event.

Image Displays a waveform image of the event inside a gray box 
corresponding to the clip. The image is scaled according 
to the width of the column.

Parameter Description

Name The name of the part. Double-clicking on the part symbol 
beside it opens the Audio Part Editor for the part.

Start The start position of the part. Editing this value is the 
same as moving the part in the Project window.

End The end position of the part. Editing this value is the same 
as resizing the part in the Project window.

Length The length of the part. Editing this value is the same as 
resizing the part in the Project window.

Offset This adjusts the start position of the events within the 
part. Adjusting this value is the same as sliding the con-
tents of the part in the Project window (see “Sliding the 
contents of an event or part” on page 49). Setting a pos-
itive Offset value is the same as sliding the contents to 
the left, while a negative Offset corresponds to sliding 
the contents to the right.

Mute Click in this column to mute or unmute the part.

Parameter Description

Parameter Description

Type The type of MIDI event. This cannot be changed.

Start The position of the event. Editing this value is the same as 
moving the event.

End This is only used for note events, allowing you to view and 
edit the end position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of 
the note – changing this resizes the note and automati-
cally changes the End value as well.

Data 1 The property of this value depends on the type of MIDI 
event:
For notes, this is the note number (pitch). This is dis-
played and edited as a note name and an octave number, 
with the values ranging between C-2 and G8.
For Controller events, this is the type of Controller, dis-
played in words. Note that you can edit this by entering a 
number – the corresponding Controller type is automati-
cally displayed.
For Pitch Bend events, this is the fine adjustment of the 
bend amount.
For Poly Pressure events, this is the note number (pitch).
For other event types, this is the value of the event.

Data 2 The property of this value depends on the type of MIDI 
event:
For notes, this is the note-on velocity.
For Controller events, this is the value of the event.
For Pitch Bend events, this is the coarse bend amount.
For Poly Pressure events, this is the amount of pressure.
For other event types, this is not used.

Channel The event’s MIDI Channel. See “Notes” on page 81.

Comment This column is used for some event types only, providing 
an additional comment about the event.
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The list columns for MIDI parts:

For SysEx (system exclusive) events, you can only edit 
the position (Start) in the list.
However, clicking the Comment column opens the SysEx Editor, in which 
you can perform detailed editing of system exclusive events. For a descrip-
tion of this, see “Working with System Exclusive messages” on page 410.

Filtering MIDI events

When you are editing MIDI in the Project Browser, the 
large number of different MIDI events displayed can make 
it hard to find your way. To remedy this, the Filter pop-up 
menu allows you to select a single event type for display.

When this option is selected, only Program Change events will be 
shown in the event display. To show all event types, select the top
item (“---”) from the menu.

Creating MIDI parts

When a MIDI track is selected in the Project Structure list, 
you can create empty MIDI parts on the track by clicking 
the Add button. This will insert a part between the left and 
right locator.

Creating MIDI events

You can use the Project Browser to create new MIDI 
events:

1. Select a MIDI part in the Project Structure list.

2. Move the project cursor to the desired position for the 
new event.

3. Use the Add pop-up above the event display to select 
which type of MIDI event to add.

4. Click the Add button.
An event of the selected type is added to the part, at the project cursor 
position. If the cursor is outside the selected part, the event is added at 
the beginning of the part.

Editing Automation tracks
All kinds of Nuendo automation (the automation subtracks 
for MIDI, instrument, audio, group and FX channel tracks 
or the individual automation tracks for VST Instruments, 
ReWire channels or Input/Output busses) are handled in 
the same way in the Project Browser. Each Automation 
item in the Project Structure list will have a number of sub-
entries, one for each automated parameter. Selecting one 
of these parameters in the Project Structure list shows its 
automation events in the list:

You can use the two columns in the list to edit the position 
of the events and their values.

Parameter Description

Name The name of the part.

Start The start position of the part. Editing this value is the 
same as moving the part.

End The end position of the part. Changing this is the same as 
resizing the part (and will automatically affect the Length 
value as well).

Length The length of the part. Changing this resizes the part and 
automatically changes the End value.

Offset This adjusts the start position of the events within the 
part. Adjusting this value is the same as sliding the con-
tents of the part in the Project window (see “Sliding the 
contents of an event or part” on page 49). Setting a pos-
itive Offset value is the same as sliding the contents to 
the left, while a negative Offset corresponds to sliding 
the contents to the right.

Mute Click in this column to mute or unmute the part.
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Editing the Video track
When the Video track is selected in the Project Structure 
list, the event display lists the video events on the track, 
with the following parameters:

Editing the Marker track
Marker events have the following parameters:

When the Marker track is selected, you can insert markers 
by selecting “Marker” or “Cycle Marker” from the Add 
pop-up menu and clicking the Add button. Regular mark-
ers will be added at the current project cursor position 
while cycle markers will be added between the current left 
and right locator positions.

Editing the Tempo track
When the Tempo track is selected in the Project Structure 
list, the event display shows the events on the Tempo 
track, with the following parameters:

You can add new Tempo events by clicking the Add button. 
This creates a jump-type event with the value 120 bpm at 
the project cursor position. Make sure that there is no other 
tempo event at the current cursor position.

Editing Time Signatures
When “Signature track” is selected in the Project Struc-
ture list, the event display shows the Time Signature 
events in the project:

You can add new Time Signature events by clicking the 
Add button. This creates a 4/4 event, at the beginning of 
the bar closest to the project cursor position. Make sure 
that there is no other time signature event at the current 
cursor position.

Deleting Events
The procedure for deleting Events is the same for all dif-
ferent track types:

1. Click on an event (or a part) in the Event display to se-
lect it.

2. Select Delete from the Edit menu or press [Delete] or 
[Backspace].

Column Description

Name The name of the video clip that the event refers to.

Start The start position of the event. Editing this value is the 
same as moving the event.

End The end position of the event. Editing this value is the 
same as resizing the event, and will automatically change 
the Length value as well.

Length The length of the event. Editing this value is the same as 
resizing the event, and will automatically change the End 
value as well.

Offset This determines “where in the video clip” the event starts.
Note that the event cannot start before the start of the 
clip, or end after the end of the clip. Thus, if the event al-
ready plays the whole video clip, the Offset cannot be 
adjusted at all.

Column Description

Name The name of the marker. This can be edited for all mar-
kers except the left and right locator.

Start The position of “regular” markers or the start position of 
cycle markers.

End The end positions of cycle markers. Editing this value is 
the same as resizing the cycle marker, and will automati-
cally change the Length value as well.

Length The length of cycle markers. Editing this value is the same 
as resizing the marker, and will automatically change the 
End value as well.

ID The number of the marker. For regular (non-cycle) mar-
kers, this corresponds to the key commands used for 
navigating to the markers. For example, if a marker has 
ID 3, pressing [Shift]+[3] on the computer keyboard will 
move the song position to that marker. By editing these 
values, you can assign the most important markers to key 
commands.
Note that you cannot edit the “L” and “R” marker IDs (left 
and right locator) or assign IDs 1 and 2 to markers (since 
these are reserved for the locators).

Parameter Description

Position The position of the Tempo event. You cannot move the 
first event on the Tempo track.

Tempo The tempo value of the event.

Type This indicates whether the tempo should jump to the 
value of the event (“Jump” type) or whether it should 
change gradually from the previous Tempo event, creat-
ing a ramp (“Ramp” type). See “Editing the tempo curve” 
on page 417.

Parameter Description

Position The position of the event. Note that you cannot move the 
first Time Signature event.

Signature The value (time signature) of the event. 

! Note that you cannot delete the first Tempo event or 
the first Time Signature event.
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Overview
The Track Sheet provides a text-form “flow-chart” repre-
sentation of the Project. It lists all audio (and video) tracks 
and their contents, and can easily be printed out. 

To open the Track Sheet window, select “Track Sheet” 
from the Project menu.

The actual Track Sheet is displayed in the lower part of the 
window. It contains the following items:

• The leftmost time column contains a list of time positions 
in the display format selected in the Project Setup dialog.
The time positions relate to start and end times of audio or video events 
or parts on the tracks.

• The following columns display the tracks in the order 
they appear in the Track list.
Only audio and video tracks are shown.

• The events are listed in their corresponding track col-
umns in the order they appear (starting at the top).

• For each event, the start and end times are shown, with 
a vertical line binding the two together.

Viewing the pages in the Track Sheet
If your project is large (i.e. there are many tracks and/or 
many events) or if you are working with a large scale factor 
(see below), the resulting Track Sheet may have more 
than one page.

The more tracks you have, the larger the number of pages 
next to each other (horizontally). The more events you 
have, the larger the number of pages below each other.

To select which page should be visible in the Track Sheet 
window, you use the “Y Page” and “X Page” fields in the 
upper left part of the Track Sheet window. You could think 
of the Track Sheet as divided into rows and columns, with 
“Y Page” determining which row should be viewed and “X 
Page” determining the column. The numbers in parenthesis 
show the total number of rows and columns, respectively.

• The size and proportions of the Track Sheet pages are 
set with the Page Setup dialog, see “Printing the Track 
Sheet” on page 436.

In this case, the page in row 2 and column 3 is shown:

X

Y

1 2 3 4

1

2
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Adjusting the view
The two sliders at the bottom of the Track Sheet window 
have the following functionality:

• The slider in the lower left corner is the scale slider.
Use this to adjust the actual size of the Track Sheet contents (including 
the font sizes). This will also affect the number of tracks and events 
shown on each page. 

• The slider in the lower right corner governs the display 
zoom.
This affects how much of the Track Sheet is shown in the Track Sheet 
window – the printout is not affected.

You can also adjust the width of the columns by dragging 
the edges of the “Timecode” and “Tracks” fields at the top 
of the window – this resizes the corresponding columns in 
the Track Sheet.

Resizing the track columns. If the Timecode and Tracks fields are hid-
den, click the “More” button.

Additional settings
• The “Pen Width” determines the thickness of the vertical 
lines that bind together the start and end times for events 
and parts.

• If the Track Sheet is more than one page wide, you can 
use the “Timecode Column” pop-up menu to determine 
whether the time column should appear only on the first 
page, on each new page, or not at all.

The following settings can be shown or hidden by clicking 
the “More/Less” button.

Printing the Track Sheet
Printing is done using the standard procedures:

1. Make sure the correct page size and page orientation 
is selected in the Page Setup dialog on the File menu.
You may also want to make additional printer settings, following the stan-
dard Windows/Mac procedures.

2. Select “Print...” from the File menu.
Make the desired printer settings in the dialog that appears, and click 
OK. The Track Sheet is printed.

Setting Description

Project By default, this is the name of the current project, but you 
can adjust this if you like. The project name will be shown 
in the top left corner of each Track Sheet page.

Editor The editor name you enter will be shown below the 
project name in the Track Sheet.

Heading Allows you to enter a heading (shown centered at the top 
of each Track Sheet page).

Do not show 
end times if
length is under...

If this checkbox is ticked, the Track Sheet will not display 
the end times of Events shorter than the time specified in 
the field to the right. This is useful if you have many short 
events, like spot effects, where only the start time is of 
any relevance.

No leading 
zeroes

By default, the time positions of events will be listed in a 
syntax with “leading zeroes”. E.g. if the display format is 
seconds, hours and minutes will be listed as “01”, “02” 
etc. If this is activated, the time column will not display the 
leading zeroes.

Merge events
if gap is less 
or equal...

If events on a track are lined up end to end – i.e. there is 
no gap between them – they will be considered as a sin-
gle event in the Track Sheet. By defining a value in this 
box, you can specify how large a gap between events has 
to be for them to be considered as separate events. If 
gaps between events are smaller than or equal to the 
value you specify, they will be listed as a single event. 
Otherwise they will be listed as separate events.

Name Filter This allows you to filter out certain event names of your 
choice so that they are not displayed in the Track Sheet. 
Click in the text field and type in the name(s) – to enter 
several names, separate each with a semi-colon (;). Par-
tial names are OK, so if you e.g. want to filter out the 
event name “Crossfade”, you could just write “Cross”. 
However, this would filter out other events starting with 
the word cross as well – e.g. “Crosstalk” would also be 
filtered out.

Setting Description
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Introduction
The Export Audio Mixdown function in Nuendo allows you 
to mix down audio from the program to a file on your hard 
disk, in a number of formats. You can choose to mix down 
one of the following:

• An output bus.
For example, if you have set up a stereo mix with tracks routed to a stereo 
output bus, mixing down that output bus would give you a mixdown file 
containing the whole mix. Similarly, you can mix down a complete surround 
bus, either to a single multi-channel file or to one file per surround channel 
(by activating the split channels option).

• The channel for an audio track.
This will mix down the channel for the track, complete with insert effects, 
EQ, etc. This can be useful for turning a number of events into a single file, 
or if you are using CPU-intensive insert effects – by exporting the track and 
re-importing it into the project you can turn off the insert effect, saving pro-
cessor power.

• Any kind of audio channel in the mixer.
This includes VST Instrument channels, effect return channels (FX Chan-
nel tracks), Group channels and ReWire channels. There are many uses 
for this – for example, you can mix down an effect return track or turn in-
dividual ReWire channels into audio files.

Notes

• The Export Audio Mixdown function mixes down the 
area between the left and right locators.

• When you mix down, you get what you hear – mutes, 
mixer settings and insert effects are taken into account.
Note though that you will only include the sound of the bus or channel 
you select for mixdown.

• MIDI tracks are not included in the mixdown!
To make a complete mixdown containing both MIDI and audio, you first 
need to record all your MIDI music to audio tracks (by connecting the 
outputs of your MIDI instruments to your audio inputs and recording, as 
with any other sound source).

• A single instrument track can be directly exported as an 
audio mixdown.

• You can also export selected tracks – this is a different 
function that doesn’t create an audio mixdown.
Rather, this is a way to transfer complete tracks (including clips and 
events) from one project to another. See “Importing audio” on page 491.

Mixing down to an audio file
1. Set up the left and right locators to encompass the 
area that you want to mix down.

2. Set up your tracks, so that they play back the way you 
want.
This includes muting unwanted tracks or parts, making manual mixer set-
tings and/or activating the R (Read) automation buttons for some or all 
mixer channels.

3. Pull down the File menu and select “Audio Mixdown…” 
from the Export submenu.
The Export Audio Mixdown dialog appears.

The available settings and options differ depending on the 
selected file format (see “The available file formats” on 
page 439).

4. In the File Location section at the top you can specify 
a name and path for the mixdown file.

Note that there are a number of options:

• Click the Options/Functions button to the right of the File 
Name field to open a pop-up menu.

• Select an entry from the Recent Paths sub-menu to reuse a 
path specified for a previous export.

• Select “Set File Name to Project Name” to use the project 
name for the export file.

• Enable the “Auto Update File Name” option (so that a check 
mark is displayed before it) to add a number to the specified 
file name everytime you click the Export button.



439

Export Audio Mixdown

• Activate the option “Use Project Audio Folder” to specify a 
path. This saves the mixdown file in the Project Audio folder.

5. Select a file format with the File Format pop-up menu.

6. Select the bus or channel you want to mix down with 
the Outputs pop-up menu in the “Audio Engine Output” 
section.
This lists all output busses and channels in the active project.

7. Activate the Split Channels option if you want to ex-
port all channels as mono files, or “Mono Export” if you 
want to export all channels as a single mono file. 

8. Make additional settings for the file to be created.
This includes selecting sample rate, bit depth, etc. The available options 
depend on the selected file format – see “The available file formats” on 
page 439.

9. If you want to automatically import the resulting audio 
file back into Nuendo, activate the checkboxes in the “Im-
port into project” section.
If you activate the “Pool” checkbox, a clip referring to the file will appear 
in the Pool. Activating the “Audio Track” checkbox as well, will create an 
audio event that plays the clip, and place it on a new audio track, starting 
at the left locator.

The Import options are only available if you have se-
lected an uncompressed file format.

10. If you activate Real-Time Export, the export will happen 
in real time, i.e. the process will take the same time as reg-
ular playback.
Some VST plug-ins require this in order to have enough time to update 
correctly during the mixdown – consult the plug-in manufacturers if un-
certain.

• When Real-Time Export is activated, the exported audio 
will be played back via the Control Room.
The fader below the Real-Time Export checkbox allows you to adjust the 
Control Room volume. Note that if the Control Room is deactivated, the 
Audition Volume slider will not be available.

11. If you activate Update Display, the meters will be up-
dated during the export process.
This allows you to check for clipping, for example.

12. Click Export.

A dialog with a progress bar is displayed while the audio file 
is created. If you change your mind during the file creation, 
you can click the Abort button to abort the operation.

• If the option “Close dialog after export” is activated, the 
dialog will be closed, otherwise it will be left open.

• If you have activated any of the “Import into project” op-
tions, the file will be imported back into the project.
When playing back the re-imported file in Nuendo, remember to mute 
the original tracks so that you really hear the correct file.

About the Import options dialog

When you activate any of the options in the Import sec-
tion, the Import Options dialog will open. For a detailed 
description of the options in this dialog see “Import Me-
dium…” on page 306. 

The available file formats
The following pages describe the different export file for-
mats, as well as their options and settings.

• AIFF files (see “AIFF files” on page 439).
• AIFC files (see “AIFC files” on page 440).
• Wave files (see “Wave files” on page 440).
• Wave 64 files (see “Wave64 files” on page 441).
• Broadcast Wave files (see “Broadcast Wave files” on page 

441).
• MP3 files (see “MPEG 1 Layer 3 files” on page 441).
• Ogg Vorbis files (see “Ogg Vorbis files” on page 442).
• Windows Media Audio Pro files (Windows only, see “Win-

dows Media Audio Pro files (Windows only)” on page 442).

AIFF files
AIFF stands for Audio Interchange File Format, a standard 
defined by Apple Inc. AIFF files have the extension “.aif” 
and are used on most computer platforms.

For AIFF files the following options are available:

Option Description

File Name
(File Location 
section)

In this field you can enter a name for the mixdown file.

Path
(File Location 
section)

Here you can specify a path where you want the mix-
down to be saved. 

Use Project 
Audio Folder
(File Location 
section)

If you activate this options the mixdown file is saved in 
the Project Audio folder, as opposed to the specified 
path.

File Format pop-
up menu (File 
Format section)

From this pop-up menu you can select the file format 
for the export, in this case “AIFF File”.
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AIFC files
AIFC stands for Audio Interchange File Format Com-
pressed, a standard defined by Apple Inc. These files sup-
port compression ratios as high as 6:1 and contain tags in 
the header. AIFC files have the extension “.aifc” and are 
used on most computer platforms. 

AIFC files support the same options as AIFF files.

Wave files
Wave files have the extension “.wav” and are the most 
common file format on the PC platform. 

Wave files support the same options as AIFF files.

Insert Broadcast 
Wave Chunk 
(File Format
section)

This allows you to include information about the date 
and time of creation, a timecode position (allowing you 
to insert exported audio at the correct position in other 
projects, etc.) along with author, description and refer-
ence text strings in the exported file. 
Some applications may not be able to handle files with 
embedded info – if you get problems using the file in 
another application, turn off the option and re-export.

Edit button (File 
Format section)

By clicking this button the “Broadcast Wave Chunk” 
dialog opens where you can enter additional informa-
tion that will be embedded in the exported files. Note 
that in the Preferences (Record–Audio–Broadcast 
Wave page) you can enter default text strings for au-
thor, description and reference that will automatically 
be displayed in the “Broadcast Wave Chunk” dialog.

Outputs pop-up 
menu (Audio 
Engine Output 
section)

This menu lists all output busses and channels in the 
active project. Simply select the bus or channel you 
want to mix down.

Mono Export 
(Audio Engine 
Output section)

If you activate this option, the exported audio is mixed 
down to mono.

Split Channels 
(Audio Engine 
Output section)

Activate this option if you want to export all channels 
as mono files.

Real-Time 
Export (Audio 
Engine Output 
section)

If you activate this option, the export will happen in real 
time, i.e. the process will take the same time as regular 
playback. Some VST plug-ins require this in order to 
have enough time to update correctly during the mix-
down – consult the plug-in manufacturers if uncertain. 
When Real-Time Export is activated, the exported au-
dio will be played back via the Control Room.

Update Display
(Audio Engine 
Output section)

If you activate this option, the meters will be updated 
during the export process. This allows you to check for 
clipping, for example. 

Sample Rate 
(Audio Engine 
Output section)

This setting determines the frequency range of the ex-
ported audio – the lower the sample rate, the lower the 
highest audible frequency in the audio. In most cases, 
you should select the sample rate set for the project, 
since a lower sample rate will degrade the audio qual-
ity (mainly reducing the high frequency content) and a 
higher sample rate will only increase the file size, with-
out adding to audio quality. Also consider the future 
usage of the file – if you e.g. plan to import the file into 
another application, you should select a sample rate 
supported by that application.
If you are making a mixdown for CD burning, you 
should select 44.100 kHz, since this is the sample rate 
used on audio CDs.

Option Description

Bit Depth (Au-
dio Engine Out-
put section)

Allows you to select 8, 16, 24 bit or 32 bit (float) files.
If the file is an “intermediate mixdown” that you plan to 
re-import and continue working on in Nuendo, we rec-
ommend that you select the 32 bit (float) option.
32 bit (float) is a very high resolution (the same resolu-
tion as used internally for audio processing in Nuendo), 
and the audio files will be twice the size of 16 bit files.
If you are making a mixdown for CD burning, you should 
use the 16 bit option, as CD audio is always 16 bit.
In this case, we recommend that you activate the UV-
22HR dithering plug-in (see the separate manual “Nu-
endo Expansion Kit – Cubase Music Tools for Nuendo 
4” for details). This reduces the effects of quantization 
noise and artifacts from being introduced when con-
verting the audio down to 16 bit.
8 bit resolution should only be used if required, since it 
will result in limited audio quality. 8 bit audio may be 
suitable in some multimedia applications, etc.

Audition Volume 
fader (Audio 
Engine Output 
section)

The fader below the Real-Time Export checkbox al-
lows you to adjust the Control Room volume. Note that 
this fader is only available if the Control Room is acti-
vated.

Pool (Import into 
project section)

Activate this option if you want to import the resulting 
audio file automatically back into the Pool. A clip refer-
ring to the file will appear in the Pool. 
If this option is activated, the Import Options dialog ap-
pears on export. For a description of the available set-
tings, see “Import Medium…” on page 306.

Audio Track 
(Import into 
project section)

If you activate this option, an audio event that plays the 
clip will be created and placed on a new audio track, 
starting at the left locator.
If this option is activated, the Import Options dialog ap-
pears on export. For a description of the available set-
tings, see “Import Medium…” on page 306.

Close dialog 
after export

If this option is activated, the dialog will be closed after 
the export, otherwise it will be left open.

Option Description
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Wave64 files
Wave64 is a proprietary format developed by Sonic 
Foundry Inc. In terms of audio quality, Wave64 files are 
identical to standard wave files, but in the file headers 
Wave64 files use 64-bit values for addressing where wave 
files use 32-bit values. The consequence of this is that 
Wave64 files can be considerably larger than standard 
Wave files. Wave64 is therefore a good file format choice 
for really long recordings (file sizes over 2GB), e.g. live sur-
round recordings. Wave64 files have the extension “.w64”.

Wave64 files support the same options as AIFF files.

Broadcast Wave files
Concerning audio, Broadcast Wave files are the same as 
regular Wave or Wave64 files, but without compression. To 
create a Broadcast Wave file, select either Wave or 
Wave64 as the file format and activate the Insert Broadcast 
Wave Chunk option. Click Edit if you wish to edit the chunk 
information, otherwise the defaults as specified in the Pref-
erences (Record–Audio–Broadcast Wave page) will be 
used. Broadcast Wave files have the extension “.wav”.

Broadcast Wave files support the same options as AIFF 
files.

MPEG 1 Layer 3 files
MPEG 1 Layer 3 files have the extension “.mp3”. By use of 
advanced audio compression algorithms, mp3 files can be 
made very small, maintaining good audio quality.

For MPEG 1 Layer 3 files the following options are avail-
able:

Option Description

File Name
(File Location 
section)

In this field you can enter a name for the mixdown file.

Path
(File Location 
section)

Here you can specify a path where you want the mix-
down to be saved. 

Use Project 
Audio Folder
(File Location 
section)

If you activate this option, the mixdown file is saved in 
the Project Audio folder, as opposed to the specified 
path.

File Format pop-
up menu (File 
Format section)

From this pop-up menu you can select the file format 
for the export.

Bit Rate fader 
(File Format 
section)

By moving this fader, you can select a bit rate for the 
mp3 file. As a rule, the higher the bit rate, the better the 
audio quality and the larger the file. For stereo audio, 
128kBit/s is often considered to result in “good” audio 
quality.

Sample Rate 
pop-up (File For-
mat section)

In this pop-up menu you can select a Sample Rate for 
the mp3 file.

Insert ID3 Tag 
option (File For-
mat section)

This allows you to include ID3 Tag information in the 
exported file. 

Edit ID3 Tag 
button (File For-
mat section)

When you click this, the ID3 Tag dialog opens, in 
which you can enter information about the file. This ad-
ditional information will be embedded as text strings in 
the file, and can be displayed by some mp3 playback 
applications.

Outputs pop-up 
menu (Audio 
Engine Output 
section)

This menu lists all output busses and channels in the 
active project. Simply select the bus or channel you 
want to mix down.

Mono Export 
(Audio Engine 
Output section)

If you activate this option, the exported audio is mixed 
down to mono.

Split Channels 
(Audio Engine 
Output section)

Activate this option if you want to export all channels 
as mono files.

Real-Time 
Export (Audio 
Engine Output 
section)

If you activate this option, the export will happen in real 
time, i.e. the process will take the same time as regular 
playback. Some VST plug-ins require this in order to 
have enough time to update correctly during the mix-
down – consult the plug-in manufacturers if uncertain. 
When Real-Time Export is activated, the exported au-
dio will be played back via the Control Room.

Update Display
(Audio Engine 
Output section)

If you activate this option, the meters will be updated 
during the export process. This allows you to check for 
clipping, for example. 

Audition Volume 
fader (Audio 
Engine Output 
section)

The fader below the Real-Time Export checkbox allows 
you to adjust the Control Room volume. Note that this 
fader is available only if the Control Room is activated.

Close dialog 
after export

If this option is activated, the dialog will be closed after 
the export, otherwise it will be left open.

Option Description
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Ogg Vorbis files
Ogg Vorbis is an open source, patent-free audio encoding 
and streaming technology, offering compressed audio files 
(extension “.ogg”) of small size, but with comparatively high 
audio quality.

For Ogg Vorbis files the following options are available:

Other file formats
Steinberg also offers optional Dolby Digital (AC3) and 
DTS encoders for export directly to AC3 or DTS format. 
Please go to www.steinberg.net for more information.

Windows Media Audio Pro files (Windows only)
This is a continuation of the Windows Media Audio format 
developed by Microsoft Inc. Due to the advanced audio co-
decs and lossless compression used, WMA Pro files can 
be decreased in size with no loss of audio quality. Further-
more, WMA Pro features the possibility of mixing down to 
5.1 surround sound. The files have the extension “.wma”.

Exporting a WMA mixdown

Depending on the chosen output, not all options may 
be shown.

Option Description

File Name
(File Location 
section)

In this field you can enter a name for the mixdown file.

Path
(File Location 
section)

Here you can specify a path where you want the mix-
down to be saved. 

Use Project Au-
dio Folder
(File Location 
section)

If you activate this option, the mixdown file is saved in 
the Project Audio folder, as opposed to the specified 
path.

File Format pop-
up menu (File 
Format section)

From this pop-up menu you can select the file format 
for the export.

Quality fader 
(File Format 
section)

The Ogg Vorbis encoder uses variable bit rate encod-
ing, and the Quality setting determines between which 
limits the bit rate will vary. Generally speaking, the 
higher the Quality setting, the higher the sound quality 
but also the larger the files.

Outputs pop-up 
menu (Audio En-
gine Output sec-
tion)

This menu lists all output busses and channels in the 
active project. Simply select the bus or channel you 
want to mix down.

Mono Export 
(Audio Engine 
Output section)

If you activate this option, the exported audio is mixed 
down to mono.

Split Channels 
(Audio Engine 
Output section)

Activate this option if you want to export all channels 
as mono files.

Real-Time Ex-
port (Audio En-
gine Output 
section)

If you activate this option, the export will happen in real 
time, i.e. the process will take the same time as regular 
playback. Some VST plug-ins require this in order to 
have enough time to update correctly during the mix-
down – consult the plug-in manufacturers if uncertain. 
When Real-Time Export is activated, the exported au-
dio will be played back via the Control Room.

Update Display
(Audio Engine 
Output section)

If you activate this option, the meters will be updated 
during the export process. This allows you to check for 
clipping, for example. 

Audition Volume 
fader (Audio En-
gine Output sec-
tion)

The fader below the Real-Time Export checkbox al-
lows you to adjust the Control Room volume. Note that 
this fader is available only if the Control Room is acti-
vated.

Close dialog af-
ter export

If this option is activated, the dialog will be closed after 
the export, otherwise it will be left open.
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The following options are available:

General tab

In the Input Stream section, you set the sample rate (44.1, 
48 or 96 kHz) and the bit resolution (16 bit or 24 bit) of the 
encoded file. These should be set to match the sample rate 
and bit resolution of the source material. If no value matches 
that of your source material, use the closest available value 
that is higher than the actual value. E.g. if you’re using 20 bit 
source material, set the bit resolution to 24 bit rather than 
16 bit.

The setting in the Channels field depends on the cho-
sen output and cannot be changed manually. 

The settings in the Encoding Scheme section are used for 
defining the desired output from the encoder, e.g. whether 
it should be a stereo file or a 5.1 surround file. Make set-
tings appropriate for the intended use of the file. If the file 
will be downloaded or streamed on the Internet, you might 
not want too high bit rates, for example. See below for de-
scriptions of the options.

• Mode

The WMA Pro encoder can use either a constant bit rate 
or a variable bit rate for encoding to 5.1 surround, or it can 
use lossless encoding for encoding to stereo. The options 
on this menu are as follows:

• Bit Rate/Quality

This menu allows you to set the desired bit rate. The avail-
able bit rate settings vary depending on the selected 
mode and/or output channels (see above). If the Mode 
“Variable Bitrate with Quality” is used (see above), the 

menu allows you to select from various levels of desired 
quality, with 10 being the lowest and 100 the highest. 
Generally, the higher the bitrate or quality you select, the 
larger the final file will be. The menu also shows the chan-
nel format (5.1 or stereo).

Advanced tab

• Dynamic Range Control

These controls allow you to define the dynamic range of 
the encoded file. The dynamic range is the difference in 
dB between the average loudness and the peak audio 
level (the loudest sounds) of the audio. These settings af-
fect how the audio is reproduced if the file is played on a 
Windows XP computer with a player from the Windows 
Media series, and the user activates the special “Quiet 
Mode” feature of the player to control the dynamic range.

The dynamic range is automatically calculated during the 
encoding process, but you can specify it manually as well.

If you want to manually specify the dynamic range, first put 
a checkmark in the box to the left by clicking in it, and then 
enter the desired dB values in the Peak and Average 
fields. You can enter any value between 0 and -90dB. 
Note, however, that it is usually not recommended to 
change the Average value, since it affects the overall vol-
ume level of the audio and therefore can affect the audio 
quality adversely.

The Quiet Mode in a Windows Media player can be set to 
one of three settings. Below, these settings are listed to-
gether with an explanation of how the Dynamic Range set-
tings affect them:

• Off: If Quiet Mode is off, the dynamic range settings that were 
automatically calculated during the encoding will be used.

• Little Difference: If this is selected and you have not manually 
changed the dynamic range settings, the peak level will be 
limited to 6dB above the average level during playback. If you 
have manually specified the dynamic range, the peak level will 
be limited to the mean value between the peak and average 
values you specified.

• Medium Difference: If this is selected and you have not manu-
ally changed the dynamic range settings, the peak level will be 
limited to 12dB above the average level. If you have changed 
the dynamic range, the peak level will be limited to the peak 
value you specified.

Mode Description

Constant Bitrate This will encode to a 5.1 surround file with a constant 
bit rate (set in the Bit Rate/Channels menu, see be-
low). Constant bit rate is preferably used if you want to 
limit the size of the final file. The size of a file encoded 
with a constant bit rate is always the bit rate times the 
duration of the file.

Variable Bitrate Encodes to a 5.1 surround file with a variable bit rate, 
according to a quality scale (the desired quality is set 
in the Bit Rate/Channels menu, see below). When you 
encode with variable bit rates, the bit rate fluctuates 
depending on the character and intricacy of the mate-
rial being encoded. The more complex passages in the 
source material, the higher the bit rate – and the larger 
the final file.

Lossless Encodes to a stereo file with lossless compression.
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• Surround Reduction Coefficients

Here you can specify which amount of volume reduction, if 
any, should be applied to the different channels in a sur-
round encoding. These settings affect how the audio is re-
produced on a system incapable of playing back the file in 
surround, in which case the surround channels of the file 
will be combined into two channels and played back in 
stereo instead.

The default values will normally produce satisfactory re-
sults, but you can change the values manually if you wish. 
You can enter any value between 0 and -144dB for the 
surround channels, the center channel, the left and right 
channels and the LFE channel respectively.

Media tab

In these fields you can enter a number of text strings with 
information about the file – title, author, copyright informa-
tion and a description of its contents. This information will 
then be embedded in the file header and can be displayed 
by some Windows Media Audio playback applications.

For more information about surround sound and en-
coding, see the chapter “Surround sound” on page 202.
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Background

What is synchronization?
Synchronization is said to exist when you make two pieces 
of equipment agree on time or tempo and position info. 
You can establish synchronization between Nuendo and a 
number of other types of devices, including tape recorders 
and video decks, but also MIDI devices that “play back”, 
such as other sequencers, drum machines, “workstation 
sequencers” etc.

When you set up a synchronization system, you must de-
cide which unit is the master. All other devices are then 
slaved to this unit, which means they will adjust their play-
back speed to the master’s.

Nuendo as slave

When a synchronization signal is coming in to Nuendo from 
another device, this device is the master and Nuendo is the 
slave. Nuendo will adjust its playback to the other device.

Nuendo as master

When you set up Nuendo to transmit synchronization in-
formation to other devices, Nuendo is the master and the 
other devices are the slaves; they will adjust their playback 
to Nuendo.

Nuendo – both master and slave

Nuendo is a very capable synchronization device. It can 
operate as both a master and a slave at the same time. For 
example, Nuendo might be slaved to a tape recorder 
transmitting timecode, while at the same time transmitting 
MIDI Clock to a drum machine, acting as a master for that.

Synchronization signals
Basically there are three types of synchronization signals 
for audio: timecode, MIDI clock and word clock.

Timecode (SMPTE, EBU, MTC, VITC etc.)
Timecode appears in a number of guises. No matter which 
“format” it has, it always supplies a “clock on the wall” 
type of synchronization, that is, a synchronization related 
to hours, minutes, seconds and two smaller units called 
“frames” and “subframes”.

• LTC (SMPTE, EBU) is the audio version of timecode. This 
means that it can be recorded on the audio track of an audio 
or video recorder.

• VITC is the video format timecode, i.e. it is stored in the actual 
video image.

• MTC is the MIDI version of timecode, transmitted via MIDI ca-
bles.

• ADAT sync (Alesis) is only used with the ASIO Positioning 
Protocol, see “About the ASIO Positioning Protocol (APP)” on 
page 452.

• Sony 9-pin is a standard that uses serial (RS-422) communi-
cation. Sony 9-Pin contains timecode as well as machine con-
trol messages (see “Setting up Sony 9-Pin” on page 457).

For the ASIO Positioning Protocol, other high precision 
timecode formats may also be supported.

Format recommendations for timecode – without ASIO 
Positioning Protocol

• When synchronizing your system to external timecode, via a 
synchronizer, the most common timecode format is MTC. 
Contrary to some reports you might have heard, MTC delivers 
good precision for external sync. This is due to the fact that 
the operating system can “time stamp” incoming MIDI mes-
sages, which increases precision.

• Sony 9-Pin is not recommended for external sync and should 
only be used when no other option is available. However, you 
might of course use 9-Pin for machine control, see “Sony 9-
Pin” on page 455.

! For a description of the VST System Link feature 
(with which you can synchronize separate computers 
running Nuendo or Cubase for example), see “Wor-
king with VST System Link” on page 460.
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Format recommendations for timecode – with ASIO 
Positioning Protocol

• LTC and VITC are the formats with the highest precision and 
are recommended when available.

• MTC is the next best option and probably the most common 
choice, since few audio hardware solutions have built-in LTC 
or VITC readers. However, LTC and VITC offer even higher 
precision when available.

• The choice with the least precision is Sony 9-Pin.

MIDI Clock
MIDI Clock is a tempo-based type of synchronization sig-
nals, i.e. it is related to the number of “beats per minute”. 
MIDI Clock signals are suitable for synchronizing two de-
vices that agree on tempo, such as for example Nuendo 
and a drum machine.

Word Clock
Word clock is basically a replacement for the sample rate 
clock in for example an audio card. Word clock hence 
runs at the same rate as the sample rate in the audio, 
44.1kHz, 48kHz etc.

Word clock does not contain any position information, it is 
only a “simple” signal for clocking the audio at its sample 
rate.

Word clock comes in many formats, analog on coaxial ca-
ble, digital as part of an S/PDIF, AES/EBU or ADAT audio 
signal, etc.

Synchronizing the transport vs. 
synchronizing audio

How timing is handled in a non-synchronized 
system
Let’s first look at the situation where Nuendo is not syn-
chronized to any external source:

Any digital playback system has an internal clock that ulti-
mately affects the playback speed and stability, and PC au-
dio hardware is no exception. This clock is extremely stable.

When Nuendo is playing back with no external synchroni-
zation, all playback is internally synchronized to the inter-
nal digital audio clock.

Synchronizing Nuendo’s playback
Let’s assume now that we use external timecode synchro-
nization with Nuendo. For example, we might synchronize 
playback to a tape recorder.

Timecode coming from an analog tape recorder will al-
ways vary slightly in speed. Different timecode generators 
and different tape recorders will also supply timecode with 
slight differences in speed. In addition, the shuttling of 
tape mechanisms due to overdubs and re-recordings can 
cause the physical tape to wear and stretch, which affects 
the speed of the timecode.

If you use a synchronizer that generates word clock and 
set up Nuendo to sync to incoming timecode, it will vary 
its overall playback speed to compensate for such fluctu-
ations in the speed of the timecode – that’s the whole pur-
pose of synchronization.

What happens with the digital audio?
The fact that Nuendo’s playback is synchronized to the 
timecode does not affect the playback of the digital audio. 
It still relies on the perfectly stable, built-in clock in the au-
dio hardware.

As might be expected, problems will appear when the per-
fectly stable digital audio gets related to the slightly vary-
ing speed of a system synchronized to timecode.

The playback timing of each event will not be in total ac-
cordance with the tape or the MIDI playback, since the 
playback speed of the audio is determined by the digital 
audio hardware’s built-in clock.

! MIDI Clock is not suitable as a master sync source 
for an application like Nuendo. Therefore Nuendo will 
transmit MIDI Clock signals to other devices, but it 
will not receive MIDI Clock.
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Resolving to word clock
The solution to this problem is to use one external clock 
for all components in the system. One master clock is 
used to derive whatever type of clock signal each compo-
nent in the system needs. For example, something called a 
house clock can be used to generate sample rate clocks 
for the digital audio hardware and timecode for Nuendo. 
This ensures that all components in the system use the 
same reference source for their timing.

Synchronizing digital audio to external clocks running at 
sample rate is often called “resolving” or “synchronizing to 
word clock”.

If you aim to perform synchronization to external signals, 
we strongly recommend that you obtain proper synchroni-
zation equipment. This encompasses:

• An audio card that can be slaved to external word clock.
• A synchronizer that can read timecode (and possibly house 

clock) and generate the required sync signals from that, such 
as the Steinberg TimeLock Pro.

or...

• An audio system with complete built-in synchronization possi-
bilities, preferably supporting the ASIO Positioning Protocol, 
see “About the ASIO Positioning Protocol (APP)” on page 452.

Using timecode without word clock
Of course, it is possible to set up a synchronization sys-
tem where you lock Nuendo to timecode without using 
word clock. However, please note that the timing of audio 
vs. MIDI cannot be guaranteed and that fluctuations in 
speed in the incoming timecode will not affect the play-
back of audio events. This means that synchronizing to 
timecode may work in the following situations:

• When the timecode was originally generated by the au-
dio card itself.

• When the source providing the timecode is extremely 
stable (such as a digital video system, a digital tape re-
corder or another computer).

• When you remain synchronized to that same stable 
source throughout the entire process, both while record-
ing and playing back audio.

Making basic settings and 
connections

Setting the Frame Rate
The frame rate is the number of frames per second in a film 
or on a video tape. Just as there is always sixty seconds to 
a minute, there is always a certain number of frames to 
each second. However, the frame rate used varies with the 
type of media (film or video), which country the video tape 
has been produced in, and other circumstances.

In the Project Setup dialog are two settings for frame rates:

• The Frame Rate pop-up is automatically adjusted to the 
frame rate of the incoming timecode.
There is an exception to this when you are synchronizing Nuendo to MIDI 
Timecode: If you have selected 29.97 fps or 30 dfps as Frame Rate in 
Nuendo, this selection will be kept, since these frame rates are not in-
cluded in the MTC format.

The following frame rates are available:

• The Display Format pop-up contains a number of for-
mats that when selected work as the “master” setting for 
the display format used in the various windows’ rulers and 
position displays.
The item “60 fps (user)” on this menu represents a user definable frame 
rate. To make editing with frame accuracy correspond to the actual frame 
rate in an external sync source, you need to set this frame rate to the 
same value as the Frame Rate pop-up.

Frame Rate Description

24 fps The traditional frame rate of 35mm film.

25 fps The frame rate used for all video and audio in Europe 
(EBU).

29.97 fps Straight 29.97 frames per second.

30 fps Straight 30 frames per second. This is often used in the 
United States for audio only work.

29.97 dfps “Drop frame” code running at 29.97 frames per second, 
most often used in the United States of America for work 
with color video.

30 dfps Very rarely used.

23.976 fps Frame rate used for HDTV.

24.976 fps Frame rate used for HDTV.

59.94 fps Frame rate used for HDTV.

60 fps Frame rate used for HDTV.
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Proceed as follows:

1. Open the Preferences dialog (accessed from the File 
menu under Windows or the Nuendo menu on the Mac) 
and select the Transport page.

2. Enter the desired frame rate under “User Definable 
Framerate”.
Either type the desired value directly or use the arrow buttons to in-
crease/decrease the value. You can enter any value between 2-200.

3. When you’re done, click OK to close the dialog and 
save the settings.

The Frame Rate you specified will now be the one used 
when you select the “User” option on the Display Format 
pop-up.

Making connections
The following connections are required for external sync 
via a synchronizer, including resolving of the audio card. 
For details on audio card and synchronizer settings and 
connections, see the manuals for these devices.

• Route the master clock signal (LTC, VITC, etc.) to an in-
put on the synchronizer.

• Connect the word clock output on the synchronizer to a 
word clock input on the audio card.

• Connect the MIDI Timecode (MTC) or 9-Pin output on 
the synchronizer to the corresponding input on the com-
puter.

• Set up the synchronizer and make sure the frame rate 
settings are in accordance with the master clock.

A typical synchronization setup.

Synchronization settings
In the following sections, you will find a description of how 
to set up your system for the different timecode sources:

Internal Timecode
In this mode, Nuendo is the master. When working with 
MMC (see “MIDI Machine Control (MMC)” on page 454), 
the external device gives the start and stop signals, but is 
synchronized by Nuendo.

Use the “MIDI Timecode Destinations” and “MIDI Clock 
Destinations” sections to specify which devices should be 
slaved to Nuendo.

Synchronizing other Equipment to Nuendo

You may have other MIDI devices that you want to syn-
chronize to Nuendo. There are two types of synchroniza-
tion that Nuendo can transmit: MIDI Clock and MIDI 
Timecode.

Transmitting MIDI Clock

If you transmit MIDI Clock to a device supporting this type 
of synchronization signal, the other device will follow Nu-
endo’s tempo. The tempo setting in the other device is of 
no relevance. Instead, it plays at the same tempo as Nu-
endo. If the device also reacts to Song Position Pointers 
(which Nuendo transmits) it will follow when you wind, re-
wind and locate using the Nuendo Transport panel.

MIDI Clock transport commands include “Start”, 
“Stop” and “Continue”. However, some MIDI equipment 
(e.g. some drum machines) do not recognize the “Con-
tinue” command. If this is the case with your equipment, 
activate the option “Always Send Start Message” in the 
Project Synchronization Setup dialog (for the MIDI Clock 
Destinations).
When this is activated, only the Start command is used.



450

Synchronization

• Activate “MIDI Clock Follows Project Position” if you 
want the other device to follow when you loop, jump and 
locate during playback.
When this is activated, the sent MIDI Clock signals will follow the se-
quencer time and tempo position at all times.

Transmitting MIDI Timecode

If you transmit MIDI Timecode to a device supporting this 
type of synchronization signal, the device will synchronize 
time-wise to Nuendo, that is, the time displays on Nuendo’s 
Transport panel and on the other device will agree. When 
you wind and locate Nuendo and then activate playback, 
the other device will follow from the same position (if it has 
this capability and is set up for it!).

If you want to be able to loop, jump and locate during 
playback in Nuendo and have the other device follow, ac-
tivate “MIDI Timecode Follows Project Time”.
When this is activated, the sent MIDI Timecode will follow the sequencer 
time position at all times.

Setting Up

1. Connect the desired MIDI Outputs from Nuendo to the 
device(s) that you plan to synchronize.

2. Open the Project Synchronization Setup dialog from 
the Transport menu.

3. Activate the sync outputs by using the corresponding 
checkboxes.
You can output any combination of MIDI Timecode and MIDI Clock to 
any combination of outputs (however, you probably don’t want to send 
MTC and MIDI Clock to the same output).

4. Set the other device(s) to their “external synchroniza-
tion” mode (or some other mode with a similar name) and 
activate playback on them if necessary.

5. Activate playback in Nuendo, and the other device(s) 
will follow.

! Please note that some external devices may not react 
smoothly to these repositioning messages. Espe-
cially when working with some older devices, it may 
take some time for them to synchronize accurately to 
the project time.

Timecode Source settings

Input and Output for MIDI 
Machine Control messages.

! Some MIDI interfaces will automatically send MIDI 
Clock to all MIDI outputs, regardless of the MIDI 
Clock Port selection in Nuendo. If this is the case, 
you should only select one MIDI Clock Port (consult 
the documentation of the MIDI Interface if in doubt).

MIDI Timecode transmitted to this output.

MIDI Clock transmitted to this output.
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MIDI Timecode and 9 Pin Sync
In these modes, Nuendo is the slave and the timecode is 
sent by the MIDI Timecode Source specified in the corre-
sponding section.

Setting up Nuendo for external sync to timecode

1. In the Project Synchronization Setup dialog, set the 
Timecode Source to MIDI Timecode or one of the 9-Pin 
options.

2. For MIDI Timecode, use the MTC Input pop-up menu 
in the MIDI Timecode Settings section to select an input 
for the timecode.

Sync settings for MIDI Timecode.

3. For Sony 9-pin timecode, select a port from the Serial 
Port pop-up menu. See “Setting up Sony 9-Pin” on page 
457 for more on connecting 9-pin devices to your com-
puter.

4. Close the Project Synchronization Setup dialog and 
open the Project Setup dialog from the Project menu.

5. Use the Start value to set which frame on the external 
device (e.g. a video tape) should correspond to the begin-
ning of the project.
Most video projects have a program start time of 01:00:00:00 for conve-
nience. It is recommended in most cases to have a project start time of 
00:59:00:00 to allow for synchronizer lockup times, test tones, timing 
beeps and so forth.

• You can also set this with the function “Set Timecode at 
Cursor” on the Project menu.
This is useful if you know that a certain position in your project would co-
incide with a certain timecode position in the external device. Move the 
project cursor to the desired position, select “Set Timecode at Cursor” 
and specify the corresponding timecode position in the dialog that ap-
pears – the Start value is adjusted accordingly.

6. In the dialog that appears, you are asked if you want to 
keep the project content at its timecode positions. Select 
“No”.
This will make all events and parts keep their positions relative to the 
project start. 

7. Close the Project Setup dialog.

8. On the Transport panel, activate the Sync button (or 
select “Use External Sync” from the Transport menu).

9. Start the tape (or video, or other master device) that 
contains the timecode. Nuendo starts playing when it re-
ceives timecode with a position “higher” than, or equal to, 
the project Start frame.

You can wind the device that sends the timecode to any 
position and start from there.

You should also look into the Sync Options, see “Time-
code Preferences” on page 454.

Sync to timecode activatedThe MIDI Input for the timecode

Sync to 9-Pin activatedSelecting a serial port

! When the master device with the timecode is 
stopped, you can use the Nuendo transport controls 
as you normally do, when it is not synchronized. 

Set this to the time-
code position where 
you want the project 
to start.
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The Sync indicator

On the Transport panel, you can check the status of in-
coming timecode by observing the sync indicator.

• If you have selected MIDI Timecode as Timecode 
Source and MIDI Machine Control as Machine Control 
Option, the sync indicator switches between “Offline” (not 
waiting for sync), “Idle” (ready for sync but no signal is 
coming in), and “Lock xx” (where xx is indicating the frame 
rate of the incoming signal).

• If you have selected one of the 9-pin options as Ma-
chine Control Option, the following applies:

• When the Sync button is activated for the first time, the Sync 
indicator displays the name of the machine.

• When Nuendo is ready for synchronization, but no signal is 
coming in, the Sync indicator reads “Stopped”.

• When the Start button is pressed, the Sync indicator reads 
“Waiting”.

• When Nuendo is locked to timecode (when correct timecode 
was detected and the sequencer is running), “Locked” is dis-
played.

• While shuttling, the Sync indicator displays “Shuttle”.
• When you are rewinding, the Sync indicator reads “REW”.
• During Fast Forward, “FF” is displayed.
• If a communication error occurred, the indicator reads “Time-

out”.
• If the external device is not in Remote mode, the indicator 

reads “Local”.
• If you are using an external tape machine and no tape has 

been inserted, the Sync indicator reads “No Tape”.
• While positioning on the external machine, the Sync indicator 

reads “Locate”.
• While using the Auto Edit function, “Auto Edit” is displayed.

ASIO Audio Device

In this mode, Nuendo is the slave and the synchronization 
signal can be received from another device connected to 
a digital interface of the audio hardware.

About the ASIO Positioning Protocol (APP)

The ASIO Positioning Protocol is a technology that ex-
pands on the type of sync described above and makes 
sample-accurate positioning possible.

When transferring audio digitally between devices, it is im-
portant that synchronization using word clock and time-
code is completely correlated. If not, the audio will not be 
recorded at the exact intended (sample-accurate) position, 
which can cause various types of problems, such as inac-
curately positioned audio material, clicks and pops etc.

A typical situation is when transferring material from a dig-
ital multi-track tape recorder to Nuendo (for editing) and 
then back again. If you do not have sample-accurate syn-
chronization set up, you cannot be sure that the material 
will appear in its exact original position, when transferred 
back to the tape recorder.

In order to take advantage of the ASIO Positioning Proto-
col, your audio hardware must be suitably equipped and 
the functionality must be included in the ASIO driver for 
the hardware.

An example of a system for doing sample-accurate trans-
fers, would be transferring audio tracks from an Alesis 
ADAT to Nuendo. Here the ADAT will be the sync master 
(though it doesn’t necessarily have to be). It provides both 
the digital audio (with an inherent word clock) and position 
information (timecode) via its ADAT sync protocol. The 
master clock is generated by the ADAT itself.

The Sync indicator

! This option is only available if your hardware is com-
patible with the ASIO Positioning Protocol.

! ASIO Positioning Protocol requires audio hardware 
with specific ASIO drivers.
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Hardware and software requirements for APP

• Your computer audio hardware (in the example above, this 
would be an ADAT card in your computer) must support all 
the functionality required for the ASIO Positioning Protocol. 
That is, it must be able to read the digital audio and the corre-
sponding position information from the external device.

• There must be an ASIO 2.0 driver for the audio hardware.
• For resolving to external timecode, the audio hardware must 

have an integrated timecode reader/generator.
• For information about which audio hardware models currently 

support APP, see the Steinberg web site (www.steinberg.net).

Setting up the audio card for external 
synchronization
1. Open the Device Setup dialog from the Devices menu 
and, on the VST Audio System page, select the name of 
your audio interface.

2. Click the Control Panel button to open the card’s pro-
prietary setup dialog.
If this card is accessed via a special ASIO driver (as opposed to MME or 
Direct X), this dialog is provided by the card, not by Nuendo. Hence the 
settings vary with the card brand and model.

3. Adjust the settings as recommended by the card man-
ufacturer, then close the dialog.
The dialog may also contain various diagnostic tools that allow you to 
verify for example whether word clock is arriving correctly.

4. From the Clock Source pop-up, select the input to 
which you routed the word clock signal.
This pop-up may not be used if you selected an input in the Control 
Panel dialog instead.

You can now set up the synchronization:

1. Open the Project Synchronization Setup dialog and 
set the Timecode Source to “ASIO Audio Device”.

2. Make the desired settings in the dialog.
For information on the different sections, click the Help button in the dialog.

3. Close the Project Synchronization Setup dialog.

4. Open the Project Setup dialog from the Project menu 
and use the Start value to set which frame on the external 
device (e.g. a video tape) should correspond to the begin-
ning of the project.

• You can also set this with the function “Set Timecode at 
Cursor” on the Project menu.
This is useful if you know that a certain position in your project coincides 
with a certain timecode position in the external device. Move the project 
cursor to the desired position, select “Set Timecode at Cursor” and 
specify the corresponding timecode position in the dialog that appears – 
the Start value is adjusted accordingly.

5. A message appears, asking you whether you want to 
keep the project content at its timecode positions. Select 
“No”.
This will make all events and parts keep their positions relative to the 
project start. 

6. Close the Project Setup dialog.

7. On the Transport panel, activate the Sync button (or 
select “Use External Sync” from the Transport menu).

! The ASIO Positioning Protocol exploits the specific 
advantage of having an audio card that has an inte-
grated timecode reader. With such a card and the 
ASIO Positioning Protocol, you can achieve constant 
sample-accurate synchronization between the audio 
source and Nuendo.

The ASIO Audio Device is selected as Timecode Source

Timecode Preferences

Set this to the time-
code position 
where you want the 
project to start.
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8. Start the tape (or video, or other master device) that 
contains the timecode. Nuendo starts playing when it re-
ceives timecode with a position “higher” than, or equal to, 
the project Start frame.

You can wind the device that sends the timecode to any 
position and start from there.

You should also take a look at the Timecode Preferences, 
see “Timecode Preferences” on page 454.

The Sync indicator

On the Transport panel you can check the status of in-
coming timecode by observing the sync indicator. It 
switches between “Offline” (not waiting for sync), “Idle” 
(ready for sync but no signal is coming in), and “Lock xx” 
(where xx indicates the frame rate of the incoming signal).

Timecode Preferences
The following timecode preferences are available in the 
Project Synchronization Setup dialog:

Lock Frames
Using this field you can set how many frames of “correct” 
timecode Nuendo should receive before attempting to 
“lock” (synchronize) to incoming timecode. If you have an 
external tape transport with a very short start-up time, you 
could try lowering this number to make lock-up even faster 
than it already is.

Drop Out Frames
On an analog tape with timecode, dropouts may occur. If 
a drop-out is very long, Nuendo may (temporarily) stop. In 
the Drop Out Frames field you can set how long a drop-
out (in frames) should be tolerated until Nuendo decides 
that the tape isn’t good enough to synchronize to. If you 
have a very stable timecode source, you may lower this 
number to make Nuendo stop more swiftly after the tape 
recorder has been stopped.

Inhibit Restart
Some synchronizers will still transmit MIDI Time Code for 
a short period after an external tape machine has been 
stopped. These extra frames of timecode can sometimes 
cause Nuendo to restart suddenly. Inhibit Restart allows 
you to control the amount of time in milliseconds that Nu-
endo will wait to restart (ignoring incoming MTC) once it 
has stopped.

Machine Control
Nuendo can control external tape transports and similar 
devices via MIDI Machine Control or Sony 9-Pin. This al-
lows you to operate an external tape transport from Nu-
endo’s Transport panel. That is, Nuendo can make the 
tape recorder locate to a certain position, start, stop, re-
wind etc.

About sync and machine control
Controlling tape transports is a two-way process:

• Nuendo sends out machine control commands to the tape re-
corder, asking it to locate to a certain position and activate 
playback etc.

• The tape recorder locates to the requested position, starts 
and delivers timecode back to Nuendo, to which Nuendo is 
synchronized.

Even though it appears as if Nuendo is controlling the 
tape recorder completely, it is important to remember that 
in this setup, Nuendo is still being synchronized to the ex-
ternal tape transport, not vice versa.

Also note that the two processes of sync and machine 
control are completely separated, in terms of protocols 
used. You can for example synchronize to MTC while 
sending out transport commands via MMC.

MIDI Machine Control (MMC)
This is a standard MIDI protocol for controlling tape trans-
ports. There are a number of tape recorders and hard disk 
recording systems on the market that support this proto-
col. Nuendo allows you to control the transport of an ex-
ternal MMC device and arm tracks for recording.

! When the master device with the timecode is 
stopped, you can use the Nuendo transport controls 
as you normally do, when it is not synchronized. 
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Sony 9-Pin
This is a standard protocol established by Sony, for con-
trolling audio and video tape transports. It is implemented 
via regular serial port communication (RS-422). The cor-
rect cabling varies between computer platforms and mod-
els. Please refer to “Connecting a Sony 9-pin compatible 
device” on page 456 to find out more about the correct 
setup for your computer.

• If your Sony 9-pin device supports RS-232, you need a “null 
modem cable”.

• The Sony 9-pin device most likely needs to be switched from 
local control to remote control in order to be controlled by Nu-
endo. If the device is not set to the correct mode, Nuendo will 
inform you. Most video decks have a switch on the front panel 
for this.

• Normally you should not lock Nuendo to timecode from the 
Sony 9-Pin device. There is timecode information in the 9-pin 
signal but it is primarily used for locating and shuttling. It is er-
ratic and not stable enough to use as a timing or speed refer-
ence. Timecode should be read from either an LTC source or 
VITC source on a video tape machine.

• Nuendo implements Start, Stop, Record, Fast-Forward, Re-
wind, Shuttle, Nudge and Locate commands for 9-Pin de-
vices, along with some special features - see “Audio Layback 
for 9-Pin Devices” on page 458.

Setting up Machine Control
Machine Control commands can be sent using one of two 
different protocols: MIDI Machine Control (MMC) or Sony 
9-Pin. The setup procedures are slightly different for the 
two formats:

MIDI Machine Control
1. Set up and test basic timecode synchronization, as de-
scribed earlier in this chapter.

2. Connect a MIDI Out on your MIDI interface to MIDI In 
on the tape recorder (or similar device).
If you have not already done so (when setting up for MIDI Timecode), 
also connect a MIDI cable from the MIDI Output on the tape recorder to 
a MIDI In on the computer.

3. Make sure you have timecode recorded on the tape 
recorder, and that it is set up to use MMC.

4. Open the Project Synchronization Setup dialog on the 
Transport menu in Nuendo.

5. In the Master Machine Control section, select “MIDI 
Machine Control”.

6. In the Master Machine Control Settings section, se-
lect the correct MMC Inputs and Outputs from the re-
spective pop-up menus.

7. Make sure that the MMC Device ID corresponds to 
the ID of the controlled device.
If more that one machine is connected or if you do not know the Device 
ID, this can be set to “All”, the “Broadcast” device ID.

8. Set the “Number of Audio Tracks” setting to the num-
ber of tracks on the external tape recorder.

9. Open the Preferences dialog from the File menu (on 
the Mac, this is located on the Nuendo menu), select the 
MIDI Filter section and make sure Sysex is activated in the 
Thru section.
This is necessary since MMC uses two-way communication (the tape re-
corder “replies” to the MMC messages it receives from Nuendo). By fil-
tering out Sysex Thru, you ensure that these MMC System Exclusive 
replies are not echoed back to the tape recorder.

10. Close the Preferences dialog and open the Project 
Setup dialog from the Project menu.

11. As when synchronizing without using transport con-
trol, use the Start value to specify which frame on the tape 
should correspond to the beginning of the project.

12. Close the Project Setup dialog.

13. Pull down the Devices menu and select MMC Master.
The MIDI Machine Control master transport panel appears.

MIDI Machine Control selected

MIDI ports selected for MMC
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It is now possible to control the external tape recorder in-
dependently or together with Nuendo:

• If you activate the Online button on the MMC Master 
panel you can use the transport buttons on the panel to 
control the transport of the device.

• You can also use the buttons to the left on the MMC 
Master panel to arm tape tracks for recording.
The number of record arm buttons depends on the “Number of Audio 
Tracks” setting in the Master Machine Control Settings section of the 
Project Synchronization Setup dialog.

• The “A1, A2, TC, VD” items refer to additional tracks 
usually found on video tape recorders.
Refer to the manual of your VTR device to see if these tracks are sup-
ported.

• If you activate the Sync button on the Transport panel, 
the MMC Master transport buttons (or the buttons on the 
main Transport panel) will control the external tape re-
corder and Nuendo in sync.

14. On the Transport panel, activate the Sync button.

15. Try to Stop, Fast Forward and Rewind from Nuendo 
and activate Play from different positions in the project.
The tape transport should follow.

• To turn off the synchronization between the tape re-
corder and Nuendo, simply deactivate Sync on the Trans-
port panel.

Nuendo as MMC slave

This is set up in the MIDI Machine Control Slave section. 
Simply specify the MIDI ports and the MMC Device ID.

Some mixers support the MMC-Master protocol for con-
trolling external devices, including Tascam DM-24, Yamaha 
DM2000 and SSL. This means that Nuendo can be used 
as a “recorder”, where track arming and transport com-
mands can be sent from the master device. In addition, 
some digital audio workstations (DAWs) can only operate 
in MMC-Master mode.

Connecting a Sony 9-pin compatible device

On Windows computers

The serial port (9-pin D-SUB connector) of your computer 
is used to establish communication with your Sony 9-pin 
compatible device (VTR, DAT, Multitrack etc.). However, 
PCs provide an RS-232 signal at the serial port, not the 
RS-422 signal expected by Sony 9-pin devices. External 
RS-232 to RS-422 converters are available from various 
manufacturers at your local dealer or can be purchased 
via the internet. If you are planning to cover distances ex-
ceeding a few meters please make sure that this adapter 
also balances the signal.

On Macintosh computers

The serial port of your computer is used to establish com-
munication with your Sony 9-pin compatible device. As 
newer Macintosh computers do not provide serial ports, 
you have to install extra serial ports on these Macintosh 
computers using one of the following methods.

• Stealth Serial Port.
This is a very common device used to provide a serial port 
on Macintosh computers lacking this kind of connectivity. 
This card can be bought in Macintosh stores or via the in-
ternet. It is inserted in the modem slot inside your Macin-
tosh and is recognized by the operating system as a serial 
port. The signal present at the 9-pin D-SUB connector is 
already RS-422 but you need to adapt between the 8-pin 
Mini DIN connector of the Stealth Card and the 9-pin D-
SUB connector found on your Sony 9-pin device using an 
appropriate cable.

• USB to serial adapter.
These USB devices are used to provide a serial port on 
Macintosh computers lacking this kind of connectivity. 
Such devices are available from various manufacturers at 
your local dealer or can be purchased via the internet. 
Make sure to install the driver of the device properly so the 
operating system can register the device as a serial port. 
The Keyspan USB to serial converter USA-19W has been 
used in this capacity with much success.

Depending on the kind of product you are using, the elec-
trical signal available at the 9-pin D-SUB connector of the 
adapter can be either RS-422 or RS-232. Refer to the 
technical specification of the adapter used to find out 
more. If an RS-232 signal is used, you must convert this to 
the RS-422 signal expected by your Sony 9-pin device. 
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External RS-232 to RS-422 converters are available from 
various manufacturers at your local dealer or can be pur-
chased via the internet. If you are planning to cover dis-
tances exceeding a few meters please make sure that this 
adapter also balances the signal.

Setting up Sony 9-Pin

1. Set up and test basic timecode synchronization, as de-
scribed earlier in this chapter.

2. Connect an unused serial port (COM port) on the 
computer to the external tape transport.
As mentioned earlier, you may need a RS-232 to RS-422 converter or 
conversion cable.

A typical Sony 9-Pin setup.

• Note that you can have two separate 9-Pin devices 
connected to the computer when using Nuendo!

3. Make sure you have timecode recorded on the tape 
recorder, and that it is set up to utilize Sony 9-Pin.

4. In the Project Synchronization Setup dialog, select ei-
ther 9 Pin Control 1 or 2 in the Master Machine Control 
Device section.

5. In the Master Machine Control settings section, use 
the Serial Port pop-up menu to select the correct serial 
(COM) port.
By selecting different ports for the two 9-Pin Devices, you can separate 
two different external tape recorders, video systems, etc. The other op-
tions in this dialog are described on the following pages.

6. Set the number of audio tracks available on the 9-pin 
device by clicking on the arrows in the respective field or 
by entering a number directly. There can be up to 48 au-
dio tracks for each 9-pin device.
You will be able to remotely arm each audio track for recording from the 9-
pin control window. This is very handy when working in a large facility that 
utilizes a common machine room where all the tape machines are located.

In the 9-Pin Device Settings section (to the left of the 
Timecode Source section), you will find two additional op-
tions for each 9-pin device:

• “Control Playback Speed”.
This option instructs Nuendo to attempt to control the playback speed of 
the 9-pin device in order to keep it in sync with Nuendo’s internal clock. 
This should be a last resort option as it is very difficult to achieve accept-
able results. Use this if there is no other way to lock to timecode coming 
from the 9-pin device other than through the 9-pin connection. 

• “Display Follows Locating Device”.
This is a very useful option for tape-based machines that take a certain 
amount of time to locate to new positions. When this option is activated 
and sync is enabled, the project cursor in Nuendo will reflect the position 
of the 9-pin machine’s transport as it locates to different positions. For 
instance, if you place the cursor several minutes ahead of the current 
tape position, Nuendo can immediately locate there but the tape ma-
chine will take several seconds to arrive at the same position. During that 
time, the cursor will move with the tape machine, giving the user visual 
feedback as to its location. This is necessary in larger facilities that have 
a central machine room where the tape machine is located. Since the 
Nuendo system is in another room, the user will not know when the tape 
machine has located to the correct position.

7. Click OK to apply your changes and close the Project 
Synchronization Setup dialog.

8. Open the Project Setup dialog from the Project menu.

9. As when synchronizing without using transport con-
trol, use the Start value to specify which frame on the tape 
should correspond to the beginning of the project.

10. Close the Project Setup dialog.



458

Synchronization

11. Pull down the Devices menu and select “9-Pin Device 
1” or “9-Pin Device 2”.
The corresponding 9-Pin Device control panel appears. This has a sepa-
rate set of transport buttons, for controlling the transport in the 9-pin de-
vice. There’s also a separate Online button, above the transport controls.

The 9-pin control panel. Most professional video tape machines have 
four audio tracks and if they are digital, use a 48k sampling rate. Tracks 
1 and 2 are record enabled.

It’s now possible to control the transport and track arming 
of the 9-pin device independently or together with Nuendo:

• If you activate the Online button on the 9-Pin Device 
control panel you can use the transport buttons on the 
panel to control the transport in the device.

• If you activate the Sync button on Nuendo’s Transport 
panel, the 9-Pin Device transport buttons (or the buttons 
on the main Transport panel) will control the 9-pin device 
and Nuendo in sync.

• When using Sony 9-Pin it is possible to advance the ex-
ternal transport frame by frame by using the Nudge Posi-
tion buttons on the Transport panel. You can assign a 
keyboard shortcut for this as well.

• Whenever you want to turn off the synchronization be-
tween the tape recorder and Nuendo, simply deactivate 
Sync on the Transport panel.

Preferences

There are several Master Machine Control Preferences 
available for 9-pin control in the Project Synchronization 
Setup dialog. They are as follows:

• “Machine position follows mouse edits”. 
When this option is activated and the transport in Nuendo is set to “Edit 
Mode,” the 9-pin device will track the edits you make with the mouse in 
the project window. Actions such as adjusting event boundaries, moving 
fade handles and even selecting events will cause the 9-pin machine to 
follow the mouse position as you make the edit. This emulates the re-
sponse of a video file playing in Nuendo under Edit Mode.

• “Machine position follows jog”.
When this option is activated, Nuendo will send Locate commands to the 
9-pin device when you use the jog wheel on the Transport panel, allow-
ing you to see each frame of video as you scroll through the tape. When 
it is deactivated, the positioning of the device takes place when the jog 
wheel has been released.

• “Send Shuttle instead of FF/Rewind”.
When the fast forward and rewind buttons are pressed on the Transport 
panel, Nuendo can send either fast forward and rewind commands to the 
9-pin device or send shuttle commands. Each 9-pin device will react dif-
ferently to these commands so some experimentation will be necessary. 
Tape machines will most likely respond best to fast forward and rewind 
commands. This option is deactivated by default.

• “Send Still instead of Stop”.
Many video tape machines will not display an image when in stop mode 
as the tape is typically retracted from the playback heads in this mode. 
Using a still or pause command instead will allow most video tape ma-
chines to display the current frame of video while paused. Many video 
tape machines have internal settings that affect this as well, allowing im-
ages to be displayed in stop mode.

• “Allow machine controlled cycle”.
Nuendo can behave in two ways when in cycle mode and using machine 
control. When this option is not activated, Nuendo will begin the cycle 
normally from the left locator. But when it gets to the right locator, Nu-
endo will go back to the left locator to start the cycle again while the tape 
machine (or other external transport) will continue on until stop is 
pressed. When this option is activated, once Nuendo reaches the right 
locator, playback will stop on both the machine and in Nuendo. Both will 
locate back to the left locator and begin playback automatically. This will 
continue until stop is pressed. Also, if there are pre and post roll values 
activated in the Transport panel, Nuendo will include these in the cycle, 
playing past the right locator by the post-roll amount and then locating to 
a point before the left locator by the pre-roll amount and playing from 
there. The tape machine will follow all of this in sync.

Audio Layback for 9-Pin Devices

Nuendo has some special features for working with 9-Pin 
devices (typically video decks). These allow you to trans-
fer audio to the 9-Pin device by recording it from Nuendo, 
manually or automatically. A typical application would be 
audio layback – if you have edited audio for a video in Nu-
endo and want to transfer the audio back to the audio 
track(s) in the video deck, at the correct positions.

! This assumes that Machine Control of the 9-Pin de-
vice has been set up, and that the proper audio con-
nections have been made for recording audio from 
Nuendo to the 9-Pin device.
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1. Open the Project Synchronization Setup dialog and 
select the 9-Pin device (1 or 2) in the Master Machine 
Control Device section.

2. Make sure the “Number of Audio Tracks” value is cor-
rect.
This should be set to the number of audio tracks in the 9-Pin device. The 
maximum number of audio tracks supported is 48.

If you have activated “Try to Recognize Device” and 
the 9-Pin Device model is known to Nuendo, the number 
of audio tracks is automatically set to the correct value.

3. Close the Project Synchronization Setup dialog.

4. Select “9-Pin Device 1” (or 2, depending on your con-
nections and setup) from the Devices menu.
The control panel for the 9-Pin Device appears.

The numbered buttons to the left correspond to the set number of audio 
tracks.

5. Make sure the Online button is activated.

6. To record enable an audio track in the 9-Pin device 
(which is connected to Nuendo via a suitable device), 
click the corresponding numbered button in the panel.
The button lights up, indicating that the corresponding audio track is 
record enabled.

7. Set the locators in Nuendo to encompass the audio 
section you want to transfer.

8. Click the Auto Edit button in the 9-Pin device panel.
This is the button to the right of the transport controls.

• If the Auto Edit function is supported by the 9-Pin de-
vice, the device will automatically go to a position just be-
fore the left locator, start playback, activate recording at 
the left locator and punch out at the right locator.
Assuming you have connected the proper outputs from Nuendo to the 
correct inputs of the tape machine, the audio section will be played back 
in Nuendo and recorded on the audio tracks of the 9-Pin device.

• If the Auto Edit function is not supported by the 9-Pin 
device, you have to activate recording “manually”.
Use the 9-Pin device control panel transport (or the main Transport 
panel) to rewind to a position before the left locator, activate automatic 
punch-in and punch-out and start playback. If no Nuendo tracks are 
record enabled, recording will only be performed by the 9-Pin device.

Setting Preroll and Postroll for Auto Edit

For the Auto Edit function provided on 9-Pin device pan-
els you can set individual preroll and postroll values. This 
is done in the Master Machine Control section Settings in 
the Project Synchronization Setup dialog.

1. Open the Project Synchronization Setup dialog and 
select the 9-Pin Device in the Master Machine Control De-
vice section.

2. In the Master Machine Control Settings section to the 
right, click on the Edit PRE/POST up/down arrow buttons 
to set a new value for the preroll and/or postroll for the 
auto edit function.
You can also click directly in the value field and enter the desired pre/
postroll value manually.

! Please consult the documentation for the 9-Pin de-
vice for information about whether the Auto Edit 
function is supported or not.
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Working with VST System Link
VST System Link is a network system for digital audio that 
allows you to have several computers working together in 
one large system. Unlike conventional networks it does 
not require Ethernet cards, hubs, or CAT-5 cables; in-
stead it uses the kind of digital audio hardware and cables 
you probably already possess in your studio.

VST System Link has been designed to be simple to set 
up and operate, yet give enormous flexibility and perfor-
mance gains in use. It is capable of linking computers in a 
“ring” network (the System Link signal is passed from one 
machine to the next, and eventually returns to the first ma-
chine). VST System Link can send its networking signal 
over any type of digital audio cable, including S/PDIF, 
ADAT, TDIF, or AES, as long as each computer in the sys-
tem is equipped with a suitable ASIO compatible audio in-
terface.

Linking up two or more computers gives you vast possibil-
ities:

• Dedicate one computer to running VST instruments while re-
cording audio tracks on another.

• If you need lots of audio tracks, you may simply add tracks on 
another computer.

• You could have one computer serve as a “virtual effect rack”, 
running CPU-intensive send effect plug-ins only.

• Since you can use VST System Link to connect different VST 
System Link applications on different platforms, you can take 
advantage of effect plug-ins and VST instruments that are 
specific to certain programs or platforms.

Preparations

Requirements
The following equipment is required for VST System Link 
operation:

• Two or more computers.
These can be of the same type or use different operating systems – it 
doesn’t matter. For example, you can link an Intel-based PC to an Apple 
Macintosh without problems.

• Each computer must have audio hardware with specific 
ASIO drivers, installed and working.

• The audio hardware must have digital inputs and outputs.
Of course, to be able to connect the computers, the digital connections 
must be compatible (i.e. the same digital formats and connection types 
must be available).

• At least one digital audio cable for each computer in the 
network.

• A VST System Link host application installed on each 
computer.
Any VST System Link applications can connect to each other.

Additionally, we recommend that you use a KVM switchbox:

Using a KVM switchbox

If you want to set up a multi-computer network, or even a 
small network in a limited space, it's a good idea to invest 
in a KVM (Keyboard, Video, Mouse) switchbox. With one 
of these you can use the same keyboard, monitor, and 
mouse to control each computer in the system, and switch 
between computers very rapidly. KVM switchboxes are 
not too expensive, and very easy to set up and operate. If 
you decide not to go this route, the network will function 
just the same, but you may end up doing a lot of jumping 
from one machine to the other while setting up!

Making connections
Below, we assume that you are connecting two comput-
ers. Should you have more than two computers, it’s still 
best to start with two and add the others one by one once 
the system is working – this makes troubleshooting easier 
if you run into problems. For two computers, you will need 
two digital audio cables, one in each direction:

1. Connect a digital audio cable from the digital output of 
computer 1 to the digital input of computer 2.

2. Connect the other cable from the digital output of 
computer 2 into the digital input of computer 1.

• If a card has more than one set of inputs and outputs, 
choose whichever one that suits you – for simplicity usu-
ally the first set is best.
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Synchronization
Before you proceed, you need to make sure that the clock 
signals on your ASIO cards are synchronized correctly. 
This is essential when cabling any kind of digital audio 
system, not just VST System Link.

The Clock Mode or Sync Mode is set up in the ASIO con-
trol panel of the audio hardware. Proceed as follows:

1. Pull down the Devices menu and open the Device Set-
up dialog.

2. On the VST Audio System page, select your audio in-
terface from the “ASIO Driver” pop-up menu.
In the Devices List, the name of the audio interface is displayed below 
the VST Audio System entry.

3. Select your audio interface in the Devices list to the 
left.

4. Click the Control Panel button.
The ASIO control panel appears.

5. Open the ASIO control panel on the other computer 
as well.
If you are using another VST System Link host application on that com-
puter, check its documentation for details on how to open the ASIO con-
trol panel.

6. Now, you need to make sure that one audio card (and 
only one!) is set to be the Clock Master, and all the other 
cards are set to listen for the clock signal coming from the 
Clock Master i.e. they must be Clock Slaves.
The naming and procedure for this differs depending on the audio hard-
ware – consult its documentation if required. If you are using Steinberg 
Nuendo ASIO hardware, all cards default to the “AutoSync” setting – in 
this case you must set one of the cards (and only one) to “Master” in the 
Clock Mode section of the control panel.

• Typically, the ASIO control panel for an audio card con-
tains some indication of whether the card receives a proper 
sync signal or not, and the sample rate of that signal.
This is a good indication that you have connected the cards and set up 
clock sync properly. Check your audio hardware’s documentation for de-
tails.

The only exception to this procedure is if you are using an 
external clock – which could be from a digital mixing desk 
or special Word Clock synchronizer for example. If so, you 
must leave all your ASIO cards in Clock Slave or Auto-
Sync mode, and make sure that each of them is listening 
for the signal coming from the synchronizer, usually 
passed through your ADAT cables or Word Clock con-
nectors in a daisy chain fashion.

VST System Link and latency
The general definition of latency is the amount of time it 
takes any system to respond to whatever messages are 
sent to it. For example, if your system’s latency is high and 
you play VST instruments in real time, you will get a no-
ticeable delay between when you press a key and when 
you hear the sound of the VST instrument. Nowadays, 
most ASIO-compatible audio cards are capable of operat-
ing with very low latencies. Also, all VST applications are 
designed to compensate for latency during playback, 
making the playback timing tight.

However, the latency time of a VST System Link network 
is the total latency of all the ASIO cards in the system 
added together. Therefore it’s extra important to minimize 
the latency times for each computer in the network.

The latency does not affect the synchronization – it's 
always perfectly in time. But it can affect the time it takes 
to send and receive MIDI and audio signals, or make the 
system seem sluggish.

To adjust the latency of a system, you adjust the size of the 
buffers in the ASIO control panel – the lower the buffer 
size, the lower the latency. It’s best to keep to fairly low la-
tencies (buffer sizes) if your system can handle it – about 
12 ms or less is usually a good idea.

! All digital audio cables by definition always carry a 
clock signal as well as audio signals, so you don't 
have to use a special Word Clock input and output 
for this (although you may find that you get a slightly 
more stable audio system if you do, especially when 
using multiple computers).

! It’s very important that one and only one card is the 
clock master, otherwise the network cannot function 
correctly. Once you have set this up, all the other 
cards in the network will take their clock signal from 
this card automatically.
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Setting up your software
Now it’s time to set up your programs. The procedures 
below describe how to set things up in Nuendo; if you are 
using another program on the other computer, please re-
fer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the 
same sample rate. Select “Project Setup…” from the 
Project menu and make sure the sample rate is the same 
in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications 
and route these to the digital inputs and outputs.
The number and configuration of the busses depends on your audio hard-
ware and on your needs. If you have a system with eight digital i/o channels 
(such as an ADAT connection), you could create several stereo or mono 
busses or a surround bus together with a stereo bus, or any combination 
you need. The important thing is that you should have the same configura-
tion in both applications – if you have four stereo output busses on com-
puter 1, you want four stereo input busses on computer 2, etc.

2. Set things up so that computer 1 plays back some au-
dio.
You could for example import an audio file and play this back in Cycle 
mode.

3. In the Inspector or mixer, make sure the playing audio 
channel is routed to one of the digital output busses you 
set up.

4. In computer 2, open the mixer and locate the corre-
sponding digital input bus.
The audio being played back should now “appear” in the program run-
ning on computer 2. You should see the input bus level meters moving.

5. Reverse this procedure so that computer 2 plays back 
and computer 1 “listens”.

Now you have verified that the digital connection works as 
it should.

From this point on in this chapter, we refer to the bus-
ses connected to the digital inputs and outputs as “VST 
System Link busses”.

Settings for the audio hardware

When you send VST System Link data between comput-
ers, it is important that the digital information isn’t changed 
in any way between the programs. Therefore, you should 
open the control panel (or additional application) for your 
audio hardware and make sure that the following condi-
tions are met:

• If there are additional “format settings” for the digital 
ports that you use for VST System Link data, make sure 
these are turned off.
For example, if you are using an S/PDIF connection for VST System Link, 
make sure that “Professional format”, Emphasis and Dithering are turned 
off.

• If your audio hardware has a mixer application allowing 
you to adjust the levels of digital inputs and outputs, make 
sure that this mixer is disabled or that the levels for the 
VST System Link channels are set to (± 0dB).

• Similarly, make sure no other forms of DSP (pan, ef-
fects, etc.) are applied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hard-
ware, the Totalmix function allows for extremely complex 
signal routing and mixing in the audio hardware. This can 
in some situations lead to “signal loops” in which case the 
VST System Link won’t work. If you want to make abso-
lutely sure this won’t cause any problems, select the de-
fault or “plain” preset for the Totalmix function.
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Activating VST System Link
Before you proceed you need to make sure that VST Sys-
tem Link is set as Timecode Source in the Synchronization 
dialog and that the desired Sync options are activated, 
see “Timecode Preferences” on page 454.

After setting up the inputs and outputs, you now need to 
define which input/output should carry the actual VST 
System Link information.

The System Link networking signal is carried on only one 
bit of one channel. This means that if you have an ADAT 
based system which normally carries eight channels of 
24-bit audio, once you activate VST System Link you will 
have seven channels of 24-bit audio and one channel of 
23-bit audio (the least significant bit of this last channel 
will be used for networking). In practice this makes no dis-
cernible difference to the audio quality, since you will still 
have around 138dB headroom on this channel.

To set things up, open the VST System Link panel:

1. Open the Device Setup dialog on the Devices menu.

2. Select VST System Link in the Devices list to the left.

3. Use the ASIO Input and ASIO Output pop-up menus 
to define which channel should be the networking channel 
(and thus become a 23-bit audio channel, in our example).
Quite often you will be able to leave these pop-ups the way they are. 

4. Click the Active checkbox at the top of the panel.

5. Repeat the steps above for every computer on the net-
work. 

As the computers are made active, you should see the 
small Transmitting and Receiving indicators flashing on 
each active computer, and the name of each computer 
should appear in the list at the bottom of the pane. Each 
computer is assigned a random number – don't worry 
about this, it's just so the network knows internally which 
one is which.

• You can double-click on the name in bold (which is the 
name of the computer you’re currently working on) and set 
it to whatever other name you wish.
This name will appear in the System Link window of every computer on 
the network.

If you don't see the name of each computer appearing 
once you have made it active, you may have to check your 
settings. 
Go through the procedure above again and make sure that all ASIO 
cards are listening to the digital clock signals correctly, and that each 
computer has the correct inputs and outputs assigned to the System 
Link network.

Putting the network online
After each computer's name you will see whether it is on-
line or not. When a computer is online, it will receive trans-
port and timecode signals, and its sequencer application 
can be started and stopped by remote control. If it is off-
line, it can only be started from its own keyboard – it is ef-
fectively an independent machine, although it is still on the 
network.

Note that any computer can control any and all of the 
others – VST System Link is a peer-to-peer network and 
there is no absolute “master” computer.
However, most users do like to think of one machine as the master (in a 
one person/two computer network, this would be the machine you actu-
ally sit behind most of the time). 

For now, let's put all computers online:

1. Activate the Online checkbox in the VST System Link 
panel for all computers. 

2. Check that the system is working by pressing Play on 
one computer – all computers should start almost instantly 
and play perfectly in time, with sample-accurate precision.

The Receiving and 
Sending indicators
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• The Offset Samples setting allows you to adjust whether 
one machine will play back slightly ahead or behind the rest.
This is normally not needed, but occasionally with some hardware you 
may find that the lock is a few samples out. In that case you can adjust 
the lock with the Offset value. For now, leave it set to 0 – it will most likely 
be what you want.

• The Transfer Bits setting allows you to specify whether 
you want to transfer 24 or 16 bits. This allows you to use 
older audio cards which do not support transfer of 24 bits.

VST System Link sends and understands all transport 
commands, so you can play, stop, fast forward, rewind 
etc. the entire network from one computer without a prob-
lem – try it! If you jump to a locator point on one machine, 
all other machines will also instantly jump to that locator 
point. You can even scrub on one computer and have the 
video and audio on another computer actually scrub right 
along with you.

Using MIDI
As well as supplying transport and sync control, VST Sys-
tem Link also supplies up to 16 MIDI ports, each with 16 
channels. You set this up as follows:

1. Use the MIDI Inputs and Outputs value boxes to spec-
ify the number of MIDI ports you need.
The default value is 0 MIDI In and 0 MIDI Out ports.

2. Create a MIDI track in the Project window and open 
the Inspector (top section).

3. If you now pull down the Input or Output Routing pop-
up menus, you will find the specified System Link ports 
added to the list of MIDI Inputs and Outputs.

This allows you to route MIDI tracks to VST instruments 
running on another computer, as described in the applica-
tion examples (see “Using one computer for VST instru-
ments” on page 466).

The “Active ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, 
there is a small possibility that you might run out of band-
width on your VST System Link network. This will manifest 
itself by notes “choking” or timing becoming erratic.

If this happens, you can devote more bandwidth to MIDI 
by activating “Active ASIO Ports for Data only” in the VST 
System Link Setup panel. When this is activated, the VST 
System Link information will be sent on the entire channel 
instead of just one bit, more than enough for all the MIDI 
you could ever hope to use. The downside is that you can 
no longer use this ASIO channel for audio transfer (do not 
connect it to a speaker!), thus leaving you only 7 channels 
of audio in our ADAT cable example. Depending on how 
you work this might be a reasonable compromise.

! Make sure that all computers have their tempos set 
to the same value, otherwise your synchronization 
will be seriously skewed.
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Hearing the network audio
If you are using an external mixing desk, hearing your audio 
really isn't an issue – just plug the outputs of each computer 
into the desired channels on the external mixing desk, press 
Play on one of the computers, and you're good to go.

However, many people prefer to mix internally inside the 
computer and just use a desk for monitoring (or maybe not 
use any external mixer at all). In this case you'll need to se-
lect one computer to be your “main mix computer” and 
send the audio from your other computers into this.

In the following example, we assume you are using two 
computers, with computer 1 as your main mix computer 
and computer 2 running two additional stereo audio 
tracks, an FX channel track with a reverb plug-in and a 
VST instrument plug-in with stereo outputs.

1. First you want to set things up so that you can listen to 
the audio playback from computer 1.
In other words, you need an unused set of outputs, e.g. an analog stereo 
output, connected to your monitoring equipment.

2. Go to computer 2 and route each of the two audio 
tracks to a separate output bus.
These should be busses connected to the digital outputs – let’s call 
them Bus 1 and 2.

3. Route the FX channel track to another VST System 
Link bus (Bus 3).

4. Route the VST instrument channel to yet another bus 
(Bus 4).

5. Go back to computer 1 and check the corresponding 
four VST System Link input busses.
If you start playback on computer 2, the audio should “appear” on the in-
put busses on computer 1. However, to mix these audio sources you 
need actual mixer channels:

6. Add four new stereo audio tracks on computer 1 and 
route these to the output bus you use for listening, e.g. to 
the analog stereo outputs.

7. For each of the audio tracks, select one of the four in-
put busses.
Now, each computer 2 bus is routed to a separate audio channel on 
computer 1.

8. Activate monitoring for the four tracks.

If you now start playback, the audio from computer 2 will 
be sent “live” to the new tracks on computer 1, allowing 
you to hear them together with any tracks you play back 
on computer 1.

For more information about Monitoring, see “About moni-
toring” on page 17.

Adding more tracks

OK, but if you have more audio tracks than you have VST 
System Link busses (physical outputs)? Then you just use 
the computer 2 mixer as a submixer: Route several audio 
channels to the same output bus and adjust the output 
bus level if needed.

Note also that if your audio cards have multiple sets of in-
put and output connections you can link up e.g. multiple 
ADAT cables and send audio via any of the busses on any 
of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the la-
tency issue we mentioned earlier. The VST engine always 
compensates for record latencies, but if you are monitor-
ing through computer 1 you will hear a processing delay 
while you listen to signals coming from your other comput-
ers (not on your recording!). If your audio card in computer 
1 supports ASIO Direct Monitoring you should definitely 
turn this on – you'll find the setting in the VST Audio Sys-
tem Device Setup panel (see “ASIO Direct Monitoring” on 
page 72). Most modern ASIO cards support this function. 
If yours doesn't you may want to change the Offset value 
in the VST System Link Setup panel to compensate for 
any latency issues.
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Setting up a larger network
This is not much more difficult than a two computer net-
work. The main thing to remember is that VST System Link 
is a daisy chain system. In other words, the output of com-
puter 1 goes to the input of computer 2, the output of 
computer 2 goes to the input of computer 3, and so on 
around the chain. The output of the last computer in the 
chain must always go back into the input of computer 1, to 
complete the ring.

Once you've done this, the transmission of all the trans-
port, sync, and MIDI information to the whole network is 
handled pretty much automatically. However, where you 
may run into confusion in a large network is in the trans-
mission of audio signals back to a central mix computer.

If you have lots of hardware inputs and outputs on your 
ASIO cards you don't need to send audio via the chain at 
all, but can transmit it directly to the master mix computer 
via one or more of its other hardware Inputs. For example, if 
you have a Nuendo Digiset interface or 9652 card on com-
puter 1 you could use ADAT cable 1 for networking, ADAT 
cable 2 as a direct audio input from computer 2, and ADAT 
cable 3 as a direct audio input from computer 3.

You can also transmit audio via the ring system if you don't 
have enough hardware I/Os for direct audio transmission. 
For example, in a four computer scenario you could send 
audio from computer 2 into a channel in the mixer in com-
puter 3, and from there to a channel in the mixer in com-
puter 4, and from there back to the master mixer in 
computer 1. This can certainly be tricky to set up, so gen-
erally it is recommended that if you want to set up a com-
plex network, you should make sure to use ASIO cards 
with at least three separate digital I/Os. 

Application examples

Using one computer for VST instruments
In this example, one computer will be used as main record 
and playback machine, and another computer as a virtual 
synth rack.

1. Record a MIDI track into computer 1.

2. Once you have finished recording, route the MIDI out-
put of that track to System Link MIDI port 1.

3. Now go to computer 2, open up the VST Instrument 
rack and assign an instrument to the first slot in the rack.

4. Route the VST Instrument channel to the desired out-
put bus.
If you are using computer 1 as your main mixing computer, this would be 
one of the VST System Link output busses, connected to computer 1.

5. Create a new MIDI track in the Project window of 
computer 2, and assign the MIDI output of the track to the 
VST Instrument you created. 

6. Assign the MIDI input of the track to be VST System 
Link port 1.
Now, the MIDI track on computer 1 is routed to the MIDI track on com-
puter 2, which in turn is routed to the VST Instrument.

7. Now activate monitoring for the MIDI track on com-
puter 2, so that it will listen and respond to any MIDI com-
mands coming in.
In Nuendo, you would click the monitor button in the Track list or Inspec-
tor.

8. Press play on computer 1.
It will now send the MIDI information on the track to the VST Instrument 
loaded on computer 2.

Even with a slow computer you should be able to stack a 
whole bunch of extra VST Instruments this way, expanding 
your sound palette considerably. Don't forget that VST 
System Link MIDI is also sample-accurate, and thus has 
much tighter timing than any hardware MIDI interface ever 
invented!
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Creating a virtual effect rack
The effect sends for an audio channel in Nuendo can ei-
ther be routed to an FX channel track or to any activated 
Group or output bus. This allows you to use a separate 
computer as a “virtual effect rack”, by setting things up in 
the following way:

1. Go to computer 2 (the machine you will use as effect 
rack) and add a new stereo audio track.
You cannot use an FX channel track in this case, since the track must 
have an audio input.

2. Add the desired effect as an insert effect for the track.
Let’s say you add a high-quality reverb plug-in.

3. In the Inspector, select one of the VST System Link 
busses as input for the audio track.
You want to use a separate System Link bus, which will only be used for 
this purpose.

4. Route the channel to the desired output bus.
If you are using computer 1 as your main mixing computer, this would be 
one of the VST System Link output busses, connected to computer 1.

5. Activate monitoring for the track.

6. Now, go back to computer 1 and select a track to 
which you want to add some reverb.

7. Bring up the effect sends for the track, in the Inspector 
or the mixer.

8. Pull down the send routing pop-up menu for one of 
the sends, and select the VST System Link bus assigned 
to the reverb in step 3.

9. Use the send slider to adjust the amount of effect as 
usual.

The signal will be sent to the track on computer 2 and pro-
cessed through its insert effect, without using any proces-
sor power on computer 1.

You can repeat the steps above to add more effects to the 
“virtual effect rack”. The number of effects available this 
way is only limited by the number of ports used in the VST 
System Link connection (and of course by the perfor-
mance of computer 2, but given that it won’t have to han-
dle any recording or playback, you should be able to use 
quite a lot of effects).

Getting extra audio tracks
All computers on a VST System Link network are locked 
with sample-accuracy. Therefore, if you find that the hard 
drive on one computer isn’t fast enough to run as many 
audio tracks as you need, you can record new tracks on 
one of the other computers instead. This would create a 
“virtual RAID system”, with several disks all operating to-
gether. All tracks will remain locked together just as tightly 
as if they were all running on the same machine. This 
means that you effectively have an unlimited track count! 
Need another 100 tracks? Just add another computer.

Dedicated Video Playback
Playback of high-resolution video can be taxing on a sys-
tem’s CPU. By dedicating one computer for video play-
back via System Link, you can free up resources on your 
main CPU for audio and MIDI processing. Since all trans-
port commands will respond on the System Link comput-
ers, scrubbing video is possible even when it is coming 
from another computer. Spotting sound effects to picture 
in Edit Mode will work the same way as it does on one 
computer. This is a viable and economic alternative to 
dedicated hard disk video systems like the Doremi V1.
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Background
Nuendo plays back video films in a number of formats. 
Under Windows, video playback can be done using the 
playback engines DirectShow, DirectX Video or Quick-
Time. 
Under Mac OS X, QuickTime is always used as playback 
engine.

There are several ways to play back video:

• Without any special hardware.
While this will be fine in many situations it does put a limit on the size of 
the internal video window as well as the quality of the image.

• Using FireWire (Mac OS X only).
Using a FireWire port, you can play back video on an external monitor us-
ing a DV-to-analog converter or a DV camera.
This is valid for DV video and QuickTime is used for playback. This can 
reduce the CPU load since the external device is decoding the DV video 
stream.

• Using Graphics cards (Windows only).
Multi-head graphics cards which support overlay functionality can be 
used to display the video picture on an external monitor. As of this writ-
ing, the following manufacturers have working solutions available: nVIDIA 
and Matrox.

• Using Video cards.
Video cards can also be used to display the video on an external monitor. 
Please note that this utilizes some of the CPU to process the video data. 
As of this writing, e.g. the “Decklink” card (Blackmagic) can be used.

Before you start
When working on a project involving a video file, there are 
several points to bear in mind:

The playback engine is used not only for playback of the 
video file, but also to provide file information in Nuendo. To 
make sure that you have chosen the right player for a par-
ticular type of video file, check the file information dis-
played in Nuendo (e.g. in the Import Video dialog or the 
Pool) prior to trying to import or playing back the file.

When this information reads “0x0 pixel”, “0.000 s” and “0 
Frames”, the video file is either corrupt, or the format is not 
supported by the codecs available to the selected video 
playback engine. You will either have to change the video 
playback engine, or install the required codec. 

As a general rule, Nuendo should be able to use a cer-
tain video file, if the native video player on your system 
(Windows Media Player on the PC or QuickTime Player 
on the Mac) can play this file.

You can expect most Windows hardware to work with 
DirectShow and DirectX Video.
On a Windows system, the DirectShow and DirectX Video players are 
provided by the operating system, you don’t have to install any additional 
software. Make sure you are using the latest version of DirectX software 
available from the Microsoft web site.

For the QuickTime playback method to be available, 
you must have QuickTime 7.1 installed on your computer.
If you don’t have QuickTime, or if a version lower than 7.1 is installed, 
QuickTime playback will not be available in Nuendo. There is a freeware 
version (a QuickTime installer is included on the Nuendo DVD if required, 
or you can download it from www.quicktime.com) and a “pro” version, 
which offers additional video cutting options. The player engine is the 
same in both versions, so for mere playback in Nuendo there is no need 
to purchase the “pro” version.

! Trying to import or play back a file not supported by 
the selected video player will lead to unpredictable 
results – if no information on the number of frames, 
the length and the pixel resolution is available (e.g. in 
the Import Video dialog), you cannot import/play this 
file properly with this particular video player.

! Under Mac OS X, there is only one standard player 
option. The QuickTime playback engine is always 
used, supporting the formats AVI, MPEG, QuickTime 
and DV. If your system has a FireWire port, there is 
also a FireWire option – see “Playing back a video 
file via FireWire (Mac OS X only)” on page 473.
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Selecting the video playback engine 
(Windows only)
When using Nuendo on a Windows system, you can se-
lect the playback engine in the Device Setup dialog (Video 
Player page).

Which playback engine to select depends largely on 
which type of video system you are using, as well as on 
the file format and codec of the video files you want to 
work with.

• When you have changed the video playback engine, 
make sure to remove any previously imported video file 
from the Pool, and re-import it.

A note on editing
Nuendo allows you to cut, copy, paste and trim video 
events, i.e. your video track may contain more than one 
video event. Make sure that these video files are of the 
same file format and resolution in order for them to play 
properly. 

Windows only: When using the DirectShow video 
playback engine, you may find that only the first event on 
the video track is played back correctly. In such a case 
make sure that the video track contains no more than one 
video event. When you need to edit your video files (i.e. 
cut, copy, paste or trim video events), it is therefore rec-
ommended to use the DirectX Video player.

Windows only: If you find that you are unable to edit a 
video file copied from a CD, this might be due to the fact 
that files copied from CD are write-protected by default. 
Right-click the file, and deactivate the “Read-Only” option 
in the File Properties dialog.

When you have a video file in a format not supported by 
Nuendo, use an external application to convert it to a for-
mat that Nuendo can import.

Operations

Importing a video file
Video files are imported in the same manner as audio files.

• By using the File menu (Import Video File).

• By using drag and drop from the Windows Explorer, the 
Mac OS Finder, the Pool or the Media Bay.

• By importing to the Pool first and then dragging to the 
Project window (see the chapter “The Pool” on page 296 
for details).

Note:

• To be able to play back the video, you must add a video track 
(by using the Add Track submenu on the Project menu or Quick 
menu). You can only have one video track in each project.

• You can have multiple video files on the track but all files must 
be of the same size and compression format.

• You may trim video files in the project window as needed, ad-
justing the event boundaries as you would for an audio event.

• The Import dialog has an option for extracting the audio from a 
video file (see “Extracting audio from a video file” on page 472) 
and for generating a thumbnail cache file for the video file, see 
below.

Video import preferences

In the Preferences dialog (Editing–Video page), there are 
two options that affect the import of video files:

• Extract Audio on Import Video File
When this is activated, the audio will automatically be extracted and im-
ported into the project when you import a video file. This way, the audio 
will also be included when you insert a video e.g. by using drag and drop. 
When you import video files by using the File menu, you can activate this 
option separately for each imported video file on the Import dialog.

• Generate Thumbnail Cache on Import Video File
When this is activated, a thumbnail cache file will be created automati-
cally when you import a video file. This is handy, as a cache file will also 
be created when you import a video file using drag and drop. When you 
import video files by using the File menu, you can activate this option 
separately for each imported video file on the Import dialog, see below.
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About Thumbnail Cache files

To display video thumbnails in the Project window, the 
option “Show Video Thumbnails” has to be activated in 
the Preferences dialog (Event Display–Video page).

When working with video in Nuendo, video files are dis-
played as events/clips on the video track with thumbnails 
representing the frames in the film. These are calculated in 
real time, i.e. they have to be redrawn during scrolling or 
moving. As this consumes quite a lot of processor power, 
reaction sometimes may be sluggish. To remedy this, you 
can generate a thumbnail cache file.

The cache file is used in situations where the processor 
load is very high and the correct redrawing or real-time 
calculation might use system resources necessary for ed-
iting or processing. When the cache file is used and you 
zoom in on the thumbnails, you will see that they are in a 
lower resolution, i.e. the pictures are not as clean as when 
they are calculated. When the processes that rely heavily 
on the computer CPU are finished, the frames will be au-
tomatically recalculated, i.e. the program automatically 
switches between real-time calculation of the pictures and 
using the cache file.

The generated thumbnail cache file will be stored in the 
same folder as the video file and will get the name of the 
file with the suffix “.videocache”.

Generating thumbnail cache files during video import

Thumbnail cache files can be created when a video file is 
imported into the project.

Proceed as follows:

1. On the File menu, open the Import submenu and select 
“Import Video File…”.
A file dialog is opened.

2. Locate and select the desired video file, activate 
“Generate Thumbnail Cache” in the lower part of the dia-
log and klick “Open”.

The Generate Thumbnail Cache option in the Import Video dialog.

A window will be displayed, showing you the progress 
and the estimated time for the process.

The thumbnail cache file is created.

After the cache file is created, the window will be closed 
and the video clip is inserted as usual. When you now 
start video playback and perform processor consuming 
operations, the thumbnail file is used to display the video 
frames in the Project window. When enough processor 
power is available, the “real” calculated thumbnail frames 
are displayed again.

To automatically create thumbnail cache files for all im-
ported video files, activate “Generate Thumbnail Cache 
on Import Video File” in the Preferences dialog (Editing–
Video page). 

Generating thumbnail cache files from within the Pool

When you have video files without thumbnail cache files 
(e.g. if you did not create a thumbnail cache file during im-
port or if you are working with an older project), you al-
ways have the possibility to generate the thumbnail cache 
file at a later stage. This is done from within the Pool.

Proceed as follows:

1. Open the Pool window and locate the video file you 
want to create a thumbnail cache file for.

2. Right-click on the file to open the context menu and 
select “Generate Thumbnail Cache”, or select “Generate 
Thumbnail Cache” from the Media menu.
Just as when creating the file during import, the status window opens 
(see above).
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After the file is created, the window will be closed and the 
thumbnail cache file is used when necessary, i.e. under 
high load.

Adopting the Video Frame rate
When using video files within Nuendo, it is important to set 
the project’s frame rate to that of the imported video. This 
ensures that the time displayed in the SMPTE readout of 
Nuendo corresponds to the actual frames in the video.

1. Pull down the Project menu and select “Project Set-
up…” (or press [Shift]+S) to open the Project Setup dialog.

2. If a video file has been placed on a video track in the 
Project window, a button now appears in the frame rate 
section of the Project Setup dialog called “Get From 
Video.” This will automatically detect the frame rate of the 
video file and apply that setting to the project.

Extracting audio from a video file
If a video file contains audio, it can be extracted. Regard-
less of the audio format in the actual file, the imported au-
dio file will always be in the format (Sample Rate and 
Record Format) that is specified for the Project in the 
Project Setup dialog.

There are three ways to extract audio from a video file:

• By activating “Extract audio” in the Import Video dialog.
This will add the audio to the currently active audio track. The new audio 
event will start at the same time as the video event, so that they are in 
sync with each other.

• By using “Import Audio from Video File” from the File 
menu.
This is just as above, but no video clip is created, only an audio event 
(starting at the project cursor position on the selected track).

• By activating “Extract Audio on Import Video File” in the 
Preferences dialog (Editing–Video page).
This will automatically extract the corresponding audio from a video file 
during import. This is also true if you import files using drag and drop.

• By using Extract Audio from Video File on the Media 
menu.
This creates an audio clip in the Pool, but doesn’t add any events to the 
Project window.

Playing back a video file
Video files are displayed as events/clips on the video 
track, with thumbnails representing the frames in the film – 
if “Show Video Thumbnails” is activated in the Prefer-
ences dialog (Event Display–Video page).

A video event on a video track.

In the Track list and Inspector, you will find the following 
options:

! Please note that the cache file will not be automati-
cally updated if a video file is edited. Whenever you 
change a video file (e.g. in a video editing applica-
tion), you need to create a new thumbnail cache file 
manually, as described above. (To refresh the “real” 
thumbnails of an edited video file, resize the video 
track so that they are calculated again.)

! The frame rate setting will change to that of the video 
file and the project start time will be altered to reflect 
the change in frame rate if needed. For example, 
when switching the project frame rate from 30fps to 
29.97fps, the start time will be changed so that all 
the events currently in the project will remain at the 
same positions in relation to realtime. If you want the 
project start time to remain the same, you must man-
ually change it back after clicking the “Get From 
Video” button.

! These functions are not available for mpeg video files.

Button Description

Lock When this is activated, the video event will be locked, see 
“Locking events” on page 50.

Show Frame 
Numbers

When this is activated, each thumbnail is shown with the 
corresponding video frame number.

Snap 
Thumbnails

When this is activated, the individual thumbnail images 
will be positioned exactly at their respective start time po-
sition. Also, no more than one thumbnail per frame will be 
shown, even if you zoom in a lot.

Mute Video When this is activated, video playback will be stopped, 
but playback of any other events in the project will con-
tinue (to decrease the processor load). You may have to 
use the Track Controls Settings dialog to make this but-
ton visible in the Track list.
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To view the video on the computer screen (as opposed to 
on an external monitor, see below), proceed as follows:

• Under Mac OS, first make sure that “Onscreen Window” 
is selected in the Video Output section in the Device Setup 
dialog (Video Player page).

• Pull down the Devices menu and select Video (or use a 
key command – by default [F8]).
A video window appears. In Stop mode, this displays the video frame at 
the project cursor position.

Playback of the video is performed together with all other 
audio and MIDI material, using the Transport panel.

Video quality in QuickTime

• When you are using QuickTime as video playback en-
gine, you can activate high quality mode, by selecting 
“High Quality” on the Video window context menu, or by 
activating “Use high-quality video settings when available” 
in the Device Setup dialog–Video Player page (in the 
Video Properties section for QuickTime).
If the QuickTime video was recorded with the corresponding quality set-
tings, this will make the video display sharper and smoother. 
Note that this will also lead to increased processor load.

Setting the Window size

If you are playing back video in a window on your com-
puter screen, you may want to adjust the size. 

• For the QuickTime and DirectX player, you can drag the 
borders, just like resizing other windows.
You can also right-click in the video window to open the context menu 
and select one of the Size options.

• For the DirectShow video player (Windows), open the 
Device Setup dialog from the Devices menu, click Video 
Player in the Devices list and use the buttons in the Video 
Properties section to select a size.

Playing back video in full screen mode

When viewing video on the computer screen, you can 
choose to let the video occupy the whole screen during 
playback or in Stop mode:

• For DirectShow video, right-click in the video window to 
switch to full screen. Right-click again to exit full screen.

• For DirectX and QuickTime, right-click in the Video win-
dow to open the context menu and select “Full Screen 
Mode”. Right-click again or press [Esc] on your computer 
keyboard to exit full screen mode.

Disabling Video Playback

In the Track list and Inspector of a video track, there is a 
Mute button. (Note that this can be hidden for the Track 
list, see “Customizing track controls” on page 507.) When 
you mute a video track, the video will not play and the 
CPU resources it used will be freed up for other purposes. 
When performing complex editing tasks that do not re-
quire watching the video, temporarily muting the video 
track can help speed up performance of Nuendo by re-
ducing the strain on the CPU.

Playing back a video file via FireWire (Mac OS X only)

For Apple computers equipped with a FireWire port, you 
can easily use this to connect to external video hardware, 
as OS X has built-in video support for the most common 
formats (NTSC/PAL/DVCPRO). FireWire is capable of 
high data-transfer speed and is the most common stan-
dard for communicating with video-related peripheral 
equipment.

• To play back a video file via hardware connected to the 
FireWire port, select “FireWire” on the Outputs pop-up 
menu of the Device Setup dialog (Video Player page).
When FireWire is selected as output, a number of format options appear 
on the Format pop-up, allowing you to select between various video for-
mats and resolutions.

• Adjust the Frame Offset value to compensate for DV 
processing delays in the external device.
Due to delays while processing DV video through the FireWire port, the 
video image will be behind or later than the corresponding audio in Nu-
endo. By using the Frame Offset parameter, you can compensate for this 
effect. Each hardware setup could have different processing delays so 
you must experiment to determine what value is appropriate. Usually, 7 
frames is a good starting point. All values for the frame offset are positive 
and indicate how many frames the video will be delivered earlier in order 
to compensate for the processing time.

Note that there is a difference in the frame offset in 
stop versus playback. The frame offset is defeated in stop 
and scrub modes so that you can see the correct frame of 
video since the processing delays are not an issue in 
these modes. It is only used during playback when pro-
cessing delays are noticeable.
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Playing back a video file using graphics cards (Windows 
only)

Multi-head graphics cards which support overlay function-
ality can be used to display the video picture on an exter-
nal TV or computer monitor in full screen mode. As of this 
writing, the manufacturers nVIDIA and Matrox have work-
ing solutions available. Check the card’s documentation 
for information on how it handles video output and how to 
set it up for multi-monitor display.

Playing back a video file using video cards

Video cards can also be used to display the video on an 
external TV or computer monitor. As of this writing, e.g. 
the “Decklink” card (Blackmagic) can be used. For further 
information, check the documentation of the video card.

Video playback preferences

In the Preferences dialog (Event Display–Video page), 
there are two options for video playback:

• Show Video Thumbnails.
When this is activated, thumbnail frames of the video contents are shown 
in the track.

• Video Cache Size.
This determines how much memory is available for video thumbnails. If you 
have long video clips and/or work with a large zoom factor (so that many 
frames are shown in the thumbnails), you may have to raise this value.

Replacing the audio in a video file
Nuendo has a special function for replacing the audio in a 
video file:

1. Pull down the File menu and select “Replace Audio in 
Video File”.

2. In the file dialog that appears, locate and select the 
video file on your hard disk, and click Open.
A new file dialog appears.

3. Locate and select the audio file that you want to insert 
into the video file, and click Open.
The audio is added to the video file, replacing its current audio track (if any).

• By combining the functions “Extract Audio”, “Export Au-
dio Mixdown” and “Replace Audio in Video File”, you can 
create a complete audio track for a video file.

Project window and Browser editing 
operations
Video clips are played back by events just as audio clips 
are. You can use all the basic editing operation on video 
events, just as with audio events. The following operations 
are not possible on the video track:

• Drawing, Gluing, Muting and Scrubbing.

• The video track has no editor and does not make use of 
parts.

Pool operations
For information about operations on video clips in the 
Pool, see the chapter “The Pool” on page 296.

The Edit Mode
Video playback follows the Nuendo transport, so that the 
video frame at the current project cursor position is shown, 
during playback and in Stop mode (e.g. if you move the 
project cursor manually or use fast forward/rewind). Nu-
endo has a special Edit Mode that makes use of this fact, 
allowing you to edit audio while getting continuous visual 
feedback on the video display:

• If you activate “Edit Mode” on the Transport menu, the 
project cursor will automatically follow when you make se-
lections or perform editing operations (such as moving, 
resizing, adjusting fades, etc.).
Since the video automatically follows the project cursor, you will instantly 
get a visual feedback when you edit! This makes it very easy to e.g. move 
an audio event to a certain spot in the video.

• To avoid obscuring the view, the project cursor will be 
hidden from the event display in Stop mode if Edit Mode is 
activated.
However, it will still be shown in the ruler. 

Listed below are three examples of how you can use Nu-
endo’s Edit Mode for matching audio and MIDI to video.
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Adjusting the position of the audio event

1. If required, set the snap point in the audio event so that 
it identifies a significant point in the audio recording.
This would be the position in the audio that you want to match to a cer-
tain position in the video. If you don’t set the snap point, the start of the 
audio event will be used instead.

2. Activate Edit Mode on the Transport menu.

3. Select the audio event.
The project cursor position is automatically moved to the position of the 
snap point.

4. While watching the video display, move the audio 
event towards the correct position.
Since the project cursor automatically follows the snap point position 
and the video automatically follows the project cursor, you just need to 
move the event until the desired video frame is displayed!

Adjusting the length of the audio event

If you have a video section and an audio event for it, that 
doesn’t quite fit, you can use time stretch to change the 
length of the audio:

1. Use the method described above to position the start 
of the audio event at the correct position according to the 
video.

2. In Edit Mode, select the Range Selection tool and 
double-click in the audio event.
This creates a selection range that spans the whole audio event.

3. Click the right edge of the selection range and drag to 
adjust it to the desired length.
While you are dragging, the project cursor position follows the right 
edge of the range, allowing you to pinpoint the desired end position in 
the video.

4. Use “Locators to Selection” (on the Transport menu) 
to set the locators to the selection range you just made.

5. With the Arrow tool, select the audio clip to be 
stretched.

6. On the Audio menu–Process submenu, select “Time 
Stretch”.

7. Click the “Use Locators” button.
The time stretch ratio is set up so that the audio event will fit the locator 
range.

8. Make the desired settings and click Process.
The audio is stretched or compressed to fit the range.

Creating fades

If you want the audio to fade in, reaching full volume at a 
certain position in the video, and fade out at another posi-
tion, here is a quick way of achieving this:

1. In Edit Mode, select the Range Selection tool.

2. Make a selection range in the audio event, roughly 
covering the section that should be played at full volume.

3. Click and drag the edges of the selection range so 
that they exactly correspond to the end of the fade-in and 
the start of the fade-out, respectively.
While you are dragging, the project cursor position follows the edge of 
the range, allowing you to pinpoint the desired fade-in and fade-out po-
sition in the video.

4. Pull down the Audio menu and select “Adjust Fades to 
Range”.
The fade-in and fade-out handles of the audio events are automatically 
adjusted.

When using the Fades handles of an audio event in 
Edit Mode, the cursor will follow their position as well, al-
lowing you to adjust fades to picture in this manner.

! Make sure you don’t exceed the 75% to 125% limit!

! This assumes that the audio event is already posi-
tioned and sized correctly according to the video.



476

Video

Working with film transfers

Frame rates
Since Nuendo has been created from the ground up as a 
total media production system, it must be capable of work-
ing with all different types of video and film frame rates.

Standard frame rates

There are several frame rate standards in use today. They 
are as follows:

• 23.98 frames per second (23.98 fps) used for cinema film to 
NTSC transfer.

• 24 frames per second (24 fps) used for cinema film cameras.
• 25 frames per second (25 fps) used for PAL/SECAM video 

signals.
• 29.97 frames per second (29.97 fps) used for NTSC video 

signals.
• 30 frames per second (30 fps) historically used for black and 

white NTSC video signals. This frame rate is often used in:
1) Music recording as a reference for synchronizing audio re-
corders and MIDI sequencing devices. 
2) Most field recorders also use 30 fps SMPTE during film 
shoots at 24 fps so that after a 2-3 pull-down is performed for 
NTSC video transfer, the frame rate becomes 29.97 fps.

Film transfers
When working with film projects, video post-production 
editors typically transfer the film footage to video for use 
with computer video editing systems. Once the film has 
been edited, it can be transferred back to film for presen-
tation in theaters or may remain in video format for televi-
sion broadcast and release on videotape or DVD.

Pull-up and Pull-down

When film footage is transferred to video, the frame rate 
must be converted from 24 fps to either 25 fps (PAL/SE-
CAM) or 29.97 fps (NTSC). This process introduces a 
slight speed change as a result of the mathematical rela-
tionships between the different frame rates.

The film to NTSC conversion is done as 2-3 pull-down 
and the film is running at 23.98 fps to maintain the exact 
2-to-3 relationship. (Result: The film is running ~0.1% 
slower in NTSC TV.)

The audio recorded along with the film must also have 
these speed changes applied to it in order to remain in 
sync with the picture once it has been transferred to 
video. Sometimes the speed change is applied at the 
same time as the film transfer and is recorded directly on 
the videotape. This allows the video editor to hear the au-
dio along with the transferred video while editing.

These speed changes also result in pitch changes. Other 
artifacts can also be added to the audio since direct digital 
transfers from the field recorder to the videotape are not 
possible since either sample rate conversion or an analog 
transfer must be used as a result of the speed change.

Most audio engineers therefore prefer to use the original 
source material when working with film audio. Once the 
original audio has been digitally transferred into Nuendo, 
the speed change must be compensated for in order to 
have the audio stay in sync with the video. Nuendo has the 
flexibility to apply these speed changes to either the audio 
or video independently to compensate for the speed 
change. 

When a specific speed change has been applied to either 
audio or video, it is called a “pull-down” or “pull-up” de-
pending on the direction of speed change. The specific 
amount and direction of speed change depends on the 
type of transfer the film underwent. Transfers to PAL/SE-
CAM and NTSC each require a different speed change in 
order to keep the audio in sync. These speed changes 
arise during the Telecine process.

The Telecine process
A telecine machine is the device used to transfer film to 
videotape. It transfers images from each frame of film to 
frames of video in a very specific way. Having a clear un-
derstanding of this process will help alleviate the confu-
sion surrounding pull-up and pull-down sample rates and 
keeping film audio in sync.
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Film frames vs. video fields

One of the first things that needs to be understood is how 
video signals are formatted in general. Each frame or sin-
gle image of a video signal is composed of two video 
“fields”, each containing half of the image. The first field 
contains all the odd horizontal lines of resolution and the 
second field contains the even horizontal lines of the im-
age. This is called “interlacing” and is needed to minimize 
the flicker effect that would result if the image was pre-
sented all at once.

Since the film frame is a single, complete image (like a 
35mm photograph), there are no fields involved. The tele-
cine machine must transfer part of the film image to one 
field and then the rest to another field of video. This may 
sound simple at first but as you will see, it can become 
quite complex.

Transferring film to PAL/SECAM video

Film transfers to PAL/SECAM video are relatively straight-
forward. Film runs at 24 fps and PAL video runs at 25 fps. 
If you speed up film by roughly 4% (or 4.16%, to be pre-
cise), it will be running at 25 fps. So, film transfers to PAL 
video result in a 4% “pull-up” in speed. The audio must 
also be pulled up by 4% in order to remain in sync with the 
video.

When properly done, the first frame of film will be trans-
ferred to both fields of the first frame of video and so on. 
All that is needed is the 4% increase in speed for this to 
be a one-to-one transfer. 

If the project is going to be returning to film for the final 
presentation, the audio can be slowed back down to nor-
mal speed when transferring back to film in order to pre-
serve the fidelity and performance values of the original 
material.

Transferring film to NTSC video

Transferring film at 24 fps to NTSC video at 29.97 fps 
presents a few more difficulties than the PAL transfer. 
Simply speeding up film to 29.97 fps would cause both 
the visual and audio elements to become too fast and 
high-pitched to be usable. There is no neat mathematical 
relationship between 24 fps and 29.97 fps. Another 
method was devised called the 2-3 Pull-down.

What is 2-3 Pull-down?

The 2-3 pull-down is a combination of speed change and 
frame-to-field-counting that results in a smooth transfer to 
NTSC video without any unwanted or noticeable pitch 
changes in the audio. Here are the steps involved during 
the process:

1. The film speed is slowed or “pulled” down to 23.976 
fps (-0.1%).
At this speed there is a mathematical relationship between 23.976 and 
29.97.

2. The first frame of film is transferred to the first two 
fields of video.

3. The second frame of film is transferred to three fields 
of video, the two fields of the second video frame and just 
the first field of the third video frame.
This is where the “2-3” part of the name comes from. Each alternating 
frame of film is transferred to two fields of video then three fields of video 
and so on. 

! The only downside to PAL transfers is that a 4% in-
crease in the speed will result in a 4% increase in the 
pitch as well! This could affect the perception of a 
character’s delivery of a line or the timbre of sound 
effects or musical tonalities. If the final project is to 
remain in the video format, pitch-correcting this 
anomaly might be desired.

! Transferring film to PAL/SECAM video requires a 
4% pull-up in speed for both the picture and sound 
elements.
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4. The third film frame is transferred to the second field of 
video frame three and the first field of video frame four.

This is a block diagram of the 2-3 pull-down process. Notice that 4 
frames of film are transferred to 5 frames of video using the 2-3 field 
technique.

5. The remaining film frames are transferred in this man-
ner, alternating between 2 and 3 fields of video, until the 
end of the transfer.
After four frames of film have been transferred this way, an even five 
video frames will be created. Over the course of one second, 24 frames 
of film and 30 frames of video will have gone by. Since they are running 
at -0.1%, the actual frame rate is 29.97 video frames per second, the 
NTSC standard.

It is important to have a clear understanding of 2-3 pull-
down in order to make accurate decisions regarding audio 
pull-down and video pull-up when working with NTSC film 
transfers in Nuendo. Film speed is faster than NTSC video 
speed. 

When the audio is pulled down, it allows production audio 
(DAT tapes or files from a field recorder) from a film shoot 
to play in sync with NTSC video. Even though 29.97 fps is 
a faster frame rate than 24 fps (film speed), the video is 
running -0.1% slower than the original film due to the 2-3 
transfer process and hence the need to slow the audio 
down a bit.

Compensating for film transfers to 
video
When working with film transfers to video, it is necessary 
to compensate for the change in speed that results from 
the telecine process. With Nuendo, there are two basic 
ways this can be done. The first is by adjusting the play-
back speed of the audio to match the speed of the video. 
The second is to adjust the speed of the video file to 
match the original speed of the film and production audio 
in Nuendo.

Adjusting audio playback speed
When adjusting audio playback speed to match the video, 
there are two scenarios based on the two video formats 
that film is transferred to, NTSC and PAL/SECAM. Since 
the telecine process for each video format results in differ-
ent speed changes, there are two types of playback ad-
justments possible. For NTSC, the speed change is down 
-0.1%. For PAL/SECAM, the change is up +4.1667%.

! Many video editors working with NTSC video refer to 
30 fps as “film speed” as opposed to 24 fps. The 
reason for this is if you speed NTSC video (29.97 
fps) up by 0.1%, you are running at the same speed 
as the original film at 24 fps. Conversations regard-
ing this can often get very confusing. Make sure you 
have a clear understanding of the material you are 
working with when dealing with film transfers and 
frame rates. It will avoid many mistakes and save time 
in the long run.
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Audio pull-down -0.1% (NTSC)

When working on a film project that has been transferred 
to NTSC video, most audio engineers prefer to use the 
original source tapes from the film shoot in order to retain 
the highest quality and fidelity. Audio that has been trans-
ferred to the videotape during the film transfer has suf-
fered a generation loss and speed change.

Since the video is running -0.1% slower than the original 
film, the audio must also be slowed down by the same 
amount as the film in order to remain in sync. 

To slow down audio playback in Nuendo, an external sam-
ple clock source will be needed to “pull” the clock speed 
down by 0.1%.

Your audio card must be set to external sync and con-
nected to the clock device via Word Clock, VST System 
Link or some other clocking method for this to work.

Since the video and audio playback speeds are indepen-
dent in Nuendo, the video will remain at the same speed 
while the audio is slowed down (pulled down). This will 
ensure that the production audio and film transfer will re-
main in sync.

You may receive an OMF, AES 31 or OpenTL file that 
contains audio from the original source tapes conformed 
to the edited video or you may have to record the source 
tapes into Nuendo yourself. Either way, you have audio in 
Nuendo that is edited to the picture but will not stay in 
sync with the video unless you pull down the sample rate. 

The idea is that when you have completed the audio mix 
for your film project, the video will be sped back up to film 
speed for the final transfer back to film and your audio mix 
can then be played at the standard 48 kHz sample rate 
(no pull-down) and will remain in sync with the picture.

Using this method preserves the quality of the original au-
dio recording made during filming and allows for a digital 
mixdown transfer at film speed without any generation 
loss or sample rate conversion.

Audio Pull-up +4.1667% (PAL/SECAM)

Audio pull-up (+4.1667%) is the same concept applied to 
PAL/SECAM video transfers. Since the film is sped up by 
4.1667% during transfer, audio in Nuendo must be run-
ning at +4.1667% speed in order to remain in sync with 
the video during editing and mixing. 

In this case, the external clock must be set to +4% 
varispeed. 

Once the project is complete, Nuendo’s sample clock can 
be returned to normal (48 kHz) for the final mixdown at film 
speed. Once again, this allows for a digital transfer of the 
final master at the correct speed for theatrical presenta-
tion.

Non-standard audio pulls

It is also possible to use pulled sample rates that do not fit 
one of the above scenarios. These sample rates would 
only need to be used in exceptional circumstances when 
an error has occurred elsewhere in the process of making 
a film. These settings could be used to correct for sync er-
rors made at another studio or problems with video editing 
systems. Just about anything is possible. 

• -4% Pull-down
If a film project was transferred to PAL/SECAM video and the audio ed-
iting and mixing was performed at video speed (48 kHz) without using 
audio pull-up, the final mix would be running at video speed not film 
speed. In this case a -4% pull-down could be used to correct this and 
get the audio running at film speed again. The downside to this is that the 
final transfer to film would have to either be analog or through a sample 
rate converter in order to be recorded with the film.

• +0.1% Pull-up
This pull-up is not normally used except in situations similar to the one 
described above but for NTSC video. It could be used to correct the 
speed of a project finished at video speed (without pull-down) prior to 
transferring it to film. Since film is moving 0.1% faster than NTSC video, 
the audio mix could be sped up to film speed using +0.1% pull-up for the 
transfer.

! When you are running at a non-standard sample rate 
(47.952 kHz = 48 kHz pull-down), digital transfers 
into Nuendo from external equipment must be made 
with the external equipment locked to the same sam-
ple clock as your audio card. Most devices are capa-
ble of a 0.1% change in sample rate and will function 
normally. 

! Any audio mixdowns that are exported from Nuendo 
when the sample clock is pulled down, will play back 
in other applications and devices faster since that 
sample clock will be running at the standard 48 kHz.

! Devices such as the Rosendahl Nanosync are capa-
ble of varispeed and have presets for the 4.1667% 
necessary with PAL film transfers and the -0.1% for 
NTSC.
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• Other pull-up/pull-down options
There may be other scenarios where non-standard pull-ups and pull-
downs can be used to correct mistakes. Nuendo provides further pull-
up/pull-down options for such situations in the Project Setup dialog and 
the respective section in the Project Synchronization dialog (see below).

Timeline adjustments when using pull-ups or pull-downs

When the audio clock of your audio card is being slowed 
down or sped up from an external clock source, Nuendo 
has no idea that it is running slower or faster than normal. 
The time displays (minutes:seconds, timecode) will be-
come inaccurate since they are based on a sample count, 
not the independent clock source.

Nuendo provides an adjustment of the timeline to com-
pensate for these changes. This setting is found in the 
Project Setup dialog:

The Pull-up/Pull-down pop-up menu in the Project Setup dialog.

Whenever you apply an audio pull to Nuendo from an ex-
ternal clock, you should also set this menu to the appropri-
ate choice. This allows Nuendo to recalculate the sample 
count to reflect the adjusted sample rate. 

For example, if the setting is switched from no pull-down to 
-0.1% pull-down, events in the timeline will appear longer 
since the sample rate has been slowed down. The event 
display will show the accurate length of events relative to 
timecode, minutes and seconds. The project setup info 
line at the bottom of the Nuendo Track list will also indicate 
whether pull-up or pull-down is applied to this project.

Moving events

When you change the setting in the Pull-up/Pull-down 
pop-up menu and there are events already in the timeline, 
Nuendo prompts you to choose whether or not to keep 
the original sample start times or not.

• Selecting “No” allows events to follow the timecode and min-
utes:seconds clock change and remain at their SMPTE start 
times.

• Selecting “Yes” forces Nuendo to leave events at the same 
sample start time regardless of the clock speed change.

Video Pull-up and Pull-down
Nuendo also provides a method to adjust for film transfers 
by speeding up or slowing down playback of the video 
files in your project. Depending on the situation, it can be 
helpful to make the video file playback at film speed and 
not adjust the audio playback at all.

Adjusting the video playback speed back to film reverses 
the process used when adjusting audio playback speed. 
For NTSC video, the video playback speed must be ad-
justed up +0.1% back to film speed. 

Altering the video playback speed is done in the Device 
Setup dialog (Video Player page). You have two options: 
0.1% pull-up and 0.1% pull-down.

! All the examples used here are with 48 kHz as the 
standard sample rate for the film and video industry. 
However, it is possible to accomplish the same tasks 
using 44.1 kHz, 88.2 kHz, 96 kHz (this is double the 
standard sample rate and commonly used for higher 
fidelity), 176.4 kHz and 192 kHz, provided you have 
an external clock device capable of pulling these 
higher sample rates.

! Nuendo does not offer a video pull-down for PAL/
SECAM since the -4% speed change necessary ex-
ceeds the video player’s capacity for varispeed.
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Video +0.1% pull-up for NTSC

Since NTSC video is running -0.1% slower than the origi-
nal film, pulling the video speed back up by +0.1%, re-
turns it to original film speed. With the video now running 
at the correct film speed, audio originally recorded at 
48 kHz on the film shoot will remain in sync with the video. 
Additionally, the final mix can be digitally transferred back 
to film at 48 kHz without the need for an analog copy or 
sample rate conversion.

Video -0.1% pull-down (non-standard)

Pulling the video speed down for a NTSC video is a non-
standard procedure and would not happen under normal 
circumstances. It is possible to pull down a video file that 
is running at 24 fps -0.1% so it matches with material run-
ning at NTSC video speed. The resulting frame rate is 
23.976 fps.

Speeding up or slowing down the video speed is only 
possible if the video is running through a “computer 
graphics card”. If a professional genlocked video card is 
used, the video playback speed is derived from the gen-
lock input.

What is 23.976 fps used for?

The world of digital video formats is ever changing and the 
results are new developments for every media professional 
involved in movies, television, corporate video and more. 
With the advent of HD cameras that are capable of record-
ing at several different frame rates internally, the options 
available to cinematographers have become staggering.

Since the look of film running at 24 fps is unique, many HD 
productions are filmed at 24 fps to mimic the look of film 
on video. Since the speed change from 24 fps to 29.97 
fps NTSC is such an odd one (requiring the 0.1% pull-
down), designers of these cameras have developed a 
method of recording that allows the camera to record like 
film but also output a NTSC video signal at the same time 
without any speed change. They record at 23.976 fps 
which translates to 24 fps pulled down -0.1%.

Many of the high-end professional HD cameras allow 
you to record at 23.976 fps, 25 fps, 29.97 fps, 30 fps, 
59.94 and even 60 fps.
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Introduction
ReWire and ReWire2 are special protocols for streaming 
audio between two computer applications. Developed by 
Propellerhead Software and Steinberg, ReWire provides 
the following possibilities and features:

• Real-time streaming of up to 64 separate audio chan-
nels (256 with ReWire2), at full bandwidth, from the “syn-
thesizer application” into the “mixer application”.
In this case, the “mixer application” is of course Nuendo. An example of a 
“synthesizer application” is Propellerhead Software’s Reason.

• Automatic, sample accurate synchronization between 
the audio in the two programs.

• The possibility to have the two programs share one audio 
card and take advantage of multiple outputs on that card.

• Linked transport controls that allow you to play, rewind, 
etc., either from Nuendo or from the synthesizer applica-
tion (provided it has some kind of transport functionality).

• Automatic audio mixing functions of separate channels 
as required.
In the case of Reason, for example, this allows you to have separate 
mixer channels for the different devices.

• Additionally, ReWire2 offers the possibility to route MIDI 
tracks in Nuendo to the other application, for full MIDI con-
trol.
For each ReWire2 compatible device, a number of extra MIDI outputs 
will be made available in Nuendo. In the case of Reason, this allows you 
to route different MIDI tracks in Nuendo to different devices in Reason, 
having Nuendo serve as main MIDI sequencer.

• The overall load on your system is much reduced, com-
pared to when using the programs together in the conven-
tional way.

Launching and quitting
When using ReWire, the order in which you launch and 
quit the two programs is very important:

Launching for normal use with ReWire
1. First launch Nuendo.

2. Enable one or several ReWire channels in the ReWire 
Device dialog for the other application.
This is described in detail in the section “Activating ReWire channels” on 
page 484.

3. Launch the other application.
It may take slightly longer for the application to start when you are using 
ReWire.

Quitting a ReWire session
When you are finished, you also need to quit the applica-
tions in a special order:

1. First quit the synthesizer application.

2. Then quit Nuendo.

Launching both programs without using 
ReWire
We cannot think of any scenario, in which you would need 
to run Nuendo and the synthesizer application simulta-
neously on the same computer, without using ReWire, but 
you can:

1. First launch the synthesizer application.

2. Then launch Nuendo.

Please note that the two programs now compete for 
system resources such as audio cards, just as when run-
ning either with other, non-ReWire audio applications.
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Activating ReWire channels
ReWire supports streaming of up to 64 separate audio 
channels, while ReWire2 supports 256 channels. The ex-
act number of available ReWire channels depends on the 
synthesizer application. Using the ReWire Device panels 
in Nuendo, you can specify which of the available chan-
nels you want to use:

1. Pull down the Devices menu and select the menu item 
with the name of the ReWire application. All recognized 
ReWire compatible applications will be available on the 
menu.
The ReWire panel appears. This consists of a number of rows, one for 
each available ReWire channel.

The ReWire panel for Reason.

2. Click on the power buttons to the left to activate/de-
activate the desired channels.
The buttons light up to indicate activated channels. Please note that the 
more ReWire channels you activate, the more processing power is re-
quired.

• For information about exactly what signal is carried on 
each channel, see the documentation of the synthesizer 
application.

3. If desired, double-click on the labels in the right col-
umn, and type in another name.
These labels will be used in the Nuendo mixer to identify the ReWire 
channels.

Using the transport and tempo 
controls

Basic transport controls
When you run ReWire, the transports in the two programs 
are completely linked. It doesn’t matter in which program 
you Play, Stop, Fast Forward or Rewind. However, record-
ing (if applicable) is still completely separate in the two 
applications.

Loop settings
If there is a loop or cycle facility in the synthesizer applica-
tion, that loop will be completely linked to the cycle in Nu-
endo. This means that you can move the start and end 
point for the loop or turn the loop on or off in either pro-
gram, and this will be reflected in the other.

Tempo settings
As far as tempo goes, Nuendo is always the master. This 
means that both programs will run in the tempo set in Nu-
endo.

However, if you are not using the Tempo track in Nuendo, 
you can adjust the tempo in either program, and this will 
immediately be reflected in the other.

! This is only relevant if the synthesizer application has 
some sort of built-in sequencer or similar.

! If you are using the Tempo track in Nuendo (i.e. the 
Tempo button is activated on the Transport panel), 
you should not adjust the tempo in the synthesizer 
application, since a tempo request from ReWire will 
automatically deactivate the Tempo track in Nuendo!
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How the ReWire channels are 
handled in Nuendo
When you activate ReWire channels in the ReWire De-
vice panels, they will become available as channel strips in 
the mixer. The ReWire channel strips have the following 
properties:

• ReWire channels appear to the right of the other audio 
and MIDI channel strips in the mixer.

• ReWire channels may be any combination of mono and 
stereo, depending on the synthesizer application.

• ReWire channels have the same functionality as regular 
audio channels.
This means you can set volume and pan, add EQ, insert effects and 
sends and route the channel outputs to groups or busses (done in the In-
spector. However, ReWire channels have no monitor buttons.

• All ReWire channel settings can be automated using 
the Read/Write buttons.
When you write automation, channel automation tracks will automatically 
appear in the Project window. This allows you to view and edit the auto-
mation graphically, just as with VST Instrument channels, etc.

• You can mix down the audio from ReWire channels to a 
file on your hard disk with the Export Audio Mixdown func-
tion (see “Mixing down to an audio file” on page 438).
You can export the output bus to which you have routed the ReWire 
channels. You can also export individual ReWire channels directly – 
“rendering” each ReWire channel to a separate audio file.

Routing MIDI via ReWire2

When using Nuendo with a ReWire2-compatible appli-
cation, additional MIDI outputs will automatically appear 
on the MIDI Output pop-up menus for MIDI tracks. This 
allows you to play the synthesizer application via MIDI 
from Nuendo, using it as one or several separate MIDI 
sound sources.

The MIDI outputs for a Reason song. Here, each output goes directly to 
a device in the Reason rack.

• The number and configuration of MIDI outputs depends 
on the synthesizer application.

Considerations and limitations
Sample rates

Synthesizer applications may be limited to audio playback 
in certain sample rates. If Nuendo is set to a sample rate 
other than those, the synthesizer application will play back 
at the wrong pitch. Consult the documentation of the syn-
thesizer application for details.

ASIO drivers

ReWire works well with ASIO drivers. By using the Nuendo 
bus system you can route sounds from the synthesizer 
application to various outputs on an ASIO compatible audio 
card.

! This feature is only available with ReWire2-compati-
ble applications.



38
File handling



487

File handling

Working with Projects

New Project
The New Project command on the File menu allows you to 
create a new project, either empty or based on a template:

1. Select New Project from the File menu.
By default, this list is empty. How to create templates is described in the 
section (see “Save as Template” on page 488).

2. Select “Empty”.
A file dialog opens, allowing you to specify a folder for the new project.

3. Select an existing project folder or click on Create and 
enter a name for a new one in the dialog that opens.
A new, untitled project is created.

Open
The Open command on the File menu is used for opening 
saved project files. Project files created with Nuendo (file 
extension “.npr”), Cubase (file extension “.cpr”) and Se-
quel (extension “.steinberg-project”) can be opened. Note 
that program-specific settings which cannot be applied in 
Nuendo will be ignored.

1. Select Open… from the File menu.
A file dialog opens, allowing you to select a project.

2. Click Open.
The project opens in the Project window.

• Several projects can be open at the same time.
This is extremely useful, if you want to copy parts or entire sections from 
one project to another.

3. If a project is already opened, opening another project 
brings up a warning.

• Click “No” to open the other project inactive.
This significantly reduces load times, especially for large projects. 

• Click “Activate” to open and activate the new project.
The active project is indicated by the blue Activate button in the upper 
left corner of the Project window. To make another project active, simply 
click its Activate button.

An active project.

• You can also open project files by selecting an entry 
from the “Recent Projects” submenu on the File menu.
This submenu lists the projects you have recently worked with, with the 
most recent one at the top of the list.

• Projects can also automatically be opened when you 
launch Nuendo (see “Startup Options” on page 489).

• You can drag projects from the MediaBay into the Nu-
endo application window (not into an existing Project win-
dow) to open them.

About the “Pending Connections” dialogs

If you open a Nuendo project created on another setup 
(other audio hardware), the program tries to find matching 
audio inputs and outputs for the i/o busses (this is one of 
the reasons why you should use descriptive, generic names 
for your input and output ports – see “Preparations” on 
page 12).

If the program cannot resolve all audio/MIDI inputs and 
outputs used in the project, a Pending Connections dialog 
will open. This will allow you to manually re-route any ports 
specified in the project to ports available in your system.

Close
The Close command on the File menu closes the active 
window. If a Project window is active, selecting Close will 
close the corresponding project.

• If the project contains unsaved changes, you will be 
asked whether you want to save the project before closing 
it.
If you select “Don’t Save” and have recorded or created new audio files 
since saving, you get the choice to delete or keep these.
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Save and Save As
The commands Save and Save As allow you to save the 
active project as a project file (file extension “.npr”). The 
Save command stores the project under its current name 
and location, while Save As allows you to rename and/or 
relocate the file. If a project has not been saved yet or if it 
hasn’t been changed since it was last saved, only Save As 
will be available.

A word about file extensions

Under Windows, file types are indicated by three letter file 
name extensions (such as *.npr for Nuendo project files). 

Under Mac OS X, it is not necessary to use file name ex-
tensions, since the file types are stored internally in the 
files. However, if you want your Nuendo projects to be 
compatible with both platforms, you should make sure the 
option “Use File Extension in File Dialog” is activated in 
the Preferences (General page). When this is activated 
(default), the proper file name extension is automatically 
added when you save a file.

Save New Version
This function is only available as a key command, by de-
fault [Ctrl]/[Command]+[Alt]/[Option]+[S]. When you use 
this function, a new version of the project will be saved. 

The new file will get the same name as the original project, 
but with an incremental number attached. For example, if 
your project is called “My Project”, you will get new versions 
called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with 
edits and arrangements and want to be able to go back to 
a previous version at any time. The newest versions are al-
ways listed on the Recent Projects submenu on the File 
menu for instant access.

Save as Template
This function allows you to save the current project as a 
template. When you create a new project, the available 
templates will be listed, allowing you to base the new 
project on a template.

Proceed as follows:

1. Set up a project.

2. Select “Save As Template…” from the File menu and 
save the project template under the desired name.

• Templates can contain clips and events just like regular 
projects.
If this is not what you want, make sure to remove all clips from the Pool 
before you save the project as template.

Templates are always stored in the Templates folder. 

On a Windows system, it is located at \Documents and 
Settings\<username>\Application data\Steinberg\Nu-
endo 4\templates. On a Mac system, it is located inside 
Users/<username>/Library/Preferences/Nuendo 4.

Setting up a default template

If you always want the same default project to open when 
you launch Nuendo, you can save a default template. Pro-
ceed as follows:

1. Set up a project.

2. Select “Save As Template…” from the File menu and 
save the project template with the name “default”. 

3. Open the Preferences dialog and select the General 
page.

4. Open the “On Startup” pop-up and select “Open ’De-
fault’ Template”.

The next time you launch Nuendo, the default template will 
automatically be opened. For details on the other Startup 
options, see “Startup Options” on page 489.

! Generally, we recommend that you save project files 
in their project folders, to keep the projects as 
manageable as possible.
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Save Project to New Folder
This function is very useful if you want to move or archive 
your project. 

1. Select “Save Project to New Folder”. 
A file dialog opens in which you can choose an existing, empty folder or 
create a new folder to save the project.

2. Click OK to confirm your choice.
The “Save to Folder Options” dialog opens with the following options:

3. Make the desired settings.

4. Click OK. 
The project is saved in the new folder. The original project is not affected. 
However, now you could e.g. delete the original project without losing 
your project data.

Startup Options

Auto Save

If you activate the Auto Save option in the Preferences 
(General page), Nuendo will automatically save backup 
copies of all open projects with unsaved changes.

Backup copies of projects are named “<project name>-
xx.bak”, where xx is an incremental number. Unsaved 
projects are backed up in a similar way as “UntitledX-
xx.bak”, with X being the incremental number for unsaved 
projects. All backup files are saved in the project folder. 

• Use the “Auto Save Interval” setting to specify the time 
intervals in which a backup copy will be created.

• Use the “Maximum Backup Files” option to specify how 
many backup files will be created with the Auto Save func-
tion.
When the maximum number of backup files is reached, the existing files 
will be overwritten (starting with the oldest file). 

On Startup
The “On Startup” pop-up menu in the Preferences (Gen-
eral page) allows you to specify what should happen each 
time you launch Nuendo. 

Option Description

Project Name Enter a project name if you want to change it from the de-
fault (the current name of the project).

Minimize Audio 
Files

If this is activated, only the audio file portions that are ac-
tually used in the project will be included. This can signi-
ficantly reduce the size of the project folder (if you are 
using small sections of large files), but it also means you 
cannot use other portions of the audio files if you con-
tinue working with the project in its new folder.

Freeze Edits This will perform a Freeze Edits operation, making all pro-
cessing and applied effects permanent to each clip in the 
Pool, see “Freeze Edits” on page 253.

Remove 
Unused Files

When this is activated, only files in the Pool that are actu-
ally used in the project will be stored in the new folder.
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The following options are available:

Nuendo Open Document Options Dialog

This dialog will open in two cases:

• If you launch Nuendo with the option “Show Open Op-
tions Dialog” selected on the “On Startup” pop-up menu 
in the Preferences (General page).

• If you hold down [Ctrl]/[Command] while launching Nu-
endo.

The Open Document Options Dialog.

The dialog lists your recently used projects.

• To open a project, select it and click the “Open Selec-
tion” button. 

• To open another project not listed here, click the “Open 
Other…” button. 
A file dialog opens that allows you to look for the desired file on your disk. 

• To create a new project, click the “New Project” button.

Working with libraries
A library is a stand-alone Pool that is not associated with a 
project file (for more information about Pools, see “The 
Pool” on page 296). You can use libraries to store sound 
effects, loops, video clips, etc., and transfer media from a 
library into a project by using drag and drop. The following 
library functions are available on the File menu:

New Library

Creates a new library. Just as when creating new projects, 
you will be asked to specify a project folder for the new li-
brary (in which media files will be stored). The library will 
show up as a separate Pool window in Nuendo. 

Open Library

Opens a file dialog for opening a saved library file.

Save Library

Opens a file dialog for saving the library file (file extension 
“.npl”).

Revert
If you select “Revert” from the File menu, you will be asked 
whether you really want to revert to the last saved version 
of the project. If you click “Revert”, all changes you have 
made since saving will be discarded.

If you have recorded or created new audio files since sav-
ing, you will be asked whether you want to delete or keep 
these.

Option Description

Do Nothing Nuendo launches without opening a project.

Open Last 
Project

The last saved project is opened on launch.

Open ’Default’ 
Template

The default template is opened, see “Setting up a default 
template” on page 488.

Show Open 
Dialog

The Open dialog opens on launch, allowing you to manu-
ally locate and open the desired project.

Show Template 
Dialog

The Template dialog opens on launch, allowing you to 
create a new project from one of the templates.

Show Open 
Options Dialog

The Open Document Options dialog opens on launch, 
see below. It allows you to make a different choice each 
time you launch Nuendo.
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Importing audio
For exporting Audio, see the chapter “Export Audio 

Mixdown” on page 437.

For the option “Replace Audio in Video File”, see “Re-
placing the audio in a video file” on page 474.

Importing audio files
For information on audio file import preferences, please 
see “Audio file import options” on page 41. For informa-
tion on import into the Pool and import options, see “Im-
port Medium…” on page 306.

Importing audio CD tracks
You can import audio from audio CDs into Nuendo 
projects in two ways:

• To import the CD tracks directly into project tracks, 
choose the “Audio CD…” option from the Import sub-
menu on the File menu.
The imported audio CD track(s) will be inserted on the selected audio 
track(s) at the project cursor position.

• To import the CD tracks into the Pool, select “Import 
Audio CD” from the Media menu.
This might be the preferred method if you want to import several CD 
tracks in one go. For more information, see “Importing audio CD tracks” 
on page 308.

Selecting one of the Import Audio CD menu items brings 
up the following dialog:

To import one or more tracks, proceed as follows:

1. If you have more than one CD drive, select the correct 
one from the Drives pop-up menu top left.
On opening the CD, the program tries to retrieve the track names from 
CDDB (a CD database). If no connection to CDDB can be established 
or the CD track names are not found, you can manually change the ge-
neric track name in the Default Name field, see below.

2. Activate the “Secure Mode” option, if you want to use 
a Secure Read mode.
Activate this if you encounter problems when trying to import an audio 
CD. Error checking and correction will be done during the process. Note 
that this mode will take more time.

3. In the Windows version, select the data transfer speed 
from the Speed pop-up menu.
While you normally want to use the fastest possible speed, you may have 
to select a slower speed for flawless audio extraction.

4. Activate the Copy checkbox for every audio file you 
want to import.
You can also select a copy section for every file, see below.
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5. Click on Copy to generate a local copy of the audio 
file(s) or section(s).
The copied files are listed at the bottom of the dialog. By default, imported 
audio CD tracks will be stored as Wave files (Windows) or AIFF files (Mac) 
in the Audio folder of the current project. To change the folder, click Folder 
and select another one from the dialog. During copying, the button is la-
beled “Stop”; click it to stop the process.

6. Click OK to import the copied audio files into the 
project, or click Cancel to stop the import and discard the 
copied files.

• If you import more than one audio file into project tracks, 
a dialog opens in which you have to choose whether to in-
sert the tracks on one track or on different ones. 
The new track(s) are displayed in the Project window. New audio clips 
are created and added to the Pool.

The columns in the “Import from Audio CD” dialog have 
the following functionality:

By default, the complete tracks are selected. 

• If you want to copy and import a section of an audio CD 
track only, select the track in the list and specify the start 
and end of the selection to be copied by dragging the 
handles in the copy selection ruler.
Use the start and end audition buttons to fine tune the selection bound-
aries.

Note that you can import sections of several audio CD 
tracks by selecting them in turn and adjusting the selec-
tion. The start and end settings for each track will be dis-
played in the list.

• You can audition the selected audio CD track by click-
ing the Play button.
The track will be played back from selection start to selection end (or un-
til you click the Stop button). 

• The arrow up/down buttons allow you to audition the 
start and end of the selection only.
The arrow down button will play a short snippet beginning at the start of 
the selection, while the arrow up button will play a snippet starting just 
before the end of the selection.

• In case no connection to CDDB could be established or 
no CD track names were found, you can change the ge-
neric audio file name in the Default Name field.
The imported audio files be will be named accordingly, i.e. <default 
name> 01 etc.

Note that if there is a track name for a specific audio 
CD track in the list, the corresponding audio file will use 
that name instead.

• To open the CD drive, click on the Eject button at the 
top of the dialog. 

Column Description

Copy Activate the checkbox in this column for the track you 
want to copy/import. To activate more than one check-
box, click and drag over the checkboxes (or press [Ctrl]/
[Command] or [Shift] and click).

# Number of track.

CD Track When you import an audio CD track, the file will be 
named according to the name in this column. The names 
are pulled automatically from CDDB, if possible. You can 
rename a track by clicking in the Track column and typing 
a new name. You can also apply a generic name to all au-
dio CD tracks, if no name was available in CDDB.

Length The length of the audio CD track in minutes and seconds.

Size The file size of the audio CD track in MegaBytes.

Copy Start You can copy a section of a track if you like. This indi-
cates the start of the section to be copied in the track. By 
default, this is set to the start of the track (0.000) but you 
can adjust this on the copy selection ruler (see below).

Copy End Indicates the end of the section to be copied in the track. 
By default, this is set to the end of the track but you can 
adjust this on the copy selection ruler (see below).

Play
Stop

Play start of selection

Play end of selection

Start of selection handle End of selection handle
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Importing Audio from Video files
While you can automatically extract the audio when im-
porting a video file (see “Extracting audio from a video file” 
on page 472), it is also possible to import the audio from a 
video file without importing the video itself:

1. Pull down the File menu and select “Audio from Video 
File…” from the Import submenu.

2. In the file dialog that opens, locate and select the 
video file and click Open.
The audio in the selected video file is extracted and converted to a Wave 
file in the project’s Audio folder.

• A new audio clip is created and added to the Pool. In the 
Project Window, an event referencing the audio file will be 
inserted on the selected track at the project Cursor posi-
tion. If no track was selected, a new track will be created.
This works just like when importing regular audio files.

For importing video files, see “Importing a video file” 
on page 470.

Importing ReCycle files
ReCycle by Propellerhead Software is a program designed 
especially for working with sampled loops. By “slicing” a 
loop and making separate samples of each beat, ReCycle 
makes it possible to match the tempo of a loop and edit the 
loop as if it was built of individual sounds. Nuendo can im-
port two file types created by ReCycle:

• REX files (export file format of the first versions of ReCycle, 
extension “.rex”).

• REX 2 files (file format of ReCycle 2.0 and later, extension 
“.rx2”).

Proceed as follows:

1. Select an audio track and move the project cursor to 
where you want the imported file to start.
You probably want to import REX files to tempo based audio tracks, since 
this will allow you to change the tempo later on (having the imported REX 
file automatically adjust).

2. Select “Audio File…” from the Import submenu on the 
File menu.

3. Select REX files or REX 2 files with the file type pop-
up menu in the file dialog.

4. Locate and select the file and click Open.
The file is imported and automatically adjusted to the current Nuendo 
tempo. 

Unlike a regular audio file, the imported REX file will con-
sist of several events, one for each “slice” in the loop. The 
events will automatically be placed in an audio part on the 
selected track and positioned so that the original internal 
timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you 
can edit each slice separately by muting, moving and re-
sizing events, adding effects and processing, etc.
You can also adjust the tempo and have the REX file automatically follow 
(provided that its track is tempo based).

You can achieve similar results by using Nuendo’s 
own loop slicing features, see “Working with hitpoints and 
slices” on page 278.

Importing compressed audio files
Nuendo can import (and export, see “Mixing down to an 
audio file” on page 438) several common audio compres-
sion formats. The procedure is the same as when import-
ing any non-compressed audio file, with one important 
thing to note:

• When you import a compressed audio file, Nuendo will 
create a copy of the file and convert this to Wave format 
(Windows) or AIFF format (Mac OS X) before importing it. 
The original compressed file will not be used in the project.

The imported file will be placed in the designated project 
Audio folder.

! The resulting Wave/AIFF file will be several times 
larger than the original compressed file.
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The following file types are supported:

MPEG audio files

MPEG, which stands for Moving Picture Experts Group, is 
the name of a family of standards used for coding audio-
visual information (e. g. movies, video, music) in a digital 
compressed format. 

Nuendo can read two types of audio MPEG files: MPEG 
Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Currently, 
mp3 is the most common of these formats, while the mp2 
format is mostly used in broadcast applications.

Ogg Vorbis files

Ogg Vorbis is a relatively new format that is open and 
patent-free and offers very small audio files maintaining 
comparatively high audio quality. Ogg Vorbis files have the 
extension “.ogg”.

Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by 
Microsoft Inc. Due to advanced audio compression algo-
rithms, Windows Media Audio files can be made very 
small, maintaining good audio quality. The files have the 
extension “.wma”.

Exporting and importing OMF files
Open Media Framework Interchange (OMFI) is a platform 
independent file format intended for transfer of digital me-
dia between different applications. Nuendo can import 
and export OMF files (file extension “.omf”), allowing you 
to use Nuendo in conjunction with other audio and video 
applications.

Exporting OMF files
You can only export stereo files in OMF format.

1. Pull down the File menu and open the Export submenu. 

2. On the submenu, select “OMF…”.
The Export Options dialog opens:

3. Use the track list to the left to select which tracks 
should be included in the exported file.
To select all tracks, click the “Select All” button. Normally, the whole 
project is included – to export the range between the locators only, 
activate “From Left to Right Locator”.

• When referencing media files (see below), you can set 
the referenced output path by entering it in the “Media 
Destination Path” field or by browsing the file dialog.
All file references will be set to this path. You can create references to 
media destinations that don’t exist on the system you are currently work-
ing with, making it easy to prepare files for use in projects on another 
system or in a network environment.

4. If you want to create copies of all the media files, 
choose the “Copy Media” option.
By default, the copied audio files are placed in a sub-directory in the ex-
port destination folder. To specify a different location for the copied files, 
use the “Media Destination Path” field.

5. If you want to copy only the portions of audio files that 
are used in the project, select “Consolidate Events” option. 
You can also define handle lengths in milliseconds to include audio out-
side each event boundary for fine tuning later. If you do not have any han-
dles when consolidating audio files, you will not be able to adjust fades 
or edit points when the project is imported in another application.

6. Select “1.0 File” or “2.0 File”, depending on which 
OMFI version is supported by the application in which you 
plan to import the file.
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• Select whether you want to include all audio data in the 
OMF file (“Export All to One File”) or use references only 
(“Export Media File References”).
If you choose “Export All to One File”, the OMF file will be totally “self-
contained”, but possibly very large. If you choose “Export Media File Ref-
erences”, the file will be small, but the referenced audio files must be 
available for the receiving application.

7. If you selected the “2.0 File” option above, you can 
choose whether to include the volume settings and fades 
for the events (as set up with the event volume and fade 
handles) as well as the clip names – to include these in 
the OMF file, activate “Export Clip Based Volume”, “Use 
Fade Curves” and/or “Export Clip Names”, respectively.

8. Specify a sample size (resolution) for the exported files 
(or use the current project settings).

9. If you activate “Quantize Events to Frames”, the event 
positions in the exported file will be moved to exact frames.

10. Click OK, and specify a name and location in the file 
dialog that opens.

The exported OMF file will contain (or reference) all audio 
files that are played in the project (including fade and edit 
files). It will not include unused audio files referenced in 
the Pool, or any MIDI data. Video files are not included.

Importing OMF files
1. Pull down the File menu and open the Import submenu.

2. On the submenu, select “OMF…”.

3. In the file dialog that opens, locate the OMF file and 
click Open.

• If there is already an open project, a dialog opens in 
which you can select whether a new project should be 
created for the file or not.
If you select “No”, the OMF file will be imported into the current project.

4. If you choose to create a new project, a file dialog 
opens in which you can select the project folder.
Select an existing project folder or create a new one by clicking on Cre-
ate and entering a name in the dialog.

5. The Import options dialog opens, allowing you to 
choose a track for the import.
Activating the “Import all media” option allows you to import media that is 
not referenced by events.
Activating the “Import Clip Gain as Automation” option imports volume 
automation and envelopes of the Volume Automation Track of each track.

• If the OMF file contains Video Event information, you are 
asked whether you want to create Markers at the start po-
sition of the Video Events.
This allows you to manually import the video files, using the Markers as 
position references.

A new, untitled project is created (or tracks are added to 
the existing project), containing the Audio Events of the 
imported OMF file.

Exporting and importing AAF files
The Advanced Authoring Format (AAF) is a multimedia file 
format used to exchange digital media and meta data be-
tween different systems and applications across multiple 
platforms. Designed by the top media software compa-
nies, this format will help media creators by allowing them 
to exchange projects between applications without losing 
valuable meta data such as fades, automation and pro-
cessing information.

Exporting AAF files
1. Select “AAF…” from the Export submenu on the File 
menu.

The Export Options dialog for AAF files.
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2. You can choose which tracks will be exported from 
your project by clicking in the export column for each track 
name in the list.
A check mark will appear next to each track that will be exported. You 
may also click the “Select All” button to select every track in the project 
for export.

3. If you wish to only export the portion of project that is 
between the left and right locators, check the box marked 
“From Left to Right Locator.”
If an event crosses over the left or right locator, it will be trimmed in the 
AAF file to the point of the locator. Only the portions of events that lie 
within the boundaries of the locators will be included in the exported file.

4. If you want to create copies of all the media files, 
choose the “Copy Media” option.
By default, the copied audio files are placed in a sub-directory in the ex-
port destination folder. To specify a different location for the copied files, 
use the Media Destination Path field.

5. If you want to copy only the portions of audio files that 
are used in the project, select the “Consolidate Events” 
option. 
You can also define handle lengths in milliseconds to include audio out-
side each event boundary for fine-tuning later. If you do not have any 
handles when consolidating audio files, you will not be able to adjust 
fades or edit points when the project is imported in another application.

Even when selecting neither of the above two options, 
you can still enter a media destination path.
All file references will be set to this path. You can create references to 
media destinations that don’t exist on the system you are currently work-
ing with, making it easy to prepare files for use in projects on another 
system or in an network environment.

6. In the Options section, you have the choice of export-
ing all data to one file or to create media references to files 
from within the AAF file.
Exporting only one file makes transfers simpler, but, at the time of writing 
of this manual, certain applications cannot handle single AAF files. 
Check with each software manufacturer for up-to-date information re-
garding AAF support in other applications.

7. You can specify the Sample Size by using the pop-up 
menu. 
This defaults to keeping the same setting as the project.

8. You can quantize events to frame boundaries by acti-
vating the last option.
Quantizing events to frame boundaries is sometimes necessary when ex-
porting projects to video workstations that limit the accuracy of edits to the 
frame. Any events that begin or end not on a frame boundary can exhibit 
odd behavior or be moved when imported into a workstation of this type.

Importing AAF files
1. Select “AAF…” from the Import submenu on the File 
menu.

2. Once you have selected a valid AAF file, Nuendo will 
ask you if you wish to create a new project. Choosing Yes 
will import tracks into a new project.

3. Select a directory or create one for the new project. 
If you choose not to create a new project, the imported tracks will be 
added to the currently active project.

4. In the dialog that opens, select the tracks you wish to 
import by clicking in the Import column next to each track.
You can also click the Select All button to import all tracks in the AAF file.

5. Click OK.
The import process will begin. Depending on the size of the imported 
project and if the files are embedded or referenced, the import process 
may take a while.

Exporting and importing AES31 files
The AES31 standard is an open file interchange format, de-
veloped by the Audio Engineering Society as a means of 
overcoming format incompatibility issues between different 
audio hardware and software. It can be used for transferring 
projects via disk or network from one workstation to an-
other, retaining time positions of events, fades, etc.

AES31 uses the widely used Microsoft FAT32 file system 
with Broadcast Wave as the default audio file format. This 
means that an AES31 file can be transferred to and used 
with any digital audio workstation that supports AES31, 
regardless of the type of hardware and software used, as 
long as the workstation can read the FAT32 file system 
and Broadcast Wave files (or regular wave files).

Exporting AES31 files
1. Select “AES31…” from the Export submenu on the 
File menu.

2. Select a name and location for the new file and click 
Save.
The exported file will contain all Audio Track data, including audio file refer-
ences. If any of the audio events in your project has real-time fades (as set 
up with the fade handles for the events), these will automatically be con-
verted to fade audio files and stored in a fades folder next to the AES31 
file.
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The following will not be included in the resulting AES file:

• Any mixer settings or automation made in Nuendo. 
• MIDI Tracks.

The saved file will be an xml file (but with the extension 
“.adl”, for audio decision list) – this means you can open it 
in any text editor to check file references etc.

Importing AES31 files
1. Select “AES31…” from the Import submenu on the 
File menu.

2. Navigate to the location of the AES31 file (extension 
“.adl”), select it and click Open.
You are prompted to select or create a project folder for the new project.

3. After specifying the name and location of the project 
folder, the new project opens containing all the audio 
tracks and events stored in the AES31 file.

Exporting and importing OpenTL files
OpenTL is a file exchange format originally developed for 
Tascam hard disk recording systems. OpenTL facilities 
also exist in a variety of DAWs, making Nuendo project 
transfer reliable and solid. For example, a common use of 
OpenTL is to convert hassle free between Nuendo and 
Pro Tools. If you import or export an OpenTL file to/from 
Nuendo, the resulting project will contain all audio files, 
edits, and track names made in the Tascam device or 
DAW, with all events positioned sample accurately on the 
time line.

OpenTL implementation in Tascam® MMR-8, 
MMP-16 and MX-2424
All three Tascam devices work with either two types of 
disk volume formats: FAT32 (Windows standard) or 
HFS+ (Mac OS standard). For proper Nuendo compati-
bility it is necessary that each and every MMR-8/MMP-16 
be running OS v5.03 and MX-2424 v3.12. A number of 
crucial OpenTL updates only appear in these machine op-
erating systems, and only this setup can assure reliable 
Nuendo exchange.

Audio file formats are volume type dependent: for FAT32 
this is BWF (*.wav) and for HFS+ this is SDII. OpenTL 
files can only be transferred within file systems of the 
same format which means that it is not possible to import 
an OpenTL project exported from Mac (HFS+) into a 
Windows system (FAT32) or vice versa, unless you use a 
conversion utility (e.g. MM-EDL).

Nuendo for Windows supports OpenTL FAT32/BWF. 
Nuendo for Mac OS X supports OpenTL HFS+/SDII as 
well as FAT32/BWF. MMR-8, MMP-16, and MX-2424 
support OpenTL projects sourcing or targeting Nuendo 
PC with up to 999 mono tracks.

Exporting OpenTL files
First, make sure all audio files (in the Pool) and tracks (in 
the Project window) in the project are in mono (split ste-
reo tracks and stereo interleaved audio files to dual mono) 
and all 16-bit or all 24-bit. The OpenTL specification does 
not include support for 32-bit audio files. If the Pool con-
tains 32-bit audio files, these will not be exported. Make 
sure all referenced audio files are located on the drive to 
which you want to export the OpenTL file.

1. Select “OpenTL…” from the Export submenu on the 
File menu.
In the dialog that opens, activate the “Copy Media” or the “Consolidate 
Events” option to guarantee that all audio is exported. Locate the target 
hotswap FAT32 disk, select the appropriate project folder and click Open.

2. Select a name and location for the new file and click 
Save.
The exported file will contain all audio track data, including file references, 
clip based volume automation, fade-in, fade-out, and crossfades. 

3. Now you can mount the carrier in the Tascam device 
and load the project.

The following will not be included in the resulting OpenTL 
EDL file: 

• Any real-time mixing, EQ, effects settings, breakpoint automa-
tion tracks

• MIDI tracks made in Nuendo

! When exporting OpenTL files on PC, do not change 
the DF or NDF frame notation after you have set the 
project start time. Make sure that all audio files in the 
Pool have the same sample rate, bit depth, and that 
all are set to Broadcast Wave file type.



498

File handling

The following is a basic OpenTL specification description:

• Maximum number of mono tracks: 999
• Supported samplerates (Hz): 44056, 44100, 44144, 47952, 

48000, 48048, 42294, 42336, 45938, 45983, 46034, 
46080, 50000, 50050, 88200, 96000

• Bit depth: 16, 24
• Audio file types: BWF (Broadcast Wave format), WAVE 

(Standard Wave), SDII (Sound Designer II)
• Volume formats: FAT32, NTFS, HFS+
• Automation support: clip based volume, breakpoint volume 

and mute
• Fade support: fade in, fade out, and cross fade
• Frame rates (Fps): 24/24, 23.976/24, 24.975/25, 25/25, 

29.97/DF, 29.97/NDF, 30/DF, 30/NDF 

Importing OpenTL files
1. Select “OpenTL…” from the Import submenu on the 
File menu.

2. Navigate to the location of the OpenTL file, select it 
and click Open.

3. You are prompted to select or create a project folder 
for the new project.
After specifying the name and location of the project folder, the new 
project opens containing all the audio files stored in the OpenTL file and 
their associated edits. Save the imported file as a Nuendo project. 

4. Open the Pool, and select “Prepare Archive…” from 
the Pool context menu. 
This will copy any necessary external audio files into the local Nuendo 
project directory. 

5. Select the Save option from the File menu. 

Importing XSend projects from 
Liquid
For Liquid users, XSend provides a means to export a Liq-
uid sequence directly to a Nuendo workstation either on 
the same machine, over a network or via portable media 
such as DVD-R.

The XSend options and features are available only if 
XSend is installed on your computer. You can either install 
XSend during the Nuendo installation process, or at a 
later point in time using the XSend installer supplied on 
the Nuendo program DVD. Also, make sure the XSend 
plug-in is activated in the Plug-in Information window.

Proceed as follows to import XSend files:

1. You must designate the XSend Incoming folder by se-
lecting the XSend preferences from the Nuendo File menu.
A dialog opens, allowing you to browse your system to select a folder 
where exported Liquid projects will be stored.

2. Export the Liquid project to the Nuendo system.
This can be done directly over a network if the two systems are con-
nected by one. No file sharing is needed. All file transfers are handled by 
XSend. Refer to the Liquid system’s documentation for more information 
on how to do this. You may also export the sequence to portable media 
such as DVD-R or CD-R discs for transfer when no network is available.

3. On the File menu–Import submenu, select “XSend…”.
Navigate to the exported Liquid sequence which will be an .XSD file type.

4. You will be asked if you wish to create a new project.
Choose Yes if you want to import the XSend sequence into a blank 
project. If you choose No, the imported sequence will be appended to 
the currently active project. The new audio tracks are displayed below 
the lowest track or channel in the project. In either case, both audio and 
video files can be included in the XSend sequence, providing a conve-
nient means to receive entire projects from Liquid users.

Exporting and importing standard 
MIDI files
Nuendo can import and export Standard MIDI Files, which 
makes it possible to transfer MIDI material to and from vir-
tually any MIDI application on any platform. When you im-
port and export MIDI files, you can also specify whether 
certain settings associated with the tracks should be in-
cluded in the files (automation subtracks, volume and pan 
settings etc.). 

Exporting MIDI files
To export your MIDI tracks as a Standard MIDI File, pull 
down the File menu and select “MIDI File…” from the Ex-
port submenu. A regular file dialog opens, allowing you to 
specify a location and name for the file.
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When you have specified a location and a name for the file, 
click “Save”. The Export Options dialog opens, allowing you 
to specify a number of options for the file – what should be 
included in the file, its type and its resolution (see below for 
descriptions of the options).

The Export Options dialog.

You will also find these settings in the Preferences (MIDI–
MIDI File page). If you set these up once and for all in the 
Preferences, you only need to click OK in the Export Op-
tions dialog to proceed.

The dialog contains the following options:

The MIDI file will include the Tempo track.

Inspector settings other than those specified in the Ex-
port options are not included in the MIDI file!
To include these, you need to convert the settings to “real” MIDI events 
and properties by using the Merge MIDI in Loop function for each track, 
see “Merge MIDI in Loop” on page 358.

Importing MIDI files
To import a MIDI file from disk, proceed as follows:

1. Select “MIDI File…” from the Import submenu on the 
File menu.

2. If there is already an open project, a dialog opens in 
which you can select whether a new project should be 
created for the file or not.
If you select “No”, the MIDI file will be imported into the current project.

3. Locate and select the MIDI file in the file dialog that 
opens and click Open.

• If you choose to create a new project, select the project 
folder.
Select an existing project folder or create a new by clicking on Create 
and entering a name in the dialog.

Option Description

Export Inspector 
Patch

If this is activated, the MIDI patch settings in the Inspec-
tor – Bank Select and Program Select (used for selecting 
sounds in the connected MIDI instrument) are included 
as MIDI Bank Select and Program Change events in the 
MIDI file.

Export Inspector 
Volume/Pan

If this is activated, Volume and Pan settings made in the 
Inspector are included as MIDI Volume and Pan events in 
the MIDI file.

Export 
Automation

If this is activated, recorded automation (see “Introduc-
tion” on page 214) is converted to MIDI controller events 
and included in the MIDI file. This also includes automa-
tion recorded with the MIDIControl plug-in. This is de-
scribed in the chapter “MIDI Effects” of the separate 
manual “Nuendo Expansion Kit – Cubase Music Tools for 
Nuendo 4”.

Export Inserts If this is activated and you are using any MIDI plug-ins as 
insert effects, the modifications to the original MIDI notes 
that occur as a result of the effect(s) will be included in 
the MIDI file. A MIDI delay, for example, will produce a 
number of repeats to a MIDI note by actually adding addi-
tional, “echoing” notes at rhythmic intervals – these notes 
will be included in the MIDI file if the option is activated.

Export Sends If this is activated and you are using any MIDI plug-ins as 
send effects, the modifications to the original MIDI notes 
that occur as a result of the effect(s) will be included in 
the MIDI file.

Export Marker If this is activated, any markers you have added (see “Us-
ing markers” on page 109) will be included in the MIDI 
file as Standard MIDI File Marker events.

Export as 
Type 0

If this is activated, the MIDI file will be of Type 0 (all data 
on a single track, but on different MIDI channels). If you 
don’t activate this option, the MIDI file will be of Type 1 
(data on separate tracks). Which type to choose de-
pends on what you want to do with the MIDI file (in which 
application or sequencer it should be used, etc.).

Export 
Resolution

You can specify a MIDI resolution between 24 – 960 for 
the MIDI file. The resolution is the number of pulses, or 
ticks, per quarter note (PPQ) and determines the preci-
sion with which you will be able to view and edit the MIDI 
data. The higher the resolution, the higher the precision. 
The resolution should be chosen depending on the appli-
cation or sequencer with which the MIDI file should be 
used though, since certain applications and sequencers 
may not be able to handle certain resolutions.

Export Locator 
Range

If this is activated, only the range between the locators 
will be exported. 

Export 
includes Delay

If this is activated, the delay of the MIDI track will be in-
cluded in the MIDI file. For more information about the 
Delay option, see “Basic track settings” on page 344.

Option Description
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The MIDI file is imported. The result depends on the con-
tents of the MIDI file and the Import Options settings in the 
Preferences (MIDI–MIDI File page). The Import Options 
are as follows:

• When you import a MIDI file into the project, the Tempo 
track will be adjusted according to the Tempo track in the 
MIDI file.

• It is also possible to import a MIDI file from disk by drag-
ging and dropping it from the Windows Explorer or the 
Mac OS Finder into the Nuendo Project window. The Im-
port Options apply as well.

Exporting and importing MIDI loops
Nuendo allows you to import MIDI loops (file extension 
“.midiloop”) and to save instrument parts as MIDI loops. 
MIDI loops are handy, as they contain not only MIDI notes 
and controllers, but also the associated VST instrument 
and instrument track preset settings.

How to import and export MIDI loops is described in detail 
in the chapter “VST Instruments and Instrument tracks” on 
page 189.

Exporting and importing tracks
You can export Nuendo tracks (Audio, FX, Group, Instru-
ment, MIDI and Video) as track archives for import into 
other Nuendo projects. All the information associated with 
the tracks will be exported (mixer channel settings, auto-
mation tracks, parts and events etc.). If you select the op-
tion “Copy” (see below), a separate “media” folder will be 
created, containing copies of all referenced audio files.

Project-specific settings (such as tempo) are not part 
of the exported track archives.

For creating track presets from tracks, see “Track Pre-
sets” on page 327.

Exporting tracks as track archive
1. Select the tracks you wish to export.

2. Pull down the File menu and open the Export submenu. 

3. On the submenu, select “Selected Tracks…”.

4. You are prompted to choose between two options:

• Click Copy to include copies of the media files in the ex-
port.
A file dialog opens in which you can choose an existing empty folder or 
create a new folder for saving the track archive (as *.xml file) and its me-
dia subfolder, which will contain any associated audio or video files.

• Click Reference to include merely a reference to the 
files in the export.
A file dialog opens in which you can choose an existing folder for saving 
the track archive (as single *.xml file).

5. Click OK to save the respective track archive type.

Option Description

Extract First 
Patch

If this is activated, the first Program Change and Bank 
Select events for each track are converted to Inspector 
settings for the track.

Extract First
Volume/Pan

If this is activated, the first MIDI Volume and Pan events 
for each track are converted to Inspector settings for the 
track.

Import Controller 
as Automation 
Tracks

If this is activated, MIDI controller events in the MIDI file 
will be converted to automation data for the MIDI tracks.

Import to Left 
Locator

If this is activated, the imported MIDI file will be placed so 
that it starts at the position of the left locator – otherwise 
it will start at the beginning of the project. Note that if you 
choose to have a new project created automatically, the 
MIDI file will always start at the beginning of the project.

Import Marker If this is activated, Standard MIDI File Markers in the file 
will be imported and converted to Nuendo markers.

Import dropped 
File as single 
Part

If this is activated and you drag and drop a MIDI file into 
the project, the whole file will be placed on a single track.

Ignore Master-
track Events on 
Merge

If this is activated and you import a MIDI file into the cur-
rent project, tempo track data in the MIDI file is ignored. 
The imported MIDI file will play according to the current 
Tempo track in the project.

Auto Dissolve 
Format 0

If this is activated and you import a MIDI file of type 0 into 
the project, the file will automatically be “dissolved”: For 
each embedded MIDI channel in the file, a separate track 
will be inserted in the Project window.
If this is deactivated, only one MIDI track will be created. 
This track will be set to MIDI Channel “Any”, allowing all 
MIDI events to play back on their original channels. You 
can also use the “Dissolve Part” function on the MIDI 
menu to distribute the events onto different tracks with 
different MIDI Channels at a later stage.

Import to Instru-
ment tracks

If this is activated and you drag a MIDI file into the 
project, an Instrument track will be created instead of a 
MIDI track. Furthermore, the program will load the corre-
sponding track preset for the instrument track (based on 
the program change events included in the MIDI file).
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Importing tracks from a track archive
The Import Track Archive function lets you import tracks 
exported from another Nuendo  project.

Note that the sample rates of the active project and 
the track archive have to match. If necessary, you have to 
convert the sample rate, see below. 

1. Pull down the File menu and open the Import submenu.

2. On the submenu, select “Track Archive…”.

3. In the file dialog that opens, select the XML file and 
click Open.
The Import Options dialog opens.

In the Project Settings area, you can see a comparison between the 
settings of the track archive and the active project.

4. In the Import Options dialog, click on the Import col-
umn to the left to select the desired track(s) or click “Se-
lect all Tracks”.
A check mark is shown for all selected tracks.

5. Choose which media files to use: 

• Select “Use Media Files From Archive” if you want to 
import the track without copying the media files into your 
project folder.

• Select “Copy Media To Project Folder” if you want to 
import the media files into your project folder. 
For the option “Perform Sample Rate Conversion”, see below.

6. Click OK.
The tracks are imported, complete with all contents and settings.

Sample rate conversion on track archive import

A track archive may contain media files with a sample rate 
that is different from the sample rate of your currently ac-
tive project. You can see the sample rate difference in the 
Project Settings area.

• To convert the sample rate of a track archive to the sam-
ple rate used in the active project on import, select the op-
tion “Copy Media To Project Folder” and then “Perform 
Sample Rate Conversion”.

Unconverted files with another sample rate than the 
one used in the project will play back at the wrong speed 
and pitch.

Other Import/Export functions
• For exporting and importing Tempo tracks, see “Export-
ing and importing Tempo tracks” on page 419.

• Nuendo mixmaps from older Nuendo versions can be 
imported into Nuendo. They will be converted into device 
panels. For information on device panels, see the separate 
PDF document “MIDI Devices”.

Cleanup
The Cleanup function on the File menu helps you to save 
hard disk space by locating and – if you like – deleting un-
used audio files in the project folders on your disk.

1. Select “Cleanup…” from the File menu.
If there are any open projects, an alert shows. Clicking “Close” closes all 
open projects and brings up the Cleanup dialog.

2. To restrict the Cleanup function to a certain folder only, 
click the “Search Folder” button and select the folder.
The default setting is that the Cleanup function is applied to all folders on 
all hard disks. You should only select a specific folder if you are certain it 
doesn’t contain audio files used in other projects (outside the folder), see 
below. You can reset the function to search all folders by opening the 
“Search Folder” dialog again and clicking “Cancel”.

3. Click the Start button.
Nuendo will now scan the selected folder (or all hard disks) for Nuendo 
project folders and check for audio and image files (in the Audio, Edits 
and Images subfolders) that are not used by any project. The found files 
are listed in the dialog.
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4. When the scan is complete, you can select files by 
clicking in the list.
Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to se-
lect a range of files. You can also click the Select All button to select all 
files in the list.

In the following situations, the Cleanup function will list 
files that are not unused:

• If you have moved or renamed files or folders (without updat-
ing the project files to use the new paths), there is no way for 
Nuendo to know that these files are used in a project. 

• If you perform the Cleanup function on a folder in which there 
are audio files belonging to other projects (outside the folder), 
these files will be considered “”.

• Also, make sure you don’t delete any files used in other 
applications, or files that you generally want to keep!

However, you can always safely delete image files since 
these can be reconstructed by the program, if necessary.

5. Delete any files you don’t want to keep by selecting 
them and clicking Delete.

6. Close the dialog by clicking the Close button.
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Background
The user can customize the appearance and functionality 
of Nuendo in various ways.

User configurable items described in this chapter are:

• Workspaces
By storing different window combinations as workspaces, you can 
quickly switch between different working modes – see “Workspaces” on 
page 504.

• Setup dialogs
Several parts of the user interface (toolbars, Transport panel, Inspector, 
info lines and channel settings windows) provide a Setup dialog, where 
you can configure which items of the respective window area or panel 
are to be shown or hidden and where they should be located – see “The 
Setup dialogs” on page 506.

• Track list
The controls shown in the Track list can be set for each track type – see 
“Customizing track controls” on page 507.

• Configuration of main menu items
You can hide items not needed on the main menus – see “Configuring 
the main menu items” on page 509.

• Preferences presets
You can save and recall preference settings as preference presets – see 
“About preference presets” on page 510.

• Appearance
The general look of the program can be adjusted – see “Appearance” on 
page 511.

• Track and event colors
You can adjust which colors should be used – see “Applying track and 
event colors” on page 512.

This chapter also contains a section describing where 
your preferences and settings are stored (see “Where are 
the settings stored?” on page 514), to help you transfer 
your customized settings to another computer.

Workspaces
A configuration of Nuendo windows is called a “work-
space”. A workspace stores the size, position and content 
of all windows, allowing you to quickly switch between dif-
ferent working modes via the menu or by using key com-
mands. E.g., you may want as large a Project window as 
possible when you are editing, whereas you may want the 
Mixer and effect windows open during mixdown. Work-
spaces are listed and managed on the Workspaces sub-
menu on the Windows menu.

Editing the active workspace
There is always one workspace active, even if you haven’t 
saved any. To make changes to the active workspace, you 
simply set up the windows as desired – including open-
ing, closing, moving and sizing windows, and adjusting 
zoom and track height. The changes are automatically 
stored for the active workspace.

• To keep a workspace from being accidentally changed, 
select “Lock Active Workspace” from the Workspaces 
submenu.
A locked workspace will keep its original window settings. You may 
change the current window layout on the screen, but the next time you 
select the workspace again, the originally stored layout will be recalled.
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Creating a new workspace
1. Pull down the Window menu and open the Work-
spaces submenu.

2. Select “New Workspace”.

3. In the dialog that opens, enter a name for the work-
space.

4. Click OK.
The workspace is stored and will appear on the submenu. It will now be 
the active workspace.

5. Set up the windows you want to include in the new 
workspace.
This may include opening, moving and sizing windows, and adjusting 
zoom and track height.

Activating a workspace
1. Pull down the Window menu and open the Work-
spaces submenu.

2. Select the workspace from the list on the submenu.
The windows are closed, opened, moved and/or resized according to the 
stored workspace.

• You can also activate any of nine workspaces using key 
commands.
This is set up under the Workspaces category in the Key Commands 
dialog.

Organizing workspaces and presets
If you select “Organize…” from the Workspaces sub-
menu, the Organize Workspaces dialog opens:

The list to the left shows the workspaces in the active 
project, while the list to the right shows the workspace pre-
sets. While workspaces are stored with each project, work-
space presets can be stored globally, allowing you to set 
up a number of workspaces for use in any project. Work-
space presets store the position and size of the main win-
dows only – project-specific windows are not included.

• In the Workspaces list to the left, you can rename work-
spaces (by double-clicking and typing) and lock or unlock 
them.

• The arrow buttons between the two lists allow you to 
copy the selected workspace to a workspace preset, or 
vice versa.

• The buttons below each list let you add, remove or acti-
vate workspaces or presets.
You can also activate a workspace or a preset by double-clicking in its 
number column.

• Normally, when you use key commands to activate 
workspaces, they relate to the order in the workspace list, 
e.g. the key command for “Workspace 1” selects the first 
workspace on the list and so on. However, if you activate 
the Use IDs checkbox, you can enter a number (1-9) in the 
ID column for each workspace. 
This number will be used as reference when you are using key com-
mands, so that the key command for “Workspace 1” recalls the work-
space with ID 1.

• Workspace presets are saved with the project. By de-
fault the global presets are shown in the list to the right – 
to see the presets of other projects, activate the Show 
Project Presets checkbox.
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• Activate the Auto Instantiate Presets checkbox to con-
vert all global workspace presets automatically into work-
spaces when you create a new project or open a project.

• To close the dialog, click the OK button or use [Esc].
Note that you can continue working in other windows with the Organize 
Workspaces dialog open.

The Setup dialogs
You can customize the appearance of the following ele-
ments:

• transport panel
• info line
• channel settings window
• toolbars 
• Inspector

Customizing via the setup context menus
If you right-click the Transport panel, the toolbars, the info 
lines, or the Inspector, the respective setup context menu 
opens. For channel settings windows, these options are 
found in the dialog menu, on the Customize View sub-
menu. On this menu, you can activate/deactivate elements 
as desired.

The following general options are available on the setup 
context menus:

• “Show All” makes all items visible.

• “Default” resets the interface to the default setting.

• “Setup…” opens the Setup dialog (see below).

If presets are available, they can be selected on the lower 
half of the menu (e.g. “Status Fields Only” for the Trans-
port panel). 

The info line and Inspector setup context menus. In the Inspector setup 
context menu, the available options depend on the track type.

Customizing via the Setup dialog
If you select “Setup…” from the setup context menus, the 
Setup dialog opens. This allows you to specify which ele-
ments should be visible/hidden and to set the order of the 
elements. You can also save and recall setup presets in 
this dialog.

The Setup dialog, e.g. for the Transport panel.

The dialog is divided into two columns. The left column 
displays the currently visible items and the right column 
displays the currently hidden items.

• You can change the current show/hide status by select-
ing items in one column and then using the arrow buttons in 
the middle of the dialog to move them to the other column.
Changes are applied directly.
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• By selecting items in the “Visible Items” column and us-
ing the Move Up and Move Down buttons, you can reorder 
the selected item(s).
Changes are applied directly. To undo all changes and revert back to the 
standard layout, select “Default” on the setup context menu.

A customized Transport panel.

• If you click the Save button (disk icon) in the Presets 
section, a dialog opens, allowing you to name the current 
configuration and to save it as a preset.

• To remove a preset, select it on the presets pop-up 
menu and click the trash icon.

• Saved configurations are available for selection from the 
Presets pop-up in the Setup dialog or directly from the 
setup context menu.

Customizing track controls
You can configure (separately for each track type) which 
track controls should be shown in the Track list. You can 
also specify the order of controls and group controls so 
that they are always shown adjacent to each other. This is 
done using the Track Controls Settings dialog.

Opening the Track Controls Settings dialog
There are two ways to open the dialog:

• Right-click a track in the Track list and select “Track 
Controls Settings” from the context menu.

• Click the arrow in the top left corner of the Track list and 
select “Track Controls Settings”.

Setting the track type
The settings made in the Track Controls Settings dialog 
apply to the selected track type (Marker, MIDI, Group/FX 
Channel, Folder, Video, Instrument, Audio). If you right-
click an audio track to open the dialog, for example, the di-
alog automatically displays the settings for audio tracks. 
The selected track type is shown in the menu display in 
the top left corner of the dialog.
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• To change the track type, click the arrow to the right in 
the menu display and select a track type from the pop-up 
menu that opens.
All settings made in the dialog will apply to all tracks (current and subse-
quent) of the selected type.

The track type pop-up at the upper left of the Track Controls Settings 
dialog.

Always make sure that you have selected the desired 
track type when editing the track controls!

Removing, adding and moving track controls
The dialog is divided into two columns. The left column 
displays controls currently visible on the Track list, and the 
right column displays the controls currently hidden.

• You can hide controls from the Track list by selecting 
them in the list to the left and clicking the Remove button. 
To show hidden elements, select them in the list to the 
right and click the Add button.
Click OK to apply the changes.

All controls can be removed except the Mute and Solo 
buttons.

• By selecting controls in the “Visible” column and using 
the Move Up and Move Down buttons, you can change 
the order of the selected control(s) on the Track list.
Click OK to apply the changes.

Grouping track controls
If you resize the Track list, the position of the controls will 
change dynamically to accommodate as many controls as 
possible in the available space (given that Wrap Controls is 
activated – see below). By grouping several track controls 
you ensure that they will always be positioned side by side 
in the Track list. To group controls, proceed as follows:

1. Make sure you have selected the desired track type.

2. Select at least two controls you wish to group in the 
Visible list.
You can only group controls that are adjacent to each other in the Visible 
list. To group controls that are currently not adjacent in the list, use the 
Move Up/Down buttons first.

3. Click Group.
A number is displayed in the Group column for the grouped controls. The 
first group created will have the number 1, the second 2 and so on.

4. Click OK.
The controls are now grouped.

• You can ungroup commands by using the Ungroup but-
ton. Please note that this will remove the selected element 
and the elements below it in the list from this group. To re-
move an entire group, select the first (topmost) element 
belonging to this group and click the Ungroup button.

About Wrap Controls
This is activated by default. Wrap Controls is allows the 
controls to be dynamically repositioned when resizing the 
Track list. That is, as many controls as can fit in any given 
space will be displayed depending on how you resize the 
Track list.

If you deactivate Wrap Controls, the positions of the con-
trols will be fixed, regardless of the size of the Track list. In 
this mode, you may have to resize the tracks vertically (by 
dragging the dividers between them) to display all the 
controls.

About the Length column
The Length column in the Visible list allows you to set the 
maximum length for certain text fields, e.g. Name. To 
change the setting, click on the number in the Length col-
umn and type in a new value.
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Resetting Track list settings
You have two possibilities to reset settings:

• Click Reset to restore all default track controls settings 
for the selected track type.

• Click Reset All to restore all default track controls set-
tings for all track types.

Saving presets
You can save track controls settings as presets for later 
recall:

1. Click on the Save icon beside the Presets name field.
A dialog opens, allowing you to type in a name for the preset.

2. Click OK to save the settings as a preset.
Saved presets are available for selection from the Presets pop-up and 
from the pop-up at the top left corner of the Track list.

• To remove a preset, select it in the Track Controls Set-
tings dialog and click the Delete icon beside the Presets 
name field.

Nuendo comes with a number of track control settings 
presets available.

Configuring the main menu items

You can configure what items should be shown on the 
main menus and submenus, and even hide entire menus. 
By customizing the menus you can hide items relating to 
program functions you never use, to customize the pro-
gram according to your needs. For example, if you never 
use the Networking features in Nuendo, you can hide the 
entire Network menu from view.

1. Open the Preferences dialog and select the Configu-
ration page.
The Configuration page contains two parent folders; “Main Menu”, which 
contains folders for all main menus, and “Command Categories” which 
contains folders for all Command categories. This section will only de-
scribe how to configure Main Menu items, not Command Categories, 
see “Turning Key Commands off” on page 519.

2. Click on the plus sign for a folder item, e.g. the File 
folder.
As you can see, all commands and submenus on the File menu are listed 
in the Name column.

• In the Menu, column you can decide which File menu 
items to hide from view, by clicking in the column beside 
the corresponding menu item you wish to hide.
If you click the “On” item in the Menu column for an item, it changes to 
“Off” and vice versa. All menu items set to “Off” will be hidden when you 
click Apply or OK.

! Configuring the main menus is a feature intended for 
experienced Nuendo users. Don’t hide menus or 
menu items unless you are sure that you do not need 
them!
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• Certain essential menu items on the File and Edit menus 
cannot be hidden, such as Save, Open, Close, Undo/
Redo etc.
For these items there is no entry in the Menu column.

• If you set a main menu folder (as opposed to a menu 
item) to Off in the Menu column, the entire menu will be 
hidden from view.
The exception to this is if the main menu folder contains non-removable 
menu items, in which case all hideable items on the menu will be set to 
Off, but the menu will still be visible.

• The Command column sets the key command On/Off 
status for the corresponding menu item.
If this is set to Off, any assigned key command for the item will be dis-
abled (see “Turning Key Commands off” on page 519 for more informa-
tion).

• You can save menu configurations as preference pre-
sets, either separately or together with other Preferences 
dialog settings – see below.

3. By using the above methods, you can customize all 
main menus to your liking.
To apply the changes without exiting the dialog click “Apply”. Click OK to 
apply the changes and exit the dialog.

• To restore all menu items to their default setting (which 
is visibility and key commands on for all menus and menu 
items), click the Defaults button.
Note that the Defaults button only restores the settings on the currently 
selected page (the Configuration page in this case) to their default set-
tings. If you have changed settings on another page of the Preferences 
dialog, these are not reset.

About preference presets
It is possible to save complete or partial preferences set-
tings as presets. This lets you recall settings quickly and 
easily.

Saving a preference preset
When you have made your preferences settings, proceed 
as follows to save all settings as a preset:

1. Make sure that the “Store marked preferences only” 
option is not activated.
This is because this option is used for saving partial settings (see below), 
as opposed to complete settings.

2. Click the Store button in the lower left section of the 
Preferences dialog.

A dialog opens, allowing you to type in a name for the pre-
set.

3. Click OK to save the preset.
Your saved settings will now be available from the Preference Presets 
pop-up for your future projects.

Loading a preference preset
To load a saved preference preset, proceed as follows:

1. Open the Preferences dialog from the File menu (Win)/
Nuendo menu (Mac).

2. Select the saved preset from the Preference Presets 
pop-up.

3. Click OK to apply the saved preset settings and exit 
the Preferences dialog.
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Saving partial preferences settings
It is also possible to save partial preferences settings. This 
is useful when you have made settings that only relate to a 
certain project or situation, for example. When you apply a 
saved partial preference preset, you only change the saved 
settings. All other preferences will be left unchanged.

When you have made your specific preferences settings, 
proceed as follows to save the partial settings as a preset:

1. Open the Preferences dialog.

2. Activate “Store marked preferences only”.
A new “Store” column is added in the Preferences page list.

3. Click in the Store column of the Preferences items you 
wish to save.
Note that if you activate a Preferences page that contains subpages, 
these will also be activated automatically. If this is not what you want, 
simply deactivated the subpages.

4. Click the Store button in the lower left section of the 
Preferences dialog.
A dialog opens, allowing you to type in a name for the preset. It is a good 
idea to choose a descriptive name for a partial preference preset, prefer-
ably relating to the saved settings (for example “Configuration” or “Edit-
ing-Controls”).

5. Click OK to save.
Your saved settings will now be available from the Preference Presets 
pop-up for your future projects.

Appearance
In the Preferences dialog, you will find a page called Ap-
pearance. It contains three sub-pages on which you will 
find the following settings:

General 

The three controls on the General page affect the appear-
ance of the windows that surround the controls and work-
spaces in Nuendo. 

• Saturation determines how rich the background colors 
are, from gray to blue. 

• Contrast determines how bright or dark the background 
is in relation to controls and displays. 

• Brightness lightens or darkens the background.

Meters 

The coloring of meters in Nuendo can be controlled in so-
phisticated ways. Multiple colors can help to visually indi-
cate what levels are being reached, e.g. in a channel of 
the VST Mixer. To do this, the meter on the Appearances–
Meters page has color handles that allow you to define 
what color the meter will have at a given signal level.

The Appearances–Meters page in the Preferences dialog.

• The default setting has four color handles. Each color 
handle has a unique color that gradually shifts as the 
meter moves toward the next color handle.
You can click on any color handle and move its position in the meter 
scale. If you hold down [Shift] while moving the handle with the mouse, it 
will move ten times slower for more precise positioning. You may also 
nudge the color handle’s position with the Arrow Up/Down keys. Holding 
Shift while nudging will move the color handle ten times faster.
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• You can add color handles by [Alt]/[Option]-clicking 
anywhere along the side of the meter scale. To remove a 
color handle, [Ctrl]/[Command]-click the handle.
By adding more color handles to the meter scale, you can define colors 
for more specific signal levels. Try adding two color handles very close to 
one another. You can make the meter color change more rapidly at a 
specific signal level this way.

• To change the color of a handle, select the handle by ei-
ther clicking on it or by jumping to it with the Tab key (hold 
down [Shift] and press the Tab key to jump backwards). 
Then use the hue and brightness controls on the right side 
to alter the handle’s color.
The currently selected color handle is indicated by a black triangle on its 
left side.

Work Area 

The work areas in Nuendo are those places where the ac-
tual data are displayed such as the project window event 
display. In these areas, there are items such as vertical 
and horizontal grid lines that can be altered in intensity by 
the controls found on this page.

Applying track and event colors
You can use color scheming for easier overview of tracks 
and events in the Project window. Applying colors is di-
vided into two areas; track and event colors.

• A track color is shown and can be edited in the Inspec-
tor, the Track list, and the corresponding channel in the 
Mixer. It is furthermore displayed in all parts and events for 
the track in the event display.
Track colors can be switched on and off globally.

• Event colors are shown for parts and events in the event 
display and are independent from the track colors.

An applied event color “overrides” the track color, if 
both are used.

The color palette can be customized, see “The Event Co-
lors dialog” on page 514.

Track colors

Applying track colors manually

To activate track colors, proceed as follows:

1. Click the Show/Hide Track Colors button at the top of 
the Track list.

This brings up the track color selector in the Inspector, the 
Track list and in the Mixer.

2. To bring up the color palette, click the track color se-
lector.

Click the arrow in the track name title bar or…

…click the color strip in the Track list.

In the Mixer, click the track color selector below the channel name.

3. Select a color from the color bar.
The track color is now reflected in the Inspector title palette and the Track 
list as well as in the Mixer and any parts and events on the selected track.
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Applying track colors automatically

In the Preferences (Editing–Project & Mixer page), you 
can find the option “Auto Track Color Mode”.

This offers you several options for automatically assigning 
colors to tracks that are added to the project.

Coloring parts and events
There are two ways to color parts and events in the 
Project window:

Using the color selector

1. Select the desired parts or events.

2. Choose a color from the color selector in the toolbar.

Using the color tool

1. On the toolbar, select the color tool (the paint bucket 
icon). 

2. Click the small strip below it to bring up the color pal-
ette.

3. Select the desired color. 

4. Click on a part/event to assign the color. 

The color is applied to all selected parts/events and over-
rides the track color (if used).

• If you press [Ctrl]/[Command] and click on a part/event 
with the color tool, the color palette is displayed and you 
can choose the desired color for an event.

• If you press [Alt]/[Option], the color tool cursor be-
comes a pipette, which can be used to select a color by 
clicking on a part/event.

Customizing the event background

On the Event Display page in the Preferences, you can 
find the option “Colorize Event Background”.

This option affects the display of events in the project win-
dow.

• When this is activated, the background of the events 
and parts in the event display will be shown in the se-
lected color.

• When this is deactivated, the event “content”, i.e. MIDI 
events, audio waveforms, etc. will be displayed in the se-
lected color and the event background will be displayed in 
gray. 

Option Effect

Use Default 
Event Color

The default color (gray) is assigned. 

Use Previous 
Track Color

Uses the color of the track above the new one (i.e. the 
track that is selected when you add a new track).

Use Previous 
Track Color +1

Uses the color next to the color of the track above the 
new one (+1 refers to the color number in the palette).

Use Last 
Applied Color

The last manually assigned color is used. 

Use Random 
Track Color

Track colors are assigned randomly.
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The Event Colors dialog
You can open the Event Colors dialog in two ways: 

• Double-click the small strip below the color tool. 

• Open the Color pop-up menu on the toolbar and select 
“Select Colors…”.

In the Event Colors dialog, you can fully customize the 
color palette, apart from the default color (gray).

To add new colors to the color palette, proceed as follows:

1. Click the Insert New Color button in the Event Colors 
section to add a new color.
A new color icon and color name are added to the Event Colors section.

2. Click the color field next to the name field to activate 
the new color for editing.

3. In the Standard Colors section, select the standard 
color. You can modify the selected color in the following 
way:
• Drag the cursor to another point in the color circle.
• Movethe handle in the color meter.
• Enter the values for red, green and blue and hue, saturation 

and luminosity manually.

4. Click the Apply button in the Standard Colors section. 
The color setting is applied to the selected color item. 

You can edit every existing event color in the same way.

• To delete an event color item, select it and click the 
“Remove Selected Color” button in the Event Colors sec-
tion.

• To increase or decrease the intensity and the brightness 
of all colors, use the corresponding buttons in the Event 
Colors section.

• To save the current set as default, click the button “This 
set as default set” in the Event Colors section. You can 
then click the button “Use default set” to the right to apply 
the saved default set.

• To return to the standard setting of the palette in Nu-
endo, click Reset.

Where are the settings stored?
As you have seen, there are a large number of ways in 
which you can customize Nuendo. While some of the set-
tings you make are stored in each project, others are 
stored in separate preference files.

If you need to transfer your projects to another computer 
(e.g. in another studio), you can bring all your settings 
along by copying the desired preference files and install-
ing them on the other computer.

It’s a good idea to make a backup copy of your prefer-
ence files once you have set things up the way you want!
This way, if another Nuendo user wants to use his or her personal set-
tings when working on your computer, you can restore your own prefer-
ences afterwards.

Remove 
new color

Increase/decrease in-
tensity for all colors

This Set as 
Default Set

Increase/decrease 
brightness for all colors

Insert
new color

Use Default 
Set
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• Under Windows, preference files are stored in the 
folder “\Documents and Settings\<user name>\Applica-
tion Data\Steinberg\Nuendo 4\”.
If you run the 64 bit version of Nuendo, this folder is called “Nuendo 
64bit”. On the Start menu, you will find a shortcut to this folder for easy 
access.

• Under Mac OS X, preference files are stored in the 
folder “Library/Preferences/Nuendo 4/” under your home 
directory.
The full path would be: “/Users/<user name>/Library/Preferences/
Nuendo 4/”.

The RAMpresets.xml file, which contains various pre-
sets settings (see below), is saved when exiting the pro-
gram. 

Program functions (e.g. crossfade) or configurations 
(e.g. panels) not used in the project will not be stored.

Below, the available preferences files are listed. When 
files are not saved in the default preferences folder (see 
above), the complete path will be shown. When files are 
saved in a further subfolder of the default folder, the path 
will begin with the name of this folder:

Setting Stored in

Edit modifier keys Edit Modifiers.xml

Key commands Key Commands.xml

Preferences 
dialog settings

Defaults.xml

Color setup saved in the project

Default Color 
setup

Defaults.xml

Crossfade 
presets

Application folder\Presets\RAMPresets.xml

Control Room – 
Settings

\Presets\ControlRoomPresets.xml (pxml file)

Control Room – 
External Plug-ins

External Plugins.xml

Device setup 
files

Application folder\Device Maps
as *.xml file

Drum maps 
(Nuendo Extension 
Kit only)

Application folder\DrumMaps 
as *.drm file

EQ presets Application folder\Presets\VstEqPresets.pxml

Port Input/
Output settings

Port Setup.xml

Audio Inserts
presets

\Presets\InsertsFolderPresets.pxml

MIDI Inserts 
presets

\Presets\MidiInsertsPresets
as *.xml file

Installed MIDI 
devices

Midi Devices.bin

Key commands 
presets

\Presets\KeyCommands\<Preset Name>.xml

Logical Editor 
presets

\Presets\Logical Edit\<Preset Name>.xml

Project Logical 
Editor

\Presets\Logical Edit Project\<Preset Name>.xml

MediaBay
settings

MediaDefaults.xml

MediaBay default 
settings

MediaFactoryDefaults.xml (these are applied on reset)

MediaBay – 
Scanned folders

scannedfolders.bin

MediaBay – 
Scanned disks

FileSysObserver.xml (When changing the file system 
these disks are automatically scanned by the MediaBay 
– Windows only.)

MediaBay 
database

mediabay.db

MediaBay Content ContentManager.xml

MIDI FX presets \Presets\<Plugin Name>\<Plugin Name>.xml

Mixer (or channel) 
settings

saved in the last active folder as *.vmx file (VST Mixer 
settings)

Mixer view 
preset

saved in project

Panel files \Panels\<device name><unique combination of letters 
and numbers>.xml

Preferences 
Configuration

Configuration.xml

Patch name 
scripts

\Scripts\Patchnames\ as *.txt file

Preferences
presets

\Presets\Configurations\<Preset Name>.xml

Quantize 
presets

\Presets\RAMPresets.xml

Score – Settings Score Setting Window.xml

Score – 
Default font

Score Default Font.xml

Score – Custom 
Palettes

Score Custom Palettes.xml

Score – Guitar 
symbols

GuitarLib.xml

Score – Chord 
symbols

\Presets\ChordSymbols.xml

Staff Presets \Presets\Staff Presets as *.xml file

Setting Stored in
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Note that the Score editor is only available for the Nuendo Expansion Kit.

Snapshot file \Presets\MIDI snapshot<device name><unique com-
bination of letters and numbers> as *.xml file

Toolbar presets \Presets\RAMPresets.xml

Track controls 
presets

\Presets\RAMPresets.xml

Track presets 
(user-defined, 
for all programs)

Win: \Documents and Settings\<user name>\Applica-
tion Data\Steinberg\Track Presets
Mac: Users/<user name>/Library/Application Sup-
port/Steinberg/Track Presets
(with the subfolders \Audio, \Instrument, \Midi, \Multi) 
as *.trackpreset file

Transport panel 
presets

\Presets\RAMPresets.xml

Usage profile
log

Usage Profile.xml (only saved if the corresponding op-
tion in the Preferences is activated)

User templates templates\<Template Name>.npr

VST connections 
presets

\Presets\RAMPresets.xml

VST 3 plug-ins 
and instruments

VstPlugInfo.xml

VST 2 plug-ins 
and instruments

Vst2xPlugins.xml

VST3 presets 
(user-defined, 
for all programs)

Win: \Common files\VST3 Presets\<company>\
<plug-in name>
Mac: Users/<user name>/Library/Audio/Presets/
<company>/<plug-in name>
as *.vstpreset file

VST3 presets 
(public, for all pro-
grams)

Win: \Documents and Settings\VST3 Presets\<com-
pany>\<plug-in name>
Mac: /Library/Audio/Presets/<company>/<plug-in 
name>
as *.vstpreset file

Workspaces saved in project

Workspace pre-
sets (global)

Window Layouts.xml

Zoom presets \Presets\RAMPresets.xml

Networking Network Manager.xml

Networking – 
Permissions

User Permissions.xml

Quick Control 
Settings

Quick Controls MIDI.xml

Setting Stored in
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Introduction
Most of the main menus in Nuendo have key command 
shortcuts for certain items on the menus. In addition, there 
are numerous other Nuendo functions that can be per-
formed via key commands. These are all default settings. If 
you want, you can customize existing key commands to 
your liking, and also add commands for menu items and 
functions currently not assigned any.

How are key commands settings saved?

Every time you edit or add any key command assignment, 
this is stored as a global Nuendo preference – not as part 
of a project. Hence, if you edit or add a key command as-
signment, any subsequent projects that you create or 
open will use these modified settings. However, the de-
fault settings can be restored at any time by clicking the 
button “Reset All” in the Key Commands dialog.

In addition, you can save complete or partial key com-
mands settings as a “key commands file”, which is stored 
separately and can be imported into any project. This way 
you can quickly and easily recall customized settings, 
when moving projects between different computers, for 
example. The settings are saved in a file on disk with the 
windows extension “.xml”.

How to save key commands settings is described in the 
section “Saving complete key commands settings as pre-
sets” on page 521.

Setting up key commands
The following is a description of how you set up key com-
mands and save them as presets for easy access.

Key commands settings are accessed and edited mainly 
in the Key Commands dialog. You can find some key com-
mand settings in the Preferences dialog as well, also ad-
dressed in this chapter.

Adding or modifying a key command

In the Key Commands dialog you will find all main menu 
items and a large number of other functions, arranged in a 
hierarchical way similar to the Windows Explorer and Mac 
OS Finder. The function categories are represented by a 
number of folders, each containing various menu items and 
functions. When you open a category folder by clicking the 
plus-sign beside it, the items and functions it contains are 
displayed with the currently assigned key commands.

To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”.
The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to 
the desired category.

3. Click the plus-sign to open the category folder and 
display the items it contains.
Note that you can also click the “global” plus and minus-signs in the top 
left corner to open and close all category folders at once.

! You can also assign tool modifier keys, i.e. keys that 
change the behavior of various tools when pressed. 
This is done in the Preferences dialog – see “Setting 
up tool modifier keys” on page 524.
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4. In the list, select the item to which you wish to assign a 
key command.
Already assigned key commands are shown in the Keys column as well 
as in the Keys section in the top right corner.

5. Alternatively, you can use the search function in the 
dialog to find the desired item.
For a description of how to use the search function, see “Searching for 
key commands” on page 520.

6. When you have found and selected the desired item, 
click in the “Type in Key” field and enter a new key com-
mand.
You can choose between any single key or a combination of one or sev-
eral keys ([Alt]/[Option], [Ctrl]/[Command], [Shift]) plus any key. Just 
press the keys you want to use.

7. If the key command you entered is already assigned to 
another item or function, this is displayed below the “Type 
in Key” field. 

If a key command already is assigned to another function, you can either 
ignore this and proceed to assign the key command to the new function 
instead, or you can select another key command.

8. Click the Assign button above the field.
The new key command appears in the Keys List.

Note that you can have several different key commands for 
the same function. So adding a key command to a function 
that already has another key command will not replace the 
key command previously defined for the function. If you 
wish to remove an assigned key command, see “Removing 
a key command” on page 520.

9. Click OK to exit the dialog.

Turning Key Commands off

Nuendo also gives you the option of turning key com-
mands off, meaning that even if a function has a key com-
mand assigned to it, you can disable the key command.

This is done in the Preferences dialog, in the following 
way:

1. Open the Preferences dialog from the File menu (un-
der Mac OS X it is located on the Nuendo menu) and se-
lect the Configuration page.
As you can see, the Configuration page contains two main folders; “Main 
Menu” and “Command Categories”.

• The “Main Menu” folder contains a number of subfolders, 
which in turn each contains items found on the main menus in 
Nuendo.

• The “Command Categories” folder also contains a number of 
subfolders, each of which contains a number of program func-
tions not available on any of the main menus.

! If the key command you enter is already assigned to 
another function, you will get a warning message 
asking if you want to reassign the command to the 
new function instead, or cancel the operation.

If a selected item or function has a key command 
assigned already, it is displayed here…

…and here.
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All the items and functions in the subfolders can have key 
commands assigned to them. The column to the right, la-
beled “Command”, allows you to set the On/Off status for 
the corresponding items. This indicates whether it should 
be possible to use assigned key commands for the items 
or not.

2. Click on the plus sign beside one of the main folders 
to open it and list the subfolders it contains.

3. Open the desired subfolder by clicking its plus sign, 
navigate to the item for which you want to disable the as-
signed key command, and select it.

4. Click in the “Command” column beside the item to set 
the status to “Off”.
Now it will not be possible to use any key command assigned to that 
menu item or function.

5. Repeat this for all items or functions for which you 
want to disable key commands.

Note that if you set an entire subfolder to “Off” in this 
way, all the items or functions it contains will automatically 
be set to “Off” as well.
If this is not what you want, you can reset separate items in the subfolder 
to “On”.

6. When you’re done, click OK to close the Preferences 
dialog and apply the changes.

Searching for key commands
If you want to know which key command is assigned to a 
certain function in the program, you can use the Search 
function in the Key Commands dialog:

1. Click in the search text field at the top left of the dialog 
and type in the function for which you want to know the key 
command.
This is a standard word search function, so you should type the command 
as it is spelled in the program. Partial words can be used; e.g., to search 
for all quantize related commands, type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon).
The search is conducted and the first matching command is selected 
and displayed in the commands list below. The keys column and the keys 
list show the assigned key commands, if any.

3. To search for more commands containing the word(s) 
you entered, click the Search button again.

4. When you’re done, click OK to close the dialog.

Removing a key command
To remove a key command, proceed as follows:

1. If the key commands dialog isn’t already open, pull 
down the File menu and select “Key Commands…”.

2. Use the list of categories and commands to select the 
item or function for which you wish to remove a key com-
mand.
The key command for the item is shown in the Keys list and the Keys 
column.

3. Select the key command in the Keys list and click the 
Remove button (the trash icon).
You will get a prompt asking if you want to remove the key command or 
cancel the operation.

4. Click Remove to remove the selected key command.

5. Click OK to close the dialog.

Setting up macros
A macro is a combination of several functions or com-
mands, to be performed in one go. For example, you could 
select all events on the selected audio track, remove DC 
offset, normalize the events and duplicate them, all with a 
single command.

Macros are set up in the Key Commands dialog as follows:

1. Click the Show Macros button.
The macro settings are shown in the lower part of the dialog. To hide 
these from view, click the button (now renamed to Hide Macros) again.

2. Click New Macro.
A new, unnamed macro appears in the Macros list. Name it by typing the 
desired name. You can rename a macro at any time by selecting it in the 
list and typing in a new name.

3. Make sure the macro is selected, and use the Catego-
ries and Commands in the upper half of the dialog to se-
lect the first command you want to include in the macro.

4. Click Add Command.
The selected command appears in the list of Commands in the Macros 
section.
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5. Repeat the procedure to add more commands to the 
macro.
Note that commands are added after the currently selected command in 
the list. This allows you to insert commands “in the middle” of an existing 
macro.

A macro with three commands.

• To remove a command from the macro, select it in the 
Macros list and click Delete.

• Similarly, to remove an entire macro, select it in the 
Macros list and click Delete.

After you have closed the Key Commands dialog, all mac-
ros you have created appear at the bottom of the Edit menu 
in the Macros submenu, available for instant selection.

You can also assign key commands to macros. All macros 
you have created appear in the upper section of the Key 
Commands dialog under the Macros category – just se-
lect a macro and assign a key command as with any other 
function.

Saving complete key commands settings as 
presets
As mentioned above, any changes made to the key com-
mands (and macros) are automatically stored as a Nuendo 
preference. However, it is also possible to store key com-
mands settings separately. This way, you can store any 
number of different key command settings, complete or 
partial, as presets for instant recall.

Proceed as follows:

1. Set up the key commands and macros to your liking.
When setting up key commands, remember to click “Assign” to make the 
changes.

2. Make sure that “Store Selected Items Only” is not ac-
tivated.
This option is for saving partial key commands settings only (see below).

3. Click the Save button next to the Presets pop-up 
menu.
A dialog appears, allowing you to type in a name for the preset. 

4. Click OK to save the preset.
Your saved key commands settings will now be available in the Preset 
pop-up menu for your future projects.

Saving partial key commands settings
It is also possible to save partial key commands settings. 
This is useful for example if you have made settings that 
only relate to a specific project or settings that you wish to 
apply only in certain situations. When you apply a saved 
partial preset you only change the specific saved settings, 
while all other key commands settings will be left un-
changed.
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When you have set up the key commands and macros, 
proceed as follows to save the partial settings as a preset:

1. Activate the “Store Selected Items Only” option.
When this is activated, a new “Store” column appears in the Commands 
list.

2. Click in the Store column for the key commands items 
you wish to save.
Note that if you check an entire category folder (as opposed to separate 
commands) all commands it contains will automatically also be selected. 
If this is not what you want, deselect the commands you don’t want to in-
clude.

3. Click the Save button (the disk icon) next to the Pre-
sets pop-up menu.
A dialog appears, allowing you to type in a name for the Preset.

4. Click OK to save.
Your saved key commands settings will now be available from the Preset 
pop-up menu for your future projects.

Loading saved key command settings
To load a key command preset, simply select it from the 
Presets pop-up menu.

Note that this operation may replace existing key com-
mands!
The key command settings you load will replace the current key command 
settings for the same functions (if any). If you have macros of the same 
name as those stored in the preset you load, these will be replaced too.
If you want to be able to revert to your current settings again, make sure to 
save them first, as described above!

Loading saved key commands settings from earlier 
versions of Nuendo 

If you have saved key commands settings with a previous 
version of Nuendo, it is possible to use them in Nuendo 4, 
by using the “Import Key Command File” function, which 
lets you load and apply saved key commands or macros:

1. Open the Key Commands dialog.

2. Click the “Import Key Command File” button to the 
right of the Presets pop-up menu.
A standard file dialog opens.

3. In the file dialog, use the “Files of type:” pop-up to 
specify if you want to import a key commands file (Win-
dows file extension “.key”) or a macro commands file (ex-
tension “.mac”).
Key commands files included any macro settings and were saved with 
the file extension “.xml”. When you have imported an older file, you might 
want to save it as a preset (see “Saving complete key commands set-
tings as presets” on page 521) to be able to access it from the Presets 
pop-up menu in the future.

4. Navigate to the file you want to import and click “Open”.
The file is imported.

5. Click OK to exit the Key Commands dialog and apply 
the imported settings.
The settings in the loaded key commands or macros file now replace the 
current settings.
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About the “Reset” and “Reset All” functions

These two buttons in the Key Commands dialog will both 
restore the default settings. The following rules apply:

• “Reset” restores the default key command setting for 
the function selected in the Commands list.

• “Reset All” will restore the default key commands for all 
commands.

About the default key commands
As mentioned before, there are numerous default key 
commands. These are listed in the section “The default 
key commands” on page 524.

Using Alternative Key Sets
As an alternative to saving and loading key commands 
settings as previously described, you can set up and save 
“alternative key sets”. This allows you to switch between 
different key commands settings “on the fly” while you are 
working in the program, instead of having to go into the 
Key Commands dialog to change them.

About the preset Alternative Key Sets

By default, Nuendo contains two different key sets:

• “Markers” is actually not an alternative key set, but rather the 
default key set that you can switch back to at any time (see 
below).

• “Shuttle” is a specialized, alternative key set containing key 
commands settings for all of the Transport panel’s Shuttle 
controls.

You could edit and save these under the same names to 
replace them with your own settings should you so wish, 
but it is advised that you instead create additional key sets 
for your specific needs.

Saving an Alternative Key Set

Here’s how to create and save an Alternative Key Set:

1. Open the Key Commands dialog from the File menu.

2. Set up the key commands and macros the way you 
want them.

3. Decide whether you want to save complete or partial 
settings by activating/deactivating “Store Selected Items 
Only”.

4. Click the Store Alternative Set button (the disk icon) in 
the Alternative Key Sets section.
A dialog appears, allowing you to type in a name for the Preset. 

5. Type in a name for the key set and click OK to save it.
The saved key set appears in the list of alternative key sets.

Editing an Alternative Key Set

To edit a saved key set, proceed as follows:

1. Select the key set in the list and click the “Open” but-
ton (the folder icon) in the Alternative Key Sets section.
The key set is now activated, and the key commands settings are 
changed accordingly.

2. Make the desired changes.

3. Click the Store Alternative Set button (the disk icon) in 
the Alternative Key Sets section.
The key set is saved with the updated settings.

Removing a saved Alternative Key Set

• To remove a saved key set, select it in the list and click 
the “Remove” button (the trash icon) in the Alternative Key 
Sets section.
A dialog appears asking if you want to remove the key set or cancel the 
operation.

! Note that the “Reset All” operation will cause any 
changes made to the default key commands to be 
lost! If you want to be able to revert to these settings 
again, make sure to save them first!



524

Key commands

Switching between Alternative Key Sets

You switch between different key sets in the program by 
using the key command assigned to the function “Toggle 
Alternate Key Commands”, located in the “File” subfolder 
in the Key Commands dialog.

The key command for this function is by default [F5], but 
you can of course change this to any key command that 
suits you best. See “Adding or modifying a key command” 
on page 518 for instructions on how to change key com-
mands.

• When you press the key command for the function, a 
small pop-up appears, indicating which key set is currently 
loaded.

• Each time you press the key command, you switch to 
the next available alternative key set.

Setting up tool modifier keys
A tool modifier key is a key you can press to get an alter-
nate function when using a tool. For example, clicking and 
dragging an event with the Arrow tool normally moves it – 
holding down a modifier key (by default [Alt]/[Option]) will 
copy it instead.

The default assignments for tool modifier keys can be 
found in the Preferences (Editing–Tool Modifiers page). 
Here, you can also edit them:

1. Open the Preferences dialog from the File menu (on 
the Mac, this is located on the Nuendo menu) and select 
the Editing–Tool Modifiers page.

2. Select an option in the Categories list, and locate the 
action for which you want to edit the modifier key.
For example, the “Copy” action mentioned above resides in the category 
“Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the 
Assign button.
The current modifier key(s) for the action is replaced. If the modifier 
key(s) you pressed are already assigned to another tool, you will be 
asked whether you want to overwrite them. If you do, this will leave the 
other tool without any modifier key(s) assigned.

5. When you’re done, click OK to apply the changes and 
close the dialog.

The default key commands
Below, the default key commands are listed according to 
category.

• As described in the section “Key command conventions” 
on page 9, modifier keys are written as: 
[Win modifier key]/[Mac modifier key].
For example, “[Ctrl]/[Command]+[N]” in the list below means 
“press [Ctrl] under Windows or [Command] under Mac OS X, 
then press [N]”.

• Note that it is possible to switch key commands for 
menu items and other functions on and off.
This is done in the Preferences dialog–Configuration page. If you disable 
a key command by switching it off, it will not be possible to invoke the 
corresponding menu item or function with the key command. See “Cus-
tomizing” on page 503.

Audio category

Automation category

Option Key command

Adjust Fades to Range [A]

Crossfade [X]

Find Selected in Pool [Ctrl]/[Command]+[F]

Option Key command

Toggle Read Enable All Tracks [Alt]/[Option]+[R]

Toggle Write Enable All Tracks [Alt]/[Option]+[W]
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Devices category

Edit category
Editors category

File category

Media category

MIDI category

Option Key command

Mixer [F3]

Video [F8]

VST Connections [F4]

VST Instruments [F11]

VST Performance [F12]

Option Key command

Autoscroll [F]

Copy [Ctrl]/[Command]+[C]

Cut [Ctrl]/[Command]+[X]

Cut Time [Ctrl]/[Command]+[Shift]+[X]

Delete [Del] or [Backspace]

Delete Time [Shift]+[Backspace]

Duplicate [Ctrl]/[Command]+[D]

Edit In-place [Ctrl]/[Command]+[Shift]+[I]

Group [Ctrl]/[Command]+[G]

Insert Silence [Ctrl]/[Command]+[Shift]+[E]

Left Selection Side to Cursor [E]

Lock [Ctrl]/[Command]+[Shift]+[L]

Move to Cursor [Ctrl]/[Command]+[L]

Mute [M]

Mute Events [Shift]+[M]

Mute/Unmute Objects [Alt]/[Option]+[M]

Open Default Editor [Ctrl]/[Command]+[E]

Open Score Editor
(Nuendo Expansion Kit only)

[Ctrl]/[Command]+[R]

Open/Close Editor [Return]

Paste [Ctrl]/[Command]+[V]

Paste at Origin [Alt]/[Option]+[V]

Paste Time [Ctrl]/[Command]+[Shift]+[V]

Record Enable [R]

Redo [Ctrl]/[Command]+[Shift]+[Z]

Repeat [Ctrl]/[Command]+[K]

Right Selection Side to Cursor [D]

Select All [Ctrl]/[Command]+[A]

Select None [Ctrl]/[Command]+[Shift]+[A]

Snap On/Off [J]

Solo [S]

Split At Cursor [Alt]/[Option]+[X]

Split Range [Shift]+[X]

Undo [Ctrl]/[Command]+[Z]

Ungroup [Ctrl]/[Command]+[U]

Unlock [Ctrl]/[Command]+[Shift]+[U]

Unmute Events [Shift]+[U]

Option Key command

Show/Hide Infoview [Ctrl]/[Command]+[I]

Show/Hide Inspector [Alt]/[Option]+[I]

Show/Hide Overview [Alt]/[Option]+[O]

Option Key command

Close [Ctrl]/[Command]+[W]

New [Ctrl]/[Command]+[N]

Open [Ctrl]/[Command]+[O]

Quit [Ctrl]/[Command]+[Q]

Save [Ctrl]/[Command]+[S]

Save As [Ctrl]/[Command]+[Shift]+[S]

Save New Version [Ctrl]/[Command]+[Alt]/[Option]+[S]

Toggle Alternate Key Commands [#]

Option Key command

Open MediaBay [F5]

Open Loop Browser [F6]

Open Sound Browser [F7]

Option Key command

Quantize [Q]

Option Key command
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Navigate category

Nudge category

Project category

Score Functions category

Tool category

Option Key command

Add Down:
Expand/Undo selection in the 
Project window to the bottom/ 
Move selected event in the 
Key Editor down 1 octave

[Shift]+[Down Arrow]

Add Left:
Expand/Undo selection in the 
Project window/
Key Editor to the left

[Shift]+[Left Arrow]

Add Right:
Expand/Undo selection in the
Project window/
Key Editor to the right

[Shift]+[Right Arrow]

Add Up:
Expand/Undo selection in the 
Project window to the top/
Move selected event in the Key 
Editor up one octave

[Shift]+[Up Arrow]

Down:
Select next in the Project window/
Move selected event in the Key Edi-
tor one semitone down

[Down Arrow]

Left:
Select next in the Project window/
Key Editor

[Left Arrow]

Right: 
Select next in the Project window/
Key Editor

[Right Arrow]

Up:
Select next in the Project window/ 
Move selected event in the 
Key Editor one semitone up

[Up Arrow]

Bottom
Select bottom track in the track list

[End]

Top: 
Select top track in the track list

[Home]

Option Key command

End Left [Alt]/[Option]+[Shift]+[Left Arrow]

End Right [Alt]/[Option]+[Shift]+[Right Arrow]

Left [Ctrl]/[Command]+[Left Arrow]

Right [Ctrl]/[Command]+[Right Arrow]

Start Left [Alt]/[Option]+[Left Arrow]

Start Right [Alt]/[Option]+[Right Arrow]

Option Key command

Open Browser [Ctrl]/[Command]+[B]

Open Markers [Ctrl]/[Command]+[M]

Open/Close Pool [Ctrl]/[Command]+[P]

Open Tempo Track [Ctrl]/[Command]+[T]

Setup [Shift]+[S]

Show/Hide Track Colors [Shift]+[C]

Option Key command

Insert Voice: Next [Alt]/[Option]+Pad[+]

Insert Voice: Previous [Alt]/[Option]+Pad[-]

Option Key command

Delete tool [5]

Draw tool [8]

Drumstick tool 
(Nuendo Expansion Kit only)

[0]

Glue tool [4]

Mute tool [7]

Next Tool [F10]

Play tool [9]

Previous Tool [F9]

Range tool [2]

Select tool [1]

Split tool [3]

Zoom tool [6]
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Transport category

Workspace category

Zoom category

Option Key command

AutoPunch In [I]

AutoPunch Out [O]

Cycle Pad [/]

Exchange time formats [.]

Fast Forward [Shift]+Pad [+]

Fast Rewind [Shift]+Pad [-]

Forward Pad [+]

Input Left Locator [Shift]+[L]

Input Position [Shift]+[P]

Input Right Locator [Shift]+[R]

Input Tempo [Shift]+[T]

Insert Marker [Insert] (Win)

Locate Next Event [N]

Locate Next Marker [Shift]+[N]

Locate Previous Event [B]

Locate Previous Marker [Shift]+[B]

Locate Selection [L]

Locators to Selection [P]

Loop Selection [Shift]+[G]

Metronome On [C]

Nudge Down [Ctrl]/[Command]+Pad [-]

Nudge Up [Ctrl]/[Command]+Pad [+]

Panel (Transport panel) [F2]

Play Selection Range [Alt]/[Option]+[Space]

Recall Cycle Marker 1 to 9 [Shift]+Pad [1] to Pad [9]

Record Pad [*]

Retrospective Record [Shift]+Pad [*]

Return to Zero Pad [.] or Pad [,]

Rewind Pad [-]

Set Left Locator [Ctrl]/[Command]+Pad [1]

Set Marker 1 [Ctrl]/[Command]+[1]

Set Marker 2 [Ctrl]/[Command]+[2]

Set Marker 3 to 9 [Ctrl]/[Command]+Pad [3] to [9] or
[Ctrl]/[Command]+ [3] to [9]

Set Right Locator [Ctrl]/[Command]+Pad [2]

Start [Enter]

Start/Stop [Space]

Stop Pad [0]

To Left Locator Pad [1]

To Marker 1 [Shift]+[1]

To Marker 2 [Shift]+[2]

To Marker 3 to 9 Pad [3] to [9] or [Shift]+[3] to [9]

To Right Locator Pad [2]

Use External Sync [T]

Option Key command

Lock/Unlock Active Workspace [Alt]/[Option]+Pad [0]

New [Ctrl]/[Command]+Pad [0]

Organize [W]

Workspace 1-9 [Alt]/[Option]+Pad [1-9]

Option Key command

Zoom Full [Shift]+[F]

Zoom In [H]

Zoom In Tracks [Alt]/[Option]+[Down Arrow]

Zoom Out [G]

Zoom Out Tracks [Alt]/[Option]+[Up Arrow] or
[Ctrl]/[Command]+[Up Arrow]

Zoom to Event [Shift]+[E]

Zoom to Selection [Alt]/[Option]+[S]

Zoom Tracks Exclusive [Z] or [Ctrl]/[Command]+
[Down Arrow]

Option Key command
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A
AAF files 495
ACID® loops 275
Activate Next/Previous Part 365
Activate project button 487
Active ASIO Ports for Data only 464
Active Part 365
Add Bus 13

Child Bus 13
Add Track 38
Adjust Fades to Range 88
Advanced Quantize 356
AES31 files 496
Aftertouch

Deleting 381
Editing 379
Recording 81

AIFF files 439
Allow machine controlled cycle 458
Alt/Option key 9
Alternative Key Sets 523
Always Send Start Message 449
Angle Mode 209
Any (MIDI channel settings) 79
Apogee UV22 HR 174
APP

Introduction to 452
Setting up 451

Appearance 511
General 511
Meters 511

Applying effects 249
Archiving 309
Arranger track

Adding 99
Creating a chain 100
Flattening 102
Renaming events 99

ASIO 2.0 72
ASIO Direct Monitoring 72
ASIO Positioning Protocol

Introduction to 452
Setting up 451

Attenuate (Surround Panner) 211

Audio channels
Copying settings 141
Linking 145
Making settings for 137
Mixing down to file 438
Saving settings 146

Audio clips
About 239
Creating new versions 301
Definition 24
Deleting 302
Locating events 303
Managing in Pool 300
Opening in the Sample Editor 306

Audio effects
About 169
Applying 249
Automating 234
Editing 182
External 182
For output busses (Master 

inserts) 173
Freezing 175
In surround configurations 212
Inserts 170
Organizing in subfolders 186
Post-fader inserts 170
Pre/Post-fader sends 178
Recording with 76
Saving 184
Selecting Presets 183, 198
Sends 177
Tempo sync 170
Using VST System Link 467

Audio events
Blue handles 87
Definition 24
Editing in Browser 430
Editing in Sample Editor 259
Fade handles 87
Making selections in 267
Slicing 283
Volume handles 88

Audio files
Converting 310
Deleting permanently 302
Exporting 438
Format for recording 67
Formats 307
Import options 41
Importing into Pool 306
Importing into Project window 41
Locating missing 305
Reconstructing missing 305
Removing missing 305

Audio loops
Tempo matching 272, 277

Audio parts
About 23
Creating by gluing events 48
Creating from events 42
Drawing 42
Editing in Audio Part Editor 291
Editing in Project Browser 430
Sliding contents 49

Audio playback speed
Adjusting 478

Audio pre-record 67
Audio Warp

Realtime pitch-shifting 288
Unstretch Audio 287

Audition icon
Sample Editor 265

Auditioning
Audio Part Editor 293
MIDI editors 370
Project window 42
Sample Editor 265

Auto Edit (Button) 459
Auto Fades 96
Auto Monitoring modes 71
Auto Quantize 79
Auto Save 489
Auto Select Events under Cursor

MIDI editors 372
Project window 43

Automatic MIDI Record Quantize 79



530

Index

Automation
Auto-Latch mode 220
Crossover mode 220
Delta indicator 216
Editing in Project Browser 432
Gap 218
Opening automation 

subtracks 231
Return Time 229
Showing and hiding 231
Touch mode 220
Touch-collecting parameters 225
Trim 224

Automation events
About 235
Drawing 235
Editing 235
Editing in the Project Browser 237
Removing 237
Selecting 237

Automation follows Events 
(Option) 234

Automation pass 215
Automation subtracks

Assigning parameters to 232
Hiding and showing 233
Muting 234

Autoscroll 57, 369

B
Backup (.bak) files 489
Bars+Beats Linear

MIDI editors 367
Tempo Track Editor 416

Beat Calculator 421
Bounce (Export Audio) 438
Bounce Selection

Pool 308
Project window 51
Sample Editor 269

Brightness 511
Broadcast Wave files

Exporting 441
Recording 67

Browser 429

Busses
About 11
Adding 13
Mixing down to file 438
Routing to and from 14
Viewing in the mixer 15

Bypass
Effect sends 178
Inserts 171

C
Calculate (Hitpoints) 279
Channel (MIDI) 77
Channel Overview

EQ 140
Insert effects 172

Channel setting
MIDI 79

Channel Settings
Audio tracks 137
Copying 141
MIDI tracks 144

Channel Settings windows
Customizing 506

Channel view sets 129
Chase 63
Child Bus 13
Chord Recognition 367
Cleanup 491, 501
Click 83
Clips, see “Audio clips”
Close Gaps 284
Close project 487
Color pop-up menu

MIDI editors 370
Project window 39

Color tool 39
Colorize Event Background 37
Configuring Studio Sends 163
Configuring the Control Room 

Mixer 156
Conform Files 310
Constrain Delay Compensation 200

Control Room
About 152
Channels 153
Configuring 153
Creating a Channel 154
Features 152
Mixer 156
Operations 158
Overview 156
Preferences 162
Settings 162

Controller display
About 368
Adding and removing lanes 377
Controller lane presets 377
Editing events 379
Editing velocity 378
Selecting event type 377

Controllers
Deleting 381
Editing 379
Lane Editing 378, 380
Recording 81

Convert Files 310
Convert to Real Copy 46
Converting MIDI to CC track 

automation 362
Count-in 83
Cpr files 487
Create Audio Images During 

Record 72
Create events 284
Create events (Cycle Rec Mode) 74
Create Groove Quantize 283
Create MIDI track when loading 

VSTi 190
Create new controller lane 377
Create Regions (Cycle Rec Mode) 74
Create slices 283
Crop 55
Crossfades

Creating 91
Editing in dialog 92
Presets 95
Removing 91
Simple Crossfade Editor 92
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Csh files 309
Ctrl/Command key 9
Cursor, see “Project cursor”
Cut Head 47
Cut Tail 47
Cut Time 54
Cycle

About 61
About recording 66
Record modes 80
Recording audio 73
Recording MIDI 80

Cycle markers
About 110
Adding in Marker window 110
Drawing 112
Editing 112
Making selections with 113
Navigating to 112
On Marker track 111

D
DC Offset 247
Deactivate

Inserts 171
Deactivate plug-in when silence is 

detected (VST 3) 169, 196
Deactivate Punch In on Stop 83
Default MIDI editor 364
Default Output Bus 14
Default template 488
Default Track Time Type 40
Delay compensation

About 170
Constraining 200

Delete
Audio files from disk 302
Events in Project window 51
MIDI controllers 360, 381
MIDI notes 375

Delete Continuous Controllers 360
Delete Controllers function 360
Delete Doubles function 360
Delete Notes function 360

Delete Overlaps
Audio 52, 75
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Process Bars 420
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Plug-ins 249
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Project
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Project Setup dialog 33
Pull-down

2-3 Pull-down 477
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Recording in MIDI editors 82
Recording tempo changes 419
Recovering recordings 85
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Synchronization
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454
Machine control 455
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Settings 449
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System Exclusive
About 411
Bulk Dumps 411
Editing 413
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changes 412

T
Talkback (Control Room 
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About 476
Transferring film to NTSC 
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Templates 488
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Editing 417
Editing in Project Browser 433
Importing and exporting 419
Recording 419
Setting in Fixed mode 419
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Tempo matching audio loops 272, 

277
Tempo record slider 419
Thin Out Data 362
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Time Linear
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Tempo Track Editor 416

Time Scales 32
Time signature 419
Time Stretch 248
Time Warp tool 422
Timecode
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Synchronizing to 451

Toggle Track List 40
Tool modifier keys 524
Toolbar

Audio Part Editor 291
Customizing 506
Key Editor 366
List Editor 383
Pool 298
Project window 30
Sample Editor 260

Track Archive (importing) 500
Track Control Settings 507
Track list

About 25
Customizing 507
Dividing 40

Track Parameters 346
Track Presets

Extracting sound from 199
Track Quick Controls

About 339
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Controlling the mixer 340
Remote Control setup 341
Removing 340
Renaming 339
Replacing 340

Track Sheet 435
Track types 23
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Track parameter 346

Transpose track
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MIDI editing 380
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Undo
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Recording 72
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Unlock 50
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Use File Extension in File Dialog 488
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Deactivate plug-in when silence is 
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VST plug-ins
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VST Sound
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Setting up sync 461
Settings 462

W
Warp tabs
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Wave files 440
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Wave64 files 441
Waveform zooming 34
Window layouts 504
Windows Media Audio files

Importing 494
Surround format (Pro) 442

WK-Audio ID 167
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WMA Pro files 442
Word Clock

About 447
Selecting for sync 453
Setting up 449

Workspaces 504
Wrap Controls (Track list) 35

X
XSend

Installing 498

Z
Zero Crossings 57
Zoom
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Zoom Tool Standard Mode 34
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